# Contents

## Chapter 1  AutoCAD Electrical What’s New
- What’s New in AutoCAD Electrical 2008 ........................................ 2
- What’s New in Previous Releases .................................................. 9
- What’s New in 2005 Release .......................................................... 12
- What’s New in 2006 Release .......................................................... 13
- What’s New in 2007 Release .......................................................... 15

## Chapter 2  Project Management .................................................. 23
- Overview of AutoCAD Electrical Help ........................................... 24
- Overview of projects ................................................................. 29
  - Use recently opened projects .................................................. 29
  - Create a new project .......................................................... 31
  - Add a new drawing to the current project .................................. 31
  - Add existing drawings to the current project ............................. 32
  - Group drawings within a project ........................................... 34
  - Change the order of drawings in the project ............................. 35
  - Remove a drawing from the active project .............................. 36
  - Assign a description to each drawing .................................... 36
  - Preview a drawing ............................................................ 37
- About collaborative design ......................................................... 50
- Create a new drawing ............................................................. 63
- Change drawing display options .............................................. 68
- Overview of project related files .............................................. 70
Overview of the project file format ................................. 77
Archive a project ....................................................... 82
Work with Multiple Clients ......................................... 83
  Overview of set up for multiple clients ......................... 83

Chapter 3  Drawing and Project Properties ............................ 95
  Overview of project and drawing properties .................... 96
  Use replaceable parameters ................................... 126
  Save settings to the project file ................................ 129
  Create a template drawing ...................................... 131
  Updating the WD_M Block ........................................ 134
    Overview of the WD_M block .................................. 134
  Using Layers ......................................................... 143
    Manage layers .................................................... 143
    Use wire layers .................................................. 150
    Change wire types ............................................... 156

Chapter 4  Symbol Libraries ............................................. 161
  Determine symbol block names .................................. 162
  Library Symbol Naming Conventions ............................. 163
    Overview of symbol naming conventions ....................... 163
  Split a tag name into two pieces ................................ 172
  Use multiple symbol libraries .................................. 173
  Overview of Hydraulic and P&ID symbols ....................... 174
  Attribute Requirements .......................................... 177
    Schematic Attributes .......................................... 177
      Overview of schematic attributes .......................... 177
    Non-Schematic Attributes ..................................... 192
      Overview of non-schematic attributes ....................... 192
      Overview of parent and stand-alone component attributes
      (TAG1) .................................................. 196
    Overview of child component attributes (TAG2) ............ 196
  Copy attributes .................................................... 196
  Managing Library Symbols ........................................ 197
    Substitute symbols in the library ............................. 197
    Change appearance of existing library symbols .............. 197
    Predefine symbol annotation .................................. 199
    Create a new library symbol .................................. 199
    Overview of the Symbol Builder ............................... 201
    Swap blocks ....................................................... 209

Chapter 5  PLC .......................................................... 217
  Generate PLC layout modules ..................................... 218
  Parametric PLC symbols vs. Full Units .......................... 218
Insert PLC modules ........................................... 221
Overview of the PLC database file ......................... 225
Single, Stand-Alone I/O Points .............................. 246
  Modify single, stand-alone PLC layout symbols .......... 246
Work with PLC styles ...................................... 251
  Modify a PLC appearance style ....................... 251
  Create a new PLC style .................................. 252
  Add a new PLC style .................................... 252
Create PLC I/O Drawings from Spreadsheets .............. 253
  Overview of the PLC spreadsheet/database format ...... 253
  Create PLC spreadsheets using RSLogix ............... 267
  Create PLC drawings from Unity Pro ................... 270
  Create XML files for export to Unity Pro .............. 280

Chapter 6  Component Tools ................................. 283
Insert schematic components ............................... 284
Insert a copy of a component .............................. 308
Insert similar components .................................. 308
Insert from catalog lists .................................... 312
Use the schematic lookup file ............................ 316
Insert from panel lists ..................................... 323
Manipulate Components ..................................... 330
  Manipulate components ................................. 330
  Annotate ratings attributes ............................ 337
  Reverse/flip components ................................ 338
Swap contact states ........................................ 340
Check coil/contact count .................................... 340
Follow signals ................................................ 342
Insert dashed link lines .................................... 344
Overview of DIN Rails ...................................... 344
Edit schematic lookup files ............................... 349
Overview of user data records ............................. 351
Component Cross-References ............................... 353
  Use stand-alone cross-reference symbols ............ 353
  Change cross-reference visibility ..................... 361
  Insert a dashed link line ................------------ 361
  Overview of cross-reference settings ................. 362
  Overview of graphical cross-reference formats ....... 368
  Overview of table cross-reference formats ........... 372
Update cross-reference tables ............................ 377
Use cross-reference exception reports .................... 383
Circuits ....................................................... 384
  Use circuitry ............................................. 384
Wire Jumpers .................................................. 396
  Define wire jumpers .................................... 396
Chapter 7  Component Attribute Tools  ........................................... 399
   Edit attribute values ......................................................... 400
   Force attributes to layers .................................................. 403
   Manipulate component text ............................................... 405
   Manipulate terminal text .................................................. 408
   Move description values ................................................... 409
   Manipulate Attributes ....................................................... 410
   Manipulate component attributes ...................................... 410
   Set tags to fixed ............................................................. 411
   Change to multi-line text .................................................. 414
   Add location codes .......................................................... 414
   Update child codes .......................................................... 416
   Location Mark Symbols ..................................................... 418
   Substitute location mark symbols for text location codes ........ 418
   Change attribute justification ............................................. 424
   Change attribute text style ................................................ 425
   Change attribute text size ................................................ 425
   Modify library symbols ..................................................... 429
   Add attributes to blocks .................................................. 431

Chapter 8  Wire/Wire Number Tools ............................................. 433
   Overview of wires .......................................................... 434
   Insert 3-phase bus wiring ................................................ 435
   Insert wires ................................................................. 437
   Trim wires ...................................................................... 439
   Stretch wires ............................................................... 440
   Overview of wire color/gauge labels .................................... 440
   Insert cable markers into wires .......................................... 443
   Insert cable markers ........................................................ 444
   Insert multiple cable markers .......................................... 445
   Insert shield symbols ...................................................... 466
   Add a second shield to a cable/shield representation ................ 467
   Insert in-line wire markers .............................................. 467
   Wire Gaps ......................................................................... 473
   Manipulate wire gaps ....................................................... 473
   Ladder Tools ...................................................................... 474
   Define and insert new ladders ........................................... 474
   Modify an existing ladder ................................................... 480
   Wire Numbers .................................................................... 484
   Overview of wire numbers ................................................ 484
   Set wire number placement ................................................ 492
   Find or replace wire number text ........................................ 501
   Encode wire color/gauge information into wire numbers ........... 502
   Fix Wire Numbering ........................................................... 506
   Fix wire numbering ........................................................... 506
Reposition Wire Numbers .................................................. 511
Modify Wire Numbers ....................................................... 519
Erase or Hide Wire Numbers .............................................. 521
Wire Sequencing ............................................................... 525
Control from/to report connection sequencing ..................... 525
Add custom signal arrow styles ....................................... 536
Edit the cable conductor database .................................... 542
Source and Destination Markers ........................................ 543
Show source and destination markers on wires .................... 543
Chapter 9 Terminal Tools .................................................. 553
Overview of connection sequencing ................................... 554
Insert terminals and connectors ....................................... 559
Multi-Level Terminals ....................................................... 568
Overview of terminal relationships .................................... 568
Edit terminal jumpers ....................................................... 573
Resequence terminal numbers ......................................... 578
View terminal wire connections ....................................... 579
Show terminal internal/external connections ....................... 580
Mark internal connections ................................................. 580
Mark external connections ............................................... 580
Erase connection codes ................................................... 581
Terminal Strips .................................................................. 581
Create terminal strips ....................................................... 581
Use the terminal strip editor .............................................. 585
Generate terminal strip tables ............................................. 624
Terminal Properties Lookup .............................................. 629
Overview of terminal properties database ......................... 629
Chapter 10 Point-to-Point Wiring Tools ................................. 635
Working with Connectors ................................................. 636
Use point-to-point wiring tools ........................................ 636
Bend wires at right angles ............................................... 659
Insert multiple bus wiring ................................................. 660
Import data from Autodesk Inventor Professional Cable & Harness .................................................. 662
Overview of the spreadsheet import file structure ................ 673
Insert splices ................................................................. 685
Chapter 11 Project-Wide Tools ............................................ 687
Move from reference to reference ..................................... 688
Contents | ix
<table>
<thead>
<tr>
<th>Chapter 12 Icon Menus</th>
<th>729</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of the Icon Menu Wizard</td>
<td>730</td>
</tr>
<tr>
<td>Add a new icon to the menu</td>
<td>732</td>
</tr>
<tr>
<td>Edit the properties of an existing icon in the menu</td>
<td>733</td>
</tr>
<tr>
<td>Use alternate icon menus</td>
<td>759</td>
</tr>
<tr>
<td>Modify Icon Menu File Directly</td>
<td>760</td>
</tr>
<tr>
<td>Overview of the icon menu file</td>
<td>760</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 13 BOM and Catalogs</th>
<th>765</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use catalog tables</td>
<td>766</td>
</tr>
<tr>
<td>Catalog table naming conventions</td>
<td>766</td>
</tr>
<tr>
<td>Family tables in the default_cat.mdb</td>
<td>768</td>
</tr>
<tr>
<td>Overview of the catalog database table structure</td>
<td>777</td>
</tr>
<tr>
<td>Use the merge utility</td>
<td>781</td>
</tr>
<tr>
<td>Catalog Assignment</td>
<td>785</td>
</tr>
<tr>
<td>Assign catalog information to components</td>
<td>785</td>
</tr>
<tr>
<td>Overview of the LISTBOX_DEF catalog database table</td>
<td>788</td>
</tr>
<tr>
<td>Copy catalog assignments from component to component</td>
<td>790</td>
</tr>
<tr>
<td>Show missing catalog assignments</td>
<td>793</td>
</tr>
<tr>
<td>Contact Quantity/Pin List Lookup</td>
<td>793</td>
</tr>
<tr>
<td>Use pin lists</td>
<td>793</td>
</tr>
<tr>
<td>Set pin list assignments for special uses</td>
<td>800</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 14 Reports</th>
<th>803</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate reports</td>
<td>804</td>
</tr>
<tr>
<td>Schematic Reports</td>
<td>897</td>
</tr>
<tr>
<td>Generate schematic reports</td>
<td>897</td>
</tr>
<tr>
<td>Panel Reports</td>
<td>923</td>
</tr>
<tr>
<td>Generate panel reports</td>
<td>923</td>
</tr>
<tr>
<td>Overview of format files</td>
<td>938</td>
</tr>
<tr>
<td>Run automatic reports</td>
<td>991</td>
</tr>
</tbody>
</table>
Modify spreadsheet data .......................................................... 996
Create user-defined attributes .................................................... 1005
Export to Autodesk Inventor Professional ........................................ 1008
  Set up for export to Autodesk Inventor Professional Cable & Harness .................................................. 1008

Chapter 15 Panel Layout .......................................................... 1021
  Overview of panel layouts .......................................................... 1022
  Automatic schematic/panel update .................................................. 1022
  Relationship between schematic drawings and panel layouts ............... 1026
  Overview of footprint attributes/Xdata ............................................ 1028
  Footprint/Terminal Insertion .......................................................... 1031
    Select and insert footprints ....................................................... 1031
    Insert a copy of a panel footprint ................................................. 1061
    Copy code values to components .................................................. 1061
    Use panel templates ............................................................... 1064
    Select component data from a spreadsheet ...................................... 1066
  Layout Wire Connection Annotation ................................................ 1074
    Merge schematic wire numbers onto footprints ................................ 1074
    Add wire information to footprints ................................................. 1077
  Lookup Files ........................................................................ 1081
    Use the footprint lookup file ....................................................... 1081
  Item Numbers/Balloons ............................................................... 1087
    Assign an item or detail number to a footprint ................................ 1087
  Nameplates ........................................................................ 1091
    Insert nameplates ..................................................................... 1091
  Panel Leveling/Sequencing Tools ....................................................... 1093
    Remove sequencing assignments ..................................................... 1093
    Show sequencing assignments ....................................................... 1093
    Swap terminal strip wire text ......................................................... 1095

Chapter 16 Conduit Tools .......................................................... 1109
  Overview of conduit tools ............................................................ 1110
  Conduit Marker Intelligence ........................................................... 1110
  Overview of conduit marker support files ........................................ 1116
  Generate a conduit marker report ..................................................... 1118
  Generate a conduit routing report ..................................................... 1120

Chapter 17 Conversion Tools ....................................................... 1123
  Convert promis.e drawing files to AutoCAD Electrical ....................... 1124
  Convert non-AutoCAD Electrical blocks ............................................. 1128
    Finish mapping values from non-AutoCAD Electrical blocks .......... 1128
  Convert text to an attribute .......................................................... 1131
<table>
<thead>
<tr>
<th>Chapter 18 Miscellaneous Tools</th>
<th>1157</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of power check tools</td>
<td>1158</td>
</tr>
<tr>
<td>Overview of pneumatic tools</td>
<td>1161</td>
</tr>
<tr>
<td>Insert hydraulic components</td>
<td>1166</td>
</tr>
<tr>
<td>Insert P&amp;ID components</td>
<td>1171</td>
</tr>
<tr>
<td>Troubleshooting Tools</td>
<td>1176</td>
</tr>
<tr>
<td>Overview of real-time error checking</td>
<td>1176</td>
</tr>
<tr>
<td>Modify invisible data</td>
<td>1184</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 19 Advanced Productivity</th>
<th>1187</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up peer-to-peer component relationships</td>
<td>1188</td>
</tr>
<tr>
<td>Create automated pin assignments</td>
<td>1190</td>
</tr>
<tr>
<td>Set up AutoCAD Electrical for multiple users</td>
<td>1193</td>
</tr>
<tr>
<td>Show source and destination markers on cable wires</td>
<td>1197</td>
</tr>
<tr>
<td>Use the PLC Database File Editor</td>
<td>1205</td>
</tr>
<tr>
<td>Add your own symbols, circuits and commands to the icon menu</td>
<td>1214</td>
</tr>
<tr>
<td>Build your own symbols</td>
<td>1223</td>
</tr>
<tr>
<td>Configure projects for various drawing standards</td>
<td>1243</td>
</tr>
<tr>
<td>Use Autodesk Vault with AutoCAD Electrical</td>
<td>1250</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 20 AutoCAD Electrical Command</th>
<th>1257</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoCAD Electrical Commands</td>
<td>1258</td>
</tr>
</tbody>
</table>

| Index                                | 1271 |
AutoCAD Electrical
What's New

In this chapter
- What's New in AutoCAD Electrical 2008
- What's New in Previous Releases
- What's New in 2005 Release
- What's New in 2006 Release
- What's New in 2007 Release
What's New in AutoCAD Electrical 2008

PLC I/O Import/Export

You can now communicate your electrical designs between AutoCAD Electrical and Schneider Electric’s Unity Pro. Employing the widely used XML language format, you can transfer design data back and forth while maintaining structure and organization.

Use the new Unity Pro Export to Spreadsheet tool to import Unity Pro XML export files to aid in the creation of PLC-style ladder drawings and panel layout drawings (in both vertical and horizontal format) in the active project. The Unity Pro export files also contain catalog information. You can reformat it to generate an equipment list to aid in the creation of a rack layout drawing used in panel layouts or separate rack layout drawings.

Use the new Unity Pro Export tool to create a Unity Pro I/O variable file (*.xxy) in the Unity Pro XML format from your AutoCAD Electrical drawings. The Unity Pro export file is generated from the PLC drawings and their respective PLC symbols.

For More Information (page 270)

PLC I/O Libraries Enhancements

You can quickly create PLC I/O drawings by selecting from a library of over 3,000 intelligent PLC I/O modules from the industry’s most popular manufacturers.

Spreadsheet to PLC I/O Utility Enhancements

You no longer have to create and save the starting drawing for the Spreadsheet to PLC I/O Utility tool. You can now define a starting drawing file name or start with the active drawing. Additional enhancements include:

■ Default settings are now read automatically the first time you run the tool.
■ You can select a settings file and make it the default.
■ You can have the newly created drawings added automatically to the end of the active project.

For More Information (page 257)
**Surfable Reports**

When reports are placed into a drawing as a table, you can click on various report cells to quickly find the corresponding devices within the schematic or panel layout drawings in the active project.

When surfing on a table inserted by the Terminal Strip Editor, you can click the title cell to surf on the Tagstrip value, even if the Tagstrip is not included in the title. If you select a cell that is not surfable (such as the Tag, Catalog, or Wire Number cell) the Tagstrip value is surfed for the terminal strip.

*For More Information* (page 688)

**Insert Component and Insert Footprint Enhancements**

The Insert Component and Insert Footprint dialog boxes are updated to improve ease of use when selecting components to insert into your drawing.

Enhanced dialog box controls include:

- **Menu tree structure**
  Displays the main menu and submenus from which you can freely navigate. Clicking the menus displays the corresponding menu icons in the Symbol Preview window. The menu is created by reading the *.dat file defined in the Project Properties dialog box.

- **Symbol Preview window**
  Displays the symbol icons and submenu icons corresponding to the selected menu. Clicking an icon performs one of the following functions based on the icon properties as defined in the *.dat file: insert a component or circuit, display a submenu, or execute a command.

- **Recently Used**
  Displays the last components inserted during the current editing session. The most recently used icon displays at the top. This list follows the view options setting in the symbol preview window and the total number of icons displayed depends on the value specified in the Display edit box.

- **View**
  Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only, or List view.

- **Tooltips**
  When you move the cursor over an icon, the icon name and block/circuit/command names display as tooltip information.
**Icon Menu Wizard Enhancements**

The Icon Menu Wizard allows you to easily customize the icon menus. You can now copy and paste icons from one submenu into another, drag and drop icons to place those that are commonly used at the top of the Symbol Preview window and those that are used less frequently at the bottom of the window, and create new icons to use when inserting components.

You can also easily modify the existing icon or menu properties like changing the name, image or block name. Right-click the menu or icon on the Icon Menu Wizard dialog box and select Properties. The existing data is overwritten in the *.dat file with the new changes.

For More Information (page 730)

**Direct Wire Sequencing**

You can now use the Edit Wire Sequence tool to define additional direct-to-terminal wire connection sequences in schematic networks. For example, 1 side of a schematic terminal might be connected to 3 field devices. A specific wire connection sequence can be defined to force the connection reporting, but it is limited to reporting the terminal as a common connection point for only 2 of the 3 field devices. The third has to be reported as jumpered to 1 of the other 2 devices. Now, with the support for secondary direct-to-terminal sequences, the third field device can be sequenced directly to the terminal and the Wire From/To report shows all 3 field devices tied directly to the terminal.

For More Information (page 528)

**Visual Wiring Sequence Indicators**

Once you define additional wire connection sequences, use the Show Wire Sequence tool to graphically show the new sequencing. When any changes are made to a wire sequence, the updated information is accurately reflected in the from/to wire list report.

For More Information (page 530)

**Terminal Strip Editor Enhancements**

The Terminal Strip Editor provides an easy way to manage and edit terminals used throughout a project. You can now start designs with a terminal strip layout drawing representing the terminal strip. In the modified Terminal Strip Selection dialog box, you can either select a terminal strip for editing, or create
a new terminal strip definition in the project and maintain its properties in
the graphical terminal strip layout drawing.

The Terminal Strip Editor dialog box now has an enhanced grid control with
bolder grid lines that provide better visual definition for the terminal strip.
Other enhancements to the dialog box include:

■ The Terminal Pin (TPin) column is now “T.”
■ The TERM column is now “Number” to indicate the terminal numbering,
whether it is a wire number or user-defined number.
■ The Function column is now “Installation.”
■ A new column (on the far left side of the grid) indicates the level definition.
■ Tooltip instructions display once you move your cursor over 1 of the tool
buttons in the dialog box.
■ There is better context menu support that is based on individual cells.
■ The Preview tab is now “Layout Preview.”
■ The Cable Preview tab is now “Cable Information.”

New tools are available on the Terminal Strip Editor dialog box to create
associations, separate levels from a multiple level terminal block into separate
terminal blocks, reverse the left and right wiring information for a terminal,
and edit terminal block properties such as the number of levels and number
of wires per connection.

The Layout Preview tab of the Terminal Strip Editor dialog box has been
enhanced to allow AutoCAD’s table objects to be inserted as a terminal strip.
This allows for more accurate representations of what is in the Terminal Strip
Editor, more flexibility with the style, and provides a means for automatic
updating.

For More Information (page 585)

Inserting Spare Terminals

Extra terminal block definitions and accessory information is now maintained
and saved on the graphical terminal strip layout. You can insert spare terminals
and have them accurately update the Bill of Materials as well as various
terminal reports.

For More Information (page 614)
Multi-Level Terminals

Multi-level terminal blocks are quickly becoming an industry standard. Using AutoCAD Electrical, you can define and manage the terminal numbers and levels as well as all connectivity information with no added complexity.

You can now associate schematic terminals to build a multi-level terminal block that is limited to the number of levels defined in the block properties. Use the new Add/Modify Associations tool to search project terminal strips for existing multi-level terminal blocks so that you can define and maintain terminal associations. Terminals must be in the same terminal strip and be in the same project to be associated together. You can also remove a terminal from any multi-level relationship and copy terminal properties from 1 terminal symbol to another.

Associating schematic terminals combines the terminals into a single terminal block property definition. The number of schematic terminals that can be combined is limited to the number of levels defined for the block property. Terminal associations can also tie together a set of schematic terminal block symbols to one panel representation of a terminal footprint.

For More Information (page 568)

Terminal Properties Database Editor

Terminal properties data is now managed based on manufacturer. Use the new Terminal Properties Database Editor tool to select the manufacturer table to edit or create a new one in the catalog database for the active project.

Terminal Jumper Support

Use the new Edit Jumper tool to add, edit, or remove jumpers between terminals that share the same potential in a schematic drawing. You can display temporary line graphics between the primary terminal and secondary terminals within the same drawing.

Jumpers now display on the panel drawing so you have a visual representation of jumpers that appear on tabular terminal strips. Cells of a table row are joined with a graphical jumper that looks like 2 circles connected by a solid thick line. Three columns of jumpers are supported within a single jumper column in the table.
Pin List Data Management

Pin list data is now managed based on manufacturer. Use the Pin List Database Editor tool to select the pin list table to edit or create a new table.

The _PINLIST table in the default_cat.mdb file now uses a single PINLIST column and a single PEER_PINLIST column. The continuation columns have been removed.

For More Information (page 795)

Installer Improvements for Manufacturer Content

You can now selectively install content based on manufacturer, reducing the size of the content databases and data redundancy. If you later decide you want to install content from another manufacturer, open the Add or Remove Programs tool in your Control Panel, select AutoCAD Electrical 2008, and click Change/Remove. Click Add/Remove Features, click Next on the first screen, and then select the manufacturers to install on the Manufacturer Contents Selection screen.

Catalog Content Updates

AutoCAD Electrical ships with a manufacturer’s catalog database that contains over 350,000 components from the industry’s most popular vendors. These components provide a full spectrum of input and output devices including switches, sensors, lights, and numerous panel devices, such as wireway and panel enclosures.

Improved Performance

Significant improvements in running commands that affect other drawings have dramatically improved the performance of AutoCAD Electrical 2008. Most notably, the Project Database Service (PDS) now only monitors the active project.

64-bit AutoCAD Electrical

AutoCAD Electrical now ships in 64-bit and 32-bit versions. The 64-bit version supports the same functionality as the 32-bit version.

DWG product recognition

Easily identify which Autodesk product created a DWG file and open the file with the application that owns the DWG file. For example, if the DWG file is...
owned by AutoCAD, double-clicking the file in Windows Explorer automatically opens the file in AutoCAD. When you move the cursor over a DWG icon, the tooltip identifies which Autodesk product and version was used to create the DWG.

**Parametric Twisted Pair Symbol Enhancements**

The icon menus are enhanced to include three new parametric twisted pair symbols. To insert a twisted pair symbol, click Components > Insert Component. On the Insert Component icon menu, click Cable Markers.

**User’s Guide**

A User’s Guide for AutoCAD Electrical is now available in PDF format. This is accessible from the Launchpad and the homepage of the Help.

**InfoCenter**

A new search engine, InfoCenter, is included on the title bar of the main AutoCAD Electrical window. It searches AutoCAD and AutoCAD Electrical Help systems to give you the most relevant information for any query you enter. You can filter content and add frequently used content to the “Favorites” section.

InfoCenter replaces the Communication Center. It provides notifications of software and content updates through a balloon notification mechanism. You can also publish internal content within your team, support RSS feeds, and easily provide feedback to Autodesk.

**What’s New for Previous Releases**

You can now quickly see which features were added or enhanced in past releases of AutoCAD Electrical. This PDF is accessible from the homepage of the AutoCAD Electrical Help. Click on the “x” for a particular feature to get more information about what functionality was added for that release.
# What's New in Previous Releases

The chart below shows which features were added or enhanced in past releases of AutoCAD Electrical. Click the ‘x’ for detailed information on what was added or enhanced for a particular release.

<table>
<thead>
<tr>
<th>Feature</th>
<th>2005</th>
<th>2006</th>
<th>2007</th>
<th>2008</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLC Module Builder</td>
<td>X (page 12)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Support for Multiple Design Standards</td>
<td>X (page 13)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Automatic Report Generation</td>
<td>X (page 12)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Merge Utility</td>
<td>X (page 12)</td>
<td>X (page 13)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Autodesk Inventor Professional Integration</td>
<td>X (page 13)</td>
<td></td>
<td>X (page 17)</td>
<td></td>
</tr>
<tr>
<td>Terminal Strip Editor</td>
<td>X (page 12)</td>
<td></td>
<td></td>
<td>X (page 4)</td>
</tr>
<tr>
<td>Engineering Design Management</td>
<td>X (page 13)</td>
<td>X (page 13)</td>
<td>X (page 21)</td>
<td></td>
</tr>
<tr>
<td>Catalog Content Updates</td>
<td>X (page 12)</td>
<td></td>
<td>X (page 20)</td>
<td>X (page 7)</td>
</tr>
<tr>
<td>MDI Aware</td>
<td></td>
<td></td>
<td></td>
<td>X (page 14)</td>
</tr>
<tr>
<td>Insert Component (Equipment List) Tool</td>
<td>X (page 13)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AutoCAD Data Migration</td>
<td></td>
<td></td>
<td></td>
<td>X (page 14)</td>
</tr>
<tr>
<td>Convert promis.e Drawings</td>
<td></td>
<td></td>
<td></td>
<td>X (page 14)</td>
</tr>
<tr>
<td>Project Manager</td>
<td></td>
<td></td>
<td>X (page 13)</td>
<td>X (page 20)</td>
</tr>
<tr>
<td>PLC I/O Libraries</td>
<td></td>
<td></td>
<td>X (page 14)</td>
<td></td>
</tr>
<tr>
<td>Wire Sequence Updates</td>
<td></td>
<td></td>
<td>X (page 14)</td>
<td>X (page 4)</td>
</tr>
<tr>
<td>Feature</td>
<td>2005</td>
<td>2006</td>
<td>2007</td>
<td>2008</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>---------------</td>
<td>---------------</td>
<td>---------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Help Updates</td>
<td>X (page 14)</td>
<td></td>
<td>X (page 8)</td>
<td></td>
</tr>
<tr>
<td>Connector Generation</td>
<td></td>
<td>X (page 15)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Splice Tool</td>
<td></td>
<td>X (page 16)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wire Number Placement</td>
<td></td>
<td></td>
<td>X (page 16)</td>
<td></td>
</tr>
<tr>
<td>Multiple Wire Bus</td>
<td></td>
<td></td>
<td>X (page 18)</td>
<td></td>
</tr>
<tr>
<td>Bend Wire Tool</td>
<td></td>
<td></td>
<td>X (page 17)</td>
<td></td>
</tr>
<tr>
<td>New Symbol Libraries</td>
<td></td>
<td></td>
<td>X (page 18)</td>
<td></td>
</tr>
<tr>
<td>Real-time Error Checking</td>
<td></td>
<td></td>
<td>X (page 18)</td>
<td></td>
</tr>
<tr>
<td>User Defined Attributes</td>
<td></td>
<td></td>
<td>X (page 18)</td>
<td></td>
</tr>
<tr>
<td>Wire Label Report</td>
<td></td>
<td></td>
<td>X (page 19)</td>
<td></td>
</tr>
<tr>
<td>New Project Tool</td>
<td></td>
<td></td>
<td>X (page 20)</td>
<td></td>
</tr>
<tr>
<td>New Drawing Tool</td>
<td></td>
<td></td>
<td>X (page 20)</td>
<td></td>
</tr>
<tr>
<td>Wire Type Selection</td>
<td></td>
<td></td>
<td>X (page 20)</td>
<td></td>
</tr>
<tr>
<td>Autodesk Productstream Integration</td>
<td></td>
<td></td>
<td>X (page 21)</td>
<td></td>
</tr>
<tr>
<td>Simplified Configuration Settings</td>
<td></td>
<td></td>
<td>X (page 21)</td>
<td></td>
</tr>
<tr>
<td>Wire Number Leaders</td>
<td></td>
<td></td>
<td>X (page 17)</td>
<td></td>
</tr>
<tr>
<td>Wire Connection Improvements</td>
<td></td>
<td></td>
<td>X (page 16)</td>
<td></td>
</tr>
<tr>
<td>Wire Collision Avoidance</td>
<td></td>
<td></td>
<td>X (page 16)</td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>2005</td>
<td>2006</td>
<td>2007</td>
<td>2008</td>
</tr>
<tr>
<td>---------</td>
<td>------</td>
<td>------</td>
<td>------</td>
<td>------</td>
</tr>
<tr>
<td>Cross-Reference Updates</td>
<td>X (page 19)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table Style Cross-Reference Updates</td>
<td>X (page 19)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enhanced Drawing Audit Report</td>
<td>X (page 19)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Improved Performance</td>
<td></td>
<td>X (page 20)</td>
<td>X (page 7)</td>
<td></td>
</tr>
<tr>
<td>Insert Components from a Menu</td>
<td></td>
<td>X (page 15)</td>
<td>X (page 3)</td>
<td></td>
</tr>
<tr>
<td>Icon Menu Wizard Enhancements</td>
<td></td>
<td></td>
<td></td>
<td>X (page 4)</td>
</tr>
<tr>
<td>PLC I/O Import/Export</td>
<td></td>
<td></td>
<td></td>
<td>X (page 2)</td>
</tr>
<tr>
<td>Spreadsheet to PLC I/O Utility Enhancements</td>
<td></td>
<td></td>
<td></td>
<td>X (page 2)</td>
</tr>
<tr>
<td>Surfable Reports</td>
<td></td>
<td></td>
<td></td>
<td>X (page 3)</td>
</tr>
<tr>
<td>Direct Wire Sequencing</td>
<td></td>
<td></td>
<td></td>
<td>X (page 4)</td>
</tr>
<tr>
<td>Inserting Spare Terminals</td>
<td></td>
<td></td>
<td></td>
<td>X (page 5)</td>
</tr>
<tr>
<td>Multi-Level Terminals</td>
<td></td>
<td></td>
<td></td>
<td>X (page 6)</td>
</tr>
<tr>
<td>Terminal Jumpers</td>
<td></td>
<td></td>
<td></td>
<td>X (page 6)</td>
</tr>
<tr>
<td>Terminal Properties Database Editor</td>
<td></td>
<td></td>
<td></td>
<td>X (page 6)</td>
</tr>
<tr>
<td>Pin List Data Management</td>
<td></td>
<td></td>
<td></td>
<td>X (page 7)</td>
</tr>
<tr>
<td>Installer Improvements</td>
<td></td>
<td></td>
<td></td>
<td>X (page 7)</td>
</tr>
<tr>
<td>64-bit AutoCAD Electrical</td>
<td></td>
<td></td>
<td></td>
<td>X (page 7)</td>
</tr>
</tbody>
</table>
What's New in 2005 Release

**Terminal Strip Editor**

The Terminal Strip Editor tool automatically creates accurate terminal strip drawings in either a graphical or table format. You can now manage and edit terminals used throughout an entire project through a simple interface.

**PLC Module Builder**

Use the new PLC Module Builder tool to graphically add new PLC modules as they are introduced by manufacturers. This eliminates the need to ever manually add any module information or wait for a new version of AutoCAD Electrical to ship.

**Expanded Catalog Content**

The standard parts catalog has been expanded to include more than 43,000 components from multiple vendors.

**Merge Catalog Database Utility**

The Merge Catalog Database utility merges the new catalog database with the customized database already on the system. This maintains any custom entries and modifications that you have made to your database while adding the new catalog information.

**Automatic Report Generation**

Use the new Automatic Report Generation tool to generate multiple reports with one command.
Vault Integration

The Vault Explorer and Vault Server are now included with AutoCAD Electrical to help manage your engineering data.

Enhanced Link to Autodesk Inventor Professional

The link to Autodesk Inventor Professional has been enhanced to support cable information instead of simple discrete wires.

Enhanced Drawing Standards Support

Drawing standards have been expanded to cover the JIC, IEC, JIS, and GB standards.

What's New in 2006 Release

Merge Utility

Use the new Merge Utility tool to merge your existing manufacturer catalog databases, PLC I/O libraries, footprint lookup databases, and corresponding footprint symbols with your existing content in one simple operation. This maintains custom entries and modifications that you have made to your databases while adding the new database and library information.

Improved Page Management

Use the new Project Manager Enhanced Secondary Window (ESW) to manage all drawing files in a project. You can manage entire projects or make modifications to single drawings using the Project Manager ESW.

Vault Integration

Autodesk Vault Explorer and Vault Server now better handle AutoCAD Electrical projects and support work group environments where multiple users can be working on the same project at the same.

Starting designs with a panel layout drawing

You can now create a panel layout drawing, and then create the corresponding logical control schematics. Once the panel creation phase is complete, AutoCAD Electrical extracts a list of schematic components for placement.
into schematic drawings. You choose the component location and a physical schematic representation of each device to be inserted into the layout and a "link" is automatically created between the devices. Any changes to the either schematic or panel representation updates the other.

**MDI Aware**

You can now have multiple drawings open at any one time. This allows you to cut and paste design information between two open drawings without closing one of them.

**AutoCAD Data Migration**

Use the new conversion tools to migrate existing electrical designs from AutoCAD or AutoCAD LT into AutoCAD Electrical for further modification. The existing tools have been greatly enhanced, making it even quicker and easier to migrate from AutoCAD drawings to intelligent AutoCAD Electrical designs.

**promis.e Data Migration**

Use the new promis.e data migration tools to easily migrate electrical designs from promis.e into AutoCAD Electrical.

**Additional PLC I/O Libraries**

The PLC I/O libraries have been expanded to include more than 2,000 new PLC I/O modules from industry's most popular manufacturers. Additional connection devices and panel footprint symbols have also been created and added to the lookup database.

**Visual Sequence Indicators**

A new option has been added to the configuration that allows you to graphically indicate the proper wiring sequence of a circuit directly on the schematic.

**Printable Help**

The AutoCAD Electrical Help system has been enhanced to allow you to print all or portions of the Help for reference. In the Help system, click the Contents tab, right-click on the section you would like to print (or click Print AutoCAD Electrical Help to print the entire Help system), and Select Print. In the Print
Topics dialog box, select Print the selected heading and all subtopics and press OK.

**AutoCAD Electrical Launchpad**

Use the new AutoCAD Electrical Launchpad to quickly access the Getting Started Manual, AutoCAD Electrical newsgroup, white papers, and more

**What's New in 2007 Release**

**Connector Generation**

Automatically generate a multi-pin parametric connector on the fly with the new Insert Connector command. The parametric connector build process allows you to select number of pins, spacing, and orientation to quickly create connector definitions in active drawing files without having to build or maintain a connector library of symbols. When you click Insert an outline of the connector displays for placement on the drawing. The rounded corners are the plug side of the connector, the x' indicates the connector insertion point and the arrow indicates the plug side wire direction. You can change the connector orientation before insertion using the Tab, V key, or X key on your keyboard.

New connector editing commands add to the features versatility:

- **Scoot** - (existing Scoot feature) moves the parametric connector horizontally or vertically, relative to the wires that are connected to the connector. Scoot also moves the wires and pins along the connector axis.

- **Reverse, Rotate, Stretch, Split Connector** - allow you to reverse a connector about its horizontal or vertical axis, rotate a connector about its insertion point at increments of 90 degrees, increase or decrease the connector's overall length or width, and split the connector into two separate block definitions.

- **Add, Delete, Move, Swap Connector Pins** - allow you to add, remove, or move the pins found inside of the connector.

**Parametric Twisted Pair Symbols**

The icon menus have been enhanced to include parametric twisted pair symbols. To insert a twisted pair symbol, select Components ➤ Insert
Component. On the Insert Component icon menu, click Miscellaneous ➤ Shields ➤ Twisted Pair.

**Wire Collision Avoidance**

Instead of drawing each line segment between components on your point to point drawings, simply select the two connection points and let AutoCAD Electrical do the rest. Using the existing the Insert Wire command, select a connection point on each component and your wire is automatically routed, without running through your existing geometry.

**Splices**

The new Splice tool allows you create up to two wire to wire connections per side while maintaining connectivity throughout your drawing and project.

**Wire Number Placement**

AutoCAD Electrical supports the automatic placement of new wire numbers above, below, or directly in-line with the wire. You can set the wire number placement for all new wires inserted.

You can use the new Toggle Wire Number In-Line tool to switch the wire number between in-line and the drawing default (above or below the wire). If the selected wire number is in-line, it toggles to above or below the wire based on the default Wire Number Placement setting in the Drawing Properties > Wire Numbers dialog box. If it starts as above or below, the selected wire number toggles to in-line.

**Wire Connection Improvements**

Enhancements were made to the Insert Wire command to make generating point to point drawings easier. These include:

- Temporary wire graphics change color to indicate when an electrical connection can be made.
- Wire connection points display as a green 'x' at the wire connection point attributes' insertion point.
- Wires are drawn with an angled wire connection if a wire is already connected to the selected wire connection point.
**Bend Wires**

Bend a wire into a right angle turn to avoid or add geometry using the new Bend Wire tool. When a wire is defined at a right angle, you can modify the wire and create a new right angle bend while maintaining the original wire connections to the components.

**Reposition Wire Number Leaders**

When defining wire number leaders you can type "C" at the command prompt to go into a wire leader collapse mode to collapse the wire leader back to the wire number block. You can do this immediately after inserting a leader if you determine that you don’t want the leader or you can re run the Wire Number Leader command if you want to remove the leader from existing wire numbers.

**Link to Autodesk Inventor Professional - Cable & Harness**

You can now communicate your electrical designs bi-directionally between AutoCAD Electrical and Autodesk Inventor Professional Cable & Harness. AutoCAD Electrical users can pass electrical intent information for cables and conductors to Autodesk Inventor Professional for the automated creation of a 3D harness design. Autodesk Inventor Professional users can now pass wire connectivity information to AutoCAD Electrical for the automatic creation of the corresponding 2D schematics. Employing the widely used XML language format, you can transfer design data back and forth while maintaining structure and organization.

From the XML import from Autodesk Inventor Professional into AutoCAD Electrical, you can select from a list of connectors defined in the export and then place the connectors onto a 2D drawing file. Once the connectors have been inserted onto the drawing, you can place all wire connections to all components on the drawing file. AutoCAD Electrical parses through the file data to determine all wire From and To connections. Once the wiring information is determined the wires are routed making sure to miss existing geometry on the drawing. The wire insertion tool finds the best possible route with the least amount of wire loops in between the connection and the wires are connected in the appropriate position on the connector representation.
Multi-discipline Symbol Libraries

AutoCAD Electrical now includes comprehensive symbol libraries for creating pneumatic, hydraulic, and P & ID drawings.

■ **Hydraulic Symbol Library:** AutoCAD Electrical's hydraulic symbol library includes filters, valves, cylinders, pressure switches, motors, pumps, meters, restrictors, quick disconnects, flow arrows and more, all adhering to the NFPA/T3.10.4R1-1990 and AS1101.1-1993 standards.

■ **Pneumatic Symbol Library:** AutoCAD Electrical's pneumatic symbol library includes operators, valves, flow paths, filters, regulators, cylinders, meters, motors, quick disconnects, mufflers, manifolds, flow arrows and more.

■ **P & ID Symbol Library:** AutoCAD Electrical's P&ID symbol library includes equipment, tanks, nozzles, pumps, fittings, valves, actuators, logic functions, instrumentation, flow, and flow arrows, all strictly adhering to the ANSI/ISA's S5.1 Instrumentation Standard

Real-time Error Checking

AutoCAD Electrical monitors and alerts users to potential design errors as they occur. You can locate the problem component automatically using the Surf command.

Identify and clean up problems that might affect an AutoCAD Electrical drawing using the improved Electrical Audit tool. This tool displays a report of detected problems for the active project. You can save this file for reference or surf the file to view and correct the errors.

Multiple Wire Bus

With a single command you can configure a new multiple wire bus that automatically routes from an existing multi-contact component or bus or in empty space. While you are defining the wires, temporary display graphics appear on your cursor to indicate the direction and number of wires that will be placed on the drawing file.

User Defined Attributes

Add and define your own attributes for existing AutoCAD Electrical symbols. The newly defined metadata is easily customized and can be extracted for various reports. The new User Defined Attribute List tool allows you to selectively determine which non-AutoCAD Electrical attributes are allowed in the AutoCAD Electrical report generators; otherwise only those attributes
defined inside of AutoCAD Electrical for each component category are processed in the project database and subsequent reports.

**Table style cross-referencing updates**

Tabular cross-referencing styles now function at the same level as graphical and text styles. Create customizable tables, updated your drawing in real-time and benefit from increased flexibility with the way you display cross-referencing information.

**Cross-reference updates**

Cross-reference settings are now supported at the project, drawing, and component level. During normal operation of cross-referencing commands, AutoCAD Electrical looks to the component for its settings information prior to using the drawing settings. If the component has settings defined, those are used. In the event that there are both component and drawing cross-reference settings on the same drawing, the component settings are used where applied and the drawing settings are used for the rest of the components. Use the newCopy/Add Component Override tool to set display settings for a specific component that are different than the drawing or use the new Remove Component Override tool to remove component overrides so the cross-referencing commands use the settings for the drawing.

Use the new Hide/Unhide Cross-Reference tool to change the visibility of cross-references. In most cases the cross-referencing should be visible but there are times when you may not want cross-referencing displayed on parent symbols.

**Wire Label Report**

Use the new Wire Label report to list wire and cable labels that exist in your drawing or project. The new preformatted wire label report is ready for export and can be printed on any ASCII, Microsoft Excel, Access, CSV or XML-compatible wire label printer. After the report is generated, you can still edit the format or make changes to the data before exporting to your desired file format.

**Enhanced Drawing Audit Report**

The Drawing Audit utility can be used to clean up certain problems that might affect your design connectivity. The audit checks for wire gaps, bad wire numbers or colors, zero length wires, wire number floaters, and visually verifies
all wires in your display. This report can be exported as a script file for post
processing or sent directly to a printer.

**Catalog Content Updates**

AutoCAD Electrical ships with a manufacturer's catalog database that contains
over 45,000 components from the industry’s most popular vendors. These
components provide a full spectrum of input and output devices including
switches, sensors, lights and numerous panel devices, such as wire way and
panel enclosures. In order to support our worldwide user base, the catalog
database now includes a greater number of Asia Pacific and European vendors.

**Improved Performance**

Improved memory management and script-based command reallocation have
dramatically improved the performance of AutoCAD Electrical 2007. Drawings
open more quickly, with enhanced editing and referencing speed.

**New Project Command**

Creating new projects and applying project properties is now easier using the
New Project tool. In a single dialog box you can define the minimum
requirements to create an AutoCAD Electrical project definition file (WDP),
the folder in which the project will be maintained, and the settings and options
defined within the project. The new project automatically becomes the active
project.

**New Drawing Command**

When you are faced with multiple customers or many one-off designs, the
New Drawing tool helps reduce the hassle of configuring new drawings to
specific standards. In a single dialog box you can apply a template, add drawing
name, border, drawing type, and descriptions, which are then stored and
available for future use. The new drawing then automatically becomes part
of the active project.

**Simplified wire type selection**

Managing wire properties from the Layer Manager is no longer necessary.
During wire insertion, the current wire type displays at the command prompt.
Now you can simply type in the hotkey "T" for immediate access to the Set
Wire Type dialog box where you can quickly assign the wire type. You can use this hotkey with the following commands:

- Wires > Insert Wire
- Wires > Angle Wires > Insert 22.5 Degree Wire (also 45 or 67.5)
- Wires > Multiple Wire Bus
- Wires > Add Rung
- Wires > Ladders > Insert Ladder

Use the new Create/Edit Wire Type tool to create new or edit existing wire types or use the new Change/Convert Wire Type tool to convert lines to wires.

**Simplified configuration settings**

Configuration settings have been condensed into a centralized Properties dialog box, where you can view and edit project settings, format styles and select default drawing settings for the entire project or a single drawing.

**Autodesk Productstream Integration**

You can now use Autodesk Productstream to manage AutoCAD Electrical bill of materials (BOMs) by controlling the release and change of a design using the Change Order environment. Additional enhancements include:

- Productstream now supports AutoCAD Electrical components, quantities, catalog numbers and balloon numbers.
- Productstream Explorer supports all Productstream and AutoCAD Electrical data.
- New controls in Productstream make it easier to navigate to and find AutoCAD Electrical data.

**Autodesk Vault Integration**

Autodesk Vault integration provides tools for running Vault operations on the entire project or individual drawing files listed within the project. It supports a single-user environment where the Vault working folder is local to the customer or a multiple-user environment where the Vault working folder is shared by many users on a shared network resource. Additional enhancements include:
You can now check out individual files as they are needed rather than having to check out the entire project at once while maintaining drawing file versioning.

The multi-user environment in AutoCAD Electrical now provides drawing status indicators and better control of project-wide commands when you are logged into Autodesk Vault.

You can now get previous versions of the drawing or project file.
Project Management

In this chapter

- Overview of AutoCAD Electrical Help
- Overview of projects
- About collaborative design
- Create a new drawing
- Change drawing display options
- Overview of project related files
- Overview of the project file format
- Archive a project
- Work with Multiple Clients
- Miscellaneous Reference files
Overview of AutoCAD Electrical Help

The AutoCAD Electrical Help system is a browser-based system available through context-sensitive links or by accessing it through the Help menu or icon. Key features of the Help system include:

■ The Help home page is designed for new users. It provides access to the basic Procedure topics.
■ There is on-demand access from the F1 function key, menus, dialog boxes and the menu bar.
■ Then navigation tabs in each topic link to related procedures, references, and concepts.
■ The Help menu gives you access to Design Support System (DSS) components: AutoCAD Electrical Help and AutoCAD Electrical Launchpad.

What are ways to gain access to Help?

You can get help about a command while you are using it.

Help Menu
From the menu bar, select Help ➤ Electrical Help Topics to view the AutoCAD Electrical Help home page.

Press F1
■ At the command prompt, press F1 to open the Procedure topic for the active tool.
■ In a dialog box, press F1 to open the Reference topic for the active tool.

Help button
In a dialog box, click Help to open the Reference topic for the active tool.

How is Help organized?

Most of the subjects in the Help system have three topic types: Procedure, Reference, and Concept. Every Help topic selected from a menu has a tab row
above the topic title. You can click a tab to go to the other available topic
types.

- **Procedure** topics provide step-by-step procedures for accomplishing
  AutoCAD Electrical tasks.

- **Reference** topics offer detailed descriptions of elements in the dialog box.

- **Concept** topics provide conceptual information about tools and tasks and
  may explain related concepts.

There are See Also links at the bottom of the topic that display a list of related
topics.

The titles of Help topics are designed to tell you the kind of information they
contain:

- Procedure topics start with an action word, for example, "Create projects."

- Reference topics have the names of the dialog box as their titles.

- Concept topics start with the words "Learn about."

**How do I get around in the Help system?**

When you start the Help system, the first thing you see is the AutoCAD
Electrical Help home page. This page is designed for new users and accesses
the basic Procedure topics. For a list of all the Procedure topics, you can access
the Site Map. There is an option to make the Site Map your home page.

**Navigation bar**

At the top of every Help window is a navigation bar with
icons. The left-most icon is either Show or Hide, which
opens or closes the navigation pane of the Help window.
The navigation pane has tabs for Table of Contents, Index,
Search, and Favorites.

**Table of Contents**

Presents an overview of the available documentation in a
list of topics and subtopics and provides a structure so you
can always see where you are in Help and quickly jump to
other topics. Click AutoCAD Electrical Command Listing
for an alphabetical list of AutoCAD Electrical tools found in
the menu and toolbars.
How do I learn the product?

Training programs and products from Autodesk help you learn the key technical features and improve your productivity. For the latest information about Autodesk training, visit http://www.autodesk.com/training or contact your local Autodesk office.

The Autodesk Authorized Training Center (ATC) network delivers Autodesk-authorized, instructor-led training to design professionals who use Autodesk software. Autodesk Authorized Training Centers use experienced and knowledgeable instructors. More than 1,200 ATC sites are available worldwide to meet your needs for discipline-specific, locally based training.

To find a training center near you, contact your local Autodesk office or visit http://www.autodesk.com/atc.

Use AutoCAD Electrical Help

AutoCAD Electrical has a variety of learning tools to assist you, whether you are a newcomer or an experienced CAD user.

To gain access to Help

Use any of the following methods to gain access to Help.

- Select Help ➤ Electrical Help Topics from the menu bar, and then browse to the desired topic. You can use the tabbed pane to access the Index, Search, or Table of Contents. You can also navigate through the home page and site map.
Press F1 to open the Procedure or Reference Help topic for the active command.

In an open dialog box, press F1 or click Help to open the Reference topic for the active command.

**To customize Help**

Use any of the following methods to customize Help.

- Click the Hide or Show button in the Help toolbar to control the visibility of the tabbed pane beside the content window.
- To add a topic to the Favorites tab, select a Help topic, click the Favorites tab, and then click Add. To delete a topic from the Favorites tab, select the topic in the list, and then click Delete.

**To search Help**

Another method for finding Help topics is to use the Search tab.

1. Click Show in the browser toolbar if the tabbed navigation pane is not displayed.
2. Click the Search tab.
3. Enter text in the search text box, and then click List Topics. Use quotation marks (" ") around the search criteria to search for a string. Use an asterisk (*) before or after text as a wildcard.
4. Double-click a topic or select a topic, and then click Display to show the topic.
5. You can also select one or more of the following Search options to limit the results.
   - Search previous results
   - Match similar words
   - Search titles only
6. Use operators to further refine your Search criteria. Click the right arrow next to the search text box, and then select one of the following operators.
   - **AND** Use AND to search for topics with more than one set of your search criteria.
■ **OR** Use OR to search for topics with at least one of your search criteria.

■ **NEAR** Use Near to search for specified text within close proximity to each other.

■ **NOT** Use NOT to search for topics that do not include your search criteria.

### To print Help

You can print a single file or you can print sections of the Help.

1. In the Help Contents tab, right-click on a heading and select Print.
2. Select whether to print the selected topic or the selected heading and all subheadings.

   **NOTE** You can also print a single topic by right-clicking in the file and selecting Print.

3. Click OK.

If you want to print the entire Help system, in the Contents tab, right-click on AutoCAD Electrical Help and select Print. Select the option to print the selected heading and all subheadings and click OK.

### To find out What's New about AutoCAD Electrical

What's New topics describe the new functionality in the most recent AutoCAD Electrical release.

1. Click Help ➤ AutoCAD Electrical Help. In the AutoCAD Electrical Help, click What's New from the navigation bar.

   You can also open the What's New by selecting Help ➤ Display Launchpad. Click What's New on the AutoCAD Electrical Launchpad.

2. Browse to a feature you want to learn about.
3. Click More Information to learn more about the feature.

### To get started with AutoCAD Electrical using Getting Started

1. Select Help ➤ Display Launchpad.
The AutoCAD Electrical Launchpad screen appears. The Launchpad has two sections. The top section is for first-time users. It has links to white papers, the Getting Started manual, the AutoCAD Electrical newsgroup, and frequently asked questions. The bottom section has links to places for additional information about AutoCAD Electrical. You can find out what's new in the current release, link to the Advanced Productivity home page, and find out more about additional Autodesk products.

2 Click Getting Started Manual on the AutoCAD Electrical Launchpad.

Overview of projects

A project is a set of interrelated wiring diagram drawings. An ASCII text file, called the project file, lists the AutoCAD drawing file names that make up the wiring diagram set. You can have as many projects as you wish, but only one project can be active at a time.

An AutoCAD Electrical project file:

- Is an ASCII text file with any path and any name followed by the .WDP extension.
- Lists the complete path to each wiring diagram drawing included in the project.
- Carries default settings that can be referenced when new drawings are created and added to the project.

NOTE A project file is not needed if the project consists of a single wiring diagram drawing.

Project files default to the directory pointed to by your project subdirectory (given by the WD_PROJ setting in your environment file). This is not mandatory. When you create a project file, you can save it to any subdirectory. In some cases you may want to store them in client-specific subdirectories to take advantage of the AutoCAD Electrical ability to access client-specific catalog files and library symbols.

Use recently opened projects

The Project Manager displays a list of recently opened projects so you can easily select another project to open without having to browse for it. The project list is dynamic with the last project you worked on appearing at the
The list of recent projects is saved in a text file called lastproj.fil in the user subdirectory (Documents and Settings\username\Application Data\Autodesk\AutoCAD Electrical\release #\{country code\}\Support\User).

Each line in this file gives the information for one project. The last piece of data in the line identifies what the project state will be when AutoCAD Electrical is started: "2"=Active, "1"=listed as Open, "0"=not listed in window but available from the Recent Projects dialog box. If you adjust this file, either manually with a text editor or programmatically (see the AutoCAD Electrical API Help), you can control what project will be active when AutoCAD Electrical starts up and what other projects will be shown in the Project Manager window.

**Work with projects**

Use the Project Manager to create a new project, access an existing project, add drawings to a project, or modify existing information associated with a project.
Create a new project

1. Click the Project Manager tool.

2. On the Project Manager, click the New Project button.

   **NOTE** You can also create a new project by right-clicking at the bottom of the tree inside the Project Manager and selecting New Project or by clicking the arrow on the Project Selection menu and selecting New Project.

3. In the Create New Project dialog box, enter the name for the new project. The .WDP extension is automatically added to the filename.

4. Select or create the directory where you want to save the project.

5. (Optional) Specify the an existing project file (WDP) to use. Use the default or click Browse to select a previously-defined project definition file.

6. (Optional) Click Descriptions to enter descriptions for the project. You can enter up to 12 description lines per page. You can also select the checkboxes for the information to be included in reports generated for the project.

7. (Optional) Click OK-Properties to modify your project default settings for project settings, components, wire numbering, cross-references, styles, and drawing formats. All information defined in these tabs is saved to the project definition file as project and drawing defaults.

8. Click OK.

Add a new drawing to the current project

1. Click the Project Manager tool.
2 On the Project Manager, click the New Drawing button.

3 Create a new drawing (page 63) and click OK.

4 In the Project Manager, right-click the project name and select Add Active Drawing. The drawing is added to the end of the existing list.

**Add existing drawings to the current project**

1 Click the Project Manager tool.

2 In the Project Manager, right-click the project name, and select Add Drawings.

3 In the Select Files to Add dialog box, select the drawings to be added to the current project. You can select multiple drawings using the Shift or Control keyboard keys.

**NOTE** The order in which you select drawings determine how they will be listed in the project drawing list.

4 Click Add.

   The drawings are added to end of the project drawing list.

**Copy a project**

Copy a project file and create copies of one or more drawings in the project.

1 Click the arrow on the Project Manager tool to access the Copy Project tool.

2 Click the Copy Project tool.
3 Enter the name of the project to copy.

**NOTE** All drawings must be closed before they can be copied to a new project.

- Click Copy active project to copy the current project.
- Click Browse to select a project to copy.

4 Click OK.

5 Select the directory where you want to save the new project.

6 Enter the name for the new project. The .WDP extension is automatically added to the filename.

7 Click Save.

8 Select one or more drawings to copy to the new project.

- **Do All:** Selects all drawings from the project drawing list to be copied to the new project.
- **Process:** Selects one or more drawings from the project drawing list to be copied to the new project.
- **Reset:** Moves all selected drawings back to the project drawing list.
- **Un-select:** Moves one or more drawings back to the project drawing list.
- **by Section/sub-section:** Selects drawings by sections and subsections.

9 Click OK.

10 Enter the directory path where the new project will be saved. If the directory does not exist, it will be created.

11 Select the project-related files to be copied. (see list below)

12 Click OK.

13 Modify the new drawing file names if necessary.

14 Click OK. The new project becomes the current project.
**Project-related files to be copied**

On the Copy Project: Step 4 -- Enter Base Path for Project Drawings dialog box you can select the project-related files to be copied to the new path. Options include:

- Title block setup (.wdt)
- Project line labels (.wdl)
- Component description defaults (.wdd)
- Catalog lookup database (cat.mdb)
- Footprint lookup database (lookup.mdb)
- Family code mapping (wd_fam.dat)
- Wire color/gauge label (.wdw)
- Schematic lookup database (schematic_lookup.mdb)
- Location codes (.loc)
- Installation codes (.inst)
- Ratings defaults (.wdr)
- Component tagging (.wdx)
- Spreadsheet PLC I/O Utility settings (.wdi)
- RSLogix import mapping (.wdf)
- User defined attributes (.wda)
- Terminal audit filter (.wdn)

**Work with project drawings**

Use the Project Manager to access an existing project and modify its associated information.

**Group drawings within a project**

You can create groups of drawings within your project list by assigning sections and subsection codes to each drawing. The AutoCAD Electrical project-wide tagging, cross-referencing, and reporting functions can then operate on the
whole project (default) or, using this section/subsection coding, on just a portion of the drawing set.

1. Click the Project Manager tool.
2. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.
3. In the Drawing Properties dialog box, click the Settings (page 114) tab.
4. In the Sheet Values section, enter a section or subsection code for the drawing.
5. Click OK.
   Repeat for each drawing you want to group together, making sure to assign the same section or subsection code to each.

**Change the order of drawings in the project**

The order in which drawings appear in the project's drawing list is the order in which AutoCAD Electrical processes them in project-wide tagging and
cross-referencing operations. You can change the drawing order using the Reorder Drawings tool.

1. Click the Project Manager tool.
2. In the Project Manager, right-click the project name, and select Reorder Drawings.
3. Find and highlight the drawing you want to move in the list.
4. Click Move Up or Move Down repeatedly until the drawing moves to the appropriate position in the list.
5. Click OK.

**Remove a drawing from the active project**

1. Click the Project Manager tool.
2. In the Project Manager, right-click the drawing name, and select Remove.
   The drawing is instantly removed from the project but it is not deleted.

**NOTE** You can remove all drawings from a project by right-clicking the project name in the Project Manager, and selecting Remove Drawings. Select the drawings to remove from the Select Drawings to Process dialog box, and click OK.

**Assign a description to each drawing**

You can assign a 3-line description to each drawing listed in your project. You can then toggle the project drawing list back and forth between drawing preview and drawing details. Flipping the drawing list to display the drawing
details can make it easier to find a specific drawing among dozens or hundreds in a project file.

1 Click the Project Manager tool.
2 In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.
3 In the Drawing Properties ➤ Settings (page 114) dialog box, enter a description for the drawing.
   Select from a list of predefined descriptions from the active project by clicking the arrow.
4 Click OK.

**TIP** These descriptions can be linked to an attribute in the title block for automatic update.

**Preview a drawing**

You can preview a drawing from the Project Manager.

1 Click the Project Manager tool.
2 In the Project Manager, select a drawing from the list.
3 In the Details pane, click Preview.
   An image of the highlighted drawing displays. Once selected, the preview remains on. Each time you highlight another drawing in the project list the display updates with an image of the selected drawing.
4 Click Details to return to the drawing description for the drawings.

**Pick a different project**

AutoCAD Electrical displays a list of recently opened projects so you can easily select another project to open without having to browse for it. The project list is dynamic with the last project you worked on appearing at the top of
the list. The list of recent projects is saved in a text file called lastproj.fil in
the user subdirectory.

1 Click the Project Manager tool.
2 In the Project Manager, click the arrow on the Project Selection
menu, and select Recent.
3 In the Recent Projects dialog box, select the project from the
list.
4 Click Drawings to see a list of the drawings in the selected
project.
   In the Project Drawings dialog box, double-click a drawing
   name to see a preview of that drawing. Click Pick Project, Open
   Drawing to make the selected project the active project and
   open the selected drawing or click Back to return to the Recent
   Projects dialog box.
5 (Optional) Click Remove to remove a project from the project
   list.
6 Click OK.
   The selected project becomes the active project.

NOTE If you know the drawing name but you aren’t sure what project the drawing
is in, click Find in the Recent Projects dialog box. In the Find Drawing in Recent
Projects dialog box, enter the name of the drawing (wildcards are accepted) and
click Find. Once a list of possible projects is presented, select the project name
and click Drawing List to see a list of the drawings contained in the project.
   Double-click the drawing name in the list to preview the drawing. Click Pick Project,
   Open Drawing to activate the project and open the selected drawing.

Project manager
This tool lists the drawing files associated with each open project. Use it to
add new drawings, reorder drawing files, and change project settings. You
cannot have two projects open in the Project Manager with the same project
name.

You can dock the Project Manager into a specific location on the screen or
hide it until you want to use the project tools. Right-click the properties icon
to display options to move, size, close, dock, hide, or set the transparency for the Project Manager.

Access:

- Click the Project Manager tool.
- Click Projects ➤ Project ➤ Project Manager.

Right-click menu

You can right-click in empty space in the Project Manager to display the following options:

- **New Project**
  - Creates a new project. Once created, the new project automatically becomes the active project.

- **New Drawing**
  - Creates a new drawing file and adds it to the active project. The new drawing displays at the bottom of the project drawing list for the active project.

Project Selection menu

You can default to a predefined directory by adding an entry to your .env file. Exit AutoCAD and open the .env file with any generic text editor (such as Wordpad). Add this line:

```
WD_PICKPRJDLG, n://(your directory)/, AutoCAD Electrical default pick proj
```

- **Recent**
  - Opens a different project from a list of recent projects or from a file selection dialog box.

- **New Project**
  - Creates a new project. Once created, the new project automatically becomes the active project.

- **Open Project**
  - Opens a different project from a file selection dialog box. In the Select Project File dialog box, navigate to the project to open and select it.
Open Project from Vault (you must be logged into the vault) Allows you to browse to the vault to open a project and make it active inside of the Project Manager. In the Select Project dialog box, navigate to the project to open and select it. Click the arrow next to the Open button and select one of the following options: Open (Check Out), Open (Check Out All), or Open Read-Only.

Buttons

New Project

Creates a new project. Once created, the new project automatically becomes the active project.

New Drawing

Creates a new drawing file and adds it to the active project.

Refresh

Refreshes the drawing list inside of the Project Manager.

For Vault: Checks for changes in external file references and updates the Vault icons in the Project Manager. Files that have changed and are currently checked out to you are not updated. Files that are checked out to another user are updated to their current version. Files that are checked out to another user are updated to their current version on your local drive. If the Vault version is newer, then the Vault icon indicates that the file needs reloading (the Vault icon turns red).

Project Task List

Performs pending updates on any drawing files inside of the active project that have been modified.
**Project-Wide Update/Retag**
Updates the related line reference numbers, cross-reference text, device tagging, and signal reference updates on the selected drawing files inside of the active project.

**Drawing List Display Configuration**
Configures the display options. There are 10 values that can be associated with the drawings listed so you can display the information based on your requirements.

**Publish/Plot**
Batch plots one or more drawings in the active project.

**Projects**
Displays all the open projects in a list. You can have as many projects open as you need, but only one project can be active at a time. The active project appears in bold text and is always found at the top of the list. Right-click the project name to display the following project editing options:

- **Descriptions**
  Edits the existing project descriptions. Displays unlimited lines describing the project. Descriptions can then be included in report headers and title blocks.

- **Title Block Update**
  Automates updating title block information for the active drawing or for the entire project drawing set.

- **Drawing List Report**
  Generates a report that lists project drawing information from the title blocks such as drawing descriptions, section, and file names. On the Drawing List Report dialog box, select to run a new report, redisplay the previously-run report or select a format .set file to use for the report.

- **New Drawing**
  Creates a new drawing file and adds it to the active project.

- **Add Drawings**
  Adds one or more drawings to the active project. When prompted, specify whether to apply the project default values to the drawing settings (in the WD_M block definition).
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Active Drawing</td>
<td>Adds an active drawing to the active project. The new drawing appears at the end of the project drawing list. When prompted, specify whether to apply the project default values to the drawing settings (in the WD_M block definition).</td>
</tr>
<tr>
<td>Reorder Drawings</td>
<td>Moves drawings up or down in the project's drawing list. The order determines how the drawings are processed for project-wide tagging and cross-referencing operations.</td>
</tr>
<tr>
<td>Remove Drawings</td>
<td>Removes one or more drawings from the current project.</td>
</tr>
<tr>
<td>Task List</td>
<td>Performs pending updates on any drawing files inside of the active project that have been modified.</td>
</tr>
<tr>
<td>Publish</td>
<td>Launches dialog boxes to plot the project, publish to the Web, publish to DWF, or create a zip file of the project.</td>
</tr>
<tr>
<td>Settings</td>
<td>Displays the project's settings and information about the AutoCAD Electrical environment.</td>
</tr>
<tr>
<td>Exception List</td>
<td>Displays a list of drawing file(s) that have different settings from the project definition file (*.WDP). If all drawing files match the .wdp, the dialog box indicates that there are no exceptions. You can then use the Settings Compare tool to display the differences.</td>
</tr>
<tr>
<td>Properties</td>
<td>Controls project-wide settings including tagging, component cross-referencing options, and catalog lookup file preferences.</td>
</tr>
<tr>
<td>Activate</td>
<td>Makes an open project the active project in the AutoCAD Electrical session. This also sends the project list to the top of the dialog.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes an open project.</td>
</tr>
</tbody>
</table>

**NOTE** You cannot close the active project; you must first activate another project in the list.
You must be logged into the vault to see this menu in the Project Manager. The status of the selected object determines which vault commands are available for selection.

<table>
<thead>
<tr>
<th>Vault</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check In All</td>
<td>Adds the project definition file (*.wdp) along with its drawing files to the vault. You can vault just the project file using the Project Check In command or you can vault the project file along with its drawing files using the project Check In All command.</td>
</tr>
<tr>
<td></td>
<td>NOTE Files used to support the project (such as *.wdl and *.wdf) appear in the Vault Check In All dialog box if they share the same file name as the project.</td>
</tr>
<tr>
<td>Check Out All</td>
<td>Reserves and locks the project definition file along with the associated drawing files listed in the Project Manager. If the project definition file is unavailable for check out, you can still check out the drawings available for editing.</td>
</tr>
<tr>
<td>Check In</td>
<td>Adds the project definition file to the vault and creates a new version of the file. Use this if you want to check in only the project definition file and none of its drawing file dependencies; otherwise use Check In All.</td>
</tr>
<tr>
<td></td>
<td>NOTE Files used to support the project (such as *.wdl and *.wdf) will appear in the Vault Check In dialog box if they share the same file name as the project.</td>
</tr>
<tr>
<td>Check Out</td>
<td>Reserves and locks the master project definition file. Retrieves an updated copy, if necessary. Use this if you want</td>
</tr>
</tbody>
</table>
to check out only the project definition file and none of its drawing file dependencies; otherwise use Check Out All.

**Undo Check Out/Undo Check Out All**

Removes the reservation/lock from the master project definition file. The master file is now available for others to check out. Any modifications made to the local copy are not checked back into the vault. Undo Check Out All removes the lock from all of the checked out drawing files and project definition file listed inside of the Project Manager for the selected project.

**Get Latest/Get Latest All**

Retrieves the latest master copy from the vault and copies it into your working folder. Older files are indicated by the status indicator displaying a red background.

### Project Drawing List

Displays the drawings associated with a project. You can select multiple drawings from the project list to open, close, remove, apply project defaults, or paste properties all at once. You cannot select multiple drawings from two or more projects. The active drawing appears in bold text in the list. By default, the selected drawing highlights in the project drawing list regardless if the Project Manager is active or not. You can turn this off by clicking the Drawing List Display Configuration button and selecting Show selection highlight only when active.

Indicates that the file is a drawing file.
Indicates that a drawing file is a reference drawing. To make a drawing a reference drawing, right-click on the drawing name and select Properties ➤ Drawing Properties.

Right-click the drawing name to display the following drawing editing options:

- **Open**
  Opens the selected drawing in a new window. You can also double-click a drawing name or select a drawing name and press Enter to open the drawing.

- **Close**
  Closes the selected drawing.

- **Copy To**
  Copies the selected drawing into the same or another open project. Select the folder to copy the drawing to, enter a new file name and select the project to save the drawing to. When prompted, specify whether to apply the project default values to the drawing settings (in the WD_M block definition).

- **Remove**
  Removes the selected drawing from the current project.

- **Replace**
  Replaces the selected drawing with one that you select from a file selection dialog box.

- **Rename**
  Renames the selected drawing directly in the drawing list.

- **Drawing Properties**
  Assigns, edits, and removes section and subsection coding for a drawing. Assigns drawing descriptions to the drawing files.

- **Apply Project Defaults**
  Applies project settings to new drawing files where the project default settings for the drawing(s) were not applied at creation time.

- **Copy**
  Copies the drawing settings and options from one drawing to be applied to one or more drawing(s).
### NOTE
Drawing-specific information (found on the Drawing Properties ➤ Drawing Settings tab) cannot be copied from one drawing to another.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste</td>
<td>Applies the copied drawing settings and options from one drawing to the selected drawing(s).</td>
</tr>
<tr>
<td>Settings Compare</td>
<td>Displays differences between all drawing settings and their associated defaults in the project definition file.</td>
</tr>
<tr>
<td>Check In</td>
<td>(you must be logged into the vault) Adds a file to the vault and creates a new version of the file. For a first time check in of a drawing file, the project definition file is forced to be checked in at the same time since it needs to be vaulted first to establish a location in the Vault database.</td>
</tr>
<tr>
<td>Check Out</td>
<td>(you must be logged into the vault) Reserves and locks the master drawing file. Retrieves an updated copy, if necessary. Checks out the drawing files when the project file is under Vault control.</td>
</tr>
<tr>
<td>Undo Check Out</td>
<td>(you must be logged into the vault) Removes the reservation/lock from the master drawing file. The master file is now available for others to check out. Any modifications made to the local copy are not checked back into the vault.</td>
</tr>
<tr>
<td>Get Latest</td>
<td>(you must be logged into the vault) Retrieves the latest master copy from the vault and copies it into your working folder. Older files are indicated by the status indicator displaying a red background.</td>
</tr>
</tbody>
</table>

### NOTE
Two projects can reference the same drawing file, however doing so can lead to conflicts if both projects try to modify the same drawing with a project-wide tagging or cross-referencing function.

#### Details
Switches between displaying drawing previews and drawing descriptions. The drawing details are updated when you highlight a drawing file and remain
visible until a new drawing file is selected. Use the up and down arrow keys on your keyboard to switch drawings.

**Details**
Display project and drawing detail based on what is highlighted in the Project pane. Information that is listed includes the status, file name, file location, file size, last saved date, and the name of the last user who modified the file.

**Preview**
Display the last saved thumbnail view for the highlighted drawing in the drawing list.

**Vault Status Icons**
(you must be logged into the vault) The Vault Status Icons indicate the status of your local copy of the files as compared against the master copy of those same files in the vault.

The Vault Status indicate when the local copy is in sync with the master and when it’s not. The tooltips help guide you to the next logical steps - especially when the local copy is no longer in sync with the master. These icons are crucial to the overall understanding of how to work in a vaulted environment.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Untitled-1" /></td>
<td>File is not in the vault.</td>
</tr>
<tr>
<td><img src="image" alt="Untitled-2" /></td>
<td>File is in the vault in a checked-in state, and the version you are working on is the same as in the vault. Also referred to as the Latest Version.</td>
</tr>
<tr>
<td><img src="image" alt="Untitled-3" /></td>
<td>File is in the vault in a checked-in state, but the version you are working on is newer than the master file in the vault. This typically means that your local file was changed without checking it out. The blank icon indicates that the master file is available for check out. If you want to save these changes, check the file out, and then select the Don’t get local copy option.</td>
</tr>
<tr>
<td><img src="image" alt="Untitled-4" /></td>
<td>File is in the vault in a checked-in state, but the version you are working on is older than the latest version in the vault. This typically means that another user made changes since your last update. Use Reload to update to the latest available version.</td>
</tr>
</tbody>
</table>
The master file is checked out to you and the version you are working on is the same as in the vault.

File is checked out to you, but the version you are working on is newer than the latest version in the vault. This typically means that you made changes to the model since the last time you checked out the file, but have not checked it back in.

File is checked out to you, but the version you are working on is older than the master file in the vault. This typically means that you started with a version for the vault that was older than the latest, and checked it out to promote it to the latest.

File is checked out to another user, and the version you are working on is the same as in the vault. Also referred to as the Latest Version. This typically happens if the other user did not check changes back into the vault.

File is checked out to another user, and the version you are working on is newer than the file in the vault. This typically happens if the user checked in changes to the vault, but kept the file checked out. Use Refresh from Vault to update to the latest available version.

File is checked out to another user, but the version you are working on is older than the latest version in the vault, and another user checked out this file. Use Refresh from Vault to update to the latest available version.

File is locked and the local copy of the file is the same as the master file in the vault.

File is locked and the local copy of the file is newer than the master file in the vault.

File is locked and the local copy of the file is older than the master file in the vault.

Create new project
Use this to define the minimum requirements to create an AutoCAD Electrical project definition file (WDP), the folder in which the project is maintained, and the settings and options defined within the project.

**Access:**

On the Project Manager, click the New Project button or select New Project from the Project Selection menu.

From the Projects menu, select Project ➤ Project Manager. Click the New Project button or select New Project from the Project Selection menu.

**NOTE** You can also create a new project by right-clicking at the bottom of the tree inside the Project Manager, and selecting New Project.

<table>
<thead>
<tr>
<th>Name</th>
<th>Specifies the name for the new project. A name must be entered in order to define any of the project properties.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>NOTE</strong> The .wdp extension is not required in the edit box.</td>
</tr>
<tr>
<td>Location</td>
<td>Specifies the location for a project definition file and folder definition. If left blank, the project definition file is created at the WD.ENV project location. Click Browse to pick a folder where the new project file/folder will be created.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> You cannot have duplicate project names in the same location.</td>
</tr>
<tr>
<td>Create Folder with Project Name</td>
<td>Creates a folder with the same name as the project where the drawing files and project definition are stored. The folder is created following the path defined in the project location edit box.</td>
</tr>
<tr>
<td>Copy Settings from Project File</td>
<td>Specifies the project settings. You can select a previously-defined project setting and apply it to your new project definition file. Click Browse to select a previously defined project definition file to copy over and apply settings to the new project being created.</td>
</tr>
</tbody>
</table>
**Specifications**

Specifies the project descriptions. Descriptions can be included in report headers and title blocks.

**OK-Properties**

Creates the project definition file in the specified location before opening the Project Properties dialog box where you can define default settings and options for your project which are saved in the project definition file.

### Copy project: step 1 - select existing project to copy

**Access:**

Click the arrow on the Project Manager tool to access the Copy Project tool.

From the Projects menu, select Project ➤ Copy Project.

**NOTE** If the active drawing is one of those to be copied to a new project, cancel out of the dialog box, open a new drawing, and then restart the Copy Project command.

**Copy Active Project**

Copies the active project.

**Browse**

Selects another project to copy.

### About collaborative design

In a collaborative design environment, several people can work on a project at the same time. The project file (.WDP) lists all the drawings that are part of a project. You can use Autodesk Vault with AutoCAD Electrical for drawing management, version control, and revision labeling.

You must install Autodesk Vault to vault projects. Autodesk Vault prevents engineers from working on the original version of a project in the vault. To maintain the relationship between the drawing files that are defined in the project file, you must check out all files specified in a project file when you need to modify one or more files. When edits are complete, the project can be checked back into the vault.

50 | Chapter 2  Project Management
AutoCAD Vault ARX adds vaulting functionality to the Project Manager. Upon initial start-up of AutoCAD Electrical you are not logged into the vault. You must log into Autodesk Vault using the File ➤ Vault menu to vault projects. The vault commands are available by right-clicking a project or drawing within the AutoCAD Electrical Project Manager. You can use the Project Manager to:

■ Check projects in and out of the vault
The most basic requirement of the vault is that you never work directly on a file in the vault. The projects in the vault are the Masters and cannot be edited. You must check out the project to the working folder on your local drive to edit it. When you finish working on the project, you must check the project back into the vault.

**TIP** If you want others to view updates you made to a project and you want to continue modifying the project, select the Keep Checked Out option on the Check In dialog box. This checks in the updates you made to the project and keeps the project checked out to you.

**NOTE** You must have all references of a project file downloaded to your working folder to edit the project file.

■ View the status of files in a design.
Vault status icons indicate the status of your local copy of the files as compared against the master copy of those same files in the vault. The vault status icons indicate when the local copy is in sync with the master and when it is not. Tooltips provide descriptions of the icons. Pause the cursor over a status icon to see a detailed description. The tooltips also help guide you to the next logical steps, especially when the local copy is no longer in sync with the master. The vault status icons are crucial to the overall understanding of how to work in a vaulted environment.

**NOTE** The vault status icons are only available in the list view and only appear when you are logged into the vault.

**Key Concepts**

■ The master files are stored and maintained in the file store on the Vault server. The vault database is also located on the server. It can be on the same or a different server from where the file store is located. The database maintains the metadata for the files in the file store and the relationships between those files.
The vault is referred to as the virtual location of the files. Users do not work directly on the master files. A file must be checked out from the virtual location in the vault to a physical location in the working folder before it can be modified.

Each user must have a physical location on their disk mapped to the corresponding vault location. A folder that has been mapped to the root folder ("\$") in a vault is called a working folder. Each Vault user can optionally set a local working folder (physical location on disk) for the root of the vault or just rely on the default one (C:\My Documents\Vault) provided by Vault. Setting up a working folder creates a user-defined virtual-to-physical mapping that is maintained for as long as the user works with the vault. The working folder can be changed, but the mapping itself cannot be removed.

When you check out a project, that project is copied from the virtual location in the vault to the physical location in the working folder. When you are ready to check the project back in, the mapping tells the vault where to check the files in from.

Opening a project from the vault checks all files out to the working folder of the Vault user. In addition, you can open a file in a checked-in state as read-only.

The essential rules to remember when working with AutoCAD Electrical Vault ARX are:

- The projects in the vault are the masters.
- You can check a project or a single drawing out of the vault to modify it.
- To check out a project for editing you must set up a working folder on the disk.

Refer to the Managing Your Data book for more information on AutoCAD Electrical Vault ARX.

**Project manager**

This tool lists the drawing files associated with each open project. Use it to add new drawings, reorder drawing files, and change project settings. You cannot have two projects open in the Project Manager with the same project name.

You can dock the Project Manager into a specific location on the screen or hide it until you want to use the project tools. Right-click the properties icon
to display options to move, size, close, dock, hide, or set the transparency for the Project Manager.

Access:

Click the Project Manager tool.

Click Projects ➤ Project ➤ Project Manager.

**Right-click menu**

You can right-click in empty space in the Project Manager to display the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Project</td>
<td>Creates a new project. Once created, the new project automatically becomes the active project.</td>
</tr>
<tr>
<td>New Drawing</td>
<td>Creates a new drawing file and adds it to the active project. The new drawing displays at the bottom of the project drawing list for the active project.</td>
</tr>
</tbody>
</table>

**Project Selection menu**

You can default to a predefined directory by adding an entry to your .env file. Exit AutoCAD and open the .env file with any generic text editor (such as Wordpad). Add this line:

`WD_PICKPRJDLG, n:/{your directory}/, AutoCAD Electrical default pick proj`

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recent</td>
<td>Opens a different project from a list of recent projects or from a file selection dialog box.</td>
</tr>
<tr>
<td>New Project</td>
<td>Creates a new project. Once created, the new project automatically becomes the active project.</td>
</tr>
<tr>
<td>Open Project</td>
<td>Opens a different project from a file selection dialog box. In the Select Project File dialog box, navigate to the project to open and select it.</td>
</tr>
</tbody>
</table>
Open Project from Vault
(you must be logged into the vault) Allows you to browse to the vault to open a project and make it active inside of the Project Manager. In the Select Project dialog box, navigate to the project to open and select it. Click the arrow next to the Open button and select one of the following options: Open (Check Out), Open (Check Out All), or Open Read-Only.

Buttons

New Project
Creates a new project. Once created, the new project automatically becomes the active project.

New Drawing
Creates a new drawing file and adds it to the active project.

Refresh
Refreshes the drawing list inside of the Project Manager. For Vault: Checks for changes in external file references and updates the Vault icons in the Project Manager. Files that have changed and are currently checked out to you are not updated. Files that are checked out to another user are updated to their current version. Files that are checked out to another user are updated to their current version on your local drive. If the Vault version is newer, then the Vault icon indicates that the file needs reloading (the Vault icon turns red).

Project Task List
Performs pending updates on any drawing files inside of the active project that have been modified.
Project-Wide Update/Retag

Updates the related line reference numbers, cross-reference text, device tagging, and signal reference updates on the selected drawing files inside of the active project.

Drawing List Display Configuration

Configures the display options. There are 10 values that can be associated with the drawings listed so you can display the information based on your requirements.

Publish/Plot

Batch plots one or more drawings in the active project.

Projects

Displays all the open projects in a list. You can have as many projects open as you need, but only one project can be active at a time. The active project appears in bold text and is always found at the top of the list. Right-click the project name to display the following project editing options:

Descriptions

Edits the existing project descriptions. Displays unlimited lines describing the project. Descriptions can then be included in report headers and title blocks.

Title Block Update

Automates updating title block information for the active drawing or for the entire project drawing set.

Drawing List Report

Generates a report that lists project drawing information from the title blocks such as drawing descriptions, section, and file names. On the Drawing List Report dialog box, select to run a new report, redisplay the previously-run report or select a format .set file to use for the report.

New Drawing

Creates a new drawing file and adds it to the active project.

Add Drawings

Adds one or more drawings to the active project. When prompted, specify whether to apply the project default values to the drawing settings (in the WD_M block definition).
### Add Active Drawing
Adds an active drawing to the active project. The new drawing appears at the end of the project drawing list. When prompted, specify whether to apply the project default values to the drawing settings (in the WD_M block definition).

### Reorder Drawings
Moves drawings up or down in the project's drawing list. The order determines how the drawings are processed for project-wide tagging and cross-referencing operations.

### Remove Drawings
Removes one or more drawings from the current project.

#### NOTE
The drawing file is not deleted, just the reference to the drawing.

### Task List
Performs pending updates on any drawing files inside of the active project that have been modified.

### Publish
Launches dialog boxes to plot the project, publish to the Web, publish to DWF, or create a zip file of the project.

### Settings
Displays the project's settings and information about the AutoCAD Electrical environment.

### Exception List
Displays a list of drawing file(s) that have different settings from the project definition file (*.WDP). If all drawing files match the .wdp, the dialog box indicates that there are no exceptions. You can then use the Settings Compare tool to display the differences.

### Properties
Controls project-wide settings including tagging, component cross-referencing options, and catalog lookup file preferences.

### Activate
Makes an open project the active project in the AutoCAD Electrical session. This also sends the project list to the top of the dialog.

### Close
Closes an open project.

#### NOTE
You cannot close the active project; you must first activate another project in the list.
Vault
You must be logged into the vault to see this menu in the Project Manager. The status of the selected object determines which vault commands are available for selection.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check In All</td>
<td>Adds the project definition file (*.wdp) along with its drawing files to the vault. You can vault just the project file using the Project Check In command or you can vault the project file along with its drawing files using the project Check In All command.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> Files used to support the project (such as *.wdl and *.wtd) appear in the Vault Check In All dialog box if they share the same file name as the project.</td>
</tr>
<tr>
<td>Check Out All</td>
<td>Reserves and locks the project definition file along with the associated drawing files listed in the Project Manager. If the project definition file is unavailable for check out, you can still check out the drawings available for editing.</td>
</tr>
<tr>
<td>Check In</td>
<td>Adds the project definition file to the vault and creates a new version of the file. Use this if you want to check in only the project definition file and none of its drawing file dependencies; otherwise use Check In All.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> Files used to support the project (such as *.wdl and *.wtd) will appear in the Vault Check In dialog box if they share the same file name as the project.</td>
</tr>
<tr>
<td>Check Out</td>
<td>Reserves and locks the master project definition file. Retrieves an updated copy, if necessary. Use this if you want</td>
</tr>
</tbody>
</table>

About collaborative design | 57
to check out only the project definition file and none of its drawing file dependencies; otherwise use Check Out All.

**Undo Check Out/Undo Check Out All**

Removes the reservation/lock from the master project definition file. The master file is now available for others to check out. Any modifications made to the local copy are not checked back into the vault.

Undo Check Out All removes the lock from all of the checked out drawing files and project definition file listed inside of the Project Manager for the selected project.

**Get Latest/Get Latest All**

Retrieves the latest master copy from the vault and copies it into your working folder. Older files are indicated by the status indicator displaying a red background.

### Project Drawing List

Displays the drawings associated with a project. You can select multiple drawings from the project list to open, close, remove, apply project defaults, or paste properties all at once. You cannot select multiple drawings from two or more projects.

The active drawing appears in bold text in the list. By default, the selected drawing highlights in the project drawing list regardless if the Project Manager is active or not. You can turn this off by clicking the Drawing List Display Configuration button and selecting Show selection highlight only when active.

Indicates that the file is a drawing file.
Indicates that a drawing file is a reference drawing. To make a drawing a reference drawing, right-click on the drawing name and select Properties ➤ Drawing Properties.

Right-click the drawing name to display the following drawing editing options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens the selected drawing in a new window. You can also double-click a drawing name or select a drawing name and press Enter to open the drawing.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the selected drawing.</td>
</tr>
<tr>
<td>Copy To</td>
<td>Copies the selected drawing into the same or another open project. Select the folder to copy the drawing to, enter a new file name and select the project to save the drawing to. When prompted, specify whether to apply the project default values to the drawing settings (in the WD_M block definition).</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the selected drawing from the current project.</td>
</tr>
<tr>
<td>Replace</td>
<td>Replaces the selected drawing with one that you select from a file selection dialog box.</td>
</tr>
<tr>
<td>Rename</td>
<td>Renames the selected drawing directly in the drawing list.</td>
</tr>
<tr>
<td>Drawing Properties</td>
<td>Assigns, edits, and removes section and subsection coding for a drawing. Assigns drawing descriptions to the drawing files.</td>
</tr>
<tr>
<td>Apply Project Defaults</td>
<td>Applies project settings to new drawing files where the project default settings for the drawing(s) were not applied at creation time.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the drawing settings and options from one drawing to be applied to one or more drawing(s).</td>
</tr>
</tbody>
</table>
NOTE  Drawing-specific information (found on the Drawing Properties ➤ Drawing Settings tab) cannot be copied from one drawing to another.

Paste
Applies the copied drawing settings and options from one drawing to the selected drawing(s).

Settings Compare
Displays differences between all drawing settings and their associated defaults in the project definition file.

Check In
(you must be logged into the vault) Adds a file to the vault and creates a new version of the file. For a first time check in of a drawing file, the project definition file is forced to be checked in at the same time since it needs to be vaulted first to establish a location in the Vault database.

Check Out
(you must be logged into the vault) Reserves and locks the master drawing file. Retrieves an updated copy, if necessary. Checks out the drawing files when the project file is under Vault control.

Undo Check Out
(you must be logged into the vault) Removes the reservation/lock from the master drawing file. The master file is now available for others to check out. Any modifications made to the local copy are not checked back into the vault.

Get Latest
(you must be logged into the vault) Retrieves the latest master copy from the vault and copies it into your working folder. Older files are indicated by the status indicator displaying a red background.

NOTE  Two projects can reference the same drawing file, however doing so can lead to conflicts if both projects try to modify the same drawing with a project-wide tagging or cross-referencing function.

Details
Switches between displaying drawing previews and drawing descriptions. The drawing details are updated when you highlight a drawing file and remain
visible until a new drawing file is selected. Use the up and down arrow keys on your keyboard to switch drawings.

**Details**
Displays project and drawing detail based on what is highlighted in the Project pane. Information that is listed includes the status, file name, file location, file size, last saved date, and the name of the last user who modified the file.

**Preview**
Displays the last saved thumbnail view for the highlighted drawing in the drawing list.

**Vault Status Icons**

(you must be logged into the vault) The Vault Status Icons indicate the status of your local copy of the files as compared against the master copy of those same files in the vault.

The Vault Status indicate when the local copy is in sync with the master and when it’s not. The tooltips help guide you to the next logical steps - especially when the local copy is no longer in sync with the master. These icons are crucial to the overall understanding of how to work in a vaulted environment.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>File is not in the vault.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>File is in the vault in a checked-in state, and the version you are working on is the same as in the vault. Also referred to as the Latest Version.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>File is in the vault in a checked-in state, but the version you are working on is newer than the master file in the vault. This typically means that your local file was changed without checking it out. The blank icon indicates that the master file is available for check out. If you want to save these changes, check the file out, and then select the Don’t get local copy option.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>File is in the vault in a checked-in state, but the version you are working on is older than the latest version in the vault. This typically means that another user made changes since your last update. Use Reload to update to the latest available version.</td>
</tr>
</tbody>
</table>
The master file is checked out to you and the version you are working on is the same as in the vault.

File is checked out to you, but the version you are working on is newer than the latest version in the vault. This typically means that you made changes to the model since the last time you checked out the file, but have not checked it back in.

File is checked out to you, but the version you are working on is older than the master file in the vault. This typically means that you started with a version for the vault that was older than the latest, and checked it out to promote it to the latest.

File is checked out to another user, and the version you are working on is the same as in the vault. Also referred to as the Latest Version. This typically happens if the other user did not check changes back into the vault.

File is checked out to another user, and the version you are working on is newer than the file in the vault. This typically happens if the user checked in changes to the vault, but kept the file checked out. Use Refresh from Vault to update to the latest available version.

File is checked out to another user, but the version you are working on is older than the latest version in the vault, and another user checked out this file. Use Refresh from Vault to update to the latest available version.

File is locked and the local copy of the file is the same as the master file in the vault.

File is locked and the local copy of the file is newer than the master file in the vault.

File is locked and the local copy of the file is older than the master file in the vault.
Create a new drawing

Use the Project Manager to create a new drawing.

1  Click the Project Manager tool.

2  In the Project Manager, click the New Drawing tool.

   NOTE  You can also create a new drawing by right-clicking at the bottom of the tree inside the Project Manager and selecting New Drawing or by right-clicking on the active project name and selecting New Drawing.

3  In the Create New Drawing dialog box, enter the name for the new drawing. The .dwg extension is automatically added to the file name.

4  Specify the template drawing to use for the creation of the drawing file. If left blank, the default ACAD.DWT file is used. Click Browse to select a template drawing or enter the path and name of a template in the box.

5  Select or create the directory where you want to save the drawing.

6  (Optional) Enter descriptions for the drawing. You can enter up to 3 description lines for the drawing file. The description displays in title block updates, custom drawing properties, and drawing list reports. Select from a list of predefined descriptions from the active project by clicking the arrow.

7  (Optional) Specify the IEC default values for the project, installation, and location fields.

8  (Optional) Specify the sheet and drawing number value for the WD_M block definition. Additionally, you can specify the values to use for a section or subsection.
(Optional) Click OK-Properties to define settings and options for your drawing. Changes you make through the Drawing Properties dialog box are saved as attribute values on the drawing's invisible WD_M block.

Click OK.

Create new drawing

Use this to create a drawing file to add to the active project.

Access:

On the Project Manager, click the New Drawing button.
Click Projects ➤ Project ➤ Project Manager. On the Project Manager, click the New Drawing button.

NOTE You can also create a new drawing by right-clicking at the bottom of the tree inside the Project Manager and selecting New Drawing or by right-clicking on the active project name and selecting New Drawing.

Drawing File

<table>
<thead>
<tr>
<th>Name</th>
<th>Specifies the file name for the new drawing. A file name must be entered to define any of the drawing properties or to create a new drawing.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>NOTE The .dwg extension is not required in the edit box.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Template</th>
<th>Specifies the path and filename for an AutoCAD Electrical template drawing (.dwt) to use for the creation of a new drawing file. If left blank, the default ACAD.DWT file is used. Click Browse to select a template drawing or type in the path and name of a template.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>NOTE The previously used drawing template is retained in the dialog box.</td>
</tr>
</tbody>
</table>

64 | Chapter 2  Project Management
For Reference Only

Indicates that the drawing should not be included in tagging, cross-referencing, and reporting functions. If selected, the drawing is included in project-wide plotting and title block operations.

Location

Specifies the location for a drawing file. You can override the default location for the drawing file and create additional folders. If left blank, the drawing file is created at the same location as the active project's definition file. Click Browse to pick a folder where the new drawing will be created.

**NOTE** You cannot have duplicate drawings in the same location.

Description 1-3

Specifies up to 3 lines of description text for the drawing file. The description displays in title block updates and custom drawing properties. Select from a list of predefined descriptions from the active project by clicking the arrow.

**NOTE** Drawing descriptions are disabled when you are modifying the properties of a drawing that is not in a project or if the project file is unavailable for edit.

**IEC-Style Designators**

Specifies IEC default values for the drawing, such as Project (%P), Installation (%I), and Location (%L) fields. When you insert a component, the %I and %L default values are used if the Installation and/or Location values would normally be blank.

Project Code

Specifies a project code for the drawing settings on all WD_M blocks. This value can be used as the replaceable parameter %P.

Installation Code

Specifies the Installation code for the WD_M block definition. This value can be used as the replaceable parameter %I.
Location Code  Specifies the Location code for the WD_M block definition. This value can be used as the replaceable parameter %L.

Drawing  Displays a list of Installation or Location codes to select from the active drawing.

Project  Displays a list of previously defined Installation or Location codes to select from the active project or from the Default.INST or Default.LOC file.

Sheet Values
Component, wire, and cross-reference tagging use replaceable parameters in their format. If you reference the drawing’s sheet number or drawing number in any of your tagging formats, then specify a default drawing-wide value to use.

Sheet  Specifies the sheet number value for the drawing settings. This value can be used as the replaceable parameter %S.

Drawing  Specifies the drawing number value for the drawing settings. This value can be used as the replaceable parameter %D.

Section  Specifies the section value for the drawing file saved in the project definition file (.wdp). This value can be used as the replaceable parameter %A.

Sub-Section  Specifies the subsection value for the drawing file saved in the project definition file (.wdp). This value can be used as the replaceable parameter %B.

OK-Properties
Creates the drawing file in the specified location before opening the Drawing Properties dialog box where you can define settings and options for your drawing. Changes you make through this dialog box are saved as attribute values on the drawing’s invisible WD_M block. If your current drawing does not have this required block present when any AutoCAD Electrical schematic
command is invoked, AutoCAD Electrical automatically inserts this block at 0,0.
Change drawing display options

You can use the Drawing List Display Configuration tool to change the way your drawings are listed in the Project Manager. By default drawings are identified by the drawing file name in the Project Drawing List.

1. On the Project Manager, click the Drawing List Display Configuration tool.

2. Determine which display options to show in the drawing list. Options include:
   - Installation Code (%I)
   - Location Code (%L)
   - Section
   - Sub Section
   - Sheet Number (%S)
   - Drawing Number (%D)
   - Drawing Description 1-3
   - File Name

3. Select the display option from the Display Options list and click the >> button or add all of the options by clicking the All >> button.
   - The display option you selected moves to the Current Display Order list. To rearrange this list, select an option and click Move Up or Move Down. To remove an option from the list, select the option and click the << button.

4. (Optional) Change the character to use between the values in the listing. The default separator value is a dash (-).

5. (Optional) Change the way the selection highlights in the listing depending on whether the Project Manager is active or not. By default the drawing file you select in the drawing list is highlighted at all times; you can select to only highlight your selection when the Project Manager drawing list is active.

6. Click OK.
   - The Project Drawing List automatically updates in the Project
Manager.

**Drawing List Display Example**

In this example, Sheet Number (%S) and Drawing Description 1 were selected as the display options and the separator value is a dash.

<table>
<thead>
<tr>
<th>Drawing List Before</th>
<th>Drawing List After</th>
</tr>
</thead>
<tbody>
<tr>
<td>demo01.dwg</td>
<td>1 - Flow and Interconnection diagram, I/O list</td>
</tr>
<tr>
<td>demo02.dwg</td>
<td>2 - 3-phase motor control, Control circuit</td>
</tr>
<tr>
<td>demo03.dwg</td>
<td>3 - Power supplies, I/O module feeds</td>
</tr>
</tbody>
</table>

**Drawing list display configuration**

Configures the display options. There are 10 values that can be associated with a drawing listed and this allows you to display the information based on your requirements.

**Access:**

- On the Project Manager, click the Drawing List Display Configuration tool.
- From the Projects menu, select Project ➤ Project Manager. On the Project Manager, click the Drawing List Display Configuration tool.

<table>
<thead>
<tr>
<th>Display Options</th>
<th>Lists the values that you can associate to a drawing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow keys</td>
<td>Moves the selected display option into or from the Current Display Order. To add an option to the list, select the display option from the Display Options list and click the &gt;&gt; button or add all of the options by clicking the All &gt;&gt; button. To remove an option from the list, select the option and click the &lt;&lt; button.</td>
</tr>
<tr>
<td>Current Display Order</td>
<td>Lists the values to display in the listing. You must have one entry specified.</td>
</tr>
</tbody>
</table>
Separator Value
Specifications which character to use between the values in the listing. Type the character in the input box or use the default (-).

Always show selection highlight/Show selection highlight only when active
Changes the way the selection highlights in the listing depending on whether the Project Manager is active or not. By default the drawing file you select in the drawing list is highlighted at all times; you can select to only highlight your selection when the Project Manager drawing list is active.

Move Up
Moves the selected display option up one spot in the Current Display Order list.

Move Down
Moves the selected display option down one spot in the Current Display Order list.

Overview of project related files

There are a number of optional project related files that AutoCAD Electrical supports. These files provide various functions such as keeping a project consistent, helping update custom title blocks across a project, or providing custom settings for various tools such as the PLC I/O module insertion tool.

Optional AutoCAD Electrical project related files include:

Catalog lookup
Database for choosing catalog part number assignments. It is also referenced when automatically generating various bill of materials reports. This is an Access-format MDB file that is named <project>_cat.mdb (project-specific version of a catalog lookup file) or DEFAULT_CAT.MDB (default catalog lookup file). If the project-specific .mdb file is used, it needs to be in the same folder where the <project>.wdp file is located. If a project-specific version is not found, then the DEFAULT_CAT.MDB is searched for in the same folder as the active project file, and then in the paths defined in subdirectory search sequence "C" below.
Lists various standard component description selections, accessible by clicking Defaults on the Insert/Edit Component and Panel Insert/Edit Component dialog boxes. This file can be a family-specific ASCII text file with a .wdd extension (for example, "PB.WDD" for family "PB" pushbuttons). If the family-specific file is not found, then it searches for a file with the same path and name as the active project with a .wdd extension (<project>.wdd). If neither a family-specific or project-specific file is found, it defaults to searching for a general description file WD_DESC.WDD in the various AutoCAD Electrical search paths and AutoCAD support paths (subdirectory search sequence “A” below). If none are found, it prompts for browsing to a .wdd description file.

When you click Defaults on the Insert/Edit Component or Panel Insert/Edit Component dialog box the contents of the ASCII text file display in a dialog box where you can select a line of text to use as the description text. The selected text, up to a “;” comment delimiter if any, then displays in the description edit box on the Insert/Edit dialog box. If the selected text has one or more “|” characters, it is interpreted as having line breaks so the 2nd and 3rd description lines fill in as well.

Component tagging pick list data carried in an external text file, accessed when you click External List on the Insert/Edit dialog box for schematic or panel layouts. The data in this file can be comma-delimited or space-delimited and can be in any order. When accessed, the contents of the file display in a dialog box so you can select a line of data. It is broken down and displays in a dialog box for mapping to various attributes carried by the schematic component or panel footprint symbol being edited. The elements in the selected line of file data can be mapped to the edited schematic or footprint symbol’s attributes such as tag, description, location, and catalog part number. This text file can have a .txt, .csv or .wdx extension. If you do not browse to and select a specific file, AutoCAD Electrical searches for a file with the same path and name as the project’s .wdp file but with a .wdx extension. On subsequent command invocations, AutoCAD Electrical defaults to the previously selected file name.
Family tag code map

Overrides the family tag code of the library symbols by mapping the codes to new values. The tag code of a symbol is used in generating the tag-ID of inserted components, like the "PB" of tag-ID "PB101" or the "K" of tag-ID "-K25." The file WD_FAM.DAT is searched for in the subdirectory search sequence "A" below. This is an ASCII text file in the format of <old>, <new>. For example, the default family tag code for a JIC library pilot light is "LT" and generates tags such as "LT101." To override this tag code and substitute a family code of "LITE" without editing the library symbols, add this line to the wd_fam.dat: “LT, LITE.”

Footprint lookup

Database for graphical footprint assignments based on the catalog part number assignments.
A file with the same path and name as the project but with a "_FOOTPRINT_LOOKUP.MDB" suffix and extension is searched for first. If the file is not found, then the default FOOTPRINT_LOOKUP.MDB file is searched for in the same directory as the project file and then in the subdirectory search sequence "B" below.

Schematic lookup

Database for schematic components inserted from panel footprints.
A file with the same path and name as the project but with a "_SCHEMATIC_LOOKUP.MDB" suffix and extension is searched for first. If the file is not found, then the default SCHEMATIC_LOOKUP.MDB file is searched for in the same directory as the project file and then in the subdirectory search sequence "B" below.

Installation codes

Lists the default installation codes for selections found in the Insert/Edit Component and Panel Insert/Edit Component dialog boxes (select Include external list from the installation's Project list subdialog box).
A file with the same path and name as the project with an .inst extension is searched for first. If the file is not found, then the DEFAULT.INST file is searched for in the same directory as the project file and then in the subdirectory search sequence "A" below.
Location codes

Lists the default location codes for selections found in the Insert/Edit Component and Panel Insert/Edit Component dialog boxes (select Include external list from the location's Project list subdialog box).

A file with the same path and name as the project with a .loc extension is searched for first. If the file is not found, then the DEFAULT.LOC file is searched for in the same directory as the project file and then in the subdirectory search sequence "A" below.

Group codes

Lists the default group codes for selections found in the Panel Insert/Edit Component dialog box (select Include external list from the location's Project list subdialog box).

A file with the same path and name as the project with a .grp extension is searched for first. If the file is not found, then the DEFAULT.GRP file is searched for in the same directory as the project file and then in the subdirectory search sequence "A" below.

Mount codes

Lists the default mount codes for selections found in the Panel Insert/Edit Component dialog boxes (select Include external list from the location's Project list subdialog box).

A file with the same path and name as the project with a .mnt extension is searched for first. If the file is not found, then the DEFAULT.MNT file is searched for in the same directory as the project file and then in the subdirectory search sequence "A" below.

Project labels

Customizes the generic LINEx labels in the various title block and project information dialog boxes.

A file with the same path and name as the project with a .wdl extension is searched for first. If the file is not found, then the DEFAULT_WDTITLE.WDL file is searched for in the same directory as the project file and then in the subdirectory search sequence "A" below.

Rating defaults

Lists the default rating values found in the Insert/Edit Component and Panel Insert/Edit Component dialog boxes.

The contents of this ASCII text file display in a dialog box. The "|" character can be used to delimit consecutive RATINGx value assignments. For example, picking an entry
“30A/60A” would put “30A” into the first RATINGx attribute and “60A” into the RATING(x+1) attribute. A file with the same path and name as the project but with a .wdr extension is searched for first. If the file is not found, then the default WD_RATINGS.WDR file is searched for in the subdirectory search sequence "A" below. Alternately, a family-specific file can be accessed (for example, PS.WDR for pressure switches).

Real time error checking
The .wdn file is a text file used specifically for auditing. Terminal numbers listed in the .wdn file are not checked for terminal number duplication. You can use wildcards to exclude a range of terminals for duplication checking such as all terminals with a tag name starting with "T" and with terminal number "1." AutoCAD Electrical searches for the <project_name>.wdn file in the same folder as the project definition file (*.wdp). If <project_name>.wdn is not found, AutoCAD Electrical looks for the DEFAULT.WDN file in the project folder (C:\Documents and Settings\{username}\My Documents\Acade {version}\AeData\Proj). The default .wdn file contains the terminal number filters GND, PE, and E. These are ignored when checking for duplication and will not be listed in the Electrical Audit report. Edit this file with an ASCII text editor, such as WordPad.

RSLogix import
Defines the optional mapping of RSLogix codes to AutoCAD Electrical symbol block names for an RSLogix file import. A file with the same path and name as the project but with a .wdf extension is searched for first. If the file is not found, then the file DEFAULT_RSLOGIX.WDF file is searched for in the subdirectory search sequence "A" below and, if not found, file _DEFAULT_RSLOGIX.WDF is then searched for.

Spreadsheet to PLC tool
Defines the settings for the AutoCAD Electrical Spreadsheet to PLC I/O Utility. You are prompted to browse to a file with a .wdi extension. The default settings file is DEMOPLC.WDI.

Title block
The attribute name mapping support file for the AutoCAD Electrical title block update tool.

74 | Chapter 2  Project Management
A file with the same path and name as the project but with a .wdt extension is searched for first. If the file is not found, then the DEFAULT.WDT file is searched for in the same directory as the project file. If the file is not found, then the file is searched for in the subdirectory search sequence "A" below.

**User defined attributes**

An attribute text file of user-defined attributes defined on AutoCAD Electrical blocks. The User Defined Attribute List is used by report tools to determine which additional attributes are listed in a report. The list file name can be the same as the active project or named Default to be used by the entire system. The DEFAULT.WDA file is saved in the base project folder, while the <project_name>.wda file is saved in the same folder as the project definition file (*.wdp).

**Wire color and gauge labels**

Maps color and gauge wire descriptions based on wire layers.

A file with the same path and name as the project but with a .wdw extension is searched for first. If the file is not found, then the DEFAULT.WDW file is searched for in the same directory as the project file. If the file is not found, then the file is searched for in the subdirectory search sequence "A" below.

**Subdirectory search sequence "A"**

1. Full path (if full path name given)
2. User subdirectory (C:\Documents and Settings\{username}\Application Data\Autodesk\AutoCAD Electrical\[release #]\{country code\}\Support\User\)
3. Active project’s .wdp file subdirectory
4. AutoCAD Electrical support (C:\Documents and Settings\{username}\Application Data\Autodesk\AutoCAD Electrical\[release #]\{country code\}\Support\AeData\)
5. AutoCAD Electrical support (C:\Documents and Settings\{username}\Application Data\Autodesk\AutoCAD Electrical\[release #]\{country code\}\Support\)
Subdirectory search sequence "B"

1. Full path (if full path name given)
2. User subdirectory (C:\Documents and Settings\{username}\Application Data\Autodesk\AutoCAD Electrical\{release #}\{country code}\Support\User)
3. Catalog lookup subdirectory (C:\Documents and Settings\{username}\My Documents\Acade {version}\AeData\Catalogs)
4. Panel footprint library base subdirectory (C:\Program Files [(x86)]\autodesk\Acade {version}\Libs\panel\)
5. AutoCAD Electrical support (C:\Documents and Settings\{username}\Application Data\Autodesk\AutoCAD Electrical\{release #}\{country code}\Support\AeData)
6. AutoCAD Electrical support (C:\Documents and Settings\{username}\Application Data\Autodesk\AutoCAD Electrical\{release #}\{country code}\Support\)
7. AutoCAD Electrical support (C:\Program Files [(x86)]\Autodesk\Acade {version}\Support\)
8. AutoCAD Electrical support (C:\Program Files [(x86)]\Autodesk\Acade {version}\)
9. All paths defined under AutoCAD Options ➤ Files ➤ Support Files Search Path

Subdirectory search sequence "C"

1. Full path (if full path name given)
Overview of the project file format

A ".wdp" project file is a text file that lists the drawing files that are to be treated as a multi-drawing wiring diagram. AutoCAD Electrical manages this file automatically. Here is a general breakdown of the .wdp file format:

**Project description**

- All lines of text marked with "*[n]*" in columns 1-4 followed by the line of project data (n=1 to xxx)
About 75 entries marked with "?[n]" in columns 1-4. Most of these values are mirrored on attributes carried by each drawing's invisible WD_M block.

NOTE This current project 'copy' of the drawing properties settings can migrate to each new AutoCAD Electrical drawing and overwrite the defaults carried on the WD_M.dwg library symbol as it inserts. When the WD_M block alert box pops up for permission to insert into a new or non-AutoCAD Electrical drawing, the dialog's toggle setting determines whether the drawing's settings are the defaults carried on the WD_M.dwg library symbol (switch OFF), or be overwritten to match the "?[n]" settings listed here in the current project's ".wdp" file (switch ON).

For example, you have an active project that is set up for a one-of-a-kind wire tagging format that is different from all of your other projects and different from the default carried on the symbol library's WD_M.dwg block insert. When you start a new drawing for the project, you want to have this switch turned on so that the special settings of your active project update the values on the inserted WD_M block insert and cause it to match the project's special settings. This eliminates the need to go back into a new drawing's properties and adjust the wire tagging format setting to match the drawing.

**Default schematic library path**

Marked with "+[1]" in columns 1-4 followed by path or semicolon delimited paths. If multiple paths, the search for a given library symbol file name includes the sequence of the paths listed here in the order given.

**Schematic icon menu file**

Marked with "+[2]" in columns 1-4 followed by file. This can be a full path or just the icon menu file name itself (such as ACE_JIC_MENU.DAT or ACE_IEC_MENU.DAT).

**Default panel library path**

Marked with "+[3]" in columns 1-4 followed by base panel library path or semicolon delimited base paths. If multiple paths, the search for a given footprint library symbol includes the sequence of paths listed here in the order given.
Panel icon menu file
Marked with "+[4]" in columns 1-4 followed by file. This can be a full path or just the icon menu file name itself (such as ACE_PANEL_MENU.DAT).

Real-time inter-drawing update
Marked with "+[5]" followed by 1 = automatic/real-time, 0 = cross-reference command must be explicitly invoked.

Use MISC_CAT table
Marked with "+[6]" followed by 1 = always use MISC_CAT for catalog lookup, 2 = use MISC_CAT if component specific table not found, 0 or entry omitted = use component-specific only.

LINEx entries for reports
Marked with "+[9]" followed by comma-delimited list. This gives a list of project properties description entries that are included as a header for generated reports.

Combined Installation/Location/Tag
Marked with "+[10]" followed by 0 = Combined Installation/Location component tag mode is "off", 1 = mode is "on", 3 = mode is "on" and include Installation/Location as a tag prefix.

DESC case mode
Marked with "+[11]" followed by 0 = allow entered DESC1-DESC3 to be upper/lower case, missing or 1 = force all entered DESC1-DESC3 values to uppercase.

Wire network mode
Marked with "+[13]" followed by 0 or missing = wire tagging normal mode (wires combined into one wire number assignment), 1 = per wire basis mode (each connected wire gets its own wire number assignment).

IEC style Installation/Location tag
Marked with "+[14]" followed by 0 or missing = add prefix to TAG when output to reports, 1 = suppress adding the prefix to TAG for reports, 3 = suppress Installation/Location tag prefix when match drawing-wide Installation/Location default values for reports. This option is only used when +[10] above is set to 1 or 3.

Auto-fill Installation/Location
Marked with "+[15]" followed by 1 = component insert to auto-fill Installation/Location attributes with drawing de-
faults, 0 or missing= normal mode (don’t auto-fill attribute values).

**Schematic- ➤ Panel wire format**  
Marked with "+[16]" for the format that is to deal with wire connection entries when there is no existing terminal pin number text on the panel wiring diagram device footprint, meaning annotation ends up formatted into an Mtext entity, and "+[17]" for format of data written onto target TERMxx/WIRENOxx attributes carried on the panel wiring diagram device footprint.

**Auto-hide wire number**  
Marked with "+[18]" followed by 1= auto-hide a wire number on a wire network when a wire number terminal is present on the network (so that the same wire number does not display twice on the single wire network), 0= normal mode (do not hide any wire number text).

**Wire number offset**  
Marked with "+[19]" followed by wire number offset value, 0 or blank or missing= normal centering of wire numbers on the wire segment, value= offset from left or upper end of wire segment.

**Alternate WD.ENV**  
Marked with "+[20]" followed by the file name. If this alternative .env file does not exist or cannot be found, the default wd.env file is used.

**Wire number by layer**  
Marked with "+[21]" followed by 0= wire number by layer mode is “off”, 1= mode is “on”, and "+[22]" holds the layer setup. Format of layer setup is semicolon delimited in repeating groups of four elements per layer definition. <layer name>;<tag format>;<starting wire number>;<suffix list>;;...

**Alternate catalog lookup**  
Marked with "+[23]" followed by 0= alternate catalog file not defined, 1=defined and "+[24]" holds the alternate catalog lookup file name.

**Exclude wire number range**  
Marked with "+[27]" followed by the wire number ranges to exclude for sequential wire numbering. (blank or missing= no wire numbers excluded) For example, “100-199,500-699.”
Wire number terminal override
Marked with "+[29]" followed by 0= normal wire numbering mode or 1= calculate reference-based wire number based on the location not the first terminal in the wire network (or revert to normal wire numbering mode if no terminal in the network).

Calculation of the "CLEN" column
Marked with "+[30]" and set as a global variable (default is 0.0) to aid in the calculation of the "CLEN" column (calculated wire length) in a from/to report that is able to map schematic wire connections to panel physical layouts. This value is the extra amount to add to each end of a calculated wire segment for connection purposes.

Tag/Wire number order
Marked with "+[31]" and set in the Project Properties dialog box. The value can be blank (no sort order override) or 0-7 for the various horizontal/vertical sort orders listed in the dialog box.

Real-time error checking
Marked with "+[32]" followed by 0= real-time error checking mode is “off”, 1= mode is “on.”

Grid column headers
Marked with "+[33]" to indicate a string of column names used in grid column headers in the Wire Type commands.

Suppress dash
Marked with "+[34]" to suppress the dash (-) if it is the first character of a tag when the Combined installation/location component tag mode is “on.” See the [+10] entry.

Project drawing list
All remaining entries give time relative path (relative to the location of the project’s .wdp file itself) to each drawing that is part of the project. The drawing name is given first. Then, if special assignments or descriptions are defined for the drawing, this information follows the drawing name in subsequent lines. Each line is prefixed with a code. If special "sec/sub" groupings are defined, then a drawing’s "sec" is preceded by a "=" entry and "sub" by a "==" entry. If one to three lines of description are defined, each is preceded by a "===" entry. If a drawing is marked "Ref only", it is preceded by a "====REF" entry.
NOTE The following options are no longer valid since they are now drawing settings: Cross-reference fill format (+[7]), Cross-reference text between (+[8]) and Cross-reference order (+[28]). Additionally Project scratch database (+[12]) has been replaced by the PDS.

Archive a project

The zip utility creates a zip file of the current project’s .wdp file and one or more drawing files it references. The zip file can optionally include a copy of the project’s temporary database file to eliminate the need to rebuild the database when the project is unzipped at a later date.

For the zip utility to function, a zip application must be installed on the system running AutoCAD Electrical.

**Initial Configuration**

1. Edit the .env file to point to the zip utility.
2. Create an entry for the utility labeled WD_ZIP followed by a comma and then the full path name to the executable zip program. For example, WD_ZIP,c:\Program Files ((x86))\winzip\winzip32.exe.

   **NOTE** All drawings to be included in the zipped file must be closed prior to running the zip utility.

This utility can also be accessed from within a number of AutoCAD Electrical routines that access and modify multiple drawings.

**Archive a drawing set**

1. Select Projects ➤ Zip Project.
2. Select the drawings to process and click OK.
3. In the AutoCAD Electrical Project Zip dialog box, enter the zip name of the file to create or update.
4. Indicate whether to include the project database.
5. Click OK.

This utility can also be accessed from within a number of AutoCAD Electrical routines that access and modify multiple drawings.
**Project zip**

Creates a framework for zipping and archiving the current project's drawing set. Your zip program may generate an error message if the active drawing is one of the drawings to zip.

**Access:**

- On the Project Manager, click the arrow on the Publish/Plot tool and select Zip Project. Select the projects to zip and click OK.
- From the Projects menu, select Zip Project. Select the projects to zip and click OK.
- Additionally, the utility can be accessed from within a number of AutoCAD Electrical routines that access and modify multiple drawings.

**Enter zip file name to create/update**

Lists the name and location for the zip file to create. If you want to update a file, browse to the zip file.

**Include project database file**

Specifies to include the project database file (.mdb) in the zip file.

---

**Overview of set up for multiple clients**

You can set up AutoCAD Electrical to deal with multiple clients, each with its own title block and library requirements. Client-specific drawing borders, title blocks, parts libraries, and part number lookup files can be set up to be automatically selected by AutoCAD Electrical when working on a specific client's project.

**Client subdirectory structure**

Set up a subdirectory structure where each client is assigned their own subdirectory. For example, it might look like this:

```
n:\campbell.nap\n:\j-m\n```

---

Work with Multiple Clients | 83
Set up title block mapping files for clients

Use the AutoCAD Electrical Title block setup tool to create a default.wdt file for each client's title block. Store this default.wdt in the client's base subdirectory. For example:

n:\campbell.nap\default.wdt

One way to do this:

1 Use AutoCAD Electrical to create a project in the client's base subdirectory (ex: n:\campbell.nap\dummy.wdp).

2 Open the client's drawing border drawing or any existing drawing that contains the client's title block (block with attributes).

3 Select Project ➤ Title Block Setup.

4 In the Title block link method dialog box, select the middle option listed under "Method 1" -- the DEFAULT.WDT file for any project found in subdirectory n:\campbell.nap.

5 Click OK.

6 Follow the dialog boxes and pick options to build the default.wdt file.

Customize labels for title blocks

Several title block-related dialog boxes in AutoCAD Electrical display generic labels like "LINE1", "LINE2", and so on. You can change these labels so that they match up with the actual link to the client's title block. For example, in the *.wdt* mapping file, you might have linked the AutoCAD Electrical data "LINE10" value to the "DRAWN_BY" attribute on the client's title block. What you want to see when AutoCAD Electrical displays a title block-related dialog box is not "LINE10" but "Drawn by."

1 Create a file called default_wdtitle.wdl in the client's subdirectory where you store the project (.wdp) files. Use any generic text editor like the Windows Notepad or Wordpad.

2 Edit the file as necessary.
   The file should contain 1 line per label in the format LINEx=label. The entries do not have to be in order and line numbers may be skipped.

3 Save and exit.
Try updating the Title Block from the Project Manager. Notice all of the updated labels.

**Specify client-specific library symbols**

If the client has special symbols or text size settings that are different from the default libraries provided with the AutoCAD Electrical product, create and maintain a client-specific symbol library subdirectory with smart AutoCAD Electrical symbols that have been adjusted to meet that client's standards. When you start a new project for this client, set the AutoCAD Electrical Symbol Library path to point at the client's library.

1. In the Project Manager, right-click the project name, and select Properties.
2. In the Project Properties ➤ Project Settings dialog box, click the plus sign (+) next to Schematic Libraries. Click Add and enter the library's path into the edit box. Make it the first or only path listed.
   This causes AutoCAD Electrical to look in the client-specific symbol library first before going to a default AutoCAD Electrical symbol library.
3. Click OK.

**NOTE** Make sure you also update the Panel Footprint Library path.

**Start a project for a client**

1. Create and save the AutoCAD Electrical project .wdp file to the client's base subdirectory where the client's default.wdt and wdtitle.wdl files are stored. Make sure that the new project also points at the client's symbol library.
   The actual drawings for the project can be stored anywhere but you might want to store them in some kind of "job number" subdirectory under the base client subdirectory. For example, let's say that for client "Campbell" you have a new project, 12345. Under the N:\campbell.nap network drive subdirectory, create subdirectory n:\campbell.nap\12345. This is where to save the drawings for that project.
2. Create a new project and save it to the base subdirectory.
   For example, create project P12345.wdp and save it to n:\campbell.nap\P12345.wdp (along with any other Campbell projects you've already created - they are all grouped together in this base subdirectory but their drawing sets are isolated into unique job number subdirectories).
With the above setup, anytime you work on a Campbell project (project file ".wdp" stored in the n:\campbell.nap directory), AutoCAD Electrical automatically uses the client-specific title block mapping file (n:\campbell.nap\default.wdt) and the client-specific dialog box label file (n:\campbell.nap\wdtitle.wdl).

Miscellaneous Reference files

Add new table to MDB

Access:

From the Projects menu, select Extras ➤ Add Table to Catalog Database. Select the database to use and click Open.

MDB file to modify

Specifies the file name of the Catalog Database file to modify.

Existing tables

Lists the existing tables found in the file.

Add new table

Specifies the name of new table to add to the selected catalog database. The new, blank table inserts with the default fields defined (for example, the fields needed for the catalog lookup function).

Project database table data -- project drawing files update

AutoCAD Electrical maintains a scratch database for a project, stored in Microsoft Access format that is used to speed up certain project-wide operations. This file is for scratch use only; it is not part of the intelligence
stored in an AutoCAD Electrical project. If the scratch database file is missing or corrupted, it is automatically generated from the project's drawing set. The project's scratch database file can be used to write back to text data carried on symbols on the drawings. With some care (described below), you can edit the database directly and then import the information back to the drawings.

The file name is <project>.mdb where <project> matches the current project's .wdp file name.

Access:

Click Projects ➤ Export to Spreadsheet ➤ Update from Project Scratch Database.

Select the database table to update then select the drawings to process. Any changes are written back to the appropriate objects. Alternately, save the scratch database file with a new name, edit, and then reference this file when the command starts.

Cautionary Note

AutoCAD Electrical 2006 and later introduced an automatic scratch database "freshen" function, Project Database Service (PDS), which complicates use of this command over previous versions of AutoCAD Electrical. The PDS automatically updates the scratch project database without your intervention (and without your knowledge). If you edit the scratch database with all of the changes you want to write back to your project set, there is a chance that the PDS will come in, without warning, and remove all of these edits (to match the current state of the unmodified dwgs) before you have a chance to run the command to update the drawings.

Even if you are careful not to update the drawings while doing the mdb edit (so that the PDS will not update anything), you can still lose all your edits when you launch the Update from Project Scratch Database command. This is because the command, just before it begins the update, may ask you if it is OK to Qsave the active drawing. If you select OK, then the PDS sees a change and updates the database (for example, erases changes for current drawing), just as the command is getting ready to process.

To prevent this, do not update the drawings while editing the scratch database file and answer "NO" to the Qsave prompt when invoking the actual update command.
Edit report

Access:

From the Projects menu, select Extras ➤ Settings List Utility. Click Edit Mode.

If you edit the information in the Configuration Report, you will have an option to update the project and drawings with the new information. Re-order the lines with the Move Up, Move Down, Move to Top, and Move to Bottom buttons. If you re-order the lines, the order of the drawing list in the project file (.WDP) can be updated to match.

<table>
<thead>
<tr>
<th>Move Up</th>
<th>Moves the currently selected line(s) up one place in the report.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Down</td>
<td>Moves the currently selected line(s) down one place in the report.</td>
</tr>
<tr>
<td>Move to Top</td>
<td>Moves the currently selected line(s) to the top of the report.</td>
</tr>
<tr>
<td>Move to Bottom</td>
<td>Moves the currently selected line(s) to the bottom of the report.</td>
</tr>
</tbody>
</table>

Edit

Edits the values of the currently selected line. Double click any line to go directly into edit.

<table>
<thead>
<tr>
<th>DWGNAM</th>
<th>Specifies the drawing name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SEC</td>
<td>If you change any of the Sec data, the Section data held in the project file (.WDP) can be updated to match.</td>
</tr>
<tr>
<td>SUBSEC</td>
<td>If you change any of the Sub-Sec data, the Sub-Section data held in the project file (.WDP) can be updated to match.</td>
</tr>
<tr>
<td>Data</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SH</td>
<td>If you change any of the SH data, the Sheet (%S) field for that drawing can be updated to match.</td>
</tr>
<tr>
<td>SHDWGNAM</td>
<td>If you change any of the SHDWGNAM data, the Dwg no. (%D) field for that drawing can be updated to match.</td>
</tr>
<tr>
<td>IEC_P</td>
<td>If you change any of the IEC_P data, the IEC Project (%P) field for that drawing can be updated to match.</td>
</tr>
<tr>
<td>IEC_I</td>
<td>If you change any of the IEC_I data, the IEC Installation (%I) field for that drawing can be updated to match.</td>
</tr>
<tr>
<td>IEC_L</td>
<td>If you change any of the IEC_L data, the IEC Location (%L) field for that drawing can be updated to match.</td>
</tr>
<tr>
<td>SH-DESC</td>
<td>If you change any of the SH-DESC data, the Description data held in the project file (.WDP) can be updated to match.</td>
</tr>
</tbody>
</table>

**IEC tag mode update**

If a change to the IEC component tag mode format is detected, use this tool to freshen the tag format. This makes sure that component tags are displayed per the change.

**Access:**

From the Projects menu, select IEC Tag Mode - Update.

**Freshen tags for**

Specifies to run a freshen on the entire project, the active drawing only, or on selected components in the active drawing.

**Freshen parent/child cross-reference annotation**

Reruns the cross-reference update.
Remove any leading dash character from component tags

Indicates whether any leading '-' characters for component tags are suppressed (box checked) or added (box unchecked). This is controlled from the Project Properties ➤ Components dialog box.

Force Installation and Location attributes to be visible or invisible

Switches the visibility of Installation and Location attributes on each component.

---

**Rebuild database file**

**Access:**

Click the drop-down arrow on the Projects tool to access the Rebuild Project Database tool.

From the Projects menu, select Projects ➤ Rebuild/Freshen Project Database.

- **List:** Lists the drawings that appear to be out-of-date with the project's wire connection table. You can trigger an update when the dialog box is open or you can defer to auto-update when a wire report is run.

- **Include wire connection processing:** Indicates to process wire connections when updating the database file or the wire connection table.

- **Freshen only:** Updates the wire connection table with the out-of-date files.

- **Full rebuild:** Performs a full rebuild of the project database file.

---

**Select drawings to process**
Lists the drawings available to update in the current project.

**Access:**

Select to run any of the project-wide commands.

**Do All**
Selects all of the drawings from the project drawing list.

**Process**
Selects one or more drawings from the project drawing list.

**Reset**
Moves all selected drawings back to the project drawing list.

**Un-select**
Moves one or more drawings back to the project drawing list.

**by Section/subsection**
Selects drawings by user-defined sections and subsections.

**Task list**

Make the changes to the drawing files that have been accumulated while drawing files were unavailable for editing.

**Access:**

Click the Project Manager tool. On the Project Manager, click the Project Task List tool or right-click the project name and select Task List. On the Update from dialog box, select Update: Select from list of drawings and click OK.

From the Projects menu, select Project ➤ Project Manager. On the Project Manager, click the Project Task List tool or right-click the project name, and select Task List. On the Update from dialog box, select Update: Select from list of drawings and click OK.

The tasks that still need to be performed on the selected drawings are listed in the upper portion of the dialog box. The login name of the user creating the task, file name, installation and location codes, component tag, type,
status, attribute, old value and new value are all displayed. The 'x' indicates that the source of the change no longer matches the task list.

**Sort**
- Sorts the list of tasks to be performed. You can specify four sorts to perform on the list.

**Select All**
- Selects all of the tasks in the list. When you click OK, all of the pending tasks will be performed on the selected drawings.

**Remove**
- Removes the selected task from the list.

---

**Files unavailable for processing**

If some of the drawings selected for processing are unavailable (such as in a read-only state) this dialog displays. The file name, status, and location of the drawing is listed in the dialog for review.

**Retry Now**
- Tries to gain full write access to the entire list of drawing files previously selected. If you gain full access, the files are locked out by you and other users cannot make any modifications until the project-wide command finishes.

**Task**
- Tasks (saves) all modifications in a task list to be run at a later time. The task list is maintained inside of the Project Task List database file (project_update.mdb). Not all commands can write to the task list. See the list below of commands that can be tasked.

**Cancel**
- Cancels the update and returns to the Select Drawings to Process dialog box. Select other files to update or try to gain write access to the entire list of drawings to process.

**Ignore**
- Processes the command on the drawings that are available for editing. Changes to unavailable drawings are not saved to the task list for later updates.
Commands that write to the project_update.mdb file

- Edit Component
- Retag Component
- Insert or copy a circuit
- Location box changes
- Find/Edit/Replace
- Set/Edit Wire Connection Sequence
- Changing an IEC setting before running a Retag
- Copy Location/Installation/Mount/Group
- Copy BOM
- Block Swap
- Terminal Strip Editor
- Insert Schematic from Panel
Drawing and Project Properties

In this chapter

- Overview of project and drawing properties
- Use replaceable parameters
- Save settings to the project file
- Create a template drawing
- Updating the WD_M Block
- Using Layers
Overview of project and drawing properties

Use the Project Properties dialog box to define settings when creating a project and then have those settings used for new drawings or those added to the project. In the Project Properties dialog box, icons indicate whether the settings apply to project settings or drawing defaults.

- Settings that apply to project settings and are saved inside the project definition file (*.wdp).
- Settings that are saved in the project file as drawing defaults. Drawing related data that should be added to the project when running the Add Drawing command is saved as Drawing Custom Properties.

Use the Drawing Properties dialog box to define settings for a new or selected drawing. These settings override the project properties set in the Project Properties dialog box. If the drawing is part of a project, the project name displays in the dialog box; otherwise, text displays indicating that the drawing is not part of a project and drawing-related edit fields that are saved in the .wdp file are disabled.

You can specify settings for the project or drawing defaults, components, wire numbers, cross-references, styles and the drawing format using either the Project Properties or Drawing Properties dialog boxes. An overview of the available options for each tab are listed below.

**Settings**

Project settings include:
- Library and Icon Menu paths
- Catalog lookup file preferences
- Real time error checking options

Drawing settings include:
- Drawing type and descriptions
- IEC default values for the Project (%P), Installation (%I), and Location (%L) fields
Sheet values for the sheet and drawing in addition to section or subsection codes

**Components**

Use this tab to:

- Specify the way new component tags are created.
- Switch between sequential or line reference based tags.
- Set component tag options such as using combined Installation/Location tags or suppressing the Installation/Location tag on reports.
- Display description text in uppercase.

**Wire Numbers**

Use this tab to:

- Set the wire number format.
- Switch between sequential or line reference based wire numbers.
- Set wire number options such as hidden numbers, excluded numbers, or displaying numbers on a per wire basis.
- Set up wire number layer options.
- Define wire number placement: above, below, or in-line.
- Define wire number leaders.

**Cross-References**

Use this tab to:

- Define the cross-reference annotation format.
- Set cross-reference options such as suppressing Installation/Location codes or using real time signal and contact cross-referencing between drawings.
- Set component cross-reference display: text, graphical, or table. You can also change the display format setup from this dialog box.
**Styles**

Use this tab to:

- Change default styles for arrows, plcs, fan-in/out markers, and wiring.
- Add or remove layers from the layer list.

**Drawing Format**

Use this tab to:

- Set the default orientation, spacing and width values for any new ladders inserted on the drawing.
- Specify the format referencing style: X-Y Grid, X Zones, or Reference Numbers.
- Set the scale factor used when inserting new components or wire numbers on the drawing.
- Set the tag/wire number sort order.
- Define and manage wire and component layers.

**Set project or drawing properties**

You can specify settings for the project or drawing defaults, components, wire numbers, cross-references, styles, and the drawing format using either the Project Properties or Drawing Properties dialog boxes. The steps below are for setting project properties but you can set drawing properties by opening the Project Manager, right-clicking on the drawing name and selecting Properties.
➤ Drawing Properties or by clicking the Drawing Properties tool on the toolbar.

1. Click the Project Manager tool.
2. In the Project Manager, right-click the project name, and select Properties.

**NOTE** You can also set project properties when you create a new project. Create the new project and click OK - Properties in the Create New Project dialog box.

3. In the Project Properties dialog box, select the tab to modify properties for.
4. Click OK.

**Project properties: project settings tab**

Modify your project default settings for libraries, catalog lookup, and error checking. All information defined in this tab is saved to the project definition file as a project default.

**Access:**

Click the Project Manager tool. In the Project Manager, right-click the project name, and select Properties.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the project name, and select Properties.

**Library and Icon Menu Paths**

Select which schematic library, panel library, and icon menus to use.

| Libraries | To modify existing input fields in the tree structure, double-click the folder, (for example, Schematic Libraries) and highlight the path to change then browse to the path of the schematic or base footprint symbol library you want to use for the project. You can also include a series of paths for AutoCAD Electrical to search in order. You can include electrical, pneumatic, or other schematic libraries in the path. |
NOTE The symbol search path includes the User and Project folders (and potentially the AutoCAD search paths) prior to the paths listed here. In the Project Manager, right-click the project name, and select Settings to view the active search path for the project.

**Icon Menu File**

If you want to use an icon menu for the project that is different from the default, enter the file name. This menu reference is saved in the project's .wdp file.

**NOTE** You can only specify one search path for the icon menu.

**Add**

Adds a new entry into the libraries tree structure.

**Browse**

Browses for a folder to select a symbol library or icon menu from.

**Remove**

Removes the selected path from the libraries tree structure.

**Move Up**

Moves the selected path up one spot in the libraries tree structure.

**Move Down**

Moves the selected path down one spot in the libraries tree structure.

**Default**

Brings the default paths from the environment file (WD.ENV) into the list box tree view for all search paths found underneath the highlighted folder.

**Catalog Lookup File Preference**

**Use component specific tables**

Searches for the component name as the catalog table. If the component table is not found, the family name table is searched. If neither table is found, use the Catalog Lookup File dialog box to create a component or family table or select a different table.

**Other File**

Defines a secondary catalog lookup file.
Always use MISC_CAT table

Searches only the MISC_CAT table. You can search other component tables if the catalog number is not found in the MISC_CAT table.

Use MISC_CAT table only if component specific table does not exist

Uses the MISC_CAT table if the component or family tables are not found in the catalog database.

Options

Real time error checking

Performs real time error checking on the project to determine if duplications of wire numbers or component tags occur in the project. An error log file is created for every project regardless whether you chose to display the real time warning dialog or not. The real time warning is saved in the log file named "<project_name>_error.log" and is saved in the User subdirectory. If a log file already exists, the new content is added to the same file. A blank line separates one error record from another.

Tag/Wire Number Sort Order

Sets the default wire numbering and component tag sort order for the project.

Catalog lookup file

This defines a secondary catalog lookup file to use.

Access:

Click the Project Manager tool. On the Project Manager, right-click on the Project name and select Properties. In the Project Properties ➤ Project Settings dialog box, Catalog Lookup File Preference section, click Other File. From the Projects menu, select Project ➤ Project Manager. On the Project Manager, right-click on the Project name and select Properties. In the Project
Access:

Properties ➤ Project Settings dialog box, Catalog Lookup File Preference section, click Other File.

Single catalog lookup file

Specifies to use only one catalog lookup file. The file that is used depends on what was selected on the Project Properties ➤ Project Settings dialog box.

Optional: Define a secondary catalog lookup file for this project

Specifies to define a secondary lookup file for the project. Catalog lookup files provided with AutoCAD Electrical include: default_cat.mdb, footprint_lookup.mdb, schematic_lookup.mdb, wd_lang1.mdb and wd_picklist.mdb.

Defines a secondary catalog lookup file that functions as such:

- For catalog part number selection, switches to a secondary catalog lookup file.
- For BOM report generation, queries the secondary catalog lookup file when the target part number is not found in the default file.

**Project properties: components tab**

Modify your project default settings for components. All information defined in this tab is saved to the project definition file as project defaults and settings.

Access:

Click the Project Manager tool. In the Project Manager, right-click the project name, and select Properties.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click on the project name, and select Properties.

**Component TAG Format**

Tag Format

Specifies the way new component tags are created. The tag consists of a minimum of 2 pieces of information: a family code and an alphanumeric ref-
ereference number (for example, "CR" and "100" to yield a tag like CR100 or 100CR). Optionally, a component tag might contain a sheet number or some user-specified separators. If your format includes the sheet number %S parameter or the drawing number %D parameter, you must enter the values in the edit boxes in the Drawing Properties ➤ Drawing Settings dialog box.

**NOTE** AutoCAD Electrical provides a predefined format for you to use or you can enter your own format using replaceable parameters. (page 126)

**NOTE** The %N parameter is mandatory in any component tag format you define.

| **Search for PLC I/O address on insert** | Searches for a connected PLC I/O module's I/O point. If found, the I/O address value is substituted for the "%N" part of the default component tag. |
| **Sequential** | Enter the beginning sequential number for the drawing. Sequential tags can continue uninterrupted from one drawing to the next if you assign the same beginning sequential number to every drawing in your project. As you insert components on any drawing of the project set, AutoCAD Electrical starts with the value you set and works its way up until it finds the next unused sequential number tag for the target component family. |
| **Line Reference** | Set up the unique format tag suffix list. This list is used to create unique reference-based tags when multiple components of the same family are located...
at the same reference location (ex: 3 push buttons on the same line reference "101" could be labeled PB101, PB101A, and PB101B -- AutoCAD Electrical does this using a suffix list of "", "A", "B", and so on).

**NOTE** The component tag suffix is automatically added to the end of the tag, but you can force AutoCAD Electrical to insert the suffix character somewhere within the tag format. Use the Suffix position parameter, %X, in the component tag format (for example, %N%X - %F).

### Component TAG Options

**Combined Installation/Location tag mode**

Uses the combined installation/location tag for interpreting component tag names. For example, -100CR relay contact marked with location code PNL1 is interpreted as being associated with a different relay coil than relay contact -100CR marked with location code PNL2. If this setting is not selected, both contacts are associated with the same parent relay coil, -100CR.

**Suppress dash when first character of tag**

Suppresses any single dash character prefix in an IEC tag that does not have a leading Installation/Location
prefix (i.e. "-K101" dash is suppressed to "K101" but "+LOC1-K101" remains unchanged).
When toggled OFF, it automatically adds a single dash character to an IEC tag that does not already have a single leading dash prefix and does not have a leading Installation/Location prefix. For example, tag "K101" becomes "+K101" but "+LOC1-K101" remains unchanged.

NOTE  This suppression takes place automatically in reports; and takes place graphically only when a component is inserted, edited, or retagged.

| Format Installation/Location into tag | Specifies to exclude the Installation and Location code values as part of the tag when displaying. Example, if this is not on a tag might show up as K16 in the Surf dialog box, but if selected the tag might show up +AAA-K16 (where AAA is the location). |
| Suppress Installation/Location in tag when match drawing default | Suppresses Location and Installation values on components if they match the drawing default values.  

NOTE  Update cross-reference text using the AutoCAD Electrical Cross-reference command. |
| Suppress Installation/Location in tag on reports | Specifies to exclude Installation and Location values as part of the tag when displayed in reports. |
| Upon insert: automatic fill Installation/Location with drawing default or last used | Fills the Installation and Location edit boxes on the Insert/Edit component dialog box and the attributes on the block with drawing default or last used values (if no drawing default). If not selected, these edit boxes and attributes are not filled in and are assumed. |

Component Options

Description text upper case  Forces description text to upper case.

Project properties: wire numbers tab

Overview of project and drawing properties | 105
Modify your project default settings for wire numbers. All information defined in this tab is saved to the project definition file as project defaults and settings.

Access:

Click the Project Manager tool. In the Project Manager, right-click on the project name and select Properties.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click on the project name and select Properties.

Wire Number Format

Wire number tags can be sequential or reference-based.

Format

Specifies the way new wire number tags are created. The wire number tag format must include the %N parameter that is the base sequential or reference-based value per the selection above. If your format includes the sheet number %S parameter or the drawing number %D parameter, you must enter the values in the edit boxes in the Drawing Properties ➤ Drawing Settings dialog box.

NOTE For reference-based wire number tagging, individual items in the suffix list are applied to the wire tags to keep multiple wires in the same reference location unique. These are added to the end of the tag, but you can force AutoCAD Electrical to insert the suffix character somewhere within the tag format. Use the Suffix position parameter, %X, in the component tag format (for example, %X%N).

NOTE AutoCAD Electrical provides a predefined format for you to use or you can enter your own format using replaceable parameters. (page 126)

Search for PLC I/O address on insert

Specifies to use PLC I/O address values for wires that connect to an addressed I/O point. This overrides both Sequential and Reference-based tagging. New wires or wire renumbering on the current drawing will show PLC I/O address-based wire numbers automatically.
NOTE Like component tags, AutoCAD Electrical uses the concept of a wire tag format string with replaceable parameters. The %N parameter must always be part of the wire format string. A typical format string might be just this %N parameter.

Sequential
Enter the starting sequential number (alpha, numeric, or alphanumeric) for the drawing. If you enter the same starting sequential number for every drawing of your wiring diagram set, AutoCAD Electrical confirms at insertion time that a new sequential wire number tag is not repeated on any other drawing.
If you set DEMO1 to 100 and DEMO2 to 200, the wire numbers on DEMO1 start at 100 and those on DEMO2 start at 200. If DEMO1 has more than 100 wire numbers it starts using wire number 200 and above while DEMO2 would begin its wire numbers where DEMO1 left off (making sure that duplicate wire numbers are not assigned).

Increment
The default is "1". Setting it to "2" with a starting sequential of "1" would yield wire numbers 1, 3, 5, 7, 9, 11, and so on.

Line Reference
Sets the wire number tag suffix. This list is used to create unique reference-based wire number tags for multiple wire networks beginning at the same reference location (such as wire network beginning at a location per line reference number, X-Y grid reference, or X-Zone reference).

Suffix Setup
Displays a suffix list. List suffix characters for wire numbers beginning on the same line reference or in the same zone (to keep wire numbers unique). Select one of the 4 pre-defined suffix lists or enter your own custom suffix list.

Wire Number Options

Based on Wire Layer
Assigns a different wire number format based on the wire layer.
Layer Setup
Overrides the default wire number format by using layer defined formats. Change the wire layer name, wire number format, starting wire sequence, and wire number suffix.

Based on Terminal Symbol Location
Specifies to use a wire number terminal on a wire network as the wire network's line reference value for calculating a reference-based wire number. For example, a wire network starts at line reference 100 and drops down and over on line reference 103. If there is a schematic terminal symbol that carries the WIRENO attribute located on line reference 103 and this option is enabled, AutoCAD Electrical calculates a reference-based wire number using 103 instead of 100. If there are multiple wire number terminals on this network, the line reference value of the upper left-most terminal is used.

Hidden on Wire Network with Terminal Displaying Wire Number
Specifies to automatically hide the wire number for a wire network that has a wire number-type terminal.

On per Wire Basis
Specifies to assign a wire number for each wire rather than the default one wire number per wire network.

Exclude
Specifies the wire number ranges to exclude if using sequential wire numbers. (applied to the %N part of the wire number tag format)
Syntax is <starting>-<ending> to show range (for example 1000-1499). Multiple ranges are allowed and must be separated with a comma or semi-colon (for example, 1000-1099;2500-2599). You can also use 2;4;6 or 2,4,6 for values not in a range.

New Wire Number Placement

NOTE The Insert Wire Number tool does not take the current wire number setting (in-line, above or below) into account when updating existing wire numbers; this setting is used only when inserting new wire numbers. Use the Toggle Wire Number In-Line tool for flipping existing wire numbers among the 3 modes.

Above Wire
Places the wire number above the physical wire.
In-Line
Places the wire number in line with the wire.

Gap Setup
Defines spacing between the wire number and the wire itself.

Below Wire
Places the wire number below the physical wire.

Centered
Specifies to insert the wire number tags in the center of each wire segment.

Offset
Specifies to insert the wire number tags the specified offset distance.

Offset Distance
Specifies a fixed, user-defined offset distance from the left or top of the first wire segment found on the wire network.

Leaders
(This option is unavailable for in-line wire numbers) AutoCAD Electrical places wire numbers on leaders when it determines that the wire number text bumps into something (it does not check if the leader itself overlays another object). Select the method for inserting new wire numbers as leaders: As Required, Always, or Never.

NOTE This change does not affect wire numbers that are already present on the drawing.

Wire Type
Displays the Rename User Columns dialog box that is used for renaming User1 to User20 header columns in the Set Wire Type, Create/Edit Wire Type, and Change/Convert Wire Type dialog boxes.

Project properties: cross-references tab
Modify your project default settings for cross-referencing. Any new drawing files created within the project are saved with the project default settings for cross-referencing.

**Access:**

Click the Project Manager tool. In the Project Manager, right-click the project name, and select Properties.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the project name, and select Properties.

**Cross-Reference Format**

Defines the cross-reference annotation format. One replaceable parameter, %N, must always be part of the cross-reference format string. A typical format string might be just the %N parameter. Use Same Drawing for on-drawing references and Between Drawings for off-drawing references. You can use the same format for both.

**NOTE** AutoCAD Electrical provides some predefined formats for you to use or you can enter your own format using replaceable parameters. (page 126)

**Cross-Reference Options**

**Real time signal and contact cross-referencing between drawings**

Automatically updates relay and wire source and destination symbols cross-referencing across multiple drawings.

**NOTE** If this option is not selected, you are prompted to authorize the update. The target drawing is automatically opened and updated. You then return to the active drawing. Any unauthorized update is queued up in a Project Task List. To update the pending updates, click Project Task List on the Project Manager.

**Peer to Peer**

Cross-references related components while using pneumatic features. Example: schematic - ➤ pneumatic.
Suppress Installation/Location codes when matching the drawing defaults

Suppresses IEC prefixes.

NOTE You need to run the Component Cross-Reference command to update any existing cross-referencing text.

Component Cross-Reference Display

There are different styles of cross referencing AutoCAD Electrical supports:

<table>
<thead>
<tr>
<th>Text Format</th>
<th>Displays cross-referencing as text with any string as a separator between references on the same attribute.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphical Format</td>
<td>Displays cross-referencing using the AutoCAD Electrical graphical font or using contact mapping edit boxes while displaying each reference on a new line.</td>
</tr>
<tr>
<td>Table Format</td>
<td>Displays cross-referencing in a table object, that automatically gets updated in real time, so you can define the columns to display.</td>
</tr>
<tr>
<td>Setup</td>
<td>Displays a dialog box for setting the display defaults for each component cross-reference display format.</td>
</tr>
</tbody>
</table>

Project properties: styles tab

Modify your project default settings for various component styles. All information defined in this tab is saved to the project definition file as project defaults and settings.

Access:

Click the Project Manager tool. In the Project Manager, right-click the project name, and select Properties.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the project name, and select Properties.

Arrow Style

Specifies the default wire signal arrow style. Select from the 4 predefined styles or a user-defined style. You can override the default style setting at insertion time.
### PLC Style
Specifies the default PLC module style. Select from the 5 pre-defined styles or a user-defined style.

**TIP** For instructions on how to add custom PLC module styles, see Add a new PLC style. (page 251)

### Fan-In/Out Marker Style
Defines the default Fan In/Out marker style and the layers for wires going out of a Fan In/Out Source marker and those coming into a Destination marker.

**TIP** For instructions on how to add custom Fan-In/Out marker styles, see Add custom fan-in/out marker styles. (page 548)

### Layer List
Lists the Fan In/Out layers.

**Add**
Defines layer names as Fan In/Out layers.

**Remove**
Removes the selected layer from the defined layer list.

### Wire Cross
Specifies the default mode of operation when wires cross each other: insert gap with no loop, insert gap and loop, or solid (no gap).

### Wire Tee
Specifies the default wire tee marker: none, dot, angle1 or angle2.

### Project properties: drawing format tab
Allows you to modify your project default settings for drawings. All information defined in this tab is saved to the project definition file as a project default.

**Access:**

Click the Project Manager tool. In the Project Manager, right-click on the project name and select Properties.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click on the project name and select Properties.
Ladder Defaults

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical/Horizontal</td>
<td>Specifies whether to create ladders horizontally or vertically.</td>
</tr>
<tr>
<td>Spacing</td>
<td>Specifies the spacing between each rung.</td>
</tr>
<tr>
<td>Default: insert new ladders without references</td>
<td>Sets the default for the Insert Ladder command. New ladders you insert do not have line reference numbering, by default.</td>
</tr>
<tr>
<td>Width</td>
<td>Specifies the width of the ladder.</td>
</tr>
<tr>
<td>Multi-wire Spacing</td>
<td>Specifies the spacing between each rung in multi-wire phases.</td>
</tr>
</tbody>
</table>

Format Referencing

Specifies the default referencing system. There are 3 modes:

<table>
<thead>
<tr>
<th>Reference System</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X-Y Grid</td>
<td>All referencing is tied to an X-Y grid system of numbers and letters along the left-hand side and top of the drawing. Set your drawing's vertical and horizontal index numbers and letters, spacing, and origin in the X-Y grid setup dialog box. <strong>TIP</strong> Use negative spacing values for Horizontal or Vertical if you want to change the X-Y grid system's origin to be other than the upper left-hand corner of the drawing.</td>
</tr>
<tr>
<td>X Zones</td>
<td>Similar to X-Y Grid, but there isn't a Y-axis. Set your drawing's horizontal labels, spacing, and origin on the X Zones setup dialog box. <strong>TIP</strong> Use a negative zone spacing value if you want the zone reference origin to be at the right side of the drawing.</td>
</tr>
<tr>
<td>Reference Numbers</td>
<td>Each ladder column has a column of assigned reference numbers.</td>
</tr>
<tr>
<td>Setup</td>
<td>Specifies how to display reference numbers - number only, numbers in a hexagon, the sheet and number values, and so on.</td>
</tr>
</tbody>
</table>
**Scale**

**Feature Scale Multiplier**
Sets the scale factor used when inserting new components or wire numbers on the drawing. To insert everything 25% bigger than normal, change the edit box value from 1.00 to 1.25. This change does not affect components and wire numbers that are already present on the drawing.

**inch/inch scaled to mm/mm full size**
Select inch if your drawing is to use library symbols from the JIC1/JIC125 libraries or mm full size for the metric scaled symbol libraries. This adjusts the wire connection trap distance that determines whether closely spaced wire ends connector not.

**Tag/Wire Number Order**
Sets the default wire numbering and component tag sort order for the drawing. Your selection overrides the project settings for sort order unless you select No override.

**Layers**
Defines and manages wire and component layers.

*NOTE* No matter what layer is current, wires will always go to a wire layer and components to component layers.

**Drawing properties: drawing settings tab**
Apply a drawing-specific settings that are maintained inside the drawing’s WD_M block and the project .wdp file.

**Access:**

Click the Project Manager tool. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.
**Drawing File**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project</strong></td>
<td>Specifies the project that the drawing is found in.</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>If the drawing is not in any of the currently open projects, &quot;Drawing not in open project&quot; displays instead of the project name. If the drawing is in an open project but it cannot be edited, &quot;Project not available for edit&quot; displays instead of the project name. This happens when a project file is read-only, it is locked by someone else, it is not checked out in Vault, or the folder where the project is located is read-only. When the project is not open or available for edit, you are unable to assign a description for the drawing.</td>
</tr>
<tr>
<td><strong>Description 1-3</strong></td>
<td>Specifies up to 3 lines of description text for the drawing file. The description displays in title block updates and custom drawing properties. This is saved in the project .wdp file. Select from a list of predefined descriptions from the active project by clicking the arrow or select a description from the drawing by clicking Pick.</td>
</tr>
<tr>
<td><strong>For Reference Only</strong></td>
<td>Indicates that the drawing should not be included in tagging, cross-referencing, and reporting functions. If selected, the drawing is included in project-wide plotting and title block operations. This is saved in the project .wdp file.</td>
</tr>
</tbody>
</table>

**IEC-Style Designators**

Specifies IEC default values for the drawing, such as Project (%P), Installation (%I), and Location (%L) fields. When you insert a component, the %I and %L default values are used if the Installation and/or Location values would normally be blank.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project Code</strong></td>
<td>Specifies a project code for the WD_M block definition. This value can be used as the replaceable parameter %P.</td>
</tr>
<tr>
<td><strong>Installation Code</strong></td>
<td>Specifies the installation code for the WD_M block definition. This value can be used as the replaceable parameter %I.</td>
</tr>
</tbody>
</table>
Location Code

Specifies the location code for the WD_M block definition. This value can be used as the replaceable parameter %L.

Drawing

Displays a list of Installation or Location codes from the active drawing.

Project

Displays a list of previously defined Installation or Location codes in the active project or from the Default.INST or Default.LOC file.

Sheet Values

Component, wire, and cross-reference tagging use replaceable parameters in their format. If you reference the drawing’s sheet number or drawing number in any of your tagging formats, then specify a default drawing-wide value to use.

Sheet

Specifies the sheet number value for the drawing settings. This value can be used as the replaceable parameter %S.

Drawing

Specifies the drawing number value for the drawing settings. This value can be used as the replaceable parameter %D.

Section

Specifies the section value for the drawing file saved in the project definition file (.wdp). This value can be used as the replaceable parameter %A.

Sub-Section

Specifies the subsection value for the drawing file saved in the project definition file (.wdp). This value can be used as the replaceable parameter %B.

Drawing properties: components tab
Apply a drawing-specific component settings that are maintained inside the drawing's WD_M block.

**Access:**

Click the Project Manager tool. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.

**Tag Format**

Specifies the way new component tags are created. The tag consists of a minimum of 2 pieces of information: a family code and an alphanumeric reference number (for example, "CR" and "100" to yield a tag like CR100 or 100CR). Optionally, a component tag might contain a sheet number or some user-specified separators. If your format includes the sheet number %S parameter or the drawing number %D parameter, you must enter the values in the edit boxes in the Drawing Properties ➤ Drawing Settings dialog box.

---

**NOTE** AutoCAD Electrical provides a predefined format for you to use or you can enter your own format using replaceable parameters. (page 126)

**NOTE** The %N parameter is mandatory in any component tag format you define.

---

**Search for PLC I/O address on insert**

Searches for a connected PLC I/O module's I/O point. If found, the I/O address value is substituted for the "%N" part of the default component tag.

---

**NOTE** This setting is saved in the MISC_FLAGS attribute on the drawing's WD_M block.

---

**Sequential**

Enter the beginning sequential number for the drawing. Sequential tags can continue uninterrupted from one drawing to the next if you assign the same beginning sequential number to every drawing in your project. As you insert components on any
drawing of the project set, AutoCAD Electrical starts with the value you set and works its way up until it finds the next unused sequential number tag for the target component family.

**NOTE** If you finish a drawing and move to the next, but then later come back to the first drawing to add another component and sequential tag, a gap appears in the numbering sequence for that drawing. Use the AutoCAD Electrical Project-wide Update/Retag tool to retag the whole drawing set.

**Line Reference**

Set up the unique format tag suffix list. This list is used to create unique reference-based tags when multiple components of the same family are located at the same reference location (ex: 3 push buttons on the same line reference "101" could be labeled PB101, PB101A, and PB101B -- AutoCAD Electrical does this using a suffix list of ",", "A", "B", and so on).

**NOTE** The component tag suffix is automatically added to the end of the tag, but you can force AutoCAD Electrical to insert the suffix character somewhere within the tag format. Use the Suffix position parameter, %X, in the component tag format (for example, %N%X - %F).

**Suffix Setup**

Displays the suffix list. The individual items in the suffix list are given in the row of edit boxes across the top of the dialog. List suffix characters for duplicate family components on the same line reference or in the same zone (to keep tags unique). The suffix is added to the end of the component tag. To add it to the inside of the tag, use "%X" in the Tag Format. Example:

- %N-%F or %N%-%F%X = suffix at the end (such as 101-CRA)
- %N%X-%F = add to number, before family code (such as 101A-CR)

Select from the default lists or manually enter your own suffix list in the row of edit boxes.

**Drawing properties: wire numbers tab**
Apply a drawing-specific wire number settings that are maintained inside the drawing's WD_M block.

Access:

Click the Project Manager tool. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.

**Wire Number Format**

Wire number tags can be sequential or reference-based.

**Format**

Specifies the way new wire number tags are created. The wire number tag format must include the %N parameter that is the base sequential or reference-based value per the selection above. If your format includes the sheet number %S parameter or the drawing number %D parameter, you must enter the values in the edit boxes in the Drawing Properties ➤ Drawing Settings dialog box.

**NOTE** For reference-based wire number tagging, individual items in the suffix list are applied to the wire tags to keep multiple wires in the same reference location unique. These are added to the end of the tag, but you can force AutoCAD Electrical to insert the suffix character somewhere within the tag format. Use the Suffix position parameter, %X, in the component tag format (for example, %X%N).

**Search for PLC I/O address on insert**

Specifies to use PLC I/O address values for wires that connect to an addressed I/O point. This overrides both Sequential and Reference-based tagging. New wires or wire renumbering on the current drawing shows PLC I/O address-based wire numbers automatically.

**NOTE** Like component tags, AutoCAD Electrical uses the concept of a wire tag format string with replaceable parameters. The %N parameter must always be part of the wire format string. A typical format string might be just this %N parameter.
### Sequential
Enter the starting sequential number (alpha, numeric, or alphanumeric) for the drawing. If you enter the same starting sequential number for every drawing of your wiring diagram set, AutoCAD Electrical confirms at insertion time that a new sequential wire number tag is not repeated on any other drawing.

If you set DEMO1 to 100 and DEMO2 to 200, the wire numbers on DEMO1 start at 100 and those on DEMO2 start at 200. If DEMO1 has more than 100 wire numbers it starts using wire number 200 and above while DEMO2 would begin its wire numbers where DEMO1 left off (making sure that duplicate wire numbers are not assigned).

### Increment
The default is "1." Setting it to "2" with a starting sequential of "1" would yield wire numbers 1, 3, 5, 7, 9, 11, and so on.

### Line Reference
Sets the wire number tag suffix. This list is used to create unique reference-based wire number tags for multiple wire networks beginning at the same reference location (such as wire network beginning at a location per line reference number, X-Y grid reference, or X-Zone reference).

### Suffix Setup
Displays a suffix list. List suffix characters for wire numbers beginning on the same line reference or in the same zone (to keep wire numbers unique). Select one of the 4 pre-defined suffix lists or enter your own custom suffix list.

### New Wire Number Placement

**NOTE** The Insert Wire Number tool does not take the current wire number setting (in-line, above or below) into account when updating existing wire numbers; this setting is used only when inserting new wire numbers. Use the Toggle Wire Number In-Line tool for flipping existing wire numbers among the 3 modes.

<table>
<thead>
<tr>
<th>Placement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Above Wire</td>
<td>Places the wire number above the physical wire.</td>
</tr>
<tr>
<td>In-Line</td>
<td>Places the wire number inline with the wire.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Gap Setup</td>
<td>Defines spacing between the inline wire number and the wire itself.</td>
</tr>
<tr>
<td>Below Wire</td>
<td>Places the wire number below the physical wire.</td>
</tr>
<tr>
<td>Offset</td>
<td>Specifies to insert the wire number tags the specified offset distance.</td>
</tr>
<tr>
<td>Centered</td>
<td>Specifies to insert the wire number tags in the center of each wire segment.</td>
</tr>
<tr>
<td>Offset Distance</td>
<td>Specifies a fixed, user-defined offset distance from the left or top of the first wire segment found on the wire network.</td>
</tr>
<tr>
<td>Leaders</td>
<td>(This option is unavailable for in-line wire numbers.) AutoCAD Electrical places wire numbers on leaders when it determines that the wire number text bumps into something (it does not check if the leader itself will overlay another object). Select the method for inserting new wire numbers as leaders: As Required, Always, or Never.</td>
</tr>
</tbody>
</table>

**NOTE** This change does not affect wire numbers that are already present on the drawing.

### Drawing properties: cross-references tab

Apply a drawing-specific cross-reference settings that are maintained inside the drawing’s WD_M block. This overrides the project settings since cross-referencing commands look at the WD_M block as the definition for all referencing on the drawing during run-time.

**Access:**

Click the Project Manager tool. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.
Cross-Reference Format

Defines the cross-reference annotation format. One replaceable parameter, %N, must always be part of the cross-reference format string. A typical format string might be just the %N parameter. Use Same Drawing for on-drawing references and Between Drawings for off-drawing references. You can use the same format for both.

NOTE AutoCAD Electrical provides some predefined formats for you to use or you can enter your own format using replaceable parameters. (page 126)

Component Cross-Reference Display

There are different styles of cross referencing AutoCAD Electrical supports:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Format</td>
<td>Displays cross-referencing as text with any string as a separator between references on the same attribute.</td>
</tr>
<tr>
<td>Graphical Format</td>
<td>Displays cross-referencing using the AutoCAD Electrical graphical font or using contact mapping edit boxes while displaying each reference on a new line.</td>
</tr>
<tr>
<td>Table Format</td>
<td>Displays cross-referencing in a table object, that automatically gets updated in real time. You can define the columns to display.</td>
</tr>
<tr>
<td>Setup</td>
<td>Displays a dialog box for setting the display defaults for each component cross-reference display format.</td>
</tr>
</tbody>
</table>

Drawing properties: styles tab

Apply a drawing-specific component styles settings that are maintained inside the drawing's WD_M block.

Access:

Click the Project Manager tool. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.
**Access:**

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.

**Arrow Style**

Specifies the default wire signal arrow style. Select from the 4 predefined styles or a user-defined style. You can override the default style setting at insertion time.

**TIP** For instructions on how to add custom wire arrow styles, see Add custom signal arrow styles. (page 536)

**PLC Style**

Specifies the default PLC module style. Select from the 5 predefined styles or a user-defined style.

**TIP** For instructions on how to add custom PLC module styles, see Add a new PLC style. (page 251)

**Fan-In/Out Marker Style**

Defines the default Fan In/Out marker style and the layers for wires going out of a Fan In/Out Source marker and those coming into a Destination marker.

**TIP** For instructions on how to add custom Fan-In/Out marker styles, see Add custom fan-in/out marker styles. (page 548)

**Layer List**

Lists the Fan In/Out layers.

**Add**

Defines layer names as Fan In/Out layers.

**Remove**

Removes the selected layer from the defined layer list.

**Wire Cross**

Specifies the default mode of operation when wires cross each other: insert gap with no loop, insert gap, and loop, or solid (no gap).

**Wire Tee**

Specifies the default wire tee marker: none, dot, angle1 or angle2.

---

**Drawing properties: drawing format tab**
Apply a drawing-specific format settings that are maintained inside the drawing's WD_M block.

**Access:**

Click the Project Manager tool. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.

### Ladder Defaults

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical/Horizontal</td>
<td>Specifies whether to create ladders horizontally or vertically.</td>
</tr>
<tr>
<td>Spacing</td>
<td>Specifies the spacing between each ladder rung.</td>
</tr>
<tr>
<td>Default: insert new ladders without references</td>
<td>Sets the default for the Insert Ladder command. New ladders you insert do not have line reference numbering, by default.</td>
</tr>
<tr>
<td>Width</td>
<td>Specifies the width of the ladder.</td>
</tr>
<tr>
<td>Multi-wire Spacing</td>
<td>Specifies the spacing between each wire in multi-wire phases.</td>
</tr>
</tbody>
</table>

### Format Referencing

Specifies the default referencing system. There are 3 modes:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X-Y Grid</td>
<td>All referencing is tied to an X-Y grid system of numbers and letters along the left-hand side and top of the drawing. Set your drawing's vertical and horizontal index numbers and letters, spacing, and origin in the X-Y grid setup dialog box. TIP Use negative spacing values for Horizontal or Vertical if you want to change the X-Y grid system's origin to be other than the upper left-hand corner of the drawing.</td>
</tr>
</tbody>
</table>
X Zones

Similar to X-Y Grid, but there isn't a Y-axis. Set your drawing's horizontal labels, spacing, and origin on the X Zones setup dialog box.

**TIP** Use a negative zone spacing value if you want the zone reference origin to be at the right side of the drawing.

Reference Numbers

Each ladder column has a column of assigned reference numbers.

Setup

Specifies how to display ladder line reference numbers - number only, numbers in a hexagon, the sheet and number values, and so on.

Scale

**Feature Scale Multiplier**
Sets the scale factor used when inserting new components or wire numbers on the drawing. To insert everything 25% bigger than normal, change the edit box value from 1.00 to 1.25. This change does not affect components and wire numbers that are already present on the drawing.

**inch/inch scaled to mm/mm full size**
Select inch if your drawing is to use library symbols from the JIC1/JIC125 libraries or mm full size for the metric scaled symbol libraries. This adjusts the wire connection trap distance that determines whether closely spaced wire ends connector not.

Tag/Wire Number Order

**Sort Order**
Sets the default wire numbering sort order for the active drawing. You can set sorting on a per-drawing basis and override the project-wide default setting defined in Properties ➤ Wire Numbers dialog box. For example, you can set the wire numbers to go in a reverse order from the I/O point on a PLC I/O drawing, but have the wire numbers going from left to right for non-PLC I/O drawings.
Layers

Define

Defines and manages wire and component layers.

NOTE No matter what layer is current, wires will always go to a wire layer and components to component layers.

Use replaceable parameters

The Drawing Properties dialog box makes use of codes as replaceable parameters that are encoded on to attributes of the drawing's invisible WD_M block. For example, if you set your component tag format to be %F%N, this format is encoded on to the TAGFMT attribute of the WD_M block. When AutoCAD Electrical assigns a TAG to a component, this format is read and the codes are replaced with the appropriate values.

Replaceable parameters are also used for device tagging, cross-referencing, wire numbering, wire annotation and graphical terminal strips.

For device tagging, cross-referencing and wire numbering

These are defined in the Drawing Properties.

%F Component family code string (for example, "PB," "SS," "CR," "FLT," "MTR")

%S Drawing's sheet number (for example, "01" entered in upper right)

%D Drawing number

%G Wire layer name

%N Sequential or Reference-based number applied to the component

%X Suffix character position for reference-based tagging (not present = end of tag)

%P IEC-style project code (default for drawing)
The %L and %I values used for cross-referencing are the Drawing Default Location and Installation values from the corresponding Parent or Child drawing and not the Location and Installation values of the component itself. If you have a Parent on a drawing that has a default Location of “M” and its child is on a drawing that has a default Location value of “MC,” the cross-referencing on the parent shows the “MC” (drawing default location value of the drawing the child is on) and the child shows the “M” (drawing default location value of the drawing the parent is on) no matter what the location value is on either the parent or child.

**NOTE** If you include %I or %L in your component’s Tag code, you are prompted to calculate the component’s tag if you change the Installation or Location value of the component once it has been inserted.

**Example of Component Tags**
(For relay number 50 on sheet 3)

\[
\%F\%S\%N = CR350
\]

\[
\%F\%N = CR50
\]

\[
\%F-%S-%N = CR-3-50
\]

(For 3 push buttons on line reference 101 using reference-based tagging)

\[
\%P\%N = PB101, PB101A, PB101B
\]

\[
\%N-%F = 101-PB, 101-PBA, 101-PBB
\]

\[
\%N%X%F = 101-PB, 101A-PB, 101B-PB
\]

**Example of Wire Number Formats**
(For wire number 50 on sheet 3)

\[
\%S/%N = 3/50
\]

\[
\%N = 50
\]
W-%S%N = W-350

For defining wire annotation and graphical terminal strips

%P
Terminal pin text

%Q
Terminal pin TERMDESC text

%I
IEC-style installation code

%L
IEC-style location code

%M
Mount assignment (on panel footprint equivalent)

%U
Group assignment (on panel footprint equivalent)

%W
Wire number

%C
Cable tag + conductor/core color combination (format is "tag-color")

%E
Cable tag

%J
Cable conductor/core color

%V
Cable tag substituted for wire number if cable tag is non-blank. The wire number is displayed when a cable ID doesn't exist.

%G
Wire color/gauge (or wire layer name)

%H
Cable wire color substituted for wire number if cable color is non-blank. The wire layer is displayed when a wire conductor in conjunction with a cable ID doesn't exist.

%T
Terminal strip terminal pin assignment

%K
Terminal strip TERMDESC text - useful for multi-stack terminals
%1  Destination component tag ID. You can use only one of the (%number) parameters.

%2  Equivalent of "%1:%P" (comp tag:term)

%3  Equivalent of "%1:%P:%D" (comp tag:term:termdesc)

%4  Equivalent of "%L%1" (IEC comp tag)

%5  Equivalent of "%L%1:%P" (tag:term)

%6  Equivalent of "%L%1:%P:%D" (tag:term:termdesc)

%7  Equivalent of "%I%I%1" (INST prefix+IEC comp tag)

%8  Equivalent of "%I%L%1:%P" (tag:term)

%9  Equivalent of "%I%L%1:%P:%D" (tag:term:termdesc)

The part after the colon(:) is suppressed if the value is blank in %2 - %9 parameters (for example, %2=comp tag:term). The ":term" part is suppressed if blank.

**Save settings to the project file**

The changes you make to the current drawing's configuration are saved on the drawing's invisible WD_M block. You can save a copy of these settings to the project file. This makes the settings available as defaults for new drawings that you might add later to the project. Alternately, you can retrieve selected
settings previously saved in the project file and assign them to the current drawing.

1. Click the arrow on the Drawing Properties tool to access the Settings Compare tool.

2. Click the Settings Compare tool.
   AutoCAD Electrical reads both the settings on the current drawing's WD_M block and a copy of the settings maintained in the current project's .wdp file. Any differences are displayed in a three-column dialog.

3. Highlight the settings you want to copy over from the drawing to the project or vice versa or click Select All to quickly change all of the settings.

4. Click Match Project to make the drawing's settings match the project defaults or click Match Drawing to make the project's settings match those of the current drawing.

5. Click OK.

**NOTE** Changing these settings does not automatically change components and wiring already present in your drawing.

**Compare drawing and project settings**

This tool compares the general/schematic settings carried on the drawing's invisible WD_M block with a copy of the settings saved in the project's .wdp project list file. You can update selected drawing settings (multiple selection is allowed) to make them match the values carried in the master project file or vice versa.

If the Settings Description cell displays in light blue the project and drawing settings don't match. When one column is matched to the other, the cell changes in color to indicate that the record has been changed. The dialog list updates automatically when you make changes and then switch between showing all settings or showing just the different settings.
NOTE Changing these settings does not automatically change components and wiring already present in your drawing.

Access:

Click the arrow on the Drawing Properties tool to access the Settings Compare tool.
From the Projects menu, select Settings Compare.

NOTE You can also access this dialog by right-clicking a drawing name in the Project Manager and selecting Properties ➤ Settings Compare.

You can also right-click any row to access the Match Project or Match Drawing options.

Show All Shows all of the settings in the drawing.

Show Differences Displays settings that are different between the WD_M block and the .wdp file.

Select All Selects all of the settings in the list so you can quickly change all settings to match either the project or the drawing.

Match Project Changes the selected drawing setting to make it match the project. Select the settings from the list, and then click the button.

Match Drawing Changes the selected project default setting to make it match the drawing. Select the settings from the list, and then click the button.

Create a template drawing

Using a template, you can start a new drawing with the WD_M block inserted, settings adjusted, and standard AutoCAD Electrical layers predefined. With
this template, AutoCAD Electrical won’t have to pause and ask permission to insert the block as you start each new wiring diagram drawing.

1 Open a new drawing or start with a copy of your standard drawing border/title block drawing.

2 Select Projects ➤ Drawing Properties.
   This triggers AutoCAD Electrical to insert the invisible WD_M block.

3 In the Drawing Properties dialog box, modify any drawing settings (such as layer naming conventions and tagging formats) and click OK.

4 Select Format ➤ Layer to create any layers you just referenced in the Drawing Properties dialog box.

5 In the AutoCAD Layer Properties Manager dialog box, adjust layer colors and click Apply.

6 Save the drawing as an AutoCAD Drawing Template file with a .DWT extension.
   This template appears in the list of saved templates the next time you open a new AutoCAD Electrical drawing.

**Drawing properties: drawing settings tab**

Apply a drawing-specific settings that are maintained inside the drawing’s WD_M block and the project .wdp file.

**Access:**

- Click the Project Manager tool. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.
- From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.

**Drawing File**

**Project**

Specifies the project that the drawing is found in.
NOTE If the drawing is not in any of the currently open projects, "Drawing not in open project" displays instead of the project name. If the drawing is in an open project but it cannot be edited, "Project not available for edit" displays instead of the project name. This happens when a project file is read-only, it is locked by someone else, it is not checked out in Vault, or the folder where the project is located is read-only. When the project is not open or available for edit, you are unable to assign a description for the drawing.

Description 1-3 Specifies up to 3 lines of description text for the drawing file. The description displays in title block updates and custom drawing properties. This is saved in the project .wdp file. Select from a list of predefined descriptions from the active project by clicking the arrow or select a description from the drawing by clicking Pick.

For Reference Only Indicates that the drawing should not be included in tagging, cross-referencing, and reporting functions. If selected, the drawing is included in project-wide plotting and title block operations. This is saved in the project .wdp file.

IEC-Style Designators
Specifies IEC default values for the drawing, such as Project (%P), Installation (%I), and Location (%L) fields. When you insert a component, the %I and %L default values are used if the Installation and/or Location values would normally be blank.

Project Code Specifies a project code for the WD_M block definition. This value can be used as the replaceable parameter %nP.

Installation Code Specifies the installation code for the WD_M block definition. This value can be used as the replaceable parameter %I.

Location Code Specifies the location code for the WD_M block definition. This value can be used as the replaceable parameter %L.
Displays a list of Installation or Location codes from the active drawing.

Displays a list of previously defined Installation or Location codes in the active project or from the Default.INST or Default.LOC file.

**Sheet Values**

Component, wire, and cross-reference tagging use replaceable parameters in their format. If you reference the drawing’s sheet number or drawing number in any of your tagging formats, then specify a default drawing-wide value to use.

- **Sheet**: Specifies the sheet number value for the drawing settings. This value can be used as the replaceable parameter %S.
- **Drawing**: Specifies the drawing number value for the drawing settings. This value can be used as the replaceable parameter %D.
- **Section**: Specifies the section value for the drawing file saved in the project definition file (.wdp). This value can be used as the replaceable parameter %A.
- **Sub-Section**: Specifies the subsection value for the drawing file saved in the project definition file (.wdp). This value can be used as the replaceable parameter %B.

**Overview of the WD_M block**

A special invisible block must be present on the drawing. The WD_M.dwg is found in the default symbol library. Below is an attribute list of information that is carried on the drawing's WD_M block, broken down by category:
Drawing layout

**SHEET or SHEET_**  
Sheets number for the drawing (%S)

**SHEETDWGNAME**  
Optional drawing number for the drawing (%D)

**IEC_PROJ**  
Optional IEC project code (%P)

**IEC_INST**  
Optional IEC installation code (%I)

**IEC_LOC**  
Optional IEC location code (%L)

**UNIT_SCL**  
Units scaling factor (1.0 = inch, 1.0 = full size mm, 25.4 = inch scaled up to mm)

**FEATURE_SCL**  
Scaling adjustment (0 = default, 1.25 = for 25% bigger)

Ladder defaults

**RUNGHORV**  
Ladder orientation: "H" = horizontal rungs (vertical ladders); "V" = vertical rungs (horizontal ladders)

**REFNUMS**  
Reference numbering system: ladder line-reference based or X-Y grid reference based  
- 1 = line reference numbers  
- 2 = numbers with ruling  
- 3 = user-defined line reference block  
- 4 = X-Y grid reference mode  
- 5 = X-Zone reference mode

**RUNGDIST**  
Default rung spacing

**DLADW**  
Default ladder width

**RUNGINGNC**  
Default rung-to-rung line reference increment (default = 1)
<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DRWRUNG</strong></td>
<td>draw ladder rungs: 0 = none, 1 = draw all rungs for new ladder, 2 = skip 1, 3 = skip 2, and so on.</td>
</tr>
<tr>
<td><strong>PH3SPACE</strong></td>
<td>3-phase bus spacing value</td>
</tr>
</tbody>
</table>

**Component tagging**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TAGMODE</strong></td>
<td>tag mode value: S = sequential, R = reference-based</td>
</tr>
<tr>
<td><strong>TAG-START</strong></td>
<td>drawing's starting sequential number - for sequential tagging only (i.e. &quot;1&quot;)</td>
</tr>
<tr>
<td><strong>TAG-RSUF</strong></td>
<td>comma-delimited component tag suffix list - for reference-based tagging only (i.e. &quot;A, B, C&quot;)</td>
</tr>
<tr>
<td><strong>TAGFMT</strong></td>
<td>component tag format specifier (default=%F%N)</td>
</tr>
</tbody>
</table>

**Wire number tagging**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>WIREMODE</strong></td>
<td>wire number format: S = sequential, R = reference-based</td>
</tr>
<tr>
<td><strong>WIRE-START</strong></td>
<td>drawing's starting sequential number - for sequential tagging only (i.e. &quot;100&quot;)</td>
</tr>
<tr>
<td><strong>WIRE-RSUF</strong></td>
<td>wire tag suffix list - for reference-based tagging only (i.e. &quot;A,B,C&quot;)</td>
</tr>
<tr>
<td><strong>WIREFMT</strong></td>
<td>wire tag format specifier (default=%N)</td>
</tr>
<tr>
<td><strong>WINC</strong></td>
<td>wire number increment</td>
</tr>
<tr>
<td><strong>WLEADERS</strong></td>
<td>wire leaders: 0 = only as required, 1 = always insert wire leaders, 2 = never insert leaders</td>
</tr>
<tr>
<td><strong>GAP_STYLE</strong></td>
<td>wire gap style: 0 = wire gap, 1 = use loops across gaps, 2 = solid crossing (no gap)</td>
</tr>
</tbody>
</table>
SORTMODE retag and wire numbering sort mode

WNUM_OFFSET wire number placement offset distance
(GBL_wd_wnum_offset); same as the project-wide +[19]
value in the .wdp file. 0.0 or missing= centered on wire
(default), >0.0 = offset from top or left end by given dis-
tance

WNUM_FLAGS
- 1’s bit set = (GBL_wd_inline_gap global) auto in line
  wire gap adjust "ON" (see WNUM_GAP attribute for
  settings list)
- 2’s +4’s bits = 00 default wire number above wire
- 01 = below wire

Layer names

TAG_LAY component tag layer
TAGFIXED_LAY fixed component tag layer
DESC_LAY parent component’s description layer
CDESC_LAY child component’s description layer
TERM_LAY component terminal pin numbers layer
XREF_LAY parent component’s cross-reference layer
CXREF_LAY child contact’s cross-reference layer
LOC_LAY component location code layer
POS_LAY component position code layer
MISC_LAY miscellaneous layer
<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMP_LAY</td>
<td>layer for schematic component graphics</td>
</tr>
<tr>
<td>LINK_LAY</td>
<td>dashed link lines layer</td>
</tr>
<tr>
<td>LOCBOX_LAY</td>
<td>location box layer</td>
</tr>
<tr>
<td>WIRELAYS</td>
<td>valid wire layer names where &quot;&quot; = all valid (comma-delimited)</td>
</tr>
<tr>
<td>WIRENO_LAY</td>
<td>valid wire number</td>
</tr>
<tr>
<td>WIRECOPY_LAY</td>
<td>extra wire number layer</td>
</tr>
<tr>
<td>WIREFIXED_LAY</td>
<td>fixed wire layer</td>
</tr>
<tr>
<td>WIREREF_LAY</td>
<td>terminal and signal arrow wire number layer</td>
</tr>
</tbody>
</table>

**Fan In/Out**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAN_INOUT_LAYS</td>
<td>valid layer names for Fan In/Out, single-line wires (comma-delimited)</td>
</tr>
<tr>
<td>FAN_INOUT_STYLE</td>
<td>Fan In/Out symbol style number</td>
</tr>
</tbody>
</table>

**Cross-reference**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XREFFMT</td>
<td>cross-reference format specifier (default=%N)</td>
</tr>
<tr>
<td>ALT_XREFFMT</td>
<td>optional cross-reference format for inter-drawing references (i.e. %S-%N)</td>
</tr>
<tr>
<td>XREF_STYLE</td>
<td>cross-reference style: 0 = text, 1 = graphical, 2 = table</td>
</tr>
<tr>
<td>XREF_FLAGS</td>
<td>1's bit = include unused contacts, 2's bit (if table)= include parent coil</td>
</tr>
<tr>
<td>XREF_UNUSEDSTYLE</td>
<td>0 = separate reference, 1 = contact count totals</td>
</tr>
</tbody>
</table>

138 | Chapter 3  Drawing and Project Properties
XREF_FILLWITH  cross-reference fill-with text
XREF_SORT  0 = sort by line reference, 1 = sort by pin list
XREF_TXTBTWN  cross-reference text between references (text style cross-referencing)
XREF_GRAPHIC  0 = contact mapping (text), 1 = graphic
XREF_GRAPHICSTYLE  0 = JIC, 1 = IEC
XREF_CONTACTMAP  contact mapping list
XREF_TBLSTYLE  table style name
XREF_TBLTITLE  table title
XREF_TBLINDEX  table fields to include
XREF_TBLFLDNAMS  table available field names
XREF_TBLCOLJUST  table fields justification

Referencing
DATUMX  X coordinate origin for X-Y or X-zone
DATUMY  Y coordinate origin for X-Y or X-zone
DISTH  horizontal interval spacing for X-Y or X-zone
DISTV  vertical interval spacing for X-Y referencing
CHAR_H  horizontal starting character for X-Y or X-zone
CHAR_V  vertical starting character for X-Y referencing
HOIRZ_FIRST  X-Y referencing format: 0 = V-H, 1 = H-V

XY_DELIM    X-Y delimiter character

**Styles**

PLC_STYLE   PLC module style code (default = 1)

ARROW_STYLE default signal arrow style number

**Miscellaneous**

WNUM_GAP list of 3 in line wire number/label gap settings (see WNUM_FLAGS
bit 1 for toggle mode); value saved to GBL_wd_inline_gapas a
list. nil or "(num1 num2 num3)"

MISC_FLAGS miscellaneous flags
  ■ 0 = gap
  ■ 1 = loop
  ■ 2 = no gap
  ■ 1's bit = mm full size
  ■ 2's bit = ignore non lay0 lay vector
  ■ 4's bit = use plc wire numbers
  ■ 8's bit = insert new ladders without references
  ■ 16's bit = search for PLC address on component insert
  ■ 32+64 bit =
    ■ 10 = none
    ■ 01 = angle 1
    ■ 11 = angle 2
    ■ 00 = dot
**Make changes to the WD_M block**

You can make changes to the WD_M block so that your settings are always the default.

1. Open an existing AutoCAD Electrical drawing and set the properties and layer names.
2. Save the drawing.
3. Select Projects ➤ Swap WD_M or WD_PNLM Blocks ➤ Update Symbol Library WD_M Block.
4. Select the WD_M - schematic settings to modify and click OK.
   The settings and layer names are collected from the drawing and appropriate adjustments are made to the WD_M block.
5. Save the modified WD_M drawing.

**NOTE** Update your template drawing’s version of the inserted WD_M block if a template drawing exists for your project.

6. Open your template file.
7. Select Projects ➤ Swap WD_M or WD_PNLM Blocks ➤ Update to New WD_M Block, Values, Layers.
   The new version of the WD_M block replaces your existing one.

**Add missing attributes to the WD_M block**

As AutoCAD Electrical adds new features, new attributes are sometimes added to the default WD_M block. However, if your drawing was created with an older WD_M block it may not carry these attributes. AutoCAD Electrical provides an easy way to swap older WD_M blocks with the new WD_M block.

1. Select Projects ➤ Swap WD_M or WD_PNLM Blocks. Select one of the following options:
   - **Update to New WD_M Block, Values, Layers**
     To swap and convert to new layers and values carried on the new WD_M.dwg.
   - **Update to New WD_M Block, No Changes**
     To swap but keep the drawing's existing layer names and values.
To swap and convert to new layers and values carried on the new WD_PNLM.dwg.

To swap but keep the drawing’s existing layer names and values.

2 Select the WD_M drawing to use as the new WD_M block in the drawing.
3 Click Open.

**Copy active drawing settings to**

The WD_M and WD_PNLM blocks carry attribute values that define the default AutoCAD Electrical settings.

**Access:**

From the Projects menu, select Swap WD_M or WD_PNLM Blocks ➤ Update Symbol Library WD_M Block.

**WD_M**

Defines the default schematic settings.

**WD_PNLM**

Defines the default panel settings.

**Alert**

A drawing needs an invisible block, WD_M.dwg, on the drawing to be compatible with AutoCAD Electrical.

The WD_M.dwg block is located in the default symbol library. This block carries about 50 attributes that define settings, layer names, and other default settings that are referenced by AutoCAD Electrical commands.

**NOTE** If the drawing includes panel layout symbols, the block WD_PNLM.dwg is also needed. The WD_M and WD_PNLM blocks can be present on the same drawing.

To insert a WD_M or WD_PNLM block

- If the WD_M block is not present in a new or existing drawing, click OK to insert the block at location 0,0.
If the WD_PNLM block is not present in a new or existing drawing when using panel layout symbols, click OK to insert the block.

To force the drawing settings to match the project settings, select the check box.

**Using Layers**

**Manage layers**

AutoCAD Electrical provides tools for managing and renaming panel and schematic layers. You can use your own layer naming convention with AutoCAD Electrical, as well as change the layer naming used on an existing AutoCAD Electrical drawing using the tools below.

**Manage panel layers**

1. Click the Panel Configuration tool.
2. Click Layers Setup.
3. Specify information for the panel component layers, non-text graphic layers, and nameplate layers.
   When AutoCAD Electrical inserts a footprint, it is modified on the fly to match the layering scheme set up in this dialog.
4. Click OK.

**Rename panel layers**

The Rename Panel Layers tool makes it easy to rename layers one by one, or multiple layers at once by using the Find/Replace method. The advantage to using the AutoCAD Electrical layer rename is that in addition to renaming the layer, AutoCAD Electrical also updates the AutoCAD Electrical layer assignment information carried on the drawing’s WD_PNLM block. For example, if DEMO-PNPG is currently assigned as the Name Plate graphics layer and you rename it to PNPG using the AutoCAD Electrical rename layer
utility, the new layer name will be substituted for DEMO-PNP in the AutoCAD Electrical Panel layer name list.

1. Click the arrow on the Miscellaneous Panel Tools tool to access the Rename Panel Layers tool.

2. Click the Rename Panel Layers tool.

3. To edit an individual layer name, select the layer to edit from the list and click Edit. Enter a new layer name and click OK.

4. To edit multiple layer names, click Find/Replace. Enter the text to find and the text to replace it with in the edit boxes. Click OK.

**Manage schematic layers**

1. Click the Drawing Properties tool.

2. In the Drawing Properties dialog box, click the Drawing Format tab.

3. In the Layers section, click Define.

4. In the Define Layers dialog box, specify information for the component layers and wire number layers. The layer names you choose are what AutoCAD Electrical will use as it inserts the parts and pieces of component symbols and wire numbers. If the layer name you enter doesn’t exist when it comes time for AutoCAD Electrical to insert something onto that layer, AutoCAD Electrical creates that layer on the fly.

5. Click OK.

6. In the Drawing Properties dialog box, click OK.
NOTE You can also change layer properties using the Project Manager tool. In the Project Manager, right-click on the drawing name and select Properties ➤ Drawing Properties (or to change the project default settings, right-click on the project name and select Properties. The settings will be applied to new drawings). In the Drawing Format tab, Layers section, click Define.

**Rename schematic layers**

The Rename Schematic Layers tool makes it easy to rename layers one by one, or multiple layers at once by using the Find/Replace method.

1. Click the arrow on the Drawing Properties tool to access the Rename Schematic Layers tool.

2. Click the Rename Schematic Layers tool.

3. To edit an individual layer name, select the layer to edit from the list and click Edit. Enter a new layer name and click OK.

4. To edit multiple layer names, click Find/Replace. Enter the text to find and the text to replace it with in the edit boxes. Click OK.

NOTE You can also change layer properties using the Project Manager tool. In the Project Manager, right-click on the drawing name and select Properties ➤ Drawing Properties (or to change the project default settings, right-click on the project name and select Properties. The settings will be applied to new drawings). In the Drawing Format tab, Layers section, click Define.

**Define layers**

AutoCAD Electrical automatically manages the wire number and component layers you setup in the drawing settings. No matter which layer is active, wires always go to a wire layer and components go to component layers.

**Access:**

Click the Drawing Properties tool. In the Drawing Properties dialog box, click the Drawing Format tab. In the Layers section, click Define.
Access:

From the Projects menu, select Drawing Properties. In the Drawing Properties dialog box, click the Drawing Format tab. In the Layers section, click Define.

**NOTE** You can also change layer properties using the Project Manager tool. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties. (To change the project default settings, right-click the project name, and select Properties. The settings are applied to new drawings). In the Drawing Format tab, Layers section, click Define.

The layer names you choose are what AutoCAD Electrical uses as it inserts the parts and pieces of component symbols and wire numbers. It doesn't matter what layer is current at the time. If the layer name you enter doesn't exist when it comes time for AutoCAD Electrical to insert something onto that layer, AutoCAD Electrical creates that layer on the fly.

**Component Block Layers**

Displays layer names. Type layer names into the edit boxes. A blank entry inserts that category on the current layer. Multiple categories can be tied to the same layer name (enter the same layer name into multiple edit boxes).

When a schematic component is inserted, the block's graphics are inserted onto the layer listed in the Non text Graphics box. The block's attribute text is automatically moved to the layers listed in the other boxes, based upon attribute function.

<table>
<thead>
<tr>
<th>Layer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Non-Text Graphics</strong></td>
<td>Layer name for all non attribute graphics of a symbol</td>
</tr>
<tr>
<td><strong>Component Tags</strong></td>
<td>Layer name for all parent and child component name tags (for example, “CR101”)</td>
</tr>
<tr>
<td><strong>Fixed Tags</strong></td>
<td>Layer name for component tags that are fixed and are not changed if processed by the RE-TAG command</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Layer name for parent functional description text (for example, “MASTER RELAY”)</td>
</tr>
<tr>
<td><strong>Description (Child)</strong></td>
<td>Layer name for child contact functional description text (a copy of the parent's description)</td>
</tr>
<tr>
<td>Layer Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cross-Reference</td>
<td>Layer name for parent cross-reference text</td>
</tr>
<tr>
<td>Cross-Reference (Child)</td>
<td>Layer name for child cross-reference text</td>
</tr>
<tr>
<td>Pin Numbers</td>
<td>Layer name for terminal pin number text</td>
</tr>
<tr>
<td>Installation/Location</td>
<td>Layer name for optional location and installation code text</td>
</tr>
<tr>
<td>Positions</td>
<td>Layer name for switch position text</td>
</tr>
<tr>
<td>Miscellaneous Text</td>
<td>Layer name for all other component annotation</td>
</tr>
<tr>
<td>Dashed Link Lines</td>
<td>Layer name for dashed lines that can be inserted to show multiple components linked together</td>
</tr>
<tr>
<td>Location Box</td>
<td>Layer name for Location Boxes</td>
</tr>
<tr>
<td>Freeze</td>
<td>If a given layer name exists, this switch (Freeze/Thaw) can be used to hide (freeze) all attributes on that layer. For example, to hide all child cross-reference text, select Freeze next to the Cross-reference (child) edit box. You can also use the AutoCAD LAYER command to do the same thing.</td>
</tr>
<tr>
<td>Apply to entities on layer &quot;0&quot; only</td>
<td>As AutoCAD Electrical inserts a component, it moves the parts and pieces of the symbol to the category layers listed in this dialog. If you do not want an attribute or the graphics of a specific electrical symbol block to be moved to the defined AutoCAD Electrical layers, create your symbol with the entities on some layer other than 0, and then select this switch.</td>
</tr>
</tbody>
</table>

**Wire Number Layers**

Displays wire number layers.

- **Wire Numbers** | Layer name for normal wire numbers
- **Wire Copies**  | Layer name for extra wire number copies
Layer name for fixed wire numbers that do not change with a renumber

Layer name for wire number copies that are part of a terminal or signal arrow symbol

Let's say your current layer is BORDER when you use the AutoCAD Electrical icon menu to insert a 2-position selector switch. The lines and circles of the switch symbol automatically go to layer SYMS, the component’s tag to layer TAGS, the description text to DESC, switch position text to POS, and soon. If a new wire number inserts as a result of the switch breaking an existing numbered wire, the wire number automatically goes to layer WIRENO. All of this happens automatically, while your layer BORDER is current.

**Rename schematic or panel layers**

The Layer Rename and Panel Layer Rename utilities make it easy to rename layers one by one, or multiple layers at once by using the Find/Replace method. In addition to renaming the layer, this also updates the AutoCAD Electrical layer assignment information carried on the drawing’s WD_M block. For example, if DEMO-WIRES is currently assigned as an AutoCAD Electrical wire layer, and you rename it using this utility, the new layer name is substituted for DEMO-WIRES in the AutoCAD Electrical wire layer name list.

**Access:**

Click the arrow on the Miscellaneous Panel Tools tool to access the Rename Panel Layers tool.

From the Panel Layout menu, select Miscellaneous Panel Tools ➤ Rename Panel Layer.

Click the arrow on the Drawing Properties tool to access the Rename Schematic Layers tool.

From the Projects menu, select Rename Schematic Layers.

Click the arrow on the Drawing Properties tool to access the Rename Schematic Layers tool.

From the Projects menu, select Rename Schematic Layers.

Layer Name | Lists the drawing layer names referenced in either the Drawing Properties dialog box or the Panel Layout Configuration dialog box.
Find/Replace  
Replaces a name or substring within a layer name.

Edit  
Edits the selected layer name.

**Panel component layers**

Use this to set the panel component layers, non-text graphic layers, and nameplate layers. When AutoCAD Electrical inserts a footprint, it is modified on the fly to match the layering scheme set up in this dialog.

**Access:**

Click the Panel Configuration tool. Click the Layers Setup button.
From the Panel Layout menu, select Panel Configuration. Click the Layers Setup button.

**Panel Component Layers**  
Lists all of the component layers. Change the layer name for a tag by entering a new name in the edit box. If you do not want an attribute moved to a PNL layer, place that attribute on some other layer than "0" on the block. Then, click on the Ignore above for symbol’s non-lay ents toggle.

**Non-Text Graphic Layers**  
When a panel component is inserted, the block will be inserted on the first layer in the "Non-text Graphics" layer list. Attributes will be moved to the layer defined for its type.

**Nameplate Layers**  
Lists existing nameplate layers for the graphics, tags, and descriptions.

**F**  
(Available if a layer exists already) Use this to freeze or thaw any of the panel layers.

**Find/Replace**  
Performs a global find and replace on the layer names.
Use wire layers

The Set Wire Type tool is used for setting a wire type for new wires only. The wire layer name and the associated wire properties (such as wire color and size) are saved in the drawing file. The chosen wire layer for a new wire is determined by the following:

- When a wire is created from an existing wire, the new wire takes on the same layer as the existing wire. It ignores the current layer and the current wire type.
- When the new wire is started in empty space but ends at an existing wire, the new wire takes on the wire layer of the ending wire, ignoring the current layer and current wire type.
- When a new wire is started at an existing wire and ends at another existing wire, the new wire takes on the layer of the beginning wire.
- If there aren't any wire layers in the drawing, the new wire is drawn in the WIRES layer.
- When a wire starts in empty space and ends at the component wire connection point (or vice versa), the new wire is drawn on the current wire type instead of the layer of the wires already tied to the same component connection points.

Use the Create/Edit Wire Type tool to create new or edit existing wire types or use the Change/Convert Wire Type tool to convert lines to wires.
Create wire layers

Wire layer names for drawings are set up in the Create/Edit Wire Type dialog box.

1 Click the arrow on the Insert Wire tool to access the Create/Edit Wire Type tool.

2 Click the Create/Edit Wire Type tool.

3 In the Create/Edit Wire Type dialog box, click inside the Wire Color column for a blank row and specify a value for the new wire layer.

4 Click inside the Size column and specify a value for the size. The Layer Name is automatically created. If you specified Wire Color: Red and Size: 20, the name RED_20 is assigned to the wire layer you are creating.

5 Click Color, Linetype, or Lineweight to assign values for the new layer.

   NOTE If you want the new wire layer to be the default, click Mark Selected as Default.

6 Click OK.

Add existing wire layers to the drawing

Wire layer names for drawings are set up in the Create/Edit Wire Type dialog box.

1 Click the arrow on the Insert Wire tool to access the Create/Edit Wire Type tool.

2 Click the Create/Edit Wire Type tool.

3 In the Create/Edit Wire Type dialog box, click Add Existing Layer.
4 In the Layers for Line "Wires" dialog box, define the layer name and click OK. You can either enter a name in the edit box or click Pick to select a name from the existing layer list. The layer displays in the wire type grid. If you selected the wrong wire layer, highlight the layer in the dialog box and click Remove Layer. You can then go back into the Layers for Line "Wires" dialog box and select another layer to add.

5 In the Create/Edit dialog box, click Color, Linetype, or Line-weight to assign new values for the layer.

6 Click OK.

Create/edit wire type

This tool creates and edits wire types. Use the grid control to sort and select the wire types for easy modification.

**TIP** Use the Change/Convert Wire Type tool to convert lines to wires or type "T" at the command prompt during wire insertion to use the Set Wire Type tool.

Access:

Click the arrow on the Insert Wire tool to access the Create/Edit Wire Type tool.
From the Wires menu, select Create/Edit Wire Type.

Wire type grid

Displays the wire types used in the active drawing. The the wire layer name and the wire properties like color, size, and user defined properties are listed in the grid. An 'x' in the Used column indicates that the layer name is currently used in the drawing; a blank value in this column indicates that the layer name exists in the drawing but it is not currently being used. The current wire type is highlighted with a gray background; selected wire types highlight in blue.

To rename the User1- User 20 column headers, right-click the project name in the Project Manager and select Properties. In the Project Properties ➤ Wire Numbers dialog box, Wire Type section, click Rename User Columns. In the Rename User Columns dialog box, specify a new column name and click OK. Renaming of user-defined columns is project-specific. You cannot rename the
Color, Size, or Layer Name columns. All of the data corresponding to the header column can be copied, cut, and pasted to another column.

All text fields are editable with the exception of the Layer Name cell; it cannot be edited for existing layers. Left-click to edit the cell or right-click in a cell to display options for modifying the cell contents. If you want to rename a layer, right-click on a cell and select Rename Layer. Right-click options include: Copy, Cut, Paste, Delete Layer and Rename Layer. You can not delete or remove a layer if it is the default layer.

You can select multiple layers to edit or remove by using the Shift or Ctrl keys on your keyboard while picking the wire layer in the wire type list.

You can move the wire type records inside the grid to whatever position you want using drag and drop. Select the wire type record(s) you want to move and drag to the new position in the grid.

**Option**

**Make All Lines Valid Wires**

Makes all existing layers valid wire layers and displays them in the wire type grid.

Once you select to make all of the layers valid wire layers, you can deselect this option if you later decide you want some layers to be wire layers and others to be line layers. All of the layers are removed from the wire type grid. You need to add layers again using the Add Existing Layer option.

**Layer**

Allows you to format the layer name, define or edit the layer color, line type, and line weight.

**Layer Name Format**

Allows you to format the layer name. The program should fill the layer name automatically once you enter a value in color, size based on the format. For example if you enter BLK for color and 10AWG for size, then the layer name will be filled in automatically as BLK_10AWG based on default %C_%S format. Placeholders are supported at any place in the format (i.e. "CUST%C-THIN%S").

Valid wire name format codes are:

- %C = Wire Color
Color Displays the AutoCAD dialog for Layer colors election. The Select Color dialog box highlights the color corresponding to the wire type record. The default color for new records is white. Undefined colors for layers use the default color while creating the layer. Multiple selection is allowed. All wire layers that have been selected can be changed to the desired color.

Linetype Displays the AutoCAD dialog for linetype selection. This Select Linetype dialog box highlights the linetype corresponding to the wire type record. The default linetype for new records is continuous. Undefined line types for layers use the default line type while creating the layer. Multiple selection is allowed. All wire layers that have been selected can be changed to the desired linetype.

NOTE If you need special line types for constructing P&ID or point to point diagrams, you need to load the special line types from the acad.lin text file.

Lineweight Displays the AutoCAD dialog for lineweight selection. The Lineweight dialog box highlights the lineweight corresponding to the wire type record. The default lineweight for new records is default. Undefined lineweights for layers should use the default lineweight while creating the layer. Multiple selection is allowed. All wire layers that have been selected can be changed to the desired lineweight.

Add Existing Layer Displays the Layers for Line Wires dialog box for specifying a layer name. You can also click Pick to select the layer name from the existing layer list that consists of all the layers in the drawing inclusive of the non-wire layers. Only lines on pre-selected layers are processed as wires. Enter a wire layer name in the dialog box. A wildcard used in the name selects a group of layers.
(for example, RED_* selects all layers that begin with "RED_ ").

Remove Layer

Removes the selected layer name from the wire type grid. The layer is no longer a valid wire layer, however the layer remains in the drawing as an AutoCAD line layer.

If multiple layers of one color exist in the drawing, you must select all layers of that color in the wire type grid to activate this button. For example, if there are multiple RED* layers such as RED_AWG18, RED_AWG20, and RED_AWG25, you must select all 3 layers in the wire type grid to enable the button.

NOTE Only unused layers in the active drawing can be deleted.

Mark Selected as Default

Makes the selected layer the default layer for new wire layers and displays the layer name in the dialog box.

OK

NOTE This is available only when one wire type record is selected in the list.

Makes the selected wire type the current wire type. If the selected wire type does not already exist on the drawing, the wire layer is created on the fly and the wire layer name and properties are saved in the drawing file. In order for the layer to be created the following rules apply:

- The layer name must be unique
- The layer name cannot be left blank
- The layer name cannot contain special characters such as / \ : ; ? * | , = ' > <
Change wire types

You can change the wire type using the Change/Convert Wire Type tool or by typing a "T" at the command prompt during wire insertion commands.

1. Click the arrow on the Insert Wire tool to access the Change/Convert Wire Type tool.

2. Click the Change/Convert Wire Type tool.
   Optionally, you can right-click on an existing wire and select Change/Convert Wire Type.

3. In the Change/Convert Wire Type dialog box, select a wire type record in the wire type list, or click Pick to select a wire type record from the drawing.
   If you right-clicked on a wire and selected Change/Convert Wire Type, in the Change/Convert Wire Type dialog box, the wire type corresponding to the selected wire layer is highlighted in the list.

4. Make any selections in the dialog box.
   If Change all wires in the wire network is selected, all wires in the wire network are changed to the new wire type. If unselected, only the selected wire is changed.
   If Convert Lines to Wires is selected, the selected lines are changed to the new wire type. If unselected, the lines are ignored.

5. Click OK.

6. Select the wires or lines in the drawing to change and press Enter.
Override wire type at command prompt

During wire insertion, the current wire type displays at the command prompt. You can override this by typing in the hot key "T" and selecting a new wire type from the Set Wire Type dialog box. The new wire type becomes the current wire type and the command continues with the wire insertion. Use the following commands:

- Wires ➤ Insert Wire
- Wires ➤ Angle Wires ➤ Insert 22.5 Degree Wires (also 45 or 67.5)
- Wires ➤ Multiple Wire Bus
- Wires ➤ Add Rung
- Wires ➤ Ladders ➤ Insert Ladder

**NOTE** If you select Another Bus (Multi-Wire) in the Multiple Wire Bus dialog box, the wires are drawn on the same wire layer as that of the existing wire bus; you do not have the ability to type "T" to change the wire type during wire insertion.

Change/convert wire type

This tool converts lines to wires. Use the grid control to sort and select the wire types for easy modification.

**TIP** Use the Create/Edit Wire Type tool to create and edit wire types or type "T" at the command prompt during wire insertion to use the Set Wire Type tool.

Access:

- Click the arrow on the Insert Wire tool to access the Change/Convert Wire Type tool.
- From the Wires menu, select Change/Convert Wire Type.
- Right-click on an existing wire and select Change/Convert Wire Type.

Wire type grid

Displays the wire types used in the active drawing. The wire layer name and the wire properties like color, size, and user defined properties are listed in the grid. An ‘x’ in the Used column indicates that the layer name is currently used in the drawing; a blank value in this column indicates that the layer name exists in the drawing but it is not currently being used.
To rename the User1-User 20 column headers, right-click the project name in the Project Manager and select Properties. In the Project Properties ➤ Wire Numbers dialog box, Wire Type section, click Rename User Columns. In the Rename User Columns dialog box, specify a new column name and click OK. Renaming of user-defined columns is project-specific. You cannot rename the Color, Size, or Layer Name columns. All of the data corresponding to the header column can be copied, cut, and pasted to another column.

**Pick**

Allows you to pick a wire or line in the active drawing. Once you pick a wire, the corresponding wire type record is highlighted. If you pick a line in the active drawing, you can add the layer where the line resides to the list of valid wire layers. A new wire type record is created automatically.

**Change/Convert**

- **Change All Wire(s) in the Network**
  Changes all the wires in the wire network to the selected wire type record. If unselected, only a single wire is changed to the selected wire type.

- **Convert Line(s) to Wire(s)**
  Changes the lines to the selected wire type in the wire type grid.

**OK**

*NOTE* This is available only when one wire type record is selected in the list.

Makes the selected wire type the current wire type. If the selected wire type does not already exist on the drawing, the wire layer is created on the fly and the wire layer name and properties are saved in the drawing file. In order for the layer to be created the following rules apply:

- The layer name must be unique
- The layer name cannot be left blank
- The layer name cannot contain special characters such as / \ : ; ? * | , = ' 

**Set wire type**

158 | Chapter 3   Drawing and Project Properties
This tool sets wire types for new wires. Use the grid control to sort and select the wire types for easy modification.

**TIP** Use the Create/Edit Wire Type tool to create and edit wire types or the Change/Convert Wire Type tool to convert lines to wires.

**Access:**

Type "T" at the command prompt during wire insertion.

**Wire type grid**

Displays the wire types used in the active drawing. The wire layer name and the wire properties like color, size, and user-defined properties are listed in the grid. An 'x' in the Used column indicates that the layer name is currently used in the drawing; a blank value in this column indicates that the layer name exists in the drawing but it is not currently being used.

To rename the User1-User20 column headers, right-click the project name in the Project Manager and select Properties. In the Project Properties dialog box, Wire Numbers section, click Rename User Columns. In the Rename User Columns dialog box, specify a new column name and click OK. Renaming of user-defined columns is project-specific. You cannot rename the Color, Size, or Layer Name columns. All of the data corresponding to the header column can be copied, cut, and pasted to another column.

**OK**

**NOTE** This is available only when one wire type record is selected in the list.

Makes the selected wire type the current wire type. If the selected wire type does not already exist on the drawing, the wire layer is created on the fly and the wire layer name and properties are saved in the drawing file. For the layer to be created, the following rules apply:

- The layer name must be unique.
- The layer name cannot be left blank.
- The layer name cannot contain special characters such as / ":;?*|,= '<.>.
Optional ENV file assignment for current project

You can create an alternate environment settings ENV file and assign it to the active project. Customer-specific ENV files can be created to store customer settings, paths, libraries, and menus. For a given project, you can assign the appropriate ENV file to the project. The ENV file name reference is saved in the project's WDP drawing list file. Whenever the project is selected, the settings in the referenced ENV file are automatically restored.

Access:

Click the Project Manager tool. Right-click the drawing name and select Settings. On the Current Settings dialog box, click Environment file.

From the Projects menu, select Project ➤ Project Manager. Right-click the drawing name and select Settings. On the Current Settings dialog box, click Environment file.
Symbol Libraries

In this chapter
- Determine symbol block names
- Library Symbol Naming Conventions
- Split a tag name into two pieces
- Use multiple symbol libraries
- Overview of Hydraulic and P&ID symbols
- Attribute Requirements
- Managing Library Symbols
Determine symbol block names

The default symbol subdirectory, jic1, and a companion 0.125 uniform text height library, jic125, each contain hundreds of component symbols in standard AutoCAD *.dwg* file format. These are referenced by AutoCAD Electrical and its icon menuing system and are inserted as standard AutoCAD blocks with attributes. There are two ways to determine the block name of an existing symbol:

**METHOD A**

Insert the symbol from the AutoCAD Electrical icon menu and then use the AutoCAD LIST command to display the block name. Add /Program Files/Autodesk/Electrical/libs/jic1/ as a prefix to this block name to obtain the path to the symbol's *.dwg* file (or /Program Files/Autodesk/Electrical/libs/jic125/ as a prefix for the uniform 0.125 unit text height version).

**METHOD B**

The file WD_MENU.dat lists the symbol descriptions and file names of all components referenced in the AutoCAD Electrical icon menuing system. You can pick the symbol names from this file. Here is an example of how the data looks in this file.

"On delay coil | S2(SHTD1N) | HTD1N".

The "|" characters divide the entry into three sections. The first piece is the description that appears in the menu's side bar, the second in a slide-library reference, and the third is the actual symbol file name. In this example, the file name of the library symbol is htd1n.dwg. The vertical version of this symbol is vtd1n.dwg.

You can select a different name for a component family by creating or editing the WD_FAM.dat file. For example, if you want limit switches to be tagged "LIM" instead of "LS" and you want pilot lights to be "PL" instead of "LT", you would add the following two lines to the file (or create the file if it does not exist):

```
LS,LIM
LT,PL
```

The change takes effect when you exit and reload AutoCAD Electrical. New limit switch components you insert will receive the "LIM" family code annotation instead of the library default of "LS," and pilot lights will be tagged
with "PL" instead of "LT." Use the RETAG command to update previously inserted components.

Overview of symbol naming conventions

AutoCAD Electrical depends on a specific naming convention to enable some of its automation features to work. Though not mandatory, you are urged to follow the naming convention outlined below if you create new AutoCAD Electrical-smart symbols for use with AutoCAD Electrical. This will allow your custom symbols to take full advantage of the AutoCAD Electrical features. View the naming conventions for various AutoCAD Electrical symbols below.

Cable Marker Symbols

AutoCAD Electrical cable conductor marker symbols follow this convention:

- The first character is "H" or "V" for horizontal wire or vertical wire insertion.
- The next two characters are "W0." A zero (0) means that the symbol does not trigger a wire number change through it.
- The fourth character is either 1 or 2: "1" for parent marker or "2" for child marker.
- The remaining characters are not specified.

Examples:

<table>
<thead>
<tr>
<th>Filename</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HW01.dwg</td>
<td>Parent cable conductor marker, horizontal wire insertion</td>
</tr>
<tr>
<td>HW02.dwg</td>
<td>Child cable marker, horizontal wire insertion</td>
</tr>
<tr>
<td>VW01.dwg</td>
<td>Parent cable conductor marker, vertical wire insertion</td>
</tr>
<tr>
<td>VW02.dwg</td>
<td>Child cable marker, vertical wire insertion</td>
</tr>
</tbody>
</table>
Components - General

Schematic components such as relays, switches, pilot lights, and discrete motor control devices (but not PLC I/O symbols) follow this naming convention:

- 32-character block name maximum, first character is either "H" or "V" for horizontal or vertical wire insertion.
- The next two characters are reserved for family type (for example, PB for push buttons, CR for control relays, LS for limit switches). A zero (0) as the second character of the family type (for example, a 0 in the overall symbol name) means that the symbol does not trigger a wire number change through it (for example, T0 for terminals, W0 for cable markers, C0 for connectors).
- The fourth character is generally a 1 or a 2: 2 for child contacts and 1 for everything else (parent or standalone component).
- If the symbol is a contact, then the 5th character is a 1 for normally open, 2 for normally closed.
- The remaining characters are not specified. They are used to keep names unique.

Examples:

- **HCR1.dwg**  
  Control relay coil, horizontal rung insertion
- **VCR1.dwg**  
  Control relay coil, vertical rung insertion
- **HCR21.dwg**  
  Horizontal relay contact, N.O.
- **HCR22.dwg**  
  Horizontal relay contact, N.C.
- **HCR22T.dwg**  
  Horizontal relay contact, N.C., with in-line terminal numbers
- **VPB11.dwg**  
  Vertical push button, parent contact, N.O.
- **VPB21.dwg**  
  Vertical push button, child contact, N.O.
- **HLS11.dwg**  
  Horizontal limit switch, parent, N.O.
HLS11H.dwg  Horizontal limit switch, parent, N.O. Held closed
VLT1RP.dwg  Vertical pilot light, red, press-to-test
HW01.dwg  Horizontal cable marker, no wire number change through it

Component Location Mark Symbols
AutoCAD Electrical expects the location symbol names to begin with the characters "WDXX."

Configuration and Ladder Master Line Reference Symbols
AutoCAD Electrical expects to find these block inserts:

<table>
<thead>
<tr>
<th>Block Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WD_M.dwg</td>
<td>Block insert consisting of about 50 invisible attributes. These carry the drawing’s settings.</td>
</tr>
<tr>
<td>WD_PNLM.dwg</td>
<td>Optional block insert consisting of several invisible attributes. These carry the drawing’s settings for panel layout functions.</td>
</tr>
<tr>
<td>WD_MLRH.dwg</td>
<td>Block insert that carries a ladder’s first line reference number and additional information such as rung spacing and ladder length.</td>
</tr>
<tr>
<td>WD_MLRV.dwg</td>
<td>Same as above but for a ladder that lies on its side.</td>
</tr>
<tr>
<td>WD_MLRHX.dwg</td>
<td>Optional, user-defined alternative to WD_MLRH.dwg. This symbol name is used by AutoCAD Electrical when you select 'User Block' from the Line Reference Numbers subdialog box of the Drawing Properties ➤ Drawing Format dialog box (on the Drawing Properties ➤ Drawing Format dialog box, Format Referencing section, select Reference Numbers and click Setup).</td>
</tr>
<tr>
<td>WD_MLRVX.dwg</td>
<td>Same as above but for a ladder that lies on its side.</td>
</tr>
</tbody>
</table>

NOTE The ladder line reference block used by AutoCAD Electrical is determined by the ladder reference configuration selected in the Format Referencing section of the Drawing Properties ➤ Drawing Format dialog box.
Connector Symbols

- The first character is "H" or "V" for horizontal or vertical orientation.
- The next 2 characters are "CN" for connector.
- The 4th character is either 1 or 2: 1 for parent or 2 for child.
- The 5th character is "_"
- The 6th character is 1-9 for the style number.
- The 7th character:
  (Combo) specifies the plug or jack ID: P = Plug, J = Jack (Receptacle)
  (Only) specifies the wire direction: 1 = right, 2 = top, 4 = left; and 8 = bottom.
- The 8th character is either "P" or "J": P = Plug, J = Jack (Receptacle)

Examples:

- **HCN1_14P.dwg**: Horizontal parent - single (plug) wiring connects from left or bottom
- **VCN2_18P.dwg**: Vertical child - single (plug) wiring connects from left or bottom
- **HCN1_11J.dwg**: Horizontal parent - single (receptacle) wiring connects from right or top
- **VCN2_12P.dwg**: Vertical child - single (plug) wiring connects from right or top

Upon completion of the parametric build connector, a unique new block definition is created. Each connector is labeled with a unique naming convention within the same project.

- **HCN1_14P_nnn**: Horizontal connector; where 'nnn' is a random number for uniqueness
- **VCN1_18P_nnn**: Vertical connector; where "nnn" is a random number for uniqueness
**Hydraulic Symbols**

The maximum number of characters for the block name is 32.

- The first character is "H" or "V" for horizontal wire or vertical.
- The next 2 characters are the first 2 letters of the family name (for example, FI for filters, CY for cylinders, PM for pumps). See Overview of Hydraulic and P&ID symbols (page 174) for a list of symbol family names.
- The 4th character is "1" for hydraulic symbols - stand-alone component.
- Use "." and enter a meaningful name corresponding to the symbol.

**Example:**

HCYL1_plunger_cyl.dwg  Horizontal standalone cylinder; plunger_cyl is the meaningful name for the symbol

**Inline Wire Marker Symbols**

Dumb inline wire marker symbols must be constructed with a tiny piece of "pigtail" line entity at each connection point. This can be very small but it must be present for AutoCAD Electrical to correctly "see" the in-line inserted block as it traces the wire network. Inline wire marker symbols follow this naming convention:

- The first character is "H" or "V" for horizontal wire or vertical wire insertion.
- The next three characters are "T0_"
- The remaining characters are undefined.

**Example:**

HT0_RED.dwg  "RED" inline marker, horizontal wire insert

**P&ID Symbols**

The maximum number of characters for the block name is 32.

- The first character is "H" or "V" for horizontal wire or vertical.
The next 2 characters are the first 2 letters of the family name (for example, GV for diaphragm valves, IN for instruments, N for nozzles). See Overview of Hydraulic and P&ID symbols (page 174) for a list of symbol family names.

The 4th character is "1" for P&ID symbols - stand-alone component.

Use "_" and enter a meaningful name corresponding to the symbol.

Example:

VTK1_ver_tank.dwg  Vertical standalone cyclone; ver_tank is the meaningful name for the symbol

Panel Layout Footprint Symbols

There isn't a required naming convention to follow, but the name must adhere to the AutoCAD 32-character block name limit.

Parametric Twisted Pair Symbols

A parametrically generated twisted pair representation consists to two instances of the same symbol (there are no parent/child versions). This symbol must carry attribute ACE_FLAG with a value of "3." Parametric twisted pair symbols follow this naming convention:

- The first 4 characters are "HT0_" or "VT0_" for horizontal or vertical parametric symbols.
- The remaining characters can be anything (default is set to "TW")

Examples:

HT0_TW.dwg  Horizontal parametric connector symbol
VT0_TW.dwg  Vertical parametric connector symbol

PLC I/O Parametric Build Symbols

These symbols begin with "HP" or "VP" (horizontal rung versus vertical) followed by a digit 1 through 9. The digit corresponds to the selected PLC module style or look (1 through 5 are provided in the AutoCAD Electrical library, 6 through 9 can be user-defined).
Plug/Jack Connector Pin Symbols

AutoCAD Electrical connector symbols follow this convention:

- The first character is "H" or "V" for horizontal wire or vertical wire insertion.
- The next two characters are "C0" if the connector does not trigger a wire number change through it (the "0" meaning that the wire number does not change), or "CN" if the connector DOES trigger a wire number change.
- The 4th character is either 1 or 2: 1 for parent marker or a 2 for child marker.
- The remaining characters are not specified.

Splice Symbols

Splices follow this naming convention:

- The first 4 characters are "HSP1" or "VSP1" for horizontal or vertical splices.
- The 5th through 7th characters are "001", "002", "003," and so on.

Examples:

- HSP1001.dwg — Horizontal splice #1
- VSP1001.dwg — Vertical splice #1
- HSP1003.dwg — Horizontal splice #3

Source/Destination Wire Signal Arrow Symbols

AutoCAD Electrical wire signal arrow symbols follow this convention:

- The first four characters of these symbol names are either "HA?S" for source signal arrows or "HA?D" for destination symbol arrows. The "?" character is the arrow style digit (1 through 4 are provided in the AutoCAD Electrical library and 5 through 9 can be user-defined).
- Characters 5 through 11 can be user-defined.

You can create your own arrow styles using these unused digits (for example, HA5S... and HA5D...). For example, copy Autodesk\Acad...
Access each copied arrow symbols in AutoCAD and edit to suit. Then, to access your new arrow style, set the default arrow style to "5" in the Drawing Properties ➤ Styles dialog box.

**Standalone Cross-Reference Symbols:**

Same naming convention as the Source/Destination Signal symbols (i.e. HA?S* and HA?D*) but without a WIRENO attribute present on the symbol.

**Stand-Alone PLC I/O Point Symbols**

These symbols begin with "PLCIO" and can be up to 32 characters long. There is no naming convention referenced by AutoCAD Electrical other than the "PLCIO" prefix.

**Examples:**

- **PLCIO50E1761-L16AWA.dwg**  
  AB 1761 model L16-AWA with 0.5 unit rung spacing

- **PLCIOI1T.dwg**  
  Standalone input point, single wire connection

**Standalone Terminal Symbols**

Stand-alone terminals follow this naming convention:

- The first two characters are "HT."
- The third character is "0" if the wire number does not change through the terminal, "1" if the terminal symbol should trigger a wire number change.
- The 4th character is an underscore (_) if the terminal carries no attributes for AutoCAD Electrical to process (such as a dumb, unannotated terminal symbol). Otherwise, the 4th through 8th character positions of the symbol file name are user-defined.

**Examples:**

- **HT0001.dwg**  
  Square terminal with annotation, wire number does not change

- **HT1001.dwg**  
  Same as above but wire number changes through the terminal
User-Defined Symbols

AutoCAD Electrical user-defined symbols follow this convention:

- The first character is "H" or "V" for horizontal wire or vertical wire insertion.
- The next two characters are "ZA" through "ZZ."
- The remaining characters can be user-defined.

Wire Dot Symbols

AutoCAD Electrical expects this symbol name to be "WD_DOT.dwg."

Wire Number Symbols

An AutoCAD Electrical wire number is a block insert consisting of a single wire number attribute. The origin of the block insert lies on its wire with the wire number attribute floating above, below, or off to the side of the block's insertion point.

Examples:

- **WD_WNH.dwg**: Wire number for horizontal wire insertion
- **WD_WNV.dwg**: Wire number for vertical wire insertion
- **WD_WCH.dwg**: Extra wire number copy for horizontal wire
- **WD_WCV.dwg**: Extra wire number copy for vertical wire

AutoCAD Electrical also supports inline wire numbers that follow the value of the main wire number. An inline wire marker has a block name that follows that of a terminal symbol that does not trigger a wire number change.

Examples:

- **HT0_W1.dwg**: Inline wire number marker, horizontal wire insertion, short wire number
Split a tag name into two pieces

TAG1_PART1, TAG1_PART2, TAG1_PARTX (as well as TAG2_PART1, TAG2_PART2, TAG2_PARTX) are alternatives to TAG1 and TAG2 that allow you to split a tag name into two pieces and, for example, position one piece above the other on the symbol. You can create drawings with a mix of both symbols having split tags and other symbols carrying just the single TAG1 or TAG2 attribute.

1. Open up the .dwg library symbol drawing that you want to modify.
2. Rename the TAG1 attribute definition to read TAG1_PART1.
3. Add a new attribute definition TAG1_PART2.
4. Position both attribute definitions inside of the symbol's circle graphics (one above the other).
   With this setup, AutoCAD Electrical will automatically split tags like CR104 and 104CR into two pieces (where characters split from numbers to letters) and apply the pieces to these attributes.
5. For instances where there might be a delimiter between the character and number parts of a tag and you don’t want the delimiter to be shown on one part or the other of the visible tag, add attribute definition TAG1_PARTX to the library symbol and mark it “invisible”.
   AutoCAD Electrical will store the split tag’s delimiter in the attribute.
NOTE If a parent symbol has the single TAG1 attribute, related child symbols can have split tag attributes and vice versa. If a parent symbol has split tag attributes, related child symbols do NOT have to have split tag attributes. The symbol's default value character string for the tag should be annotated as a default value on the TAG1_PART1 attribute definition.

Use multiple symbol libraries

You can select the library you want to use for each project. One project might require a JIC-style library, and another an IEC-style library. Each symbol library set must be in its own subdirectory, but adhere to the AutoCAD Electrical file naming convention. You cannot have duplicate symbols in the various symbol libraries.

To set a symbol library to use for a particular project, right-click the project name inside the Project Manager, and select Properties. In the Project Properties ➤ Project Settings dialog box, click the plus sign (+) next to Schematic Libraries or Panel Footprint Libraries. Click Add and enter the library’s path into the edit box or click Default to use the default libraries.

NOTE You can include electrical, pneumatic, or other schematic libraries in the path.

You can also include a series of library paths for AutoCAD Electrical to use. To do this, enter the names of the libraries (in order) with a semicolon between them. For example:

C:/Program Files/Autodesk/Acad {version}/Libs;/C:/\{user path}\{user library}.

AutoCAD Electrical search sequence

AutoCAD Electrical runs through specific search sequences when looking for your symbols.

1. Looks on the drawing for a copy of the requested symbol.
2. Checks for the specific file name if a full path name is provided.
3. Checks in your user subdirectory (given by the WD_USER setting in the .env file).
4. Checks in the directory where the active project's .wdp file is located.
5 Checks in the selected library -- this is the library selected per the active project.
6 Checks the directory containing AutoCAD Electrical support files.
7 Checks the current directory.
8 Checks the path given by the AutoCAD Electrical environment variable.

**Set a symbol library as the default**

1 Exit AutoCAD Electrical.
2 Make a back-up copy of your environment (.env) file. To find the full name and path of your .env file, right-click inside the Project Manager, and select Settings.
3 Open the .env file in a text editor such as Wordpad.
4 Look for a line in the environment file that begins with "WD_LIB."
5 Edit this line to reflect the path of your default library. For example if the path to your new default library is now n:/elec/syms, change the line to read:
   WD_LIB,n:/elec/syms/,AutoCAD Electrical symbols
6 Save and close the file.

Another way to do this is to use an AutoCAD Electrical variable in the WD_LIB line of the .env file. You could use %ACAD_SUP_LAST% or %ACAD_SUP_FIRST% to point to the last (or first) path defined in your AutoCAD Preferences ➤ Support file path.

WD_LIB,%ACAD_SUP_LAST%,AutoCAD Electrical symbols
WD_LIB,%ACAD_SUP_FIRST%,AutoCAD Electrical symbols

**Overview of Hydraulic and P&ID symbols**

The hydraulic symbol library consists of all the hydraulic symbols and is found under C:\Program Files [(x86)]\Autodesk\Acade \{version}\Libs\hyd_iso125.
### Hydraulic family names

<table>
<thead>
<tr>
<th>Family Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FI</td>
<td>Filter</td>
</tr>
<tr>
<td>CYL</td>
<td>Cylinder</td>
</tr>
<tr>
<td>VAL</td>
<td>Valves (directional, throttle valve, pressure valve)</td>
</tr>
<tr>
<td>FC</td>
<td>Flow control valve</td>
</tr>
<tr>
<td>CK</td>
<td>Check valve</td>
</tr>
<tr>
<td>MAN</td>
<td>Manifolds</td>
</tr>
<tr>
<td>PS</td>
<td>Pressure switch</td>
</tr>
<tr>
<td>MOT</td>
<td>Motor</td>
</tr>
<tr>
<td>PMP</td>
<td>Pump</td>
</tr>
<tr>
<td>ACC, CMP</td>
<td>Accumulator, compensator</td>
</tr>
<tr>
<td>MTR</td>
<td>Meter</td>
</tr>
<tr>
<td>FS</td>
<td>Float switch</td>
</tr>
<tr>
<td>HE, HTR</td>
<td>Heat exchanger, heaters</td>
</tr>
</tbody>
</table>

A Piping and Instrumentation Diagram (P&ID) is a schematic illustration of functional relationship of piping, instrumentation and system equipment. P&ID shows all of piping including the physical sequence of branches, reducers, valves, equipment, instrumentation and control interlocks. The P&ID are used to operate the process system.

The P&ID symbol library consists of all the P&ID symbols and is found under C:\Program Files [x86]\Autodesk\Acade {version}\Libs\pid.
# P&ID family names

<table>
<thead>
<tr>
<th>Family Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CT</td>
<td>Equipment: Cooling tower</td>
</tr>
<tr>
<td>TK</td>
<td>Equipment: Cyclone</td>
</tr>
<tr>
<td>E</td>
<td>Equipment: Engine, exchanger</td>
</tr>
<tr>
<td>C</td>
<td>Equipment: Turbine, compressors</td>
</tr>
<tr>
<td>F</td>
<td>Equipment: Fans</td>
</tr>
<tr>
<td>M</td>
<td>Equipment: Mixer, agitators</td>
</tr>
<tr>
<td>TK, V</td>
<td>Tanks and vessels</td>
</tr>
<tr>
<td>N</td>
<td>Nozzles</td>
</tr>
<tr>
<td>P</td>
<td>Pumps</td>
</tr>
<tr>
<td>FIT</td>
<td>Fittings</td>
</tr>
<tr>
<td>GVA</td>
<td>Valves</td>
</tr>
<tr>
<td>ACT</td>
<td>Actuators</td>
</tr>
<tr>
<td>LOG</td>
<td>Logic Functions</td>
</tr>
<tr>
<td>INS</td>
<td>Instrumentation</td>
</tr>
<tr>
<td>FLW, FE</td>
<td>Flow</td>
</tr>
</tbody>
</table>
## Attribute Requirements

### Overview of schematic attributes

The following are attribute requirements for various categories of schematic symbols. Note that some attributes are used in multiple categories.

### Schematic parent and child components

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAG1</td>
<td>(Parent only) Attribute for required component tag name (64 characters maximum). The default value you assign to this attribute definition becomes the family code character string AutoCAD Electrical uses to build the component’s tag name when the block is inserted into your schematic. This default value character string is used as the Family Code (%F) portion of the drawing’s tag format code you set up in the Properties dialog box. <strong>Example:</strong> the TAG1 attribute definition on the symbol carries a default value of “MCR” and the drawing’s tag format is “%F%N” where %N is the placeholder for the line reference number or next sequential number. As each instance of this symbol is inserted, it will automatically be assigned a tag name with an “MCR” prefix tacked on to the reference or next sequential number. <strong>NOTE</strong> When a component is marked with a fixed tag, this attribute name is automatically changed with a “F” suffix (i.e. TAG1 ➤ TAG1F).</td>
</tr>
<tr>
<td>TAG2</td>
<td>(Child only) This is a copy of the parent component’s tag name (64 characters maximum). If no parent tag is found then AutoCAD Electrical displays the attribute definition’s default value (ex: “MCR” or “PB” or “X”).</td>
</tr>
<tr>
<td>TAG1_PART1</td>
<td>(Parent only) Alternate to using a single TAG1 attribute (64 characters maximum). This allows the component tag name to be split into two pieces (example: two lines - “MDOT” on first line and “123” on the</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>second line for a full tag name of &quot;MOT123&quot;). AutoCAD Electrical pastes the values on these two attributes together when it processes the component. To include a delimiter character in the tag name but not show it on the drawing (for example, &quot;MOT-123&quot; but just show &quot;MOT&quot; and &quot;123&quot;), then a third attribute definition marked invisible, &quot;TAG1_PARTX&quot; can be added to carry the dash delimiter.</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** The default for the %F tagging parameter, as described in TAG1 above, is carried on the TAG1_PART1 piece of the attribute pair. If a component with a split tag is marked as Fixed, the attribute names are automatically changed to "TAG1F_PART1" and "TAG1F_PART2." |

<table>
<thead>
<tr>
<th>TAG2_PART1</th>
<th>(Child only) Same as above but for child components (64 characters maximum).</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAG2_PART2</td>
<td>Optional attribute that can carry a copy of whatever AutoCAD Electrical assigns to the tag name attribute - TAG1 or the split tag attribute combination (64 characters maximum).</td>
</tr>
<tr>
<td>COPYTAG</td>
<td>Attribute used to hold manufacturer name or code (24 characters maximum). This attribute is generally marked as invisible. MFG01 - MFG10: Optional invisible attributes for manufacturer name or code for up to 10 additional &quot;Multiple Catalog&quot; part number assignments (24 characters maximum each). If these attributes are not present and AutoCAD Electrical needs to store the additional part number information, it is saved on the inserted symbol as Xdata. <strong>NOTE</strong> MFG, CAT, and ASSYCODE generally appear on parent components only; not child contact symbols.</td>
</tr>
<tr>
<td>MFG</td>
<td>Attribute used to hold catalog part number assignment (60 characters maximum). This attribute is generally marked as invisible. CAT01 - CAT10: Optional invisible attributes for catalog number code for up to 10 additional &quot;Multiple Catalog&quot; part number assignments (60 characters maximum each). If these attributes are not present and AutoCAD Electrical needs to store the additional part number information, it will be saved on the inserted symbol as Xdata.</td>
</tr>
</tbody>
</table>

178 | Chapter 4  Symbol Libraries
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASSYCODE</td>
<td>Invisible attribute for optional subassembly code that causes AutoCAD Electrical to look for subassembly items to extract into BOM reports (60 characters maximum). These subassembly items must be defined in the active catalog lookup file in the ASSYCODE and ASSYLIST fields. The value for this attribute is generally set automatically when the user makes a selection from the catalog lookup that carries sub-assembly information. ASSYCODE01 - ASSYCODE10: Optional invisible attributes for sub-assembly code for up to 10 additional Multiple Catalog part number assignments (24 characters maximum each). If these attributes are not present and AutoCAD Electrical needs to store the additional part number information, it will be saved on the inserted symbol as Xdata.</td>
</tr>
<tr>
<td>FAMILY</td>
<td>Invisible attribute that carries the components family type (ex: &quot;CR&quot;, &quot;TD&quot;, &quot;M&quot;, &quot;PB&quot;; 8 characters maximum). Generally, the FAMILY attribute definition's default value is the same as the default value for the component’s TAG1 or TAG2 attribute. It is used as a check at the time child components are linked to a parent. On a family mismatch, an alert dialog displays. A generic child device can be linked to any type of parent symbol if the child’s Family attribute value is left blank. AutoCAD Electrical will fill it in on the fly with the parent’s FAMILY code when the link is made.</td>
</tr>
<tr>
<td>DESC1</td>
<td>DESC1: Description, first or only line of description text (60 characters maximum).</td>
</tr>
<tr>
<td>DESC2</td>
<td>DESC2: 2nd line of description text.</td>
</tr>
<tr>
<td>DESC3</td>
<td>DESC3: 3rd line of description text.</td>
</tr>
<tr>
<td>INST</td>
<td>Optional component installation code (for example, &quot;MACH1&quot;; 24 characters maximum).</td>
</tr>
<tr>
<td>LOC</td>
<td>Optional component location code (for example, &quot;FIELD&quot;, &quot;JBOX2&quot; ; 16 characters maximum).</td>
</tr>
<tr>
<td>XREFNO</td>
<td>(Parent only) Attributes to hold normally open and normally closed cross-reference annotation. These attributes automatically switch to invisible if graphical cross-referencing is applied to the component symbol.</td>
</tr>
<tr>
<td>XREFNC</td>
<td></td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **XREF**  | This attribute can be used in two different ways. It can be used for a combined list of normally open and normally closed contacts. AutoCAD Electrical underlines the closed contacts. If XREFNO and XREFNC are present then this XREF attribute will be used to carry undefined, non-NO/NC references.  

**NOTE**: If XREF is not present then non-NO/NC contacts are included with the XREFNO annotation. |
<p>| <strong>CONTACT</strong> | Invisible attribute present when the symbol is a contact. The value of this attribute is the contact’s de-energized state (ex: &quot;NO&quot; or &quot;NC&quot; or any text string with an embedded &quot;NO&quot; or &quot;NC&quot; such as &quot;NO-TC&quot;. Use &quot;NULL&quot; as the contact attribute’s value if you want to exclude the contact from being included in any AutoCAD Electrical cross-reference text annotation.) |
| <strong>POSn</strong>  | Attribute to mark switch position text where &quot;n&quot; is the position number digit (POSl through POS12; 24 characters maximum). You can leave the default value blank and then fill it in at component insertion time. |
| <strong>STATE</strong> | Optional contact state character string to denote relationship between switch positions and open/closed contact state. It is for display only. You can leave the default value blank and then fill it in at component insertion time. |
| <strong>RATINGn</strong> | Optional rating / value attribute text where &quot;n&quot; is a digit starting with &quot;1&quot; (60 characters maximum). AutoCAD Electrical supports up to 12 RATINGn attributes (for example, RATING1 through RATING12) on the component symbol. These assignments can be pulled into various AutoCAD Electrical reports. |
| <strong>X?LINK</strong> | Optional invisible attribute that allows AutoCAD Electrical to automatically tie in dashed link lines between related components (instead of cross-reference annotation). The &quot;?&quot; is a digit that indicates the preferred link line connection direction and follows the wire connection convention (see X?TERMi below). |
| <strong>PINLIST</strong> | (Parent only) Optional invisible attribute carried on a parent symbol for storing the allowed contact pin list for the parent’s child contacts |</p>
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PEER_PINLIST</td>
<td>(Parent only) Similar to above but is used to temporarily hold a second pin list that is later retrieved during insertion of a peer parent device. For example, a reversing motor starter contactor might be a single component with a single part number, but has a parent coil and a peer reversing coil. Each is to receive its own unique pin list. The catalog lookup assignment pulls both sets of pin lists to the parent. Then, inserting the peer reversing coil and referencing the parent, the peer's pin list is retrieved from this temporary storage attribute (or Xdata) on the parent and pulled over to the peer.</td>
</tr>
<tr>
<td>WDTAGALT</td>
<td>(Parent only) Optional attribute carried on a parent symbol used for setting up a peer-to-peer relationship. It stores the cross-reference tag name of a related symbol shown on a different drawing type (ex: instrument drawing or pneumatic drawing vs. electrical schematic). For example, an instrument drawing might be included in an AutoCAD Electrical project drawing set with a valve marked &quot;FY201&quot;. On the electrical schematics, the solenoid for this instrument valve is tagged &quot;SV456&quot;. The WDTAGALT attribute carried on the schematic valve symbol can be annotated with the &quot;FY201&quot; instrument tag name and a WDTAGALT attribute on the instrument diagram's symbol carries the &quot;SV456&quot; tag name pointing back at the schematic representation. With this in place, AutoCAD Electrical can cross-reference between them, do auto-update, and enable surfing from one drawing type to the other.</td>
</tr>
<tr>
<td>NOTE</td>
<td>For cross-referencing to include these peer references, make sure that the Peer-to-peer toggle is turned on (under Project Properties ➤ Cross-Reference tab).</td>
</tr>
<tr>
<td>WDTYPE</td>
<td>Optional attribute used in conjunction with WDTAGALT above. The value of this attribute is displayed (for informational purposes only) in the surf window description for peer items during a surf operation. A typical attribute assignment might be &quot;PID&quot; for a peer symbol used on an instrument drawing or &quot;Hyd&quot; for a peer symbol appearing on a hydraulic schematic.</td>
</tr>
</tbody>
</table>
### Attribute Description

**WD_WEBLINK**
Attribute carried on a parent symbol for embedding Internet URL’s, ".pdf", ".xls", or ".doc" links that can be surfed on. The attribute value should be the URL, .pdf, .xls, or .doc document file name that should be displayed when selected from the component’s Surf dialog. Multiple weblink attributes can be assigned to a symbol. Use attribute names with the WD_WEBLINK prefix, for example, WD_WEBLINK1 and WD_WEBLINK2.

### Wire connection/terminal pin number pairs

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
</table>
| X?TERMn         | Invisible wire connection attributes where an external wire connects to the attribute’s origin point. The “n” character is an incremented digit starting at “01” used to keep multiple wire connection point attribute names unique. It also provides a link to an associated terminal number (TERMN) and a terminal description (TERMDESCn) attribute. The “?” character position is used to identify the preferred wire connection direction:  
  ■ 1: wire connects to the attribute from the right  
  ■ 2: wire connects to the attribute from above  
  ■ 4: wire connects to the attribute from the left  
  ■ 8: wire connects to the attribute from below  
  ■ 0: special for motor connections that radiate from a circle  
  
If more than 99 terminals are present on a single symbol, the “n” value can continue with double alpha letters/numbers such as "A0," "A1," "AZ," "B0" and so on. |
| X?TERMDESCn     | Optional wire connection description attributes that match up with X?TERMn wire connection attributes (128 characters maximum). These value assigned to each termination description attribute can be extracted into various wire connection reports or merged onto panel wiring diagram representations of schematic symbols. |

**NOTE** X?TERMn attributes can be stand-alone, meaning there isn’t an associated TERMn attribute.
Attribute | Description
--- | ---
TERMn | Optional terminal pin number attribute where "n" is a two-digit number (starting at 01) that is used to match up with the corresponding X?TERMn wire connection attribute (10 characters maximum). A single TERMn attribute can have 2, 3, or 4 wire connection attributes associated with it. For example, a round, stand-alone terminal symbol having a single terminal in number attribute TERM01 can carry 4 wire connection attributes to allow connection from any direction. All 4 wire number attribute names would end with 01 to link them all to the common terminal pin number attribute.

WD_JUMPERS | Optional internal wire jumpers attribute that can be encoded to link sets of terminals together so AutoCAD Electrical will consider them internally jumpered when calculating wire number assignments and processing wire connection and from/to reports. For example, a WD_JUMPERS attribute value of ((01 02)) will flag AutoCAD Electrical to treat wire connection X?TERM01 as electrically jumpered to XD?TERM02. WD_JUMPERS attribute value of ((01 04)(02 05 06)) means that wire connection X?TERM01 and X?TERM04 will be treated as internally jumpered together and X?TERM02, X?TERM05, and X?TERM06 are viewed as jumpered together.

**NOTE** You can keep jumpers from displaying in Wire From/To reports by placing the jumpers on a layer that contains the substring "JUMPER."

---

**Schematic connector parametric build symbols**

The parametric connector is made up of a series of master symbols; one parent and multiple children (default library symbol names HCN1_1*.dwg, VCN1_1*.dwg, HCN2_1*.dwg, VCN2_1*.dwg). Below is a list of attributes for these symbol types.

**Parent and Child Pin symbol attributes**
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAG1</td>
<td>(Parent only) Same as above.</td>
</tr>
<tr>
<td>TAG2</td>
<td>(Child only) Same as above.</td>
</tr>
<tr>
<td>INST</td>
<td>Same as above.</td>
</tr>
<tr>
<td>LOC</td>
<td>Same as above.</td>
</tr>
<tr>
<td>MFG</td>
<td>(Parent only) Same as above.</td>
</tr>
<tr>
<td>CAT</td>
<td>Same as above.</td>
</tr>
<tr>
<td>ASSYCODE</td>
<td>Same as above.</td>
</tr>
<tr>
<td>FAMILY</td>
<td>Same as above.</td>
</tr>
<tr>
<td>GENDER</td>
<td>Invisible attribute with blank value.</td>
</tr>
<tr>
<td>ACE_FLAG</td>
<td>Invisible attribute with a value of &quot;2&quot; for all parametric connector symbols and a value of &quot;1&quot; for splice symbols (1 character maximum).</td>
</tr>
<tr>
<td>DESC1</td>
<td>Same as above.</td>
</tr>
<tr>
<td>DESC2</td>
<td>Same as above.</td>
</tr>
<tr>
<td>DESC3</td>
<td>Same as above.</td>
</tr>
<tr>
<td>X?LINK</td>
<td>Same as above.</td>
</tr>
<tr>
<td>WDBLKNAM</td>
<td>(Parent only) Invisible attribute with a value of &quot;HC0&quot; (0 = zero; 32 characters maximum). This is used to flag access of the &quot;C0&quot; connector table in the catalog lookup database file.</td>
</tr>
</tbody>
</table>

**Parametric Connector - Wire Connection attributes**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TERM01P</td>
<td>Attribute for terminal pin number (for plug pin number).</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>TERM01J</td>
<td>Attribute for terminal pin number (for receptacle pin number).</td>
</tr>
<tr>
<td>X?TERM01P</td>
<td>Invisible wire connection attributes for plug and receptacle side respectively. The &quot;?&quot; is the wire connection direction digit (1, 2, 4, or 8).</td>
</tr>
<tr>
<td>X?TERM01J</td>
<td>Attribute for terminal pin description for plug side and receptacle side respectively. The &quot;?&quot; digit is same as above.</td>
</tr>
<tr>
<td>X?WIRE01P</td>
<td>Attribute for wire connection annotation for plug side and receptacle side respectively. The &quot;?&quot; digit is same as above.</td>
</tr>
<tr>
<td>X?WIRE01J</td>
<td>Attribute for terminal pin description for plug side and receptacle side respectively. The &quot;?&quot; digit is same as above.</td>
</tr>
<tr>
<td>X?_TINY_DOT_DONT_REMOVE_01P</td>
<td>Visible attribute, very small, single character value (a &quot;.&quot;) that must remain visible and must be placed at the exact insertion location of the Xn-TERM01P and XnTERM01J attributes. This attribute is needed to maintain wire connection integrity if a connector pin is moved beyond the end of the connector shell. The &quot;?&quot; digit is same as above.</td>
</tr>
</tbody>
</table>

**Schematic terminal symbols**

The following attributes can be used for terminal symbols or multi-connection sequence terminal symbols (default library symbol block names HT00*.dwg, VT00*.dwg, HT10*.dwg, VT10*.dwg, HT0W*.dwg, VT0W*.dwg).

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAGSTRIP</td>
<td>Attribute to carry terminal strip tag name (24 characters maximum).</td>
</tr>
<tr>
<td>X?TERM01</td>
<td>Attribute for wire connection (up to 4 attributes positioned at each end of the symbol’s horizontal and vertical axes with the ‘n’ part giving the wire connection direction digit as described above).</td>
</tr>
</tbody>
</table>
### Attribute Description

**X?TERMDESC01**  
Attributes used internally by the Terminal Strip Editor command.

**X?PIN01**  

**STRIPSEQ**

**LINKTERM**

**WIRENO** or **TERM01**  
Attribute to carry the terminal number assignment (24 characters maximum). If the terminal is to automatically display the wire number value of the wire network that it is inserted into, then WIRENO attribute must be present. Otherwise, if the attribute is to carry a terminal pin assignment independent of the wire number, attribute TERM01 must be used.

**INST**  
Same as above.

**LOC**  
Same as above.

**MFG**

**CAT**

**ASSYCODE**

**WDBLKNAM**  
Optional invisible attribute with value of "TRMS" to force access of the TRMS table in catalog lookup (32 characters maximum).

### Special Multiple Connection Sequence Terminal symbol

The following attributes can be used for this special type of terminal symbol. This single symbol instance can be used to define a series of up to six terminal strip inter-connections (example, a wire that passes through a series of shipping split terminal strips). Default library symbol block names H--1_multi*.dwg, V--1_multi*.dwg.

#### Attribute Description

**WD_#_TAGSTRIP**  
Attribute to carry terminal strip number (16 characters maximum). Use WD_1_TAGSTRIP for the first terminal strip number and select from WD_2_TAGSTRIP through WD_6_TAGSTRIP for the next terminal number in the sequence.
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WD_#_TERMNO</td>
<td>Attribute to carry optional terminal number. Use WD_1_TERMNO for the first terminal strip number and select from WD_2_TERMNO through WD_6_TERMNO for the next terminal number in the sequence.</td>
</tr>
<tr>
<td>WD_#_INFO</td>
<td>Attribute to carry additional information such as installation, location, catalog, and item number assignments; and any connected cable information. Use WD_1_INFO for the first terminal strip number and select from WD_2_INFO through WD_6_INFO for the next terminal number in the sequence.</td>
</tr>
<tr>
<td>X?TERM01</td>
<td>Attribute for wire connections on each end of the symbol, the '?' character is the wire connection direction, same as above.</td>
</tr>
<tr>
<td>X?TERM02</td>
<td></td>
</tr>
</tbody>
</table>

**Source/Destination wire signal symbols**

These symbols allow a wire to jump from one place to another, either within a drawing or across multiple drawing. Default library symbol names are HAxSn.dwg, HAxDn.dwg where "x" = style digit and "n" = orientation 1, 2, 3 or 4.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIGCODE</td>
<td>Attribute carries unique signal code that is user defined as the symbol is inserted (32 characters maximum). This value is used to match up each source signal symbol with it one or more destination signal symbols.</td>
</tr>
<tr>
<td>WIRENO</td>
<td>Attribute carries a copy of the wire number that gets assigned to the wire that the signal symbol is attached to (24 characters maximum). This attribute can be hidden, if desired.</td>
</tr>
<tr>
<td>XREF</td>
<td>Attribute carries the reference location for the matching source or destination symbols. Updates automatically with the Update Signal References tool or Auto Wire Numbers tool.</td>
</tr>
<tr>
<td>DESC1</td>
<td>Optional description attribute (60 characters maximum).</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>SHEET</td>
<td>Optional attribute for the SHEET (%S) value assigned in the Drawing Settings (12 characters maximum). Updates automatically with the Update Signal References tool or Auto Wire Numbers tool.</td>
</tr>
<tr>
<td>DWGNAM</td>
<td>Optional attribute for the DWGNAM (%D) value assigned in the Drawing Settings (40 characters maximum). Updates same as above.</td>
</tr>
<tr>
<td>X?TERM01</td>
<td>Attribute for wire connection where the “?” character is the wire connection direction, same as above.</td>
</tr>
</tbody>
</table>

**Stand-Alone Source/Destination cross-reference symbols**

These symbols are similar to the above except there is no wire connection attribute and no WIRENO attribute. Default library symbol names are HAxS1_REF.dwg, HAxD1_REF.dwg where "x" = style digit.

**In-line wire labels or wire numbers**

These symbols insert into a wire, break the wire, and reconnect at each end. They carry a text label or wire number in the gap between the connected wire ends. They symbols can dynamically adjust their gap to accommodate the width of the in-line text. Default library symbol block names are HT0_*_.dwg, VT0_*_.dwg.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COLOR or WIRENO</td>
<td>Visible attribute for the text label (COLOR) or in-line wire text (WIRENO) (24 characters maximum). This attribute is center or middle justified and placed midway between the pair of wire connection attributes listed below.</td>
</tr>
<tr>
<td>X?TERM01</td>
<td>Pair of invisible wire connection attributes where the wires connect. Connection is made to each attribute's origin point. The &quot;?” character position in each attribute name identifies the wire connection direction:</td>
</tr>
</tbody>
</table>
### Attribute Description

- **8**: wire connects to the attribute from below

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X2_TINY_DOT_DONT_REMOVE</strong></td>
<td>Visible attribute, very small, single character value (a &quot;.&quot;) that must remain visible and must be placed at the exact insertion location of each of the XnTERM01 attributes. This attribute is needed to allow the gap to auto-adjust to text width and to maintain connectivity through the symbol if the in line label or wire number text is blanked or grows small compared to the total gap width in the wire.</td>
</tr>
</tbody>
</table>

### PLC single I/O point symbols

These attributes need to be present on single, stand-alone I/O symbols with one or two wire connections. Default library symbol block names are PLCIOI*.dwg and PLCIOO*.dwg.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAG1</td>
<td>Attribute for PLC I/O module tag name (parent / child) with the default attribute definition value for the parent symbol becoming the &quot;%F&quot; part of the tag name format (64 characters maximum).</td>
</tr>
<tr>
<td>TAG2</td>
<td></td>
</tr>
<tr>
<td>TAGA01</td>
<td>Attribute for the I/O address (32 characters maximum).</td>
</tr>
<tr>
<td>INST</td>
<td>Same as above.</td>
</tr>
<tr>
<td>LOC</td>
<td></td>
</tr>
<tr>
<td>XREF</td>
<td>Same as above.</td>
</tr>
<tr>
<td>TERM01L</td>
<td>Attribute for terminal pin number on each side (10 characters maximum). If just a single wire connection then the attribute name is TERM01.</td>
</tr>
<tr>
<td>TERM01R</td>
<td></td>
</tr>
<tr>
<td>X?TERM01L</td>
<td>Attributes for wire connections on each side. If just a single wire connection then the attribute name is X?TERM01 where the &quot;?&quot; character is the wire connection direction.</td>
</tr>
<tr>
<td>X?TERM01R</td>
<td></td>
</tr>
</tbody>
</table>
### Attribute

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TERMDESC01L</strong></td>
</tr>
<tr>
<td><strong>TERMDESC01R</strong></td>
</tr>
<tr>
<td><strong>MFG</strong></td>
</tr>
<tr>
<td><strong>CAT</strong></td>
</tr>
<tr>
<td><strong>ASSYCODE</strong></td>
</tr>
<tr>
<td><strong>DESCA01 - DESCE01</strong></td>
</tr>
<tr>
<td><strong>LINE1</strong></td>
</tr>
<tr>
<td><strong>LINE2</strong></td>
</tr>
<tr>
<td><strong>DESC</strong></td>
</tr>
<tr>
<td><strong>FAMILY</strong></td>
</tr>
</tbody>
</table>

### Splices

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>XnWIRE01</strong></td>
</tr>
<tr>
<td><strong>XnWIRE02</strong></td>
</tr>
<tr>
<td><strong>TERMDESCxx</strong></td>
</tr>
<tr>
<td><strong>ACE_FLAG</strong></td>
</tr>
</tbody>
</table>
### Parametric Twisted Pair symbols

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X?TERM01</td>
<td>Pair of invisible wire connection attributes where the wires connect. Connection is made to each attribute's origin point. The &quot;?&quot; character position in each attribute name identifies the wire connection direction:</td>
</tr>
<tr>
<td></td>
<td>■ 1: wire connects to the attribute from the right</td>
</tr>
<tr>
<td></td>
<td>■ 2: wire connects to the attribute from above</td>
</tr>
<tr>
<td></td>
<td>■ 4: wire connects to the attribute from the left</td>
</tr>
<tr>
<td></td>
<td>■ 8: wire connects to the attribute from below</td>
</tr>
<tr>
<td>X?_TINY_DOT_DONT_REMOVE</td>
<td>Visible attribute, very small, single character value (a &quot;.&quot;) that must remain visible and must be placed at the exact insertion location of each of the XnTERM01 attributes. This attribute is needed to allow the gap to auto-adjust to text width and to maintain connectivity through the symbol if the in line label or wire number text is blanked or grows small compared to the total gap width in the wire.</td>
</tr>
<tr>
<td>ACE_OFFSET</td>
<td>Invisible attribute that carries the vertex offset distance measured from the midpoint of the symbol's two wire connection points. A positive value increases the total distance between the vertices (of the two symbols making up the twisted pair symbol). A negative value decreases this distance. A value of 0.0 means that the vertex location is at the symbol's midpoint.</td>
</tr>
<tr>
<td>ACE_FLAG</td>
<td>Invisible attribute set to a value of 3 to identify a twisted pair symbol (1 characters maximum).</td>
</tr>
</tbody>
</table>
Overview of non-schematic attributes

Terminal block footprint symbols

Terminal block footprint symbols require special attributes in their definitions to help facilitate the Terminal Strip Editor graphical layout. AutoCAD Electrical generates a physical layout of the terminal strips and annotates the terminal number, wire number, and destination device of what is connected to the terminal block from the attributes. To accomplish this annotation, attributes are needed to accommodate the position of text relative to the terminal block symbol.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>P_TAGSTRIP</td>
<td>Invisible attribute to carry terminal strip number (24 character maximum) for terminal footprint.</td>
</tr>
<tr>
<td>LOC</td>
<td>Invisible attribute for optional terminal location code (for example, “JBOX1”; 16 characters maximum).</td>
</tr>
<tr>
<td>INST</td>
<td>Invisible attribute for optional terminal installation code (for example, “MACH1”; 24 characters maximum).</td>
</tr>
<tr>
<td>TERM or WIRENO</td>
<td>Attribute to carry the terminal pin number assignment (10 characters maximum). It can be related to the attached wire number or independent of the wire number.</td>
</tr>
<tr>
<td>MFG</td>
<td>Invisible attribute for optional manufacturer name or code (24 characters maximum).</td>
</tr>
<tr>
<td>CAT</td>
<td>Invisible attribute for optional catalog number (60 character maximum).</td>
</tr>
<tr>
<td>ASSYCODE</td>
<td>Invisible attribute for optional subassembly code that causes AutoCAD Electrical to look for subassembly items to extract into BOM reports (60 characters maximum). These subassembly items must be defined in the active catalog lookup file in the ASSYCODE and ASSYLIST fields.</td>
</tr>
</tbody>
</table>
**Attribute** | **Description**
--- | ---
The value for this attribute is generally set automatically when the user makes a selection from the catalog "Lookup" that carries sub-assembly information.

**WDBLKNAM** | Invisible attribute that specifies the WD block name for catalog lookup (32 characters maximum). Default for terminals is "TRMS."

**FP** | Invisible attribute or Xdata. Identifies the block insert as a non-schematic item (i.e a physical footprint representation).

**FPT** | Invisible attribute or Xdata. Identifies the block insert as a panel terminal footprint representation.

**WIRENOR**<br>**WIRENOL** | Optional attributes for schematic interconnection annotation (24 characters maximum).

**TERMDESCR**<br>**TERMDESL** | Optional attributes for schematic interconnection annotation (128 characters maximum).

**Hydraulic and P&ID symbols**

**Attribute** | **Description**
--- | ---
**TAG1** | Attribute for required component tag name (64 characters maximum). The default value you assign becomes the family code character string AutoCAD Electrical uses to build the component’s tag name when the block is inserted into your wiring diagram. This default value character string is used as the Family Code (%F) portion of the drawing’s tag format code you set up in the Drawing Properties ➤ Components dialog box(example %F%N).

**INST** | Optional attribute for component installation code (for example, “MACH1”; 24 characters maximum).

**LOC** | Optional attribute for component location code (for example, "FIELD", "JBOX2”; 16 characters maximum).
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAMILY</td>
<td>Invisible attribute that carries the components family type (for example, &quot;FI&quot;, &quot;INS&quot;; 8 characters maximum). Generally, the FAMILY attribute definition’s default value is the same as the default value for the component’s TAG1 or TAG2 attribute. A generic child device can be linked to any type of parent symbol if the child’s Family attribute value is left blank. AutoCAD Electrical will fill it in on the fly with the parent’s FAMILY code when the link is made.</td>
</tr>
<tr>
<td>CAT</td>
<td>Invisible attribute for optional catalog number (60 characters maximum).</td>
</tr>
<tr>
<td>MFG</td>
<td>Invisible attribute for optional manufacturer name or code (24 characters maximum).</td>
</tr>
<tr>
<td>ASSYCODE</td>
<td>Invisible attribute for optional subassembly code that causes AutoCAD Electrical to extract subassembly items into BOM reports (60 characters maximum). The value for this attribute is generally set by AutoCAD Electrical and not by the user.</td>
</tr>
<tr>
<td>RATING1</td>
<td>Optional attribute for rating/value text (60 characters maximum).</td>
</tr>
<tr>
<td>DESC1, DESC2, DESC3</td>
<td>DESC1: Description, first or only line of description text (60 characters maximum). DESC2: 2nd line of description text. DESC3: 3rd line of description text.</td>
</tr>
<tr>
<td>WDTYPE</td>
<td>Attribute used on non-electrical schematic symbols to identify them as non-electrical (4 characters maximum). Values of the attribute give a generic type of symbol such as &quot;HI&quot; for hydraulic symbol or &quot;PID&quot; for instrument symbol. This attribute value show up in several pick list dialogs (such as Insert/Edit Component ➤ Tags used so far dialog pick list).</td>
</tr>
<tr>
<td>WDTAGALT</td>
<td>Attribute carried on a parent symbol used for setting up a &quot;peer-to-peer&quot; relationship (64 characters maximum). It stores the cross-reference tag name of a related symbol shown on a different drawing type (ex: instrument drawing or pneumatic drawing vs. electrical schem-</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>XREF</td>
<td>Attribute that be used for a combined list of normally open and normally closed contacts (if XREFNO and XREFNC are present) or used for non-NO/NC contacts (if XREFNO and XREFNC are not present). AutoCAD Electrical underlines the closed contacts.</td>
</tr>
<tr>
<td>TERM</td>
<td>Optional terminal pin number attribute (10 characters maximum). Make sure to keep terminal pin number text paired with its wire connection attributes.</td>
</tr>
</tbody>
</table>
| X?TERMn   | Invisible wire connection attributes where an external wire connects to the attribute’s origin point. The ‘n’ character is an incremented digit starting at “01” used to keep multiple wire connection point attribute names unique. The “?” character position is used to identify the preferred wire connection direction:  
  ■ 1: wire connects to the attribute from the right  
  ■ 2: wire connects to the attribute from above  
  ■ 4: wire connects to the attribute from the left  
  ■ 8: wire connects to the attribute from below  
  ■ 0: special for motor connections  
  If more than 99 terminals are present on a single symbol, the ‘n’ value can continue with double alpha letters/numbers such as “A0,” ”A1,” ”AZ,” ”B0” and so on. |
Overview of parent and stand-alone component attributes (TAG1)

AutoCAD Electrical puts the component's tag name on this attribute, names like "PB101" or "CR-55" (24 characters maximum). The default value you assign to this attribute definition at the library symbol level (i.e. symbol's .dwg file opened and displayed in AutoCAD) becomes the family code character string AutoCAD Electrical uses to build the component's tag name when the block is inserted into your wiring diagram. This default value character string is used as the Family Code (%F) portion of the drawing's tag format code you set up in the Drawing Properties ➤ Components dialog box (example %F%N).

For example, use "PB" for a default value of the attribute definition TAG1 if the family name you want AutoCAD Electrical to use is "PB" (examples: "PB100", "100-PB", "PB4-100"). Note that this family name can be overridden at component insertion time, a later edit, or automatically by use of the "wd_fam.dat " mapping file.

NOTE If the TAG1 attribute carries no default value then AutoCAD Electrical will use that symbol's FAMILY attribute value.

Overview of child component attributes (TAG2)

AutoCAD Electrical puts a copy of the parent component's tag name on the child component attribute (TAG2). During the AutoCAD Electrical tagging operation, AutoCAD Electrical takes the parent coil's tag name (carried on its TAG1 attribute) and copies it to this contact's TAG2 attribute. If no parent tag is found then AutoCAD Electrical displays the attribute definition's default value.

Copy attributes

COPYTAG is the optional TAG copy attribute. When AutoCAD Electrical updates a TAG1 of TAG2 attribute, it also looks for and updates any COPYTAG attributes present on the symbol with a copy of the TAG text. A special replaceable parameter, "%T", can be encoded onto the COPYTAG attribute definition's prompt value. This allows for adding a suffix and/or prefix to the TAG text. If you need more than one extra TAG copy on a symbol, name the attributes COPYTAG01, COPYTAG02, etc. If there is no prompt value encoded
on the attribute definition, AutoCAD Electrical simply applies a copy of the tag-ID to the COPYTAG* attribute(s).

For example, you create a large "drive" schematic symbol with a TAG1 attribute for the drive's tag-ID. You want some other parts of this single symbol to carry the TAG1 value plus a suffix like "-POT" and "-DBRES". On your library symbol, insert an attribute definition "COPYTAG01" with a prompt value of "%T-POT" near the symbol's potentiometer graphic and "COPYTAG02" with a prompt value of "%T-DBRES" near the dynamic braking resistor graphic. When this symbol is inserted on a schematic drawing, and a TAG is assigned, AutoCAD Electrical will automatically update each COPYTAG* attribute accordingly.

Substitute symbols in the library

You can temporarily substitute an altered symbol for a symbol that is found in the standard library. Put the altered symbol's .dwg file in your USER subdirectory (right-click inside the Project Manager and select Settings to find the full path). The AutoCAD Electrical component insertion command always looks at this directory for the requested symbol prior to going to the selected symbol library.

NOTE AutoCAD Electrical uses regular AutoCAD blocks. If you insert a block from one library and then try to insert the same block name from a different library, you'll get a copy of the original version of the block. Use AutoCAD Electrical's Swap/Update Block command to make the change.

Change appearance of existing library symbols

The AutoCAD Electrical default symbol library is installed in the /Program Files/Autodesk/Acadv {release#}/libs/jic1 subdirectory (and /Program Files/Autodesk/Acadv {release#}/libs/jic125 for a uniform 0.125 text height library). You can modify the "*.dwg" version of each symbol to comply with your specific standards or client requirements.

1. Open each symbol up in its native AutoCAD .dwg format (using File ➤ Open).
2 Move the tag, description, location, and cross-reference annotation attribute definitions to different locations to satisfy your drafting standards (attribute definitions look like text entities).

3 Adjust attribute definition text size to meet your requirements but avoid deleting any of the existing attribute definitions. Attributes are needed to give the symbol full compatibility with AutoCAD Electrical features.

4 Insert additional non-AutoCAD Electrical attributes that your applications might need.

5 Edit these attributes by clicking Show/edit miscellaneous on the AutoCAD Electrical edit dialogs.

NOTE Before you spend a lot of time modifying each library symbol, you may want to take a look at the AutoCAD Electrical Modify Symbol Library tool. This tool provides a way to make mass changes to the library of symbols. It has a number of options, including scaling each symbol, changing attribute height based on AutoCAD Electrical attribute type, and picking a different text font for the AutoCAD Electrical text style.

Tips and Hints

Leave all symbol attribute definitions and geometry on layer "0" and that entity color assignments are by layer. Let AutoCAD Electrical manage what layers the various parts and pieces of your symbol get put on at insertion time. This layer naming scheme is set up in the Define Layers dialog box. If you want certain layer naming maintained on your inserted components, select Apply to entities on layer "0" only. With this checked, non-layer "0" entities maintain their existing layer names as the component inserts into the drawing.

**Edit miscellaneous and non-AutoCAD Electrical attributes**

View or edit any attributes that are not predefined AutoCAD Electrical attributes.

Access:

Click Show/edit miscellaneous on any of the Insert/Edit dialog boxes.

The attributes that can be modified depend on which Insert/Edit dialog box you are working in.
Predefine symbol annotation

You can have certain symbols insert with switch position text, terminal pin numbers, or BOM catalog numbers prefilled with default values.

1. Open the symbol's .dwg file in AutoCAD. The default symbol library path is \Program Files [(x86)]\Autodesk\Acade {version}\Libs\jic1.

2. Use the DDEDIT or PROPERTIES command to change the symbol's default attribute values.

For example, let's say that you always want your N.O. limit switch symbol to insert showing the two terminal pin numbers labeled as "1" and "2." In AutoCAD, call up and edit these symbol files: HLS11.DWG, VLS11.DWG, HLS21.DWG, and VLS21.DWG (modify both the jic1 and jic125 versions). In each case use DDEDIT to change the TERM01 and TERM02 attribute default values to be "1" and "2" respectively. At insertion time, these values show up as defaults.

NOTE You can override the default values at insertion time.

Create a new library symbol

AutoCAD Electrical uses stock AutoCAD blocks and attributes in its library symbols. The symbols can be any size and width. You don't have to edit an external support file or database to register a symbol for use in an AutoCAD Electrical wiring diagram drawing.

NOTE You can also use the Symbol Builder tool, but the quickest way to create a new symbol might be to start with an existing AutoCAD Electrical compatible symbol. Start with a copy of a similar type and then modify to suit. Avoid deleting the existing attribute definitions. Reposition and edit their default values as required.

1. Open a new drawing using the desired symbol name.

2. Insert an exploded copy of an existing AutoCAD Electrical symbol that somewhat resembles what you need in the new symbol. Take into
consideration the number of wire connection points, rating attributes,
and whether your new symbol is a parent symbol (attribute TAG1) or a
child symbol (attribute TAG2).

3  Clean up the graphics. Keep everything on layer 0.

4  Reuse attribute definitions from the exploded symbol. Reposition them
as required. Make sure that you keep terminal pin number text paired
with its wire connection attribute (the last two digits of each attribute
name must match, "X4TERM01" wire connection point attribute matched
with "TERM01" terminal pin number text attribute).

5  Use DDDEDIT to change the TAG1 or TAG2 and the FAMILY attribute
values to the desired family code. Insert any pre-defined terminal pin,
description, or catalog number attribute values.

6  Delete unneeded attribute definitions and graphics.

7  Save your work to the jic1, jic125, or user subdirectory (right-click inside
the Project Manager and select Settings to find the full path). To test it,
call up a new or existing AutoCAD Electrical drawing. Try to insert your
new symbol into an existing piece of wire. You can manually enter your
new symbol's file name using Type it on the main icon menu page.

Tips and Hints

Pigtails

Avoid putting wire pigtails on your new symbols. Pigtails can defeat the
AutoCAD Electrical SCOOT command and automatic wire numbering when
two symbols with pigtails bump up against each other. A wire connection
pigtail is mandatory when you insert a very short pigtail at a wire connection
point that has no other visible symbol geometry nearby since AutoCAD
Electrical needs to see something tangible on a symbol at a wire connection
point.

Symbol origin

The AutoCAD Electrical library symbols generally have their origin points
centered between the first (or only) pair of wire connection point attributes.
Though this is not mandatory, it helps AutoCAD Electrical determine the
correct orientation for alignment with an underlying wire at insertion time.

Symbol width
There are no restrictions. Every symbol can have a different width. At insertion time the symbol’s width is determined by reading the locations of its wire connection attributes (attributes with name X?TERMn).

Wire connection points

A symbol can have hundreds of connection points and a terminal pin number attribute tied to each (use suffix codes beginning with "01" and ending with "ZZ").

Component description text

You can insert three lines of description text up to 60 characters long. The attribute names are DESC1, DESC2, and DESC3 and generally appear on both parent/stand-alone and child contact symbols. You can insert additional DESCn attributes on your symbol and edit them with any attribute editing tool, but AutoCAD Electrical will not process them.

Overview of the Symbol Builder

Use this tool to convert existing symbols or create new, custom components on the fly. It works nicely for quickly building power supplies, filters, drives, controllers, and other custom devices or for converting existing non-AutoCAD Electrical symbols to make them AutoCAD Electrical-smart. Schematic symbols created or converted using the Symbol Builder are fully compatible with AutoCAD Electrical, break wires upon insertion, and appear in the various BOM, component, and wire connection reports.

You can exit the Symbol Builder command and re-enter it at any time. You can also exit the command and use regular AutoCAD commands to edit or finish the symbol you're creating and the AutoCAD Wblock command to write it to disk. Each time you re-enter the Symbol Builder tool, make sure you window your existing geometry at the builder's initial prompt. This allows the tool to track what standard attributes and wire connection points you've already inserted.

New symbols you create are inserted with the AutoCAD Electrical Insert Component or Insert Panel Component commands. You can add your new symbol to the icon menu or you can select it from the Type it or Browse options in the bottom left-hand corner of the icon menu.

Convert or create library symbols

Use this tool to quickly pick and place attributes. You do not have to exit your current drawing to build the symbol. You can do it in place or off to the side
in an empty spot on your drawing. You can exit and restart the tool as many times as necessary to set up the symbol.

1. Explode any existing blocks or draw new symbols from scratch.
2. Click the arrow on the Miscellaneous tool to access the Symbol Builder tool.
3. Click the Symbol Builder tool.
4. Select any geometry that are to become part of the new or converted symbol (or press Enter if you are starting from scratch).
5. Pick which type of symbol you want to build. For example, pick Parent for a schematic device.

    **NOTE** Depending on the selected symbol category, the Symbol Builder dialog choices and selections differ.

6. Select various options to insert required attributes, wire connection points, terminal text, and so on.
7. When you finish, click Block to insert your new component into your drawing or Wblock to first save a copy of your new symbol. Try to retain the first 4 characters of the assigned block name.

**Symbol builder: choose symbol category**

This tool converts existing symbols or creates new, custom components on the fly. It works nicely for quickly building power supplies, filters, drives, controllers, and other custom devices or for converting existing non-AutoCAD Electrical symbols to make them "AutoCAD Electrical smart." Schematic symbols created or converted using the Symbol Builder are fully compatible
with AutoCAD Electrical, break wires upon insertion, and appear in the various BOM, component, and wire connection reports.

Access:

Click the arrow on the Miscellaneous tool to access the Symbol Builder tool.
From the Components menu, select Symbol Library ➤ Symbol Builder.

Parent
Schematic symbol is used as a stand-alone symbol or a parent component with related secondary contacts.

Child
Schematic secondary symbol that is related to a parent component.

Terminal
Schematic terminal with terminal number.

Terminal
Schematic terminal that follows the wire number rather than having a terminal number of its own.

Footprint
Panel symbol that is not used as a terminal or nameplate.

Terminal
Panel terminal symbol.

Nameplate
Panel nameplate symbol.

NOTE Depending on the selected symbol category, the dialog box choices and selections differ.

Component type: schematic parent, stand-alone, or child

Access:

Click the arrow on the Miscellaneous tool to access the Symbol Builder tool.
Click Parent or Child, then click Standard.
Access:

From the Components menu, select Symbol Library ➤ Symbol Builder. Click Parent or Child, then click Standard.

Missing attributes: Lists attributes you can insert for the symbol.

Height: Specifies the attribute height.

Justify: Specifies the attribute justification.

Family code: Specifies the default component family code.

TAG1 %F default: Specifies the default code for parent component tags. When you insert the TAG1 attribute for a Parent schematic symbol, you're prompted for a default value. This value is used as the default family code for an automatically-generated schematic component tag upon insertion into a drawing. This defaults to "DV" unless you override it with another value (such as "PB" or "CR" or "MOT").

TAG2 %F default: Specifies the default code for child component tags. This value matches the code carried by the parent.

Pick text: Converts existing text to the target AutoCAD Electrical attribute.

Insert attribute: Adds the correct attributes to make your new symbol AutoCAD Electrical compatible. Different attributes display depending on the selected symbol category.

Change: Changes the visibility, size, justification, rotation, and position for the ATTDEF.

**Symbol builder - schematic symbols**
Use this tool to build a smart schematic symbol by adding AutoCAD Electrical attributes to the symbol's geometry and converting text entities to AutoCAD Electrical attributes.

Access:

Click the arrow on the Miscellaneous tool to access the Symbol Builder tool. Click Parent, Child, Terminal, or Terminal.

From the Components menu, select Symbol Library ➤ Symbol Builder. Click Parent, Child, Terminal, or Terminal.

The following options are available when building schematic parent or stand-alone symbols, schematic child symbols, and schematic terminal symbols (with terminal and wire numbers).

**Rectangle**

Hides the dialog box so you can draw a selection rectangle on the drawing.

**Browse**

Opens a dialog box for selecting the exploded block or drawing to include with the symbol.

**Standard**

Opens a dialog box for selecting the missing attributes for the symbol. When you insert the TAG1 attribute for a parent schematic symbol, you are prompted for a default value. This value is used as the default family code for an automatically-generated schematic component tag upon insertion into a drawing. This defaults to "DV" unless you override it with another value (such as "PB" or "CR" or "MOT").

Choose the text size and justification for the attribute from the menus (if the desired text size is not shown, go to the bottom of the list and click ",add-").

In the Component type: Schematic Terminal dialog box, click Insert Attribute to speed up the process of adding the correct attributes to make your new symbol AutoCAD Electrical-compatible. Different attributes display depending on the selected symbol category.
**Wire connection**

Inserts wire connection points. For each wire connection point you need, select the desired wire connection direction and then place the point on your new symbol.

**Terminal**

This choice can only be used if you already have an AutoCAD Electrical wire connection attribute defined, and you want to link terminal text to it. It is useful to help make an existing symbol "AutoCAD Electrical smart."

**NO/NC**

If your symbol needs to show whether it is normally open or normally closed, use this button to add the necessary attribute.

**Dashed**

In addition to using TAGS to link a parent symbol with a child symbol, you can draw dashed lines between a parent symbol and its related child contact. This method requires special attributes at the point where the dashed line connects to the symbol.

**Rating**

You can add up to 12 optional rating attributes that can be used for anything from amps to motor horsepower. Define an attribute prompt for each (such as "Motor FLA" or "Voltage"). These prompts display in the AutoCAD Electrical Insert/Edit Component dialog box when you insert or edit your new symbol.

**Convert text**

If you windowed existing geometry and text entities at the initial prompt of the Symbol Builder, this converts the existing text entities to AutoCAD Electrical attributes "in place." Select Convert to AutoCAD Electrical attributes to map your text/attributes to the attribute names for the selected symbol type.

**Change**

Specifies the text style, text line weight, and width factor for the new attributes.
Save and insert

Save and Insert: When you finish, click Block to insert your new component into your circuit or Wblock to first save a copy of your new symbol (the default save location is your user subdirectory).

Caution: AutoCAD Electrical provides a default name for your new symbol. If you are creating a schematic parent or child contact symbol, avoid changing the first 4 letters of the generated symbol file name and limit the total length to 32 characters. AutoCAD Electrical uses the first 4 characters for parent/child tagging operations.

Component type: panel footprint, terminal, or nameplate

Access:

Click the arrow on the Miscellaneous tool to access the Symbol Builder tool.
Click Footprint, Terminal, or Nameplate, then click Standard.
From the Components menu, select Symbol Library ➤ Symbol Builder. Click Footprint, Terminal, or Nameplate, then click Standard.

Missing attributes
Lists attributes that you can insert for the symbol.

Height
Specifies the attribute height.

Justification
Specifies the attribute justification.

Visible
Changes the visibility of the attribute.

Pick Text
Converts existing text to the target AutoCAD Electrical attribute.

Insert Attribute
Adds the correct attributes to make your new symbol AutoCAD Electrical compatible. Different attributes display depending on the selected symbol category.

Change
Changes the visibility, size, justification, rotation, and position for the ATTDEF.

Panel symbol builder
This tool is used to build a smart schematic symbol by adding AutoCAD Electrical attributes to the symbol’s geometry and converting text entities to AutoCAD Electrical attributes.

**Access:**

- Click the arrow on the Miscellaneous tool to access the Symbol Builder tool.
- Click Footprint, Terminal, or Nameplate.
- From the Components menu, select Symbol Library ➤ Symbol Builder. Click Footprint, Terminal, or Nameplate.

The following options are available when building panel footprint symbols, terminal symbols, and nameplate terminals.

**Rectangle**

Hides the dialog box so that you can draw a selection rectangle on the drawing.

**Browse**

Opens a dialog box for selecting the exploded block or drawing to include with the symbol.

**Standard**

Opens a dialog box for selecting the missing attributes for the symbol.

Choose the text size and justification for the attribute from the menus (if the desired text size is not shown, go to the bottom of the list and click "-add-").

On the Component type: Panel Footprint dialog box, click Insert Attribute to speed up the process of adding the correct attributes to make your new symbol fully AutoCAD Electrical compatible. Different attributes display depending on the selected symbol category.

**Rating**

You can add up to 12 optional rating attributes that can be used for anything from amps to motor horsepower. Define an attribute prompt for each (such as "Motor FLA" or "Voltage"); these prompts display in the AutoCAD Electrical Insert/Edit Component dialog box when you insert or edit your new symbol.
**Term/Wire Numbers**

Inserts wire numbers and terminal pin numbers. For each wire number you need, select the desired wire number direction and then place the point on your new symbol. Select one of the supplied wire number or terminal styles from the menu. You can edit existing terminal styles or create your own. All terminal symbols are saved in the /Program Files/Autodesk/Electrical/libs/jic1 subdirectory under file name "bb?*.dwg", where "?" is the style number.

You can also specify to insert multiple wire/terminal numbers and set the scale for the numbers in this dialog box.

**Convert text**

If you windowed existing geometry and text entities at the initial prompt of the Symbol Builder, this converts the existing text entities to AutoCAD Electrical attributes "in place". Select Convert to AutoCAD Electrical attributes to map your text/attributes to the attribute names for the selected symbol type.

**Change**

Specifies the text style, text line weight, and width factor for the new attributes.

**Save and insert**

When you are finished, click Block to insert your new component into your circuit or Wblock to first save a copy of your new symbol (the default save location is your user subdirectory).

**Swap blocks**

The block swapper tool can operate in several different modes:

- **Swap Block**: Exchanges one block for another, retaining the old block’s scale, rotation, wire connections, attribute values, and attribute positions (if Retain is selected). For example, use the tool to swap out a red standard pilot light with a green one, or drawing-wide, swap out all standard red pilot lights with red press-test pilot lights.

- **Update**: Updates all instances of a given block with an updated version of the same block. Again, all attribute values and wire connections are retained. For example, an old AutoCAD Electrical project set needs to be
used on a new project but the client likes his limit switches drawn a bit differently. Simply make client-specific versions of the limit switch symbols. Then use the Update option; select any limit switch on the drawing, and then reference the path to the new version of the symbol. AutoCAD Electrical quickly replaces all instances of the symbol it finds on the drawing(s) with the new version of the same symbol. The Library mode works the same way as the Update mode, but will swap out all the blocks on the drawing(s).

When you swap or update a block there may be times when you want the values of certain attributes mapped to different attribute names. For example, you may be doing a Library Update and the library symbols you are swapping out do not use standard AutoCAD Electrical attribute names. You want a quick way to update the library symbols, but you do not want to lose information held on the current attributes.
Update or change blocks in place

1. Click the arrow on the Insert Component tool to access the Swap/Update Block tool.

2. Click the Swap/Update Block tool.

3. Determine whether you want to exchange one block for another (Option A) or update all instances of a given block with an updated version of the same block (Option B).

   **Option A:** Select to swap a block one at a time, drawing-wide, or project-wide.

   - Indicate whether to pick a new block from the icon menu, pick a new block just like another block, or pick a new block from the File dialog box.
   - Determine whether you want to retain old attribute locations, old block scales, or retag if parent swap causes family changes.

   **Option B:** Select to update a block by replacing it with a new version or substitute new versions of all blocks.

   - Specify the file name of the block that will be substituted for all instances of the selected block.
   - Determine whether you want to retain old attribute locations, old block scales, or copy the old block's attribute values to new swapped block.

4. Select whether to use the same attribute names or use an attribute mapping file.

5. Click OK.

6. If you selected to pick a new block from the icon menu, select the icon from the Insert Component dialog box.

7. Select the component to swap out.

8. If you chose to do a project-wide swap, select the drawings to process and click OK.
The chosen component is replaced with the symbol selected in the Insert Component dialog box.

**Swap block/update block/library swap**

This tool lets you update or change blocks in place. Attribute values are retained during the swapping process. Wire connections are also maintained even if the new symbol is slightly wider or narrower than the original.

**Access:**

Click the arrow on the Insert Component tool to access the Swap/Update Block tool.

From the Components menu, select Component Miscellaneous ➤ Swap/Update Block.

**Swap Block (swap to different block name)**

<table>
<thead>
<tr>
<th>Swap a block - one at a time</th>
<th>Exchanges one block for another one block at a time.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Swap a block - drawing wide</strong></td>
<td>Exchanges one block for another throughout the drawing.</td>
</tr>
<tr>
<td><strong>Swap a block - project wid</strong></td>
<td>Exchanges one block for another throughout the project.</td>
</tr>
<tr>
<td><strong>Pick new block from icon menu</strong></td>
<td>Specifies to select a new block from the icon menu.</td>
</tr>
<tr>
<td><strong>Pick new block &quot;just like&quot;</strong></td>
<td>Specifies to select a new block similar to the original block.</td>
</tr>
<tr>
<td><strong>Pick new block from file selection dialog</strong></td>
<td>Specifies to select a new block from the File ➤ Open dialog box.</td>
</tr>
<tr>
<td><strong>Retain old attribute locations:</strong></td>
<td>Specifies to retain the attribute locations from the original block.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Retain old block scale</strong></td>
<td>Specifies to retain the scale value from the original block.</td>
</tr>
<tr>
<td><strong>Allow undefined Wire Type line reconnections</strong></td>
<td>Specifies to include non-wire LINEs for reconnection when the new block swaps in. The LINEs then display in the Wire From/To and Cable From/To reports. If unselected, the non-wire LINEs are excluded and do not appear in reports.</td>
</tr>
<tr>
<td><strong>Auto retag if parent swap causes family change</strong></td>
<td>Automatically retags the component if the Family code of a component changed due to the swap. Otherwise, the tag remains the same even if it does not match the new component's Family code.</td>
</tr>
</tbody>
</table>

**Update block (revised or different version of same block name)**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Update a block</strong></td>
<td>Updates all instances of a given block with an updated version of the same block.</td>
</tr>
<tr>
<td><strong>Library swap</strong></td>
<td>Updates all instances of a library symbol with an updated version of the same symbol</td>
</tr>
</tbody>
</table>

**Attribute mapping**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use same attribute names</strong></td>
<td>Uses the same attribute names from the original block.</td>
</tr>
<tr>
<td><strong>Use attribute mapping file</strong></td>
<td>Allows the values of certain attributes to be mapped to different attribute names.</td>
</tr>
<tr>
<td><strong>Mapping file</strong></td>
<td>Determines how AutoCAD Electrical should map the attributes. The file should have two columns of attribute names. The first column should contain the current attribute name and the second column the new attribute name. The mapping file may be an Excel spreadsheet, a comma-delimited file (.CSV), or a simple text file</td>
</tr>
</tbody>
</table>
with a space separating the current attribute name from the new attribute name.

**Library swap -- all drawing**

Updates all instances of a library symbol with an updated version of the same symbol on the active drawing or in a project.

**Access:**

- Click the arrow on the Insert Component tool to access the Swap/Update Block tool. Select the Library Swap option and click OK.
- From the Components menu, select Components Miscellaneous ➤ Swap/Update Block. Select the Library Swap option and click OK.

**Path to new block library**

Specifies the path for the symbol library that is referenced for the block substitution. To use a different library, enter its path or click Browse.

**Insertion scale**

<table>
<thead>
<tr>
<th>Scale</th>
<th>Specifies which scale factor to use. 1.0 = full scale; Configuration Scale = the scale setting in the Drawing Properties ➤ Drawing Format dialog box; 25.4 = inch to millimeter scale factor; and 1/25.4 = millimeter to inch scale factor.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retain old block scale</td>
<td>Specifies to retain the scale value from the original block.</td>
</tr>
<tr>
<td>Retain old attribute locations</td>
<td>Specifies to retain the attribute locations from the original block.</td>
</tr>
</tbody>
</table>

**Copy old block’s attribute values to new swapped block**

Specifies whether to copy the attribute values to the new block, to discard all old values, or to copy the old values only if the new value is blank.

**Update block - new block’s path\filename**
Substitutes a new version of a component block for all inserted instances of that block found on a drawing or in a project.

Access:

Click the arrow on the Insert Component tool to access the Swap/Update Block tool. Select the Update a Block option and click OK.

From the Components menu, select Components Miscellaneous ➤ Swap/Update Block. Select the Update a Block option and click OK.

**Path\filename of new block**

Specifies the path\filename of the block that will be substituted for all instances of the selected block. Enter a file name or click Browse.

**Insertion scale**

<table>
<thead>
<tr>
<th>Scale</th>
<th>Specifies which scale factor to use. 1.0 = full scale; Configuration Scale = the scale setting in the Drawing Properties ➤ Drawing Format dialog box; 25.4 = inch to millimeter scale factor; and 1/25.4 = millimeter to inch scale factor.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Retain old block scale</th>
<th>Specifies to retain the scale value from the original block.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retain old attribute locations</td>
<td>Specifies to retain the attribute locations from the original block.</td>
</tr>
</tbody>
</table>

**Copy old block’s attribute values to new swapped block**

Specifies whether to copy the attribute values to the new block, to discard all old values, or to copy the old values only if the new value is blank.
In this chapter

- Generate PLC layout modules
- Insert PLC modules
- Overview of the PLC database file
- Single, Stand-Alone I/O Points
- Work with PLC styles
- Create PLC I/O Drawings from Spreadsheets
Generate PLC layout modules

AutoCAD Electrical can generate any of hundreds of different PLC I/O modules on demand, in a variety of different graphical styles, all without a single, complete I/O module library symbol resident on the system. Modules automatically adapt to the underlying ladder rung spacing, whatever that value might be, and can even be stretched or broken into two or more pieces at insertion time. This is all possible because AutoCAD Electrical generates PLC I/O modules through a parametric generation technique driven by a PLC database (ACE_PLC.MDB).

The PLC database contains not just the stack sequence but also text values to annotate onto each symbol in the stack. As AutoCAD Electrical builds the module, it reads the underlying ladder rung spacing and spreads the stack out or compresses it to match the rung spacing. During the insertion process, in AutoCAD Electrical, you can interrupt it to break the module and then restart it at a different location.

Parametric PLC symbols vs. Full Units

Parametric PLC symbols are stored in the \Program Files [(x86)\Autodesk\Acade {version}\libs\jic\ subdirectory (or \Program Files [(x86)\Autodesk\Acade {version}\libs\jic125\ for 0.125 height version) along with all of the other AutoCAD Electrical component symbols. Their file names begin with the characters "HP" (Horizontal ladder rungs / PLC) or "VP" (Vertical ladder rungs) followed by a digit that corresponds to a PLC I/O style number. Each symbol is a building block with a different arrangement of attributes and wire connection points. AutoCAD Electrical selects the appropriate symbols to use, stacks them together in the order defined by the data file, and produces a completed I/O module.

The PLC database file (ace_plc.mdb) is used to drive the PLC I/O module generation process. You can modify the PLC database file manually or using the PLC Database File Editor (page 232)(recommended method). The AutoCAD Electrical PLC database file (ace_plc.mdb) is installed in the C:\Documents and Settings\{username}\My Documents\Acade {version}\AeData\Plc subdirectory.

Each Parametric PLC symbol is a building block with a different arrangement of attributes and wire connection points. AutoCAD Electrical selects the appropriate symbols to use, stacks them together in the order defined by the parametric data file, and produces a completed I/O module. AutoCAD Electrical inserts the symbols based upon the underlying ladder's rung spacing, explodes
them, draws a rectangular box around the entire assembly, creates a single block out of the collection, and annotates the new module's attributes.

Some PLC units may not lend themselves very well to parametric generation. If a PLC module symbol is built with the appropriate attributes in place and the symbol name follows AutoCAD Electrical's naming convention (the block name begins with "PLCIO"), it can be inserted as a single unit using the Components ➤ Insert PLC Modules ➤ Insert PLC (Full Units) command. The selected unit inserts into the ladder, breaks the wires, and then reconnects.

**PLC parametric selection**

AutoCAD Electrical can generate PLC I/O modules on demand, in a variety of different graphical styles via a parametric generation technique. It is driven by a database file and a handful of library symbol blocks.

**Access:**

- Click the Insert PLC (Parametric) tool.
- From the Components menu, select Insert PLC Modules ➤ Insert PLC (Parametric).

**Manufacturer Catalog tree**

Provides a complete list of the PLC modules available to AutoCAD Electrical. The Manufacturer Catalog tree is compiled from the database file, "ace_plc.mdb."

**Module List**

Displays the defined modules. Once you select a module type or a specific module from the Manufacturer Catalog tree, AutoCAD Electrical reads through the information contained in the database. Select from this list to begin the PLC module insertion process.

**Graphics Style**

Specifies the graphical appearance of the PLC module. Styles 1-5 are provided with AutoCAD Electrical. Styles 6-9 may be user-defined. Select a style number and a sample portion of a PLC module displays.

To create a user-defined style: There are about two dozen symbols associated with each style. They are located in the \Program Files [(x86)]\Autodesk\Acad [version]\Libs subdirectory and carry the file name "HP*.dwg" or "VP*.dwg."
where "?" is the style number. An easy way to create a new style is to copy an existing style's symbols to one of the unused style numbers (6, 7, 8, or 9) and edit each library symbol.

**Scale**

Specifies the scale for the PLC module. You can also specify to apply a border to the PLC module upon insertion.

**Module layout**

**Access:**

Click the Insert PLC (Parametric) tool. Select the PLC module to insert, click OK, and place the PLC in the drawing.

From the Components menu, select Insert PLC Modules ➤ Insert PLC (Parametric). Select the PLC module to insert, click OK, and place the PLC in the drawing.

**Spacing**

Specifies the spacing for the module. The module will default to the underlying rung spacing. If you wish to override this spacing, modify the number shown in the spacing edit box. The arrows below this box increment the number by the rung spacing. For example, if the rung spacing is 0.5 then each time you click on ">" the number increases by 0.5.

**I/O points**

Specifies whether to include all of the points or break the module into many pieces. You can break a module into as many pieces as you want at insertion time. This is useful for a module that won't fit into a single ladder column. You can also add extra space between adjacent I/O points. This allows for the extra room needed for parallel components. Select Allow Spacers/Breaks and after each I/O you have the opportunity to insert a space, break the module, or insert the rest normally. If the module's definition (in the Attributes column of the Module Terminal Information table of the ace_plc.mdb file or by selecting the check box in the Break After column of the PLC Database File Editor dialog box) carries a ";\SPECIAL=BREAK" flag, then the Note highlights and the module automatically prompts you for permission to break at the correct point during module insertion.
**Include unused/extra connections**

Specifies to include all of the extra connections to the PLC. Some modules may have terminals that are not used (i.e. dummy terminals with no electrical connection). Unused terminals are skipped by default. This results in the most compact representation of the module, but the PLC modules can be set up to optionally show unused terminals. This is done by adding in "]SPECIAL=INCLUDE" and "]SPECIAL=EXCLUDE" flags (in the Attributes column of the Module Terminal Information table of the ace_plc.mdb file) or by selecting "When Including Unused" or "When Excluding Unused" in the Show column of the PLC Database File Editor dialog box.

**Insert PLC modules**

In AutoCAD Electrical, you can insert either PLC I/O points as independent symbols or as a complete PLC module into your drawing.

1. Click the arrow on the Insert PLC (Parametric) tool to access the Insert PLC (Full Units) tool.

2. Click the Insert PLC (Full Units) tool.

3. In the PLC Fixed Units dialog box, select the PLC module to insert.

4. Specify the insertion point on the drawing.

5. Add or edit any information in the Edit PLC Module dialog box, and click OK.

**Edit PLC module**

Use this dialog box when inserting or editing a PLC module. Specify the values you need and press OK. The values are then annotated onto the selected module.
NOTE Editing the first address, I/O point address, or catalog information for a plc module that has been imported using the Unity Pro Export to Spreadsheet tool may result in problems when you export the data back to Unity Pro. An alert displays to ask whether you want to proceed with the changes.

Access:

Click the arrow on the Insert PLC (Parametric) tool to access the Insert PLC (Full Units) tool. Select the PLC module to insert and place it on the drawing. Click Components ➤ Insert PLC Modules ➤ Insert PLC (Full Units). Select the PLC module to insert and place it on the drawing.

You can go back to any component at any time and make changes.

Addressing

First Address Specifies the 1st I/O address for the PLC module.

List

Lists the available I/O addresses to select from. When you select an I/O address from the list the I/O Point Description: Address automatically updates.

Used: Drawing or Project

Lists any I/O points already assigned to the drawing or project. Select a tag from the list to copy, or to increment for this new component.

Tag

Specifies a unique identifier assigned to each I/O point. The tag value can be manually typed in the edit box.

Options

Substitutes a fixed text string for the %F part of the tag format. Retag Component can then use this override format value to calculate a new tag for the PLC module. For example, a certain PLC module needs to always have an "IO" family tag value instead of "PLC" so that re-tag, for example, will assign IO-100 instead of PLC100. To achieve this tag override you would enter "IO-%N" for the tag override format.
**Line 1/Line2**

Specifies optional description text for the module. May be used to identify the module's relative location in the I/O assembly (example: Rack # and Slot #).

**Manufacturer**

Lists the manufacturer number for the I/O point. Enter a value or select one from the Catalog lookup.

**Catalog**

Lists the catalog number for the I/O point. Enter a value or select one from the Catalog lookup.

**Assembly**

Lists the assembly code for the I/O point. The Assembly code is used to link multiple part numbers together.

**Catalog Lookup**

Opens the I/O point's PLCIO table in the catalog database from which you can manually enter or select the Manufacturer or Catalog values. Search the database for a specific catalog item to assign to the selected cable. Database queries are set up in the 3 lists across the top of the dialog with the database hits listed in the dialog's main window.

**Description**

Optional line of description text. May be used to identify the module type (for example, "16 Discrete Inputs - 24VDC")

**I/O Point Description**

<table>
<thead>
<tr>
<th>Address</th>
<th>Specifies the I/O address assignment.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description 1-5</td>
<td>Optional description text. Up to 5 lines of description attribute text can be entered.</td>
</tr>
<tr>
<td>Next/Pick</td>
<td>Selects a description from a module on the current drawing.</td>
</tr>
</tbody>
</table>
### List descriptions

Lists the I/O point descriptions currently assigned to each I/O point on the module or connected, wired devices in a pick list. Selecting one of the buttons next to this displays a different list of description in the box below.

### I/O

Lists I/O point descriptions used so far on the module. Pick to copy.

### Wired Devices

Lists descriptions of wired devices that are found to be connected to the I/O module. Pick to copy the description.

### External File

Displays contents of an external comma-delimited ASCII text file of I/O point descriptions. Pick an entry in the file and then copy the values to edit boxes in the Edit dialog.

### Installation/Location codes

Changes the installation or location code(s). You can search the current drawing or entire project for installation and location codes. A quick read of all the current or selected drawing files is done and a list of codes used so far is returned. Select from the list to automatically update the module with the installation or location code.

### Pins

Assigns pin numbers to the pins that are physically located on the module.

### Show/Edit Miscellaneous

View or edit any attributes that are not predefined AutoCAD Electrical attributes.

### Ratings

Specifies values for each ratings attribute. You can enter up to 12 ratings attributes on a module. Select Defaults to display a list of default values.

**NOTE** If Ratings is grayed out, the module you are editing does not carry rating attributes.
Overview of the PLC database file

You can modify the PLC database file manually or using the PLC Database File Editor (page 232)(recommended method). The AutoCAD Electrical PLC database file (ace_plc.mdb) is installed in the C:\Documents and Settings\[username]\My Documents\Acade [version]\AeData\Plc subdirectory. By default the AutoCAD Electrical PLC database file contains the are "PLC_Manufacturer", "PLC_MSG" and "PLC_Styles" tables in addition to several module specification and module terminal information tables.

NOTE  PLC Parametric build symbols are best to be used on ANSI D-Size and IEC A1 page sizes.

<table>
<thead>
<tr>
<th>PLC_Manufacturer</th>
<th>This table lists the Manufacturer, Series, Type and Table Name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLC_MSG</td>
<td>This table is for internal use only. It is recommended that you do not edit this table.</td>
</tr>
<tr>
<td>PLC_Styles</td>
<td>This table lists the box settings on a per-style basis.</td>
</tr>
</tbody>
</table>

There are two tables for each module type. The Module Specification table contains information such as the model number, type, description, rating, and rectangle offset values. The Module Terminal Information table (ends with "_Data") contains terminal information such as code value, terminal sequence number, block name, and terminal attributes.

**Module Specification table**

*Example: "allen-bradley_1746_analog_input"*

This file lists information that appears in the module's selection line listed in the bottom half of the PLC Module Selection dialog box.

<table>
<thead>
<tr>
<th>CODE</th>
<th>Model number</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE</td>
<td>Module type</td>
</tr>
<tr>
<td>POINTS</td>
<td>Number of I/O points</td>
</tr>
</tbody>
</table>

Overview of the PLC database file | 225
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DESCRIPTION</td>
<td>Description displayed in selection dialog box</td>
</tr>
<tr>
<td>ADDRESS_BASE</td>
<td>Base numbering value (octal, decimal, hex)</td>
</tr>
<tr>
<td>ADDRESS_FORMAT</td>
<td>Reserved for future use; currently empty</td>
</tr>
<tr>
<td>OPTIONAL_BLOCK</td>
<td>Optional block to insert at bottom of module (i.e. DIP switches)</td>
</tr>
<tr>
<td>RATING</td>
<td>Voltage rating</td>
</tr>
<tr>
<td>LISP</td>
<td>AutoLISP file to run at module insertion time</td>
</tr>
<tr>
<td>BOX_RIGHT, BOX_LEFT,</td>
<td>Offsets (right, left, top, and bottom) for the rectangle that's drawn around</td>
</tr>
<tr>
<td>BOX_TOP BOX_BOTTOM</td>
<td>the finished stack of symbols to create an overall module.</td>
</tr>
<tr>
<td>BOX_SPLIT_BOTTOM, BOX_SPLIT_TOP</td>
<td></td>
</tr>
<tr>
<td>METRIC_BOX_RIGHT, METRIC_BOX_LEFT,</td>
<td></td>
</tr>
<tr>
<td>METRIC_BOX_TOP, METRIC_BOX_BOTTOM</td>
<td></td>
</tr>
<tr>
<td>METRIC_BOX_SPLIT_BOTTOM, METRIC_BOX_SPLIT_TOP</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** You can suppress the rectangular box around the finished module by removing these entries from a module's specification table.

The following are optional parameters for parametric build symbol placement:

**Box color/linetype/layer**

You can instruct AutoCAD Electrical to draw the rectangular box using non-default line properties for color, layer, line type, or Itscale. Encode this information as a series of keywords as if you were using AutoCAD's CHPROP command to make the change. The keywords are encoded into the "BOX_RIGHT", "BOX_LEFT", "BOX_TOP" and "BOX_BOTTOM" entries in a module's specification table. For example, the following will make the left and right-hand sides of the enclosing box cyan using line type 'Hidden2' and the top and bottom blue using the default line type:

BOX_RIGHT=0.5 COLOR CYAN LTYPE HIDDEN2
BOX_LEFT=0.5 COLOR CYAN LTYPE HIDDEN2
BOX_TOP=0.5 COLOR BLUE
BOX_BOTTOM=0.375 COLOR BLUE
Module Terminal Information table (ends with _Data)

Example: "allen-bradley_1746_analog_input_Data"

This file contains terminal information for the module type.

<table>
<thead>
<tr>
<th>CODE</th>
<th>Module's catalog number</th>
</tr>
</thead>
<tbody>
<tr>
<td>SEQUENCE</td>
<td>Terminal sequence number</td>
</tr>
<tr>
<td>BLOCK</td>
<td>Block name used for insertion. The &quot;?&quot; gets filled in during insertion and the block name uses either a &quot;H&quot; or &quot;V&quot; depending on the selected orientation.</td>
</tr>
<tr>
<td>ATTRIBUTES</td>
<td>Optional attributes for the terminal. These include user attributes, %%x prompt values, address prefix or suffix, non-sequential addresses, breaks, re-prompt of I/O address, including unused terminals and special spacing.</td>
</tr>
</tbody>
</table>

The following are optional parameters for parametric build symbol placement:

**Use of %%x prompt values**

After you're prompted to enter values such as rack, group or slot, the values are available for use on any subsequent I/O point of the module. If you want to use each I/O point's TERMDESC_ attribute to carry the I/O address in Rack/Group, bit number format, do the following:

1. Prompt for Rack and Group values in the module's first entry.
   
   %1PROMPT=Rack number;2PROMPT=Group number.

2. Encode the TERMDESC_ value using %1, %2, and a bit number suffix.
   
   TERMDESC_=1:%1%2/00 for the first I/O point
   TERMDESC_=1:%1%2/01 for the 2nd I/O point

**User Attributes**

You can add and annotate your own attributes to the parametric symbols if they are referenced in the Module Terminal Information table.

**Address prefix or suffix**

You can include a prefix or suffix to each address value that's inserted. For example, if you want "IN-" to come in as a prefix for inputs on a given module.
you would edit the database file and add ";TAGA_=IN-%%N" to each I/O parametric data entry in the module’s block of data. The %%N represents the calculated I/O address and the "IN-" is the prefix that gets added.

**Dealing with non-sequential addresses**

Some modules may have I/O address assignments that do not sequentially increment from one terminal to the next. Use the "%%A" flag to represent the module's beginning address. In the example shown below, the address sequence is non-sequential. Note the use of the "TAGA_%%A+ <some value>" flags.

<table>
<thead>
<tr>
<th>CODE</th>
<th>BLOCK</th>
<th>ATTRIBUTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>D2-08ND3</td>
<td>HP?--WLR</td>
<td>TERM_=C,C;MFG=PLC-DIRECT;CAT=D2-08ND3;...</td>
</tr>
<tr>
<td>D2-08ND3</td>
<td>HP?WA-DQ</td>
<td>TERM_=0</td>
</tr>
<tr>
<td>D2-08ND3</td>
<td>HP?WA-DR</td>
<td>TERM_=4;TAGA_%%A+4</td>
</tr>
<tr>
<td>D2-08ND3</td>
<td>HP?WA-DQ</td>
<td>TERM_=1;TAGA_%%A+1</td>
</tr>
<tr>
<td>D2-08ND3</td>
<td>HP?WA-DR</td>
<td>TERM_=5;TAGA_%%A+5</td>
</tr>
<tr>
<td>D2-08ND3</td>
<td>HP?WA-DQ</td>
<td>TERM_=2;TAGA_%%A+2</td>
</tr>
<tr>
<td>D2-08ND3</td>
<td>HP?WA-DR</td>
<td>TERM_=6;TAGA_%%A+6</td>
</tr>
<tr>
<td>D2-08ND3</td>
<td>HP?WA-DQ</td>
<td>TERM_=3;TAGA_%%A+3</td>
</tr>
<tr>
<td>D2-08ND3</td>
<td>HP?WA-DR</td>
<td>TERM_=7;TAGA_%%A+7</td>
</tr>
</tbody>
</table>

**Forcing a break**

You can pre-define a module break point in the Module Terminal Information table. Add "\SPECIAL=BREAK" on the line where you want the break to occur.

20 terminals are allowed on the parametric build symbols by default. If the module exceeds 20 terminals the break is placed in a logical location; such as after a grouping of I/O addressing. For example, a 32 I/O point card could have 36 terminals on it, the module definition would run the break command at 18 (after the first set of 16 I/O addresses). If you want to break the module
sooner you can use the PLC Database File Editor to add the break command or do the following in the Module Terminal Information table.

HP?WA-D;TERM_07\SPECIAL=BREAK

Triggering for re-prompt of I/O address

Some modules include inputs and outputs. You can trigger AutoCAD Electrical to prompt for a new beginning address number when the parametric build flips from inputs to outputs or vice versa. Add "\SPECIAL=ADDR_OUT" on the line where you want a re prompt for a new output address or add "\SPECIAL=ADDR_IN" if you want a reprint for a new beginning input address.

Including unused terminals

Some modules may have terminals that are not used. Unused terminals are skipped by default, resulting in a compact representation of the module. You can set up the PLC database file to optionally show unused terminals by adding "\SPECIAL_INCLUDE" and "\SPECIAL_EXCLUDE" in the Module Terminal Information table.

Special spacing

Normally when AutoCAD Electrical generates a PLC module, it uses the current rung spacing for I/O and wire connection point spacing. You can override this by using the "\SPECIAL=SPACINGFACTOR=<val> in the Module Terminal Information table. When AutoCAD Electrical sees this on an I/O point or wire connection entry line, it uses a factor of the rung spacing. For example, a "\SPECIAL=SPACINGFACTOR=0.5" for a given I/O or wire connection entry flags AutoCAD Electrical to insert this point down 0.5 rung spacing instead of a full rung spacing. A value of 1.5 inserts the point down an extra half rung spacing than normal while 0.0 inserts the I/O point at the same location as the preceding one.

For example, the following four lines in a parametric data file inserts four points spread out over four ladder rung spaces:

HP?WA-D;TERM_=01
HP?W--;TERM_=COM
HP?W--;TERM_=VDC
HP?WA-D;TERM_=02

If you want the two middle terminal symbols to be grouped together into one rung space instead of taking up two spaces, edit the file to read:

HP?WA-D;TERM_=01
HP?W--;TERM_=COM;\SPECIAL=SPACINGFACTOR=0.5
Copy modules

You can copy an entire module into a new module using the PLC Database File Editor.

1. Click the arrow on the Insert PLC (Parametric) tool to access the PLC Database File Editor tool.

2. Click the PLC Database File Editor tool.

3. In the PLC selection list, right-click on the module that you want to copy from and select Copy.

4. Right-click the Type in the tree that you want to copy to. For example, if you want to copy the new module to Allen-Bradley, 1746, Discrete Input, you would find Discrete Input under Allen Bradley ➤ 1746 in the tree.

5. Select Paste Module.

   If you attempt to copy a PLC Module part number into a PLC Type that already has a module with the same name, the PLC Database File Editor prompts you to change the name of the new module being copied.

6. To change the name for the module, right-click the module, select Rename, and enter a new name.

Adjust the terminal information

When you highlight an exiting module part number in the PLC Database File Editor tree structure, the terminal grid control becomes populated with the terminal information previously defined for the module.

1. Click the arrow on the Insert PLC (Parametric) tool to access the PLC Database File Editor tool.

2. Click the PLC Database File Editor tool.

3. Select the module to modify from the tree structure.
Inside the terminal grid control there are drop-down list boxes, text boxes, and context menus that you can use to modify the terminal information.

4 Select the terminal(s) to modify. You can select multiple fields to edit at the same time by dragging your mouse across contiguous fields or by holding down the Control key while selecting non-contiguous fields. You can also select multiple terminals if you want the terminals to carry the same information.
   - If you want to modify the terminals one at a time, either make your changes on the PLC Database File Editor dialog box (using the drop-down list boxes or text boxes) or select a single terminal (making sure to select the entire row if you want to change more than one field), click the right mouse button, and select Edit Terminal from the menu.
   - If you want to modify multiple terminals at the same time, select the terminals, click the right mouse button, and select Edit Terminal from the menu.

5 In the Select Terminal Information dialog box, make any modifications to the selected terminal(s). Changes that you make in this box will be applied to all of the selected terminals in the terminal grid control.

6 Click OK to save your changes and return to the PLC Database File Editor.

7 Click Done to save your changes and exit the dialog box or click Done/Insert to save your changes and insert the PLC module into your drawing.

**PLC database file editor**
This tool creates and modifies PLC modules. All editing and creation of PLC data is stored within the PLC Database File (ACE_PLC.MDB).

Access:

Click the arrow on the Insert PLC (Parametric) tool to access the PLC Database File Editor tool.
From the Components menu, select Insert PLC Modules ➤ PLC Database File Editor.

**PLC Selection List**

Provides a complete list of the PLC data files available to AutoCAD Electrical. The PLC Selection list uses an expandable and collapsible tree structure for the PLC categories. These PLC categories are: Manufacturer, Series, Type, and Part Number. The tree structure supports right-click controls for copying, renaming, deleting, and creating PLC data.

The right-click controls for the selection list are:

- **New Manufacturer** (available only for the PLC branch of the tree structure) Defines a new manufacturer. The manufacturer then appears in the PLC Selection tree structure in alphabetical order.
- **New Series** (available only for the Manufacturer branch of the tree structure) Defines a new PLC series underneath the respective Manufacturer. The series then appears in the PLC Selection tree structure in alphabetical order.
- **New Type** (available only for the Series branch of the tree structure) Defines a new PLC type underneath the respective Manufacturer and Series. The type then appears in the PLC Selection tree structure in alphabetical order.
- **New Module** (available only for the Type and Module/Code branches of the tree structure) Defines a new PLC module underneath the respective Manufacturer, Series, and Type. The module then appears in the PLC Selection tree structure in alphabetical order.
- **Paste Module** (available only for the Type branch of the tree structure) Copies the PLC module to the highlighted PLC Type branch. This option becomes
active after you copy or cut a PLC module inside the Module/Code branch of the tree structure.

Delete

Deletes an entire PLC module, type, series, or manufacturer from the tree structure and the PLC database (ACE_PLC.MDB).

Rename

Renames a PLC module, type, series, or manufacturer in the tree structure. You cannot have duplicate names in the same branch of the tree structure.

Cut

(available only for the Module branch of the tree structure) Cuts the highlighted module code from the tree structure. You can then paste the code into the same PLC Type, or a new PLC Type category.

Copy

(available only for the Module branch of the tree structure) Copies the highlighted module code from the tree structure into the same PLC Type, or a new PLC Type.

NOTE If you attempt to copy a PLC Module part number into a PLC Type that already has a module with the same name, the PLC Database File Editor prompts you to change the name of the new module being copied.

Terminal Grid Control

Highlight a module from the PLC Selection tree structure to populate the Terminal Grid Control with the terminal information that was previously defined for the module. When creating a new PLC module, the PLC Database File Editor lists as many blank Terminal Type fields since are terminals defined within the New Module dialog box.

Terminal Type

Specifies the type for the terminal. Select from the various predetermined types of addressable terminals and non-addressable terminals.

Show

Shows terminals that are not used. If Include Unused/Extra Connections in the Module Layout dialog box is selected, all terminal entries marked (in the PLC Database File Editor dialog box) with 'when excluding unused' are skipped and all terminal entries marked with "when including unused" are shown.
Optional Re-prompt

Prompts for a new beginning address number when the parametric build flips from inputs to outputs or from outputs to inputs. On the line where you want AutoCAD Electrical to reprint for a new output address, select Output. If you want AutoCAD Electrical to reprint for a new input address, select Input from the list.

Break After

Specifies for the module to break automatically after a specific terminal type. To activate the prompt for an automatic break in the PLC module, select Break After.

Spacing Factor

Overrides the current rung spacing for I/O and wire connection point spacing. For example, a value of 2 inserts the point down two times the rung spacing instead of a full rung spacing.

You can right-click any row in the grid control to activate a menu of commands that allows you to edit the terminal, insert a new terminal before or after the selected terminal in the grid control, or delete a terminal from the grid control. You can select multiple fields to update at the same time by dragging your mouse across contiguous fields or by holding down the Control key while selecting non-contiguous fields.

Terminal Attributes

Displays attributes associated to the selected terminal. These attributes can have predefined values, including some values that you specify at insertion time.

New Module

Opens a dialog box for defining the module descriptions and parameters. A series of boxes are used to type in or select the values required to define the module.

NOTE If you right-click a type or module in the PLC Selection window and select New Module, the New Module dialog box opens with data already specified for the Manufacturer, Series, and Series Type.

Module Specifications

Opens a dialog box for modifying some of the specifications previously defined during the creation of a new module.
NOTE The Manufacturer, Series, Series Type, Code, and Terminals fields are not active since they are under the control of the tree structure in the PLC Selection window and the total number of terminals listed in the Terminal Type grid control.

Save Module

Saves the module to the PLC database file. If you exit the PLC Database File Editor without clicking Save Module, you get a prompt asking whether or not to save your changes.

Style Box Dimensions

Opens a dialog box for defining the module box dimensions (such as the offset values and line properties) based upon the style number used when the PLC was created.

NOTE The Module Box Dimensions override the style dimensions.

Settings

Opens a dialog box for adding or updating the symbols available to build a module.

PLC selection

Use this to select a module to add to the terminal blocks from. Select the module from the list and click OK.

Access:

Click the drop-down arrow on the Insert PLC (Parametric) tool to access the PLC Database File Editor tool. Click the Settings button, then click the Add Blocks From Module button.

From the Components menu, select Insert PLC Modules ➤ PLC Database File Editor. Click the Settings button, then click the Add Blocks From Module button.

The dialog box provides a complete list of the PLC modules available to AutoCAD Electrical. The Manufacturer Catalog list is compiled from the "ace_plc.mdb" file.

Module box dimensions
Use this to define the outer box dimensions of the module. The box dimensions are calculated from the insertion point of the parametrically-built PLC symbols.

Access:

Click the drop-down arrow on the Insert PLC (Parametric) tool to access the PLC Database File Editor tool. Click the New Module or Module Specifications button, and then click the Module Box Dimensions button.

From the Components menu, select Insert PLC Modules ➤ PLC Database File Editor. Click the New Module or Module Specifications button, and then click the Module Box Dimensions button.

NOTE A value for the Split Top and Split Bottom dimensions must be set before you can specify their line properties.

Module Box Dimensions

NOTE You must enter at least one of the Top, Bottom, Left or Right dimension values in order to assign settings specific to this module.

Sets the right, left, top, and bottom offsets for the rectangle that surrounds the module. The optional Split Top and Split Bottom specify the offsets for a split module where Split Top specifies the offset for the top of a split module and Split Bottom specifies the offset for the bottom of the split module. If left blank, AutoCAD Electrical will use the rectangle Top and Bottom values.

Line Properties

Sets the properties for the lines that make up the box. You can set the color and line type using the properties fields. To predefine the color, enter "COLOR colorname" into the box. For line type, enter "LTYPE linetypename" into the box. See the CHPROP command in the AutoCAD Help for more information about the various properties you can set.

Select terminal information

Use this to add or modify the type of terminal being used. You can select multiple fields to edit at the same time by dragging your mouse across
contiguous fields or by holding down the Control key while selecting non-contiguous fields.

**Access:**

Click the drop-down arrow on the Insert PLC (Parametric) tool to access the PLC Database File Editor tool. Right-click in the terminal grid control section of the dialog box, and select Edit Terminal from the menu.

From the Components menu, select Insert PLC Modules ➤ PLC Database File Editor. Right-click in the terminal grid control section of the dialog box, and select Edit Terminal from the menu.

The dialog box options enable depending on the fields selected at the time the dialog box was activated. For example, if you select the Show and Spacing Factor fields for multiple terminal entries in the Terminal Grid Control section of the PLC Database File Editor dialog box and then you activate this dialog box, you can update both fields through this dialog box for the selected terminals.

**Category**

Lists the terminal categories to select from. Top Input and Top Output are addressable terminals, while the Top Terminal category consists of non-addressable terminals. Other categories to select from are Input, Output, and Terminal.

**Types for Category**

Displays the types for the terminal category. Browse the list of images to determine which terminal type is appropriate for the terminal.

**Recently Used**

Shows an image of the terminals that were recently used.

**Show**

Specifies whether to show terminals that are not used. If the 'Include unused/extra connections' option in the Module Layout dialog box is selected, all terminal entries marked (in the PLC Database File Editor dialog box) with 'when excluding unused' are skipped.
Optional Re-prompt Address

Specifies whether to prompt for a new beginning address number when the parametric build flips from inputs to outputs or from outputs to inputs. On the line where you want AutoCAD Electrical to re-prompt for a new output address, select Output. If you want AutoCAD Electrical to re-prompt for a new input address, select Input from the list.

Break After

Specifies for the module to break automatically after a specific terminal type. To activate the prompt for an automatic break in the PLC module, check the Break After check box.

Spacing Factor

Overrides the current rung spacing for I/O and wire connection point spacing. For example, a value of 2 will cause AutoCAD Electrical to insert the point down two times the rung spacing instead of a full rung spacing.

New module

Defines the module descriptions and parameters. A series of boxes are used to type in or select the values required to define the module.

Access:

Click the arrow on the Insert PLC (Parametric) tool to access the PLC Database File Editor tool. Click New Module.

From the Components menu, select Insert PLC Modules ➤ PLC Database File Editor. Click New Module.

New Module Controls

Specifies the Manufacturer, Series, Series Type, and Code (Catalog Number) for the new module. Select from the list or enter the name in the edit box.

NOTE If you right-click a type or module in the PLC Selection window and select New Module, the New Module dialog box opens with data already specified for the Manufacturer, Series, and Series Type.
**PLC Selection Expanded Description Listing Controls**

These controls display as an expanded description when the module is highlighted in the tree structure of the PLC Selection dialog box. These include:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Describes the PLC module being defined.</td>
</tr>
<tr>
<td>Module Type</td>
<td>Gives an abbreviated type to the PLC module.</td>
</tr>
<tr>
<td>Base Addressing</td>
<td>Specifies whether the PLC module addressing follows an industry standard.</td>
</tr>
<tr>
<td></td>
<td>Select from Octal, Decimal, Hexadecimal, and Prompt. Prompt asks you at module insertion time for Octal, Decimal, and Hexadecimal.</td>
</tr>
<tr>
<td>Rating</td>
<td>Specifies the power rating value for the PLC module.</td>
</tr>
<tr>
<td>Terminals</td>
<td>Specifies the total number of terminals defined on the PLC module.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> This is not active since it is under the control of the total number of terminals listed in the Terminal Type grid control.</td>
</tr>
<tr>
<td>Addressable Points</td>
<td>Specifies the total number of termination points on the PLC module that will receive the PLC address attributes.</td>
</tr>
</tbody>
</table>

**AutoCAD Block to insert**

Specifies an AutoCAD block file to insert directly below the last I/O point inserted parametrically. These are typically used for block files that represent DIP switch settings and notes on how to configure the PLC module.

**Autolisp file to run at module insertion time**

Specifies an AutoCAD Lisp routine to run after the program executes the parametric build of the PLC module. These are typically used for inserting groups of symbols and wires, or modifying attributes on symbols to accommodate a more custom PLC module build.
Module Box Dimensions

Opens a dialog box for defining the outer box dimensions of the module. The box dimensions are calculated from the insertion point of the parametrically-built PLC symbols.

Module Prompts

Opens a dialog box for defining up to nine prompts to be used at the time of module insertion. You can specify the prompt number and the accompanying text, or you can remove prompts from this dialog box.

Terminal block settings

Adds or updates the symbols available to build a module.

Access:

Click the arrow on the Insert PLC (Parametric) tool to access the PLC Database File Editor tool. Click Settings. From the Components menu, select Insert PLC Modules ➤ PLC Database File Editor. Click Settings.

You can add a terminal to the list by clicking in any box in the last entry of the list. A blank entry line is added to the bottom of the list. You must define the block name, assign it to a terminal category for selection, give it a description, and assign a bitmap to be used for dialog displays.

Block File Name

Defines the AutoCAD drawing file name that is inserted if this terminal is included in your PLC module. These PLC symbols are stored in the symbol library of the active project with the other AutoCAD Electrical component symbols. Their file names begin with the characters "HP" (Horizontal ladder rungs/PLC) or "VP" (Vertical ladder rungs/PLC) followed by a digit that corresponds to a PLC I/O style number.

Category

Defines the category for the terminal. When you add a new terminal, you select from a list of terminal categories and that group of terminals is displayed. There are some categories by default (such as Input or Output) but you can add your own by typing in the edit box. This new category is added to the list.
Unique Description

Specifies the description that appears underneath the terminal in the Select Terminal Information dialog box.

Sample Bitmap File

Specifies the bitmap file for the terminal type. These are visible on the Select Terminal Information dialog box. If you are adding your own terminals, you can create corresponding bitmap files. Enter your bitmap name in the box or Browse for it. The next time you select a terminal type, the bitmap will be displayed.

Graphics Style

Specifies the graphical appearance of the PLC module. Styles 1-5 are predefined, styles 6-9 may be user-defined. Select a style number - a sample portion of a PLC module displays.

There are about two dozen symbols (with a file name "HP?*.dwg" where "?" is the style number) associated with each style in the \Program Files [(x86)\Autodesk\Acade {version}\libs\jic1 subdirectory. To create a new style, copy an existing style's symbols to one of the unused style numbers (6-9) and edit each library symbol.

View Drawing or View Bitmap

Displays the AutoCAD .dwg or bitmap file for the selected terminal. You can see the attributes of a specific terminal and the placement of each.

Add Blocks From Module

Opens a dialog box for selecting a module to add terminal blocks from. Select the module from the list and click OK.

Style box dimensions
Defines the module box dimensions (such as the offset values and line properties) based upon the style number used when the PLC was created.

Access:

Click the arrow on the Insert PLC (Parametric) tool to access the PLC Database File Editor tool. Click Style Box Dimensions.

From the Components menu, select Insert PLC Modules ➤ PLC Database File Editor. Click Style Box Dimensions.

**NOTE** You must set a value for the Split Top and Split Bottom dimensions before specifying their line properties.

**Graphics Style**

Specifies the graphical appearance of the PLC module. Styles 1-5 are predefined, styles 6-9 may be user defined. Select a style number - a sample portion of a PLC module displays.

There are about two dozen symbols (with a file name "HP?*.dwg" where "?" is the style number) associated with each style in the \Program Files [(x86)]\Autodesk\Acade [version]\libs\jic1 subdirectory. To create a new style, copy an existing style's symbols to one of the unused style numbers (6-9) and edit each library symbol.

**Module Box Dimensions for Selected Style**

Sets the right, left, top, and bottom offsets for the rectangle that surrounds the module. The optional Split Top and Split Bottom specify the offsets for a split module where Split Top specifies the offset for the top of a split module and Split Bottom specifies the offset for the bottom of the split module. If left blank, the rectangle Top and Bottom values are used.

**Line Properties**

Sets the properties for the lines that make up the box. You can set the color and line type using the properties fields. To predefine the color, enter "COLOR colorname" into the box. For line type, enter "LTYPE linetypename" in the box.

**Module specifications**
Modifies specifications previously defined during the creation of a new module.

**Access:**

Click the arrow on the Insert PLC (Parametric) tool to access the PLC Database File Editor tool. Click Module Specifications. From the Components menu, select Insert PLC Modules ➤ PLC Database File Editor. Click Module Specifications.

**Module Controls**

Specifies the Manufacturer, Series, Series Type, and Code (Catalog Number) for the module.

**NOTE** These fields are not active since they are under the control of the tree structure in the PLC Selection window.

**PLC Selection Expanded Description Listing Controls**

These controls display as an expanded description when the module is highlighted in the tree structure of the PLC Selection dialog box. These include:

<table>
<thead>
<tr>
<th>Description</th>
<th>Describes the PLC module being defined.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module Type</td>
<td>Gives an abbreviated type to the PLC module.</td>
</tr>
<tr>
<td>Base Addressing</td>
<td>Specifies whether the PLC module addressing follows an industry standard. Select from Octal, Decimal, Hexadecimal, and Prompt. Prompt asks you at module insertion time for Octal, Decimal, and Hexadecimal.</td>
</tr>
<tr>
<td>Rating</td>
<td>Specifies the power rating value for the PLC module.</td>
</tr>
<tr>
<td>Terminals</td>
<td>Specifies the total number of terminals defined on the PLC module.</td>
</tr>
<tr>
<td>Addressable Points</td>
<td>Specifies the total number of termination points on the PLC module that will receive the PLC address attributes.</td>
</tr>
</tbody>
</table>

**NOTE** This is not active since it is under the control of the total number of terminals listed in the Terminal Type grid control.
**AutoCAD Block to insert**

Specifies an AutoCAD block file to insert directly below the last I/O point inserted parametrically. These are typically used for block files that represent DIP switch settings and notes on how to configure the PLC module.

**Autolisp file to run at module insertion time**

Specifies an AutoCAD Lisp routine to run after the program executes the parametric build of the PLC module. These are typically used for inserting groups of symbols and wires, or modifying attributes on symbols to accommodate a more custom PLC module build.

**Module Box Dimensions**

Opens a dialog box for defining the outer box dimensions of the module. The box dimensions are calculated from the insertion point of the parametrically-built PLC symbols.

**Module Prompts**

Opens a dialog box for defining up to nine prompts to be used at the time of module insertion. You can specify the prompt number and the accompanying text, or you can remove prompts from this dialog box.

**Prompts at module insertion time**

Use this to define up to nine prompts to be used at the time of module insertion. You can specify the prompt number and the accompanying text, or you can remove prompts from this dialog box.

**Access:**

Click the drop-down arrow on the Insert PLC (Parametric) tool to access the PLC Database File Editor tool. Click the New Module or Module Specifications button, then click the Module Prompts button.

From the Components menu, select Insert PLC Modules ➤ PLC Database File Editor. Click the New Module or Module Specifications button, then click the Module Prompts button.

You can define up to nine different prompts at insertion time.

- To assign a prompt, select the prompt number from the list, enter the prompt text in the edit box, and click Change.
To modify a prompt, select the prompt number from the list, modify the
text in the edit box, and click Change.

To remove a prompt, select the prompt number from the list and click the
Remove Selected Prompt button.

Example

Let's say you assigned RACK NUMBER to the prompt %%%1 and SLOT NUMBER
to the prompt %%%2. At insertion time, the I/O Point dialog box will open so
that you can enter values for the RACK NUMBER and SLOT NUMBER fields
right before the module is built. The value you enter in the RACK NUMBER
edit box is temporarily saved in memory under the variable name %%%1. The
SLOT NUMBER value is saved under the %%%2 variable name.

These prompts can be used in the attribute grid to fill in attribute values or
partial attribute values at module insertion time.

Modify single, stand-alone PLC layout symbols

The single, stand-alone PLC I/O symbols are in the "\Program Files
{(x86)\Autodesk\Acade {version}\libs\jic1" library (or "\Program Files
{(x86)\Autodesk\Acade {version}\libs\jic125" library) but do not follow the
normal AutoCAD Electrical naming convention. Their file names must start
with "PLCIO" in order for AutoCAD Electrical to find and process them along
with the full PLC modules in the various BOM and PLC reports. The last three
characters need not follow any naming convention.

Open each in AutoCAD and modify the appearance to suit your needs. Here
are the file names of the default symbols (in the "\Program Files
{(x86)\Autodesk\Acade {version}\libs\jic1" subdirectory):

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLCIO11T.dwg</td>
<td>First input, single wire left</td>
</tr>
<tr>
<td>PLCIO11.dwg</td>
<td>2+ input, single wire left</td>
</tr>
<tr>
<td>PLCIO12T.dwg</td>
<td>First input, wire left and right</td>
</tr>
<tr>
<td>File Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>PLCIOI2.dwg</td>
<td>2+ input, wire left and right</td>
</tr>
<tr>
<td>PLCIOO1T.dwg</td>
<td>First output, wire right</td>
</tr>
<tr>
<td>PLCIOO1.dwg</td>
<td>2+ output, wire right</td>
</tr>
<tr>
<td>PLCIOO2T.dwg</td>
<td>First output, wire left and right</td>
</tr>
<tr>
<td>PLCIOO2.dwg</td>
<td>2+ output, wire left and right</td>
</tr>
</tbody>
</table>
Insert PLC layout points

PLC I/O points can be inserted as independent symbols spread out over your drawing set. AutoCAD Electrical provides a small set of single I/O point library symbols that you can expand and modify to suit your needs.

1. Click the Insert Component tool.
2. On the main icon menu select PLC I/O.

   **NOTE** Single I/O points are selected from the second and third rows of the sub dialog.

3. Select the component to insert and specify an insertion point.

   **NOTE** Select from the upper row for the first I/O point of a module. These symbols carry attributes for catalog BOM assignment. Select from the bottom row for the 2nd through nth points of a module (which are children symbols of the first symbol parent).

4. Add or edit any information in the Edit PLC I/O Point dialog box and click OK.

Annotate stand-alone I/O points

The Edit PLC I/O Point dialog displays when a stand-alone I/O point symbol is inserted or edited. Use this dialog to make changes to your selected I/O point.

1. Click the Insert Component tool.
2. Select to insert PLC I/O points (found on the second and third rows of the sub dialog box) and specify an insertion point.

   To edit an existing point, right-click on an I/O point and select Edit Component from the context menu.

3. Make changes to the I/O point.
4. (Optional) To assign the I/O address, click Used: Drawing or Used: Project to select an I/O address that has been used already on a module.
5 (Optional) To assign the description, click External File to select the description from a comma-delimited ASCII text file of available I/O point descriptions.

6 Click OK and the values are annotated onto the I/O point.

**Edit PLC I/O point**

Use this dialog box when inserting or editing a stand-alone I/O point symbol. Specify the values you need and press OK. The values are then annotated onto the selected I/O point.

**Access:**

Click the Insert Component tool. Select to insert a PLC I/O point. Specify the insertion point on the drawing.

From the Components menu, select Insert Component. Select to insert a PLC I/O point. Specify the insertion point on the drawing.

**Address**

**I/O Address**

Searches for a wire connection to a nearby PLC I/O address and, if found, uses the PLC address number in the component's tag name.

**Used: Drawing or Project**

Lists any I/O addresses already assigned. Select a tag from the list to copy, or to increment for this new component.

**Parent/Sibling**

Transfers all information from the parent component to the child component being inserted or edited. If the parent is visible on the screen, click Parent/Sibling, and select the parent (or another related contact).

**Module Tag/Description**

**Tag**

Specifies a unique identifier assigned to each I/O point. The tag value can be manually typed in the edit box.
Optional description text for the I/O point. May be used to identify the point's relative location in the I/O assembly (for example, Rack # and Slot #).

Manufacturer
Lists the manufacturer number for the I/O point. Enter a value or select one from the Catalog lookup.

Catalog
Lists the catalog number for the I/O point. Enter a value or select one from the Catalog lookup.

Assembly
Lists the assembly code for the I/O point. The Assembly code is used to link multiple part numbers together.

Catalog Lookup
Opens the I/O point's catalog database from which you can manually enter or select the Manufacturer or Catalog values. Search the database for a specific catalog item to assign to the selected cable. Database queries are set up in the 3 lists across the top of the dialog with the database hits listed in the dialog's main window.

Options
Substitutes a fixed text string for the %F part of the tag format. Retag Component can then use this override format value to calculate a new tag for the PLC module. For example, a certain PLC module needs to always have an "IO" family tag value instead of "PLC" so that retag, for example, assigns IO-100 instead of PLC100. To achieve this tag override, enter "IO-%N" for the tag override format.

Description
Optional line of description text. May be used to identify the PLC type (for example, "16 Discrete Inputs - 24VDC")

I/O Point Description

Description 1-5
Specifies optional description text. Up to 5 lines of description attribute text can be entered.

Pick
Selects a description from a module on the current drawing.
List descriptions: External file

Displays contents of an external comma-delimited ASCII text file of I/O point descriptions. Pick an entry in the file, and then copy the values to edit boxes in the Edit dialog.

**Installation/Location codes**

Changes the installation or location codes. You can search the current drawing or entire project for installation and location codes. A quick read of all the current or selected drawing files is done and a list of codes used so far is returned. Select from the list to automatically update the module with the installation or location code.

**Pins**

Assigns pin numbers to the pins that are physically located on the module.

**Show/Edit Miscellaneous**

View or edit any attributes that are not predefined AutoCAD Electrical attributes.

**Ratings**

Specifies values for each ratings attribute. You can enter up to 12 ratings attributes on a module. Select Defaults to display a list of default values.

**NOTE** If Ratings is grayed out, the module you are editing does not carry rating attributes.

---

**Work with PLC styles**

**Modify a PLC appearance style**

There are 5 predefined PLC styles provided with AutoCAD Electrical, numbered 1 through 5. If one or more of these do not appeal to you or if you have a client with specific requirements not met by any of the 5 styles, you can pick one of the existing styles and modify it.
There are about 3 dozen symbols associated with each style. They are located in the jic1 subdirectory (or jic125 for the uniform 0.125 text height version). They carry the file name "HP?*.dwg" where "?" is the style number.

Create a new PLC style

An easy way to create a new PLC style is to copy an existing PLC style’s library symbols to one of the unused style numbers (6, 7, 8, or 9) and then edit each one to suit your needs.

For example, copy style 1 to style 6 by copying "\Program Files [(x86)]\Autodesk\Acade {version}\libs\jic1\hp1*.dwg" to "\Program Files [(x86)]\Autodesk\Acade {version}\libs\jic1\hp6*.dwg" (or, if you are using the 0.125 uniform text height library, copy "\Program Files [(x86)]\Autodesk\Acade {version}\libs\jic125\hp1*.dwg" to "\Program Files [(x86)]\Autodesk\Acade {version}\libs\jic125\hp6*.dwg"). Open the hp6*.dwg drawing files in AutoCAD and modify as required. To access your new style, select "6" in the style sub dialog box when you prepare to select and insert a new PLC module.

Add a new PLC style

The icon menu graphics that display for the various PLC styles are bitmap files saved to your \Program Files [(x86)]\Autodesk\Acade {version}\Acade\ folder where AutoCAD Electrical's Insert PLC and Drawing Properties tools can access them.

1. Create the new style in AutoCAD.
2. Zoom in to the new PLC style.
3. Save the file as a bitmap using the following name definition:
   - For the Drawing Properties dialog box: the graphic must have the name P_STYLExH.bmp or P_STYLExV.bmp where ‘x’ is the PLC style number (1-9) and H or V indicate the module orientation (horizontal or vertical)
   - For the Insert PLC dialog box: the file name must be STYLExH.bmp or STYLExV.bmp where ‘x’ is the PLC style number (1-9) and H or V indicate the module orientation (horizontal or vertical)

   **NOTE** If the resulting bitmap is too small or off-center, open the source drawing in AutoCAD again. Resize your AutoCAD graphics window so that it is more square. Center the image and resave. Repeat until you are satisfied with the result.
Overview of the PLC spreadsheet/database format

The PLC information can be read from an Microsoft Excel spreadsheet, Access database table, or a comma-delimited file. AutoCAD Electrical expects to find certain columns containing the information needed to generate the drawings. The columns can be in any order defined by your settings. All columns are optional except the Module part number (Code) column. Three example PLC data files are found in the User folder: DEMOPLC.XLS, DEMOPLC.CSV and DEMOPLC_IEC.XLS. A settings file is also provided to run the Spreadsheet to PLC I/O Utility: DEMOPLC_IEC.WDI.

Use the Spreadsheet to PLC I/O Utility tool to assign spreadsheet or table column numbers to the data categories below.

Module data

Module part numbers (Code)  This can be the code for a parametrically generated module, or for a full module's library symbol. It can even be a non-PLC symbol such as a variable speed drive.

Address (ADDR)  The I/O address for each I/O point. This value gets annotated to the "TAGA_" attribute.

Rack numbers (R)  The module's rack number, used for the attribute assigned to the %%%1 Prompt from the parametric data file.

Group numbers (G)  The module's group number, used for the attribute assigned to the %%%2 Prompt from the parametric data file.

Slot numbers (S)  The module's slot number, used for the attribute assigned to the %%%3 Prompt from the parametric data file.

Remote terminal panel (RTP)  The module's remote terminal panel ID number, used for the attribute assigned to the %%%4 Prompt from the parametric data file.

Wire numbers  The wire number used for each I/O point.
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module’s tag</td>
<td>The value assigned to the module’s TAG attribute.</td>
</tr>
<tr>
<td>Module’s Installation</td>
<td>The value assigned to the module’s installation attribute.</td>
</tr>
<tr>
<td>Module’s Location</td>
<td>The value assigned to the module’s location attribute.</td>
</tr>
<tr>
<td>Description 1-5 (DESC1-DESC5)</td>
<td>The values assigned to the module’s 5 description attributes.</td>
</tr>
<tr>
<td>Voltage/Input/Output (VOLTAGE)</td>
<td>The value used to determine if a module is an input or output module if it cannot be determined from the parametric data file. For input modules, AutoCAD Electrical looks for DI, AI, or IN as part of the text string. For output modules, AutoCAD Electrical looks for DO, AO, or OUT as part of the text string. For combination modules, it looks for IO, Other, or both IN and OUT in the text string.</td>
</tr>
</tbody>
</table>

**Special PLC values**

There are some special values that can be placed in a row to direct special PLC module features:

- **BREAK**
  - Insert this keyword in the ADDRESS column of the spreadsheet where you want the PLC module to break and continue on the next ladder column. There should not be any other data in the spreadsheet row; only the word “BREAK” in the address column.

- **SPACER**
  - Insert this keyword in the ADDRESS column of the spreadsheet where you want to add extra space between adjacent I/O points. There should not be any other data in the spreadsheet row; only the word “SPACER” in the address column.

- **SKIP**
  - Insert this keyword into the CODE module part number column right after the end of the previous module’s data on the spreadsheet. This keyword triggers the utility to skip a ladder before it begins the next module in the spreadsheet. There should not be any other data in the spreadsheet row; only the word “SKIP” in the part number code column.
Place an asterisk (*) in front of a device block name to trigger an Insert Circuit instead of an Insert Component. Any associated TAG, DESC, MFG, and CAT column values for this entry are annotated onto the first AutoCAD Electrical symbol found on the inserted circuit.

**Inline component data**

The PLC Generator supports up to 9 inline components. Replace the numeric value “n” with the next incrementing number; the first component would have a tag of D1TAG while the second component would have the tag of D2TAG. The columns of data are as follows:

| **Tag (DnTAG)** | The value to be used for the component's TAG attribute. For terminals, use this column to encode both the TAG and Terminal Number. Use this format TAGSTRIP:TERM where the colon character separates the terminal's TAG-ID value from the terminal number to be applied to the TERM attribute. For example, "TB1:25" in the component tag column puts "TB1" on the TAGSTRIP attribute and "25" on the TERM attribute. |
| **Description (DnDESC)** | The values assigned to the component's DESC attributes. Use the | symbol to separate text and assign it to DESC1, DESC2, or DESC3. For example, if you use "CYCLE|START" in the description field, "CYCLE" is assigned to DESC1 and "START" to DESC2. |
| **Block (DnBLK)** | The .dwg file name for the component you want to use. |
| **Location (DnLOC)** | The value assigned to the component's location (LOC) attribute. |
| **Installation** | The value assigned to the component's installation (INST) attribute. |
| **Manufacturer** | The value assigned to the component's manufacturer (MFG) attribute. |
| **Catalog** | The value assigned to the component's catalog (CAT) attribute. |
| **Assembly** | The value assigned to the component's assembly code (ASSYCODE) attribute. |
You can predefine other attribute values using the format "mainval;attrnam2=attrval2;attrnam3=attrval3," and so on. Enter this in any inline component column except the Block column defining the component's block name.

Components for input modules are inserted left-to-right, while components for output modules are inserted right-to-left. Note that the spacing between devices (as defined in your settings) is maintained even if no component is defined for a particular column.

**Special wiring for inline components**

Normally each inline component is wired in series connected from the bus to the I/O point. AutoCAD Electrical also supports jumpers between adjacent rungs. To direct AutoCAD Electrical to use a jumper, you encode the jumper as one of the available inline devices. Use the "|" character as the symbol block name for the jumper. To control removal of wire connections, follow the "|" character with 4 characters to cover upper left, upper right, lower left, and lower right connections. Use "W" to keep the wire connection and "X" to remove. For example, a block name of "|WWXW" inserts a jumper and trims the lower left wire connection. "|XWXW" trims away the left-hand wire connections of both top and bottom. Just a "|" for the block name is the same as "|WWWW", all wire connection retained.

Wiring to analog input or output modules might need to loop back to a return terminal instead of going all the way across to a power bus. You can direct the generator to pop in a vertical short wire to loop back around. For looping back to the right, insert "|XWXW" as the first inline device. To loop back to the left use "|WXWX".
Automatically generate I/O schematic drawings

A project's PLC I/O requirements, in spreadsheet or database format, can drive automatic generation of the I/O schematic drawings.

1 Click the arrow on the Insert PLC (Parametric) tool to access the Spreadsheet to PLC I/O Utility tool.

2 Click the Spreadsheet to PLC I/O Utility tool.

3 Select the spreadsheet and click Open.

4 In the Spreadsheet to PLC I/O Utility dialog box, enter a value for the beginning line reference number for the first ladder of the drawing. Specify any other options to use for the ladder reference numbers.

5 Specify how you want the module to be placed in the drawing.

6 Click Start.

AutoCAD Electrical constructs a set of PLC I/O drawings based on the information carried in the PLC spreadsheet. Ladders and modules insert automatically, breaking at the bottom of one ladder and continuing on the next.

Change and use PLC I/O settings

You have control over many aspects of how these drawings auto-generate. You also can adapt this tool to an existing spreadsheet or database format that is different from the example demoplcl.xls file format. You can change these settings each time you run the program or change them once and save your settings for future use.
Change and save the settings

1. Click the arrow on the Insert PLC (Parametric) tool to access the Spreadsheet to PLC I/O Utility tool.

2. Click the Spreadsheet to PLC I/O Utility tool.

3. Select the spreadsheet and click Open.

4. In the Spreadsheet to PLC I/O Utility dialog box, do one of the following:
   ■ Click Setup to define how the drawings should be set up (based on the default settings). This includes how many ladders you want inserted, the type and orientation of the ladders, spacing, and number of rungs. You can also define the module placement, style, scale, and in-line device placement and spacing.
   ■ Click Browse to select an existing setting file that you can then edit and save.
   ■ Click Setup then click Spreadsheet/Table Columns to define what column in your spreadsheet or database table goes with what data value in the utility. The first page of this dialog deals with the overall module information. The sub-dialog box (accessed from clicking the More button) identifies the column data for up to nine in-line connected devices for each I/O point.

5. Click Save to save the settings to a file for future use.

6. Enter a file name for the settings (the file extension will be ".WDI") and click Save.
Read the settings

1. Click the arrow on the Insert PLC (Parametric) tool to access the Spreadsheet to PLC I/O Utility tool.

2. Click the Spreadsheet to PLC I/O Utility tool.

3. Select the spreadsheet and click Open.

4. In the Spreadsheet to PLC I/O Utility dialog box, click Browse.

5. Select a previously created file (it has a ".WDI" file extension) and click Open.

   Your settings are now restored and are used for the drawings generated from the selected spreadsheet or database table.

Spreadsheet to PLC I/O utility

AutoCAD Electrical reads in your information (.xls, .mdb, or .csv format) and then constructs a set of PLC I/O wiring diagrams directly from your data. Ladders and modules insert automatically, breaking at the bottom of one ladder and continuing on the next (or on to the next drawing).

Access:

Click the arrow on the Insert PLC (Parametric) tool to access the Spreadsheet PLC I/O Utility tool. Select the spreadsheet output file and click Open.

From the Components menu, select Insert PLC Modules ➤ Spreadsheet to PLC I/O Utility. Select the spreadsheet output file and click Open.

Settings

Select a PLC settings file (.wdi) to use. The default is to use the settings in the WDIO.LSP file. Specify the settings to use by entering a file name in the box or clicking Browse to select a file. The path to the selected WDI file displays underneath the edit box. If you enter the name of the .wdi file, AutoCAD
Electrical searches for the file in the standard search locations in the following order:

1. User subdirectory (C:\Documents and Settings\{username}\Application. Data\Autodesk\AutoCAD Electrical\{release #}\{country code}\Support\User\)
2. Active project's .wdp file subdirectory
3. Symbol library paths defined for the active project
4. AutoCAD Electrical lookup subdirectory (C:\Documents and Settings\username\My Documents\Acade{version}\AeData
5. AutoCAD Electrical support (C:\Program Files [(x86)]\Autodesk\Acade {version}\Support\)
6. Current Directory
7. All paths defined under AutoCAD Options ➤ Files ➤ Support Files Search Path

Click Setup to display the Spreadsheet to PLC I/O Utility Setup dialog box. Use this to modify and save new setting configurations.

**NOTE** If you select the .wdi file to use after you make changes in the Spreadsheet to PLC I/O Utility Setup dialog box, the settings in the .wdi file are used and the setup changes are not applied.

### Ladder Reference Numbering

**Start**
Specifies the value for the beginning line reference number for the first ladder of the first drawing. Leading zeros and embedded alpha characters are supported for line reference numbering.

**Index**
Defines if you want your line reference numbers to sequence by 1 (default) or by some other amount.

**Column to column**
Indicates whether to use the next sequential number for the first ladder on each successive column or to use the specified value to skip for the next column's first ladder reference.
Indicates whether to use the next sequential number for the first ladder on each successive drawing or to use the specified value to skip for the next drawing’s first ladder reference.

**Module Placement**

There are 3 options related to module placement. This allows you to define if you want each I/O module to start at the top of a ladder, if you want the module built in a ladder with the previous module only if it fits completely, or if you want the module to be built in the same ladder with the previous module and split if necessary to fill the ladder.

**Include unused/extra connections**

You may have PLC modules with terminal connections that are unused. Usually AutoCAD Electrical leaves these out and the module is built without showing these terminal connections. Select this to include the connections in the PLC module. If you select to place modules within the same ladder, enter the number of rungs to skip between modules.

**NOTE** When a module is selected that contains some of these terminals, they are included if you select this option.

If you want to show these connections, include them in the Attributes column of the Module Terminal Information table of the ace_plc.mdb file with ";\SPECIAL=INCLUDE" following the block information or by selecting "When Including Unused" or "When Excluding Unused" in the Show column of the PLC Database File Editor dialog box.

**Allow pre-defined breaks**

Your PLC modules automatically break at a given point when a ";\SPECIAL=BREAK" code is encountered in the module’s block of parametric data.
**Drawing File Creation**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use active drawing</td>
<td>Indicates to use the open and active drawing file to begin the PLC placement process.</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>This is unavailable if a Starting file name is specified.</td>
</tr>
<tr>
<td>Starting file name</td>
<td>Specifies the drawing file to begin with for your PLC drawings. Enter a name or click Browse to select a file. The .dwg extension is not required and the file is saved in the same folder as the active .wdp file.</td>
</tr>
<tr>
<td>Pause between drawings/Free run</td>
<td>Your spreadsheet may contain enough information to generate multiple drawings. Select Pause between drawings to stop between each drawing or select Free run if you want the program to run completely to the end without stopping.</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>When you select Pause Between Drawings, a single drawing is generated and then a dialog box opens allowing you to adjust settings, select to do a free run, or continue with a pause between drawings. The Use active drawing option is disabled.</td>
</tr>
<tr>
<td>Sheet</td>
<td>If your ladders use the AutoCAD Electrical Sheet parameter you can enter a value for the optional sheet number.</td>
</tr>
<tr>
<td>Add new drawing to active project</td>
<td>Adds newly created drawings to the active project. The new drawings are added to the end of the project’s drawing list.</td>
</tr>
</tbody>
</table>

**Save**

Saves the setup information and settings in a .wdi file to be reused.

**Spreadsheet to PLC I/O utility setup**

Use this to define how the drawings should be set up. This includes how many ladders you want inserted, the type and orientation of the ladders, spacing,
and number of rungs. You can also define the module placement, style, scale, and inline device placement and spacing.

Access:

Click the arrow on the Insert PLC (Parametric) tool to access the Spreadsheet PLC I/O Utility tool. Select the spreadsheet output file and click Open. In the Spreadsheet to PLC I/O Utility dialog box, click Setup.

From the Components menu, select Insert PLC Modules ➜ Spreadsheet to PLC I/O Utility. Select the spreadsheet output file and click Open. In the Spreadsheet to PLC I/O Utility dialog box, click Setup.

**NOTE** New default values can be programmed into the source file. The program source file name is "wdio.lsp." Open the file with any ASCII text editor and carefully edit the values near the top of the file.

### Ladder

**Origin**

Specifies the insertion point for first (or only) ladder on the drawing. This corresponds to the upper left-hand corner of the ladder.

**Orientation**

Specifies to create a vertical bus ladder (with horizontal wires) or horizontal bus ladder (with vertical wires).

**Reference numbers**

Specifies the default referencing system:

- Numbers Only
- Numbers Ruling
- User Blocks
- X-Y Grid: All referencing is tied to an X-Y grid system of numbers and letters along the left-hand side and top of the drawing. Set your drawing's vertical and horizontal index numbers and letters, spacing, and origin in the X-Y grid setup dialog box.

**TIP** Use negative spacing values for horizontal or vertical if you want to change the XY grid system's origin to be other than the upper left-hand corner of the drawing.
**X Zones:** Similar to X-Y Grid, but there isn't a Y-axis. Set your drawing's horizontal labels, spacing, and origin on the X Zones setup dialog box.

**TIP** Use a negative zone spacing value if you want the zone reference origin to be at the right side of the drawing.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Width</strong></td>
<td>Specifies the width of each ladder (offset distance between the ladder's 2 bus wires) from left to right rail.</td>
</tr>
<tr>
<td><strong>Distance between</strong></td>
<td>Specifies the offset distance from the insertion point of one ladder to the insertion point of the next ladder.</td>
</tr>
<tr>
<td><strong>Ladders per drawing</strong></td>
<td>Specifies the number of ladders to insert. Vertical ladders insert left to right. Horizontal ladders insert top to bottom.</td>
</tr>
<tr>
<td><strong>Rungs per ladder</strong></td>
<td>Specifies the quantity of line reference / wire rungs per ladder. This value multiplied by the &quot;Spacing - ladder rung to rung&quot; value determines the length of the inserted ladders.</td>
</tr>
<tr>
<td><strong>Rung spacing</strong></td>
<td>Specifies the distance from one rung to the next rung on a ladder.</td>
</tr>
<tr>
<td><strong>Rung count skip for I/O start</strong></td>
<td>Specifies the quantity of rungs to skip before inserting a PLC module (0=no skip)</td>
</tr>
<tr>
<td><strong>Suppression</strong></td>
<td>Indicates whether to include/exclude bus rails and rungs.</td>
</tr>
<tr>
<td><strong>Signal arrow style</strong></td>
<td>Specifies the default wire signal arrow style. Select from the 4 predefined styles or a user-defined style. You can override the default style setting at insertion time.</td>
</tr>
<tr>
<td><strong>Module</strong></td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>PLC graphical style</strong></td>
<td>Specifies the default PLC module style. Select from the 5 predefined styles or a user-defined style.</td>
</tr>
<tr>
<td><strong>Input offset from neutral</strong></td>
<td>Specifies the Input module insertion offset distance (vertical ladder orientation - measured in +X direction from right-hand vertical bus; horizontal ladder orientation - measured in +Y direction from lower horizontal bus).</td>
</tr>
<tr>
<td><strong>Output offset from hot bus</strong></td>
<td>Specifies the Output module insertion offset distance (vertical ladder orientation - measured in -X direction from the left-hand vertical bus; horizontal ladder orientation - measured in the -Y direction from the upper horizontal bus).</td>
</tr>
</tbody>
</table>

**NOTE** If module type cannot be determined or if it is combination Input and Output, then the module is inserted down the middle of the ladder.

| **Maximum I/O per ladder** | Specifies the maximum number of module I/O points to insert into each ladder without breaking the module and continuing it in the next ladder. |
| **I/O point spacing** | Specifies the insertion point offset distance between one in-line device and the next. |
| **Scale** | Specifies the PLC module scale override value (default = 1.0). This applies a scale factor to the PLC module insertion except for the "Spacing - I/O point to I/O point" value defined above. If Apply this scale to module outline only is selected, then this scaling factor is applied only to the module's outline. |
In Line Devices

First input device from hot bus  Specifies the starting offset distance from the left-hand or upper bus for the first (or only) in-line device defined for each Input module I/O point.

First output device from neutral bus  Specifies the starting offset distance from the right-hand or lower bus for the first (or only) in-line device defined for each Output module I/O point.

Spacing between multiple devices  Specifies the insertion point offset distance between one in-line device and the next.

Spreadsheet/Table Columns

Displays the Spreadsheet to PLC I/O Drawing Generator dialog box for reviewing and mapping spreadsheet columns to attributes on the PLC module symbol.

Drawing Template

You can force the tool to use a specific template for new drawings. Enter the template drawing file name with the full path or click Browse to search for an existing template (this looks in the AutoCAD template folder where all of the user drawing templates are saved). For the current default template, leave the value blank. If you do not want to use a template drawing, enter a single dot in the edit box.

NOTE  Make sure your template does not have any existing ladders.

Save

Saves the spreadsheet information in a .wdi file to be reused. Once you save the new .wdi file, the Spreadsheet to PLC I/O Utility dialog box redisplays and the new .wdi file name displays in the Settings edit box.
Create PLC spreadsheets using RSLogix

RSLogix is a PLC programming software package for programming various Allen-Bradley PLCs. This program has an output function that can write the I/O information out to an ASCII file. AutoCAD Electrical imports this information and creates a regular spreadsheet from the data that can then be used to create PLC drawing files.

Using the RSLogix 500 Import dialog box, you can omit PLC cards, reserve future locations for PLC cards in drawings, and browse to select a PLC code from the PLC database. Once you modify the .eas file and apply the PLC data to categories you can save the data into a PLC import spreadsheet that is used to create the PLC drawing files.

Export I/O information using RSLogix

Use this to create a Microsoft Excel spreadsheet file from a RSLogix file that can be imported into AutoCAD Electrical using the Spreadsheet to PLC I/O Utility tool.

1 In RSLogix, export your RSLogix 500 file into .EAS format.
2 Click the arrow on the Insert PLC (Parametric) tool to access the RSLogix 500 Export to Spreadsheet tool.

3 Click the RSLogix 500 Export to Spreadsheet tool.

4 Select an .EAS or .CSV file and click Open.

5 In the RSLogix 500 Import dialog box, select whether the I/O points should be displayed in 8, 16, or 32 point groupings.

6 Pick an I/O module for each set of I/O points. Enter it in the edit box, select from the PLC dialog using Browse, or select from the already used list once you have some modules selected.

7 Click OK to assign the module and move on to the next set of points.

8 (Optional) To change a module assignment, select the module assignment and click Change. In the RSLogix 500 Import Change Module dialog box, change the selected module part number by entering the new module name in the edit box, selecting it from the PLC dialog using Browse, or selecting it from the already used list once you have some modules selected. Click OK to assign the module and return to the Input Module dialog box.

9 (Optional) Click Omit to skip a set of points, or click Future to skip the points and add information so AutoCAD Electrical will add a blank column when generating the drawing from the spreadsheet.

10 Enter a name for the spreadsheet once a module has been assigned for each set of points. Click Save. Use Microsoft Excel to modify your spreadsheet as needed.

11 Click Components ➤ Insert PLC Modules ➤ Spreadsheet to PLC I/O Utility to create the PLC drawing. (page 257)
Use this tool to import I/O information from RSLogix and create a regular spreadsheet from the data that can then be used for the Spreadsheet to PLC I/O generator.

Access:

Click the arrow on the Insert PLC (Parametric) tool to access the RSLogix 500 Export to Spreadsheet tool. Select an .EAS or .CSV file and click Open. From the Components menu, select Insert PLC Modules ➤ RSLogix 500 Export to Spreadsheet. Select an .EAS or .CSV file and click Open.

The text “Input Module x of x” displays underneath the dialog box title bar to keep track of which module you are editing out of the total number of modules found in the RSLogix import file.

8pt, 16pt, or 32 pt slot addressing  
Specifies whether the I/O points displayed should be in 8pt, 16pt, or 32 pt groupings.

Default to  
Specifies to display the module in octal or decimal format.

Module assignment so far  
Displays the I/O modules already picked for each set of I/O points. Enter the module name in the edit box, select it from the PLC dialog box using Browse, or select it from the already used list once you have some modules selected. Click OK to assign the module and move on to the next set of points.

Omit  
Skips a set of points.

Future  
Skips the points and adds information so AutoCAD Electrical adds a blank column when generating the drawing from the spreadsheet.

RSLogix 500 import change module

Access:

Click the arrow on the Insert PLC (Parametric) tool to access the RSLogix 500 Export to Spreadsheet tool. Select an .EAS or .CSV file and click Open. Select one of the module assignments and click Change.
Access:

From the Components menu, select Insert PLC Modules ➤ RSLogix 500 Export to Spreadsheet. Select an .EAS or .CSV file and click Open. Select one of the module assignments and click Change.

The text “Change Module x” displays underneath the dialog box title bar to keep track of which module you are changing.

- **Select below for module part number assignment**
  - Displays the I/O modules already picked for each set of I/O points. Change the selected module part number by entering the new module name in the edit box, selecting it from the PLC dialog box using Browse, or selecting it from the already used list once you have some modules selected. Select OK to assign the module and return to the RSLogix 500 Import dialog box.

- **Omit**
  - Skips a set of points.

- **Future**
  - Skips the points and adds information so AutoCAD Electrical will add a blank column when generating the drawing from the spreadsheet.

Create PLC drawings from Unity Pro

AutoCAD Electrical imports Unity Pro XML files to aid in the creation of various types of PLC and Panel Layout drawings in the active project. Unity Pro supports numerous Schneider Electrical PLC cards, PLC racks, power supplies, and various accessories.

Unity Pro exports two XML files (.xhw and .xsy) that can be used in the automatic creation of AutoCAD Electrical PLC ladder-style drawings. The .xhw file contains the PLC hardware information such as catalog numbers and starting addressing information. The .xsy file contains the information about the software such as variable types (input/output) and I/O addressing information.

These files also contain catalog information that can be reformatted to generate an equipment list to help in the creation of a rack layout drawing used in
Panel Layouts or separate Rack Layout drawings using the Unity Pro Export to Spreadsheet tool.

**Data structure from the Unity Pro Hardware Configuration File**

The tree structure data that displays in the Hardware File section of the Unity Pro Import dialog box is as follows:

- **Project node**
  - The Project node is the topmost node defined in the tree structure.
  - The label given to the node is the file name of the hardware configuration (.xhw) file that was defined during the export from Unity Pro.
  - The name of the hardware configuration file can be different than that of the I/O configuration file.

- **Bus Name node**
  - The Bus Name node consists of the Bus Name Description and the Bus Number ID.
  - *Example: Bus 1 Local Quantum Bus*
    - Bus Name Description: displays the name of the bus and is specified in the busType element in the .xhw file. (i.e. Local Quantum Bus)
    - Bus Number ID: displays the number of the bus and is specified in the position element of the .xhw file. (i.e. Bus 1)

- **Rack Location and Catalog Number node**
  - The Rack Location node consists of descriptions, location information and a catalog number.
  - *Example: Rack \1.1\1 140XBP0600*
    - Rack Description: displays the description of the rack and is specified in the family element of the .xhw file. (i.e. Rack)
    - Rack Location: displays the location of the rack and is specified in the topoAddress element of the .xhw file. (i.e. \1.1\1)
    - Rack Catalog Number: displays the catalog number of the rack and is specified in the partNumber element of the .xhw file. (i.e. 140XBP0600)

- **Module Location and Catalog Number node**
  - The Module Location node consists of descriptions, location information and a catalog number.
  - *Example: Supply \1.1\1.1 140CPS21400*
    - Module Description: displays the description of the module and is specified in the family element of the .xhw file. (i.e. Supply)
- Module Location: displays the location of the module in the rack and is specified in the topoAddress of the .xhw file. (i.e. 1.1\1.1)
- Module Catalog Number: displays the catalog number of the module and is specified in the partNumber element of the .xhw file. (i.e. 140CPS21400)

**Unity Pro to AutoCAD Electrical Mapping File**

The Unity Pro to AutoCAD Electrical mapping file, DEFAULTUNITY.MAP, allows you to define the text strings to be placed in the custom field of the Unity Pro Data Editor to map directly to an AutoCAD Electrical schematic symbol name.

**AutoCAD Electrical Symbol Mapping File Example:**

```
;This file is to be used for mapping of Unity Pro custom strings
;for PLC I/O devices to AutoCAD Electrical schematic symbol names
;Syntax: Value in Custom Field, Symbol Block File Name
;Example: PBNO,HPB11
; PBNC,HPB12
PB NC,HPB12
*2POS*,HSS112
*3POS*,HSS113
```

The comment fields (marked with ;) at the top of the file are used for information. The custom field supports spaces in the string and wild cards.

**NOTE** The distance the remote component is located from the PLC and hot bus rail is determined by the PLC settings file.

**Equipment List Structure and Data**

When you click OK on the Unity Pro Import dialog box, a PLC Spreadsheet file is created along with an Equipment List spreadsheet file. The Equipment List file includes all of the catalog information in the .xhw file. The structure of the Equipment List is:

- Column 1 = CATALOG; partNumber variable from the .xhw file
- Column 2 = MANUFACTURER; found in Default_cat.mdb (PLCIO table)
Import Unity Pro files to a spreadsheet

1. In Unity Pro, right-click the configuration file in the project browser and select Export.
2. Enter a file name for the .xhw file and click Export.
3. Right-click the Variables & FB Instances file in the project browser and select Export.
4. Enter a file name for the .xsy file and click Export.

**NOTE** We recommend that you export the files into the same location as the AutoCAD project (.wdp) file.

If the export was successful, the Unity Pro command window states that the file was exported with 0 errors or warnings.
5 In AutoCAD Electrical, click the arrow on the Insert PLC (Parametric) tool to access the Unity Pro Export to Spreadsheet tool.

6 Click the Unity Pro Export to Spreadsheet tool.

7 Select the Unity Pro hardware configuration file (.xhw) and click Open.

8 Select the Unity Pro I/O configuration file (.xsy) and click Open.

Upon successful validation of the files selected for import, the Unity Pro Import dialog box displays.

9 In the Unity Pro Import dialog box, modify the selected files to create a spreadsheet for PLC import. You can right-click on a module or rack in the tree structure and select to include or exclude it from being saved into the spreadsheet file. Do any of the following optional steps:
   ■ Indicate whether to display only modules in the .xhw file that contain I/O addressing (PLCs).
   ■ Indicate whether to include inner or outer terminals. You then need to select whether to place the terminal symbol names in every row or only those that have a defined I/O point.
   ■ In the Hardware File section, select the module to modify. The data relative to the I/O variable file for the selected module displays in the I/O Variable File section of the dialog box. If you select a module that does not have addresses (such as power supplies or CPUs) the grid remains empty.
   ■ Change the symbol name or device tag for any of the I/O points using the right-click menu options. The Select Symbol option displays the icon menu from which you can select the symbol name.
   ■ Specify the symbol name to be inserted for inner and outer terminals in the spreadsheet. The default symbol name is HT0001 (a terminal that maintains the wire number potential, has a tag strip ID and terminal number, and is square). Click the Select from Icon Menu button to select a terminal to use from the icon menu.

10 Click OK.
11 Specify a file name and location for the PLC spreadsheet file and click Save.

12 Specify a file name and location for the Equipment List file and click Save.

13 Select Components ➤ Insert PLC Modules ➤ Spreadsheet to PLC I/O Utility to create the PLC drawing. (page 257)

**Unity Pro import**

This tool imports Unity Pro hardware (.xsy) and I/O variable (.xsy) files into AutoCAD Electrical to reformat the data into a PLC import spreadsheet. After the spreadsheet file is created use the Spreadsheet to PLC I/O Utility tool to automatically create PLC style drawing files.

When you click OK, you are prompted to enter a name for the PLC spreadsheet file. You can save this file in .xls (preferred), .mdb or .csv format. Once you enter a name (or accept the default) and click Save, you are then prompted to create an equipment list spreadsheet file. You can save this file in .xls, .mdb (preferred) or .csv format. The suggested file name is the name of the hardware import file with the suffix '(Equipment).'

**Access:**

Click the arrow on the Insert PLC (Parametric) tool to access the Unity Pro Export to Spreadsheet tool. Select to open a Unity Pro hardware configuration (.xhw) file and a Unity Pro I/O configuration file (.xsy).

From the Components menu, select Insert PLC Modules ➤ Unity Pro Export to Spreadsheet. Select to open a Unity Pro hardware configuration (.xhw) file and a Unity Pro I/O configuration file (.xsy).

**Hardware File**

The path and file name of the hardware file created from Unity Pro (.xhw) displays at the top of this section of the dialog box.

**Hardware file information**

Allows you to view and select the hardware configuration from the Unity Pro export files. The tree structure has 4 nodes:

- Unity Project (export file name)
- Bus name
- Rack location and catalog number
- Module location and catalog number

Right-click on a node to include or exclude modules from being saved into the spreadsheet file. Upon exclusion the module icon changes to indicate that it has been excluded. You can exclude or include an entire rack node. Multiple node selection is allowed.

**Changed icons:**

![No excluded icon](Image1)

**NOTE** If you choose to include modules that do not contain any I/O addressing, the module catalog number appears in the Code column of the spreadsheet.

---

**Show only I/O modules**

Indicates to display only modules in the .xhw file that contain I/O addressing (PLCs). If a rack node only includes modules that are not PLC I/O modules, the entire rack is removed from the tree structure. If a rack node contains modules with and without I/O addressing, those that don’t have I/O addresses are removed.

**Include inner terminals**

Defines a terminal symbol to be placed into the spreadsheet on the inner side of the in-line component (between the I/O point and the in-line component).

- All I/O addresses: Places the terminal symbol name into the row of every I/O address listed in the import spreadsheet.

- I/O addresses defined: Places the terminal symbol name into every row where an I/O point is defined from Unity Pro. The defined address from Unity Pro is the topographical address coming from the I/O variable file that contains a value for the address string.
Include outer terminals

Defines a terminal symbol to be placed into the spreadsheet on the outer side of the in-line component (between the I/O component and the wire connected to the ladder rail).

- All I/O addresses: Places the terminal symbol name into the row of every I/O address listed in the import spreadsheet.
- I/O addresses defined: Places the terminal symbol name into every row where an I/O point is defined from Unity Pro. The defined address from Unity Pro is the topographical address coming from the I/O variable file that contains a value for the address string.

I/O Variable File

Once you select a module node from the tree selection the data relative to the I/O variable file displays for viewing and editing. The path and file name of the I/O variable file created from Unity Pro (.xsy) displays at the top of this section of the dialog box.

I/O variable file grid

Displays a list of the I/O variables found inside of the Unity Pro I/O Variable export file (.xsy). This remains empty if the selected module does not have addresses (such as power supplies and CPUs). All I/O points for the respective PLC card display in the grid (including those that are undefined). The total number of I/O points and the order of the data is determined from the topological address in the .xsy file in combination with the PLC definition inside of the AutoCAD Electrical PLC database file (ACE_PLC.MDB).

**NOTE** Single and multiple row selection is allowed.

- Address: Displays the address string from the Unity Pro I/O Variable export file. This field is not editable in the dialog box.
- Description: Displays the comment field string associated to the address from the Unity Pro I/O
Variable export file. This field is not editable in the dialog box.

- Terminal: Defines the placement of a terminal symbol in line with the PLC I/O point. Select the check box to place a terminal symbol in the spreadsheet and drawing file. Since this is not defined in the Unity Pro export files, it must be defined prior to creating the AutoCAD Electrical import spreadsheet.

- Symbol Name: Displays the AutoCAD Electrical schematic symbol file name to be placed in line with the PLC I/O points. If the symbol is not found in the schematic symbol library or the custom string is not mapped to a symbol name in the mapping file, the name displays in red. Right-click in this column to select a file name from the icon menu or to clear the symbol name. The symbol name is derived from the value in the Custom field of the Unity Pro data and the symbol file name that it is mapped to in the mapping file.

- Device Tag: Displays the tag value. If left blank, the normal tagging method for parent components is followed while children components remain untagged. Click in the column to enter a value or right-click to copy, cut or paste a value into the cell.

### Inner terminal symbol
Specifies the symbol name to be inserted for inner terminals in the spreadsheet. The default symbol name is HT0001 (a terminal that maintains the wire number potential, has a tag strip ID and terminal number, and is square). Click the Select from Icon Menu button to select a terminal to use from the icon menu.

### Outer terminal symbol
Specifies the symbol name to be inserted for outer terminals in the spreadsheet. The default symbol name is HT0001. Click the Select from Icon Menu button to select a terminal to use from the icon menu.
button to select a terminal to use from the icon menu.

**I/O variable grid right-click options**

Right-clicking in the I/O variable grid control allows you to edit the file prior to creating the PLC I/O spreadsheet. Multiple selection is allowed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Symbol</td>
<td>Displays the icon menu for selection of symbol file names. Selecting a symbol file name fills in an empty grid cell or overwrites the existing text in a cell.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects every row in the grid control</td>
</tr>
<tr>
<td>Clear All</td>
<td>Removes every row from selection.</td>
</tr>
<tr>
<td>Select All Defined I/O</td>
<td>Makes a selection in the grid for the rows that are defined with I/O addresses.</td>
</tr>
<tr>
<td>Cut</td>
<td>(single selection only) Cuts the selected value (description, symbol name or device tag).</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the selected value from one or more grid cells.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes in the selected value from one or more grids into the selected grid(s).</td>
</tr>
<tr>
<td>Apply Terminal Inner</td>
<td>Selects all inner terminals in the grid.</td>
</tr>
<tr>
<td>Apply Terminal Outer</td>
<td>Selects all outer terminals in the grid.</td>
</tr>
</tbody>
</table>

**OK + Run**

Displays the Write Unity Pro Data to PLC Spreadsheet dialog box where you can quickly save the data to a spreadsheet and start the PLC drawing creation automatically. The Spreadsheet to PLC I/O Utility dialog box then opens with the saved spreadsheet already selected.
Create XML files for export to Unity Pro

The Unity Pro Export command creates the Unity Pro I/O variable file (.xsy) in the Unity Pro XML format. You can create the file for the active project or active drawing. AutoCAD Electrical suggests naming the XML data file based on whether you select to export for the project or a drawing. The default file name is either “Projectname.xml” or “Drawing filename.xml.”

The Unity Pro export file is generated from the PLC drawings and their respective PLC symbols. To ensure the proper importing and editing of the I/O variable file in Unity Pro, the variable name and variable type are maintained inside of the PLC drawings. Variable names and types are defined inside of Unity Pro and are the required for bidirectional updates.

NOTE These values are maintained on the PLC module. If you delete the module from the drawing, the variable name and type are also removed.

Variable names and types are created for new I/O addresses for import back into Unity Pro. During the AutoCAD Electrical import process, the rest of the addressing is filled in based on the available I/O points on the module. These additional I/O points receive a variable name and type upon import into AutoCAD Electrical.

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Takes on the address string as the value.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable Type</td>
<td>Takes on the same type as the other defined I/O addresses on the module. If I/O points are not defined on the module then Boolean characters are used.</td>
</tr>
</tbody>
</table>

Export a file in the Unity Pro XML format

The AutoCAD Electrical Unity Pro export file is generated from the PLC drawings and their respective PLC symbols. The variable names and types are
maintained on the PLC module so that the file can be imported back into Unity Pro.

1. In AutoCAD Electrical, click the arrow on the Schematic Reports tool to access the Unity Pro Export tool.

2. Click the Unity Pro Export tool.

3. In the Unity Pro Export dialog box, select to create an export file (.xsy) for the project or the active drawing and click OK.

4. If you selected Project, select the drawings to process and click OK.

5. In the Write PLC Data to Unity Pro Import File dialog box, specify the file name and click Save.
   By default the file is saved in the My Documents folder. AutoCAD Electrical suggests a file name for the XML export file depending on whether you are creating the file for the project or the active drawing.

**Unity Pro export**

This tool creates the Unity Pro I/O variable file (.xsy) in the Unity Pro XML format. The XML file contains the PLC I/O addresses and descriptions for import into the Unity Pro software.

**Access:**

- Click the arrow on the Schematic Reports tool to access the Unity Pro Export tool.
- From the Projects menu, select Reports ➤ Unity Pro Export.

Select whether to create an XML export file for the project or for the active drawing.
Component Tools

In this chapter

- Insert schematic components
- Insert a copy of a component
- Insert similar components
- Insert from catalog lists
- Use the schematic lookup file
- Insert from panel lists
- Manipulate Components
- Swap contact states
- Check coil/contact count
- Follow signals
- Insert dashed link lines
- Overview of DIN Rails
- Edit schematic lookup files
- Overview of user data records
- Component Cross-References
- Circuits
- Wire Jumpers
Insert schematic components

Use the Insert Component tool to insert a component into the drawing.

1. Click the Insert Component tool.
2. In the Insert Component dialog box, select the starting orientation for the component: horizontal or vertical.
3. (Optional) If you want to turn off the Insert/Edit Component dialog box when inserting symbols onto the drawing select No Edit dialog.
4. (Optional) If you want to insert the component, untagged (for example, without assigning a unique Component Tag) select No Tag. The untagged value that displays is the component's TAG1/TAG2 default value.
5. Select the component to insert (such as Push Buttons ➤ Push Button N.O.) Select an icon picture or the component type from the left-hand list.
   The menu's right-hand column is the Dyna-stack. It displays the last six components inserted during the current editing session. Click Previous to display the last submenu from which a component was inserted or Used to display a list of recently inserted components.
6. Specify the insertion point in the drawing.
   The orientation of the symbol tries to match the underlying wire. The wire breaks automatically if the symbol lands on it.
7. On the Insert/Edit Component dialog box, annotate the component.
8. Click OK.

Insert component

This icon menu can be modified, expanded, or replaced with your own custom menu. You can change the default icon menu using the Library and Icon Menu Paths section of the Project Properties ➤ Project Settings dialog box.
Select Projects ➤ Project ➤ Project Manager. Right-click the project name
and select Properties. Use the Icon Menu Wizard to easily modify the menu. The default icon menu can also be redefined in "wd.env." Add entry "WD_MENU" for schematic icon menu and "WD_PMENU" for panel layout icon menu.

Access:

Click the Insert Component tool or the Multiple Insert Component tool.

Click Components ➤ Insert Component or Components ➤ Multiple Insert ➤ Multiple Insert (Icon Menu).

NOTE This dialog box is also accessed when inserting Pneumatic, Hydraulic, or P&ID components; in-line wire labels; stand-alone cross-reference symbols; cable markers; and saved circuits.

Select an icon picture or the component type from the Menu tree structure. The main menu in the tree structure is displayed as the menu heading just above the menu tree structure.

Tabs

- Menu: Changes the visibility of the Menu tree view.
- Up one level: Displays the menu that is one level before the current menu in the Menu tree view. This is unavailable if the main menu is selected in the Menu tree view.
- Views: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.

Menu

The tree structure is created by reading the icon menu file (*.dat). The tree structure is based on the arrangement order of submenus defined in the .dat file.

Symbol Preview window

Displays the symbol and submenu icons corresponding to the menu or the submenu selected in the Menu tree structure.
Clicking on the icon performs one of the following functions based on the icon properties as defined by the *.dat file:

- Inserts the symbol or circuit onto the drawing
- Executes a command
- Displays a submenu

**NOTE** When you move the cursor over an icon, the icon name and block/circuit/command name display as tooltip information.

### Recently Used
Displays the last components inserted during the current editing session; the most recently used icon displays in the top. This list follows the view options setting in the symbol preview window (icon only, icon with text or list view) and the total number of icons displayed depends on the value specified in the Display edit box.

### Display
Specifies the number of icons to display in the Recently Used list box. Enter integer numbers only; the default value is 10.

### Vertical/Horizontal
Inserts the icon using a vertical or horizontal orientation. This is opposite the drawing’s default ladder rung orientation.

### No edit dialog
Turns off the Insert/Edit Component dialog box when inserting symbols onto the drawing. To add component detail later, click the Edit Component tool, and select the component to edit.

### No tag
Inserts the component, un-tagged (i.e. without assigning a unique Component Tag). The untagged value that displays is the component’s TAG1/TAG2 default value. To add component detail later, click the Edit Component tool, and select the component to edit.

### Always display previously used menu
Indicates to display the previously used menu each time you open the Insert Component dialog box. For example, if you insert a push button from the Push Buttons menu, the next time you open the Insert Component dialog box the Push Button menu displays by default.
### Scale schematic
Specifies the component block insertion scale. This defaults to the value set in the Drawing Properties ➤ Drawing Format dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.

### Scale panel
Specifies the footprint insertion scale. This defaults to the value set in the Drawing Properties ➤ Drawing Format dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.

### Type it
Manually type in the component block to insert.

### Browse
Browses to and selects the component to insert.

---

**Right-click menus**

**Options for the Menu tree structure view**
Right-click on the main menu or submenu in the Menu tree structure view to display the following options:

- **Expand/Collapse**: Toggles the visibility of the menus.
- **Properties**: Opens a Properties dialog box to view the existing menu or submenu properties like the menu name, image or submenu title. Use the Icon Menu Wizard to change any menu properties.

**Options for the Symbol Preview window**
Right-click an icon or in empty space in the Symbol Preview window to display the following options:

- **View**: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.
- **Properties**: (available for icons only) Opens a Properties dialog box to view the existing symbol icon properties like the icon name, image, block names and so on. Use the Icon Menu Wizard to change any icon properties.
Pneumatic, Hydraulic and P&ID icon menus

The Menu tree structure displays the symbols for the selected component type (pneumatic, hydraulic or P&ID). The Insert Pneumatic Component, Insert Hydraulic Component and Insert P&ID Component tools are accessed on the Extra Library toolbar.

![Insert Pneumatic Component](image)

Insert Pneumatic Component

![Insert Hydraulic Component](image)

Insert Hydraulic Component

![Insert P&ID Component](image)

Insert P&ID Component

Insert/edit component

**NOTE** While inserting a component for the first time, you establish its tag definition inside the project. To edit this newly defined component that could potentially reference other components found on different drawing files in the project, the relationship must be established prior to editing. The steps to link the new component with related components are: 1) Insert a new component and change the component tag as needed; 2) Click OK and insert the component on the drawing; 3) Right-click the component and select Edit Component; 4) Change the description, catalog data and so on as needed; 5) Click OK. In the Update Related Components dialog box, click Yes-Update to update the related components with your changes or click Skip to just update the component you edited.

Access:

Click the Insert Component tool. Select the component type to insert and specify the insertion point on the drawing.

Click Components ➤ Insert Component. Select the component type to insert and specify the insertion point on the drawing.
Access:
Click the Edit Component tool and select the component to edit.
Click Components ➤ Edit Component and select the component to edit.

You can go back to any component at any time and make changes.

**NOTE** Some options may not be available depending on whether you are inserting a single component or multiple components. To insert multiple components, click Components ➤ Multiple Insert ➤ Multiple Insert (Icon Menu).

**Component Tag**

Any existing tags appear in the edit box. To define the component tag, edit the existing tag or type a specific tag in the edit box. Select Fixed if you don’t want this tag to be updated on a retag.

If you enter an existing component tag during the insert/edit process, a warning dialog box displays. (Turn off the warning in the Project Properties ➤ Project Settings dialog box. This temporarily disables the warning dialog box for the current session of AutoCAD Electrical). It alerts you of the duplication and suggests alternative tag names based on the user-defined format. You can select whether to use the duplicated tag or use a new tag that is suggested (or you can type in a new tag).

**NOTE** An error log file is created for every project regardless of whether you chose to display the real-time warning dialog or not. The real-time warning is saved in the log file named "<project_name>_error.log" and is saved in the User subdirectory.

**Use PLC Address**
Searches for a wire connection to a nearby PLC I/O address and, if found, uses the PLC address number in the component's tag name.

**Tags Used**
Lists any component (panel or schematic) tag names in the same family as the current component. Select a tag from the list to copy, or to increment for this new component.
Assigns a tag from an external list file. You can reference an ASCII text file in comma or space delimited format to help annotate the component's description, tag, catalog, and other information.

Substitutes a fixed text string for the %F part of the tag format. Enter a tag format override in the edit box. Retag Component uses this override format value to calculate a new tag for the selected component.

**Catalog Data**

You can do a drawing-wide or project-wide listing of similar components with their catalog assignments. During your editing session, the last MFG / CAT / ASSYCODE assignment for each component type you insert into your wiring diagram is remembered. When you insert another component of that type, the previous component's catalog assignment is set as the default (assuming a previous one was made during the current editing session).

Lists the manufacturer number for the component. Enter a value or select one from the Catalog lookup.

Lists the catalog number for the component. Enter a value or select one from the Catalog lookup.

Lists the assembly code for the component. The Assembly code is used to link multiple part numbers together.

Specifies a unique identifier assigned to each component. The tag value can be manually typed in the edit box.

Specifies the quantity number for the part number (blank=1). This value gets inserted into a BOM report's "SUBQTY" column.

Opens the component's catalog database from which you can manually enter or select the Manufacturer or Catalog values. Search the database for a specific catalog item to assign to the selected component. Database queries are set up in the 3 lists across the top of the dialog with the database hits listed in the dialog's main window.
**Previous**
Scans the previous project to find an instance of the selected component and returns the component values. You can then make your catalog assignment by picking from the dialog list.

**Drawing**
Lists the part numbers used for similar components in the current drawing.

**Project**
Lists the part numbers used for similar components in the project. You can search in the active project, another project, or an external file.
- **Active project**: All the drawings in the current project are scanned and the results are listed in a dialog box. Select from the list to assign your new component with a catalog number that is consistent with other similar components in the project.
- **Other project**: Scans each listed drawing in a previous project for the target component type and returns the catalog information in a subdialog box. Make your catalog assignment by picking from the dialog list.
- **External file**: You can pull catalog assignments from a generic ASCII file created by a word processor or output from a spreadsheet or database program. A dialog box displays the contents of the selected text file. Find and highlight the appropriate entry. AutoCAD Electrical reads the line of text from the file and breaks it into its component parts. These are displayed in the left-hand dialog list. For each relevant item, highlight it, and then pick the appropriate category button in the center column. The highlighted item is transferred to the corresponding category (and then to the Insert/Edit dialog box once OK is clicked).

**Multiple Catalog**
Inserts or edits extra catalog part numbers on to the selected component. You can add up to 99 part numbers to any component. These multiple BOM part numbers appear as sub-assembly part numbers to the main catalog part number in the various BOM and component reports.

**Catalog Check**
Displays what the selected item will look like in a Bill of Material template.
Ratings

Specifies values for each ratings attribute. You can enter up to 12 ratings attributes on a component. Select Defaults to display a list of default values.

NOTE If Ratings is grayed out, the component you are editing does not carry rating attributes.

Description

Up to 3 lines of description attribute text can be entered.

**Drawing**

Displays a list of descriptions found in the current drawing so you can pick similar descriptions to edit.

**Project**

Displays a list of descriptions found in the project so you can pick similar descriptions to edit.

**Defaults**

Opens an ASCII text file from which you can select standard descriptions.

**Pick**

Picks a description from a component on the current drawing.

If a symbol does not have the DESC1-3 attributes, the description edit boxes are dimmed. If you want to put descriptions on fuse symbols (or other symbols without these attributes), open the fuse library symbols in AutoCAD Electrical and add the DESC1, DESC2, and DESC3 attribute definitions. Fuse symbol file names are HFU*.dwg and VFU*.dwg.

Cross-Reference

**Component override**

Overrides the drawing’s WD_M block settings with component-specific cross-reference settings. Click Setup to manually edit the component cross-reference settings.

**Reference NO/ Reference NC**

A pin list database table is consulted when a part number is added or an existing part number is changed on a parent symbol. If a match on the part number’s Manufacturer, Catalog, and Assembly values in the database table is found,
the associated contact count and pin number information is retrieved and placed on the parent component. Click NO/NC Setup to view or manually edit pin list data values.

**Installation Code**

Changes the installation codes. You can search the current drawing or entire project for installation codes. A quick read of all the current or selected drawing files is done and a list of installation codes used so far is returned. Select from the list to automatically update the component with the installation code.

Assign short installation codes to components like "PNL" and "FIELD" so you can create location-specific BOM and component lists later.

**Location Code**

Changes the location code(s). You can search the current drawing or entire project for location codes. A quick read of all the current or selected drawing file is done and a list of location codes used so far is returned. Select from the list to automatically update the component with the location code.

Assign short location codes to components like "PNL" and "FIELD" so you can extract cable from/to reports and location-specific BOM reports later. (For example, BOM for all field cables, BOM for all PNL cables.)

**Show/Edit Miscellaneous**

View or edit any attributes that are not predefined AutoCAD Electrical attributes.

**Pins**

Assigns pin numbers to the pins that are physically located on the component. For Connectors: Once a connector is inserted onto the drawing file's block definition, you can edit the connector pins found inside of the connector. Click List to display the Connector Pin Numbers in Use dialog box where you can edit the pin numbers and descriptions.

**Switch Positions**

Labels the positions of a selector switch.
OK-Repeat

(not available when editing components) Inserts the new component onto the drawing and then inserts another 'just like' component.

Insert/edit component: IEC

This Insert/Edit Component dialog box is for working in IEC mode. If you are working in JIC mode, the dialog box displays differently.

**NOTE** While inserting a component for the first time you establish its tag definition inside of the project. To edit this newly defined component that could potentially reference other components found on different drawing files in the project, the relationship must be established prior to editing. The steps to link the new component with related components are: 1) Insert a new component and change the component tag as desired; 2) Click OK and insert the component on the drawing; 3) Right-click the component and select Edit Component; 4) Change the description, catalog data and so on as needed; 5) Click OK. In the Update Related Components dialog box, click Yes-Update to update the related components with your changes or click Skip to just update the component you edited.

**Access:**

Click the Insert Component tool. Select the component type to insert and specify the insertion point on the drawing.

Click Components ➤ Insert Component. Select the component type to insert and specify the insertion point on the drawing.

Click the Edit Component tool and select the component to edit.

Click Components ➤ Edit Component and select the component to edit.

You can go back to any component at any time and make changes.

**NOTE** Some options may not be available depending on whether you are inserting a single component or multiple components. To insert multiple components, select Components ➤ Multiple Insert ➤ Multiple Insert (Icon Menu).

**Installation**

Changes the installation codes. You can search the current drawing or entire project for installation codes. A quick read of all the current or selected drawing
file is done and a list of installation codes used so far is returned. Select from
the list to automatically update the component with the installation code.

Assign short installation codes to components like "PNL" and "FIELD" so you
can create location-specific BOM and component lists later.

**Location**

Changes the location codes. You can search the current drawing or entire
project for location codes. A quick read of all the current or selected drawing
files is done and a list of location codes used so far is returned. Select from
the list to automatically update the component with the location code.

Assign short location codes to components like "PNL" and "FIELD" so you can
extract cable from/to reports and location-specific BOM reports later. (For
every example, BOM for all field cables, BOM for all PNL cables.)

**Component Tag**

Any existing tags appear in the edit box. To define the component tag, edit
the existing tag or type a specific tag in the edit box. Select Fixed if you don’t
want this tag to be updated on a retag.

If you enter an existing component tag during the insert/edit process, a
warning dialog box displays. This alerts you of the duplication and suggests
alternative tag names based on the user-defined format. You can select whether
to use the duplicated tag or use a new tag that is suggested (or you can type
in a new tag).

**NOTE** The combined value of the component tag, installation code and installation
code is used for error checking in IEC mode.

<table>
<thead>
<tr>
<th>Use PLC Address</th>
<th>Searches for a wire connection to a nearby PLC I/O address and, if found, uses the PLC address number in the component's tag name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tags Used</td>
<td>Lists any component (panel or schematic) tag names in the same family as the current component. Select a tag from the list to copy, or to increment for this new component.</td>
</tr>
<tr>
<td>External List</td>
<td>Assigns a tag from an external list file.</td>
</tr>
</tbody>
</table>

Insert schematic components | 295
Options

Substitutes a fixed text string for the %F part of the tag format. Enter a tag format override in the edit box. Retag Component uses this override format value to calculate a new tag for the selected component.

Description

Up to 3 lines of description attribute text can be entered.

Drawing

Displays a list of descriptions found in the current drawing so you can pick similar descriptions to edit.

Project

Displays a list of descriptions found in the project so you can pick similar descriptions to edit.

Defaults

Opens an ASCII text file from which you can quickly pick standard descriptions.

Pick

Picks a description from a component on the current drawing.

Catalog Data

You can do a drawing-wide or project-wide listing of similar components with their catalog assignments. During your editing session, the last MFG / CAT / ASSYCODE assignment for each component type you insert into your wiring diagram is remembered. When you insert another component of that type, the previous component's catalog assignment is set as the default (assuming a previous one was made during the current editing session).

Manufacturer

Lists the manufacturer number for the component. Enter a value or select one from the Catalog lookup.

Catalog

Lists the catalog number for the component. Enter a value or select one from the Catalog lookup.

Assembly

Lists the assembly code for the component. The Assembly code is used to link multiple part numbers together.
Item
Specifies a unique identifier assigned to each component. The tag value can be manually typed in the edit box.

Count
Specifies the quantity number for the part number (blank=1). This value gets inserted into a BOM report’s "SUBQTY" column.

Lookup
Opens the component’s catalog database from which you can manually enter or select the Manufacturer or Catalog values. Search the database for a specific catalog item to assign to the selected component. Database queries are set up in the 3 lists across the top of the dialog box with the database hits listed in the dialog box’s main window.

Previous
Scans the previous project to find an instance of the selected component and returns the component values.

Drawing
Lists the part numbers used for similar components in the current drawing.

Project
Lists the part numbers used for similar components in the project.

Multiple Catalog
Inserts or edits extra catalog part numbers on to the selected component. You can add up to 10 part numbers to any component. These multiple BOM part numbers appear as subassembly part numbers to the main catalog part number in the various BOM and component reports.

Catalog Check
Displays what the selected item will look like in a Bill of Material template.

Cross-Reference

Component override
Overrides the drawing’s WD_M block settings with component-specific cross-reference settings. Click Setup to manually edit the component cross-reference settings.
A pin list database table is consulted when a part number is added or an existing part number is changed on a parent symbol. If a match on the part number's Manufacturer, Catalog, and Assembly values in the database table is found, the associated contact count and pin number information is retrieved and placed on the parent component. Click NO/NC Setup to view or manually edit pin list data values.

Ratings

Specifies values for each ratings attribute. You can enter up to 12 ratings attributes on a component. Select Defaults to display a list of default values.

**NOTE** If Ratings is unavailable, the component you are editing does not carry rating attributes.

Show/Edit Miscellaneous

View or edit any attributes that are not predefined AutoCAD Electrical attributes.

Pins

Assigns pin numbers to the pins that are physically located on the component.

**For Connectors:** Once a connector is inserted onto the drawing file's block definition, you can edit the connector pins found inside of the connector.

- **Pins**
  
  Displays pairs of pins in the first column, the plug pin values in the second column, and the receptacle pin values in the last column.

- **Edit**
  
  Enter a new pin number value in the edit boxes or click the arrows to either increase or decrease both plug and receptacle values by one.

- **List**
  
  Lists all of the pins previously used in the project and the next available pin assignment that can be used.

**Multiple bill of material information**

This tool allows you to insert or edit extra catalog part numbers on to the currently selected component or footprint. You can add up to 99 additional
part numbers to any schematic or panel component on-the-fly. These multiple BOM part numbers appear as sub-assembly part numbers to the main catalog part number in the various BOM and component reports.

Access:

On the Insert/Edit Component or Panel Layout - Component Insert/Edit dialog box, Catalog Data section, click Multiple Catalog.

**NOTE** You can also access this dialog by clicking Multiple Catalog on the Copy Catalog Assignment dialog box (Components ➤ Component Miscellaneous ➤ Copy Catalog Assignment)

The additional catalog part numbers are saved on the symbol as MFGn/CATn/ASSYCODEn attribute values where "n" is the sequential code value "01" through "10" selected in the top list box. If these attributes are not present on the symbols, AutoCAD Electrical saves the information as Extended Entity Data (Xdata) on the symbol's block insert.

**Sequential code**

Adds up to 99 extra part numbers (in addition to the main catalog part number). Pick which one you want to add or inspect/edit. Click the list button to show all extra part numbers carried on the component.

**Catalog Data**

Specifies the catalog part number information such as the manufacturer and catalog number.

**Count**

Specifies the quantity number for the extra part number (blank=1). This value gets inserted into a BOM report’s "SUBQTY" column.

**Unit**

Specifies the unit of measure, which can be displayed in the component list report.
**Parts Catalog Lookup**

Lists the catalog database table that is to be referenced for the description information for the given Manufacturer/Catalog/Assembly combination. For each catalog entry you must provide a name for the catalog look-up table. For the main catalog entry this information is provided on the symbol itself but may not be there for these catalog entries. Select List to pick from a list of tables that are contained in your catalog database file or Misc to use the MISC_CAT table.

**Catalog Lookup**

Checks for and displays catalog table information in the Parts Catalog dialog box for the selected component type.

**Catalog Check**

Quickly performs a Bill of Material check and displays the result.

**Multiple catalog part number assignments**

This displays the order in which the extra part numbers will appear in the various AutoCAD Electrical reports. You can add up to 99 additional part number assignments to a component.

**Access:**

On the Insert/Edit Component or Panel Layout - Component Insert/Edit dialog box, Catalog Data section, click Multiple Catalog. Click List Sequential Code on the Multiple Bill of Material Information dialog box.

**NOTE** You can also access this dialog by clicking Multiple Catalog on the Copy Catalog Assignment dialog box (Components ➤ Component Miscellaneous ➤ Copy Catalog Assignment) and then clicking List Sequential Code.

To change the order, highlight the part number and click Move Up or Move Down to move it in the list.

**Tags in use**
Displays a listing of all component tags found on the schematic for the project.

Access:

Click the Insert Component tool. Select the component type to insert and specify the insertion point on the drawing. In the Insert/Edit Component dialog box, click Tags Used: Schematic.

From the Components menu, select Insert Component. Select the component type to insert and specify the insertion point on the drawing. In the Insert/Edit Component dialog box, click Tags Used: Schematic.

Sort

Sorts the list by component tag, drawing sequence, or description.

Show parent/stand-alone references

Shows all parent components for related family codes in the project. (Default)

Show child references

Shows the children along with the parent for related family codes in the project.

Show all components for all families

Shows devices from all families in the project.

Show all panel components

Displays all panel components.

Freshen

Makes changes on the current drawing visible in the tag list and updates the data in the project database.

Copy Tag

Applies the selected line to the edited component.

Calculate Next

Provides the next available tag (sequence or line reference number) for the device type selected in the dialog box.

Panel tag list
Displays a listing of all component tags found on the panel drawings for the project.

**Access:**

Click the Insert Component tool. Select the component type to insert and specify the insertion point on the drawing. In the Insert/Edit Component dialog box, click Tags Used: Panel.

From the Components menu, select Insert Component. Select the component type to insert and specify the insertion point on the drawing. In the Insert/Edit Component dialog box, click Tags Used: Panel.

**Sort**

Sorts the list by component tag, installation code, location code, or sheet number.

**Freshen**

Makes changes on the current drawing visible in the tag list and updates the data in the project database.

**Option: tag format "family" override**

AutoCAD Electrical provides a way to override a component tag but still update the reference number portion on a re-tag.

**Access:**

From the Components menu select, Edit Component and click the Options button in the Component Tag area.

You can substitute a fixed text string for the %F part of the tag format for a component. Re-tag can then use the override format value to calculate a new tag for the component. For example, a certain relay component needs to always have an "MC-R" family tag value instead of "CR" so that re-tag, for example, will assign MC-R100 instead of CR100. To achieve this tag override you would enter "MC-R%N" for the tag format.

**Component annotation from external file**

This tool pulls information from a selected line in an external space or comma-delimited text file and assigns its text to a specific attribute/xdata on
the component. The default extension for this file is ".wdx" but can also be ".csv" or ".txt." The file format is free-form.

Access:

Click the Insert Component tool. Select the component type to insert and specify the insertion point on the drawing. In the Insert/Edit Component dialog box, click External List. Select the .wdx, .csv, or .txt file to reference and click Open. Select a line of data from the list and click OK.

From the Components menu, select Insert Component. Select the component type to insert and specify the insertion point on the drawing. In the Insert/Edit Component dialog box, click External List. Select the .wdx, .csv, or .txt file to reference and click Open. Select a line of data from the list and click OK.

Select a value from the list of data elements on the left, then click one of the buttons next to the attribute name to assign the value to.

Overwrite

Overwrites the existing value in the edit box with the selected value.

Add

Adds the selected value to the edit box. The value is appended to any existing value.

Descriptions

Standard Description lists can be created in ASCII text files with a .WDD file extension. You may create project related list, component family lists, a generic list, or any type of description list.

Access:

Click the Edit Component tool and select the component to edit. Click Defaults in the Description section of the Insert/Edit Component dialog box.

From the Components menu, select Edit Component and select the component to edit. Click Defaults in the Description section of the Insert/Edit Component dialog box.

Highlight an entry from the list and click OK, or click Pick File to select a different file and description list.

Descriptions panel

Displays the values for the description file.
**Pick File**  Selects a different file and description list.

**Language**  Displays the Language Database file (WD_LANG1.MDB) for the AutoCAD Electrical Language Conversion tool.

**Project**  Displays a project .wdd file (if not already displayed).

**Family**  Displays a family .wdd file (if not already displayed). For example, if the component has the family code “PB” for pushbuttons and a file called PB.WDD exists, it displays when you click Family.

**General**  Displays a generic file (WD_DESC.WDD) if not already displayed.

**Add/Edit**  Opens a dialog box for adding or editing description text (DESC1, DESC2, and DESC3) for the file. Enter a value or click Edit File to edit the file using WordPad.

**OK-Description 1**  Inserts the selected text into line Description 1. Any existing text in description lines 2 and 3 is left untouched (i.e. inserting dual language descriptions).

**OK-Description 2**  Inserts the selected text into line Description 2. Any existing text in description lines 1 and 3 is left untouched.

**OK-Description 3**  Inserts the selected text into line Description 3. Any existing text in description lines 1 and 2 is left untouched.

**Select description from AutoCAD Electrical language table**

Opens the current language table for review. The default table is wd_lang1.mdb

**Access:**

Click the Edit Component tool and select the component to edit. Click the Defaults button in the Description section of the Insert/Edit Component dialog box, and click Language.

From the Components menu, select Edit Component and select the component to edit. Click the Defaults button in the Description section of the Insert/Edit Component dialog box, and click Language.
NOTE Use the Projects ➤ Language Conversion ➤ Edit Language Database File tool to modify the language table.

Select language
Selects a predefined language.

NOTE Language matches are not case sensitive, but phrase substitutions are made exactly as entered in the language table.

Phrase list in selected language
Displays a phrase list for the selected language.

Pick language/Phrase to use
Specifies which language to use for the selected phrase.

Pick File
Selects a different file and description list.

Project
Displays a project .wdd file (if not already displayed).

Family
Displays a family .wdd file (if not already displayed). For example, if the component has the family code “PB” for pushbuttons and a file called PB.WDD exists, it displays when you click Family.

Generic
Displays a generic file (WD_DESC.WDD) if not already displayed.

Select description text format
Specifies how to handle description text in the selected language.

Access:

Click the Edit Component tool and select the component to edit. In the Insert/Edit Component dialog box, Description section, click Defaults. In the Descriptions dialog box, click Language. Select the phrase and language to edit and click OK.

From the Components menu, select Edit Component and select the component to edit. In the Insert/Edit Component dialog box, Description section, click
Access:

Defaults. In the Descriptions dialog box, click Language. Select the phrase and language to edit and click OK.

1 Line, 2 Lines, 3 Lines

Specifies whether to display the selected description text in one line or across multiple lines. Examples of what the description will look like appear next to the options.

Manual edit/override

Overrides the selected description text. You can use the default text or type modifications in the edit box. The "|" character forces a line break.

OK ➤ Description 1

Inserts selected description text into the component's first description text line, leaving any existing text in lines 2 and 3 as is. However, if you selected 2 Lines above and click OK ➤ Description 1, the description text displays in description lines 1 and 2 in the Insert/Edit Component dialog box.

OK ➤ Description 2

Inserts selected description text into the component's second description text line, leaving any existing text in lines 1 and 3 as is.

OK ➤ Description 2,3

Inserts text starting at the component's second description text line, leaving any existing text in the 1st line as is.

NOTE These are useful for inserting description text in dual languages.

Pin numbers in use

Lists all the pins previously used in the project and the available pins that can be assigned to a component. The component tag displays below the title bar in the dialog box.

Access:

Click the Edit Component tool. Select the component to edit. In the Insert/Edit Component dialog box, Pins section, click List.
Access:

From the Components menu, select Edit Component. Select the component to edit. In the Insert/Edit Component dialog box, Pins section, click List.

Pin List

The three lists display all available pins to be assigned to the component. The number in parenthesis () indicates the single or pair of pins for the component. Pins can be Unused NO Pairs, Unused Form-C contacts, and undefined.

Sheet, Reference

Displays the sheet number and potential reference line number where the connector definition is located in the project.

Type

Displays the contact type (for example, "NO" or "NC"). This is the value carried by the component’s CONTACT attribute. If no attribute is present or this attribute is blank, then this field will be blank.

Pins

Displays the pin numbers already in use in the project.

Wire Numbers

Displays the wire numbers carried on wires attached to each of the pins above. If no wire connection to the pin, or if the wire does not carry a wire number assignment, then this field is blank.
Insert a copy of a component

Use the Copy Component tool to insert a copy an existing component into the drawing.

1 Click the Copy Component tool.
2 Select a component from the drawing just like the new one you want to insert.
3 Select the insertion point.
   This inserts a copy of the symbol you selected and then displays the Insert/Edit Component dialog box, so you can finish annotating the component.
4 Click OK.

Insert similar components

Use the Multiple Insert tool to insert a series of similar components at fence crossing points with underlying wires.

1 Click the Multiple Insert Component tool.
2 Select the component type from the Insert Component: Schematic Symbols dialog box.
3 Select the component from the selection dialog box.
4 Select a point above the first wire that you want to process.
5 Select a point below the final wire for processing, and then right-click to end the command.
6 With each possible insertion point (that is, fence crossing point with a wire) a dialog box displays, prompting you to decide whether to keep the insertion, keep all of the insertions, or skip to the next one.
If you keep the insertion point, the regular Insert/Edit dialog box is displayed, where you finish annotating the component.

7 Click OK to complete the operation.

Insert or edit child component

Access:

Click the Multiple Insert Component tool. Select the component type to insert and select the insertion point on the drawing.

From the Components menu, select Multiple Insert ➤ Multiple Insert (Icon Menu). Select Relay/Contact and select the insertion point on the drawing.

Click the Edit Component tool and select the component to edit.

From the Components menu, select Edit Component and select the component to edit.

You can go back to any component at any time and make changes.

Component Tag

The parent tag value can be manually typed into the edit box or selected from a drawing-wide or project-wide list of similar components. If the parent is visible on the screen, click Parent/Sibling and select the parent (or another related contact). This transfers all information automatically to the child contact being inserted or edited.

Ratings

Specifies values for each ratings attribute. You can enter up to 12 ratings attributes on a component. Select Defaults to display a list of default values.

NOTE If Ratings is grayed out, the component you are editing does not carry rating attributes.

Description

Up to 3 lines of description attribute text can be entered. These lines are automatically filled with a copy of the parent’s description text if the parent Tag name is picked using one of the methods above. You can enter descriptions or select a description from a component on the current drawing.
Cross-reference

AutoCAD Electrical automatically fills in cross-reference text when the cross-reference command is run.

Installation Code

Changes the installation code(s). You can search the current drawing or entire project for installation codes. AutoCAD Electrical does a quick read of all the current or selected drawing files and returns a list of all installation codes used so far. Pick from the list to automatically update the component with the installation code.

Assigning short installation codes to components like "PNL" and "FIELD" allow you to later create location-specific BOM and component lists.

Location Code

Changes the location code(s). You can search the current drawing or entire project for location codes. A quick read of all the current or selected drawing files is done and a list of location codes used so far is returned. Pick from the list to automatically update the component with the location code.

Assigning short location codes to components like "PNL" and "FIELD" allow you to later extract cable from/to reports and location-specific BOM reports (ex: BOM for all field cables, BOM for all PNL cables).

Show/Edit Miscellaneous

View or edit any attributes that are not predefined AutoCAD Electrical attributes.

Pins

Assigns pin numbers to the pins that are physically located on the component.

Insert or edit child component: IEC
This is Insert/Edit Child Component dialog box for working in IEC mode. If you are working in JIC mode, the dialog box will display differently.

**Access:**

- Click the Multiple Insert Component tool. Select the component type to insert and select the insertion point on the drawing.
- Click Components ➤ Multiple Insert ➤ Multiple Insert (Icon Menu). Select Relay/Contact and select the insertion point on the drawing.
- Click the Edit Component tool and select the component to edit.
- Click Components ➤ Edit Component and select the component to edit.

You can go back to any component at any time and make changes.

**Installation**

Changes the installation codes. You can search the current drawing or entire project for installation codes. A quick read of all the current or selected drawing files is done and a list of installation codes used so far is returned. Select from the list to automatically update the component with the installation code.

Assign short installation codes to components like "PNL" and "FIELD" so you can create location-specific BOM and component lists later.

**Location**

Changes the location codes. You can search the current drawing or entire project for location codes. A quick read of all the current or selected drawing files is done and a list of location codes used so far is returned. Select from the list to automatically update the component with the location code.

Assign short location codes to components like "PNL" and "FIELD" so you can extract cable from/to reports and location-specific BOM reports later. (For example, BOM for all field cables, BOM for all PNL cables.)

**Component Tag**

The parent tag value can be manually typed into the edit box or selected from a drawing-wide or project-wide list of similar components. If the parent is visible on the screen, Click Parent/Sibling and select the parent (or another related contact). This transfers all information automatically to the child contact being inserted or edited.
Description

Up to 3 lines of description attribute text can be entered. These lines are automatically filled with a copy of the parent’s description text if the parent Tag name is picked using one of the methods described previously. You can enter descriptions or select a description from a component on the current drawing.

Ratings

Specifies values for each ratings attribute. You can enter up to 12 ratings attributes on a component. Select Defaults to display a list of default values.

NOTE If Ratings is grayed out, the component you are editing does not carry any rating attributes.

Show/Edit Miscellaneous

View or edit any attributes that are not predefined AutoCAD Electrical attributes.

Cross-reference

AutoCAD Electrical automatically fills in cross-reference text when the cross-reference command is run.

Pins

Assigns pin numbers to the pins that are physically located on the component.

Insert from catalog lists

Use this to annotate the selected schematic (or panel) component with the catalog number or a component description selected from a user-defined pick list and insert it into the drawing.
NOTE This procedure uses schematic tools, but the same procedure can be done using panel tools.

1 Click the arrow on the Insert Component tool to access the Insert Component (Catalog List) tool.

2 Click the Insert Component (Catalog List) tool.

3 Sort the component list by catalog, description, or manufacturer.

4 Select the component to insert.

5 (Optional) Click Edit to make any changes to the catalog record. Modify the record in the Edit Record dialog box and click OK.

6 (Optional) Click Add to create a new record. If the new record is similar to an existing record, highlight the existing record before you click Add. Modify the record in the Add Record dialog box and click OK.

7 Click OK.

8 Specify an insertion point in the active drawing.

9 Make any changes in the Insert/Edit Component dialog box and click OK.

Schematic component or panel footprint

Inserts schematic or panel symbols by choosing a catalog number or a component description from a user-defined pick list. The data displayed in this pick list is stored in a database in generic Access format. The file name is wd_picklist.mdb and can be edited with Access or from Add/Edit/Delete along
the bottom of the pick list’s dialog box. The AutoCAD Electrical normal search path sequence is used to locate this file.

**Access:**

- Click the arrow on the Insert Component tool to access the Insert Component (Catalog List) tool.
- From the Component menu, select Insert Component (Lists) ➤ Insert Component (Catalog List).
- Click the arrow on the Insert Footprint tool to access the Insert Footprint (Catalog List) tool.
- From the Panel Layout menu, select Insert Footprint (Lists) ➤ Insert Footprint (Catalog List).

Both schematic and panel layout symbols can be included in the pick list database but only schematic or panel entries are displayed at a time depending on whether the routine is called from the AutoCAD Electrical or Panel Layout toolbar.

**Sort by**

Specifies how to sort the record list. You can sort by description, catalog number, or manufacturer code.

**Add**

Opens a dialog box for creating a new record. If the footprint block is not in an AutoCAD or an AutoCAD Electrical search path, include the part of the path that needs to be appended to one of these search paths (or you can enter the full path). If the new record is similar to an existing record, highlight the existing record before you click Add.

**Edit**

Opens a dialog box for editing an existing record. Highlight the record and click Edit. Modify the record in the displayed dialog box.

**Delete**

Removes an existing record.

### Add or edit record

**Access:**

- Click the drop-down arrow on the Insert Component tool to access the Insert Component (Catalog List) tool. Click Add or Edit.
- From the Components menu, select Insert Component (Catalog List).

---

314 | Chapter 6  Component Tools
Access:

Click the drop-down arrow on the Insert Footprint tool to access the Insert Footprint (Catalog List) tool.
From the Panel Layout menu, select Insert Footprint (Catalog List). Click Add or Edit.

NOTE When you add a record you must indicate if the component or circuit is Schematic or Panel and you need to indicate if it should be inserted as a block or exploded upon insert (as you would for a circuit). Then, at a minimum, you need to define the block name and either the catalog number or description.

Select Schematic or Panel Device

Specifies if the component (or circuit) is Schematic or Panel.

Single block or explode on insert

Specifies if it should be inserted as a block or exploded upon insert (as you would for a circuit).

Minimum of Block Name and either Description or Catalog

- **Block/Assembly/Circuit**: The Block value can be a symbol name or AutoLISP expression. If the footprint block is not in an AutoCAD search path or an AutoCAD Electrical search path, include the part of the path that needs to be appended to one of these search paths (or enter the full path to the footprint block). Use Browse to locate the block name or use Pick to capture the block name if it already exists on the current drawing.

- **Description**: Specifies the optional comment for the footprint record. This is for reference in this file only. It does not get extracted into any AutoCAD Electrical report.

- **Catalog**: (not used for exploded inserts) The Catalog value may contain wildcards. Wild card characters include:
  * "*" = match any characters
  "?" = match any single character
  "$" = match any single numeric digit
  "@" = match any single alphabetic character

---

Insert from catalog lists | 315
NOTE If the catalog number actually has a character in it like #, then precede it with the ` char, example "F120#10" would be "F120`#10"

Optional Values

These options are not available for exploded inserts. Options for specifying the manufacturer code, assembly code, and text values. If the catalog information includes an ASSYCODE value, include it in the record to ensure a complete match. If the same footprint is used no matter what the ASSYCODE value is (ex: different combinations of contact blocks on a base relay) then use "*" wildcard character for the ASSYCODE value in the record.

The TEXTVALS value can be used to filter your pick list based on the component’s FAMILY code value. For this to work, the text substring "FAMILY=<family code>" needs to be somewhere in each line of text to be displayed. The TEXTVALS field can also be used to auto-fill attribute values on insertion. For example, if the line includes the substring "MFG=AB; CAT=1492; LOC=PNL1" then the MFG, CAT, and LOC edit boxes will auto-fill with the values "AB", "1492", and "PNL1" respectively.

Use the schematic lookup file

The schematic lookup file maps catalog information from a panel component or equipment list to a specific schematic component library symbol. AutoCAD Electrical supplies a starter lookup file called schematic_lookup.mdb in Access ".mdb" file format. Within the database file are tables based on Manufacturer codes. When you select a panel footprint from an AutoCAD Electrical extract file or select a panel footprint from a catalog lookup file, it carries a manufacturer code, on the MFG attribute. AutoCAD Electrical takes this MFG code, goes to the matching table name in the schematic lookup database and tries to find a match on the manufacturer, catalog number and assembly code (if non-blank). If a match is found, AutoCAD Electrical retrieves the component block path/name (or AutoCAD Electrical command list) from the matching record and inserts the schematic component representation into the drawing.

You must expand and modify these tables to meet your specific schematic needs. You can do this using tools provided with AutoCAD Electrical or through the use of a database program that can read/write the Access file format. You may use the MDB file (schematic_lookup.mdb) or a project-specific schematic lookup file, called <project>_schematic_lookup.mdb. If the
project-specific .mdb file is used, it needs to be in the same subdirectory as the <project>.wdp file.

**Lookup file naming convention:** AutoCAD Electrical takes the target footprint’s MFG code and looks for a table, in your Access schematic_lookup.mdb file with that name. For example, if the footprint’s MFG value is SQD, then AutoCAD Electrical searches for a schematic lookup table called SQD; manufacturer code of AB yields the table name AB.

**Lookup file format**

All fields contain characters except for RECNUM, which is automatically numbered in the list for you. Fields may be blank and may use wildcards, with the exception of SCHEMATIC_BLKNAM. Each record consists of these fields (in this order):

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MANUFACTURER</td>
<td>Manufacturer name (same as attribute value)</td>
</tr>
<tr>
<td>CATALOG</td>
<td>Catalog part number</td>
</tr>
<tr>
<td>ASSEMBLYCODE</td>
<td>Assembly code part number link</td>
</tr>
<tr>
<td>FUNCTION_DESCRIPTION</td>
<td>Assigned description text (DESC1-DESC3)</td>
</tr>
<tr>
<td>PANEL_BLKNAM</td>
<td>Block name of the panel footprint insert</td>
</tr>
<tr>
<td>CATEGORY</td>
<td>Blank for component queries, 'T' or 'W' for terminal queries</td>
</tr>
<tr>
<td>WDBLKNAM</td>
<td>Name used to tie into catalog lookup table (ex. PB11, CR)</td>
</tr>
<tr>
<td>SCHEMATIC_BLKNAM</td>
<td>Schematic symbol block name or special insert command flag</td>
</tr>
<tr>
<td>COMMENTS</td>
<td>Description of the schematic block name</td>
</tr>
<tr>
<td>RECNUM</td>
<td>Record number (automatically numbered in the list)</td>
</tr>
</tbody>
</table>

Use the schematic lookup file | 317
**Table query sequence**

Queries on this database can be multi-level until a hit is returned. The first level is a query on the MFG/CAT/ASSYCODE fields. If 0 records are returned, a second query is done on just the CATALOG field (or the CATEGORY field if working with terminals). If 0 records are returned, a third query is done on the WDBLKNAM field. If this fails to return any records, a final query is made on keywords in the FUNCTION_DESCRIPTION field.

**NOTE** When querying panel terminals, the second query is on the CATEGORY field, which contains a 'T' or 'W'. This query determines which symbols to display in the Insert dialog box. The 'T' displays a list of terminal symbols for terminal numbers, while the 'W' displays a list of terminal symbols for wire number terminals.

When multiple block name choices are returned, they are displayed in a pick list along with any comments from each matching record. If a match is not found or if matches are found and you choose not to use any of them, the displayed Insert dialog box offers several other options. You can:

- Pick from AutoCAD Electrical's icon menu
- Browse to the symbol file (available from the icon menu)
- Enter a symbol name into the edit box (available from the icon menu)
- Pick a ‘just like schematic component to get the schematic block name

**Insert components from equipment lists**

Use this to annotate the selected schematic (or panel) component with the panel footprint or equipment list data and insert it into the drawing.
NOTE This procedure uses schematic tools, but the same procedure can be done using panel tools.

1. Click the arrow on the Insert Component tool to access the Insert Component (Equipment List) tool.

2. Click the Insert Component (Equipment List) tool.

3. Select the spreadsheet file to use and click Open.

4. If multiple sheets/tables were found in the data file, select the table to edit.

5. Click OK.

6. On the Settings dialog box, determine whether to use the default settings or select a file of previously saved settings.
   - Default Settings: The View/Edit Settings options become available to modify the default settings. Modify the settings or click OK to continue with the insert using the default settings.
   - Read Settings: Select the file (*.wde) to read the settings from and click Open.

7. (Optional) Click Spreadsheet/Table columns to define the order of the data in the selected equipment list file.
   On the Equipment List Spreadsheet Settings dialog box, assign column numbers to the data categories (such as Manufacturer, Catalog, and Installation).

8. (Optional) Click Save Settings to save the settings to a file for later recall.

9. On the Settings dialog box, click OK.

10. In the Schematic equipment in (or the Panel equipment in) dialog box, review the components by sorting or performing a catalog check.

11. Select the component to insert on the drawing.
12 Make any changes to the component's scale, orientation, or rotation angle.

13 Select the method for inserting the component into the drawing:
   - **Insert**: Finds and inserts a schematic (or panel) component for the highlighted equipment list component.
   - **Pick File**: Picks a file for the insert. Select an existing AutoCAD Electrical extracted equipment list component list file or extract a fresh copy of panel component data from the current project's database.
   - **Convert Existing**: (for Panel components only) Inserts selected entry's data on an existing “dumb” block insert. This instantly converts the block to a smart AutoCAD Electrical footprint.

14 In the Insert dialog box, select the block name to insert from the list.

15 Click OK.

**Settings**

This spreadsheet organizes the selected user-created equipment list and presents the list in a pick list. As you pick an item from the pick list, the appropriate schematic symbol is found and inserted in the drawing at your pick point. Your equipment list can be an AutoCAD Electrical-generated Component report, or it can be a list of motors giving horsepower and starter type along with motor ID and descriptions.

**NOTE** You can open a comma-delimited file, Excel spreadsheet, or Access database file for input.

**Access:**

Click the arrow on the Insert Component tool to access the Insert Component (Equipment List) or click the arrow on the Insert Footprint tool to access the Insert Footprint (Equipment List) tool. Select the spreadsheet file to use and click Open. Click the table to edit and click OK.

From the Components menu, select Insert Component (Lists) ➤ Insert Component (Equipment List) or select Panel Layout ➤ Insert Footprint (Lists) ➤
Access:

Insert Footprint (Equipment List). Select the spreadsheet file to use and click Open. Click the table to edit and click OK.

Default settings

Uses the default settings for managing equipment lists.

Read settings

Reads and uses the settings for a previously saved file.

Spreadsheet/Table columns

Defines the order of the data in the selected equipment list file. Assign column numbers to data categories (such as Manufacturer, Catalog, and Installation) in the Equipment List Spreadsheet Settings dialog box.

Save settings

Saves the column information in a text file to be reused. The filename is user-defined with the extension WDE.

Schematic equipment in

This tool lists BOM data extracted from your equipment list and finds the appropriate schematic symbol by querying the schematic_lookup.mdb. It inserts the schematic components at your pick point. Each line or record in the equipment list represents a single entry into the Equipment in dialog box for schematic component selection. The quantity for a selected catalog number is not considered when inserting schematic components.

You can select to insert a single schematic component or multiple components from the equipment list.

Access:

Click the arrow on the Insert Component tool to access the Insert Component (Equipment List) tool. Select the spreadsheet file to use and click Open. Specify to use default or previously saved settings and click OK.

From the Components menu, select Insert Component (Lists) ➤ Insert Component (Equipment List). Select the spreadsheet file to use and click Open. Specify to use default or previously saved settings and click OK.

Sort List

Sorts the list of components. You can specify four sorts to perform on the list.
Catalog Check

Performs a Bill of Material check and displays the result. This is enabled if the selected equipment list item contains catalog data.

TAG Options

Specifies whether to use the component tag as listed in the equipment list or recalculate the schematic tag based on the tagging settings of the drawing. When a component that doesn’t have a tag is selected from the list, this switch is automatically set to Use auto-generated schematic TAG.

- **Use auto-generated schematic TAG**: Modifies the schematic component tag based upon the drawing settings.
- **Use Equipment List TAG**: Maintains the tag as defined in the component listing and sets the tag to fixed in the schematic.

Scale

Specifies the block insert scale. (1.0 = full)

Vertical

Changes the default drawing orientation.

Insert

Finds and inserts a schematic component for the highlighted equipment list component. The query of the schematic_lookup.mdb file returns one or more block names based on data that appears in the pick list. The results are displayed in the Insert dialog box along with a short description of each choice.

Pick File

Picks a file for the insert. Select an existing AutoCAD Electrical extracted equipment list component list file or extract a fresh copy of panel component data from the current project’s database.

Insert

This dialog box displays the result of a query on the schematic_lookup.mdb file. Select the appropriate block to insert from the list and click OK.
selected schematic component is then annotated with the panel footprint or equipment list data and inserted into the drawing. You can also select one of the methods below to insert an alternative symbol.

Access:

Click Insert on the Panel terminals, Panel components, or Schematic equipment list in dialog boxes.

Icon Menu Displays the icon menu from which you can select the schematic component to insert. This is different than the schematic symbols in the list and should not be considered another way to select the same components.

Copy Component Copies a "just like" components and annotates it with the panel data.

Insert from panel lists

Insert components or terminals from panel lists

After the schematic component is selected and inserted in the drawing, all panel-related information is copied to the schematic. Use the Insert/Edit
Component dialog box to make any additional changes to the new schematic component.

1. Click the arrow on the Insert Component tool to access the Insert Component (Panel List) tool.

2. Click the Insert Component (Panel List) tool.

   **NOTE** Click the Insert Terminal (Panel List) tool to insert a panel terminal.

3. Specify whether to extract the panel component/terminal list for the active drawing or the active project.

4. Specify any installation or location codes to extract.

5. Click OK.

6. If you are extracting for the entire project, select which drawing files to process, and click OK.

7. On the Panel Components (or Panel Terminals) dialog box, select from the list of panel components/terminals to insert the schematic symbol on the schematic drawing.
   
   To modify the pick list so you can easily find the component or terminal to select, click Sort List, Display, or Mark Existing.

8. Click Insert.

9. On the Insert dialog box, select which block name to insert from the list.
   
   If you want to insert an alternative block that is not in the list, click Icon Menu to select a component from the icon menu or click Copy Component to insert a component 'just like' another existing component.

10. Click OK.

11. Select the insertion point on the drawing.

12. Make any changes to the inserted component in the Insert/Edit Component dialog box and click OK.
Panel layout list ➤ schematic components insert

This tool lists panel components extracted from your panel drawing, finds the appropriate schematic symbol, and inserts the schematic components at your pick point.

Access:

Click the arrow on the Insert Component tool to access the Insert Component (Panel List) tool.
From the Components menu, select Insert Component (Panel List).

Extract component list for

Specifies to export the data for the active drawing or the entire active project.

Save list to external file

Creates a comma-delimited file of the panel component data. The extracted file name is the same as the project by default (project_name.WD4). You can display this data in spreadsheet format (open it in comma-delimited "CSV" format), edit, and then save.

Browse

Uses a previous project’s panel component list to create a spreadsheet listing. After the initial extraction, a list of panel components displays for selection.

Installation Codes to extract

Extracts only the information for components with specific installation values. Once you pick Named Installations, you can type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes.

Location Codes to extract

Extracts only the information for components with specific location values. Once you pick Named Location, you can type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes.

Panel terminal list ➤ schematic terminals insert

This report provides error checking between the schematics and the panel layout drawings. The program looks at the selected drawings, both schematic
and panel, looking for a match. For each panel component, the routine tries to find a matching schematic component based on tag, location, and installation information. If a match is found, then it compares catalog information looking for any discrepancies.

Access:

Click the arrow on the Insert Component tool to access the Insert Terminal (Panel List) tool.
From the Components menu, select Insert Terminal (Panel List).

- **Extract terminal list for**
  Specifies to export the data for the active drawing or multiple drawings in the active project.

- **Save list to external file**
  Creates a comma-delimited file of the panel component data. The extracted file name is the same as the project by default (project_name.WD4). You can display this data in spreadsheet format (open it in comma-delimited "CSV" format), edit, and then save.

- **Browse**
  Uses a previous project’s terminal list to create a spreadsheet listing. After the initial extraction, a list of terminals displays for selection.

- **Installation Codes to extract**
  Extracts only the information for panel terminals with specific installation values. Once you pick Named Installation, you can type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes.

- **Location Codes to extract**
  Extracts only the information for panel terminals with specific location values. Once you pick Named Location, you can type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes.

**Panel components**

This presents a list of all panel components extracted from the project’s panel layout drawings. As you pick an item from the pick list, the appropriate schematic symbol is found and inserted in the drawing at your pick point.
After the selection of the schematic component and the annotation of the device tag, all panel-related information such as descriptions, installation, and location codes are copied to the schematic.

You can select to insert a single schematic component or multiple components from the panel list.

Access:

Click the arrow on the Insert Component tool to access the Insert Component (Panel List) tool. Select Project and click OK. Select the files to process and click OK.

From the Components menu, select Insert Component (Panel List). Select Project and click OK. Select the files to process and click OK.

Sort List

Sorts the list of panel components. You can specify four sorts to perform on the list.

Reload

Reopens the Panel Layout List ➤ Schematic Components Insert dialog box so you can re-extract data or select a saved external file to use.

Mark Existing

Matches panel components extracted from the project database with schematic components previously placed into the drawing and marks any existing components. An "x" displays in left-hand column for any listed panel component tag that already has its schematic component inserted on the drawing and there is an exact match on catalog and manufacturer values between the two. An "o" displays if the tags match but there is mismatch on catalog and manufacturer values between the two.

Display

Specifies to show all extracted panel data or hide the panel data that has a matching schematic component.
Catalog Check

Performs a Bill of Material check and displays the result. This is enabled if the selected panel item contains catalog data.

TAG Options

Specifies whether to use the panel tag as is, or recalculate the schematic tag based on the tagging settings of the drawing. When a component that doesn't have a tag is selected from the list, this switch is automatically set to Use auto-generated schematic TAG.

Use auto-generated schematic TAG

Modifies the schematic component tag based on the drawing settings. If a new tag is generated when inserting the schematic component, the source panel footprint is updated with the generated tag. The active drawing is automatically updated, while updates on other drawings are maintained inside of the update task file (project_name.upd) for later modification of the panel drawings to match the new schematic component tag.

Use panel footprint TAG

Maintains the tag as defined in the panel component listing and sets the tag to fixed in the schematic.

Scale

Specifies the block insert scale. (1.0 = full) The drawing scale is used as the default.

Vertical

Changes the default drawing orientation.

Insert

Finds and inserts a schematic component for the highlighted panel component. The query of the schematic_lookup.mdb file returns one or more block names based on data that appears in the pick list. The results are displayed in the Insert dialog box along with a short description of each choice.
Pick File

Picks a file for the insert. Select an existing AutoCAD Electrical extracted panel component list file or extract a fresh copy of panel component data from the current project's database.

Panel terminals

This presents a list of all panel terminals extracted from the project's panel layout drawings. As you pick an item from the pick list, the appropriate schematic terminal is found and inserted in the drawing at your pick point. After the selection of the schematic terminal and the annotation of the device tag, all panel-related information such as descriptions, installation, and location codes are copied to the schematic.

You can select to insert a single terminal block or multiple terminal blocks from the panel list.

Access:

Click the arrow on the Insert Component tool to access the Insert Terminal (Panel List) tool. Select Project and click OK. Select the files to process and click OK.

From the Components menu, select Insert Terminal (Panel List). Select Project and click OK. Select the files to process and click OK.

Sort List

Sorts the list of panel terminals. You can specify four sorts to perform on the list.

Reload

Reopens the Panel Terminal List ➤ Schematic Terminals Insert dialog box so you can re-extract data or select a saved external file to use.

Mark Existing

Matches schematic components extracted from the project database with panel terminal components and marks any existing components. An "x" displays in left-hand column for any listed panel component tag that already has its schematic inserted on the drawing and there is an exact match on catalog and manufacturer values between the two. An "o" displays if the tags match but there is mismatch on catalog and manufacturer values between the two.

Display

Specifies to show all extracted panel data or hide the panel data that has a matching schematic component.
<table>
<thead>
<tr>
<th>Catalog Check</th>
<th>Performs a Bill of Material check and displays the result. This is enabled if the selected panel terminal contains catalog data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last symbol used</td>
<td>Displays the last symbol selected through the insert process. You can clear the selection and go back through the insert process to select the schematic terminal symbol or you can automatically insert the last symbol used by not making any changes.</td>
</tr>
<tr>
<td>Scale</td>
<td>Specifies the block insert scale. (1.0 = full)</td>
</tr>
<tr>
<td>Rotate</td>
<td>Changes the default drawing orientation.</td>
</tr>
<tr>
<td>Insert</td>
<td>Finds and inserts a schematic terminal for the highlighted panel terminal. A query of the schematic_lookup.mdb file returns one or more block names based on data that appears in the pick list. The results are displayed in the Insert dialog box along with a short description of each choice.</td>
</tr>
<tr>
<td>Pick File</td>
<td>Specifies to pick a file for the insert. Select an existing AutoCAD Electrical extracted panel terminal list file or extract a fresh copy of panel component data from the current project’s database.</td>
</tr>
</tbody>
</table>

**Manipulate components**

You can manipulate components by moving, stretching, splitting, aligning, or deleting them.

**Delete components**

The Delete Component command lets you remove the selected component. The broken wires are repaired and any resulting instances of multiple wire numbers now assigned to a single wire network are reconciled. In the case of a child contact, AutoCAD Electrical looks for its parent on the current drawing and removes the deleted contact from the parent’s cross-reference annotation (if the parent is on some other drawing then a separate run of the "X
Cross-reference" command is required on the drawing set). If you erase a parent schematic component you will have the option to search for related child components, surf to them, and optionally delete them.

**Scoot components/wire segments**

The Scoot command lets you quickly reposition components and wire segments. Components stay connected and existing wire numbers re-center. Pick on the component to slide just the component along it’s connected wire(s). The component’s scoot will be constrained along the wire segment. Scoot works on wire numbers, components, terminals, PLC I\O modules, jogs in dashed link lines, signal arrows, wires, and wires with wire-crossing loops.

*NOTE* Components constrained by connected wiring at right angles will not scoot.

**Align components/wire numbers**

The Align Components command aligns the selected component with a master component that you select. All connected wires will be adjusted, and wire numbers re-centered if necessary. You can align vertically or horizontally by flipping the command with a V or H character and a [space] entered on the command line.

*NOTE* The Align Component command can be used on panel layout symbols.

**Move components**

The Move Component command removes the selected component from its current location/wire connection and inserts it into the new position you pick. AutoCAD Electrical uses a rotated version of the symbol, if necessary, as it breaks and reconnects any underlying wires. AutoCAD Electrical attempts to repair the broken wires and reconcile multiple wire numbers left over in the component's vacated position. If you use this command and select on a panel footprint, AutoCAD Electrical issues the normal AutoCAD Move command.

**Move component attributes**

The Move/Show Attributes command removes the selected attribute from its current location and inserts it into the new position you pick. If you accidentally pick on the block's graphics instead of an attribute, this move command will kick into the attribute Display/Edit mode instead.
**Stretch PLC modules**

The Stretch PLC Module command is a very handy feature, especially for PLC modules. Let’s say you have a PLC module and you need to add a couple components in parallel on a particular rung and you did not leave enough room between the I/O points. What do you do? You could erase everything and rebuild the module and then reinsert the components, redo the wiring, etc. or you could use the Stretch PLC Module command.

**NOTE** The block name itself is changed to make it unique.

**Split PLC modules**

The Split PLC Module command is especially handy for splitting PLC modules once they have been built or inserted. Maybe you need to move the last few I/O terminal points to another ladder to make room for some other devices.

**Manipulate components**

You can manipulate components by moving, stretching, splitting, aligning, or deleting them.
Delete components

1 Click the Delete Component tool.
2 Select the components to delete.
3 Press Enter.

**NOTE** If you erase a parent schematic component, you have the option to search for related child components, surf to them, and delete them.

Scoot components/wire segments

1 Click the Scoot tool.
2 Select the component to scoot along its connected wires or select the wire segment to scoot the entire wire, including components, along the bus. A rectangle indicates the selected items.
3 Move your cursor to the appropriate position and click. The items scoot and reconnect.

**NOTE** You can run the Auto-Retag operation on the components if they move to a new line reference, or update the child cross-references only.

Align components/wire numbers

1 Click the arrow on the Scoot tool to access the Align Components tool.

2 Click the Align Components tool.
3 Select the master component to align with. A temporary line appears showing the alignment position.
4 Select the components to move into alignment with the selected master component. You can select the components individually or by windowing.
All connected wires are adjusted, and wire numbers recentered if necessary. You can align vertically or horizontally by flipping the command with a V or H character and a [space] entered on the command line.

**Move components**

1. Click the arrow on the Scoot tool to access the Move Component tool.
2. Click the Move Component tool.
3. Select the component to move.
4. Select the insertion point for the move. The component automatically moves to the selected position.

**Stretch PLC modules**

1. Click the arrow on the Scoot tool to access the Stretch PLC Module tool.
2. Click the Stretch PLC Module tool.
3. Select the blocks to stretch using a crossing window or crossing polygon window.
4. Press Enter.
5. Select your base and second point of displacement. The exploded blocks stretch and are then rebuilt (maintaining all the original block information, including attributes).

**Split PLC modules**
1 Click the arrow on the Scoot tool to access the Split PLC Module tool.

2 Click the Split PLC Module tool.

3 Select the block to split. It explodes the block into individual parts.

4 Select the objects for the new child component using a crossing window or crossing polygon.
   Keep windowing until all objects are selected. To cancel the selection of any object, press U and select as usual.

5 Define the origin point for the new block. You can enter the coordinates or click Pick Point and select the origin point on the drawing.

6 Set the break type: no lines, straight lines, jagged lines, or draw it.

7 (Optional) Select to reposition the child block to move it as part of this command.

8 Click OK.

9 To reposition the child block, select a point on the screen to place the block.

**Split block**

Use this tool to split blocks or parametric connectors into 2 separate block definitions (for example, parent and a child or a child and another child).

**Access:**

Click the arrow on the Scoot tool to access the Split Block tool. Select the block to split and specify the split point.

From the Components menu, select Component Miscellaneous ➤ Split Block. Select the block to split and specify the split point.

Click the arrow on the Insert Connector tool to access the Split Connector tool. Select the connector to split and specify the split point.
Access:

From the Components menu, select Insert Connector ➤ Split Connector. Select the connector to split and specify the split point.

**Child Base Point**

Specifies the origin point for the new block. The default is in-line with the first set of pins on the split-off piece. If you do not want to accept the default, enter the coordinates or click Pick Point and select the origin point on the drawing.

**Break Type**

Specifies the break type: no lines, straight lines, jagged lines, or draw it. The default is set to jagged lines. Click Draw to manually draw the break type on the drawing.

**Layer**

Specifies the layer for the child block. You can accept the default or click List to select the layer from a list of existing layers.

**Reposition Child Block**

Specifies to reposition the child block to move it as part of this command.
Annotate ratings attributes

1. Click the Edit Components tool.

2. Click the Show All Ratings button in the Insert/Edit Components dialog box. The View/Edit Rating Value dialog box displays, letting you enter values for each ratings attribute.

3. Click the Defaults button next to the edit box to display the list of default values.

4. Select a line from the file to map its values to the available ratings attributes. Notice that a single line may carry multiple values with each value separated by a "|" character. Any text that follows a semi-colon is considered a comment and will be ignored.

5. Choose whether to select a different file or add a new file to the ratings defaults file.

6. Click OK to finish the operation.

You may create multiple .WDR files. AutoCAD Electrical will look for a generic defaults file called WD_RATINGS.WDR stored in the AutoCAD Electrical support directory. You may also create a project specific file with the same name and path as the project with the .WDR extension. You may also have Family specific files named for the Family code of the component with the .WDR extension. For example, if the component has the family code "PB" for pushbuttons and a file called PB.WDR exists, it will display when you select the "Family" button.

NOTE If the Show All Ratings button is disabled, the component you are editing does not have a rating attribute.

Ratings defaults

AutoCAD Electrical allows up to 12 Ratings attributes on a component. To help you annotate these attributes AutoCAD Electrical lets you pick from a list of defaults. To take advantage of this feature you need to create/modify a
text file with a .WDR extension. This file is a simple text file and can be edited with any editor such as WordPad.

**Access:**

Click the Edit Component tool. Click the Show All Ratings button, and then click Defaults.

From the Components menu, select Edit Component and click the Show All Ratings button, and then click Defaults.

**Ratings panel**

Displays the values for the rating attribute.

**Pick File**

Selects a different file and description list.

**Project**

Displays a project .WDD file (if it is not already displayed).

**Family**

Displays family-specific files named for the Family code of the component. For example, if the component has the family code "PB" for pushbuttons and a file called PB.WDD exists, it will display when you select the Family button.

**Generic**

Displays a generic file (WD_DESC.WDD) if it is not already displayed.

**Add/Edit**

Adds a new file to the rating defaults file. Enter a value in the dialog box or click Edit File to edit the file using WordPad.

**Reverse/flip components**

Use this tool to reverse or flip selected component graphics and its associated attributes.
NOTE This tool only operates on a component with 2-wire connections (for example, limit switch contact symbol).

1 Click the arrow on the Scoot tool to access the Reverse/Flip Component tool.

2 Click the Reverse/Flip Component tool.

3 Select whether to reverse or flip the component.

NOTE Components are reversed perpendicular to the axis formed by the two wire connections or flipped along the axis of the wire connection.

4 (Optional) Select to reverse or flip the graphics only.

**Reverse/flip component**

This tool reverses or flips selected component graphics and its associated attributes.

NOTE This tool only operates on a component with 2-wire connections (for example, limit switch contact symbol).

**Access:**

Click the arrow on the Scoot tool to access the Reverse/Flip Component tool. From the Components menu, select Reverse/Flip Component.

**Reverse**

Reverses the component graphics and the attributes perpendicular to the axis formed by the two wire connections.

**Flip**

Flips the component graphics and the attributes along the axis of the wire connection (for example, from top-side of the wire to the bottom and vice versa).
Specifies to reverse or flip only the graphics; component attributes are not modified.

Swap contact states

This tool flips a contact from one state (open or closed) to the other. It looks at the picked contact, reads its block name, and checks the 5th character position for either 1 or 2. It then substitutes 1 or 2 for the found character.

1 Click the Toggle NO/NC tool.
2 Select the component to toggle.
3 (Optional) Type Ctrl + Z to undo the contact swap if you selected the wrong component.
   Existing attribute text is preserved on the flipped contact. If the maximum contact counts are carried by the parent symbol, the maximum counts are checked so that they are not exceeded by the flip.

Check coil/contact count

Using the Cross-Reference Check tool (Components ➤ Cross-Reference ➤ Cross-Reference Check), AutoCAD Electrical first extracts a complete list of components from the project drawing set. Then it prompts you to select a component to check. AutoCAD Electrical reads the component's tag, finds all associated components, and lists them in a dialog. It also displays the parent's assigned catalog number (if one exists) where you can do a catalog check to see if the item's description indicates that the quantity of contacts can be accommodated.

Component reference listing
The Cross-Reference Check tool displays all associated and parent components to the selected component.

Access:

Click the arrow on the Component Cross-Reference tool to access the Cross-Reference Check tool.
From the Components menu, select Cross-Reference ➤ Cross-Reference Check.

A complete list of components is extracted from the project drawing set. The component's tag is read, then all associated components are found and listed in the dialog box. A bill of material check can be performed to see if the item's description indicates that the quantity of contacts can be accommodated.

References

■ N.O. references: Lists the number of normally open contacts assigned to the selected component.

■ N.C. references: Lists the number of normally closed contacts assigned to the selected component.

■ Other references: Lists the number of child devices that are neither NO or NC contacts. These may include pins of a connector, form C contacts, or general devices that are being referenced.

■ Reference listing: Lists the type, number, location, installation, and description text for the reference.

Parent Information

■ Manufacturer code: Lists the parent's associated manufacturing code (if one exists).

■ Catalog number: Lists the parent's associated catalog number (if one exists).

■ Assembly code: Lists the parent's associated assembly code (if one exists).

■ Catalog Check: Creates a BOM description for the selected component using the parent component's catalog number. Comparing the description (2 available) with the contact count (3 required) reveals a needed adjustment.
Catalog lookup: Opens the parts catalog in order to look up component-specific catalog information.

Follow signals

Follow a signal for a source or destination signal

Use the List Signal Code tool to follow a signal from a specific source or destination symbol.

1. Click the drop-down arrow on the Source/Destination Signals tool to access the List Signal Code tool.

2. Click the List Signal Code tool.

3. Select the signal marker to list. The signal code dialog box appears. All source and destination references for the signal code are listed in the three boxed groups.

4. Review the references for the signal code.

5. Click the Surf button to navigate to any of the references.

6. Click Cancel when you are finished reviewing the signal references.

Signal code

Follows a signal from a specific source or destination symbol and lists the signal code references.

Access:

Click the arrow on the Source/Destination Signals tool to access the List Signal Code tool.

From the Wires menu, select Signal Reference ➤ List Signal Code.
All source and destination references for the signal code are listed in the three boxed groups:

**Previous drawings (sheet/reference)**
Shows the references on upstream (previous) drawings.

**Current drawing**
Shows the references on the current drawing.

**Downstream drawings (sheet/reference)**
Shows references on downstream (next) drawings.

**Surf**
Navigates to any of the references.
**Insert dashed link lines**

This tool draws a dashed line from a component to a "To" or "From" arrow symbol.

1. Click the arrow on the Link Components with Dashed Lines tool to access the Insert Reference Arrow - To tool (or the Insert Reference Arrow - From tool).

2. Click the Insert Reference Arrow - To tool.

3. Select the contact to draw the line from.

4. Select where the arrow endpoint should be on the drawing.

5. Insert a description for the dashed link line in the Description dialog box and click OK.
   
   The line is a polyline drawn on the layer name defined on the Component Text and Line "Wire" Layers dialog box.

6. (Optional) Use the AutoCAD Layer command to assign a different line type to the layer.

7. (Optional) Use the Scoot command to reposition any jog in the dashed link line.

8. (Optional) Use the AutoCAD Erase command to remove the dashed link line.

**Overview of DIN Rails**

The Din Rail is generated based on data held in a Microsoft Excel spreadsheet called WDDINRL.XLS. Each row in the main worksheet, DIN_RAIL, represents a rail type. The Manufacturer, Catalog, and Description fields are used to create the drop-down list on the dialog box. In addition, each rail type has a corresponding worksheet named to match the catalog number. This worksheet defines some parameters based on the number of slots calculated from the rail length.
### Spreadsheet fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MFG</td>
<td>Manufacturer.</td>
</tr>
<tr>
<td>CAT</td>
<td>Catalog Number.</td>
</tr>
<tr>
<td>ASSYCODE</td>
<td>Assembly code.</td>
</tr>
<tr>
<td>DESC</td>
<td>Description used for dialog listing only.</td>
</tr>
<tr>
<td>RAILWID</td>
<td>Din rail width; distance between the top and bottom rail lines.</td>
</tr>
<tr>
<td>RAILCEN</td>
<td>Distance between the din rail centerlines.</td>
</tr>
<tr>
<td>RAILCEN1</td>
<td>Distance between the din rail centerlines; used for nonsymmetrical din rails.</td>
</tr>
<tr>
<td>RAILCEN2</td>
<td>Distance between bottom center line and the slot centers; used for nonsymmetrical din rails.</td>
</tr>
<tr>
<td>RAIL2SLOTcen</td>
<td>Distance from the origin of the din rail to the center of the slots; used for off-center din rails.</td>
</tr>
<tr>
<td>RAIL2ENDBASE</td>
<td>Distance from the origin of the din rail to the din rail bottom; used for off-center din rails.</td>
</tr>
<tr>
<td>RAILLENSTD</td>
<td>Standard length of din rail.</td>
</tr>
<tr>
<td>RAILLENMIN</td>
<td>Minimum length of rail piece.</td>
</tr>
<tr>
<td>SLOTOFS</td>
<td>Distance from the beginning of the din rail to the center of the first slot.</td>
</tr>
<tr>
<td>SLOTcen2cen</td>
<td>Distance between slots measured from the center of each slot.</td>
</tr>
</tbody>
</table>
SLOTLEN

Length of each slot. Enter a SLOTLEN of 0.0 to generate a block without slots.

SLOTWID

Width of each slot.

CHANNEL

Distance from channel line to the origin; repeated for each channel line.

CHANNEL_END

Distance from origin to channel end for each channel.

MIN_SHIFT

Length of rail to shift from one piece of rail to the next to make sure last piece is not less than the minimum length.

NCHOLE

Name of AutoCAD block for the drill hole.

BRKT

Allow standoff brackets, Yes or No. If No, then the button is disabled on the dialog. If Yes, the button is enabled and you can select standoff brackets.

BRKT_NAME

Name of AutoCAD block for standoff bracket.

BRKT_MFG

Manufacturer for standoff bracket. Added as Multi-BOM on the created Din Rail block.

BRKT_CAT

Catalog number for standoff bracket. Added as Multi-BOM on the created Din Rail block.

BRKT_ASMB

Assembly code for standoff bracket. Added as Multi-BOM on the created Din Rail block.

WDBLKNAM

Name used to tie into the catalog lookup table. Values are either DIN or WW based on whether the spreadsheet record is a din or wire way. This determines whether the DIN or WW table (of the default_cat.mdb) displays when you click Catalog Lookup on the Panel Layout - Component Insert/Edit dialog box.
Parametric building of wire ways

You can create generic wire way records in the spreadsheet (wddinrl.xls) for parametric building of wire ways. To do so, add the following records in the spreadsheet:

- MFG = PANDUIT
- CAT = Generic
- DESC = Wire duct, 3.25"x3.11" tall, slotted
- RAILLENSTD = 72
- WDBLKNAM = WW

- MFG = PANDUIT
- CAT = Generic
- DESC = Wire duct, 3.92"x1.89" tall, slotted
- RAILLENSTD = 78.72
- WDBLKNAM = WW

In the Din Rail dialog box, select one of these records as the Rail Type and click OK. In the Panel Layout - Component Insert/Edit dialog box, Catalog section, click Catalog Lookup. The Parts catalog dialog box now displays wire ways with Manufacturer = PANDUIT and Type = Slotted. Select a suitable wire way from the list.

Line properties

There may be times that you want to specify a Color, Linetype, or Layer for a particular line entity that makes up the Din Rail. You can do this with a few optional spreadsheet fields. For the 2 end lines, you add 2 columns in your spreadsheet, each called END_PROP. The first one is for the left end, the second is for the right end. The format is COLOR colorname LAYER layername LTYPE linetype. For example, COLOR 9 LAYER MISC LTYPE HIDDEN2. It is expecting a single space between the values. If you leave the field blank, or leave out one of the properties, it draws the lines using the current defaults. For the channel lines, it works similarly, but the columns should be called CHANNEL_PROP. Put them in the same order as the CHANNEL values. For example, you want the inner lines to be font HIDDEN2 and the CHANNEL...
columns are in this order, 0.69 0.49 -0.49 -0.69, this means the inner lines are the second and third channel columns. So the CHANNEL_PROP columns are:

- First column: leave blank
- Second column LTYPE HIDDEN2
- Third column: LTYPE HIDDEN2
- Fourth column: blank

END_PROP Use this field to define the properties for the end lines.

CHANNEL_PROP Use this field to define the properties for the channel lines.

**Din rail**

**Access:**

Click the arrow on the Insert Footprint tool to access the Insert Footprint (Icon Menu) tool. Select DIN Rail from the list. From the Panel Layout menu, select Insert Footprint (Icon Menu). Select DIN Rail from the list.

Once the information is entered and you click OK, the Din Rail is generated. Each Din Rail section is created as a separate block. If you selected Standoff brackets, each bracket is a separate block. Some AutoCAD Electrical information is added to each block so it can be treated as an AutoCAD Electrical Panel entity. The AutoCAD Electrical edit dialog appears for the first Din Rail section and the first bracket, if applicable.

**Rail Type**

Lists the rail types to select from.

**Origin and length**

Specifies the origin and length of the component. Type the information into each edit box or click Pick Rail Info to pick the origin on your drawing and then drag the mouse to define the rail length.

**Orientation**

Specifies to orient the din rail horizontally or vertically.

**Scale**

Specifies the scale to use for the din rail.
Panel mounting

Specifies to mount the panel at NC holes, standoffs, or none.

Edit schematic lookup files

1. Click the arrow on the Miscellaneous Panel Tools tool to access the Schematic Database File Editor tool.

2. Click the Schematic Database File Editor tool.

3. (Optional) Click Sort to sort the database fields so that you can quickly find the record you are looking for.

4. (Optional) Click Find or Replace to jump to the next occurrence of the specified text or to replace the existing text.

5. (Optional) Click Filter to filter the listing based on certain values in the table. After you define the values to filter, apply the filter in the database editing window.

6. Decide if you want to edit an existing record or add a new one.
   - If you decide to edit an existing record, select the record to edit and click Edit on the Edit dialog box or double-click the record in the list.
   - If you decide to add a new record, click Add New or Add Copy on the Edit dialog box.

7. Add or edit the record values and click OK.
   Your new record is added to the list. You can also immediately see any changes you made to an existing record.

8. Click Save/Exit.
Use this tool to add or modify records in the schematic_lookup.mdb file to use for mapping panel footprints and terminal representations to the equivalent schematic component block names.

**Access:**

Click the arrow on the Miscellaneous Panel Tools tool to access the Schematic Database File Editor tool.

From the Panel Layout menu, select Database File Editor ➤ Schematic Database File Editor.

This lookup database table is a catalog lookup Access .mdb file that can be expanded as needed. Use either Microsoft Access or this dialog box to add new entries, edit or delete entries from the table.

**Sort**

Sorts the list of database records using either an alphanumeric sort or number values. You can specify four sorts to perform on the list.

**Find**

Specifies the value to find and then jumps to the next occurrence of the specified text. This searches in a specific column or in the entire table.

**Replace**

Indicates to replace the find value with the new text string that you specify.

**Filter**

Filters the listing based on certain values in the table. Picking the blank entry in the list removes the filter for that field. After you define the values to filter, apply the filter in the database editing window.

**Edit**

Displays the Edit Record dialog box for modifying the existing record in the database.

**Add New**

Displays the Edit New Record dialog box for entering a new record into the database.

**Add Copy**

Displays the Edit Copied Record dialog box for modifying and copying the record to make a new record. You cannot have two duplicate copies in the database.

**Delete**

Removes the selected record from the database.
**Edit record**

Edit new, existing, or copied records in the schematic_lookup.mdb database.

**Access:**

Click the arrow on the Miscellaneous Panel Tools tool to access the Schematic Database File Editor tool. Click Add New, Add Copy, or Edit or double-click on a record in the Edit dialog box.

From the Panel Layout menu, select Database File Editor ➤ Schematic Database File Editor. Click Add New, Add Copy, or Edit or double-click on a record in the Edit dialog box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MANUFACTURER</td>
<td>Manufacturer name (same as attribute value)</td>
</tr>
<tr>
<td>CATALOG</td>
<td>Catalog part number</td>
</tr>
<tr>
<td>ASSEMBLYCODE</td>
<td>Assembly code part number link</td>
</tr>
<tr>
<td>FUNCTION_DESCRIPTION</td>
<td>(Optional) Assigned description text (DESC1-DESC3)</td>
</tr>
<tr>
<td>PANEL_BLKNAM</td>
<td>Block name of the panel footprint insert</td>
</tr>
<tr>
<td>CATEGORY</td>
<td>Blank for component queries, 'T' or 'W' for terminal queries</td>
</tr>
<tr>
<td>WDBLKNAM</td>
<td>Name used to tie into catalog lookup table (ex. PB11, CR)</td>
</tr>
<tr>
<td>SCHEMATIC_BLKNAM</td>
<td>Schematic symbol block name or special insert command flag. Click Command List to add a command rather than a single block name.</td>
</tr>
<tr>
<td>COMMENTS</td>
<td>Description of the schematic block name</td>
</tr>
</tbody>
</table>

**Overview of user data records**

AutoCAD Electrical supports a user table in the project database. You can add your own application data to any AutoCAD Electrical block insert (components, footprints, wire numbers, terminals, wire jump arrows). A copy of this...
information is extracted and maintained in a USER table in the project database. This allows you to do queries on the project database file (in Microsoft Access format) and access all of this user information carried on all entities project-wide. This data is stored on the entities as invisible extended entity data. You are free to use this data in any way you see fit.

Examples: storing explicit wire sequencing information, cable or wire lengths, routing information, storing special parts information, descriptions, or MRP data, storing engineering notes, setup, or maintenance information, and so on.

Each application data record that you add to an entity can be up to 255 characters long. A single AutoCAD Electrical entity can carry several hundred of these records. Each record is tracked on the entity by entity handle plus a three digit record number beginning at "000". This same information is automatically maintained, project-wide, by AutoCAD Electrical in the user table of the project's database file.

**Edit user table data**

You can add, edit, or remove free-form user data records attached to the selected block insert. These records are stored in a user database table in the project database file.

**Access:**

Click the arrow on the Edit Component tool to access the Edit User Table Data tool.

From the Components menu, select Component Miscellaneous ➤ Edit User Table Data.

<table>
<thead>
<tr>
<th><strong>Record number</strong></th>
<th>Lists the record number for the selected block insert.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data</strong></td>
<td>Lists the user data for the record number.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Specifies the new data for the selected record number. Note that there is a 255 character maximum per record.</td>
</tr>
<tr>
<td><strong>Add new</strong></td>
<td>Adds a new user data record. A separate dialog box displays where you can enter the record data and number.</td>
</tr>
</tbody>
</table>
Delete record  Removes the selected record number from the database. If no user data records are found on the block insert, an alert is displayed in the dialog box prompting you to add a new record.

Use stand-alone cross-reference symbols

Cross-referencing is based on collecting and annotating groups of components that carry the same TAG text string value (for example, 101CR). Components do not have to be of the same family to be cross-referenced, but they must have the same TAG1/TAG2/TAG_*/TAG attribute values.

Cross-reference data is annotated onto attributes REFNO and XREFNC for N.O and N.C. references respectively. Alternately, if attribute XREF is present, both N.O. and N.C. references are combined into a single cross-reference text string.

Insert stand-alone cross-reference symbols

You use stand-alone cross-reference symbols just as you would wire source/destination arrow symbols but without the wires. Insert a source reference symbol, and then tie one or more destination reference symbols to
it. These can be on the same drawing or scattered across the project drawing set.

1. Click the arrow on the Parent/Child Cross-Reference tool to access the Insert Stand-Alone Cross-Reference tool.

2. Click the Insert Stand-Alone Cross-Reference tool.

3. On the Insert Component dialog box, select the cross-reference symbol to insert from the Symbol Preview window. You can also enter the symbol to insert in the Type it edit box or click Browse to select a symbol to insert.

4. Specify the insertion point on the drawing.

5. On the Stand-alone Source Cross-Reference Symbol dialog box, specify the unique name for the source/destination pair. You can select the code:
   - From a list of recently used codes.
   - From a list of codes on the active drawing.
   - From a list of codes in the active project.
   - From a destination cross-reference symbol.

6. Click OK.

**Create stand-alone cross-reference symbols**

1. Create a blank drawing file and save it following the library symbol naming conventions.

2. Copy an existing symbol’s .dwg file to the new file.

3. Edit and save the file.

4. Add the file to the icon menu.
Update stand-alone cross-reference symbol annotations

1  Click the arrow on the Parent/Child Cross-Reference tool to access the Update Stand-Alone Cross-Reference tool.

2  Click the Update Stand-Alone Cross-Reference tool. The Update Wire Signal and Stand-Alone Cross-Reference dialog box displays.

3  Specify whether to update the cross-reference annotation between pairs of stand-alone cross-reference symbols.

4  Specify to update the cross-references for the entire drawing or one at a time.

5  Click OK.

Insert component

This icon menu can be modified, expanded, or replaced with your own custom menu. You can change the default icon menu using the Library and Icon Menu Paths section of the Project Properties ➤ Project Settings dialog box. Select Projects ➤ Project ➤ Project Manager. Right-click the project name and select Properties. Use the Icon Menu Wizard to easily modify the menu. The default icon menu can also be redefined in "wd.env." Add entry "WD_MENU" for schematic icon menu and "WD_PMENU" for panel layout icon menu.

Access:

Click the Insert Component tool or the Multiple Insert Component tool.
Click Components ➤ Insert Component or Components ➤ Multiple Insert ➤ Multiple Insert (Icon Menu).
NOTE This dialog box is also accessed when inserting Pneumatic, Hydraulic, or P&ID components; in-line wire labels; stand-alone cross-reference symbols; cable markers; and saved circuits.

Select an icon picture or the component type from the Menu tree structure. The main menu in the tree structure is displayed as the menu heading just above the menu tree structure.

### Tabs
- **Menu**: Changes the visibility of the Menu tree view.
- **Up one level**: Displays the menu that is one level before the current menu in the Menu tree view. This is unavailable if the main menu is selected in the Menu tree view.
- **Views**: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.

### Menu
The tree structure is created by reading the icon menu file (*.dat). The tree structure is based on the arrangement order of submenus defined in the .dat file.

### Symbol Preview window
Displays the symbol and submenu icons corresponding to the menu or the submenu selected in the Menu tree structure. Clicking on the icon performs one of the following functions based on the icon properties as defined by the *.dat file:
- Inserts the symbol or circuit onto the drawing
- Executes a command
- Displays a submenu

**NOTE** When you move the cursor over an icon, the icon name and block/circuit/command name display as tooltip information.

### Recently Used
Displays the last components inserted during the current editing session; the most recently used icon displays in the top. This list follows the view options setting in the symbol preview window (icon only, icon with text or list view) and the total number of icons displayed depends on the value specified in the Display edit box.
Display  Specifies the number of icons to display in the Recently Used list box. Enter integer numbers only; the default value is 10.

Vertical/Horizontal  Inserts the icon using a vertical or horizontal orientation. This is opposite the drawing’s default ladder rung orientation.

No edit dialog  Turns off the Insert/Edit Component dialog box when inserting symbols onto the drawing. To add component detail later, click the Edit Component tool, and select the component to edit.

No tag  Inserts the component, un-tagged (i.e. without assigning a unique Component Tag). The untagged value that displays is the component’s TAG1/TAG2 default value. To add component detail later, click the Edit Component tool, and select the component to edit.

Always display previously used menu  Indicates to display the previously used menu each time you open the Insert Component dialog box. For example, if you insert a push button from the Push Buttons menu, the next time you open the Insert Component dialog box the Push Button menu displays by default.

Scale schematic  Specifies the component block insertion scale. This defaults to the value set in the Drawing Properties ➤ Drawing Format dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.

Scale panel  Specifies the footprint insertion scale. This defaults to the value set in the Drawing Properties ➤ Drawing Format dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.

Type it  Manually type in the component block to insert.

Browse  Browses to and selects the component to insert.

Right-click menus

Options for the Menu tree structure view
Right-click on the main menu or submenu in the Menu tree structure view to display the following options:

- **Expand/Collapse**: Toggles the visibility of the menus.
- **Properties**: Opens a Properties dialog box to view the existing menu or submenu properties like the menu name, image or submenu title. Use the Icon Menu Wizard to change any menu properties.

**Options for the Symbol Preview window**

Right-click an icon or in empty space in the Symbol Preview window to display the following options:

- **View**: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.
- **Properties**: (available for icons only) Opens a Properties dialog box to view the existing symbol icon properties like the icon name, image, block names and so on. Use the Icon Menu Wizard to change any icon properties.

**Pneumatic, Hydraulic and P&ID icon menus**

The Menu tree structure displays the symbols for the selected component type (pneumatic, hydraulic or P&ID). The Insert Pneumatic Component, Insert Hydraulic Component and Insert P&ID Component tools are accessed on the Extra Library toolbar.

- **Insert Pneumatic Component**
- **Insert Hydraulic Component**
- **Insert P&ID Component**
Stand-alone source or destination cross-reference symbol

You use stand-alone cross-reference symbols just as you would wire source/destination arrow symbols but without the wires. Insert a source reference symbol and then tie one or more destination reference symbols to it. These can be on the same drawing or scattered across the project drawing set.

Access:

Click the arrow on the Component Cross-Reference tool to access the Insert Stand-Alone Cross-Reference tool. Select the cross-reference component to insert and place it on the drawing.

From the Components menu, select Cross-Reference ➤ Insert Stand-Alone Cross-Reference. Select the cross-reference component to insert and place it on the drawing.

Code Specifies the unique name for the source/destination pair. This links each source cross-reference symbol to its destination cross-reference symbols.

Sheet (for Hexagon symbols only) Displays the sheet (Drawing Property) value for the drawing the matching symbol.

Reference Displays the line reference value for the matching symbol.

Recent Provides a list of source or destination symbols inserted this AutoCAD session.

Drawing Displays drawing-wide pick lists of all source/destination codes used so far.

Project Displays project-wide pick lists of all source/destination codes used so far.

Pick Picks the matching symbol from the active drawing.

OK+ Update Destination Saves changes and updates the related destination symbols with any changes.
Update wire signal and stand-alone cross-reference

There may be times that you need to update your source or destination signals singly, drawing-wide, or project-wide. This utility updates cross-reference information for two types of cross-reference symbols: wire number signal arrow symbols and stand-alone cross-reference symbols.

Access:

- Click the arrow on the Source/Destination Signals tool to access the Update Signal References tool.
- From the Wires menu, select Signal References ➤ Update Signal References.

Wire Signals

- **Update source/destination cross-references**
  Updates the from/to cross-reference annotation on each wire network source and destination arrow symbol.

- **Update source/destination wire number tags**
  Makes the wire number tags on the destination end match the wire number carried on the source end of each wire signal pair.

Stand-Alone Cross-Reference Symbols

Set up the desired cross-reference format in the Cross-Reference Format section of the Drawing Properties ➤ Cross-Reference dialog box. This is on a per-drawing basis.

- **Update stand-alone cross-reference symbols**
  Updates the cross-reference annotation between pairs of stand-alone cross-reference symbols. These are wire number signal symbols, but without a WIRENO attribute and do not attach to wires. They can float. Insert these from the schematic Insert Component ➤ Component Miscellaneous dialog box.
Change cross-reference visibility

This tool changes the visibility of the cross-reference XREF attribute. In most cases the cross-referencing should be visible but there are times when you may not want the cross-referencing displayed on parent symbols.

1. Click the arrow on the Component Cross-Referencing tool to access the Hide/Unhide Cross-Reference tool.

2. Click the Hide/Unhide Cross-Referencing tool.

3. Select the objects whose cross-referencing you want to hide or display. Single selection, window selection or multiple selection is allowed.

4. Right-click to end the selection and apply the command.

Insert a dashed link line

This tool draws a smart dashed line between stacked contacts of a multicontact component. When the dashed link line inserts, the TAG2 and DESC attributes of the 2nd through nth components you select for linking automatically flip to invisible. Use the Attribute Hide command to turn the visibility of the selected attributes back on.
1 Click the Link Components with Dashed Lines tool.

2 Select the contacts in the order you want the dashed link line drawn.

AutoCAD Electrical changes the contact's annotation to invisible and draws a dashed link line from the bottom of the upper contact to the top of the new contact. The line is a polyline drawn on the layer name defined on the Define Layers dialog box.

3 (Optional) Use the AutoCAD Layer command to assign a different line type to the layer.

4 (Optional) Use the Scoot command to reposition any jog in the dashed link line.

5 (Optional) To remove a dashed link line, run the command again, selecting in the same order as before. The dashed line toggles off and the hidden attribute annotation reappears.

### Overview of cross-reference settings

Cross-reference settings are supported at the project, drawing, and component level.

- **Project Cross-Reference Settings**: Settings are maintained inside of the project definition file (.wdp). Once settings are created for the project, AutoCAD Electrical applies those settings to new, existing, and copied drawings inside of the project. Ultimately cross-reference settings are written to the drawing file's WD_M block to be used during normal operations.

- **Drawing Cross-Reference Settings**: Settings are maintained on the drawing's WD_M block. When the cross-reference command is run,
AutoCAD Electrical uses the drawing settings to determine the cross-reference types. During program run-time, the cross-reference command looks at the WD_M block as the definition for all referencing on the drawing.

**Component Cross-Reference Settings**

Settings are maintained at the component to override the drawing's WD_M block settings. During program run-time the cross-reference command first looks to the component definition prior to the WD_M block as the definition for referencing the component on the drawing.

During normal operation of cross-referencing commands, AutoCAD Electrical looks to the component for its settings information prior to using the drawing settings. If the component has settings defined, those are used. In the event that there are both component and drawing cross-reference settings on the same drawing, the component settings are used where applied and the drawing settings are used for the rest of the components.

**Set cross-referencing display**

Cross-reference settings are supported at the project, drawing, and component level. Changes you make to the settings are automatically updated in real time.
To set display settings for a specific component that are different than the drawing, use the Copy/Add Component Override tool.

1. Click the Project Manager tool.

2. In the Project Manager, right-click the project or drawing name, and select Properties.

   **NOTE** Selecting the project applies changes to the project definition file and not the drawing. You must later apply the settings to drawings to see display changes.

3. Click the Cross-References tab. In the Component Cross-Reference Display section, select Text, Graphical, or Table Format and click Setup.

   - **Text Format:** Displays cross-referencing as text with any user-defined string as a separator between references on the same attribute.
   - **Graphical Format:** Displays cross-referencing using the AutoCAD Electrical graphical font or using contact mapping edit boxes while displaying each reference on a new line.
   - **Table Format:** Displays cross-referencing in a table object so you can define the columns to display.

4. Specify the format for the cross-reference display.
   The Preview box displays an image that shows an example of the cross-referencing format being defined.

5. Select the display options.

   **TIP** See the Reference topics for each cross-reference display format to learn about the various display options.

6. If you selected to use the Table Format style, specify the table style and table title. Select a table style from the list. The list initially displays table styles from the active drawing and from the table styles drawing. Click Browse to select a drawing with the desired table style. Once selected, the table style is applied to the Table Styles drawing.
To set the table title, select the allowable replaceable parameter entry from the selection list, enter the replaceable parameter to use, or enter text for the table title.

7 Click OK.

If you selected to use the Table Format style, the table location is based on the cross reference attribute position, but you can move the table to any location on the drawing and the table will remain in the new position for that symbol.

**Cross-reference component override**

You can define components to have different cross-referencing styles. The settings specified using this tool override the drawing properties. Component overrides are copied when the component is copied; similarly they are applied to multiple inserts of the same component.

**Access:**

Click the arrow on the Component Cross-Reference tool to access the Copy/Add Component Override tool.

From the Components menu, select Cross-Reference ➤ Copy/Add Component Override.

**NOTE** You can also access this by selecting Components ➤ Insert Component. Select the component type to insert and specify the insertion point on the drawing. In the Insert/Edit Component dialog box, Cross-Reference section, select Component override and click Setup.

Select the component with settings to copy or override.

**Cross-Reference Format**

Defines the cross-reference annotation format. One replaceable parameter, %N, must always be part of the cross-reference format string. A typical format string might be just the %N parameter. Use the upper section for on-drawing references and the bottom section for off-drawing references. You can use the same format for both.
NOTE If your format includes the sheet number %S parameter or the drawing number %D parameter, you must enter the values in the edit boxes in Sheet Values section of the Drawing Properties ➤ Drawing Settings dialog box.

Component Cross-Reference Display

There are different styles of cross referencing AutoCAD Electrical supports:

- **Text Format**: Displays cross-referencing as text with any user-defined string as a separator between references on the same attribute.

- **Graphical Format**: Displays cross-referencing using the AutoCAD Electrical graphical font or contact mapping edit boxes while displaying each reference on a new line.

- **Table Format**: Displays cross-referencing in a table object, that automatically gets updated in real time, while allowing you to define the columns to display.

Click Setup to display a dialog box for setting the display defaults for each component cross-reference display format.

**Remove component overrides**

You can apply overrides to a component so its settings override those of the drawing or project. Use this tool to remove the component overrides so the cross-referencing commands use the settings for the drawing or project.

**Access:**

Click the arrow on the Component Cross-Reference tool to access the Remove Component Override tool.

From the Components menu, select Cross-Reference ➤ Remove Component Override.

Select to remove the component overrides on the project, active drawing, or selected components on the drawing.
Project and Active drawing (all) remove overrides on all components on the drawings while Active drawing (pick) removes overrides for selected components only.

**Text cross-reference format setup**

This format displays cross-referencing as text with any user-defined string as a separator between references on the same cross-reference attribute.

**NOTE** Mtext cross-referencing can still be used on selected components that use text cross-referencing.

**Access:**

Click the Project Manager tool. In the Project Manager, right-click the project or drawing name and select Properties. Click the Cross-References tab. In the component Cross-Reference Display section, select Text Format, and click Setup.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the project or drawing name and select Properties. Click the Cross-References tab. In the component Cross-Reference Display section, select Text Format, and click Setup.

**NOTE** You can also access this by selecting Components ➤ Insert Component. Select the component type to insert and specify the insertion point on the drawing. In the Insert/Edit Component dialog box, Cross-Reference section, select Component override and click Setup. In the Cross-reference component override dialog box, select Text Format, and click Setup.

**Format**

The Reference Separator edit box allows you to define any string as a separator between references on the same attribute. Spaces are allowed. The default separator is a comma. Use "" anywhere in the edit box to change the XREF attribute to multi-line text and add a carriage return after each reference. The separator value is applied to the drawing settings in the WD_M block definition or the component to override the drawing settings.

When there are 2 or more references on the same cross-reference attribute each reference is separated by the specified separator. If you use a comma as the separator the references would look like this:

NO 412,633

NO 20.3,21.3
**Preview**

Displays an image that shows an example of the cross-referencing format being defined.

**Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Unused Children (Contacts)</td>
<td>Displays the child symbols that are not referenced or being used in the project pin list.</td>
</tr>
<tr>
<td>Separate Reference</td>
<td>Displays each unused child symbol in its own reference.</td>
</tr>
<tr>
<td>Contact Count Totals</td>
<td>Displays the total count of all unused child symbols in a single reference.</td>
</tr>
<tr>
<td>Fill Reference With</td>
<td>Specifies what should be displayed in the unused reference position for both Separate and Contact Count options. If left empty, a space appears where the referencing would be displayed. For example if you enter the text &quot;SP&quot; for spares, &quot;SP&quot; displays in the referencing.</td>
</tr>
<tr>
<td>Cross-Referencing Sorted by Line Reference</td>
<td>Displays the referencing in the order that the contacts are found in the project’s line reference.</td>
</tr>
<tr>
<td>Cross-Referencing Sorted by Pin List Order</td>
<td>Displays the referencing in the order that the Pin List is defined on the parent component. This is sorted regardless if the pins are displayed as part of the referencing.</td>
</tr>
</tbody>
</table>

**Overview of graphical cross-reference formats**

When you select to use the graphical cross-reference format style, the preview image changes to show you an example of what the cross-reference may look like in the drawing. Below are examples of the graphical cross-reference format.

**Graphic Font Format:**
Displays the cross-reference format using a graphical font. Select to use the JIC font or the IEC/GB/JIS font. The setting is applied to the graphical font regardless of the tagging mode assigned in the project properties. This setting is taken from drawing properties if there are no cross-reference overrides specified on the inserted component.

The following example displays cross-referencing next to the symbol in the graphic font format while the unused children (contacts) are displayed as separate references. The Fill Reference With value is “SP.”

Contact Mapping Format:

Overview of graphical cross-reference formats | 369
Displays the cross-reference format using cross-referencing type values (NO, NC, NONC).

Graphical cross-reference format setup

This format displays cross-referencing using the AutoCAD Electrical graphical font or using contact mapping edit boxes while displaying each reference on a new line.

Access:

- Click the Project Manager tool. In the Project Manager, right-click the project or drawing name and select Properties. Click the Cross-References tab. In the component Cross-Reference Display section, select Graphical Format, and click Setup.
- From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the project or drawing name, and select Properties. Click the Cross-References tab. In the component Cross-Reference Display section, select Graphical Format, and click Setup.

NOTE You can also access this by selecting Components ➤ Insert Component. Select the component type to insert and specify the insertion point on the drawing. In the Insert/Edit Component dialog box, Cross-Reference section, select Component override, and click Setup. In the Cross-reference component override dialog box, select Graphical Format, and click Setup.
Format

In the event where there are 2 or more references for the same component, each reference is entered into a new line.

Graphic Font
Displays the cross-reference format using a graphical font. Select to use the JIC font or the IEC font. The setting is applied to the graphical font regardless of the tagging mode assigned in the project properties.

The JIC image font style displays the cross-referencing using the JIC style normally open, normally close, and Form C contact types.

The IEC/GB/JIS image font style displays the cross-referencing using the IEC style normally open, normally close, and Form C contact types.

Contact Mapping
Displays the cross-reference format using cross-referencing type values (NO, NC, NONC). Enter the format into the edit boxes.

Preview
Displays an image that shows an example of the cross-referencing format being defined.

Options

Display Unused Children (Contacts)
Displays the child symbols that are not referenced or being used in the project pin list.

Separate Reference
Displays each unused child symbol in its own reference. This is dependent on pin list count.

Contact Count Totals
Displays the total count of all unused child symbols in a single reference.

Fill Reference With
Specifies what should be displayed in the unused reference position for both Separate and Contact

Overview of graphical cross-reference formats | 371
Overview of table cross-reference formats

When you select to use the table cross-reference format style, the preview image changes to show you an example of what the cross-reference may look like in the drawing. Below are examples of the table cross-reference format.

Graphic Font Format:

Displays the cross-reference format using a graphical font. Select to use the JIC font or the IEC font. The setting is applied to the graphical font regardless of the tagging mode assigned in the project properties.

The following examples display the table cross-referencing using the graphic font format inside the table style. The Fill Reference With value is "SP" for unused children (contacts).

Contact Mapping Format:
Displays the cross-reference format using cross-referencing type values (NO, NC, NONC).

**Form C contacts and tables**

A typical type of contact is a Form C contact type which is comprised of 2 contacts; 1 open and 1 closed where they share a common terminal pin number. You can choose to display both of the Form C contacts as 2 individual symbols, or together as one symbol.

**Example where 2 symbols make up the Form C contact**

The common pin is on the right-hand side next to the referencing column and displays in the P2 column of the table.
Example where a single symbol makes up the Form C contact

The common pin is on the right-hand side next to the referencing column and displays in the P2 column of the table.

**Table cross-reference format setup**

This format displays cross-referencing in a table object that automatically gets updated in real time, so you can define the columns to display. To display component cross-referencing in a table, you must select a predefined table style and define the column labels to display.

If new contacts are added to the component, the cross-referencing table automatically updates. The table location is based on cross-reference attributes, but you can move the table to any location on the drawing and the table remains in the new position.

**NOTE** If you change the table setup once a table has been inserted onto the drawing, you must run the Component Cross-Reference tool to update the table.

**Access:**

Click the Project Manager tool. In the Project Manager, right-click the project or drawing name, and select Properties. Click the Cross-References tab. In the component Cross-Reference Display section, select Table Format, and click Setup.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the project or drawing name, and select Properties. Click
Access:

the Cross-References tab. In the component Cross-Reference Display section, select Table Format, and click Setup.

**NOTE** You can also access this by selecting Components ➤ Insert Component. Select the component type to insert and specify the insertion point on the drawing. In the Insert/Edit Component dialog box, Cross-Reference section, select Component override, and click Setup. In the Cross-reference component override dialog box, select Table Format, and click Setup.

**Format**

**Graphic Font**

Displays the cross-reference format using a graphical font. Select to use the JIC font or the IEC/GB/JIS font. The setting is applied to the graphical font regardless of the tagging mode assigned in the project properties.

- The JIC image font style displays the cross-referencing using the JIC style normally open, normally close, and Form C contact types.

- The IEC/GB/JIS image font style displays the cross-referencing using the IEC style normally open, normally close, and Form C contact types.

**Contact Mapping**

Displays the cross-reference format using cross-referencing type values (NO, NC, NONC). Enter the format into the edit boxes.

See [Learn about table cross-reference formats](#) (page 368) for examples of the format styles.

**Preview**

Displays an image that shows an example of the cross-referencing format being defined.
Options

Display Parent (Coil) Displays the parent component's reference information inside the cross-reference format.

Display Unused Children (Contacts) Displays the child symbols that are not referenced or being used in the project pin list.

Separate Reference Displays each unused child symbol in its own reference.

Contact Count Totals Displays the total count of all unused child symbols in a single reference.

Fill Reference With Specifies what should be displayed in the unused reference position for both Separate and Contact Count options. If left empty, a space appears where the referencing would be displayed. For example if you enter the text "SP" for spares, "SP" displays in the referencing.

Table Style

Table styles are defined within a drawing file to determine the size, shape, style, and font of a table object. There is always a table style on a drawing. The standard table style cannot be deleted. Various style drawing files that determine the drawing-related settings are provided with AutoCAD Electrical. The Table Styles drawing (TableStyle.dwg) defines a series of table objects that are used in the selection process and then copied to the drawing files.

Select a table style from the list. The list initially displays table styles from the active drawing and the TableStyle.dwg. Click Browse to select a drawing with the desired table style. Once selected, the table style can be applied to the Table Styles drawing. If the selected style does not exist on the TableStyle.dwg it will be copied to it. When a drawing is referenced the style is then copied from the TableStyle.dwg.

Click Define Columns to open the Cross-Reference Table Data Fields to Display dialog box to define the columns to be used in the table cross-referencing.
**Table Title**

Controls the replaceable parameters and carriage returns. Select the allowable replaceable parameter entry from the selection list, enter the replaceable parameter to use, or enter text for the table title. Add a carriage return inside of the string by using "|" anywhere in the Table Title edit box.

**NOTE** If the replaceable parameter does not include a value from the drawing, a blank space is displayed in the table title. If the title line is left blank, the table will not show the title row.

**Update cross-reference tables**

The table style cross-referencing provides support for replaceable parameters to be defined and displayed in the table title. Some AutoCAD Electrical commands take this into account when modifications are made to the drawing and the cross-reference table is subsequently updated.

- **Delete Component**: If a component with a cross-reference table is deleted, the table is also deleted from the drawing.

- **Component Retag**: If a component is retagged (retag, move component, move circuit, edit component) the cross-reference table updates if the tag is part of the title.

- **Edit Component**: If a replaceable parameter is modified for a component that has a cross-reference table, the table title updates to reflect the changes.

- **Copy Catalog Assignment**: When copying a different catalog number to a parent symbol, the PNLST and contact count may update and the cross-reference table updates in real-time.

- **IEC Tagging Mode**: If IEC drawing-wide Location or Installation values change, the cross-reference table title updates to reflect the changes.

- **Copy Circuit**: If a circuit with a cross-reference table is copied, the table title updates with the new tag values.
**Insert Component**
If inserting a parent component with a cross-reference table, the table inserts at the cross-reference attribute locations (XREF and XREFNO). If inserting a child component, the cross-reference table updates for the parent component.

**Scoot**
If scooting a parent component with a cross-reference table, the table also scoots along the wire.

**NOTE**
If you change the component catalog number or add a multiple BOM catalog number to the component (both change the Pin List data) the cross-reference table updates as soon as you exit out of the Insert/Edit Component dialog box. Additionally, if you modify the Pin List manually on the parent component, the cross-reference table updates with the new pin numbers and the modified contact count once the Insert/Edit Component dialog box is exited.

**Commands that do not support real-time cross-reference updates include:**
- Component Find and Replace
- Spreadsheet Export and Import

**Set cross-referencing display**
Cross-reference settings are supported at the project, drawing, and component level. Changes you make to the settings are automatically updated in real time.
TIP To set display settings for a specific component that are different than the drawing, use the Copy/Add Component Override tool.

1 Click the Project Manager tool.

2 In the Project Manager, right-click the project or drawing name, and select Properties.

NOTE Selecting the project applies changes to the project definition file and not the drawing. You must later apply the settings to drawings to see display changes.

3 Click the Cross-References tab. In the Component Cross-Reference Display section, select Text, Graphical, or Table Format and click Setup.
   ■ Text Format: Displays cross-referencing as text with any user-defined string as a separator between references on the same attribute.
   ■ Graphical Format: Displays cross-referencing using the AutoCAD Electrical graphical font or using contact mapping edit boxes while displaying each reference on a new line.
   ■ Table Format: Displays cross-referencing in a table object so you can define the columns to display.

4 Specify the format for the cross-reference display.
   The Preview box displays an image that shows an example of the cross-referencing format being defined.

5 Select the display options.

TIP See the Reference topics for each cross-reference display format to learn about the various display options.

6 If you selected to use the Table Format style, specify the table style and table title. Select a table style from the list. The list initially displays table styles from the active drawing and from the table styles drawing. Click Browse to select a drawing with the desired table style. Once selected, the table style is applied to the Table Styles drawing.
To set the table title, select the allowable replaceable parameter entry from the selection list, enter the replaceable parameter to use, or enter text for the table title.

7 Click OK.

If you selected to use the Table Format style, the table location is based on the cross reference attribute position, but you can move the table to any location on the drawing and the table will remain in the new position for that symbol.

**Table cross-reference format setup**

This format displays cross-referencing in a table object that automatically gets updated in real time, so you can define the columns to display. To display component cross-referencing in a table, you must select a predefined table style and define the column labels to display.

If new contacts are added to the component, the cross-referencing table automatically updates. The table location is based on cross-reference attributes, but you can move the table to any location on the drawing and the table remains in the new position.

**NOTE** If you change the table setup once a table has been inserted onto the drawing, you must run the Component Cross-Reference tool to update the table.

**Access:**

- Click the Project Manager tool. In the Project Manager, right-click the project or drawing name, and select Properties. Click the Cross-References tab. In the component Cross-Reference Display section, select Table Format, and click Setup.

- From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the project or drawing name, and select Properties. Click the Cross-References tab. In the component Cross-Reference Display section, select Table Format, and click Setup.

**NOTE** You can also access this by selecting Components ➤ Insert Component. Select the component type to insert and specify the insertion point on the drawing. In the Insert/Edit Component dialog box, Cross-Reference section, select Component override, and click Setup. In the Cross-reference component override dialog box, select Table Format, and click Setup.
Format

Graphic Font
Displays the cross-reference format using a graphical font. Select to use the JIC font or the IEC/GB/JIS font. The setting is applied to the graphical font regardless of the tagging mode assigned in the project properties.

The JIC image font style displays the cross-referencing using the JIC style normally open, normally close, and Form C contact types.

The IEC/GB/JIS image font style displays the cross-referencing using the IEC style normally open, normally close, and Form C contact types.

Contact Mapping
Displays the cross-reference format using cross-referencing type values (NO, NC, NONC). Enter the format into the edit boxes.

See Learn about table cross-reference formats (page 368) for examples of the format styles.

Preview
Displays an image that shows an example of the cross-referencing format being defined.

Options

Display Parent (Coil)
Displays the parent component’s reference information inside the cross-reference format.

Display Unused Children (Contacts)
Displays the child symbols that are not referenced or being used in the project pin list.

Separate Reference
Displays each unused child symbol in its own reference.
Contact Count Totals
Displays the total count of all unused child symbols in a single reference.

Fill Reference With
Specifies what should be displayed in the unused reference position for both Separate and Contact Count options. If left empty, a space appears where the referencing would be displayed. For example if you enter the text "SP" for spares, "SP" displays in the referencing.

Table Style
Table styles are defined within a drawing file to determine the size, shape, style, and font of a table object. There is always a table style on a drawing. The standard table style cannot be deleted. Various style drawing files that determine the drawing-related settings are provided with AutoCAD Electrical. The Table Styles drawing (TableStyle.dwg) defines a series of table objects that are used in the selection process and then copied to the drawing files.

Select a table style from the list. The list initially displays table styles from the active drawing and the TableStyle.dwg. Click Browse to select a drawing with the desired table style. Once selected, the table style can be applied to the Table Styles drawing. If the selected style does not exist on the TableStyle.dwg it will be copied to it. When a drawing is referenced the style is then copied from the TableStyle.dwg.

Click Define Columns to open the Cross-Reference Table Data Fields to Display dialog box to define the columns to be used in the table cross-referencing.

Table Title
Controls the replaceable parameters and carriage returns. Select the allowable replaceable parameter entry from the selection list, enter the replaceable parameter to use, or enter text for the table title. Add a carriage return inside of the string by using "|" anywhere in the Table Title edit box.

NOTE If the replaceable parameter does not include a value from the drawing, a blank space is displayed in the table title. If the title line is left blank, the table will not show the title row.
Use cross-reference exception reports

The AutoCAD Electrical Component Cross-reference tool creates two text reports in the process of annotating components with cross-reference information. The Cross-reference report gives a listing of each component and quantity and locations of child contacts. The Exception/Error report lists the exceptions AutoCAD Electrical found as it processed the drawing or drawing set. Exceptions include child contact with no parent and parent relay coil with no child contacts found.

Surfing on Cross-Reference Exception reports

Click Surf on the Error/Exception Report dialog box. AutoCAD Electrical flips into surfer mode. Double-click any listed error/exception entry in the Surf dialog box. AutoCAD Electrical immediately surfs to the appropriate drawing and zooms up on the offending contact. Click Edit to correct the error, and then surf to the next one.

Component cross-reference

Cross-referencing is based upon collecting and annotating groups of components that carry the same TAG text string value (such as "101CR"). Components do not have to be of the same family to be cross-referenced; they just need to have the same TAG1/TAG2/TAG_*/TAG attribute values.

Access:

Click the arrow on the Parent/Child Cross-Reference tool to access the Component Cross-Reference tool.

From the Components menu, select Cross-Reference ➤ Component Cross-Reference.

Cross-reference data is annotated on to attributes "XREFNO" and "XREFNC" for N.O and N.C. references respectively. Alternately, if attribute XREF is present, both N.O. and N.C. references are combined into a single cross-reference text string.

Run Cross-Reference on
Specifications to run the report on selected components, the current drawing, or the entire project.

Cross-reference
Displays the last Cross-Reference report.

Exception
Displays the last Exception/Error report.
Using other dialog boxes to set cross-reference options

- The cross-reference format is set up on the Drawing Properties ➤ Cross-Reference dialog box. This is on a per-drawing basis and can include sheet and drawing ID, line or grid-reference location, and fixed punctuation.

- A project-wide option to fill unused contact references with a user defined text string is available using the Projects ➤ Project ➤ Project Manager tool. Right-click the project name and select Properties. In the Project Properties ➤ Cross-References dialog box, Component Cross-Reference Display section, select Text Format and click Setup.

- Real-time cross-reference update can be turned on or off on the Project Properties ➤ Cross-References dialog box.

Use circuitry

You can save groupings of components, wires, ladders, and other entities as circuits. Similar to blocks, saved circuits are inserted as a single object. Saved circuits save time when your projects require common arrangements of components, such as motor starters or control circuits.

When you use any of the AutoCAD Electrical Insert Circuit commands to insert a circuit, the circuit explodes. Wire numbers and component tags are updated according to the current drawing’s tag settings; however fixed tags are not updated.
Copy circuitry

This tool copies existing circuits and pastes the copied circuit to a specified location. The components are automatically retagged based on their new line reference locations.

1. Click the arrow on the Insert Circuit tool to access the Copy Circuit tool.
2. Click the Copy Circuit tool.
3. Select the components and wires to copy. Carefully window (from left to right) around the circuit, making sure to capture the connection wires and dots that tie in to the vertical bus.
4. Press Enter.
5. (Optional) Press M to make multiple copies of the selected circuit.
6. Select the base point and then the second point for the copy.

**NOTE** If the circuit you copied contains any fixed wire numbers or component tags, specify to keep them, blank them out, retag all of the found tags, or keep all orphan contacts.

Move circuitry

This tool moves the selected circuit to a specified location. The components are automatically retagged based on their new line reference locations and cross-references are updated.

1. Click the arrow on the Insert Circuit tool to access the Move Circuit tool.
2. Click the Move Circuit tool.
3. Select the circuit to move. Carefully window (from left to right) around the circuit, making sure to capture the connection
wires and dots that tie in to the vertical bus.

4  Press Enter.

5  Select the base point, and then the second point for the move.

**Save circuit portions for later use**

Use this tool to save circuit portions for later use.

**NOTE** You can also use the AutoCAD WBLOCK command to save circuits to disk and then use the Insert Wblocked Circuit tool to insert the circuit.

1  Zoom around the circuit to save so that it fills your screen.
2 Click the arrow on the Insert Circuit tool to access the Save Circuit to Icon Menu tool.

3 Click the Save Circuit to Icon Menu tool.

4 On the Save Circuit to Icon Menu dialog box, right-click in the Symbol Preview window and select Add icon ➤ New circuit.

**NOTE** You can also click the arrow on the Add tab and select New circuit.

5 On the Create New Circuit dialog box, specify:
   - Name of the icon.
   - Image file to use. Make sure to select Create PNG from current screen image.
   - Circuit drawing file name.

**NOTE** If you didn’t zoom in on the circuit in Step 1 above, you can click Zoom on the Create New Circuit dialog box to zoom around the circuit to save.

6 Click OK.

7 Select the circuit’s insertion base point.

8 Window around the circuit (from left to right), capturing all of the appropriate components and wiring and press Enter. AutoCAD Electrical processes the circuit and saves it to your AutoCAD Electrical user subdirectory.

**NOTE** You can overwrite the user subdirectory using the wd_usercktdir setting in the environment (.env) file. For example, if wd_usercktdir is enabled and set to “N:\Electrical\Circuits”, the new circuit and image file are saved to N:\Electrical\Circuits.

AutoCAD Electrical creates and adds a new circuit icon (.png) of your circuit to the bottom of the symbol preview window.
**Add existing circuits to the icon menu**

Use the Save Circuit to Icon Menu tool to add existing circuits to the icon menu. You can then select the circuit from the Insert Component dialog box for insertion into a drawing.

1. Click the arrow on the Insert Circuit tool to access the Save Circuit to Icon Menu tool.

2. Click the Save Circuit to Icon Menu tool.

3. On the Save Circuit to Icon Menu dialog box, right-click in the Symbol Preview window and select Add icon ➤ Add circuit.

   **NOTE** You can also click the arrow on the Add tab and select Add circuit.

4. On the Add Existing Circuit dialog box, specify:
   - Name of the icon.
   - Image file to use. Make sure to select Create PNG from current screen image.
   - Existing circuit name.

5. Click OK.
   The existing circuit is added to the bottom of the symbol preview window.

**Insert circuits**

You can insert circuits you saved using the Save Circuit to Icon Menu tool or circuits that you saved using AutoCAD's WBLOCK command. After you specify an insertion point, the circuit inserts and the component tags update. You can then edit the component tags, run the wire numbering tool, or add or delete components and wiring. This circuit behaves as if you had drawn it by hand, one component and one wire at a time.
Insert a saved circuit

1 Click the arrow on the Insert Circuit tool to access the Insert Saved Circuit tool.

2 Click the Insert Saved Circuit tool.

3 On the Insert Component dialog box, select the circuit you want to insert into the drawing from the Symbol Preview window.

4 Click OK.

5 On the Circuit Scale dialog box, click OK to use the defaults or specify a scale and then click OK.

6 Specify the insertion point on the drawing.

Insert a WBlocked circuit

1 Click the arrow on the Insert Circuit tool to access the Insert WBlocked Circuit tool.

2 Click the Insert WBlocked Circuit tool.

3 On the Insert WBlocked Circuit dialog box, select the circuit you want to insert into the drawing and click Open.

4 On the Circuit Scale dialog box, click OK to use the defaults or specify a scale and then click OK.

5 Specify the insertion point on the drawing.

Insert component

This icon menu can be modified, expanded, or replaced with your own custom menu. You can change the default icon menu using the Library and Icon Menu Paths section of the Project Properties ➤ Project Settings dialog box.
Select Projects ➤ Project ➤ Project Manager. Right-click the project name and select Properties. Use the Icon Menu Wizard to easily modify the menu. The default icon menu can also be redefined in "wd.env." Add entry "WD_MENU" for schematic icon menu and "WD_PMENU" for panel layout icon menu.

Access:

Click the Insert Component tool or the Multiple Insert Component tool.
Click Components ➤ Insert Component or Components ➤ Multiple Insert ➤ Multiple Insert (Icon Menu).

NOTE This dialog box is also accessed when inserting Pneumatic, Hydraulic, or P&ID components; in-line wire labels; stand-alone cross-reference symbols; cable markers; and saved circuits.

Select an icon picture or the component type from the Menu tree structure. The main menu in the tree structure is displayed as the menu heading just above the menu tree structure.

Tabs
- Menu: Changes the visibility of the Menu tree view.
- Up one level: Displays the menu that is one level before the current menu in the Menu tree view. This is unavailable if the main menu is selected in the Menu tree view.
- Views: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.

Menu
The tree structure is created by reading the icon menu file (*.dat). The tree structure is based on the arrangement order of submenus defined in the .dat file.

Symbol Preview window
Displays the symbol and submenu icons corresponding to the menu or the submenu selected in the Menu tree structure.
Clicking on the icon performs one of the following functions based on the icon properties as defined by the *.dat file:

- Inserts the symbol or circuit onto the drawing
- Executes a command
- Displays a submenu

**NOTE** When you move the cursor over an icon, the icon name and block/circuit/command name display as tooltip information.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Recently Used</strong></td>
<td>Displays the last components inserted during the current editing session; the most recently used icon displays in the top. This list follows the view options setting in the symbol preview window (icon only, icon with text or list view) and the total number of icons displayed depends on the value specified in the Display edit box.</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>Specifies the number of icons to display in the Recently Used list box. Enter integer numbers only; the default value is 10.</td>
</tr>
<tr>
<td><strong>Vertical/Horizontal</strong></td>
<td>Inserts the icon using a vertical or horizontal orientation. This is opposite the drawing’s default ladder rung orientation.</td>
</tr>
<tr>
<td><strong>No edit dialog</strong></td>
<td>Turns off the Insert/Edit Component dialog box when inserting symbols onto the drawing. To add component detail later, click the Edit Component tool, and select the component to edit.</td>
</tr>
<tr>
<td><strong>No tag</strong></td>
<td>Inserts the component, un-tagged (i.e. without assigning a unique Component Tag). The untagged value that displays is the component’s TAG1/TAG2 default value. To add component detail later, click the Edit Component tool, and select the component to edit.</td>
</tr>
<tr>
<td><strong>Always display previously used menu</strong></td>
<td>Indicates to display the previously used menu each time you open the Insert Component dialog box. For example, if you insert a push button from the Push Buttons menu, the next time you open the Insert Component dialog box the Push Button menu displays by default.</td>
</tr>
</tbody>
</table>
Specifies the component block insertion scale. This defaults to the value set in the Drawing Properties ➤ Drawing Format dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.

Scale panel

Specifies the footprint insertion scale. This defaults to the value set in the Drawing Properties ➤ Drawing Format dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.

Type it

Manually type in the component block to insert.

Browse

Browses to and selects the component to insert.

Right-click menus

Options for the Menu tree structure view

Right-click on the main menu or submenu in the Menu tree structure view to display the following options:

- Expand/Collapse: Toggles the visibility of the menus.
- Properties: Opens a Properties dialog box to view the existing menu or submenu properties like the menu name, image or submenu title. Use the Icon Menu Wizard to change any menu properties.

Options for the Symbol Preview window

Right-click an icon or in empty space in the Symbol Preview window to display the following options:

- View: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.
- Properties: (available for icons only) Opens a Properties dialog box to view the existing symbol icon properties like the icon name, image, block names and so on. Use the Icon Menu Wizard to change any icon properties.
Pneumatic, Hydraulic and P&ID icon menus

The Menu tree structure displays the symbols for the selected component type (pneumatic, hydraulic or P&ID). The Insert Pneumatic Component, Insert Hydraulic Component and Insert P&ID Component tools are accessed on the Extra Library toolbar.

Insert Pneumatic Component

Insert Hydraulic Component

Insert P&ID Component

Save circuit to icon menu

You can save windowed portions of circuitry for later reuse. Up to 24 circuits can be saved at any one time in this scratch menu. You can change the user circuit menu number (default is 19) by editing this command in the CUI editor.

**TIP** To get a good icon picture for the circuit button, zoom in close to the circuit you plan to save so that it fills the screen.

Access:

Click the arrow on the Insert Circuit tool to access the Save Circuit to Icon Menu tool.

Click Components ➤ Save Circuit to Icon Menu.

Menu

The tree structure is created by reading the icon menu file (*.dat). The tree structure is based on the arrangement order of submenus defined in the .dat file.
Tabs

- Menu: Changes the visibility of the Menu tree view.
- Up one level: Displays the menu that is one level before the current menu in the Menu tree view.
- Views: Changes the view display for the Symbol Preview window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.
- Add: Modifies the icon menu by adding icons for circuits or a new submenu.

Symbol Preview window

Displays the symbol images corresponding to the menu or the sub-menu selected in the Menu section. You can drag icons within the Symbol Preview window for rearrangement (multiple selection is allowed) such as placing commonly used icons at the top and rarely used icons at the bottom of the window.

Symbol Preview right-click menu

Right-click in empty space in the Symbol Preview window to display the following options:

- View: Changes the view display for the Symbol Preview window. The current view option is marked with a checkmark. Options include: Icon with text, Icon only or List view.
- Add Icon: Adds new circuit icons or an existing circuit into the Symbol Preview window.
- New Submenu: Creates a new submenu in the Symbol Preview window and the tree structure.
- Cut: Removes the selected icon from the Symbol Preview window. You can then paste the icon into the desired submenu.
- Copy: Makes a copy of the highlighted icon and stores it in the Paste clipboard. You can then paste the icon into the desired submenu.
- Paste: Adds the copied or cut icon to the highlighted submenu.
- Delete: Deletes the icon.
Properties: Opens a Properties dialog box to modify the existing symbol icon properties like the icon name, image or block names. The existing data in the *.dat file is overwritten with your changes.

**Circuit scale**

This tool allows you to specify the scale and options for circuit insertion.

**Access:**

- Click the arrow on the Insert Circuit tool to access the Insert Saved Circuit or the Insert WBlocked Circuit tool.
- From the Components menu, select Insert Saved Circuit or Insert WBlocked Circuit.

<table>
<thead>
<tr>
<th>Custom scale</th>
<th>Specifies the insertion scale.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move all lines to wire layers</td>
<td>Moves all non-layer &quot;0&quot; line entities to a valid wire layer.</td>
</tr>
<tr>
<td>Keep all fixed wire numbers</td>
<td>Indicates to not erase wire numbers if they are fixed.</td>
</tr>
<tr>
<td>Keep all source arrows</td>
<td>Indicates to not erase the circuit’s source arrows.</td>
</tr>
<tr>
<td>Update circuit’s text layers as required</td>
<td>Updates the circuit’s layers per AutoCAD Electrical assignment.</td>
</tr>
<tr>
<td>Don’t blank out orphan contacts</td>
<td>Leaves the tag ID alone if parent is not found.</td>
</tr>
</tbody>
</table>
Define wire jumpers

You can create internal jumpers on a selected component using the Add/Edit Internal Jumper tool. When wire numbers are inserted using AutoCAD Electrical, these internal jumpers are read and wire numbers are assigned accordingly.

If you select to jumper two pins on a component together, an alert displays indicating that internal jumpering will cause a conflict with the existing wire number assignments. If you click Continue, an internal jumper inserts between the two pins on the component; you need to rerun the Insert Wire Numbers tool to reconcile these two different wire numbers now jumpered together. If you click Cancel, the internal jumper data is not inserted.

**NOTE** You can keep jumpers from displaying in Wire From/To reports by placing the jumpers on a layer that contains the substring "JUMPER."

Add wire jumpers from a list

1. Select Components ➤ Component Miscellaneous ➤ Add/Edit Internal Jumper.
2. Select terminals from the list.
   Drag your mouse to select contiguous terminals or use the CTRL button to select noncontiguous terminals.
3. Click Add.

Add wire jumpers by picking

1. Select Components ➤ Component Miscellaneous ➤ Add/Edit Internal Jumper.
2. Click Pick. The dialog closes. You can select as many terminals as you want.
   Try to select as near the terminal as you can since AutoCAD Electrical finds the closest connection terminal to your selected point.
3 After you select the terminals, press Enter and the dialog displays. Notice that the selected terminals are highlighted in the list.

4 Click Add to finish defining the jumper.

**Change an existing jumper assignment**

1 Select Components ➤ Component Miscellaneous ➤ Add/Edit Internal Jumper.

2 Select the terminal from the list on the right. Once selected, the terminals that are part of this jumper assignment are highlighted on the terminal list.

3 Reselect the terminals to be jumpered, using the Shift and CTRL keys as needed.

4 Click Update once the appropriate terminals are highlighted.

**Wire jumpers**

You can add, change, or delete internal jumpers on a selected component. When wire numbers are inserted, these internal jumpers are read and wire numbers are assigned accordingly.

If you select to jumper two pins on a component together, an alert displays indicating that internal jumpering will cause a conflict with the existing wire number assignments. If you click Continue, an internal jumper inserts between the two pins on the component; you need to rerun the Insert Wire Numbers tool to reconcile these two different wire numbers now jumpered together. If you click Cancel, the internal jumper data is not inserted.

**Access:**

Click the arrow on the Edit Component tool to access the Add/Edit Internal Jumper tool.

Click Components ➤ Component Miscellaneous ➤ Add/Edit Internal Jumper.

**Add** Adds an internal jumper assignment.

**Update** Changes an existing jumper assignment.
**Delete**  
Removes the selected jumper assignment from the list.

**Pick**  
Selects the terminals to add to a jumper assignment. Try to select as close to the terminal as you can. AutoCAD Electrical finds the closest connection terminal to your selected point.

**Show Jumpers**  
Displays the current jumper assignments. AutoCAD Electrical draws temporary lines between the jumpered terminals. These graphics disappear the next time you do a Regen.
Component Attribute Tools

In this chapter

- Edit attribute values
- Force attributes to layers
- Manipulate component text
- Manipulate terminal text
- Move description values
- Manipulate Attributes
- Set tags to fixed
- Retag components
- Change to multi-line text
- Add location codes
- Update child codes
- Location Mark Symbols
- Location box
- Change attribute justification
- Change attribute text style
- Change attribute text size
- Modify library symbols
- Add attributes to blocks
Edit attribute values

You can use three different tools to edit a component's information.

**Using the Edit Component tool**

The standard way is to use the regular Edit Component command and edit the tag value from the Insert/Edit Component dialog box.

1. Click the Edit Component tool.
2. Select the component to edit.
3. Edit the tag value in the Insert/Edit Component dialog box.
4. Click OK to complete the edit.

**Using the Edit Selected Attribute tool**

Lets you pick right on the attribute. This tool also works on invisible attributes. It finds and displays the closest attribute to your pick point on a block insert.

1. Click the arrow on the Edit Component tool to access the Edit Selected Attribute tool.
2. Click the Edit Selected Attribute tool.
3. Select the attribute to edit.
   A dialog box displays and lets you type in a new attribute value.
4. Enter a new attribute value in the Edit Attribute dialog box.
   Click Pick to select another attribute whose text you want to use for the selected attribute. You can also click on the arrow keys to increment or decrement the attribute value.
5. Click OK.

To edit an invisible attribute: pick on the block insert near where the invisible attribute is located. AutoCAD Electrical finds and displays your pick point's nearest attribute. AutoCAD Electrical displays an "x" at the attribute's origin.
Using the Move/Show Attribute tool

You can use the AutoCAD Electrical Move/Show Attribute command to edit a component's attribute text.

1 Click the Move/Show Attribute tool.
2 Pick on the component's graphics (not on the attribute text itself; otherwise it flips into Attribute Move mode). If there are no graphics to pick on (such as wire number block/attribute or ladder line reference block/attribute), type "B" and space and then pick on any attribute on the block insert. This forces the command into attribute display mode.

   The Show/Hide Attributes dialog box opens, listing all of the component's attributes and their values.
3 Check the Edit Attributes box in the upper right-hand corner of the dialog box.
4 Select the attribute you want to edit from the list.
   A dialog box opens and lets you type in a new attribute value.
5 Type in a new attribute value in the Edit Attribute dialog box.
   You can click on the arrow keys to increment or decrement the attribute value.
6 Click OK.

**NOTE** You can also use any attribute editing command to edit an AutoCAD Electrical component's attribute values. For example, use the AutoCAD DDATTE command.

**Edit attribute**

This tool lets you edit an attribute's text by picking right on the attribute. A dialog box pops up and you type in a new attribute value. This tool also works
on invisible attributes. It will find and display the closest attribute to your pick point on a block insert.

**Access:**

Click the arrow on the Edit Component tool to access the Edit Selected Attribute tool.

From the Components menu, select Attributes ➤ Edit Selected Attribute.

**Attribute value**

Specifies the attribute text. You can click on the arrow keys to increment or decrement the attribute value.

**Pick**

Selects another attribute whose text you want to use for the selected attribute.
Force attributes to layers

This tool changes the layer assignment for selected attributes.

1. Click the arrow on the Move/Show Attribute tool to access the Change Attribute Layer tool.

2. Click the Change Attribute Layer tool.

3. Specify the target layer:
   - Type the name in the box.
   - Click List to select from a list of layers in the active drawing.
   - Click Wires to change to the layer used for wire numbers on wires. The default layer is WIRENO; this is defined on the WD_M block's WIRENO_LAY attribute.
   - Click Terminals to change to the layer used for wire numbers on terminals and source or destination signal arrows. The default layer is WIREREF; this is defined on the WD_M block's WIREREF_LAY attribute.

4. Click OK.

5. Select the attributes to change to the target layer.

NOTE Windowing of attributes is not supported. You must pick them individually.

Force attribute/text to a different layer

This tool changes the layer assignment for selected attributes.

Access:

Click the arrow on the Move/Show Attribute tool to access the Change Attribute Layer tool.
**Access:**

From the Components menu, select Attributes ➤ Change Attribute Layer.

<table>
<thead>
<tr>
<th>Change to Layer</th>
<th>Specifies the target layer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>List</td>
<td>Lists the layers in the active drawing. Select a layer from this list or enter the layer name in the Change to Layer box.</td>
</tr>
<tr>
<td>Wires</td>
<td>Forces the tool to change to the layer used for wire number text placed on wires. The default layer is WIRENO; this is defined on the WD_M block’s WIRENO_LAY attribute</td>
</tr>
<tr>
<td>Terminals</td>
<td>Forces the tool to change to the layer used for wire number text placed on terminals and source or destination signal arrows. The default layer is WIREREF; this is defined on the WD_M block’s WIREREF_LAY attribute</td>
</tr>
</tbody>
</table>
Find, edit, or replace component text

1. Click the arrow on the Retag Components tool to access the Find/Edit/Replace Component Text tool.

2. Click the Find/Edit/Replace Component Text tool.

3. Choose to process either the current drawing or the project and click OK.
   The drawing or project set is scanned to find all the AutoCAD Electrical components and the current attribute text values.
   - If you chose to process the project, select the drawings to process and add them to the Drawings to Process list. Click OK to continue the operation.
   - If you chose to process the drawing by picks, select the components to process and press Enter.
     The Find/Edit/Replace dialog box displays, allowing you to define your search and replace parameters.

4. Click the Find check box next to the attribute you want to find.

5. Enter the attribute value or click the List button to select the value from a list of current text values.

6. Click the Replace check box for the selected attribute and type a new text string in the edit box.

7. Select to find and replace the exact text value or sub-strings within the attribute value.

8. Click Start Search to begin the find and replace operation. Each found match is displayed in a separate dialog box. You can edit, replace, skip to the next, or replace all of the found values.

An example of search criteria

To change all of the Location Codes marked "PNL1" to "PNL2A" you would:
Set the Location Code find value to "PNL1."
- Set the Location Code replace value to "PNL2A."
- Click All so the text will only be replaced if the entire text value matches the find value.

Find/edit/replace (drawing or project)
This tool finds and replaces component and terminal text values or sub-strings within those values. You can do this on the current drawing or across the project drawing set.

Access:
Click the arrow on the Retag Components tool to access the Find/Edit/Replace Component Text tool. Select to process the drawing or project and click OK.
From the Components menu, select Component Tagging ➤ Find/Edit/Replace Component Text. Select to process the drawing or project and click OK.

Find
Specifies the value to find. Initially, only the Find (F) toggles are enabled.

Replace
Replaces the find value with the new text string that you specify.

List
Displays a list of the current text values for the selected attribute. Select from this list to define your find parameter.

All
Replaces the text only if the entire text value matches the find value.

Part
Replaces the text if any part of the text value matches the find value.

Start search
Starts the search in the drawing or project for the find values that are specified. Each found match is displayed. You can edit, replace, skip to the next, or replace all of the values with the specified replace value.

NOTE This tool does not support wildcard characters.
**Find/edit/replace component text**

Use this tool to find and replace component and terminal text values or find and replace substrings within those values. You can do this on the active drawing or across the project drawing set.

**Access:**

Click the arrow on the Retag Components tool to access the Find/Edit/Replace Component Text tool.

From the Components menu, select Component Tagging ➤ Find/Edit/Replace Component Text.

Decide if you want to run the component retag across selected components, the active drawing, or the entire project.
Find or replace terminal text

1. Click the arrow on the Retag Components tool to access the Find/Replace Terminal Text tool.

2. Click the Find/Replace Terminal Text tool.

3. Select to replace the Full, exact match or a substring match.

4. If you chose to perform a substring match, select whether only the first occurrence within the text value should be replaced.

5. Define your find and replace with values.

6. Click OK to begin the find and replace operation.

7. Choose to process either the current drawing or the project and click OK.
   - If you chose to process the project, select the drawings to process and add them to the Drawings to Process list. Click OK to continue the operation.
   - If you chose to process the drawing by picks, select the components to process and press Enter.

8. The drawing or project set is scanned to find all the terminals and the current terminal text values. The find value is replaced with the specified replace value.

Find/replace terminal text
This tool lets you find and replace terminal number text values or find and replace sub-strings within those values. You can do this on a selection from
the active drawing, the entire active drawing, or across the project drawing set.

Access:

Click the arrow on the Retag Components tool to access the Find/Replace Terminal Text tool.

From the Components menu, select Component Miscellaneous ➤ Find/Replace Terminal Text.

<table>
<thead>
<tr>
<th>Full, exact match</th>
<th>Specifies to replace the text only if the entire text value matches the find value.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substring match</td>
<td>Specifies to replace the text if any part of the text value matches the find value.</td>
</tr>
<tr>
<td>First occurrence only</td>
<td>Specifies that only the first occurrence within the text value should be replaced.</td>
</tr>
<tr>
<td>Find</td>
<td>Specifies the value you wish to find.</td>
</tr>
<tr>
<td>Replace with</td>
<td>Specifies the text string to replace the find value with.</td>
</tr>
</tbody>
</table>

Move description values

AutoCAD Electrical supports 3 lines of description text on schematic components. If some only have 1 or 2 lines of description, the description may seem to float too high above the device. You can use these tools to move the description attribute values up or down to another position.

1. Select Components ➤ Attributes ➤ Push Description Up or Push Description Down.

2. Select the schematic components to process.
   - **Push Description Up**: DESC2 and DESC3 are pushed up to the DESC1 and DESC2 attribute positions when blanks are found.
Push Description Down: DESC1 and DESC2 are pushed up to the DESC2 and DESC3 attribute positions when blanks are found.

Manipulate component attributes

Move component attributes

1 Click the Move/Show Attribute tool.

2 Select the attributes to move and press Enter.
   You can pick the components individually or by windowing.
   The attributes highlight with a rectangular box drawn around them.

3 Select the base and insertion points for the move. The attribute follows your cursor and is automatically moved to the selected position.
   The attributes remain tied to the block inserts.

Hide attributes

Pick on the graphic of a target block insert to display a listing of all attribute names and values. You can toggle attributes between hidden and visible or you can edit individual attribute values.

1 Select Components ➤ Attributes ➤ Hide/Unhide Attribute ➤ Hide Attribute (Single Picks) or Hide Attribute (Window/Multiple).

2 Select the attributes to hide or pick on block graphics to display a list of attributes. The attribute is hidden immediately after it is selected.
   You can window attributes to hide by typing W and [space]. Do a crossing window (right to left) to capture the attributes you want to hide.

3 (Optional) Type U and [space] to unhide the attribute.
Show attributes

1 Select Components ➤ Attributes ➤ Hide/Unhide Attribute ➤ Unhide Attribute (Window/Multiple).

2 Select the attributes to display by drawing a crossing window around the attributes on the drawing.

3 Press Enter.

4 Select one or more attribute to flip to visible from the list.

5 Click OK.

Rotate component attributes

1 Click the arrow on the Move/Show Attribute tool to access the Rotate Attribute tool.

2 Click the Rotate Attribute tool.

3 Select the attribute text, text, or MTEXT string to rotate 90 degrees from its current orientation.
   After rotation, press M and [space] to flip into the Move Attribute mode.

Set tags to fixed

Fix selected tags
NOTE To unfix a component tag, in the Fixed/Unfixed Component Tag Marking dialog box, select Force selected tags to unfixed (normal), click OK, and select the tag to unfix.

1 Click the arrow on the Edit Component tool to access the Fix/UnFix Component Tag tool.

2 Click the Fix/UnFix Component Tag tool.

3 In the Fixed/Unfixed Component Tag Marking dialog box, select whether to force selected tags to fixed or switch a tag between being fixed or unfixed and click OK.
   - **Force selected tags to fixed**: Select the component to fix. Right-click to accept the selection.
   - **Single edit switch fixed/unfixed**: Select the component to fix. In the Fix/Unfix Component Tag dialog box, select Make it Fixed and click OK.

**Fix tags project-wide**

1 Click the arrow on the Project Manager tool to access the Project-Wide Utilities tool.

2 Click the Project-Wide Utilities tool.

3 In the Project-Wide Utilities dialog, Component Tags section, select Set all Parent Component Tags to fixed. To unfix tags project-wide, select Set all Parent Component Tags to normal.

4 Click OK.

5 In the Batch Process Drawings dialog, select to process the project, and click OK.

6 In the Select Drawings to Process dialog, select the drawings to process, and click OK.
**Fixed/unfix component tag**

Use this tool to mark a component tag as fixed. The tag is unaffected if the drawing is later reprocessed by a Retag command.

Access:

- Click the arrow on the Edit Component tool to access the Fix/UnFix Component Tag tool.
- From the Components menu, select Component Tagging ➤ Fix/UnFix Component Tag.

Select whether to force selected tags to fixed, force selected tags to unfixed, or switch a tag between being fixed or unfixed.

AutoCAD Electrical changes the component's attribute to a fixed layer as defined in the Define Layers dialog box.

**Retag components**

Run the AutoCAD Electrical Retag when something changes on your drawing or project that affects the component tags. This can include revising the ladder line reference numbers or changing the tag format. Retag redoes each selected primary component tag, and then updates the related secondary components. You can select to update a single component, a group of components, a drawing, drawings within your project, or the entire project. The Tag format is set up on the Project Properties ➤ Components or Drawing Properties ➤ Components dialog box.

Access:

- Click the Retag Components tool.
- From the Components menu, select Component Tagging ➤ Retag Components.

Decide if you want to run the component retag across selected components, the active drawing, or the entire project.
Change to multi-line text

This tool converts a long string of relay coil or source/destination cross-reference text to a multiline text entity (MTEXT). The underlying attribute value is maintained, but flipped to visible. The MTEXT entity is created at the same XY location as the underlying attribute. The MTEXT entity updates, scoots, and behaves as if it is an attribute tied to the component block.

1. Click the arrow on the Component Cross-Reference tool to access the Change Cross-Reference to Multiple Line Text tool.

2. Click the Change Cross-Reference to Multiple Line Text tool.
3. Select the text string to change.
4. Type a new text string for the selected text.
   Use the Text Formatting dialog box to change the text style and size. You can also right-click and select from the context menu options.
5. Use the grips or double-click on the text to bring up text formatting options to reformat the reference string into multiple lines.
6. Click OK.

Add location codes to components

You can add Location codes to components after they have been created or you can set a default Location code to use for all components that are inserted into a drawing.

Add Location codes on a per-drawing basis
First, set your project to use automatic fill for Location values, and then set the default for the drawing. You have a default Location value for each new component that you insert (whether field or panel) on the same drawing.

1. Click the Project Manager tool.
2. In the Project Manager, right-click the project name, and select Properties.
3. In the Project Properties ➤ Components dialog box, Component TAG Options section, select Upon insert: automatic fill Installation/Location with drawing default or last used. Click OK.
4. Open the drawing to set the default location value for.
5. Select Projects ➤ Drawing Properties.
6. In the Drawing Properties ➤ Drawing Settings dialog box, IEC - Style Designators section, enter a default Location value. Click OK.

**TIP** You can click Drawing or Project to select a Location value that has already been used in either the active drawing or project.

The next time you insert a new component on this drawing, the Location code are prefilled with the drawing default.

**Add a Location code to a saved component**

1. Open a saved symbol’s .dwg file in AutoCAD.
2. Use the ATTDEF command to add the new attribute or copy an attribute definition and rename it.
3. Save the drawing file.
   The symbol now contains an AutoCAD Electrical Location value attribute.
Update child location codes

A child contact should carry the same location code that is present on its parent component. If relay coil CR101 is marked "PNL1," then all CR101 contacts should also carry this location code. In addition, if a child component carries MFG and CAT attributes, they should carry the same information as the parent.

1. Click the arrow on the Component Cross-Reference tool to access the Child Location/Description Update tool.

2. Click the Child Location/Description Update tool.

3. Select the values to match to those carried on the schematic parent component.

4. Click OK.

5. Select the components to update in your drawing and right-click or type "ALL" to process the entire drawing.

AutoCAD Electrical quickly extracts a listing of all parent components and pertinent codes from all drawings listed in the current project and applies these to the child contacts you selected on the active drawing.

Child contact and panel update from schematic parent

This tool updates child and panel components with installation, location, and description values carried by the associated parent schematic component.

Access:

Click the arrow on the Component Cross-Reference tool to access the Child Location/Description Update tool.

From the Components menu, select Cross-Reference ➤ Child Location/Description Update.
Installation/Location Attributes

**Installation codes**
Specifies to update the child and panel components with the parent installation code.

**Location codes**
Specifies to update the child and panel components with the parent location code.

**Description text**
Specifies to update the child and panel components with the parent description text.

**Description to always match parent**
Specifies that the description should always match the parent description text.

**Description update only if child blank**
Specifies that the description should only be updated to match the parent description text if the child description values are blank.

**Rating values**
Specifies to update the child and panel components with the parent rating values.

Manufacturer/Catalog part number values

**Manufacturer/Catalog part number values**
Specifies to update the child and panel components with the parent Manufacturer/Catalog part number values.

**Manufacturer/Catalog to always match schematic parent**
Specifies that the Manufacturer/Catalog should always match the parent Manufacturer/Catalog values.

**Manufacturer/Catalog update only if child is blank**
Specifies that the Manufacturer/Catalog should only be updated to match the parent Manufacturer/Catalog text if the child Manufacturer/Catalog values are blank.

**NOTE** If you choose to update the Manufacturer/Catalog, it will not carry to the children unless they carry the Manufacturer and Catalog attributes.
Substitute location mark symbols for text location codes

You can insert location marks on symbols that are identified with location code in text form.

Add a location code to a component

If you try to insert a location mark symbol on a component with a blank location code, you are prompted to enter the location code before selecting a
marker. Once you insert a location code, a location mark symbol can be associated to it and the component.

1. Click the Location Symbols tool.
2. Select a component to add the symbol to and press Enter.
   If a location code is not associated to the component, the Add Location to Component dialog box displays.
3. Specify the location code by typing it, clicking on component that carries the location value, or by selecting from a list of location codes used on the drawing or in the project.
4. Click OK.

Insert a location mark symbol

1. Click the Location Symbols tool.
2. Select a component to add the symbol to and press Enter.
3. From the Location Symbols dialog box, select the symbol to associate with the component and click OK.
   The attribute text turns to invisible and the location symbol inserts at its location.

You can reposition the location marks with the AutoCAD Move command. If you scoot the symbol, the mark moves with it.

NOTE You cannot assign the same mark to two different locations.
Remove a location mark symbol

- Click the Location Symbols tool.
- Select a component to remove the symbol from and press Enter.
  The location mark symbols are removed and the original location attribute is visible again.

Add a new symbol to the menu

The Location Symbols menu is driven by a text file (wd_locs.dat) that you can modify.

1. Create the mark symbol, save it to the Program Files \(\{x86\}\)\Autodesk\Acade \{version\}\Libs\jic1\ subdirectory with a file name that begins with "WDXX" (for example, "WDXXSQ1.DWG").
   Create an AutoCAD slide of the symbol and save the resulting .sld file.
2. Open the drawing in AutoCAD and center it on the screen.
3. Type MSLIDE at the command prompt.
4. Enter \Documents and Settings\{username\}\Application Data\Autodesk\AutoCAD Electrical \{version\}\wdxxsq1.sld as the file name to create.
5. Click Save.
6. Make a backup copy of \Documents and Settings\{username\}\Application Data\Autodesk\AutoCAD Electrical\{release #\}\{country code\}\Support\wd_locs.dat.
7. Edit wd_locs.dat with a text file editor (such as Wordpad).
8. Add the reference to the new mark symbol (for example, "Special Square \ WDXXSQ1.SLD \ WDXXSQ1").

**NOTE** You can also do this using the AutoCAD Electrical Icon Menu Wizard.

Location symbols

Location mark symbols are block inserts with block names that begin with "WDXX". Default symbols are included in the AutoCAD Electrical symbol library (ex: in JIC1 subdirectory). You can edit the symbol appearance by just calling up in AutoCAD and modifying to suit. You can substitute "smart"
geometric symbols for text "location" code values. The location text is hidden and replaced by a geometric shape. These are smart in that they update if the underlying component location code changes.

Access:

Click the Location Symbols tool. Select a component to add the symbol to and press Enter.

From the Components menu, select Component Tagging ➤ Location Symbols.

Select a component to add the symbol to and press Enter.

Some location symbol options include: Filled Triangle, Filled Square, Filled Diamond, Filled Circle, 1/2 Filled Triangle, 1/2 Filled Square, 1/2 Filled Diamond, and 1/2 Filled Circle.

**Adding custom symbols to menu**

You can create additional symbols if you wish. Follow the WDXX... naming convention and add to the icon menu as illustrated below. The icon menu is driven by an ASCII text file, wd_locs.dat. Edit this file to add references for your own location mark symbols. You can also add additional submenu pages to the menu in a manner similar to that of the Insert Component icon menu file.

Example WD_LOCS.DAT file with user added submenus 100 and 101:

```
**M0
L4
LOCATION SYMBOLS
Filled Triangle | loc2(s_wdxxt) | wdxxt
Filled Square | loc2(s_wdxxs) | wdxxs
Filled Diamond | loc2(s_wdxxd) | wdxsd
Filled Circle | loc2(swdxsc) | wdxxc
Remote station syms | remote.sld | $S=M100
Customer symbols | cust.sld | $S=M101
**M100
L4W
REMOTE STATION SYMBOLS
```

Substitute location mark symbols for text location codes | 421
Main Operator sta | wdxx_mos | wdxx_mos
Wash-down sta | wdxx_wds | wdxx_wds
**M101
L2
CUSTOMERS SYMBOLS
Customer power | wdxx_cp | wdxx_cp
Customer furnished | wdxx_cf | wdxx_cf

NOTE You only need to define the L^W row if you plan on using this .dat file in a version of AutoCAD Electrical prior to AutoCAD Electrical 2008.

Location box
The Location Box tool will draw a dashed box around selected components. A description can be assigned to the box, and components within the box can have their location and installation code(s) changed.

Access:
Click the drop-down arrow on the Location Symbols tool to access the Location Box tool.
From the Components menu, select Component Tagging ➤ Location Box.

Installation/Location Codes

<table>
<thead>
<tr>
<th>Location</th>
<th>Specifies the location code.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation</td>
<td>Specifies the installation code.</td>
</tr>
<tr>
<td>Drawing</td>
<td>Searches active drawing for location codes.</td>
</tr>
<tr>
<td>Project</td>
<td>Searches active project for location codes.</td>
</tr>
</tbody>
</table>

422 | Chapter 7 Component Attribute Tools
Pick Like

Picks the location code from a component in the active drawing.

**Dashed Box Information**

**Description Height**

Specifies the description height. Description height can be entered in the edit box or picked from an existing device from the active drawing.

**Box Description**

Specifies the description text.

**Description Insert Point**

Specifies the description insertion point: top, bottom, left or right.

**Drawing**

Searches the active drawing for location box descriptions.

**Use Location/Installation**

Indicates for the description to use the location and installation values.

**Pick Like**

Picks a description from a component in the active drawing.

**NOTE** Use the AutoCAD Electrical Edit Component to change the Location Box values.
Change attribute justification

Use this tool to change the justification of wire number text, component description text, or any attribute.

1. Click the arrow on the Move/Show Attribute tool to access the Change Attribute Justification tool.

2. Click the Change Attribute Justification tool.

3. Select the appropriate justification from the list, or click Pick Master to select an attribute on the drawing that has the justification you want to use.

4. Select the attributes or text objects one at a time, or enter W, and then window your objects.

5. Click OK.

Change attribute/text justification

Use this tool to change the justification of wire number text, component description text, or attributes.

Access:

Click the arrow on the Move/Show Attribute tool to access the Change Attribute Justification tool.

From the Components menu, select Attributes ➤ Change Attribute Justification.

Select Justification
Lists the justification choices to choose from.

Pick Master
Selects an attribute or text entity on the drawing whose justification you want to use.

Once you select your attributes or text objects, each object updates to match the selected justification.
Change attribute text style

Use this tool to adjust the font assignment (either project-wide or drawing-wide) to the text style “WD” or “WD_IEC.”

1. Click the arrow on the Project Manager tool to access the Project-Wide Utilities tool.

2. Click the Project-Wide Utilities tool.

3. In the Project-Wide Utilities dialog box, Change Attribute section, select Change Style and click Setup.

4. In the Project-Wide AutoCAD Electrical Style Change dialog box, select the font name to apply to text style WD or WD_IEC and click OK.

5. In the Project-Wide Utilities dialog box, click OK.

6. In the Batch Process Drawings dialog box, select to process the project and click OK.

7. In the Select Drawings to Process dialog box, select to process specific files or click Do All to process all of the drawings in the active project. Click OK.

   AutoCAD Electrical processes the selected drawings and adjusts the text style WD or WD_IEC to the specified font name.

Change attribute text size

To make permanent changes to the symbol text heights, you should adjust the attribute definitions on the library symbols themselves.
**Use the change attribute size utility**

1. Click the arrow on the Move/Show Attribute tool to access the Change Attribute Size tool.

2. Click the Change Attribute Size tool.

3. Select your new attribute size by either picking on a similar text or attribute entity or by manually entering the size value into the edit box.

4. Enter the new width factor into the edit box. Make sure you click to apply the width.

5. Select to change the attribute name by picking individual attributes, by type, or by typing a specific attribute name.
   - If you chose to select one attribute at a time, select the attribute(s) in the drawing. The attribute text automatically changes to the new attribute size.
   - If you chose to change all attributes of a certain type, select an example attribute and window the entire drawing. This finds and adjusts all attributes of the same name to your specified size.
   - If you chose to type in an attribute name, type the name in the edit box. (Wildcards are allowed.) You can include a series of attribute names to match by separating each attribute name with a semicolon.

6. Press OK and window the entire drawing.

7. Press Enter.

**Use the project-wide utilities**

1. Click the arrow on the Project Manager tool to access the Project-Wide Utilities tool.

2. Click the Project-Wide Utilities tool.
3 In the Project-Wide Utilities dialog box, Change Attribute section, select Change Attribute Size and click Setup.

4 In the Project-Wide Attribute Size Change dialog box, select the attribute types to change.

5 Enter the text height and optional width factor and click OK.

6 In the Project-Wide Utilities dialog box, click OK.

7 In the Batch Process Drawings dialog box, select to process the project and click OK.

8 In the Select Drawings to Process dialog box, select the drawings to process and click OK.

   AutoCAD Electrical processes the selected drawings and adjusts the target attributes to the value you’ve specified.

**Use the squeeze and stretch text utilities**

Use the Squeeze attribute tool to compress an attribute to make it fit into a tight spot (such as between closely spaced components). Use the Stretch
attribute tool to expand an attribute. Each click on the attribute dynamically changes the attribute’s width factor by 5%.

1. Click the arrow on the Move/Show Attribute tool to access the Squeeze Attribute/Text tool.

2. Click the Squeeze Attribute/Text tool.

3. Select the attribute text to change.
   The text is automatically compressed.

1. Click the arrow on the Move/Show Attribute tool to access the Stretch Attribute/Text tool.

2. Click the Stretch Attribute/Text tool.

3. Select the attribute text to change.
   The text automatically stretches.

Change attribute size

Use this tool to quickly change attribute text size when components or wire numbers have already been inserted onto your drawings.

Access:

Click the drop-down arrow on the Move/Show Attribute tool to access the Change Attribute Size tool.
From the Components menu, select Attributes ➤ Change Attribute Size.

Pick
Selects the new attribute size by picking a similar text or attribute.

Size
Specifies the attribute size value.


**Width**
Specifies the attribute width value.

**Apply**
Applies the new size or width values to the selected attributes.

**Single**
Changes the size of the attributes as you select them.

**By name**
Changes all attributes of a certain type. Select an example attribute for AutoCAD Electrical to determine the attribute's name. All attributes of the same name are found and adjusted to your specified size.

**Type it**
Specifies an attribute name for AutoCAD Electrical to match, wildcard characters are allowed. Window an area containing the attributes you want changed. All attributes that match the typed name are found and adjusted to the specified size.

For example, you want to change all the description attributes on all the PLC modules on your drawing. Select "Type it," and then enter "DESC*" for the attribute name. Window the entire drawing. You can include a series of attribute names to match by separating each attribute name with a semi-colon. (Example: "DESC*;TAG*"

---

**Modify library symbols**

**Change library symbol attribute size**

Use the Modify Symbol Library tool to change the attribute description size for library symbols.

**NOTE**  Make a backup copy of the library you plan to modify (such as the \Program Files (x86)\Autodesk\Acad (version)\libs\jic1 library). If the conversion doesn't give you the results you expect you can restore the symbols, adjust the settings, and then re-run.

1. Select Components ➤ Symbol Library ➤ Modify Symbol Library.

2. Select the folder containing the library symbols you wish to convert and press OK.

---

Modify library symbols | 429
The Symbol Library Attribute Text/Scale Resize dialog box displays. You can change the attribute size based on the AutoCAD Electrical attribute type.

3 Select the attributes to change. Notice that you can change the attributes for parent/stand-alone symbols separate from the child/contact symbols.

4 Enter the new value and click Start. The first library symbol is immediately opened, the changes are made to the selected attributes, the drawing is saved, and the operation moves on to the next symbol. This continues until each symbol has been updated.

NOTE You can also use this tool to change the default text width or the text font used for AutoCAD Electrical’s text style.

Symbol library attribute text/scale resize

Access:

From the Components menu, select Symbol Library ➤ Modify Symbol Library. Select the folder and click OK.

Re-scale symbol Specifies the new scale for the symbol. A value of 1.0 = no change.

Run AutoLISP “(command...)” expression Specifies which command to run using AutoCAD Electrical’s build-in AutoLISP programming. Enter the AutoLISP code in the edit box.

Force attributes to fixed text width Specifies the new width for the attribute text.

Change “WD” style Specifies the default text width and font used for AutoCAD Electrical’s text style. Choose the desired style from the list.

Do a save even if no change Specifies to performa save even if you didn’t make modifications to the symbol library.

Force attributes to fixed text heights Specifies the text height for the following attributes: parent or child components, installation and loca-
Add attributes to blocks

Use this tool to add an attribute to one insert instance of a block. The block does not need to be an AutoCAD Electrical block.

1 Click the arrow on the Move/Show Attribute tool to access the Add Attribute tool.

2 Click the Add Attribute tool.

3 Select the block.

4 Define the attribute name, value, height, justification, and visibility.

5 Click OK to create the attribute.

6 Select the attribute location on the drawing.

**NOTE** Added attributes do not become part of the block definition. They disappear during the Explode command and when inserting another instance of the same block.

**Add attribute**
Adds a new attribute to an instance of an AutoCAD Electrical block already inserted into the drawing file. The attribute can be user-defined or an AutoCAD Electrical-specific attribute.

Access:

Click the arrow on the Move/Show Attribute tool to access the Add Attribute tool.
From the Components menu, select Attributes ➤ Add Attribute.

<table>
<thead>
<tr>
<th>Name</th>
<th>Specifies text used to identify the attribute (attribute tag).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Specifies the attribute text. This value is displayed on the drawing and used in reports.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> This can be left blank.</td>
</tr>
<tr>
<td>Height</td>
<td>Specifies the height for the attribute value.</td>
</tr>
<tr>
<td>Justification</td>
<td>Specifies the justification for the attribute value.</td>
</tr>
<tr>
<td>Invisible</td>
<td>Indicates whether the attribute will be visible on the drawing.</td>
</tr>
</tbody>
</table>
Wire/Wire Number Tools

In this chapter
- Overview of wires
- Insert 3-phase bus wiring
- Insert wires
- Trim wires
- Stretch wires
- Overview of wire color/gauge labels
- Insert cable markers into wires
- Insert shield symbols
- Insert in-line wire markers
- Wire Gaps
- Ladder Tools
- Wire Numbers
- Wire Sequencing
- Source and Destination Markers
Overview of wires

AutoCAD Electrical treats line entities as wires when the lines are found on an AutoCAD Electrical-defined wire layer. You can have many wire layers set up on your drawing. Each wire layer has a descriptive name like "RED_16" or "BLK_14_THW" and is assigned a screen color to visually mimic the wire color. Wires do not have to begin or end at snap points, and they do not have to be orthogonal (they can be skewed at any angle).

A wire network is one or more wire line segments and optional branches that interconnect and form an electrically unbroken conductor. Wire segments of the network may contain in-line terminals and wire crossing gaps. All segments of a wire network receive the same wire number unless you select On per Wire Basis in the Wire Number Options section of the Project Properties ➤ Wire Numbers dialog box (on the Project Manager, right-click the project name and select Properties). When multiple wires are tied to a common wire connection point, each wire is treated as an independent wire network and receives its own unique wire number assignment by AutoCAD Electrical.
Insert 3-phase bus wiring

1. Click the arrow on the Insert Wires tool to access the Insert Multiple Wires tool.

2. Click the Insert Multiple Wires tool.

3. Set the horizontal and vertical spacing for the wires.

4. Specify where to start the wires.

5. Set the number of wires to 3, and click OK.
   During wire insertion, the current wire type displays at the command prompt. The current wire type indicates the layer name in which the new wires are drawn. You can override this by typing "T" and selecting a new wire type from the Set/Edit Wire Type dialog box. The new wire type becomes the current wire type and the command continues with the wire insertion.

6. If starting at a component or bus, select the component. Drag the cursor slowly to the right as the second and third phases
latch on to their appropriate vertical wires. You can see the 3 wires stretch straight across the screen.

As you pull the 3-phase wire out, you can turn a corner by moving your cursor out of line with the bus. To reverse the turn's phase sequence, press F.

7 Right-click to terminate the wires. The wires and wire connection dots insert, and loops are automatically inserted at wire crossing points.

**NOTE** If the distance between two horizontal wires is relatively small the vertical wire crossing them avoids inserting loop gaps since the wire trap distance setting is used to see whether wire loop gaps are possible or not. Reduce the scale factor or increase the distance between two wires to insert gap loops.

To tie the new 3-phase wire to an existing bus, but with reversed sequence, start the new 3-phase wire connected at the last wire on the existing bus. Move the cursor backward across the other wires until the connections are made, and then move the cursor forward again. This results in a reversed sequence connection.

**TIP** If you have trouble connecting a new 3-phase wire to an existing bus, start the command and select the starting point on the existing bus. Move the cursor slowly across the other wires of the bus so AutoCAD Electrical has a better chance of finding them and correctly connecting the new wiring.

**Multiple wire bus**

Inserts vertical or horizontal bus wiring. Bus spacing defaults to the default ladder rung spacing for horizontal bus. For a vertical bus, the spacing is the default value defined in the Ladder Defaults section in the Drawing Properties ➤ Drawing Format dialog box. Multiple bus wiring automatically breaks and reconnects to any underlying components that it finds in its path. If it crosses
any existing wiring, wire-crossing gaps automatically insert (if the drawing is so configured).

Access:

Click the arrow on the Insert Wire tool to access the Multiple Wire Bus tool. From the Wires menu, select Multiple Wire Bus.

NOTE You can use the Scoot command to adjust bus spacing after insertion.

| Horizontal | Specifies the horizontal spacing between the wires. |
| Vertical   | Specifies the vertical spacing between the wires. |

**Insert wires**

You can insert single or angled (22.5, 45, or 67.5 degree) line wire segments on a wire layer (the wire layer does not have to be the current layer). AutoCAD Electrical supports scooting components along angled wires.
NOTE The AutoCAD Insert Line command can also be used to insert AutoCAD Electrical wires on a valid wire layer.

1. Click the Insert Wire tool (or click the arrow on the Insert Wire tool to access the Insert 22.5, 45, or 67.5 Degree Wire tools).

2. Select the starting point of the wire. You can start a wire segment in empty space, from an existing wire segment, or from an existing component. If you start from a component, the wire segment is started at the nearest wire connection terminal to your pick point on that symbol.
   
   During wire insertion, the current wire type displays at the command prompt. You can override this by typing in the hotkey “T” and selecting a new wire type from the Set/Edit Wire Type dialog box. The new wire type becomes the current wire type and the command continues with the wire insertion.
   
   You can also type “X” during wire insertion to show the wire connection points in the drawing.

3. Select the ending point of the wire. You can end the wire segment or angled segment in empty space, from an existing wire segment, or from an existing component. If it ends at a wire segment, a dot (wddot.dwg) is applied, if appropriate. If it ends at another component, the nearest wire connection terminal is found and connected to your pick point on that symbol.

   NOTE If the distance between 2 horizontal wires is relatively small, the vertical wire crossing them avoids inserting loop gaps since the wire trap distance setting is used to see whether wire loop gaps are possible or not. Reduce the scale factor or increase the distance between two wires to insert gap loops.

   If the wire was an angled wire, press “9” to switch to normal 90-degree wire mode. If the wire was an angled wire, press “N” to switch to normal 90-degree wire mode. The wire picks up at the end of the angled wire segment and defaults to horizontal or vertical. To view wire connection terminal locations position the cursor near the target component, press ‘S’ followed by a [space]. Green Xs appear on the screen at the wire connection point locations.
NOTE A wire connection point should only have up to 3 wire connections tied to it. Adding more wires to a single point prevents the angled wire connection to tie uniquely to the wire connection point.

Trim wires

Use this tool to remove a wire segment and dots as required. You can pick on a single wire or draw a fence through multiple wires to trim.

1 Click the Trim Wire tool.
2 Select the wire segment to remove on the drawing or type F followed by a [space] to remove multiple wires at once.
3 If you are removing multiple wires, draw a fence through the wires to trim.

A Zoom Extents is triggered when a wire runs off the screen. If this zooming back and forth becomes annoying during multiple trims then zoom back so that all of the circuitry is completely shown on the screen, or press Z and [space] at the trim prompt. This triggers a Zoom Extents that will persist through the rest of the trimming edits.

NOTE You can use the AutoCAD Erase command to remove wires, but the wire connection dots will not be automatically removed.
Stretch wires

Use this tool to lengthen a wire until it meets another wire or an AutoCAD Electrical component.

1. Click the arrow on the Insert Wires tool to access the Stretch Wire tool.
2. Click the Stretch Wire tool.
3. Select the end of the wire to stretch.

Overview of wire color/gauge labels

When you select a wire to label, AutoCAD Electrical reads the wire's layer name, retrieves the matching text label, and inserts it as a label/leader on the drawing. The resulting wire color/gauge label is automatically revised if you change the wire layer of a labeled wire.

The mapping file is an ASCII text file with a *.wdw* extension. The default mapping file, default.wdw, is referenced if a project-specific .wdw file is not found. The mapping file lists each wire layer name followed by the wire color/gauge label text that is to be assigned to that wire layer.

You can easily set up or edit these labels. Select the wire color/gauge tool and select Setup to display the setup dialog. All of the current drawing's valid layer names are listed in the upper dialog list along with any matching labels found in the *.wdw* file (if it exists). Highlight any layer name and type in the label you want to associate with it. Use the "|" character to trigger a line break within your label text. For example, "RED_14_THHN:RED|AWG#14" will cause wire labels for layer "RED_14_THHN" to display as two-line "RED" and "AWG#14" labels. Your entries are saved to the *.wdw* file for instant reference as you insert wire color/gauge labels.
About automatic wire leaders

AutoCAD Electrical places wire numbers on leaders when it determines that the wire number text bumps into something (it does not check if the leader itself will collide with something). AutoCAD Electrical first makes 15 tiny step checks in the "up" direction. If this fails it checks 15 steps in the down direction. If this fails, it tries at approximately 60-degree angles. If all checks fail, it leaves the wire number where it originally was going to put it. This entire process takes just a split second.

Leader checks are triggered when wire numbers are inserted or they re-center due to an adjacent SCOOT operation. If a component is scooted and the result is enough room for a wire number on a leader to do without the leader, AutoCAD Electrical automatically removes the leader and positions the wire number just above the wire.
Map wire type labels to each wire layer

This tool maps a wire color/gauge/wire type label to each wire layer.

1. Click the arrow on the Wire Number Leader tool to access the Wire Color/Gauge Labels tool.

2. Click the Wire Color/Gauge Labels tool.

3. Click Setup to change the text size, arrow style, and layers for the label.
   - Select the layer name to add/modify the default color/gauge text string for wire labels and leaders.
     To add or modify the default color/gauge text string, select the layer name from the list in the Wire label color/gauge setup dialog box. To add new wire layer names, use the Wires ➤ Create/Edit Wire Type dialog box.
   - Set the text size, arrow size, arrow type, and gap size for the leader.
     The label text size follows the current AutoCAD DIMTXT setting and the arrow size defaults to the current AutoCAD DIMASZ setting.
   - Specify the leader layer and text layer.
   - Click OK to apply the changes to the wire labels. The specified leader and text layers are displayed in the dialog box under the Setup button.

4. Select how to place the label in the drawing: automatic placement by AutoCAD Electrical, by picking the leader location point, or by picking the location for the text label with no leader. If you picked Auto placement, AutoCAD Electrical will look for a clear spot and insert the leader/label automatically.

Insert wire color/gauge labels

This tool inserts labels on your drawing's wiring.

Access:

Click the arrow on the Wire Number Leader tool to access the Wire Color/Gauge Labels tool.
Access:

From the Wires menu, select Wire Numbers Miscellaneous ➤ Wire Color/Gauge Labels.

Setup

Sets the default color/gauge text string, text size, arrow size, gap size, and arrow type for the wire label/leaders. To add or modify the default color/gauge text string, select the layer name from the list in the Wire label color/gauge setup dialog box. To add new wire layer names, use the Wires ➤ Create/Edit Wire Type dialog box.

Manual/No Leader

Places the text label (with no leader) at the location you pick.

Auto Placement

Places the label on the drawing automatically. AutoCAD Electrical looks for a good spot to place the label and the label is automatically placed without any picking on your part.

Manual

Places the label at the leader location point you pick.

Insert cable markers into wires

You can insert parent and child cable markers into wires. These markers carry a cable TAG value, just like any parent/child device combination.
Insert cable markers

1. Click the Cable Markers tool.

2. In the Insert Component dialog box, select the cable marker to insert and pick the insertion point on the drawing.
   The Insert/Edit Cable Marker dialog box displays.

3. Set the cable tag by keeping the default, using the buttons, or typing in a new tag.
   Make sure you select Fixed if you want this tag to be marked so that it won’t be updated on a future re-tag.

4. Define the wire color by selecting it from a list or typing the color id in the edit box.
   Subsequent insertions of child cable markers, tied back to the parent through any of the normal methods (Parent/sibling or drawing/project-wide pick list) will cause AutoCAD Electrical to offer the cable's next conductor color as a default.

5. Assign the catalog information, description, location and installation codes, and references for the tag.

6. Click OK.
   If a parent cable marker was inserted, the Insert Some Child Components dialog box displays, allowing you to automatically insert child cable markers that are tied to the parent.

7. If you want to insert child markers, make any changes to the dialog box and click Ok insert Child. If you don’t want any child markers to be associated with the parent marker, click Close.

**NOTE** You can use the Dashed Link Line command to insert linked lines between the symbols.
Insert multiple cable markers

AutoCAD Electrical provides a way to insert all the markers for a particular cable from one dialog. In addition, you can edit existing cable marker sets, or even delete cable markers from a single dialog.

1. Click the arrow on the Cable Markers tool to access the Multiple Cable Markers tool.

2. Click the Multiple Cable Markers tool.

3. Select to run a report for the project or drawing and click OK. AutoCAD Electrical processes the drawing or project before the Location Code Selection for From/To Reporting dialog box displays.

4. Pick the location codes from the left and right-hand lists.

   NOTE Components that have no assigned location code are grouped under a generic "(??)" code.

5. Make any necessary changes in the From/To combination box and click OK when you are ready to run the report. The Cable Insert/Edit dialog box displays.

6. Define which wires are part of the cable by using the Include, Include All, Remove, and Remove All buttons. The wires for the cable are listed in the Wires Included in Cable portion of the dialog box.

7. Set the cable tag by keeping the default, using the buttons, or typing in a new tag. Make sure you select Fixed if you want this tag to be marked so that it won't be updated on a future re-tag.

8. Set the wire color by selecting it from a list or typing the color id in the edit box. Subsequent insertions of child cable markers, tied back to the parent through any of the normal methods (Parent/sibling or drawing/project-wide pick list) will cause AutoCAD Electrical to offer the cable's next conductor color as a default.
Assign the catalog information, description, location and installation codes, and references for the tag.

Click Insert/Update Now to insert the cable or click Insert/Update Later to save the changes for later.

If you chose Now, any affected drawings are opened and the cable markers are inserted or updated. If you chose to insert/update later, your changes are saved in a file called 'projnam_cblmarkin.upd' in the same directory path as your project file. When you are ready to insert the cable(s), select Wires ➤ Cables ➤ Multiple Cable Markers Update from the menu.

**Insert component**

This icon menu can be modified, expanded, or replaced with your own custom menu. You can change the default icon menu using the Library and Icon Menu Paths section of the Project Properties ➤ Project Settings dialog box. Select Projects ➤ Project ➤ Project Manager. Right-click the project name and select Properties. Use the Icon Menu Wizard to easily modify the menu. The default icon menu can also be redefined in "wd.env." Add entry "WD_MENU" for schematic icon menu and "WD_PMENU" for panel layout icon menu.

**Access:**

Click the Insert Component tool or the Multiple Insert Component tool.
Click Components ➤ Insert Component or Components ➤ Multiple Insert ➤ Multiple Insert (Icon Menu).

**NOTE** This dialog box is also accessed when inserting Pneumatic, Hydraulic, or P&ID components; in-line wire labels; stand-alone cross-reference symbols; cable markers; and saved circuits.
Select an icon picture or the component type from the Menu tree structure. The main menu in the tree structure is displayed as the menu heading just above the menu tree structure.

Tabs
- **Menu**: Changes the visibility of the Menu tree view.
- **Up one level**: Displays the menu that is one level before the current menu in the Menu tree view. This is unavailable if the main menu is selected in the Menu tree view.
- **Views**: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.

Menu
The tree structure is created by reading the icon menu file (*.dat). The tree structure is based on the arrangement order of submenus defined in the .dat file.

Symbol Preview window
Displays the symbol and submenu icons corresponding to the menu or the submenu selected in the Menu tree structure. Clicking on the icon performs one of the following functions based on the icon properties as defined by the *.dat file:
- Inserts the symbol or circuit onto the drawing
- Executes a command
- Displays a submenu

**NOTE** When you move the cursor over an icon, the icon name and block/circuit/command name display as tooltip information.

Recently Used
Displays the last components inserted during the current editing session; the most recently used icon displays in the top. This list follows the view options setting in the symbol preview window (icon only, icon with text or list view) and the total number of icons displayed depends on the value specified in the Display edit box.

Display
Specifies the number of icons to display in the Recently Used list box. Enter integer numbers only; the default value is 10.
<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Vertical/Horizontal</strong></td>
<td>Inserts the icon using a vertical or horizontal orientation. This is opposite the drawing’s default ladder rung orientation.</td>
</tr>
<tr>
<td><strong>No edit dialog</strong></td>
<td>Turns off the Insert/Edit Component dialog box when inserting symbols onto the drawing. To add component detail later, click the Edit Component tool, and select the component to edit.</td>
</tr>
<tr>
<td><strong>No tag</strong></td>
<td>Inserts the component, un-tagged (i.e. without assigning a unique Component Tag). The untagged value that displays is the component’s TAG1/TAG2 default value. To add component detail later, click the Edit Component tool, and select the component to edit.</td>
</tr>
<tr>
<td><strong>Always display previously used menu</strong></td>
<td>Indicates to display the previously used menu each time you open the Insert Component dialog box. For example, if you insert a push button from the Push Buttons menu, the next time you open the Insert Component dialog box the Push Button menu displays by default.</td>
</tr>
<tr>
<td><strong>Scale schematic</strong></td>
<td>Specifies the component block insertion scale. This defaults to the value set in the Drawing Properties ➤ Drawing Format dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.</td>
</tr>
<tr>
<td><strong>Scale panel</strong></td>
<td>Specifies the footprint insertion scale. This defaults to the value set in the Drawing Properties ➤ Drawing Format dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.</td>
</tr>
<tr>
<td><strong>Type it</strong></td>
<td>Manually type in the component block to insert.</td>
</tr>
<tr>
<td><strong>Browse</strong></td>
<td>Browses to and selects the component to insert.</td>
</tr>
</tbody>
</table>

**Right-click menus**

**Options for the Menu tree structure view**
Right-click on the main menu or submenu in the Menu tree structure view to display the following options:

- **Expand/Collapse**: Toggles the visibility of the menus.
- **Properties**: Opens a Properties dialog box to view the existing menu or submenu properties like the menu name, image or submenu title. Use the Icon Menu Wizard to change any menu properties.

### Options for the Symbol Preview window

Right-click an icon or in empty space in the Symbol Preview window to display the following options:

- **View**: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.
- **Properties**: (available for icons only) Opens a Properties dialog box to view the existing symbol icon properties like the icon name, image, block names and so on. Use the Icon Menu Wizard to change any icon properties.

### Pneumatic, Hydraulic and P&ID icon menus

The Menu tree structure displays the symbols for the selected component type (pneumatic, hydraulic or P&ID). The Insert Pneumatic Component, Insert Hydraulic Component and Insert P&ID Component tools are accessed on the Extra Library toolbar.

- ![Insert Pneumatic Component](image)
- ![Insert Hydraulic Component](image)
- ![Insert P&ID Component](image)

### Insert or edit cable marker (parent wire)

Insert cable markers into wires | 449
Cable markers carry a cable TAG value, just like any parent/child device combination. They can also carry a conductor color value (carried as a RATING1 attribute value on the marker block symbol). The parent symbol has provision to carry MFG/CAT part number information and, if the particular cable is referenced in the AutoCAD Electrical cable conductor database table (_W0_CBLWIRES within your Access catalog file), then AutoCAD Electrical can track conductors used versus conductors available.

**Access:**

Click the Cable Markers tool. In the Insert Component dialog box, select the marker to insert from the Symbol Preview window and specify the insertion point.

From the Wires menu, select Cables ➤ Cable Markers. In the Insert Component dialog box, select the marker to insert from the Symbol Preview window and specify the insertion point.

**Cable Tag**

There are a few ways to define the tag for this cable. If there is an existing tag, it appears in the edit box. If not, you can type a specific tag in the edit box. Make sure you select Fixed if you want AutoCAD Electrical to mark this tag so it won’t be updated on a re-tag.

**Use PLC Address**

Searches for a wire connection to a nearby PLC I/O address and, if found, uses the PLC address number in the component’s tag name.

**Use End Locations**

Uses the location codes of the connecting components.

**Tags: Used so far**

Lists any cable tag names in the same family as the current cable. Select a tag from the list to copy, or to increment for this new cable marker.

**External List**

Assigns a tag from an external list file. You can reference an ASCII text file in comma or space delimited format to help annotate the component’s description, tag, catalog, and other information.
**Wire Color/ID**

Sets the conductor color code by manually entering it in the edit box or select from a generic color pick list.

**Drawing**

Lists the wire colors used for similar cable markers in the current drawing.

**Project**

Lists the wire colors used for similar cable markers in the project.

**Catalog Data**

You can instruct AutoCAD Electrical to do a drawing-wide or project-wide listing of similar cable markers with their catalog assignments. During your editing session, the last MFG / CAT / ASSYCODE assignment for each component type you insert into your wiring diagram is remembered. When you insert another component of that type, the previous component's catalog assignment is set as the default (assuming a previous one was made during the current editing session).

**Manufacturer**

Lists the manufacturer number for the cable marker. Enter a value or select one from the Catalog lookup.

**Catalog**

Lists the catalog number for the cable marker. Enter a value or select one from the Catalog lookup.

**Assembly**

Lists the assembly code for the cable marker. The Assembly code is used to link multiple part numbers together.

**Item**

Specifies a unique identifier assigned to each cable marker. The tag value can be manually typed in the edit box.

**Count**

 Specifies the quantity number for the part number (blank=1). This value gets inserted into a BOM report’s “SUBQTY” column.

**Lookup**

Opens the cable marker’s catalog database from which you can manually enter or select the Manufacturer or Catalog values. Search the database for a specific catalog item to assign to the selected cable marker. Database queries are set up in the 3 lists across the top of the dialog with the database hits listed in the dialog’s main window.
Scans the previous project to find an instance of the selected cable marker and returns the marker values. You can then make your catalog assignment by picking from the dialog list.

Lists the part numbers used for similar cable markers in the current drawing.

Lists the part numbers used for similar cable markers in the project. You can search in the active project, another project, or in an external file.

- **Active project:** All the drawings in the current project are scanned and the results are listed in a dialog box. Select from the list to assign your new cable marker with a catalog number that is consistent with other similar cable markers in the project.

- **Other project:** Scans each listed drawing in a previous project for the target cable marker type and returns the catalog information in a sub-dialog box. Make your catalog assignment by picking from the dialog list.

- **External file:** You can pull catalog assignments from a generic ASCII file created by a word processor or output from a spreadsheet or database program. A dialog box displays the contents of the selected text file. Find and highlight the desired entry. AutoCAD Electrical reads the line of text from the file and breaks it into its component parts. These are displayed in the left-hand dialog list. For each relevant item, highlight it and then pick the appropriate category button in the center column. The highlighted item is transferred to the corresponding category (and then to the Insert/Edit dialog box once OK is clicked).

Inserts or edits extra catalog part numbers on to the selected cable markers. You can add up to 10 part numbers to any cable markers. These multiple BOM part numbers appear as sub-assembly part numbers to the main catalog part number in the various BOM and component reports.

Displays what the selected item will look like in a Bill of Material template.
Description

One, two, or three lines of description attribute text can be entered.

Drawing Displays a list of descriptions found in the current drawing so you can pick similar descriptions to edit.

Project Displays a list of descriptions found in the project so you can pick similar descriptions to edit.

Defaults Opens an ASCII text file from which you can select standard descriptions.

Pick Picks a description from a cable marker on the current drawing.

Child conductor references

Component override Overrides the drawing's WD_M block settings with component-specific cross-reference settings. Click Setup to manually edit the component cross-reference settings.

Cross Reference AutoCAD Electrical automatically fills in cross-reference text when the cross-reference command is run.

Installation Code

Changes the installation code(s). You can search the current drawing or entire project for installation codes. AutoCAD Electrical does a quick read of all the current or selected drawing files and returns a list of all installation codes used so far. Pick from the list to automatically update the component with the installation code.

Assign short installation codes to components like "PNL" and "FIELD" so you can later take full advantage of the AutoCAD Electrical ability to create location-specific BOM and component lists.

Location Code

Changes the location codes. You can search the current drawing or entire project for location codes. AutoCAD Electrical does a quick read of all the
current or selected drawing files and returns a list of all location codes used so far. Pick from the list to automatically update the component with the location code.

Assign short location codes to components like "PNL" and "FIELD" so you can later take full advantage of the AutoCAD Electrical ability to extract wire and cable from/to reports, and location-specific BOM reports (for example, BOM for all field cables, BOM for all PNL cables).

**Show/edit miscellaneous**

View or edit any attributes that are not predefined AutoCAD Electrical attributes.

**Insert or edit cable marker (parent wire): IEC**

Cable markers carry a cable TAG value, just like any parent/child device combination. They can also carry a conductor color value (carried as a RATING1 attribute value on the marker block symbol). The parent symbol has provision to carry MFG/CAT part number information and, if the particular cable is referenced in the AutoCAD Electrical cable conductor database table (_W0_CBLWIRES within your Access catalog file) AutoCAD Electrical can track conductors used versus conductors available.

**Access:**

- Click the Cable Markers tool. Select Cable Marker from the list.
- From the Wires menu, select Cables ➤ Cable Markers. Select Cable Marker from the list.

This is Insert/Edit Cable Marker (Parent wire) dialog box for working in IEC mode. If you work in JIC mode, the dialog box displays differently.

**Installation**

Changes the installation code(s). You can search the current drawing or entire project for installation codes. A quick read of all the current or selected drawing files is done and a list of installation codes used so far is returned. Select from the list to automatically update the component with the installation code.

Assign short installation codes to components like "PNL" and "FIELD" so you can create location-specific BOM and component lists later.
**Location**

Changes the location codes. You can search the current drawing or entire project for location codes. A quick read of all the current or selected drawing files is done and a list of location codes used so far is returned. Select from the list to automatically update the component with the location code.

Assign short location codes to components like "PNL" and "FIELD" so you can extract cable from/to reports and location-specific BOM reports later (for example, BOM for all field cables, BOM for all PNL cables).

**Cable Tag**

Any existing tags appear in the edit box. To define the cable tag, edit the existing tag or type a specific tag in the edit box. Select Fixed if you don't want this tag to be updated on a re-tag.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use PLC address</td>
<td>Searches for a wire connection to a nearby PLC I/O address and, if found, uses the PLC address number in the component's tag name.</td>
</tr>
<tr>
<td>Use end locations</td>
<td>Uses the location codes of the connecting components.</td>
</tr>
<tr>
<td>Tags: Used so far</td>
<td>Lists any cable tag names in the same family as the current cable. Select a tag from the list to copy, or to increment for this new cable marker.</td>
</tr>
<tr>
<td>External list file</td>
<td>Assigns a tag from an external list file.</td>
</tr>
</tbody>
</table>

**Description**

Up to 3 lines of description attribute text can be entered. These lines are automatically filled with a copy of the parent's description text if the parent TAG name is picked using one of the methods above.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawing</td>
<td>Displays a list of descriptions found in the current drawing so you can pick similar descriptions to edit.</td>
</tr>
<tr>
<td>Project</td>
<td>Displays a list of descriptions found in the project so you can pick similar descriptions to edit.</td>
</tr>
</tbody>
</table>
Opens an ASCII text file from which you can select standard descriptions.

Picks a description from a component on the current drawing.

**Catalog Data**

You can instruct AutoCAD Electrical to do a drawing-wide or project-wide listing of similar cable markers with their catalog assignments. During your editing session, the last MFG / CAT / ASSYCODE assignment for each component type you insert into your wiring diagram is remembered. When you insert another component of that type, the previous component’s catalog assignment is set as the default (assuming a previous one was made during the current editing session).

Lists the manufacturer number for the cable marker. Enter a value or select one from the Catalog lookup.

Lists the catalog number for the cable marker. Enter a value or select one from the Catalog lookup.

Lists the assembly code for the cable marker. The Assembly code is used to link multiple part numbers together.

Specifies a unique identifier assigned to each cable marker. The tag value can be manually typed in the edit box.

Specifies the quantity number for the part number (blank=1). This value gets inserted into a BOM report’s "SUBQTY" column.

Opens the cable marker’s catalog database from which you can manually enter or select the Manufacturer or Catalog values. Search the database for a specific catalog item to assign to the selected cable marker. Database queries are set up in the 3 lists across the top of the dialog with the database hits listed in the dialog’s main window.

Scans the previous project to find an instance of the selected cable marker and returns the marker values. You can then make your catalog assignment by picking from the dialog list.
Lists the part numbers used for similar cable markers in the current drawing.

**Project**

Lists the part numbers used for similar cable markers in the project. You can search in the active project, another project, or in an external file.

- **Active project**: All the drawings in the current project are scanned and the results are listed in a dialog box. Select from the list to assign your new cable marker with a catalog number that is consistent with other similar cable markers in the project.

- **Other project**: Scans each listed drawing in a previous project for the target cable marker type and returns the catalog information in a sub-dialog box. Make your catalog assignment by picking from the dialog list.

- **External file**: You can pull catalog assignments from a generic ASCII file created by a word processor or output from a spreadsheet or database program. A dialog box displays the contents of the selected text file. Find and highlight the desired entry. AutoCAD Electrical reads the line of text from the file and breaks it into its component parts. These are displayed in the left-hand dialog list. For each relevant item, highlight it and then pick the appropriate category button in the center column. The highlighted item is transferred to the corresponding category (and then to the Insert/Edit dialog box once OK is clicked).

**Multiple Catalog**

Inserts or edits extra catalog part numbers on to the selected cable markers. You can add up to 10 part numbers to any cable markers. These multiple BOM part numbers appear as sub-assembly part numbers to the main catalog part number in the various BOM and component reports.

**Catalog Check**

Displays what the selected item will look like in a Bill of Material template.

**Wire Color/ID**

The conductor color code can be manually entered into the edit box or selected from a generic color pick list.
**Child conductor references**

AutoCAD Electrical automatically fills in cross-reference text when the cross-reference command is run.

**Show/edit miscellaneous**

View or edit any attributes that are not predefined AutoCAD Electrical attributes.

**Insert or edit cable marker (2nd+ wire of cable)**

Cable markers carry a cable TAG value, just like any parent/child device combination. They can also carry a conductor color value (carried as a RATING1 attribute value on the marker block symbol).

**Access:**

Click the Cable Markers tool. Select 2+ Child Marker from the list.

From the Wires menu, select Cables ➤ Cable Markers. Select 2+ Child Marker from the list.

**Component Tag**

If the parent is visible on screen, click Parent/Sibling and select the parent (or another related marker). This automatically transfers all information to the child marker being inserted/edited.

<table>
<thead>
<tr>
<th>Tag</th>
<th>The parent cable tag value can be manually typed in the edit box or selected from a drawing-wide or project-wide list of existing cables.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawing</td>
<td>Lists the component tags used for similar cable markers in the current drawing.</td>
</tr>
<tr>
<td>Project</td>
<td>Lists the component tags used for similar cable markers in the project.</td>
</tr>
<tr>
<td>Parent/Sibling</td>
<td>Transfers all information from the parent cable marker to the child cable marker being inserted or edited. If the parent is visible on the screen, click Parent/Sibling and select the parent (or another related contact).</td>
</tr>
</tbody>
</table>
**Wire Color/ID**

The conductor color code can be manually entered into the edit box or selected from a generic color pick list. If the parent marker carries a part number, you can select the next unused color from a used/unused pick list.

**Drawing**

Lists the wire colors used for similar cable markers in the current drawing.

**Project**

Lists the wire colors used for similar cable markers in the project.

**Description**

Up to 3 lines of description attribute text can be entered. These lines are automatically filled with a copy of the parent's description text if the parent TAG name is picked using one of the methods above.

Click Pick to copy a description from a cable marker on the current drawing.

**Parent cable marker cross-reference**

AutoCAD Electrical automatically fills in cross-reference text when the cross-reference command is run.

**Installation Code**

Changes the installation codes. You can search the current drawing or entire project for installation codes. A quick read of all the current or selected drawing files is done and a list of installation codes used so far is returned. Select from the list to automatically update the component with the installation code.

Assign short installation codes to components like "PNL" and "FIELD" so you can take full advantage of the AutoCAD Electrical ability to create location-specific BOM and component lists later.

**Location Code**

Changes the location codes. You can search the current drawing or entire project for location codes. A quick read of all the current or selected drawing files is done and a list of location codes used so far is returned. Select from the list to automatically update the component with the location code.

Assign short location codes to components like "PNL" and "FIELD" so you can take full advantage of the AutoCAD Electrical ability to extract wire and cable...
from/to reports, and location-specific BOM reports later (for example, BOM for all field cables, BOM for all PNL cables).

**Show/edit miscellaneous**

View or edit any attributes that are not predefined AutoCAD Electrical attributes.

**Insert or edit cable marker (2nd+ wire of cable): IEC**

Cable markers carry a cable TAG value, just like any parent/child device combination. They can also carry a conductor color value (carried as a RATING1 attribute value on the marker block symbol).

**Access:**

Click the Cable Markers tool. Select 2+ Child Marker from the list.

From the Wires menu, select Cables ➤ Cable Markers. Select 2+ Child Marker from the list.

This is Insert/Edit Cable Marker (2nd+ wire of cable) dialog box for working in IEC mode. If you work in JIC mode, the dialog box displays differently.

**Installation**

Changes the installation codes. You can search the current drawing or entire project for installation codes. A quick read of all the current or selected drawing files is done and a list of installation codes used so far is returned. Select from the list to automatically update the component with the installation code.

Assign short installation codes to components like "PNL" and "FIELD" so you can create location-specific BOM and component lists later.

**Location**

Changes the location codes. You can search the current drawing or entire project for location codes. A quick read of all the current or selected drawing files is done and a list of location codes used so far is returned. Select from the list to automatically update the component with the location code.

Assign short location codes to components like "PNL" and "FIELD" so you can extract cable from/to reports and location-specific BOM reports later (for example, BOM for all field cables, BOM for all PNL cables).
Component Tag

The parent cable tag value can be manually typed into the edit box or selected from a drawing-wide or project-wide list of existing cables. If the parent is visible on screen, click Parent/Sibling and select the parent or another related marker. This automatically transfers all information to the child marker being inserted/edited.

Description

Up to 3 lines of description attribute text can be entered. These lines are automatically filled with a copy of the parent's description text if the parent TAG name is picked using one of the methods above.

Wire Color/ID

The conductor color code can be manually entered into the edit box or selected from a generic color pick list. If the parent marker carries a part number you can select the next unused color from a used/inuse pick list.

Parent cable marker cross-reference

AutoCAD Electrical automatically fills in cross-reference text when the cross-reference command is run.

Show/edit miscellaneous

View or edit any attributes that are not predefined AutoCAD Electrical attributes.

Multiple cable markers

This tool first extracts components and wiring. Then you select "From" and "To" location code combinations to report. AutoCAD Electrical filters and formats the wiring and connected component data and reports each wire and what is connected at each end. Components that have no assigned location code are grouped under a generic "(??)" code. Component wiring that daisy-chains along a common bus (for example, hot or neutral bus) may not report in the connected sequence you expect. (You can use the AutoCAD
Electrical Wire Sequence command to define wire connection sequencing for wire networks that have three or more interconnected components).

**Access:**

Click the arrow on the Cable Markers tool to access the Multiple Cable Markers tool. From the Wires menu, select Cables ➤ Multiple Cable Markers.

**From/To report for**

Specifies to process the report for the project, the entire drawing, or picked components in the drawing.

**List**

Lists drawings that appear to be out-of-date with the project's wire connection table.

**Freshen wire connection table**

Updates the wire connection table to include the drawings that are out-of-date.

**Format**

Displays a listing of report settings files that have a prefix equal to the report type shown in the dialog box.

**Cable insert or edit**

Cable markers carry a cable TAG value and a conductor color value (carried as a RATING1 attribute value on the marker block symbol).

**Access:**

Click the arrow on the Cable Markers tool to access the Multiple Cable Markers tool. Make your selections and click OK on the Wire From/To Report and the Location Code Selection for From/To Reporting dialog boxes. From the Wires menu, select Cables ➤ Multiple Cable Markers. Make your selections and click OK on the Wire From/To Report and the Location Code Selection for From/To Reporting dialog boxes.
Wires from extract
Lists the wires that match the From/To locations (from the Wire From/To Report) and aren't part of a cable yet (meaning that no cable marker has been inserted on this wire). Use Add All, Add, Remove All, and Remove to define which wires are part of the cable. Sort the lists to make it easier to find the wires. Click Change Format to define which fields of information to show in the list to facilitate finding the wires to include in your cable.

Cable(s)
Lists any existing cables and the wires that belong to each cable. If there are no existing cables, then the only item in Cable(s) is "newCBL1." Select New anytime you want to define a new cable. Otherwise, to edit an existing cable, select its tag from this list.

Cable Tag
There are a few ways to define the tag for the cable. If there is an existing tag, it appears in the edit box. If not, you can type a tag in the edit box. Make sure you select Fixed if you want AutoCAD Electrical to mark this tag so it is no updated on a retag.

Cable End Locations
Uses the location codes of the connecting components.

Tags: Used so far
Lists any cable tags already assigned. Select a tag from the list to copy, or to increment for this new cable.

External List File
Assigns a tag from an external list file.

Description
Up to 3 lines of description attribute text can be entered. Use List Drawing and List Project to pick similar descriptions to edit. Defaults opens an ASCII text file from which you can quickly pick standard descriptions.

Installation Code
Assign short installation codes to components like "PNL" and "FIELD" so you can take full advantage of the AutoCAD Electrical ability to create location-specific BOM and component lists later.
**Location Code**

Assign short location codes to components like "PNL" and "FIELD" so you can take full advantage of the AutoCAD Electrical ability to extract wire and cable from/to reports, and location-specific BOM reports later (for example, BOM for all field cables, BOM for all PNL cables).

**Catalog Data**

MFG and CAT numbers can be manually entered or picked from Catalog lookup. The Assembly code is used to link multiple part numbers together. Use Drawing and Project to quickly list of part numbers used for like components. If the part number you select has a color conductor list associated with it, the available conductor colors and a list of used ones is tracked.

**Lookup**

Opens the cable's catalog database from which you can manually enter or select the Manufacturer or Catalog values. Search the database for a specific catalog item to assign to the selected cable. Database queries are set up in the 3 lists across the top of the dialog with the database hits listed in the dialog's main window.

**Previous**

Scans the previous project to find an instance of the selected cable and returns the cable values. You can then make your catalog assignment by picking from the dialog list.

**Drawing**

Lists the part numbers used for similar cables in the current drawing.

**Project**

Lists the part numbers used for similar cables in the project. You can search in the active project, another project, or in an external file.

- **Active project**: All of the drawings in the current project are scanned and the results are listed in a sub-dialog box. Select from the list to assign your new cable with a catalog number that is consistent with other similar cables in the project.

- **Other project**: Scans each listed drawing in a previous project for the target cable type and returns the catalog information in a sub-dialog box. Make your catalog assignment by picking from the dialog list.

- **External file**: You can pull catalog assignments from a generic ASCII file created by a word processor or output from a spreadsheet or database program. A dialog box displays the contents of the selected text file. Find and highlight the desired entry.
AutoCAD Electrical reads the line of text from the file and breaks it into its component parts. These are displayed in the left-hand dialog list. For each relevant item, highlight it and then pick the appropriate category button in the center column. The highlighted item is transferred to the corresponding category (and then to the Insert/Edit dialog box once OK is clicked).

**Multiple Catalog**
Inserts or edits extra catalog part numbers on the selected cable. You can add up to 10 part numbers to any cable. These multiple BOM part numbers appear as sub-assembly part numbers to the main catalog part number in the various BOM and component reports.

**Catalog Check**
Displays what the selected item will look like in a Bill of Material template.

**Wire Colors**
Set the conductor color code by manually entering it in the edit box or by picking from a color list. The list displays the wire colors for the cable. If you have already selected catalog information, the colors in the list correspond to the specific cable type. If you haven’t assigned catalog information, the list is a generic set of colors.

To assign a color to a particular wire, select the wire in the list of wires for the cable. Assign the color by selecting it from the list or type it in the edit box. You can assign a color to all wires at one time by selecting Follow Color List. This assigns a color to each wire of the selected cable even if the wire already has a color assigned to it.

**Setup**
Opens a dialog box for setting the parent cable marker symbol, the cable marker placement on the wire, and options for hiding children attributes.

**Insert/Update Now**
Opens any affected drawings and automatically inserts or updates any cable markers.
**Insert/Update Later**

Saves your changes in a file called ‘projnam_cblmrkin.upd’ in the same directory path as your project file. The changes are accumulated in this file until you are ready for them. Select Wires ➤ Cables ➤ Multiple Cable Markers Update from the menu to insert or update the cable markers that were saved.

**Insert shield symbols**

AutoCAD Electrical provides a few special Shield symbols that graphically represent the cable shield type. There are “dumb” shields that do not carry an AutoCAD Electrical tag and there are cable marker/shields that carry an AutoCAD Electrical tag. You can have parent and child shields. You can insert them one at a time and relate them as you would any other component or insert a group at a time.

1. Click the Insert Component tool.
2. On the Insert Component dialog box, click the Miscellaneous button.
3. Click the Shields button.
4. Select the type of shield to insert into the drawing.
5. Pick the points on each wire for the shield/cable marker and right-click to end the selection. The shield inserts into the drawing.
   If you chose to insert a cable marker with a shield, the standard Insert/Edit Cable Marker dialog box displays.

**NOTE** Each successive symbol is automatically related to the parent (the top/left-most wire) as it is inserted.
**Add a second shield to a cable/shield representation**

You can add a second shield representation to an existing set of cable/shield markers.

1. Using the Cable Markers tool, select to insert a 2nd shield.
2. Select an existing shield marker (either select the first or last cable/marker shield symbol).
3. Specify the insertion point and right-click to end the selection.

**Insert in-line wire markers**

You can insert a special in-line marker into any wire. This marker can be used to identify a special signal name or conductor color. These reference-only markers are ignored for wire numbering and reporting.
NOTE The wire breaks around the inline marker.

1. Click the arrow on the Wire Leaders tool to access the In-Line Wire Label tool.

2. Click the In-Line Wire Labels tool.
   The Insert Component dialog displays with a selection of predefined in-line markers and user-defined markers.

3. Select a marker and place it on a wire.
   
   NOTE If the label is too wide, use the Squeeze Attribute/Text tool. You can also use the Adjust In-Line Wire/Label Gap tool to adjust the gap width rather than squeezing the attribute to fit the gap.

4. Press ESC to exit the command.

TIP You can also create wider marker symbols by following the block naming convention for terminal symbols (page 170). For example, the horizontal Red marker's file name is C:\Program Files\Autodesk\Acade 2007\Libs\jic1\jic1\HTO_RED.dwg and the vertical version is C:\Program Files\Autodesk\Acade \version\Libs\jic1\jic1\VTO_RED.dwg. AutoCAD Electrical keys off of the first four characters of the block/drawing name.

Insert component

This icon menu can be modified, expanded, or replaced with your own custom menu. You can change the default icon menu using the Library and Icon Menu Paths section of the Project Properties ➤ Project Settings dialog box. Select Projects ➤ Project ➤ Project Manager. Right-click the project name and select Properties. Use the Icon Menu Wizard to easily modify the menu. The default icon menu can also be redefined in "wd.env." Add entry
"WD_MENU" for schematic icon menu and "WD_PMENU" for panel layout icon menu.

Access:

Click the Insert Component tool or the Multiple Insert Component tool.
Click Components ➤ Insert Component or Components ➤ Multiple Insert ➤ Multiple Insert (Icon Menu).

NOTE This dialog box is also accessed when inserting Pneumatic, Hydraulic, or P&ID components; in-line wire labels; stand-alone cross-reference symbols; cable markers; and saved circuits.

Select an icon picture or the component type from the Menu tree structure. The main menu in the tree structure is displayed as the menu heading just above the menu tree structure.

Tabs

- Menu: Changes the visibility of the Menu tree view.
- Up one level: Displays the menu that is one level before the current menu in the Menu tree view. This is unavailable if the main menu is selected in the Menu tree view.
- Views: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.

Menu

The tree structure is created by reading the icon menu file (*.dat). The tree structure is based on the arrangement order of submenus defined in the .dat file.

Symbol Preview window

Displays the symbol and submenu icons corresponding to the menu or the submenu selected in the Menu tree structure. Clicking on the icon performs one of the following functions based on the icon properties as defined by the *.dat file:
- Inserts the symbol or circuit onto the drawing
Executes a command
Displays a submenu

NOTE When you move the cursor over an icon, the icon name and block/circuit/command name display as tooltip information.

Recently Used Displays the last components inserted during the current editing session; the most recently used icon displays in the top. This list follows the view options setting in the symbol preview window (icon only, icon with text or list view) and the total number of icons displayed depends on the value specified in the Display edit box.

Display Specifies the number of icons to display in the Recently Used list box. Enter integer numbers only; the default value is 10.

Vertical/Horizontal Inserts the icon using a vertical or horizontal orientation. This is opposite the drawing’s default ladder rung orientation.

No edit dialog Turns off the Insert/Edit Component dialog box when inserting symbols onto the drawing. To add component detail later, click the Edit Component tool, and select the component to edit.

No tag Inserts the component, un-tagged (i.e. without assigning a unique Component Tag). The untagged value that displays is the component’s TAG1/TAG2 default value. To add component detail later, click the Edit Component tool, and select the component to edit.

Always display previously used menu Indicates to display the previously used menu each time you open the Insert Component dialog box. For example, if you insert a push button from the Push Buttons menu, the next time you open the Insert Component dialog box the Push Button menu displays by default.

Scale schematic Specifies the component block insertion scale. This defaults to the value set in the Drawing Properties ➤ Drawing Format dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.
Specifies the footprint insertion scale. This defaults to the value set in the Drawing Properties ➤ Drawing Format dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.

Manually type in the component block to insert.

Browses to and selects the component to insert.

**Right-click menus**

**Options for the Menu tree structure view**

Right-click on the main menu or submenu in the Menu tree structure view to display the following options:

- Expand/Collapse: Toggles the visibility of the menus.
- Properties: Opens a Properties dialog box to view the existing menu or submenu properties like the menu name, image or submenu title. Use the Icon Menu Wizard to change any menu properties.

**Options for the Symbol Preview window**

Right-click an icon or in empty space in the Symbol Preview window to display the following options:

- View: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.
- Properties: (available for icons only) Opens a Properties dialog box to view the existing symbol icon properties like the icon name, image, block names and so on. Use the Icon Menu Wizard to change any icon properties.

**Pneumatic, Hydraulic and P&ID icon menus**

The Menu tree structure displays the symbols for the selected component type (pneumatic, hydraulic or P&ID). The Insert Pneumatic Component, Insert
Hydraulic Component and Insert P&ID Component tools are accessed on the Extra Library toolbar.

- Insert Pneumatic Component
- Insert Hydraulic Component
- Insert P&ID Component
Manipulate wire gaps

Insert wire gaps

AutoCAD Electrical automatically inserts a gap/loop when a new wire crosses another. Under some conditions you may need to manually add a loop gap at the point of two crossing lines.

1. Click the arrow on the Insert Wire tool to access the Insert Wire Gap tool.

2. Click the Insert Wire Gap tool.

3. Select the wire to remain solid.

4. Select the crossing wire to have the gap. The gap inserts into the second wire.

**NOTE** You can turn off the automatic gap/loop feature by selecting Solid in the Wiring Style section of the Drawing Properties Style dialog box.
**Remove wire gaps**

Use the Delete Wire Gap command if a gap/loop is no longer needed in an existing wire.

1. Click the arrow on the Insert Wire tool to access the Delete Wire Gap tool.
2. Click the Delete Wire Gap tool.
3. Select the wire segments near the unneeded gaps.
   The gap is removed from the second wire.

**Flip wire gaps**

Use the Flip Gap command to flip the gap to the other wire.

1. Click the arrow on the Insert Wire tool to access the Flip Wire Gap tool.
2. Click the Flip Wire Gap tool.
3. Select the wire that has the gap/loops to flip. You can also window the wires containing the gaps to flip by pressing a W, then windowing the wires.
   AutoCAD Electrical makes the gapped wire solid and flips the gap/loop to the crossing wires.

**Define and insert new ladders**

**Insert new ladder**
There is no limit to the number of ladders that can be inserted into a drawing, but ladders may not overlap each other. You can insert a new ladder at any time. Multiple ladder fragments in the same vertical column need to be
vertically aligned along their left-hand side. Note that these limitations do not apply when X-Y Grid or X-Zone referencing is selected.

1. Click the Insert Ladder tool.
2. Specify the width and spacing of the ladder.
3. Specify the 1st reference, index and rungs.
   Index is the increment number for line reference numbering (default = 1). If you don't want every line reference number to show up then you can use the AutoCAD Erase command to get rid of the extras. Do not erase the top-most line reference number. This is the ladder's MLR block and carries the ladder's intelligence.

   **NOTE** You don't need to enter a value for the length since it is calculated once the 1st reference, index and rung values are set.

4. Specify whether to create a one-phase or three-phase ladder. If you select to create a three-phase ladder, the Width and Draw Rungs options are grayed out.
5. Specify how to draw the rungs.
   No Bus just draws the line reference numbers, while No Rungs just draws the hot and neutral bus with rungs. Add rungs with the AutoCAD Electrical Add Rung command or the Insert Wire tool. Select Yes to automatically include a rung at every reference location (skip = 0) or every other line reference position (skip = 1). You can specify whether to skip rungs; specifying a value of Skip = 4 means that four rungs will be skipped for every one that is drawn.
6. Click OK.
7. Specify the start position of the ladder. Enter a start and end value or pick a point on the drawing.
   During ladder insertion, the current wire type displays at the command prompt. You can override this by typing in the hotkey "T" and selecting a new wire type from the Set Wire Type dialog box. The new wire type becomes the current wire type and the command continues with the ladder insertion.
8 Specify the last reference number for the ladder. If you entered values in the step above, this step is not necessary.

9 Left mouse click to insert the ladder.

**NOTE** Use AutoCAD Move to relocate an entire ladder. Make sure you that get the entire ladder including the very first line reference number (the MLR block insert). Select the Revise Ladder button and then click Cancel on the dialog. Using this command forces AutoCAD Electrical to re-read and update its internal ladder location list.

### Set ladder defaults

You can set the new ladder width and spacing defaults by modifying a template or the attribute definitions. These default values are carried on the invisible WD_M block.

**Using a template**

Use these steps if you are using a template drawing with a pre-inserted WD_M block.

1 Open the template drawing in AutoCAD Electrical (it has a "dwt" extension).

2 Select Projects ➤ Drawing Properties.

3 In the Drawing Properties dialog box, click the Drawing Format tab.

4 In the Ladder Defaults section, make the appropriate changes and click OK.

5 Save and exit the template drawing.

**Changing attribute values**

1 Open the WD_M drawing (found at: \Program Files [(x86)]\Autodesk\Acade [version]\libs\jic1\WD_M.dwg).

2 Change the default values of the attribute definitions.
   - **DLADW**: default ladder width
   - **RUNGDIST**: default ladder rung spacing
■ **PH3SPACE**: default 3-phase spacing

3 Save and exit the drawing.

You can permanently change the relative position of line reference numbers and text size by modifying the RUNGFIRST attribute definition.

1 Display the MLR block’s drawing. The file names (found at: \Program Files (x86)\Autodesk\Acade [version]\libs\jic1\) are:
   - **WD_MLRH.dwg**: for horizontal rung / vertical ladders
   - **WD_MLRV.dwg**: for vertical rung / horizontal ladders
   - **WD_MLRHX.dwg**: hexagon-shaped user block (horizontal rung / vertical ladders)
   - **WD_MLRVX.dwg**: hexagon-shaped user block (vertical rung / horizontal ladders)

2 Change the default values as desired, but do not delete any of the attributes you find.

3 Move or change the text size of the RUNGFIRST attribute definition.

4 Save and exit the drawing.

**Insert ladder**

There is no limit to the number of ladders that can be inserted into a drawing, but ladders can not overlap each other. You can insert a new ladder at any time. Multiple ladder fragments in the same vertical column must be vertically aligned along their left-hand side. Note that these limitations do not apply when X-Y Grid or X-Zone referencing is selected.

**Access:**

Click the Insert Ladder tool.
From the Wires menu, select Ladders ➤ Insert Ladder.

During ladder insertion, the current wire type displays at the command prompt. You can override this by typing in the hotkey “T” and selecting a new
wire type from the Set/Edit Wire Type dialog box. The new wire type becomes the current wire type and the command continues with the ladder insertion.

Width
Specifies the width of the ladder.

Spacing
Specifies the spacing between each rung.

Length
Specifies both the length of the ladder and the number of rungs. You can enter the total ladder length, the number of ladder rungs, or leave both blank and manually pick the beginning and ending points of the ladder.

1st reference
Specifies the beginning line reference for the ladder. Index is the increment number for line reference numbering (default = 1). If you don't want every line reference number to show up then you can use the AutoCAD Erase command to get rid of the extras. Do not erase the top-most line reference number. This is the ladder's MLR block and carries the ladder's intelligence.

Phase
Specifies whether to create a one-phase or three-phase ladder. If you select to create a three-phase ladder, the Width and Draw Rungs options are grayed out.

Draw rungs
Specifies how to draw the rungs. No Bus just draws the line reference numbers, while No Rungs just draws the hot and neutral bus with rungs. Add rungs with the AutoCAD Electrical Add Rung command or the Insert Wire tool. Select Yes to automatically include a rung at every reference location (skip = 0) or every other line reference position (skip = 1). You can specify whether to skip rungs; specifying a value of Skip = 4 means that four rungs will be skipped for every one that is drawn.
Modify an existing ladder

Renumber an existing ladder

1. Click the arrow on the Insert Ladder tool to access the Revise Ladder tool.

2. Click the Revise Ladder tool.

3. Enter the new beginning line reference number and click OK.

   **NOTE** This does not update existing components or wire numbers.

4. Select Components ➤ Component Tagging ➤ Retag Components to update component tags to match the new line reference number.

5. Select Wires ➤ Insert Wire Numbers to update the wire numbers. Select Tag/retag ALL.
   If off-page wire connections are involved, make sure that you click Cross-reference Signals on the Wire Tagging dialog box.

6. Click Pick Individual Wires and select the wires to retag.

Change the size of a ladder

You can use the Revise Ladder tool to shorten, lengthen, widen, or compress an existing ladder.
To lengthen or shorten the ladder:

1. Click the arrow on the Insert Ladder tool to access the Revise Ladder tool.
2. Click the Revise Ladder tool.
3. Change the column of line reference numbers to match the appropriate ladder length and click OK.
4. Select the AutoCAD Stretch command from the menu to lengthen or shorten the ladder.

To widen or compress the ladder:

1. Click the Scoot tool.
2. Select the ladder's vertical rail and pull it out or push it in.
3. Select Components ➤ Align to put components back into neat columns.
4. Select the components to align and press Enter.

**Reposition a ladder**

You can reposition an existing ladder on your drawing using the AutoCAD Move command.

1. Select the AutoCAD Move command from the menu.
2. Select the ladder, making sure to include the very first line reference number.
4. Click Cancel.
   This forces AutoCAD Electrical to reread and update its internal ladder location list.
Change rung spacing

1. Click the arrow on the Insert Ladder tool to access the Revise Ladder tool.
2. Click the Revise Ladder tool.
3. Change the column of line reference numbers to the desired rung spacing and ladder length.
4. Select Components ➤ Scoot (or the AutoCAD Stretch command) to move the existing rungs to their new rung locations.

Insert rungs

AutoCAD Electrical finds the nearest line reference location and places a ladder rung at that reference position (both bus wires must be visible on the screen for this to work).

1. Click the Add Rung tool.
2. Select a blank space anywhere between the hot and neutral bus wires to add the rung.
   During rung insertion, the current wire type displays at the command prompt. You can override this by typing in the hotkey “T” and selecting a new wire type from the Set/Edit Wire Type dialog box. The new wire type becomes the current wire type and the command continues with the rung insertion.
   If the new rung encounters a schematic device floating in space, it tries to break the wire across the device.

Convert line reference numbers

Use this to convert the upper-most line reference number on a non-intelligent ladder to be aware of AutoCAD Electrical.

1. On the Conversion toolbar, click the Convert Ladder tool.
2 Select the top line reference number and press Enter.
The Modify Line Reference Numbers dialog box displays.

3 Specify the desired rung spacing, ladder length, and starting reference number.

4 Click OK.

**Modify line reference numbers**

This tool adjusts the line reference numbering along the side of the ladders; however it doesn’t change existing ladder rung spacing. When converting line reference numbering using the Convert Ladder tool, select only the first line reference number to determine location, size, and justification of the new line reference numbers being converted. Once OK is pressed, existing ladder information is erased and the new smart ladder is inserted.

**NOTE** Updating the ladder’s reference numbers does not update existing components or wire numbers.

**Access:**

Click the arrow on the Insert Ladder tool to access the Revise Ladder tool. From the Wires menu, select Ladders ➤ Revise Ladder.

On the Conversion toolbar, click the Convert Ladder tool. Select the top line reference number and press Enter.

From the Projects menu, select Conversion Tools ➤ Convert Drawing ➤ Convert Ladder. Select the top line reference number and press Enter.

**Rung spacing**

Specifies the spacing between each rung.

**Rung count**

Specifies the number of rungs for each ladder.

**Reference numbers**

Specifies the length of the ladder by adjusting the begin and end reference numbers. The very first line reference number on each ladder is a smart AutoCAD block and attributes. All the rest of the numbers are just text entities (that can be erased, if desired, but do not erase the top or first line reference number).
Index
Specifies the line reference number increment value (default=1). Selecting Redo forces a refresh of line reference numbering.

Wire number format
Specifies the format for placing wire numbers. (default = configure wire number format value) You can specify a unique automatic wire numbering format on a per ladder basis (ex: one ladder of 24 volt wiring requiring wire numbers with a unique prefix or suffix, ex: %NVDC).

Overview of wire numbers

Wire numbers are blocks or attributes inserted on a line wire entity. AutoCAD Electrical assigns each wire number type to its own layer. You can assign a different color to each of these layers so you can easily tell them apart. There are 4 types of wire numbers: Normal, Fixed, Extra, and Signal.

Normal
Wire numbers that are free to update when you rerun the Insert Wire Numbers command.

Fixed
Wire numbers that are fixed to their current value. They do not update with subsequent runs of the Insert Wire Numbers command.

Extra
Extra copies of the Normal or Fixed wire number that are assigned to a given wire network. A single wire network has one Normal or one Fixed wire number (but not both) and may have many extra copies of the wire number inserted at various locations on the network.

Terminal/Signal
Wire numbers for terminals and signal arrows.
Wire tag formats

The origin of a wire number block must lie on the wire segment, though the text attribute may be moved away from the wire. AutoCAD Electrical uses the concept of a wire tag format string with replaceable parameters. One replaceable parameter, %N, must always be part of the wire format string. A typical format string might be just this %N parameter.

Replaceable parameters for defining a default wire number tag format are:

- %S: Drawing's sheet number
- %D: Drawing number
- %N: Sequential or reference-based number applied to the component
- %X: Suffix character position for reference-based tagging (not present = end of tag)
- %P: IEC-style project code (default for drawing)
- %I: IEC-style "installation" code (default for drawing)
- %L: IEC-style "location" code (default for drawing)

Examples: Wire beginning on line reference "100" of sheet "02" yields these wire number tags for the following formats:

- %N: wire number = 100
- W%N: wire number = W100
- %S-%N: wire number = 02-100
- %S%N: wire number = 02100
- %S : %N: wire number = 02:100
Check line entities

Some problems with wire numbering (or lack thereof) can be traced to line wires not being on a valid wire layer. Use the Show Wires tool to make a quick check of what is a wire and what is not. The solution to the problem may be as simple as moving some line entities to a valid AutoCAD Electrical wire layer (per the drawing's property setting for wire layer names).

Show Wires highlights every line entity in bright red that is found to be on a valid AutoCAD Electrical wire layer. Select the AutoCAD Redraw command to remove the highlights.

1. Click the drop-down arrow on the Insert Wire tool to access the Show Wires tool.

2. Click the Show Wires tool.

3. Select whether to show the wires. All lines (wires) on wire layers are highlighted in bright red.

4. Select whether to show the origin point for each wire number attribute text entity. The origin of a wire number block must lie on the wire segment, though the text attribute may be moved away from the wire.

   **NOTE** Do not use the AutoCAD Move command to move the attribute.

5. Select whether to highlight the wire number attribute text pointed to by each Xdata pointer. Xdata pointers identify which wire number insert goes with which wire segment.

Insert special wire numbering

This tool speeds up the process of inserting special wire numbering generally associated with 3-phase bus and motor circuits. It can also be used in a
continuous mode. You can insert a long series of incrementing wire numbers and assign each, in turn, to the wires you pick.

1. Click the arrow on the Insert Wire Numbers tool to access the 3 Phase Wire Numbers tool.

2. Click the 3 Phase Wire Numbers tool.

3. Enter a base starting number in the edit box or click Pick to select an existing attribute value on the active drawing. If the picked text carries a numeric substring, this is extracted and inserted into the Base edit box.

4. Enter an optional Prefix and/or Suffix value or choose from a default pick list by clicking List. The prefix or suffix value can be a comma-delimited string with each entry applied in sequence to the Wire Numbers section shown at the right-hand side of the dialog box.

5. Set the hold and increment options for each of the edit box values as required. Pay attention to the proposed generated wire numbers in the right-hand side of the dialog box.

6. Set the number of wire numbers needed in the bottom right-hand side of the dialog box.

TIP Select None to potentially generate a continuous list of incrementing wire numbers.

7. Select OK.

8. Select the wires for the wire numbers, either single picks or using the Fence selection. Fence selection inserts the wire numbers at the crossing points while single selections uses the drawing’s default wire number placement (for example, centered on the wire segment).

Tips and Hints

- Tab out of an edit box to start the Wire Numbers listing to update.
You can add to the default prefix and suffix list display. Create an ASCII text file and list each prefix/suffix entry, one per line in the file. Name the file <projectname>.3ph (where "projectname" is the name of your active project) or default.3ph and put the file in any folder that is part of AutoCAD Electrical’s search path list.

The wire number assignments go in as Fixed (they will hold the values that you have assigned and will not retag with a subsequent run of the Insert Wire Numbers command).

**NOTE** If this tool does not meet your needs, use the Edit Wire Number tool to assign fixed wire numbers one at a time.

**Automatically insert wire numbers**

This tool quickly processes and tags wires on the current drawing, wires in the project, or individually picked wires.

1. Click the Insert Wire Numbers tool.
2. Select to tag all wires or only new wires.
3. Select to process and tag wires with sequential wire numbers or with wire numbers based upon the wire network’s line reference location.
4. (Optional) Set other tagging options such as:
   - specify the wire tag format to use
   - specify the wire layer format
   - force all wire numbers to be fixed
   - update cross-reference text on wire signal source and destination symbols
   - update the database for wire signal source and destination symbols
5. Select to tag the selected wires, wires on a drawing, or wires in a project.

**Wire tagging**
AutoCAD Electrical processes wire line entities into wire networks, and inserts or updates wire numbers associated with them.

**Access:**

- Click the Insert Wire Numbers tool.
- From the Wires menu, select Insert Wire Numbers.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To do</td>
<td>Specifies to process all the wiring or just the un-tagged (new) wires.</td>
</tr>
<tr>
<td>Wire tag mode</td>
<td>Specifies to use the sequential or line-reference based setting for the drawing.</td>
</tr>
<tr>
<td>Format override</td>
<td>Specifies the wire tag format to use for overriding the format set in the Drawing Properties dialog box.</td>
</tr>
<tr>
<td>Use wire layer format overrides</td>
<td>Overrides the default wire number format (set in the Layers section of the Drawing Properties ➤ Drawing Format dialog box) by using layer-defined formats.</td>
</tr>
<tr>
<td>Insert as fixed</td>
<td>Forces all wire numbers to be fixed (they do not update if wire number retagging is run again at a later date).</td>
</tr>
<tr>
<td>Cross-reference Signals</td>
<td>Updates cross-reference text on wire signal source and destination symbols.</td>
</tr>
<tr>
<td>Freshen database (for Signals)</td>
<td>Updates the database for wire signal source and destination symbols.</td>
</tr>
<tr>
<td>Project-wide</td>
<td>Tags or retags wiring project-wide.</td>
</tr>
<tr>
<td>Pick individual wires</td>
<td>Tags or retags the selected wiring on the current drawing only.</td>
</tr>
<tr>
<td>Drawing-wide</td>
<td>Tags or retags wiring on the current drawing.</td>
</tr>
</tbody>
</table>
**Wire tagging (project-wide)**

AutoCAD Electrical processes wire line entities into wire networks, and inserts or updates wire numbers associated with them across a project.

**Access:**

- Click the Insert Wire Numbers tool. Select Sequential and click Project-Wide.
- From the Wires menu, select Insert Wire Numbers. Select Sequential and click Project-Wide.

<table>
<thead>
<tr>
<th>Wire tag mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequential (1st tag defined for each drawing)</td>
<td>Starts at the wire number specified for that drawing (as set in the Drawing Properties &gt; Wire Numbers (page 493) dialog box). A starting wire number must be assigned for each drawing.</td>
</tr>
<tr>
<td>Sequential (consecutive drawing to drawing)</td>
<td>Allows you to type in a starting wire number and increments from there, ignoring the defined setting of the starting wire number.</td>
</tr>
<tr>
<td>Reference-based tags</td>
<td>Sets the wire number based on the line-reference value.</td>
</tr>
</tbody>
</table>

**To do**

- Specifies to process all the wiring or just the untagged (new) wires.

**Cross-reference Signals**

- Updates cross-reference text on wire signal source and destination symbols.

**Freshen database (for Signals)**

- Updates the database for wire signal source and destination symbols.

**Format override**

- Specifies the wire tag format to use for overriding the format set in the Drawing Properties dialog box.
Overrides the default wire number format (set in the Layers section of the Drawing Properties ➤ Drawing Format dialog box) by using layer-defined formats.

Insert as fixed
Forces all wire numbers to be fixed (they do not update if wire number retagging is run again at a later date).

3 phase wire numbering
This tool speeds up the process of inserting special wire numbering generally associated with 3-phase bus and motor circuits. It can also be used in a continuous mode. You can insert a long series of incrementing wire numbers and assign each, in turn, to the wires you pick.

You can add to the default prefix and suffix list display. Create an ASCII text file and list each prefix/suffix entry, one per line in the file. Name the file <projectname>.3ph (where "projectname" is the name of your active project) or default.3ph and put the file in any folder that is part of AutoCAD Electrical's search path list.

Access:
Click the arrow on the Insert Wire Numbers tool to access the 3 Phase Wire Numbers tool.
From the Wires menu, select Wire Numbers Miscellaneous ➤ 3 Phase Wire Numbers.

Prefix
Specifies the prefix value for the wire numbers. Enter a value or click List to choose from a default pick list.

Base
Specifies the base starting number for the wire numbers. Enter a value or click Pick to select an existing attribute value on the active drawing.

Suffix
Specifies the suffix value for the wire numbers. Enter a value or click List to choose from a default pick list.

Hold/Increment
Specifies whether to hold or increment the prefix, base, and suffix values for all wire numbers that are entered onto the drawing. For example, if you set Base = 100/Increment and Suffix = L1/Hold, the wire numbers will be 100L1, 101L1, 102L1.
Wire Numbers

Displays a preview of the wire numbers to be inserted onto the drawing.

**TIP** Tab out of an edit box to trigger the Wire Numbers listing to update.

---

Maximum

Specifies the maximum number of wire numbers. When you select a new option (3, 4, or None) the Wire Numbers section automatically updates with a preview based on the value selected in relation to the options specified for the prefix, base, and suffix values.

**TIP** Select None to potentially generate a continuous list of incrementing wire numbers

---

Set wire number placement

You can set the wire number placement for new wires inserted in a single drawing or for the entire project. This does not update existing wire numbers.
TIP Change the position of an existing wire number using the Toggle Wire Number In-Line tool.

1 Click the Project Manager tool.

2 In the Project Manager, right-click on the project name and select Properties (or click the drawing name, and select Properties ➤ Drawing Properties).
If you change this setting in the project properties, the drawings already in the project do not get this setting.

NOTE You can also automatically set wire number placement using the Drawing Properties tool. Follow the steps below.

3 In the Project or Drawing Properties dialog box, click the Wire Numbers tab.

4 In the Wire Number Placement section, select how you want to automatically place new wire numbers: above, below, or inline of the wire.
   ■ Above Wire: Places the wire number above the physical wire.
   ■ In-Line: Places the wire number in line with the wire. Click Gap Setup to define the spacing between the wire number and the wire itself.
   ■ Below Wire: Places the wire number below the physical wire.

5 Click OK.

NOTE Use the Copy Wire Number (In-Line) tool to insert individual wire numbers inline with the wire rather than above or below the wire in the active drawing.

Drawing properties: wire numbers tab
Apply a drawing-specific wire number settings that are maintained inside the drawing's WD_M block.

Access:

Click the Project Manager tool. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.

**Wire Number Format**

Wire number tags can be sequential or reference-based.

**Format**

Specifies the way new wire number tags are created. The wire number tag format must include the %N parameter that is the base sequential or reference-based value per the selection above. If your format includes the sheet number %S parameter or the drawing number %D parameter, you must enter the values in the edit boxes in the Drawing Properties ➤ Drawing Settings dialog box.

**NOTE** For reference-based wire number tagging, individual items in the suffix list are applied to the wire tags to keep multiple wires in the same reference location unique. These are added to the end of the tag, but you can force AutoCAD Electrical to insert the suffix character somewhere within the tag format. Use the Suffix position parameter, %X, in the component tag format (for example, %X%N).

**Search for PLC I/O address on insert**

Specifies to use PLC I/O address values for wires that connect to an addressed I/O point. This overrides both Sequential and Reference-based tagging. New wires or wire renumbering on the current drawing shows PLC I/O address-based wire numbers automatically.

**NOTE** Like component tags, AutoCAD Electrical uses the concept of a wire tag format string with replaceable parameters. The %N parameter must always be part of the wire format string. A typical format string might be just this %N parameter.
**Sequential**

Enter the starting sequential number (alpha, numeric, or alphanumeric) for the drawing. If you enter the same starting sequential number for every drawing of your wiring diagram set, AutoCAD Electrical confirms at insertion time that a new sequential wire number tag is not repeated on any other drawing.

If you set DEMO1 to 100 and DEMO2 to 200, the wire numbers on DEMO1 start at 100 and those on DEMO2 start at 200. If DEMO1 has more than 100 wire numbers it starts using wire number 200 and above while DEMO2 would begin its wire numbers where DEMO1 left off (making sure that duplicate wire numbers are not assigned).

**Increment**

The default is "1." Setting it to "2" with a starting sequential of "1" would yield wire numbers 1, 3, 5, 7, 9, 11, and so on.

**Line Reference**

Sets the wire number tag suffix. This list is used to create unique reference-based wire number tags for multiple wire networks beginning at the same reference location (such as wire network beginning at a location per line reference number, X-Y grid reference, or X-Zone reference).

**Suffix Setup**

Displays a suffix list. List suffix characters for wire numbers beginning on the same line reference or in the same zone (to keep wire numbers unique). Select one of the 4 pre-defined suffix lists or enter your own custom suffix list.

### New Wire Number Placement

**NOTE** The Insert Wire Number tool does not take the current wire number setting (in-line, above or below) into account when updating existing wire numbers; this setting is used only when inserting new wire numbers. Use the Toggle Wire Number In-Line tool for flipping existing wire numbers among the 3 modes.

<table>
<thead>
<tr>
<th>Placement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Above Wire</strong></td>
<td>Places the wire number above the physical wire.</td>
</tr>
<tr>
<td><strong>In-Line</strong></td>
<td>Places the wire number inline with the wire.</td>
</tr>
</tbody>
</table>
Gap Setup
Defines spacing between the inline wire number and the wire itself.

Below Wire
Places the wire number below the physical wire.

Offset
Specifies to insert the wire number tags the specified offset distance.

Centered
Specifies to insert the wire number tags in the center of each wire segment.

Offset Distance
Specifies a fixed, user-defined offset distance from the left or top of the first wire segment found on the wire network.

Leaders
(This option is unavailable for in-line wire numbers.) AutoCAD Electrical places wire numbers on leaders when it determines that the wire number text bumps into something (it does not check if the leader itself will overlay another object). Select the method for inserting new wire numbers as leaders: As Required, Always, or Never.

NOTE: This change does not affect wire numbers that are already present on the drawing.

Project properties: wire numbers tab
Modify your project default settings for wire numbers. All information defined in this tab is saved to the project definition file as project defaults and settings

Access:
Click the Project Manager tool. In the Project Manager, right-click on the project name and select Properties. From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click on the project name and select Properties.
**Wire Number Format**

Wire number tags can be sequential or reference-based.

**Format**

Specifies the way new wire number tags are created. The wire number tag format must include the %N parameter that is the base sequential or reference-based value per the selection above. If your format includes the sheet number %S parameter or the drawing number %D parameter, you must enter the values in the edit boxes in the Drawing Properties ➤ Drawing Settings dialog box.

**NOTE** For reference-based wire number tagging, individual items in the suffix list are applied to the wire tags to keep multiple wires in the same reference location unique. These are added to the end of the tag, but you can force AutoCAD Electrical to insert the suffix character somewhere within the tag format. Use the Suffix position parameter, %X, in the component tag format (for example, %X%N).

**NOTE** AutoCAD Electrical provides a predefined format for you to use or you can enter your own format using replaceable parameters. (page 126)

**Search for PLC I/O address on insert**

Specifies to use PLC I/O address values for wires that connect to an addressed I/O point. This overrides both Sequential and Reference-based tagging. New wires or wire renumbering on the current drawing will show PLC I/O address-based wire numbers automatically.

**NOTE** Like component tags, AutoCAD Electrical uses the concept of a wire tag format string with replaceable parameters. The %N parameter must always be part of the wire format string. A typical format string might be just this %N parameter.

**Sequential**

Enter the starting sequential number (alpha, numeric, or alphanumeric) for the drawing. If you enter the same starting sequential number for every drawing of your wiring diagram set, AutoCAD Electrical confirms at insertion time that a new sequential wire number tag is not repeated on any other drawing.
If you set DEMO1 to 100 and DEMO2 to 200, the wire numbers on DEMO1 start at 100 and those on DEMO2 start at 200. If DEMO1 has more than 100 wire numbers it starts using wire number 200 and above while DEMO2 would begin its wire numbers where DEMO1 left off (making sure that duplicate wire numbers are not assigned).

Increment

The default is "1". Setting it to "2" with a starting sequential of "1" would yield wire numbers 1, 3, 5, 7, 9, 11, and so on.

Line Reference

Sets the wire number tag suffix. This list is used to create unique reference-based wire number tags for multiple wire networks beginning at the same reference location (such as wire network beginning at a location per line reference number, X-Y grid reference, or X-Zone reference).

Suffix Setup

Displays a suffix list. List suffix characters for wire numbers beginning on the same line reference or in the same zone (to keep wire numbers unique). Select one of the 4 pre-defined suffix lists or enter your own custom suffix list.

Wire Number Options

Based on Wire Layer

Assigns a different wire number format based on the wire layer.

Layer Setup

Overrides the default wire number format by using layer defined formats. Change the wire layer name, wire number format, starting wire sequence, and wire number suffix.

Based on Terminal Symbol Location

Specifies to use a wire number terminal on a wire network as the wire network's line reference value for calculating a reference-based wire number. For example, a wire network starts at line reference 100 and drops down and over on line reference 103. If there is a schematic terminal symbol that carries the WIRENO attribute located on line reference 103 and this option is enabled, AutoCAD Electrical calculates a reference-based wire number using 103 instead of 100. If there are multiple wire number terminals on this
network, the line reference value of the upper left-most terminal is used.

**Hidden on Wire Network with Terminal Displaying Wire Number**

Specifies to automatically hide the wire number for a wire network that has a wire number-type terminal.

**On per Wire Basis**

Specifies to assign a wire number for each wire rather than the default one wire number per wire network.

**Exclude**

Specifies the wire number ranges to exclude if using sequential wire numbers. (applied to the %N part of the wire number tag format)

Syntax is `<starting>-<ending>` to show range (for example 1000-1499). Multiple ranges are allowed and must be separated with a comma or semi-colon (for example, 1000-1099;2500-2599;). You can also use 2,4,6 or 2;4;6 for values not in a range.

**New Wire Number Placement**

*NOTE* The Insert Wire Number tool does not take the current wire number setting (in-line, above or below) into account when updating existing wire numbers; this setting is used only when inserting new wire numbers. Use the Toggle Wire Number In-Line tool for flipping existing wire numbers among the 3 modes.

**Above Wire**

Places the wire number above the physical wire.

**In-Line**

Places the wire number in line with the wire.

**Gap Setup**

Defines spacing between the wire number and the wire itself.

**Below Wire**

Places the wire number below the physical wire.

**Centered**

Specifies to insert the wire number tags in the center of each wire segment.

**Offset**

Specifies to insert the wire number tags the specified offset distance.
**Offset Distance**

Specifies a fixed, user-defined offset distance from the left or top of the first wire segment found on the wire network.

**Leaders**

(This option is unavailable for in-line wire numbers) AutoCAD Electrical places wire numbers on leaders when it determines that the wire number text bumps into something (it does not check if the leader itself overlays another object). Select the method for inserting new wire numbers as leaders: As Required, Always, or Never.

**NOTE** This change does not affect wire numbers that are already present on the drawing.

**Wire Type**

Displays the Rename User Columns dialog box that is used for renaming User1 to User20 header columns in the Set Wire Type, Create/Edit Wire Type, and Change/Convert Wire Type dialog boxes.
Find or replace wire number text

This tool lets you find and replace wire number text values or find and replace sub-strings within those values. You can do this on the current drawing or across the project drawing set.

1. Click the drop-down arrow on the Edit Wire Number tool to access the Find/Replace Wire Numbers tool.

2. Click the Find/Replace Wire Numbers tool.

3. Specify whether to replace the text only if the entire wire number text string matches the Replace value or to replace the text anywhere within the wire number text string.

4. Enter up to three different Find/Replace values, and then click Go.

5. Choose to process the project, the current drawing, or selected wire numbers on the current drawing. AutoCAD Electrical scans the selection looking for all the AutoCAD Electrical wire number text values and replacing text as instructed.

Find or replace wire numbers

Use this tool to find and replace wire number text values, or find and replace substrings within those values. You can do this on the active drawing or across the project drawing set.

Access:

Click the arrow on the Edit Wire Number tool to access the Find/Replace Wire Numbers tool.
Access:

From the Wires menu, select Wire Number Miscellaneous ➤ Find/Replace Wire Numbers.

**Full, exact match**
Specifies to replace the text only if the entire text value matches the find value.

**Substring match**
Specifies to replace the text if any part of the text value matches the find value.

**First occurrence only**
Specifies that only the first occurrence within the text value should be replaced.

**Find**
Specifies the value you wish to find.

**Replace**
Specifies the text string to replace the find value with.

**Encode wire color/gauge information into wire numbers**

Use the Wire Layer/Format Overrides tool to have wire numbering automatically insert with wire color, gauge, and type information encoded.
into the wire number itself. For example, you can have wire numbers like 123-RD-14 or 124-BLK-10 instead of 123 or 124.

1. Click the Project Manager tool.
2. In the Project Manager, right-click the project name, and select Properties.
3. In the Project Properties dialog box, click the Wire Numbers tab.
4. In the Wire Number Options section, select Based on Wire Layer and then click Layer Setup.
   The Assign Wire Numbering Formats by Wire Layers dialog box opens. This is where you enter each wire layer name and the wire number format that you want to see for wire numbers on that wire layer. For example, let's say you routinely use wire layers "RED_14_THHN" and "BLK_10_XHHN" in drawings in your project. Whenever you have a wire number on the red wire, you want AutoCAD Electrical to automatically append a ",RD-14" suffix to the wire number. For wire numbers generated on wires drawn on layer BLK_10_XHHN you want AutoCAD Electrical to automatically append a ",BLK-10" suffix to the wire number.
5. In the Assign Wire Numbering Formats by Wire Layers dialog box, enter RED_14_THHN in the Wire Layer Name box and enter %N-RD-14 in the Wire Number Format For Layer box. Click Add.
6. Enter BLK_10_XHHN in the Wire Layer Name box and enter %N-BLK-10 in the Wire Number Format For Layer box. Click Add.
7. Repeat until you have all possible wire layers set up.
   This information is stored in the project's .wdp file and is applied across all drawings listed in your project.
8. Click OK.

Now when you run the Insert Wire Numbers command on any drawing in your project, nonfixed wire numbers update if they are associated with wires that are tagged in your override list.
Assign wire numbering formats by wire layers

The default format of a wire number is defined in the AutoCAD Electrical Project Properties dialog box. This format is used for all wire numbers inserted on a drawing. However, there may be times when you want certain types of wires to be numbered in a different way (i.e. to carry a different format). AutoCAD Electrical allows you to override the default wire number format by using layer defined formats. For example, your default wire number format is %N, meaning it takes on the line reference number (in Reference Mode) or the sequential number (in Sequential Mode). If there are multiple wire numbers on a particular line reference a suffix is used from the defined suffix list to make the wire number unique.

Access:

Click the Insert Wire Numbers tool. Click Use Wire Layer Format Overrides Setup. From the Wires menu, select Insert Wire Numbers. Click Use Wire Layer Format Overrides Setup.

NOTE You can also access this dialog box by selecting Based on Wire Layer and then clicking Layer Setup in the Wire Number Options section of the Project Properties ➤ Wire Numbers dialog box.

| Wire list | Lists all defined wire layer formats. |
| Add | Adds the new wire layer format to the list. |
| Update | Updates the selected wire layer format with the changes you've specified in the dialog box. |
| Delete | Removes the new wire layer format from the list. |
| Wire layer name | Specifies the name for the wire layer to modify. You may type the layer name or select from the list of valid wire layers. Wild cards are allowed. |
| List | Displays a list of valid wire layers. |
| Default | Automatically enters the default value for the format, sequence start, and suffix list fields. |
Wire number format for layer:
Defines the format override.

Starting wire sequence:
Specifies the sequential start number for the layer. Use this if you are using Sequential Mode.

Wire number suffix list for layer:
Specifies a unique suffix list. The suffix list must be a comma delimited string. Use this if you are using Reference Mode.

**Replaceable parameters for device tagging and wire numbering**

- **%F** Component family code string (ex: "PB", "SS", "CR", "FLT", "MTR")
- **%S** Drawing's sheet number (ex: "01" entered in upper right)
- **%D** Drawing number
- **%G** Drawing’s wire layer name
- **%N** Sequential or Reference-based number applied to the component
- **%X** Suffix character position for reference-based tagging (not present = end of tag)
- **%P** IEC-style project code (default for drawing)
- **%I** IEC-style installation code (default for drawing)
- **%L** IEC-style location code (default for drawing)
- **%A** Project drawing list’s SEC value for active drawing
- **%B** Project drawing list’s SUB-SEC value for active drawing

**NOTE** If you include %I or %L in your component’s Tag code, you will be prompted to recalculate the component’s tag if you change the Installation or Location value of the component once it has been inserted.
Fix Wire Numbering

Fix a wire number

In some cases, you may find that certain wire numbers must be preassigned. These might include motor wiring that needs to include special suffix values or other wiring, such as instrumentation, that might not follow the default numbering convention. Manually edit the wire number and flip it to fixed.
Fixing a wire number means that the wire number tag is left unchanged if later processed or reprocessed by the automatic wire numbering utility.

1 Click the Edit Wire Number tool.
2 Select a wire or select an existing wire number. If a wire number exists, the Modify/Fix/Unfix dialog box displays. However, if a wire number doesn’t exist on the selected wire, the Insert Wire Number dialog box displays.
3 Edit the wire number or enter a new wire number. If you are inserting a wire number, use the arrows or click Pick to select the appropriate wire number. Pick speeds up the task if you have a number of special wire numbers to manually edit.
4 Select to make the wire number visible or hidden.
5 If you want the wire number to be fixed, select Fixed and click OK. If the wire number is already fixed and you want to turn it back into a regular wire number, clear the check box and click OK.

Fix all wire numbers

There may be times when you want to fix all or many wire numbers on a drawing at their current values. Use the Fix Wire Numbers tool and identify all of the wiring you want AutoCAD Electrical to mark as fixed.

1 Click the arrow on the Edit Wire Number tool to access the Fix Wire Numbers tool.
2 Click the Fix Wire Numbers tool.
3 Select a wire number or component to fix.
4 Right-click when you are done selecting the wires. You can check whether the wire is fixed by clicking the Edit Wire Number tool, selecting the wire, and reviewing the dialog box.

Fix/unfix all wire numbers project-wide
You can quickly fix or unfix all wire numbers across the active project using the Project-Wide Utilities tool.

1. Click the arrow on the Project Manager tool to access the Project-Wide Utilities tool.

2. Click the Project-Wide Utilities tool.

3. In the Project-Wide Utilities dialog box, Wire Numbers section, select Set all wire numbers to fixed or Set all wire numbers to normal, and click OK.

4. Select the drawings to process and click OK.

**Modify/fix/unfix**

When a wire number is fixed, the wire number attribute is renamed and moved to a special fixed wire number layer. Assigning a different color to this layer makes it easy to identify which wire numbers are fixed and which are normal. The layer name for fixed wire numbers is entered in the Define Layers dialog box (from the Drawing Properties ➤ Drawing Format dialog box).

**Access:**

Click the Edit Wire Number tool.
From the Wires menu, select Edit Wire Number.

**Wire Number**

Specifies the wire number to edit. Use the arrows to scroll through possible wire numbers.
If you enter an existing wire number during the insert/edit process, a warning dialog displays (turn off the warning in the Project Properties ➤ Project Settings dialog box. This temporarily disables the warning dialog box for the current session of AutoCAD Electrical). This alerts you of the duplication and suggests alternative wire number based on the user-defined format. You can select whether to use the duplicated wire number, use a new wire number that is suggested, or you can type in a wire number.
NOTE An error log file is created for every project regardless whether you chose to display the real time warning dialog or not. The real time warning is saved in the log file named "<project_name>_error.log" and is saved in the User subdirectory.

Pick
Prefills the wire number edit box with the text entity you select. Use Up or Down to quickly increment or decrement the wire number.

Make it Fixed
Fixes the wire number so that it does not change if later processed by the automatic wire numbering utility.

Visible/Hidden
Displays or hides the wire number on the drawing. Hidden wire numbers are still present and appear in wire reports.

Zoom
Restores the previous screen view (a zoom extents may be done to follow an untagged wire that travels off screen).

**Project-wide utilities**
You can have multiple drawings open at any time. However, in order to maximize performance and memory usage you may want to minimize the number of open drawings when running project-wide commands.

Access:

- Click the Project-Wide Utilities button.
- From the Projects menu, select Project-Wide Utilities.

**Wire Numbers**
Select to keep wire numbers the same, erase specified wire numbers, reset specified wire numbers, or set wire numbers to fixed or normal.

**Signal Arrow Cross-reference text**
Select to maintain the signal arrow cross-reference text or to remove all signal arrow cross-reference text across the current project.
Component Tags

Select to maintain the component tags or to set all parent component tags to fixed or normal across the current project.

For each drawing

Enter the name or browse to a command script file to be used for each drawing in the current project or to purge all blocks.

Change Attribute

<table>
<thead>
<tr>
<th>Change Attribute Size</th>
<th>Click Setup to select the attributes to change, and then enter the height and width definitions for the selected attributes.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NOTE</strong></td>
<td>If you do not want the attribute height or width to change, do not enter a value definition.</td>
</tr>
</tbody>
</table>

| Change Style          | Click Setup to select a text font to apply to the text style used on component attributes.                        |
Reposition Wire Numbers

Scoot wire numbers

If you want to move a wire number along its wire segment, use Scoot and pick right on the wire number.

1. Click the Scoot tool.
2. Select the wire number to slide along its connected wires or select the wire segment itself to scoot the entire wire, including the components, along the bus. You can scoot an entire rung up or down. A rectangle drawn in temporary graphics indicates the selected items.
3. Move your cursor to the desired position and click your mouse button.
   The items scoot and reconnect.

Move a wire number

If you want to move an existing wire number from one segment of the network to another, use the Move Wire Number command.

1. Click the arrow on the Edit Wire Number tool to access the Move Wire Number tool.
2. Click the Move Wire Number tool.
3. Select the wire segment where you want the wire number repositioned (you don't have to first pick on the existing wire number).
   The wire number automatically moves to the selected position.

Rotate a wire number
1 Click the arrow on the Move/Show Attribute tool to access the Rotate Attribute tool.

2 Click the Rotate Attribute tool.

3 Select the wire number text to rotate 90 degrees from its current orientation.
   Each click on the wire number text rotates it another 90 degrees counter-clockwise.

Reposition the wire number text with an attached leader

If you want to reposition the wire number text with an attached leader, use the Wire Number Leader command.

1 Click the Wire Number Leader tool.

2 Select the wire number text.

3 Select the new position for the wire number. Right-click or press Enter to position the wire number.

   NOTE You can type "C" at the command prompt to collapse the wire leader back to the wire number block. You can do this immediately after inserting a leader if you determine that you don't want the leader or you can rerun the command if you want to remove the leader from existing wire numbers.

Move the wire number without use of a leader

If you want to reposition the wire number without use of a leader, use the Move Attribute utility.

1 Click the Move/Show Attribute tool.

2 Select the attribute(s) to move and press Enter.
   You can pick the components individually or by windowing.
   Each attribute highlights with a rectangular box drawn around
Select the base and insertion points for the move. The attribute follows your cursor and is automatically moved to the selected position.

The attributes remain tied to the parent block inserts.

**NOTE** Avoid using the AutoCAD MOVE command to reposition a wire number. An AutoCAD Electrical smart wire number is an invisible block with one visible wire number attribute associated with it. The block's X-Y insertion point needs to physically lie on the wire segment. If it is forced off of the segment during an AutoCAD MOVE command, then AutoCAD Electrical no longer sees it linked to the wire. If you want to use straight AutoCAD commands to reposition a wire number, use GRIPS to move the wire number attribute or any other attribute position editing command so that you reposition the wire number attribute but not its underlying block insertion point.

**Swap wire numbers**

Swap wire numbers between two wire networks by selecting the Swap Wire Numbers tool. Select on the "From" and the "To" wire networks or pick right on the existing wire number text.

1. Click the arrow on the Edit Wire Number tool to access the Swap Wire Numbers tool.

2. Click the Swap Wire Numbers tool.

3. Select the first wire or number and then select the second wire or number.
   
   The wire numbers automatically switch positions.

**Position extra wire numbers**

Extra wire numbers can be positioned anywhere on a wire network. These copies follow the network's main wire number attribute. If AutoCAD Electrical modifies it, then any wire number copies on the network also update. Extra wire numbers go on their own layer that is defined in the Define Layers dialog.
box. If you assign a color to this layer that is different than the normal wire number and fixed wire number layers, then it is easy to tell them apart from the network's main wire number.

1. Click the Copy Wire Numbers tool.
2. Select the wire location where you want the extra wire number to insert.

**Position wire numbers in-line with the wire**
You may want some wire numbers to appear in-line with the wire rather than above or below the wire.

1. Click the arrow on the Copy Wire Numbers tool to access the Copy Wire Number (In-Line) tool.

2. Click the Copy Wire Number (In-Line) tool.

3. Specify the insertion point for the wire number.

4. In the Insert Wire Number dialog box, enter the wire number, use Pick to select similar text from the drawing, or click the arrows to increment or decrement the wire number.

5. Click OK. The wire number is automatically inserted in-line with the wire.

6. If the gap between the wire and the wire number text isn’t quite large enough you can change the gap setup.

7. Click the arrow on the Copy Wire Numbers tool to access the Adjust In-Line Wire/Label Gap tool.

8. Click the Adjust In-Line Wire/Label Gap tool.

9. Type S and press Enter to open the In-Line Wire Label Gap Setup dialog box.

   Adjust the values as necessary to define the adjustment for the gap size.

   - **A**: Specifies the width between the end of the wire and the text. The second option for setting “A” is the snap setting for the width. The width stays constant until the text grows to a point where the Text + A + A gets past the current gap width in the wire. The gap width then jumps up to the next snap width increment. If this 2nd value is set to 0.25, the gaps in the wires are always going to be at 0.25 increments (0.25, 0.5, 0.75, 1.0). If this middle value is left at 0.0, then the snap distance is 0 and the gap in the wire grows or shrinks smoothly as the wire text grows or shrinks.

   - **C**: Specifies the minimum gap width by setting a fixed size value. If you want fixed spacing for the in-line wire number gap, enter a size value in the C edit box. A non-blank C value gives the minimum gap.
width even if the wire number is a single character or has been blanked out.

The gap is adjusted for the selected wire number.

**Mirror a wire number**

1. Click the Flip Wire Number tool.
2. Select the wire number to mirror.

Each wire number selected is mirrored across its associated wire.

**TIP** Use the Toggle Wire Number In-Line tool to move a wire number from above/below the wire to in-line, and vice-versa.

**Toggle wire number position**

Use the Toggle Wire Number In-Line tool to switch the wire number between above or below and inline. If the selected wire number is inline, it switches to above or below based on the default Wire Number Placement setting in the Drawing Properties ➤ Wire Numbers dialog box. If it starts as above or below, the selected wire number toggles to in-line.

**NOTE** If there isn't room for a wire number to become an inline wire number, it remains an above or below line wire number.

**TIP** Use the Flip Wire Number tool to switch a wire number between above and below the wire.

1. Click the Toggle Wire Number In-Line tool.
2. Select the wire number to toggle. You can select on the wire number or on the wire itself.
3. Right-click to exit the command.

**Drawing properties: wire numbers tab**
Apply a drawing-specific wire number settings that are maintained inside the drawing’s WD_M block.

Access:

Click the Project Manager tool. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.

**Wire Number Format**

Wire number tags can be sequential or reference-based.

**Format**

Specifies the way new wire number tags are created. The wire number tag format must include the %N parameter that is the base sequential or reference-based value per the selection above. If your format includes the sheet number %S parameter or the drawing number %D parameter, you must enter the values in the edit boxes in the Drawing Properties ➤ Drawing Settings dialog box.

**NOTE** For reference-based wire number tagging, individual items in the suffix list are applied to the wire tags to keep multiple wires in the same reference location unique. These are added to the end of the tag, but you can force AutoCAD Electrical to insert the suffix character somewhere within the tag format. Use the Suffix position parameter, %X, in the component tag format (for example, %X%N).

**Search for PLC I/O address on insert**

Specifies to use PLC I/O address values for wires that connect to an addressed I/O point. This overrides both Sequential and Reference-based tagging. New wires or wire renumbering on the current drawing shows PLC I/O address-based wire numbers automatically.

**NOTE** Like component tags, AutoCAD Electrical uses the concept of a wire tag format string with replaceable parameters. The %N parameter must always be part of the wire format string. A typical format string might be just this %N parameter.
Enter the starting sequential number (alpha, numeric, or alphanumeric) for the drawing. If you enter the same starting sequential number for every drawing of your wiring diagram set, AutoCAD Electrical confirms at insertion time that a new sequential wire number tag is not repeated on any other drawing.

If you set DEMO1 to 100 and DEMO2 to 200, the wire numbers on DEMO1 start at 100 and those on DEMO2 start at 200. If DEMO1 has more than 100 wire numbers it starts using wire number 200 and above while DEMO2 would begin its wire numbers where DEMO1 left off (making sure that duplicate wire numbers are not assigned).

The default is "1." Setting it to "2" with a starting sequential of "1" would yield wire numbers 1, 3, 5, 7, 9, 11, and so on.

Sets the wire number tag suffix. This list is used to create unique reference-based wire number tags for multiple wire networks beginning at the same reference location (such as wire network beginning at a location per line reference number, X-Y grid reference, or X-Zone reference).

Displays a suffix list. List suffix characters for wire numbers beginning on the same line reference or in the same zone (to keep wire numbers unique). Select one of the 4 pre-defined suffix lists or enter your own custom suffix list.

New Wire Number Placement

NOTE The Insert Wire Number tool does not take the current wire number setting (in-line, above or below) into account when updating existing wire numbers; this setting is used only when inserting new wire numbers. Use the Toggle Wire Number In-Line tool for flipping existing wire numbers among the 3 modes.

Places the wire number above the physical wire.

Placements the wire number inline with the wire.
Gap Setup
Defines spacing between the inline wire number and the wire itself.

Below Wire
Places the wire number below the physical wire.

Offset
Specifies to insert the wire number tags the specified offset distance.

Centered
Specifies to insert the wire number tags in the center of each wire segment.

Offset Distance
Specifies a fixed, user-defined offset distance from the left or top of the first wire segment found on the wire network.

Leaders
(This option is unavailable for in-line wire numbers.) AutoCAD Electrical places wire numbers on leaders when it determines that the wire number text bumps into something (it does not check if the leader itself will overlay another object). Select the method for inserting new wire numbers as leaders: As Required, Always, or Never.

**NOTE** This change does not affect wire numbers that are already present on the drawing.

**Modify Wire Numbers**

**Increment wire numbers**

You can force new incremental wire numbers (as opposed to line referenced numbers) to increment by more than one during insertion.

In the Drawing Properties dialog box, click the Wire Numbers tab. In the Wire Number Format section, select Sequential and set the increment value. If you want this increment value to be your standard for all new drawings, follow the same procedure in the Project Properties ➤ Wire Numbers dialog box.
NOTE You can also do this by creating an electrical template drawing with the wd_m block pre-inserted and the increment value pre-assigned.

**Change the default wire number size**

You will need to change several block inserts in each of the symbol libraries you use. The wire number block drawings you need to adjust are: wd_wnh.dwg (horizontal wire number), wd_wnv.dwg (vertical wire number), wd_wch.dwg (horizontal extra wire number copy), and wd_wcv.dwg (vertical extra wire number copy). You can find these in your AutoCAD Electrical symbol library (C:\Program Files [(x86)]\Autodesk\Acade [version]\Libs\jic1, jic125, iec2, iec4, and so on).

1. Determine which schematic symbol library is in use and open drawing "wd_wnh.dwg" in AutoCAD.
2. Change the text size of the WIRENO attribute definition.
3. Save the drawing.
4. Open drawings "wd_wnv.dwg", "wd_wch.dwg", and "wd_wcv.dwg."
5. Repeat steps 2 and 3 for each.

NOTE You won't see these new, resized wire numbers on existing drawings unless you erase all of the wire numbers and purge the drawing of the old block inserts.

**Make wire numbers on vertical wires come in rotated 90 degrees**

You can make wire numbers for vertical wires come in automatically rotated 90 degrees so the wire number lays along the wire.

1. Determine which schematic symbol library is in use and open drawing "wd_wnv.dwg" in AutoCAD.
2. Rotate the WIRENO attribute 90 degrees using the AutoCAD Rotate command.
3. Save the drawing.
4. Open drawing "wd_wcv.dwg."
5. Repeat steps 2 and 3.
Erase or Hide Wire Numbers

**Erase a wire number**

If you erase a wire number and select right on an extra wire number copy, AutoCAD Electrical will erase just that copy but leave the networks main wire number and any other copies in place.

1. Select Wires ➤ Delete Wire Numbers.
2. Select the wire number or pick on any wire in the network.
3. Press Enter. The wire number is automatically deleted.
   Extra wire number copies can also be deleted.

**Erase all wire numbers project-wide**

1. Click the arrow on the Project Manager tool to access the Project-Wide Utilities tool.
2. Click the Project-Wide Utilities tool.
3. Select to remove all wire numbers or keep fixed wire numbers and click OK.
4. Select which drawings you want to process and click OK.
   The selected drawings are processed and the wire numbers change across the project.

**Hide wire numbers**
AutoCAD Electrical automatically hides wire numbers when the wire number is on the same network as a terminal symbol that carries a copy of the wire number (WIRENO attribute). There may be times when you want to manually hide or unhide wire number(s).

1. Click the arrow on the Edit Wire Number tool to access the Hide Wire Numbers tool.

2. Click the Hide Wire Numbers tool.

3. Select a wire number or the wire it is associated to. AutoCAD Electrical moves the wire number to a special hide layer and the number is no longer visible on the screen.

   The new hide layer is created from the wire number layer name with a ",HIDE," suffix. For example, if the wire number text layer is called WIRENO then the hide layer name is called "WIRENO_HIDE". The layer is created automatically when needed and you are asked if you want to freeze this layer.

**Unhide wire numbers**

1. Click the arrow on the Edit Wire Number tool to access the Unhide Wire Numbers tool.

2. Click the Unhide Wire Numbers tool.

3. Select a wire number or the wire the hidden number is associated to.

   AutoCAD Electrical moves the wire number out of the hide layer and the number is visible on the screen.

**X zones setup**
Use this tool to insert the X grid labels for drawings that use X Zones for the Format Referencing. You can also change other settings from here (such as origin) instead of going back into the Drawing Properties dialog box.

**NOTE** Your drawing must be configured for X Zones. Set the Format Referencing in the Drawing Properties ➤ Drawing Format dialog box to X Zones.

**Access:**

Click the arrow on the Insert Ladder tool to access the X Zone tool.

**NOTE** You can also access this dialog from the Project Properties or Drawing Properties dialog boxes. Some options are not available when you access the dialog box through the properties dialog boxes.

<table>
<thead>
<tr>
<th>Origin</th>
<th>Specifies the origin for the X Zone grid. Click pick to select the origin on the drawing or enter X and Y values.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>NOTE</strong> The Pick button is not available when accessed through the properties dialog box.</td>
</tr>
<tr>
<td>Spacing</td>
<td>Specifies the spacing between the grid columns. Enter the horizontal value.</td>
</tr>
<tr>
<td>Zone labels</td>
<td>(only available when accessed from the toolbar or menu) Specifies the labels for the grid columns. Enter the horizontal value. You can enter the first value only or a complete list. If you enter a list, separate the values with commas - such as &quot;A, B, C, D.&quot;</td>
</tr>
<tr>
<td>Insert zone labels</td>
<td>(only available when accessed from the toolbar or menu) Specifies whether to insert the grid labels. If you select to insert the labels, enter the column counts.</td>
</tr>
</tbody>
</table>

**X-Y grid setup**
Use this tool to insert the X-Y grid labels for drawings that use X-Y Grid for the Format Referencing. You can also change other settings from here (such as origin) instead of going back into the Drawing Properties dialog box.

**NOTE** Your drawing must be configured for X-Y Grids. Set the Format Referencing in the Drawing Properties ➤ Drawing Format dialog box to X-Y Grid.

**Access:**

Click the arrow on the Insert Ladder tool to access the XY Grid tool.

**NOTE** You can also access this dialog from the Project Properties or Drawing Properties dialog boxes. Some options are not available when you access the dialog box through the properties dialog boxes.

<table>
<thead>
<tr>
<th><strong>Origin</strong></th>
<th>Specifies the origin for the XY grid. Click pick to select the origin on the drawing or enter X and Y values.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NOTE</strong></td>
<td>The Pick button is not available when accessed through the properties dialog box.</td>
</tr>
<tr>
<td><strong>Spacing</strong></td>
<td>Specifies the spacing between the grid columns. Enter the horizontal and vertical values.</td>
</tr>
<tr>
<td><strong>X-Y Format</strong></td>
<td>Specifies the order that is used from the X-Y grid in determining the %N part of the tag. If this is set to Horizontal, the horizontal values of the grid are used as the first part, and the vertical value as the second. If Vertical is selected then the vertical values are used for the first part and the horizontal values used for the second. Example: if you have Horizontal values of A - F and Vertical values of 1 - 9 and this is set to Horizontal, you might get a %N value of &quot;B2&quot;; if this is set to Vertical you might get a %N value of &quot;2B.&quot;</td>
</tr>
<tr>
<td><strong>Grid labels</strong></td>
<td>(only available when accessed from the toolbar or menu) Specifies the labels for the grid columns. Enter the horizontal and vertical values. You can enter the first value only or a complete list. If you enter a list, separate the values with commas - such as &quot;A, B, C, D.&quot;</td>
</tr>
</tbody>
</table>
**PLC I/O wire numbers**

This tool inserts wire numbers based upon the I/O address that each PLC connected wire touches. Wire numbers go in as FIXED which means that they do not change if a wire number retag is run later on.

**Access:**

Click the arrow on the Insert Wire Numbers tool to access the PLC I/O Wire Numbers tool.

From the Wires menu, select Wire Numbers Miscellaneous ➤ PLC I/O Wire Numbers.

**I/O Wire Tag Format:** Specifies the wire tag format for the plc wire.

**Predefined:** Uses an exact wire number match on the address. The options are I:%n or O:%n.

---

**NOTE** For automatic wire numbering based strictly on the actual I/O address, open the Drawing Properties dialog box, and click the Wire Number tab. In the Wire Numbering section, select Search for I/O address on insert.

---

**Control from/to report connection sequencing**

A wire network consisting of three or more interconnected components introduces potential unknowns into a from/to connection report. Does A connect to B and then jumper to C or does C connect to A and jumper to B? By default, AutoCAD Electrical reports from/to connections on a single network...
by first grouping devices by common Location codes and sequentially reports each group's inter-wiring. It then ties each common Location group together with a single from/to wire connection. For wire connections with the same Location group (or if all devices have the same Location value or no Location value), AutoCAD Electrical attempts to sort the wire connections by physical location on the drawing and report the from/to connections in that order.

**NOTE** You can keep jumpers from displaying in Wire From/To reports by placing the jumpers on a layer that contains the substring "JUMPER."

AutoCAD Electrical provides several methods to more specifically define wire connection sequencing.

**NOTE** You can run one or more sequencing methods simultaneously, even in the same wire network, since there is a hierarchy of which methods takes precedence over others.

### Angled Tee Wire Connection Method

The use of angled tee wire connections can influence the wire connection sequence reporting. Sequencing is defined by the tee symbol's orientation (a three-digit attribute value named WDWSEQ carried on the symbol). The 90 degree turn or the straight-through section (depending on the style of the angled tee symbol) indicates the beginning of the sequence, while the 45 degree turn is the secondary connection. AutoCAD Electrical reports each wire connection as it is shown.

This method of influencing from/to reporting may fail to give expected results if the orientation and arrangement of multiple angled tee connection symbols in a given network is ambiguous or if it defines more than two connected wires to a given device's wire connection point.

Set the automatic angled wire tee insert mode (instead of tee intersection dots) in the Project Properties ➤ Styles dialog box.

**NOTE** Schematic wire sequencing and Direct-to-Terminal wire sequencing, if present, overrides the Angled Tee connection sequencing.

### Schematic Wire Connection Sequence Method

This involves touching the connection sequence for each wire network containing three or more interconnected components. AutoCAD Electrical places an incrementing connection sequence value on each wire connection point (saved as a three-digit Xdata value, starting with “001” on the wire.
connection attribute). When any of the AutoCAD Electrical From/To reports processes wire networks containing this incrementing sequencing data, the from/to wire connections order accordingly.

**NOTE**  Schematic wire connection and Direct-to-Terminal sequencing methods on a given wire network take precedence over all other sequencing methods. For example, if a wire network is sequenced with the Edit Wire Sequence tool, the sequencing influence normally provided by angled tee marker symbols used in the wire network is overridden.

**Direct-to-Terminal Wire Connection Sequence Method**

This defines additional Direct-to-Terminal wire connection sequences. For example, one side of a schematic terminal might be connected to three devices. A specific wire connection sequence (using the Schematic Wire Connection sequence method above) can be defined to force the connection reporting but it is limited to reporting the terminal as a common connection point between only two of the three devices. The third device would default to being reported as jumpered to one of the other two devices. Additional secondary Direct-to-Terminal sequences can be defined so that the third device can be sequenced directly to the terminal (you can also directly sequence two terminals together). The result is that the From/To connection reporting shows all three devices tied directly to the terminal.

**NOTE**  The limit of Direct-to-Terminal sequences that you can define in a single wire network is 50.

**Level/Routing Method**

This brings the panel layout into play to affect the reporting sequence in the various From/To reports. The panel layout or panel wiring diagram layout representations are assigned level/routing codes consisting of a four-level hierarchy plus a sequence number. As schematic wire networks are processed for the From/To reports, the existence of panel layout representations that are marked with level/routing values is checked. If this information is found for all the devices of the network being processed, the network’s connections are sorted by this hierarchy and sequence information. The result is a set of From/To reported connections that follow the level/routing data carried by the layout.

**NOTE**  Schematic wire sequencing and Direct-to-Terminal wire sequencing, if present, override the influence of Level/Routing sequencing.
Edit a wire network’s connection sequence

You can explicitly define the wire connection sequence of any wire networks consisting of three or more interconnected devices. Doing this gives you control over how AutoCAD Electrical analyzes the circuits (such as the order of the contents in the WFRM2ALL table in the project’s scratch database file) and how from/to connection information is output to various reports or annotated on to physical footprint representations (using the Panel Layout ➤ Wire Annotation of Panel Footprint tool).

NOTE The * next to a wire in the Wire Connection Sequence portion of the Edit Wire Connection Sequence dialog box indicates that the device wire connection is on another drawing. A “t” indicates that the device is a schematic terminal and is a candidate for Direct-to-Terminal sequencing.
Edit a wire sequence

This tool predefines a wire network's connection sequence. The network can be either fully contained on the active drawing or pass across multiple drawings using signal source/destination symbols.

1. Click the arrow on the Insert Wire tool to access the Edit Wire Sequence tool.
2. Click the Edit Wire Sequence tool.
3. Click the Edit Wire Sequence tool.

**NOTE** You can also access this tool by right-clicking on any wire segment in the wire network.

3. Select any wire segment on the wire network you want to process.
4. On the Edit Wire Connection Sequence dialog box, adjust the connection to connection sequencing in the list by clicking Move Up or Move Down or click Pick Mode to define the sequencing by actual picks at each wire connection point.

**NOTE** Pick Mode is unavailable when you are working with a wire network that crosses multiple drawing files. If you are working with wire networks that jump to one or more additional drawings, click Freshen to update the wire connectivity database with any out-of-date files.

5. (Optional) To directly connect additional components to a given terminal, select the components and the terminal (marked with a “t” in the left-hand column) in the Wire Connection Sequence list and click Add.

A copy of the terminal and the actual component move to the Direct-to-Terminal Secondary Sequences list at the bottom of the dialog box. You can then click Move Up or Move Down to change the order of the sequence (if you've selected two or more devices plus a terminal) or remove a sequence by selecting the sequence and clicking Reset.

6. Click OK-new.

This writes the sequence information back to the component
wire connections (as Xdata on the wire connection attributes and optionally to terminal symbols in the case of Direct-to-Terminal Secondary sequencing).

7 (Optional) Right-click on a wire on the wire network and select Wire Sequence ➤ Show Wire Sequence. Press the spacebar to advance through the sequence.

You can also view the results of your sequencing by running the Wire From/To report.

**Show a defined wire sequence**

This tool shows the wire sequence defined using the Edit Wire Sequence tool.

1 Click the arrow on the Insert Wire tool to access the Show Wire Sequence tool.

2 Click the Show Wire Sequence tool.

**NOTE** You can also access this tool by right-clicking on any wire segment in the wire network.

3 Press the Space bar to step through the defined wire sequence.

**NOTE** If the wire sequence crosses multiple drawings and you try to view the sequence as an animation, a dialog box listing the off-drawing wire connection information displays so that you can indicate to go to the other drawing(s) to continue viewing the sequence.

**Insert wire tee markers**

Use the tee marker tools to insert dot tee markers or angled tee markers at existing wire tee intersections or to flip existing markers from dot to angled and vice versa. This dot and angled tee insertion happens automatically when you use the Insert Wire tool and the drawing is set up (in the Drawing Properties ➤ Styles dialog box) for dots or angled tee symbols at intersections.
You cannot insert a tee connection symbol into empty space. A valid line wire ending (not crossing) at a tee intersection somewhere along the length of another line wire is needed. This means that it does not insert a tee connection symbol at a simple 90-degree wire turn. You can right-click on any of your inserted tee markers for access to editing tools such as Toggle Angled Tee Markers, Delete Component, Scoot, or Insert Wire.

**Insert dot tee markers**

Use this tool to insert a dot tee connection symbol at a manually drawn wire intersection. If present, this replaces an existing angled wire connection symbol with a dot connection symbol.

**NOTE** For these dot or angled tee markers to insert automatically as each wire tee intersection is created, set the default Wire Tee connection in the Wiring Style section of the Drawing Properties ➤ Styles dialog box.

1. Click the arrow on the Wire Tee Markers tool to access the Insert Dot Tee Markers tool.

2. Click the Insert Dot Tee Markers tool.

3. Select at or near the intersection point.

**NOTE** If you want to change the tee symbol’s orientation after insertion, right-click on the marker and select Insert Angled Tee Marker or Toggle Angled Tee Markers (or select the tool from the toolbar). If you want to customize the appearance of this symbol, edit the symbol stored in the selected schematic symbol library. Note that angled tee symbols carry attribute WDWSEQ with a three-digit value that defines preferred wire sequence order. The dot symbol name is WDDOT.dwg.

Right-click on the marker and select Delete Component to remove an inserted tee connection symbol and heal the wires.

**Insert angled tee markers**

This inserts an angled tee connection symbol at an existing wire intersection.
For these dot and angled tee markers to insert automatically as each wire tee intersection is created, set the default Wire Tee connection in the Wiring Style section of the Drawing Properties ➤ Styles dialog box.

1. Click the arrow on the Wire Tee Markers tool to access the Insert Angled Tee Markers tool.

2. Click the Insert Angled Tee Markers tool.

3. Select at or near the intersection point.
   If a dot marker is present, it is deleted and replaced by the angled tee symbol.

4. After the symbol inserts and reconnects to the wiring, press the spacebar or Enter to switch the inserted tee through 4 different orientations. Press Esc when the appropriate orientation displays.

NOTE If you want to change the tee symbol’s orientation after insertion, right-click on the marker and select Toggle Angled Tee Markers (or select the tool from the toolbar). To customize the appearance of these symbols, edit the tee symbols stored in the selected schematic symbol library. These tee symbol names are HT0_###.dwg and VT0_###.dwg where # = combinations of 1,2,4, and 8. Be aware that each symbol carries attribute WDWSEQ with a three-digit value indicating wire connection sequence priority for the three wire connection points of the symbol.

Right-click on the marker and select Delete Component to remove an inserted tee connection symbol and heal the wires.

**Toggle angled tee markers**

This toggles an existing angled tee connection symbol (or windowed symbols) through a total of 4 possible orientations.

1. Click the arrow on the Wire Tee Markers tool to access the Toggle Angled Tee Markers tool.
2. Click the Toggle Angled Tee Markers tool.
3. Select or window the tee connections to change.
4. Right-click or press the spacebar to toggle through the various tee connection orientations, and press Esc when the desired one displays. This replaces any dot tee symbols with angled tee symbols and then toggles through the 4 possible orientations for each.

**Edit wire connection sequence**

This tool defines the wire connection sequence of any wire networks containing three or more interconnected devices. Doing this gives you control over how AutoCAD Electrical analyzes the circuits (such as the order of the contents in the WFRM2ALL table in the project’s scratch database file) and how from/to connection information is output to various reports or annotated on physical footprint representations (using the Panel Layout ➤ Wire Annotation of Panel Footprint tool).

**Access:**

Click the arrow on the Insert Wire tool to access the Edit Wire Sequence tool.
Click Wires ➤ Wire Miscellaneous ➤ Edit Wire Sequence.

---

**NOTE** You can also access this by right-clicking on any segment of a wire network and selecting Wire Sequence ➤ Edit Wire Sequence.

Provides tools to define the desired sequence order, such as sorting the components by physical location, moving the components up or down in the listing, and going into a pick mode (in the active drawing only) where you can pick the wire connection points in order to define the connection sequence.

Once you specify the sequencing, you can use the Show Wire Sequences tool to view the sequence or use the Wire From/To reporting tool to see how the sequencing is reported.
NOTE Your dialog box differs depending on whether you selected to modify the sequence of a wire network that is connected to a terminal. When a terminal is part of the selected wire network, you have an option to define secondary Direct-to-Terminal wire connection sequences.

### Wire Connection Sequence
Lists the wires and terminals found in the circuit. The * indicates that the wire is on another drawing and the “t” indicates that the entry is a terminal and a candidate for a direct-to-terminal secondary sequence definition.

**NOTE** Components connected on the far side of a terminal (on a side opposite of the picked wire network) are not displayed in the list, even if the terminal is one that does not change the wire number through it.

### Pick Mode
Defines the sequence by actual picks at or very near each wire connection point. Pick near each wire connection in the order of how you want the wiring sequence to proceed from component to component.

**NOTE** Pick Mode is unavailable when you are working with a wire network that crosses multiple drawing files.

### Sort Location
Automatically sorts the wire connection display by the installation and location values. If previously sorted, the sort is reversed.

### Move Up
Moves the selected wire connection up one space in the wire order list.

### Move Down
Moves the selected wire connection down one space in the wire order list.

### Direct-to-Terminal Secondary Sequences
Lists additional sequences where a component connection (or terminal connection) is to be reported as being directly wired to a selected terminal.
**Add**

Moves the selected components to the Direct-to-Terminal Secondary Sequences list along with a copy of the selected terminal. You must select the components and terminal to sequence together for this button to be available. If you select multiple components to daisy-chain to the terminal (by holding CTRL key down), the first selected component displays ties directly to the terminal.

**Reset**

(available only when an entry in the sequence is highlighted) Removes the selected sequencing from the Direct-to-Terminal Secondary Sequences list. The component is moved back to the Wire Connection Sequence list.

**Connection**

Indicates whether the component is undefined (-), reported on the internal side of the terminal (I) or reported on the external side of the terminal (E). If selected, an I or E displays in the PD1 or PD2 column (Point Description) of the Wire From/To report.

**Freshen**

Updates the wire connectivity database (the WFRM2ALL table) with wire connection information from any out-of-date files.

**NOTE** If all drawings are up-to-date, this button is disabled. If not, the button is enabled and the count of out-of-date drawings displays next to the button.

**Remove All**

Removes the wire connection sequence information from a wire network. This consists of Xdata assignments on component wire connection attributes and optional Xdata assignments on terminal symbols if any Direct-to-Terminal sequences are defined.

**OK-new**

Applies the dialog’s wire connection sequence information in the form of Xdata to the wire connection points and terminals of the selected wire net-
Add custom signal arrow styles

The icon menu graphics that display for the various signal styles are bitmap files saved to your C:\Program Files \( (x86) \) \Autodesk \Acade \{version\} \Acade \ folder where AutoCAD Electrical's Insert Signal utilities and Drawing Properties tool can access them.

1. Create the new style in AutoCAD.
2. Zoom in to the new arrow style.
3. Save the file as a bitmap using the following name definition: ASTANCExh.bmp where "x" is the arrow style 1-9.

**NOTE** If the resulting bitmap is too small or off-center, open the source drawing in AutoCAD again. Resize your AutoCAD graphics window so that it is more square. Center the image and resave. Repeat until you are satisfied with the result.

Insert destination code

The wire number for a destination-arrowed wire network is retrieved from its associated source-arrowed wire network. Enter the same number/word/phrase that is carried on the source arrow to make the link to it.

**NOTE** A Destination signal arrow cannot be tied to a wire network that carries a pre-assigned fixed wire number.

Access:

Click the arrow on the Source/Destination Signals tool to access the Destination Signal Arrow tool.
Access:

From the Wires menu, select Signal References ➤ Destination Signal Arrow.

**Code**

Specifies the code for the destination signal. Enter a unique number/word/phrase, 32-character maximum, for AutoCAD Electrical to use to internally link the destination wire network to any/all source wire networks.

**Description**

(optional) Specifies the description for the destination signal.

**Defaults**

Opens an ASCII text file from which you can quickly pick standard descriptions.

**Recent**

Picks from recently inserted codes.

**Drawing**

Displays drawing-wide pick lists of all source/destination codes used so far.

**Project**

Displays project-wide pick lists of all source/destination codes used so far.

**Pick**

Picks on an existing wire network. AutoCAD Electrical searches it for an existing source arrow and retrieves its signal code for use on this new destination arrow.

**Signal Arrow Style**

Specifies the arrow style to use for the destination signal. There are currently 9 styles to choose from.

**Ok + Update Source**

Finishes the destination arrow insert and updates the source arrow with this destination arrow.

**Signal - source code**

The wire number from a source-arrowed wire network is copied to any/all associated destination-arrowed wire networks. Enter a unique
number/word/phrase, 32-char maximum, for AutoCAD Electrical to use to internally link the source wire network to any/all destination wire networks.

Access:

Click the drop-down arrow on the Source/Destination Signals tool to access the Source Signal Arrow tool.

From the Wires menu, select Signal References ➤ Source Signal Arrow.

| Code | Specifies the code for the source signal. Enter a unique number/word/phrase, 32-character maximum, for AutoCAD Electrical to use to internally link the source wire network to any/all destination wire networks. |
| Use | Places the specified value into the code box. This is useful for using the next number in a sequence. |
| Description | (optional) Specifies the description for the source signal. |
| Defaults | Opens an ASCII text file from which you can quickly pick standard descriptions. |
| Recent | Picks from recently inserted codes. |
| Drawing | Displays drawing-wide pick lists of all source/destination codes used so far. |
| Project | Displays project-wide pick lists of all source/destination codes used so far. |
| Search | Follows the selected wire network looking for a destination arrow at the other end. If found, repeat its signal code for this new source arrow. |
| Pick | Picks on an existing wire network. AutoCAD Electrical searches it for an existing destination arrow. |
and retrieves its signal code for use on this new source arrow.

### Signal Arrow Style
Specifies the arrow style to use for the source signal. Select from the 4 pre-defined styles or a user-defined style.

### OK + Update Destination
Finishes the source arrow insert and updates the destination arrow with this source arrow.

## Project properties: styles tab
Modify your project default settings for various component styles. All information defined in this tab is saved to the project definition file as project defaults and settings.

### Access:
Click the Project Manager tool. In the Project Manager, right-click the project name, and select Properties.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the project name, and select Properties.

### Arrow Style
Specifies the default wire signal arrow style. Select from the 4 predefined styles or a user-defined style. You can override the default style setting at insertion time.

**TIP** For instructions on how to add custom wire arrow styles, see Add custom signal arrow styles. (page 536)

### PLC Style
Specifies the default PLC module style. Select from the 5 pre-defined styles or a user-defined style.

**TIP** For instructions on how to add custom PLC module styles, see Add a new PLC style. (page 251)

### Fan-In/Out Marker Style
Defines the default Fan In/Out marker style and the layers for wires going out of a Fan In/Out Source marker and those coming into a Destination marker.
Layer List

Lists the Fan In/Out layers.

Add

Defines layer names as Fan In/Out layers.

Remove

Removes the selected layer from the defined layer list.

Wire Cross

Specifies the default mode of operation when wires cross each other: insert gap with no loop, insert gap and loop, or solid (no gap).

Wire Tee

Specifies the default wire tee marker: none, dot, angle1 or angle2.

**Drawing properties: styles tab**

Apply a drawing-specific component styles settings that are maintained inside the drawing’s WD_M block.

**Access:**

Click the Project Manager tool. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the drawing name, and select Properties ➤ Drawing Properties.

Arrow Style

Specifies the default wire signal arrow style. Select from the 4 predefined styles or a user-defined style. You can override the default style setting at insertion time.

TIP For instructions on how to add custom wire arrow styles, see Add custom signal arrow styles. (page 536)

PLC Style

Specifies the default PLC module style. Select from the 5 predefined styles or a user-defined style.
**Fan-In/Out Marker Style**

Defines the default Fan In/Out marker style and the layers for wires going out of a Fan In/Out Source marker and those coming into a Destination marker.

**TIP** For instructions on how to add custom Fan-In/Out marker styles, see *Add custom fan-in/out marker styles*. (page 548)

**Layer List**

Lists the Fan In/Out layers.

**Add**

Defines layer names as Fan In/Out layers.

**Remove**

Removes the selected layer from the defined layer list.

**Wire Cross**

Specifies the default mode of operation when wires cross each other: insert gap with no loop, insert gap, and loop, or solid (no gap).

**Wire Tee**

Specifies the default wire tee marker: none, dot, angle1 or angle2.

---

**Wire signal or stand-alone reference report**

There are 2 types of reports that can be generated: one on wire signal source/destination codes and one on stand-alone reference codes.

**Access:**

![Source/Destination Signals tool](image)

Click the arrow on the Source/Destination Signals tool to access the Signal Error/List Report tool.

From the Wires menu, select Signal References ➤ Signal Error/List Report.

**Wire Signal Source/Destination codes report**

Runs a report that lists all of the signal source and destinations used on the project drawing set or an
exception report that lists problem areas such as a destination signal with no source found or a source signal that doesn't tie to a destination. Click Format on the subdialog box to select from a listing of report settings files found that have a prefix equal to the selected report type.

**Stand-alone Reference Source/Destination codes report**

Runs a report that lists all the stand-alone source and destinations used on the project drawing set or an exception report that lists problem areas such as a destination reference with no source found or a source reference that doesn't tie to a destination. Click Format on the subdialog to select from a listing of report settings files found that have a prefix equal to the selected report type.

**Surf**

Continues surfing on problems related to the selected report.

---

**Edit the cable conductor database**

You can edit the cable conductor database table (_W0_CBLWIRES in the default_cat.mdb file) just like any other AutoCAD Electrical catalog table. The main Access database catalog file can be named either default_cat.mdb or <project>_cat.mdb. You can open it in Microsoft Access or you can edit it from within AutoCAD Electrical. To do so, right-click a cable marker and select Edit Component from the context menu. In the Insert/Edit Cable Marker dialog box, Catalog Data section, click Lookup. In the Parts Catalog dialog box, click Cable Conductor List View/Edit.

**Cable conductor database “_W0_CBLWIRES” table structure**

The records in the cable conductor database table are structured as follows:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog</td>
<td>60</td>
<td>Catalog number of cable</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>24</td>
<td>Manufacturer code</td>
</tr>
</tbody>
</table>

---

542 | Chapter 8  Wire/Wire Number Tools
### Show source and destination markers on wires

For a given cable part number there is a record for each conductor within that cable. For example, a 15-conductor Belden type 8486 cable has 15 records; one for each conductor in that cable type. The Manufacturer and Catalog fields for all 15 records are marked "BELDEN" and "8486." The Conductor field carries each conductor's unique color id.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conductor</td>
<td>24</td>
<td>Conductor color or ID code</td>
</tr>
<tr>
<td>Gauge</td>
<td>24</td>
<td>Conductor gauge description</td>
</tr>
<tr>
<td>Recnum</td>
<td>N/A</td>
<td>Auto number field (used internally)</td>
</tr>
</tbody>
</table>

There may be times when you want to show source and destination markers on the individual wires of a cable, but you want to show the wires coming together to form the cable.
When a Fan In/Out marker is inserted, AutoCAD Electrical breaks the wire and changes the layer of one side of the wire to a special layer. If you are inserting a source marker, then the wire coming out of the marker is changed. If it is a destination marker, the wire coming into the marker is changed. You can use the AutoCAD Electrical Fan In/Out - Single Line Layer command to change a wire to one of these layers.
Add source markers

1 Click the arrow on the Source/Destination Signals tool to access the Fan In/Out Source tool.

2 Click the Fan In/Out Source tool.

3 Select the style and orientation for the markers and click OK.

4 Select the insertion point on the screen for the marker.
The Signal-Source Code dialog box displays.

5 Enter a source code for the marker and optionally a description. Enter a unique number/word/phrase, 32-character maximum, for AutoCAD Electrical to use to internally link the source wire network to any/all destination wire networks.

6 Select how you want to view the signal codes used so far:
   ■ Display drawing-wide or project-wide pick lists of all source/destination codes used so far
   ■ Follow the selected wire network looking for a destination arrow at the other end. If found, repeat its signal code for this new source arrow.
   ■ Pick on an existing wire network. AutoCAD Electrical searches it for an existing destination arrow and retrieves its signal code for use on this new source arrow.

7 Specify the arrow style to use for the destination signal.

8 Click OK.
The Source/Destination Signal Markers (for Fan In/Out) dialog box displays. You have a few options for inserting the matching destination marker:
   ■ Do not insert the matching destination marker.
   ■ Do not insert the matching destination marker after each source.
   ■ Insert the matching destination marker.
   ■ Automatically insert the matching destination markers for each source.
NOTE If the destination wires are nearby it may be easiest to insert them right away. If they are on another drawing you can wait until later to insert them.
**Add destination markers**

1. Click the arrow on the Source/Destination Signals tool to access the Fan In/Out Destination tool.

2. Click the Fan In/Out Destination tool.

3. Select the style and orientation for the markers and click OK.

4. Select the wire for the destination marker. The Insert Destination Code dialog box displays.

5. Enter the code or select Recent to see a list of the recent markers inserted.

6. Specify the arrow style to use for the destination signal.

7. Continue selecting wires until all destination markers have been inserted.

**Set marker styles and layers**

The AutoCAD Electrical Fan In/Out feature relies on layering to work. You can select the default Fan In/Out marker style here along with defining the layers for the wires.

1. Click the Drawing Properties tool.

2. In the Drawing Properties dialog box, click the Style tab.

   If you have an older drawing, you may be warned about an older version of the WD_M block. If that happens, go ahead and swap the WD_M block and try again.

3. In the Fan-In/Out Marker Style section, set the default marker style.

4. Define the layers for the wires. Click Add to define layer names as Fan In/Out layers.

5. Click OK.
Define fan-in/out layers

A special layer or set of layers can be defined for the wires going out of a Fan In/Out Source marker and the wires coming into a Destination marker.

1. Click the arrow on the Source/Destination Signals tool to access the Fan In/Out - Single Line Layer tool.

2. Click the Fan In/Out - Single Line Layer tool.
   The list displays only layers that are already assigned as Fan In/Out Layers as defined in the drawing properties setup.

3. Use Pick if you aren't sure of the layer you want, but you have a line on your drawing on that layer. You can also use this if the line's layer isn't defined as a Fan In/Out layer and you want to add it on the fly.

4. Select whether to make the layer current.

5. Check the box to change the existing fan in/out lines only if you want to make sure that you only change the layers of wires that are already defined as Fan In/Out wires. Otherwise AutoCAD Electrical can convert any selected lines to the Fan In/Out layer.

Add custom fan-in/out marker styles

The icon menu graphics that display for the various Fan In/Out marker styles are bitmap files saved to your C:\Program Files (x86)\Autodesk\Acad {version}\Acad\ folder where AutoCAD Electrical's Fan In/Out utilities and Drawing Properties tool can access them.

1. Create the new style in AutoCAD.

2. Zoom in to the new Fan In/Out marker style.

3. Save the file as a bitmap using the following name definition: StylexVI.bmp and StylexVO.bmp where "x" is the fan-in/out marker style 1-9.
NOTE If the resulting bitmap is too small or off-center, open the source
drawing in AutoCAD again. Resize your AutoCAD graphics window so that
it is more square. Center the image and resave. Repeat until you are satisfied
with the result.

Fan-in/fan-out signal source

Uses set of in-line source/destination symbols that follow the naming format
of ha#s?_inline.dwg and ha#d?_inline.dwg where # = style number and ? =
1,2,3,4 orientation number (just like with existing source/destination arrows).
Running new commands inserts in-line source marker symbols and changes
the connected wire on the fan-in side to be on a non-wire layer. Putting
matching destination in-line markers at the fan-out end does the same. It
changes the connected common wires on the fan-out side to a non-wire layer
but leaves the individual segments on the opposite side of marker on the
original wire layer. The AutoCAD Electrical source/destination update or Auto
Wire Number command then makes the match-up annotation, whether the
fan-in/fan-out are on the same or different drawings.

Access:

Click the arrow on the Source/Destination Signals tool to access the Fan In/Out
Source tool.
From the Wires menu, select Signal References ➤ Fan In/Out Source.

Source marker style

Specifies the style for the source marker. Some op-
tions are: Solid (wire num/desc), Break (wire num -small gap/desc), Break (medium gap/desc), and Break
(wide gap/desc).

Wire connection orientation

Specifies the orientation for the markers. Options
are: above, below, right, or left.

Fan-in/fan-out signal destination

Uses set of in-line source/destination symbols that follow the naming format
of ha#s?_inline.dwg and ha#d?_inline.dwg where # = style number and ? =
1,2,3,4 orientation number (just like with existing source/destination arrows).
Running new commands inserts in-line source marker symbols and changes
connected wire on the fan-in side to be on a non-wire layer. Putting matching
destination in-line markers at the fan-out end does the same. It changes the
connected common wires on the fan-out side to non-wire layer but leaves the individual segments on the opposite side of marker on the original wire layer. The AutoCAD Electrical source/destination update or Automatic Wire Number command then makes the match-up annotation, whether the fan-in/fan-out are on the same or different drawings.

**Access:**

Click the arrow on the Source/Destination Signals tool to access the Fan In/Out Destination tool.
From the Wires menu, select Signal References ➤ Fan In/Out Destination.

**Destination marker style**

Specifies the style for the destination marker. Some options are: Solid (wire num/desc), Break (wire num - small gap/desc), Break (medium gap/desc), and Break (wide gap/desc).

**Wire connection orientation**

Specifies the orientation for the markers. Options are: above, below, right, or left.

**Fan-in/out - single line layer**

A special layer or set of layers can be defined for the wires going out of a Fan In/Out source marker and the wires coming into a destination marker.

**Access:**

Click the arrow on the Source/Destination Signals tool to access the Fan In/Out - Single Line Layer tool.
From the Wires menu, select Signal References ➤ Fan In/Out - Single Line Layer.

**Fan-In/Out Line Layers**

Displays only layers that are already assigned as Fan In/Out Layers as defined in the drawing properties setup.

**Pick**

Picks similar fan-in/out lines from the drawing. You can use this if the line’s layer isn’t defined as a Fan In/Out layer and you want to add it on the fly.
Change existing wires only (no convert) Changes only the layers of wires that are already defined as Fan In/Out wires. Otherwise AutoCAD Electrical can convert any selected lines to the Fan In/Out layer.

One pick gets all connected wires Changes all of the wires to the selected layer that is associated with the selected wire network. If this option is not selected, only the selected wire changes.

Make selected layer current Makes the selected layer the current layer.
Terminal Tools

In this chapter

- Overview of connection sequencing
- Insert terminals and connectors
- Multi-Level Terminals
- Edit terminal jumpers
- Resequence terminal numbers
- View terminal wire connections
- Terminal Strips
- Terminal Properties Lookup
Overview of connection sequencing

The Multi-Connection Sequence Terminal symbol allows a single in-line schematic symbol to represent a sequence of wire connections passing through two or more (up to six) terminal strips. For example, a wire connection that must pass through a series of shipping split terminal strips can be represented by a single in-line wire schematic symbol (instead of having to show each individual terminal in the sequence).

Two sample symbols are provided. Their appearance may be edited or new ones created as required. They are inserted using the AutoCAD Electrical Insert Component tool. Browse to insert. The symbol names are:

H - - 1_MULTI_CONN.dwg wire number changes through the symbol
H - - 1_MULTI_CONN_NOCHG.dwg wire number does not change through it

A dialog interface lets you encode multiple connection sequence information on to six sets of attribute groups carried on the symbol:

WD_1_TAGSTRIP Attribute to carry first terminal strip number (16 character maximum)
WD_1_TERMNO Attribute to carry optional terminal number
WD_1_INFO Attribute to carry additional information such as installation, location, catalog and item number assignments, and any connected cable information
WD_2_TAGSTRIP Same as above but for second terminal in the sequence
WD_2_TERMNO Same as above but for second terminal in the sequence
WD_2_INFO Same as above but for second terminal in the sequence through maximum of
WD_6_TAGSTRIP Same as above but for sixth terminal in the sequence
WD_6_TERMNO Same as above but for sixth terminal in the sequence
WD_6_INFO Same as above but for sixth terminal in the sequence

Click on the entry you wish to edit and select the Edit button.

**NOTE** For AutoCAD Electrical to recognize this symbol as a multi-connection sequence terminal symbol, at a minimum it must carry attribute named WD_1_TAGSTRIP. Multi-connection sequence terminal symbols do not support some AutoCAD Electrical auto-update and surfing features.
**Edit multi-connection sequence terminal symbol**

**Access:**

Click the Insert Component tool. Enter "H--1_MULTI_CONN_NOCHG" in the Type It box and click OK. Specify the insertion point on the drawing.

From the Components menu, select Insert Component. Enter "H--1_MULTI_CONN_NOCHG" in the Type It box and click OK. Specify the insertion point on the drawing.

Select any entry within a group to view/edit that group.

**Edit**

Opens the Edit entry dialog box so you can make changes to values such as the tag-ID, terminal number, or Installation code.

**Save Changes**

Saves your changes by writing the data to attributes on the symbol (most of these attributes are set as invisible).

---

**Edit entry**

**Access:**

Click the Insert Component tool. Enter "H--1_MULTI_CONN_NOCHG" in the Type It box and click OK. Specify the insertion point on the drawing. In the Edit Multi-Connection Sequence Terminal Symbol dialog box, select one of the six series-connected entries and click Edit.

From the Components menu, select Insert Component. Enter "H--1_MULTI_CONN_NOCHG" in the Type It box and click OK. Specify the insertion point on the drawing. In the Edit Multi-Connection Sequence Terminal Symbol dialog box, select one of the six series-connected entries and click Edit.

This in-line component lets you manually define a connection sequence of up to 6 series-connected terminal strip points. All are embedded in this single graphical component but are fully reported in the various wire connection reports.

For example, you might have a wire that connects from a pushbutton and goes out to a field device. But to get to the field device, the wire connection must pass through a local terminal strip, then a shipping split terminal strip, on to a field connection terminal strip, and finally a terminal strip near the field device. Instead of showing all four series-connected terminals in the wire,
you can substitute this single "multi-connection sequence" terminal representation and manually define the connection sequence.

**Tag - ID**

Terminal strip tag-ID

**Terminal Number**

Terminal strip terminal number

**Miscellaneous**

Edit box shows saved data values defined by selections below.

**Installation Code**

Changes the installation code assignment. You can search the current drawing or entire project for installation codes. A quick read of all the current or selected drawing file is done and a list of installation codes used so far is returned. Select from the list to automatically update the component with the installation code.

Assign short installation codes to components like "PNL" and "FIELD" so you can create location-specific BOM and component lists later.

**Location Code**

Changes the location codes. You can search the current drawing or entire project for location codes. A quick read of all the current or selected drawing file is done and a list of location codes used so far is returned. Select from the list to automatically update the component with the location code.

Assign short location codes to components like "PNL" and "FIELD" so you can extract cable from/to reports and location-specific BOM reports later. (For example, BOM for all field cables, BOM for all PNL cables.)

**Catalog Data**

You can do a drawing-wide or project-wide listing of similar components with their catalog assignments. During your editing session, the last MFG / CAT / ASSYCODE assignment for each component type you insert into your wiring diagram is remembered. When you insert another component of that type,
the previous component's catalog assignment is set as the default (assuming a previous one was made during the current editing session).

Find  Scans each drawing for the target component type and returns a list of what was found. You can make your catalog assignment by selecting from the list.

Catalog Lookup  Opens the component's catalog database from which you can manually enter or select the Manufacturer or Catalog values. Search the database for a specific catalog item to assign to the selected component. Database queries are set up in the 3 lists across the top of the dialog with the database hits listed in the dialog's main window.

Drawing  Lists the part numbers used for similar components in the current drawing.

Project  Lists the part numbers used for similar components in the project. You can search in the active project, another project, or in an external file.

- **Active project**: All the drawings in the current project are scanned and the results are listed in a dialog box. Select from the list to assign your new component with a catalog number that is consistent with other similar components in the project.

- **Other project**: Scans each listed drawing in a previous project for the target component type and returns the catalog information in a sub-dialog box. Make your catalog assignment by picking from the dialog list.

- **External file**: You can pull catalog assignments from a generic ASCII file created by a word processor or output from a spreadsheet or database program. A dialog box displays the contents of the selected text file. Find and highlight the desired entry. AutoCAD Electrical reads the line of text from the file and breaks it into its component parts. These are displayed in the left-hand dialog list. For each relevant item, highlight it and then pick the appropriate category button in the center column. The highlighted item is transferred to the corresponding category (and then to the Insert/Edit dialog box once OK is clicked).
Catalog Check
Displays what the selected item will look like in a Bill of Material template.

Wire entering this connection
Click Internal, External, or Both to change the Connection Code (I=Internal, E=External). The code changes the Miscellaneous value as follows: LEFT_TERMDESC=I (for Internal), LEFT_TERMDESC=E (for External).

Wire leaving this connection
Click Internal, External, or Both to change the Connection Code (I=Internal, E=External). The code changes the Miscellaneous value as follows: RIGHT_TERMDESC=I (for Internal), RIGHT_TERMDESC=E (for External).

Wire number
Manually define the wire number that leaves this terminal connection and goes to the next. If this is the last terminal in the sequence, this wire number assignment is ignored and the actual wire number connecting the right-hand side of the symbol is used.

Wire layer
Manually define the wire layer assignment. If this is the last terminal in the sequence, this value is ignored.

Cable
Manually define the cable marker tag-ID. If this is the last terminal in the sequence, this value is ignored.

Conductor
Manually define a cable marker conductor color value. If this is the last terminal in the sequence, this value is ignored.

Delete this entry
Removes the displayed terminal sequence from the overall list and moves any following entry positions up to fill in the gap.

Insert new before this one
Moves the current display terminal sequence down one position and creates a new, empty entry ahead of it. There is a maximum of 6 total positions.
Insert new after this one

Pushes all of the following sequences down one position and creates a new, empty entry just after the displayed entry. There is a maximum of 6 total positions.

Insert terminals and connectors

Terminal symbols on the schematic are a representation of wire connection points. The terminal symbol representation on the schematic can have associations with the physical terminal block on the panel drawing. To insert a terminal, select the Insert Component toolbar icon to display AutoCAD Electrical's icon menu, and then select Terminals/Connectors.

There are four types of terminal behavior that you can select from and five main terminal styles (square, round, hexagon, diamond and triangle). Each type of terminal behavior is controlled by the terminal block name.

Non-intelligent terminals. These do not show up in reports.

Terminals that take on a terminal number that matches the wire number passing through or connected to the terminal.

Terminals that carry a user-defined terminal number.

Terminals that force a new wire number to generate as a wire passes through the terminal.
Insert terminals

You can select from five main terminal styles (square, round, hexagon, diamond and triangle). Each type of terminal behavior is controlled by the terminal block name.

1. Click the Insert Component tool.

2. Click the Terminals/Connectors button.

3. Select a terminal symbol to insert.

4. Specify the insertion point.

5. On the Insert/Edit Terminal Symbol dialog box, annotate the terminal symbol including (but not limited to) the terminal number, tag strip value, and catalog information.

Insert/edit terminal symbol

Annotates the terminal by tracking which terminal numbers and terminal strip ID names have been used so far.

Access:

Click the Insert Component tool. Select Terminals and Connectors, select the terminal to insert and specify the insertion point on the drawing.

Click Components ➤ Insert Component. Select Terminals and Connectors, select the terminal to insert, and specify the insertion point on the drawing.

Click the Edit Component tool and select the terminal to edit.

Click Components ➤ Edit Component and select the terminal to edit.

Terminal

These controls determine the overall tagging of the terminal block in the project. The Installation, Location and Tag Strip values define which strip the terminal belongs to. The symbol block file name displays at the top of the Terminal group.
NOTE Assign short installation or location codes to components like "PNL" and "FIELD" to later take full advantage of the AutoCAD Electrical ability to create installation or location-specific Bill of Materials and component lists.

| Installation | Changes the installation codes. Click Browse to search the active drawing, entire project and an external list (default.inst) for installation codes. Pick from the list to automatically update the component with the installation code. |
| Location | Changes the location codes. Click Browse to search the active drawing, entire project and an external list (default.loc) for location codes. Pick from the list to automatically update the component with the location code. |
| Tag Strip | Specifies the Tag ID given to the terminal strip. If there is an existing name, it appears in the edit box; if not, you can enter a specific ID name. Click the < and > buttons to increment or decrement the last digit/character in the Tag Strip value. |
| Number | Specifies the terminal number. If there isn’t PINLIST information, the < and > buttons increment or decrement the terminal number. You can also click Pick to select a text object or an attribute on the active drawing to use for the terminal number. When inserting a new terminal, the highest terminal number in the strip is identified and the default terminal number for the new terminal increments by 1. |

NOTE This is unavailable when the terminal symbol does not have a TERM01 attribute or when the terminal number is the same as the wire number.

Modify Properties/Associations

These controls support associations between schematic terminal symbols and their panel terminal footprint or between multiple schematic terminal symbols.
NOTE You cannot associate terminals using the Add/Modify or Break Out options when you insert a terminal using the Insert Terminal (Panel List) tool. However, once the terminal is inserted onto the drawing, you can modify the associations using these tools.

Add/Modify
Displays the Add/Modify Associations dialog box where you can select terminal strips and their respective blocks to make an association to the terminal symbol being inserted or edited.

NOTE This is disabled if the active drawing is not part of the active project.

Pick
Selects another terminal symbol on the active drawing to associate to. You can select only one terminal symbol to make the association.

NOTE While in selection mode, you can use Pan or Zoom to find the terminal symbol to select.

Break Out
Removes the terminal being edited out of the defined association. The properties from the original association and the terminal’s levels are maintained.

Block Properties
Displays the Block Properties dialog box where you can define and maintain terminal block properties.

NOTE This is disabled if the active drawing is not part of the active project.

Properties/Associations
The list box displays the current status of the edited terminals association. It lists all associated terminal symbols from the schematic and terminal panel footprints. If the terminal symbol is being inserted for the first time, the list box only displays the reference for itself. The number of levels defined in the block properties displays at the top of the Properties/Associations group. The terminal being edited is highlighted in the list box.
You can double-click in the list to modify the terminal association in the Add/Modify Associations dialog box.

**Label**
Lists the level description defined in the terminal block properties. This data is entered into the LnnLABEL attribute if present; otherwise, it is placed into xdata.

**Number**
Lists the terminal numbers defined in the association. Only one terminal number is allowed per level and each level displays its respective terminal number or text. Panel terminal symbols do not display terminal numbers.

**PinL**
Lists the pin numbers defined on the left side of the terminal block. This data is entered into the LnnPINL attribute if present; otherwise, it is placed into xdata.

**PinR**
Lists the pin numbers defined on the right side of the terminal block. This data is entered into the LnnPINR attribute if present; otherwise, it is placed into xdata.

**Reference**
Lists the terminal symbol’s reference location in the project. The syntax is ‘Sheet,Reference’ based on the drawing configuration.

---

**Project List**
These controls allow for quick selection of terminal strips and terminal numbers used throughout the active project.

**Project List**
Shows all the previously defined terminal strips in the active project. When inserting a new terminal, this list is populated with the previously inserted terminal’s Installation, Location and TAGSTRIP values.
Lists all terminal numbers found, either drawing-wide or project-wide, whose Tag Strip value matches the highlighted Tag Strip value.

**Catalog Data**

You can do a drawing-wide or project-wide listing of similar terminals with their catalog assignments. During your editing session, the last MFG / CAT / ASSYCODE assignment for each terminal type you insert into your wiring diagram is remembered. When you insert another terminal of that type, the previous terminal’s catalog assignment is set as the default (assuming a previous one was made during the current editing session).

**Manufacturer**
Lists the manufacturer name for the terminal. Enter a value or select one from the Catalog lookup.

**Catalog**
Lists the catalog number for the terminal. Enter a value or select one from the Catalog lookup.

**Assembly**
Lists the assembly code for the terminal. The Assembly code is used to link multiple part numbers together.

**Item**
Specifies a unique identifier assigned to each terminal. The value can be manually typed in the edit box.

**Catalog Lookup**
Opens the terminal’s catalog database from which you can select the Manufacturer and Catalog values. Search the database for a specific catalog item to assign to the selected terminal. Database queries are set up in the 3 lists across the top of the dialog with the database hits listed in the dialog’s main window.

**Drawing**
Lists the part numbers used for similar terminals in the active drawing.

**Project**
Lists the part numbers used for similar terminals in the project. You can search in the active project, another project, or in an external file.

| Active project: | All the drawings in the active project are scanned and the results are listed in a dialog box. Select from |

| 564 | Chapter 9  | Terminal Tools  |
the list to assign your new terminal with a catalog number that is consistent with other similar terminals in the project.

- **Other project**: Scans each listed drawing in a previous project for the target terminal type and returns the catalog information in a sub-dialog box. Make your catalog assignment by picking from the dialog list.

- **External file**: You can pull catalog assignments from a generic ASCII file created by a word processor or output from a spreadsheet or database program. A dialog box displays the contents of the selected text file. Find and highlight the desired entry. AutoCAD Electrical reads the line of text from the file and breaks it into its component parts. These are displayed in the left-hand dialog list. For each relevant item, highlight it and then pick the appropriate category button in the center column. The highlighted item is transferred to the corresponding category (and then to the Insert/Edit dialog box once OK is clicked).

### Multiple Catalog
Inserts or edits extra catalog part numbers on to the selected terminal. You can add up to 10 part numbers to any terminal. These multiple BOM part numbers appear as sub-assembly part numbers to the main catalog part number in the various BOM and terminal reports.

### Catalog Check
Extracts the details from the catalog database to display what the selected item will look like in a Bill of Material template.

### Descriptions
Specifies the optional description attribute text to assign to the terminal block (up to 3 lines of text can be specified). Click Browse to search for all terminal descriptions in the project or active drawing. Select the description you want to copy to the edited terminal block by selecting it in the list and clicking OK.

**NOTE** These edit boxes are disabled if the terminal does not carry the attributes (such as ratings).

### Defaults
Opens an ASCII text file (wd_desc.wdd or <project>.wdd) from which you can select standard descriptions.
Picks a description from a component on the current drawing.

**Ratings**

You can enter up to 12 ratings attributes on a component. The View/Edit Rating Values dialog box lets you enter values for each ratings attribute. Select the Defaults button next to the edit box to display a list of default values.

**NOTE** If this button is grayed out, the component you are editing does not carry any rating attributes.

**Show/Edit Miscellaneous**

View or edit any attributes that are not predefined AutoCAD Electrical attributes.

**Terminal block properties**

Use this dialog box to control the number of levels assigned to a multiple level terminal block. You can control the level description, number of wires per connection, pins right and pins left. The terminal block properties are maintained on every terminal symbol in its association.

**Access:**

Click the Insert Component tool. Select Terminals and Connectors from the dialog box and specify the insertion point on the drawing. In the Insert/Edit Terminal Symbol dialog box, click Block Properties.

Click Components ➤ Insert Component. Select Terminals and Connectors from the dialog box and specify the insertion point on the drawing. In the Insert/Edit Terminal Symbol dialog box, click Block Properties.

Click the Edit Component tool and select the terminal to edit. In the Insert/Edit Terminal Symbol dialog box, click Block Properties.

Click Components ➤ Edit Component and select the terminal to edit. In the Insert/Edit Terminal Symbol dialog box, click Block Properties.

**NOTE** You can also access this dialog box by clicking Edit Terminal Block Properties on the Terminal Strip Editor dialog box.
The default level for any terminal symbol that is placed into the project that is not associated to another is 0.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufacturer</td>
<td>Displays the Manufacturer value that is currently assigned to the terminal being edited.</td>
</tr>
<tr>
<td>Catalog Number</td>
<td>Displays the Catalog Number value that is currently assigned to the terminal being edited.</td>
</tr>
<tr>
<td>Assembly Code</td>
<td>Displays the Assembly Code value that is currently assigned to the terminal being edited.</td>
</tr>
<tr>
<td>Levels</td>
<td>Specifies the number of levels for the terminal. The grid expands for editing based on the number of levels specified. You can then define the level description, wires per connection and pins.</td>
</tr>
<tr>
<td>Terminal Block Property Definition grid</td>
<td>Displays the terminal levels. You can edit and maintain properties of the terminal block here.</td>
</tr>
<tr>
<td>Level Description: Specifies the description for the levels of the terminal block. Text you enter here displays in the Insert/Edit Terminal Symbol and Multiple Level dialog boxes. This is a terminal property that is maintained on every symbol in its association.</td>
<td></td>
</tr>
<tr>
<td>Wires per Connection: Specifies the number of wires allowed per connection for the terminal connection point.</td>
<td></td>
</tr>
<tr>
<td>Pin Left/Pin Right: Specifies labels for pin numbers associated to the terminal destinations. These fill in the LnnPINL and LnnPINR attributes on the terminal block when its level is selected. This is a terminal property that is maintained on every symbol in its association.</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** These properties do not limit the number of connections allowed on the schematic.
Terminal block property attributes

The values in the grid are stored as follows, where “nn” represents the level number and is always stored as two digits (i.e. 01, 02, and so on):

<table>
<thead>
<tr>
<th>Data</th>
<th>Attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level Description (60 characters maximum)</td>
<td>LnnLABEL</td>
</tr>
<tr>
<td>Wires Per Connection (3 characters maximum)</td>
<td>LnnWIREPERC</td>
</tr>
<tr>
<td>Pin Left (12 characters maximum)</td>
<td>LnnPINL</td>
</tr>
<tr>
<td>Pin Right (12 characters maximum)</td>
<td>LnnPINR</td>
</tr>
</tbody>
</table>

**NOTE** If these attributes are not present, the data is placed into Xdata with the same name, only with a “VIA_WD_” prefix.

Overview of terminal relationships

AutoCAD Electrical supports two types of relationships for terminals: schematic-to-schematic and schematic-to-panel.

**Schematic-to-Schematic**

The schematic-to-schematic relationship defines separate schematic terminal symbols as one multi-level (also referred to as multi-tier or multi-stack) terminal block. On the schematic drawing, each schematic terminal symbol represents one level of the multi-level terminal block.

**NOTE** Multiple terminal symbols for one level is not currently supported.

The number of levels for the block is defined as a block property. Each level carries certain characteristics, such as a label, wires per connection, left pin, and right pin. Each schematic terminal symbol carries all of the block properties for each level so that removing one terminal symbol does not remove the
block properties. If a block property is modified, all of the terminal symbols update.

The terminal symbols are associated by an ID value held on the LINKTERM attribute or xdata. When a terminal symbol is inserted, by default it is seen as a standalone terminal (it has no associations) and receives a new LINKTERM value. When the terminal is associated to another, the LINKTERM value updates so that each terminal carries the same LINKTERM value. Changing or removing the LINKTERM value breaks any associations that terminal may have.

To associate schematic terminals, you first need to add block properties. The number of terminals you can associate is limited to the number of levels defined in the block properties. Once block properties are established you can associate schematic terminals to build a multi-level terminal block by:

- Clicking the Components ➤ Terminals ➤ Associate Terminals tool. You select a master terminal and then select each terminal symbol to associate to the master.
- Clicking Pick on the Insert/Edit Terminal Symbol dialog box. This adds the edited symbol into an association with the picked terminal.
- Clicking Add/Modify on the Insert/Edit Terminal Symbol dialog box. This adds the edited symbol into an association with any schematic terminal in the project.

Prebuilt circuits may contain associated terminals. These relationships are maintained when the circuit is inserted. Copying a circuit also maintains these relationships within the copied circuit.

When the Bill of Materials report is run, these separate terminal symbols that make up one multi-level terminal, are counted as one in the quantity.

**Schematic-to-Panel**

The schematic-to-panel relationship is used mainly for updating. If the schematic or panel is modified, the other updates to reflect the changes. This relationship is similar to component relationships, which are based on the TAG value. The TAGSTRIP, Installation and Location values need to match for the terminals to associate together and the association number on the LINKTERM is also taken into account when creating a relationship between the schematic terminal and its panel representation. Block properties are not required to associate a schematic to panel terminal. Once they are associated, modifications on one results in modifications on the other.
You can associate a schematic and panel terminal automatically using either the Insert Panel Terminal from Schematic tool or the Insert Schematic Terminal from Panel tool. In the case of multi-level terminals, the Insert Panel Terminal from Schematic tool shows only one terminal for insertion regardless of how many schematic terminal symbols/levels there are for that multi-level block. The Insert Schematic Terminal from Panel tool shows one terminal for each level for insertion.

**NOTE** Panel terminals inserted by the Terminal Strip Editor are automatically associated to the schematic representation.

Additionally, you can click the Components ➤ Terminals ➤ Associate Terminals tool to select terminals to associate or click Add/Modify on the Panel Layout - Terminal Insert/Edit dialog box to add the panel terminal to an association with a schematic terminal on any drawing in the project.

**Associate terminals**

Use the Associate Terminals tool to associate two or more terminal symbols together. Associating schematic terminals combines the terminals into a single terminal block property definition. The number of schematic terminals that can be combined is limited to the number of levels defined for the block properties.
Associating a panel terminal provides a way to define a particular panel footprint to represent a schematic block property definition.

1. Click the arrow on the Miscellaneous tool to access the Associate Terminals tool.

2. Click the Associate Terminals tool.

3. Select a terminal symbol to use as the master. This is used as the basis for any terminal property definition.

   **NOTE** Your terminal symbol must have block properties defined. To define block properties, right-click on the symbol and select Edit Component. In the Insert/Edit Terminal Symbol dialog box, click Block Properties.

4. Select additional terminal symbols to add to the association.

5. Press Enter to associate the terminals.

   The catalog data, block properties, Tagstrip value, Installation code and Location code are copied from the master terminal and added to the terminals in the association.

   **NOTE** If the number of selected terminals exceeds the total number of levels defined in the block properties, an alert displays and the extra terminals are not added to the association.

**Tips and Hints**

- This tool works on terminal symbols on the same drawing only.

- If the master terminal is already part of another association, the existing association is maintained and the newly selected terminal symbols join the association.

- If the selected terminals are part of their own association, they are removed from the association and added to the new association with the selected master terminal.

- Terminals placed onto the drawing using the Terminal Strip Editor cannot be added to an association using this tool.
Show terminal associations

Use the Show Terminal Associations tool to display the current associations for the selected terminals. AutoCAD Electrical draws temporary lines between the associated terminals. These graphics disappear the next time you do a Regen.

1. Select Components ➤ Terminals ➤ Show Terminal Associations.
2. Select the terminals you want to view the associations of.

Red dashed lines are drawn between the terminals that are associated to the selected terminal. A list of the associated terminals also displays at the command prompt.

Break apart terminal associations

Use the Break Apart Terminal Associations tool to break a terminal symbol out of an existing association. Schematic terminals are removed from any multi-tier relationship and any schematic-panel relationships. Panel terminals are removed from any schematic-panel relationships.

NOTE The properties of the existing terminal association are maintained on each symbol.

1. Click the arrow on the Miscellaneous tool to access the Break Apart Terminal Associations tool.
2. Click the Break Apart Terminal Associations tool.
3. Select the terminal to remove from the association. Repeat for each terminal you want to break out of its associations.
4. Press Enter.

Copy terminal block properties

Use the Copy Terminal Block Properties tool to copy terminal properties from one terminal symbol to another. If the application of the terminal properties reduces the number of levels and the number of schematic terminal symbols
in the association exceeds the total allowed, an alert displays and the properties are not copied.

1. Click the arrow on the Miscellaneous tool to access the Copy Terminal Block Properties tool.

2. Click the Copy Terminal Block Properties tool.

3. Select the master terminal to copy properties from.

4. Select the terminals to apply the properties to.

5. Press Enter.

**Edit terminal jumpers**

Use the Edit Jumper tool to jumper two or more terminals together in a schematic diagram. The terminals to be jumpered can be on the same drawing or span multiple drawings within the same project. Choose one of the following workflows for editing terminal jumpers:

**Workflow 1:**

1. Select Components ➤ Terminals ➤ Edit Jumper.

2. Select the primary terminal.

3. Do one of the following:
   - Select the secondary terminal on the drawing to create a jumper to the primary terminal. You cannot select a terminal that is part of another jumper.
   - Enter Browse (B) at the command line to browse to and select the secondary terminal in the Select Terminals to Jumper dialog box.

4. (Optional) Continue selecting any terminals to add to the jumper.

5. Press Enter to create the jumper or enter Edit (E) to edit the existing jumpers.
6 (Optional) If you selected to edit the jumpers, make modifications in the Edit Terminal Jumpers dialog box and click OK.

7 (Optional) Enter Show s at the command line to draw temporary broken lines between the primary terminal and secondary terminals within the same drawing.

**Workflow 2:**

1 Select Components ➤ Terminals ➤ Edit Jumper.

2 Enter Browse (B) at the command line.

3 Select the terminals to be jumpered (from the left tree view) and copied to the right tree view.

4 Do one of the following:
   - Click Edit to create the jumper or edit the jumpers on the selected terminal.
   - Click Close to return to the command prompt and:
     - (Optional) Select additional terminals in the drawing to add to the jumper.
     - Press Enter to create the jumper or enter Edit (E) to edit the existing jumpers.
     - (Optional) If you selected to edit the jumpers, make modifications in the Edit Terminal Jumpers dialog box and click OK.
     - (Optional) Enter Show s at the command line to draw temporary broken lines between the primary terminal and secondary terminals within the same drawing.

5 Click Cancel to cancel the operation.

**Select terminals to jumper**

Use this to select a terminal from a list of all the terminals in the active project.

**Access:**

Click Components ➤ Terminals ➤ Edit Jumper. Enter Browse (B) at the command line or first select a terminal and then enter Browse (B) to select additional terminals.
As you select a terminal, the drawing in which that terminal resides displays under the tree views or under the terminal preview window.

<table>
<thead>
<tr>
<th>Schematic Terminals</th>
<th>Lists all of the terminal strips and terminals in the active project. Select the terminals to jumper together; as you make your selection, the terminals are bolded in the left tree and added to the Jumper Terminals list. Terminal nodes have a graphic on the left side to indicate whether the terminal has a jumper attached to it. An empty circle indicates that there isn’t a jumper and the filled circle means a jumper exists.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jumper Terminals</td>
<td>Lists the terminals that will be jumpered into a single jumper group, including any terminals selected at the command prompt.</td>
</tr>
<tr>
<td>&lt; or &gt;</td>
<td>The &gt; button copies the selected terminals to the Jumper Terminals list; the selected terminals are then bolded in the Schematic Terminals list. The &lt; button removes the selected terminals from the Jumper Terminals list and unbolds the terminal in the Schematic Terminals list.</td>
</tr>
<tr>
<td>Edit</td>
<td>Creates a jumper across the selected terminals and displays the Edit Terminal Jumpers dialog box.</td>
</tr>
<tr>
<td>View</td>
<td>Displays the selected terminal in a preview window at the bottom of the dialog box.</td>
</tr>
</tbody>
</table>

**NOTE** You can select to view a schematic terminal or tabular view of the entire terminal strip. If you select a terminal strip from the Schematic Terminal list and click View, a tabular view of the terminal strip displays, showing a layout of the connected terminals.

By default, the preview window is hidden. This can be toggled using Show and Hide once a terminal has been viewed.
Switches the visibility of the preview window at the bottom of the dialog box.

**Preview window**

Shows a graphical representation of the selected terminals. You can pan the image using the left mouse button or the Pan tool. You can zoom the image using the mouse wheel or the various zoom tools.

**Edit terminal jumpers**

Use this to edit the jumper information (such as adding catalog data) or delete the jumper.

**Access:**

Click Components ➤ Terminals ➤ Edit Jumper. Enter Edit (E) at the command line or first select a terminal and then enter Edit (E).

**Jumpers to Terminals**

Lists all of the jumpers (grouped by Jumper ID) attached to the selected terminal.

**Catalog Data**

Specifies the catalog data for the jumper between the primary terminal and the selected terminal. If the selected terminal is not jumpered these options are disabled.

- **Manufacturer:** Specifies the manufacturer name.
- **Catalog:** Specifies the catalog name.
- **Assembly:** Specifies the assembly code.
- **Item:** Specifies the item value.
- **Count:** Specifies how the catalog data is used in the Bill of Materials. When multiple terminals are jumpered together, you can have a single catalog item represent a jumper bar that spans the selection, or single jumpers between each terminal.
- **Lookup:** Displays the catalog database from which you can select the Manufacturer and Catalog values.

- **Drawing:** Lists the part numbers used for similar components in the active drawing.

- **Project:** Lists the part numbers used for similar components in the active project.

---

**Delete**

Select the jumper label, terminal strip or a single terminal to perform one of the following actions:

- **Jumper label:** Deletes the jumper from all of the terminals.

- **Terminal strip:** Deletes the terminals in that group from the jumper. If there are no remaining terminals in the group, the jumper is deleted.

- **Single terminal:** Deletes the terminal from the jumper. If this is the last terminal to be deleted, the entire jumper is deleted.

---

**View**

Displays the selected terminal in a preview window at the bottom of the dialog box.

By default the preview window is hidden. This can be switched using Show and Hide once a terminal has been viewed.

---

**Hide/Show**

Switches the visibility of the preview window at the bottom of the dialog box.

---

**Preview window**

Shows a graphical representation of the selected terminals. You can pan the image using the left mouse button or Pan tool. You can zoom the image using the mouse wheel or the various zoom tools.
Resequence terminal numbers

AutoCAD Electrical provides utilities to make it easy to resequence the terminal numbers across one or many drawings. These utilities do not resequence terminals that carry a wire number as the terminal number.

1. Select Components ➤ Components Miscellaneous ➤ Terminal Strip Utilities.

2. Select a method to use for resequencing the terminal strips.
   - **Terminal Renumber (Pick Mode):** Enter the first terminal number to use and press Enter. Select each terminal in order on the screen. The terminal number updates automatically, incrementing with each pick. Right-click to exit the command.
   - **Terminal Renumber (Project-Wide):** The Project-wide Schematic Terminal Resequence dialog box displays. Follow these steps.

3. Enter the terminal strip tag ID and the starting terminal number.

4. If you want to refine the search, enter an installation or location code to use when searching the drawings.
   Click Project or Drawing to select an installation or location code from existing terminal numbers.

5. Click OK.

6. In the Select Drawings to Process dialog box, select the drawings to search through, and click OK.

Project-wide schematic terminal renumber

This resequences the terminal numbers across one or many drawings.

Access:

From the Components menu, select Components Miscellaneous ➤ Terminal Strip Utilities ➤ Terminal Resequence (project-wide).
### View terminal wire connections

Schematic and panel layout/wiring diagram terminal symbols can carry TERMDESC attribute values used to control which side of a terminal is to receive internal or external wire connections. Schematic terminals use attributes X1TERMDESC01 for the right wire connection, X2TERMDESC01 for the top, X4TERMDESC01 for the left, and X8TERMDESC01 for bottom wire connections.

<table>
<thead>
<tr>
<th>Tag-ID</th>
<th>Specifies the terminal strip ID to use when searching each drawing for terminals. Only terminals with this ID are updated.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Installation/Location in terminal strip Tag-ID match</td>
<td>Updates a terminal only if it matches the Terminal Strip ID, Location, and Installation values specified.</td>
</tr>
<tr>
<td>Installation code</td>
<td>Refines the search by including an installation value.</td>
</tr>
<tr>
<td>Location code</td>
<td>Refines the search by including a location value.</td>
</tr>
<tr>
<td>Starting terminal number</td>
<td>Specifies the number to begin the terminal strip with; you can use alphanumeric values. The default value is 1.</td>
</tr>
</tbody>
</table>

After you click OK, select the drawings to process from the active project.
**Show terminal internal/external connections**

This tool shows the state of the invisible attribute values for selected objects. The values are shown with red and green arrows.

1. Click the arrow on the Insert Wires tool to access the Terminal: Show Internal/External Connections tool.
2. Click the Terminal: Show Internal/External Connections tool.
3. Select the objects to show the connection codes for. You can pick on individual objects or select a group of objects using a boundary box.

**Mark internal connections**

This tool marks attributes with an 'I' for internal wiring.

1. Click the arrow on the Insert Wires tool to access the Terminal: Show Internal/External Connections tool.
2. Click the arrow on the Show Terminal Connection Codes tool to access the Terminal: Mark Internal Connections tool.
3. Click the Terminal: Mark Internal Connections tool.
4. Select near a terminal's wire connection point. The attribute will be marked with an arrow to indicate whether it is an internal.

**Mark external connections**

This tool marks attributes with an 'E' for external wiring.
1 Click the arrow on the Insert Wires tool to access the Terminal: Show Internal/External Connections tool.

2 Click the arrow on the Terminal: Show Internal/External Connections tool to access the Terminal: Mark External Connections tool.

3 Click the Terminal: Mark External Connections tool.

4 Select near a terminal's wire connection point. The attribute will be marked with an arrow to indicate whether it is an external value.

**Erase connection codes**

1 Click the arrow on the Insert Wires tool to access the Terminal: Show Internal/External Connections tool.

2 Click the arrow on the Terminal: Show Internal/External Connections tool to access the Terminal: Erase Internal/External Connections tool.

3 Click the Terminal: Erase Internal/External Connections tool.

4 Select near a terminal's wire connection point to erase the connection code. (I= internal, E= external)
Create terminal strips

Use the Terminal Strip utility to create non-intelligent terminal strips. The terminal numbers can be imported from a file, windowed on one or more drawings, individually picked, typed in by hand, or all of the above.

1. Select Components ➤ Components Miscellaneous ➤ Terminal Strip Utilities.

2. Select a method to use for creating the terminal strips.
   - **Terminal List (Manual Picks):** Select to pick or window the text and/or attribute values you want to import into the terminal strip generator utility.
   - **Terminal List (From File):** Select the file containing the terminal text.

3. Press Enter to end the selection.
   The Terminal Strip Representation dialog box displays.

4. In the Terminal Strip Representation dialog box, sort, add, remove, and re-arrange the terminal strip layout.

5. Click OK.
   The Terminal Strip Representation Setup dialog box displays. Set the text size, terminal height and width sizes, and terminal strip orientation.

6. Make your selections and click OK.

7. Select the insertion point for your terminal strip.

Modify an existing terminal strip

1. Re-invoke the command, window the existing terminal strip to capture the existing terminal numbers.

2. Cancel the command.

3. Delete the old terminal strip.

4. Re-invoke the terminal strip utility.

5. Make any edits and re-insert the terminal strip.

**Terminal strip representation**
Access:

From the Components menu, select Components Miscellaneous ➤ Terminal Strip Utilities ➤ Terminal List (Manual Picks).
From the Components menu, select Components Miscellaneous ➤ Terminal Strip Utilities ➤ Terminal List (From File).

You can sort, add, remove, and re-arrange the terminal strip layout. You can even go to other schematic drawings and add more to the list (just click Cancel, go to the next drawing, and re-invoke the utility - it remembers what you have accumulated so far).

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define spare</td>
<td>Defines the label for the spare terminals.</td>
</tr>
<tr>
<td>Sort</td>
<td>Sorts the list of terminals in ascending order.</td>
</tr>
<tr>
<td>Reverse sort</td>
<td>Rearranges the list of terminals in descending order.</td>
</tr>
<tr>
<td>Move up</td>
<td>Moves the selected terminal up one spot in the terminal list.</td>
</tr>
<tr>
<td>Move down</td>
<td>Moves the selected terminal down one spot in the terminal list.</td>
</tr>
<tr>
<td>Insert new</td>
<td>Creates a new terminal to add to the terminal strip. Specify the terminal name/number, the number of terminals to insert, and indicate whether to make the new terminal the spare terminal.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the Edit dialog box so you can change the terminal text or count.</td>
</tr>
<tr>
<td>Cut</td>
<td>Removes the selected terminal from the terminal list.</td>
</tr>
<tr>
<td>Copy</td>
<td>Makes a copy of the selected terminal and stores it in the Paste clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Adds the copied terminal into the terminal list from the clipboard.</td>
</tr>
<tr>
<td>Pick</td>
<td>Temporarily dismisses the dialog box and allows you to select more terminals for the list.</td>
</tr>
</tbody>
</table>
Terminal strip representation - setup

Annotates the text size, height and width sizes, and orientation of the terminal strip.

Access:

From the Components menu, select Components Miscellaneous ➤ Terminal Strip Utilities ➤ Terminal List (Manual Picks). Select the terminal to modify and click OK.

From the Components menu, select Components Miscellaneous ➤ Terminal Strip Utilities ➤ Terminal List (From File). Select the terminal to modify and click OK.

Terminal Text

Text Specifies to align the text to the left, center, or right side of the terminal strip.

Height Sets the height of the terminal strip.

Width Sets the width of the terminal strip.

Layer Specifies the layer for the table text. The selected layer is displayed next to the button on the dialog box.

Terminal pitch and Terminal width

Terminal pitch (spacing) Sets the spacing between entries in the terminal strip.

Terminal width Sets the width for the terminal strip.

Use .750 Changes the terminal width value to .750 if selected.

Terminal Ruling

Box Around Creates a single box around the terminal strip.
Between Entries Creates lines between entries in the terminal strip.

Start Line Specifies which line the terminal strip will start at.

End Specifies which line the terminal strip will end at.

Layer Specifies the layer for the table ruling lines. The selected layer is displayed next to the button on the dialog box.

**Terminal Strip Orientation**

Vertical Specifies to vertically display the terminal strip.

Rotate 90 degrees (counter-clockwise) Specifies to rotate the terminal strip 90 degrees in a counter-clockwise direction.

Rotate -90 degrees (clockwise) Specifies to rotate the terminal strip 90 degrees in a clockwise direction.

**Use the terminal strip editor**

Terminal blocks are used to connect devices that require quick disconnect or disassembly during product shipment, while at other times they can be used to distribute power to other devices. The Terminal Strip Editor defines the locations for these connected devices during the system design process. Terminal strip editing is primarily used towards the end of the control system design cycle to expedite the labeling, numbering, and rearranging of terminals on a terminal strip.

A document that is created to facilitate the construction of a terminal strip and all of its wiring is a terminal strip layout drawing. These drawings display the general arrangement of all the terminal blocks that belong to a specific terminal strip. You can also display the wiring and device connection information next to the terminal block symbol using the Terminal Strip Editor. You can rely on the terminal strip layout drawing for all information regarding the terminal strip without having to reference the schematic drawings.
The Installation (INST), Location (LOC) and Tag Strip (TAG_STRIP) values are used to determine a terminal strip’s uniqueness no matter which standard is used in the active project (such as IEC or JIC).

After changes have been made with the Terminal Strip Editor, the changes are written back to the schematic drawing for future updates, and a graphical or tabular drawing of a terminal strip layout is created. Your drawing must be part of the active project in order to perform updates.

**NOTE** If you make changes to an existing graphical terminal strip, the Terminal Strip Editor requires that the terminal strip is refreshed or placed on a drawing in the active project so the information is saved.

If the Terminal Strip Editor encounters an error and is unable to start, a log file (named TSE_Error_<date and time>.log) is created in the same location as the project file. The log information includes details about the event, the user name, project name, date and time.

**Wiring Constraints**

The Terminal Strip Editor can add or remove extra terminals based on the assigned wiring constraints. Wiring constraints is the limitation of the number of wires that can be connected to a particular device (for example, terminal). When modifying terminals, you can assign the number of wires allowed for each side of the terminal in the Wires Per Connection section of the Terminal Block Properties dialog box.

Extra terminals get placed only when editing a terminal using the Terminal Strip Editor. Once you define the Wires Per Connection value, the Terminal Strip Editor checks to see if there are more wires/devices connected to a side of the terminal than what is allowed. If it finds the defined constraint to be exceeded, the Terminal Strip Editor adds an additional terminal and moves the destination that is exceeding the constraint to the new terminal. The new terminal has the same destination, property, and catalog assignment as the original terminal. The moved destination is placed in the same level of the new terminal as it was in the original terminal. The extra terminals are reflected in the Bill of Materials.

When a terminal strip is edited with the Terminal Strip Editor, the need for extra terminals is re-evaluated and they are removed if the constraints are no longer exceeded. If the main footprint terminal is removed from the association, the extras are removed.
Insert a terminal strip using the Terminal Strip Editor

1. On the Panel Layout toolbar, click the Terminal Strip Editor tool.
2. On the Terminal Strip Selection dialog box, click New.
   
   **NOTE** If you want to use the Installation, Location, and Tag Strip values from an existing terminal, select the terminal before you click New.

3. On the Terminal Strip Definition dialog box, specify the Installation code, Location code, Tag Strip value, and number of terminal blocks to be defined on the terminal strip.
4. Click OK.
5. Select the tab to edit: Terminal Strip, Catalog Code Assignment, Cable Information or Layout Preview.
   - **Terminal Strip tab**: Modify the terminal block properties, spare terminals, accessories, multi-level terminals, and destination locations.
   - **Catalog Code Assignment tab**: In addition to what can be done in the Terminal Strip tab, you can assign, delete, copy, or paste catalog part numbers to terminal blocks.
   - **Cable Information tab**: View the terminal destination locations based on the cable assignments. Modify the terminal block properties, spare terminals, and terminal tag or number.
   - **Layout Preview tab**: Create graphical table blocks or table object drawings of the selected terminal strip. You can preview the terminal in the Preview window before inserting the terminal strip onto the current drawing.

6. On the Preview Layout tab, click Insert Terminal Strip.
7. Specify the terminal strip insertion point on the drawing.

Select a terminal strip to edit

1. On the Panel Layout toolbar, click the Terminal Strip Editor tool.

Use the terminal strip editor | 587
2 Select which terminal strip to edit on the Terminal Strip Selection dialog box and click Edit.

3 Select the tab to edit: Terminal Strip, Catalog Code Assignment, Cable Information or Layout Preview.
   - **Terminal Strip tab:** Modify the terminal block properties, spare terminals, accessories, multi-level terminals, and destination locations.
   - **Catalog Code Assignment tab:** In addition to what can be done in the Terminal Strip tab, you can assign, delete, copy, or paste catalog part numbers to terminal blocks.
   - **Cable Information tab:** View the terminal destination locations based on the cable assignments. Modify the terminal block properties, spare terminals, and terminal tag or number.
   - **Layout Preview tab:** Create graphical table blocks or table object drawings of the selected terminal strip. You can preview the terminal in the Preview window before inserting or updating the terminal strip in the current drawing.

4 Modify the terminal strip and click OK.
   To place the terminal strip on the current drawing, click Insert Terminal Strip on the Preview Layout tab. You can also click Rebuild or Refresh to update the edited graphical or table object terminal strip in place.

**Terminal strip selection**

Displays terminal strips inside of the active project. The combination of Installation, Location, and Terminal Strip values make a complete unique record for selection in the Terminal Strip Selection dialog box.

**Access:**

On the Panel Layout toolbar, click the Terminal Strip Editor tool.
Click Panel Layout ➤ Terminal Strip Editor.

**NOTE** Empty fields from the schematic display empty boxes in the selection window to indicate that no value was defined by the user in the schematic drawing.
Sort the entire table by selecting the individual column headers. Do any of the following:

- To edit an existing terminal strip, select the terminal strip and click Edit.
- To create a new terminal strip, click New.
- To create a new terminal strip based on an existing one, select the terminal strip and click New.

**Terminal strip definition**

This dialog box controls the naming of the terminal strip, Installation and Location codes, and default options for the terminal blocks being created.

**Access:**

On the Panel Layout toolbar, click the Terminal Strip Editor tool. On the Terminal Strip Selection dialog box, click New.

Click Panel Layout ➤ Terminal Strip Editor. On the Terminal Strip Selection dialog box, click New.

Use the following options to create a new terminal strip definition that has not been placed into the schematic. Some of the properties are written to each terminal symbol on the graphical terminal strip layout drawing.

**Installation**

Specifies the Installation code value for the new terminal strip. Click Browse to display a list of existing installation values found in the active drawing, entire project or an external list (default.inst). Pick from the list to automatically update the component with the installation code.

**Location**

Specifies the Location code value for the new terminal strip. Click Browse to display a list of existing location values found in the active drawing, entire project or an external list (default.inst). Pick from the list to automatically update the component with the location code.

**Terminal Strip**

Specifies the strip tag name for the new terminal strip. You cannot have duplicate terminal strip names in the active project.
Number of Terminal Blocks

Specifies the number of blocks the terminal strip is made up of. This value is not maintained on any of the terminal symbols in the graphical terminal strip layout.

If the Installation and Location values are left blank, the terminal strip is created using only the strip tag name. The Installation (INST), Location (LOC) and Tag Strip (TAG_STRIP) values are used to determine a terminal strip’s uniqueness no matter which standard is used in the active project (such as IEC or JIC).

Terminal strip editor: terminal strip tab

Modifies terminal numbering, sorting, and destination settings. The terminals display in the center of the list box, with the destinations on both sides.

Access:

On the Panel Layout toolbar, click the Terminal Strip Editor tool. Make your selection on the Terminal Strip Selection dialog box and click Edit or New. Click the Terminal Strip tab.

You can sort the terminal blocks inside of the Terminal Strip Editor dialog box by selecting the column headers. The first click on the header sorts the column in ascending order. The second click sorts in descending order. The sort criteria applies to all tabs inside of the Terminal Strip Editor dialog box so you do not have to sort again if you switch between tabs.

Terminal Listing

There are three sections to the grid: Internal Destination, Terminal Block Information, and External Destination. The bold vertical grid lines make it easier to determine the differences in these sections. The horizontal grid lines delineate between wires connected to the terminal blocks. Each row indicates one wire per side. The bold horizontal grid lines make it easier to distinguish separations between terminal blocks on the strip.

Select the terminal blocks for editing. Multiple blocks can be selected using either the Shift or Control key while highlighting rows, or by clicking and dragging the mouse. If you select a single row that is part of a multi-line terminal entry, all associated rows highlight.
NOTE You can right-click any row in the terminal listing to access any of the editing tools found in the button groupings at the bottom of the dialog box. You can also right-click to select or deselect all of the terminals in the strip.

<table>
<thead>
<tr>
<th>Internal Destination</th>
<th>Displays the devices on the left side of the terminal strip.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal Block Information</td>
<td>Displays the terminal block number and terminal device pin connection descriptions. These values display in the Terminal Listing with a blue background indicating that they are associated to the terminal block.</td>
</tr>
<tr>
<td>External Destination</td>
<td>Displays the devices on the right side of the terminal strip.</td>
</tr>
</tbody>
</table>

A single line entry terminal block has only two wires connected with its destinations on opposing sides (left/right). Use the terminal block properties to connect more wires to the terminal block, which changes the block into a multiple-line terminal entry.

Properties

- **Edit Terminal Block Properties**
  - Defines or edits terminal block properties. When a multi-level terminal block is selected, the properties are edited for all levels of the terminal. The defined properties are assigned to every terminal symbol in its association. You can define up to 99 terminal levels in the block properties.

- **Copy Terminal Block Properties**
  - Copies terminal block properties from one terminal to be pasted into another terminals.

- **Paste Terminal Block Properties**
  - Pastes the previously copied terminal block properties into the selected terminals.
**Terminal**

*Edit Terminal*  
Modifies the selected terminal block. Any modifications to the ID (Installation, Location, Terminal Strip) removes the terminal block from its current terminal strip into the modified or newly defined terminal strip. You can perform a search of the project for current installation and location codes.

*Reassign Terminal*  
Moves the highlighted terminal blocks from the active terminal strip to the terminal strip defined in the Reassign Terminal dialog box. You can perform a search of the project for current installation and location codes.

*Renumber Terminals*  
Renumbers all, or a partial list, of terminal blocks from the active terminal strip. On the Renumber Terminal Strip dialog box, specify the new starting number and other options for renumbering the terminal.

**NOTE**  
You cannot renumber a terminal that uses a wire number as its terminal number. Additionally, duplicate terminal numbers are not restricted.

*Move Terminal*  
Moves an entire terminal (including all levels and any extra terminals created due to wiring constraints) on the terminal strip. You can move the terminal block up or down one row in the listing or manually pick a new position on the terminal strip listing.

**Spare**

*Insert Spare Terminal*  
Inserts spare terminal blocks on the active terminal strip. Use the Insert Spare Terminal dialog box to define a terminal block number or name, specify the number of spares to be inserted, and to insert the spare terminals above or below the highlighted terminal. You can add up to 10,000 spare terminals into the terminal block.
NOTE Spare terminal assignments are temporary for the current session of the Terminal Strip Editor. Place the graphical terminal strip layout on the drawing during the current session if you want to keep the spare terminal assignments.

Insert Accessory

Inserts one or more accessories (such as terminal end barriers or partitions) into the terminal strip.

NOTE Accessory terminal assignments are temporary for the current session of the Terminal Strip Editor. Place the graphical terminal strip layout on the drawing during the current session if you want to keep the accessory terminal assignments.

Delete Spare Terminals/Accessories

Deletes the spare terminal block or accessory on the terminal strip listing.

Destinations

Toggle Location

Toggles an entire location code from an Internal destination to an External destination or from an External destination to an Internal destination. You don’t have to select any terminal blocks from the terminal listing.

Toggle Installation

Toggles an entire installation code from an Internal destination to an External destination or from an External destination to an Internal destination. You don’t have to select any terminal blocks from the terminal listing.

Toggle Terminal Destinations

Changes the destination from Internal (left) to External (right) or from External to Internal.

Switch Terminal Destinations

Switches both destination values for the highlighted terminal block. The Internal destinations switch to the External (right) destinations, while all External destinations switch to Internal destinations.
Move Destination

Moves the destinations within the terminal/level definition. All the selected destinations are moved up or down within the level they belong to. Only the destinations for cloned blocks due to wire constraints can cross the boundary of the level they originally belong to.

Multi-Level

Associate Terminals

Combines two or more terminal blocks from any drawing into a single multiple-level terminal block. You are alerted if you select too many levels to associate. You can then decrease the number of selected levels or use the Break Apart Terminal Associations tool to separate out one of the levels in the new association.

Break Apart Terminal Associations

Separates one or more levels from the multiple level terminal block into separate terminal blocks. When the new terminal definitions are created, they retain the same properties as the original terminal.

- **One terminal**: Breaks the selected levels from their original association and adds them into a new association together.
- **Separate terminals**: Breaks the selected levels from their original association and adds each level into a new individual association. These levels occupy the same level in their new terminal definition, and new terminals are assigned the same properties as the original definition from which they were originally associated in.

Terminal strip editor: catalog code assignment tab
Modifies terminal catalog numbers. The terminals display in the center of the list box, with associated catalog number information and destinations on both sides.

Access:

On the Panel Layout toolbar, click the Terminal Strip Editor tool. Make your selection on the Terminal Strip Selection dialog box and click Edit or New. Click the Catalog Code Assignment tab.

You can sort the terminal blocks inside of the Terminal Strip Editor dialog box by selecting the column headers. The first click on the header sorts the column in ascending order. The second click sorts in descending order. The sort criteria applies to all tabs inside of the Terminal Strip Editor dialog box so you do not have to sort again if you switch between tabs.

Terminal Listing

There are three sections to the grid: Internal Destination, Terminal Block Information, and External Destination. The bold vertical grid lines make it easier to determine the differences in these sections. The horizontal grid lines delineate between wires connected to the terminal blocks; each row indicates one wire per side. The bold horizontal grid lines make it easier to distinguish separations between terminal blocks on the strip.

Select the terminal blocks for editing. Multiple blocks can be selected using either the Shift or Control key while highlighting rows, or by clicking and dragging the mouse. If you select a single row that is part of a multi-line terminal entry, all associated rows highlight.

**NOTE** You can right-click on any row in the terminal listing to access any of the editing tools found in the button groupings at the bottom of the dialog box. You can also right-click to select or deselect all of the terminals in the strip.

<table>
<thead>
<tr>
<th>Internal Destination</th>
<th>Displays the devices on the left side of the terminal strip.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal Block Information</td>
<td>Displays the terminal block number, terminal device pin connection descriptions, and catalog data. These values</td>
</tr>
</tbody>
</table>
display in the Terminal Listing with a blue background indicating that they are associated to the terminal block.

**External Destination**

Displays the devices on the right side of the terminal strip.

A single line entry terminal block has only two wires connected with its destinations on opposing sides (left/right). Use the terminal block properties to connect more wires to the terminal block, which changes the block into a multiple-line terminal entry.

### Properties

- **Edit Terminal Block Properties**
  - Defines or edits terminal block properties. When a multi-level terminal block is selected, the properties are edited for all levels of the terminal. The defined properties are assigned to every terminal symbol in its association. You can define up to 99 terminal levels in the block properties.

- **Copy Terminal Block Properties**
  - Copies terminal block properties from one terminal to be pasted into another terminals.

- **Paste Terminal Block Properties**
  - Pastes the previously copied terminal block properties into the selected terminals.

### Terminal

- **Edit Terminal**
  - Modifies the selected terminal block. Any modifications to the ID (Installation, Location, Terminal Strip) removes the terminal block from its current terminal strip into the modified or newly defined terminal strip. You can perform a search of the project for current installation and location codes.

- **Reassign Terminal**
  - Moves the highlighted terminal blocks from the active terminal strip to the terminal strip defined in the Reassign Terminal dialog box.
**Renumber Terminals**

Renumbers all, or a partial list, of terminal blocks from the active terminal strip. On the Renumber Terminal Strip dialog box, specify the new starting number and other options for renumbering the terminal.

**NOTE** You cannot renumber a terminal that uses a wire number as its terminal number. Additionally, duplicate terminal numbers are not restricted.

**Move Terminal**

Moves an entire terminal (including all levels and any extra terminals created due to wiring constraints) on the terminal strip. You can move the terminal block up or down one row in the listing or manually pick a new position on the terminal strip listing.

**Spare**

**Insert Spare Terminal**

Inserts spare terminal blocks on the active terminal strip. Use the Insert Spare Terminal dialog box to define a terminal block number or name, specify the number of spares to be inserted, and to insert the spare terminals above or below the highlighted terminal. You can add up to 10,000 spare terminals into the terminal block.

**NOTE** Spare terminal assignments are temporary for the current session of the Terminal Strip Editor. Place the graphical terminal strip layout on the drawing during the current session if you want to keep the spare terminal assignments.

**Insert Accessory**

Inserts one or more accessories (such as terminal end barriers or partitions) into the terminal strip.

**NOTE** Accessory terminal assignments are temporary for the current session of the Terminal Strip Editor. Place the graphical terminal strip layout on the drawing during the current session if you want to keep the accessory terminal assignments.
Deletes the spare terminal block or accessory on the terminal strip listing.

**Destinations**

- **Toggle Location**
  Toggles an entire location code from an Internal destination to an External destination or from an External destination to an Internal destination. You don’t have to select any terminal blocks from the terminal listing.

- **Toggle Installation**
  Toggles an entire installation code from an Internal destination to an External destination or from an External destination to an Internal destination. You don’t have to select any terminal blocks from the terminal listing.

- **Toggle Terminal Destinations**
  Changes the destination from Internal (left) to External (right) or from External to Internal.

- **Switch Terminal Destinations**
  Switches both destination values for the highlighted terminal block. The Internal destinations switch to the External (right) destinations, while all External destinations switch to Internal destinations.

- **Move Destination**
  Moves the destinations within the terminal/level definition. All the selected destinations are moved up or down within the level they belong to. Only the destinations for cloned blocks due to wire constraints can cross the boundary of the level they originally belong to.

**Multi-Level**

- **Associate Terminals**
  Combines two or more terminal blocks from any drawing into a single multiple-level terminal block. You are alerted if you select too many levels to associate. You can then decrease the number of selected
levels or use the Break Apart Terminal Associations tool to separate out one of the levels in the new association.

Break Apart Terminal Associations
Separates one or more levels from the multiple level terminal block into separate terminal blocks. When the new terminal definitions are created, they retain the same properties as the original terminal.

- **One terminal**: Breaks the selected levels from their original association and adds them into a new association together.
- **Separate terminals**: Breaks the selected levels from their original association and adds each level into a new individual association. These levels occupy the same level in their new terminal definition, and new terminals are assigned the same properties as the original definition from which they were originally associated in.

Catalog

Assign Catalog Number
Assigns catalog part numbers to the selected terminal blocks, spare terminals, or accessories. The catalog number assignments are written back to the schematic and panel drawings. This displays the Parts Catalog dialog box. Once the catalog number is selected from the Parts Catalog dialog box, the Catalog Manufacturer and Part Number are entered into the Terminal Strip Editor dialog box.

Delete Catalog Number
Removes the catalog part numbers previously assigned to terminal block, spare terminal, or accessory (either within the Terminal Strip Editor or the schematic drawing).

Copy Catalog Number
Copies one terminal’s catalog part numbers to be pasted to other terminal blocks within the Terminal Strip Editor.
Paste Catalog Number

Paste one terminal’s catalog part numbers (and terminal block properties) to another single terminal or multiple terminal blocks within the Terminal Strip Editor.

**Terminal strip editor: cable information tab**

Displays cable previews for terminal blocks. The terminals are displayed in the center of the list box with the cable name, wire conductor information, and device destination information on both sides.

**Access:**

On the Panel Layout toolbar, click the Terminal Strip Editor tool. Make your selection on the Terminal Strip Selection dialog box and click Edit or New. Click the Cable Preview tab.

You can sort the terminal blocks inside of the Terminal Strip Editor dialog box by selecting the column headers. The first click on the header sorts the column in ascending order. The second click sorts in descending order. The sort criteria applies to all tabs inside of the Terminal Strip Editor dialog box so you do not have to sort again if you switch between tabs.

**Terminal Listing**

There are three sections to the grid: Internal Destination, Terminal Block Information, and External Destination. The bold vertical grid lines make it easier to determine the differences in these sections. The horizontal grid lines delineate between wires connected to the terminal blocks; each row indicates one wire per side. The bold horizontal grid lines make it easier to distinguish separations between terminal blocks on the strip.

Select the terminal blocks for editing. Multiple blocks can be selected using either the Shift or Control key while highlighting rows, or by clicking and dragging the mouse. If you select a single row that is part of a multi-line terminal entry, all associated rows highlight.
NOTE You can right-click on any row in the terminal listing to access any of the editing tools found in the button groupings at the bottom of the dialog box. You can also right-click to select or deselect all of the terminals in the strip.

**Internal Destination**
Displays the devices on the left side of the terminal strip.

**Terminal Block Information**
Displays the terminal block number, terminal device pin connection descriptions, and cable information. These values display in the Terminal Listing with a blue background indicating that they are associated to the terminal block.

**External Destination**
Displays the devices on the right side of the terminal strip.

A single line entry terminal block has only two wires connected with its destinations on opposing sides (left/right). Use the terminal block properties to connect more wires to the terminal block, which changes the block into a multiple-line terminal entry.

**Properties**

- **Edit Terminal Block Properties**
  Defines or edits terminal block properties. When a multi-level terminal block is selected, the properties are edited for all levels of the terminal. The defined properties are assigned to every terminal symbol in its association. You can define up to 99 terminal levels in the block properties.

- **Copy Terminal Block Properties**
  Copies terminal block properties from one terminal to be pasted into another terminal.

- **Paste Terminal Block Properties**
  Pastes the previously copied terminal block properties into the selected terminals.
Terminal

Edit Terminal
Modifies the selected terminal block. Any modifications to the ID (Installation, Location, Terminal Strip) removes the terminal block from its current terminal strip into the modified or newly defined terminal strip. You can perform a search of the project for current installation and location codes.

Reassign Terminal
Moves the highlighted terminal blocks from the active terminal strip to the terminal strip defined in the Reassign Terminal dialog box.

Renumber Terminals
Renumbers all, or a partial list, of terminal blocks from the active terminal strip. On the Renumber Terminal Strip dialog box, specify the new starting number and other options for renumbering the terminal.

NOTE: You cannot renumber a terminal that uses a wire number as its terminal number. Additionally, duplicate terminal numbers are not restricted.

Move Terminal
Moves an entire terminal (including all levels and any extra terminals created due to wiring constraints) on the terminal strip. You can move the terminal block up or down one row in the listing or manually pick a new position on the terminal strip listing.

Spare

Insert Spare Terminal
Inserts spare terminal blocks on the active terminal strip. Use the Insert Spare Terminal dialog box to define a terminal block number or name, specify the number of spares to be inserted, and to insert the spare terminals above or below the highlighted terminal. You can add up to 10,000 spare terminals into the terminal block.
Spare terminal assignments are temporary for the current session of the Terminal Strip Editor. Place the graphical terminal strip layout on the drawing during the current session if you want to keep the spare terminal assignments.

**Insert Accessory**

Inserts one or more accessories (such as terminal end barriers or partitions) into the terminal strip.

**NOTE** Accessory terminal assignments are temporary for the current session of the Terminal Strip Editor. Place the graphical terminal strip layout on the drawing during the current session if you want to keep the accessory terminal assignments.

**Delete Spare Terminals/Accessories**

Deletes the spare terminal block or accessory on the terminal strip listing.

**Destinations**

**Toggle Location**

Toggles an entire location code from an Internal destination to an External destination or from an External destination to an Internal destination. You don’t have to select any terminal blocks from the terminal listing.

**Toggle Installation**

Toggles an entire installation code from an Internal destination to an External destination or from an External destination to an Internal destination. You don’t have to select any terminal blocks from the terminal listing.

**Toggle Terminal Destinations**

Changes the destination from Internal (left) to External (right) or from External to Internal.

**Switch Terminal Destinations**

Switches both destination values for the highlighted terminal block. The Internal destinations switch to the External (right) destinations, while all External destinations switch to Internal destinations.
Move Destination

Moves the destinations within the terminal/level definition. All the selected destinations are moved up or down within the level they belong to. Only the destinations for cloned blocks due to wire constraints can cross the boundary of the level they originally belong to.

Terminal strip editor: layout preview tab

Controls a preview display of the terminal strip in graphical or tabular layout. This helps determine the best way to generate a terminal layout prior to placing the image on the drawing file.

Access:

On the Panel Layout toolbar, click the Terminal Strip Editor tool. Make your selection on the Terminal Strip Selection dialog box and click Edit or New. Click the Layout Preview tab.

Graphical Terminal Strip/Tabular Terminal Strip/Table Object

Terminal Strip

Specifies the type of terminal strip to generate. The dialog box options change depending on whether you are creating a graphical or tabular terminal strip.

You can insert an AutoCAD table object as a tabular terminal strip. This allows for more accurate representations of what is in the Terminal Strip Editor, more flexibility with the look and style, and provides a means of automatic updating.

Graphical Layout

Generates a graphical representation including terminal footprints, terminal numbers, wiring information, and terminal destination information.

| Total Terminals | Displays the total number of terminal block symbols needed to create the terminal strip layout. |
| Overall Distance | Displays the overall distance the terminal strip footprint takes up when placed on the active drawing. |
| Default pick list for Annotation format | Lists some common formatting types. You are not limited to the selections provided by the default pick list. The replaceable parameter variables can be displayed in any combination including hard-coded characters such as dashes, brackets, and parenthesis. |
| Annotation Format | Determines the formatting of the wiring information associated with the terminal destination. You can define variable information to display the contents of the Terminal Strip Editor. One field is for the left-hand side, while the other is for the right-hand side of the terminal footprint. |
| **NOTE** | You can leave this field blank if you do not want the annotation format added to the preview. |
| Scale on Insert | Specifies the scale to use when inserting the graphical representation onto the drawing file. |
| Angle on Insert | Specifies the angle to use when inserting the graphical representation onto the drawing file. Select from the list of pre-defined angles. |

**Tabular Layout**

Generates a tabular representation including terminal numbers, wiring information, and terminal destination information. The table created is a grouping of AutoCAD block files with specific attributes to display the terminal and destination information.

| Total Row | Displays the total number of rows needed to create the tabular terminal strip layout. For example, even though the terminal strip contains only 86 terminal block symbols, the tabular format may present more rows in a multi-line terminal situation. |
| Terminal Table Header Block | Defines columns in the table and display the terminal strip identification. The default name for the Terminal Table Header Block is TERMLAY_HEADER.DWG. Click Browse to search for a header block to be used in this tabular terminal strip layout. You |
can leave this field blank if you do not want a header added to the preview.

**Terminal Table Row Block**

Defines the individual terminal block rows in the table and displays the terminal, wiring, cabling, and terminal destination information. The default name for the Terminal Table Row Block is TERM-LAY_ROW.DWG. You can create your own terminal row symbols by modifying the attribute requirements, and then click Browse to search for the new row block to be used in this tabular terminal strip layout.

**NOTE** We do not recommend leaving this option blank because the table will be empty.

Tabular layout AutoCAD block files insertion points are required to be in-line with one another in the Y-axis. AutoCAD Electrical places each symbol in the drawing at a relative distance based upon the height of the geometry in the block file.

**Rows Per Section**

Specifies the number of rows per section. Dividing the total number of rows by the rows per section, with the excess falling into the last section, determines the total number of sections.

**Section**

Specifies which section to display in the preview window and then inserts it onto the drawing file. You can also use the slide control, which breaks the number of sections into the slide. Slide the arrow to the appropriate position to change the number in the input box while updating the preview window.

**Annotation Format**

Specifies the device tag destination format to be displayed on either side of the terminal block.

**Default Format**

Updates the Annotation Format fields to reflect the default allowed replaceable parameters (page 126).
### Tabular Layout for a Table Object

The following options are available if you selected to create a Tabular Terminal Strip (Table Object).

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scale on Insert</td>
<td>Specifies the scale to use when inserting the graphical representation onto the drawing file.</td>
</tr>
<tr>
<td>Angle on Insert</td>
<td>Specifies the angle to use when inserting the graphical representation onto the drawing file. Select from the list of predefined angles.</td>
</tr>
<tr>
<td>Table Rows</td>
<td>Displays the total number of rows needed to create the tabular terminal strip layout. For example, even though the terminal strip contains only 86 terminal block symbols, the tabular format may present more rows in a multi-line terminal situation.</td>
</tr>
<tr>
<td>Table Style</td>
<td>Specifies the table style to use for the tabular report. Select from the list or click Browse to browse to and select another drawing file whose table styles you want to use.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> If the selected table style is not in the TableStyle.dwg file, it is added.</td>
</tr>
<tr>
<td>Define Columns</td>
<td>Defines the columns for the tabular report. The selections are stored in the table when it is inserted and the next time the terminal strip is edited, the settings are read back in.</td>
</tr>
<tr>
<td>Row Styles</td>
<td>Defines specific row styles to use for the selected table style. On the Select Row Cell Styles dialog box, select the table style and row cell styles to use and click OK. The selections are stored in the table when it is inserted and the next time the terminal is edited, the settings are read back in.</td>
</tr>
<tr>
<td>Layer</td>
<td>Defines the specific layer for the tabular terminal strip to be placed on when inserted. On the Select</td>
</tr>
</tbody>
</table>
Table Layer dialog box, select the layer name from the list of layers on the active drawing and click OK. The selections are stored in the table when it is inserted and the next time the terminal is edited, the settings are read back in.

<table>
<thead>
<tr>
<th>Table Title</th>
<th>Defines a title for the table. Enter a title, select from a list of variables or use a combination of both. When selecting from the list, the selection is added to the end of the string if one exists in the edit box.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse</td>
<td>Browses for any saved settings (in a *.tsl file) that you previously created.</td>
</tr>
<tr>
<td>Save As</td>
<td>Saves the settings to an external file (with extension *.tsl) that you can later reuse. The default folder location is the User folder in the Documents and Settings location.</td>
</tr>
<tr>
<td>Default</td>
<td>Uses the default settings for creating the tabular report.</td>
</tr>
</tbody>
</table>

**Update Preview**

Refreshes the preview window with any changes made with the preview controls or the Terminal Strip Editor. If you modify the total number of sections in the terminal strip or change the number of terminals per section, you can refresh the preview.

Use icons or the right-click menu to zoom and pan inside of the preview window.

**Insert Terminal Strip**

Places the terminal strip on the active drawing.

**Rebuild**

(Not available for tabular terminal strips.) Updates an existing terminal strip that was previously inserted by the Terminal Strip Editor in place. If the terminal strip exists in the project, the terminal strip is located, deleted and rebuilt in place without prompting you to select a new insertion point.
Refresh

(Available for tabular terminal strips created from table objects only.) Refreshes the data within an existing tabular terminal strip; a new table is not inserted.

Terminal block properties

Use this dialog box to control the number of levels assigned to a multiple level terminal block. You can control the level description, number of wires per connection, pins right and pins left. The terminal block properties are maintained on every terminal symbol in its association.

Access:

Click the Insert Component tool. Select Terminals and Connectors from the dialog box and specify the insertion point on the drawing. In the Insert/Edit Terminal Symbol dialog box, click Block Properties.

Click Components ➤ Insert Component. Select Terminals and Connectors from the dialog box and specify the insertion point on the drawing. In the Insert/Edit Terminal Symbol dialog box, click Block Properties.

Click the Edit Component tool and select the terminal to edit. In the Insert/Edit Terminal Symbol dialog box, click Block Properties.

Click Components ➤ Edit Component and select the terminal to edit. In the Insert/Edit Terminal Symbol dialog box, click Block Properties.

NOTE You can also access this dialog box by clicking Edit Terminal Block Properties on the Terminal Strip Editor dialog box.

The default level for any terminal symbol that is placed into the project that is not associated to another is 0.

Manufacturer Displays the Manufacturer value that is currently assigned to the terminal being edited.

Catalog Number Displays the Catalog Number value that is currently assigned to the terminal being edited.

Assembly Code Displays the Assembly Code value that is currently assigned to the terminal being edited.

Levels Specifies the number of levels for the terminal. The grid expands for editing based on the number of
levels specified. You can then define the level description, wires per connection and pins.

Terminal Block Property Definition grid

- **Level Description**: Specifies the description for the levels of the terminal block. Text you enter here displays in the Insert/Edit Terminal Symbol and Multiple Level dialog boxes. This is a terminal property that is maintained on every symbol in its association.

- **Wires per Connection**: Specifies the number of wires allowed per connection for the terminal connection point.

- **Pin Left/Pin Right**: Specifies labels for pin numbers associated to the terminal destinations. These fill in the LnnPINL and LnnPINR attributes on the terminal block when its level is selected. This is a terminal property that is maintained on every symbol in its association.

**NOTE**: These properties do not limit the number of connections allowed on the schematic.

**Terminal block property attributes**

The values in the grid are stored as follows, where “nn” represents the level number and is always stored as two digits (i.e. 01, 02, and so on):

<table>
<thead>
<tr>
<th>Data</th>
<th>Attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level Description (60 characters maximum)</td>
<td>LnnLABEL</td>
</tr>
<tr>
<td>Wires Per Connection (3 characters maximum)</td>
<td>LnnWIREPERC</td>
</tr>
<tr>
<td>Pin Left (12 characters maximum)</td>
<td>LnnPINL</td>
</tr>
<tr>
<td>Pin Right (12 characters maximum)</td>
<td>LnnPINR</td>
</tr>
</tbody>
</table>
NOTE If these attributes are not present, the data is placed into Xdata with the same name, only with a “VIA_WD_” prefix.

**Edit terminal**

Edits individual terminals/levels.

**Access:**

On the Panel Layout toolbar, click the Terminal Strip Editor tool. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Terminal Strip, Catalog Code Assignment, or Cable Information tab, select the level to modify. In the Terminals section, click Edit Terminal.

Click Panel Layout ➤ Terminal Strip Editor. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Terminal Strip, Catalog Code Assignment, or Cable Information tab, select the level to modify. In the Terminals section, click Edit Terminal.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation Code</td>
<td>Changes the installation codes. Click Browse to display a list of existing installation values found in the active drawing, entire project or an external list (default.inst). Pick from the list to automatically update the component with the installation code.</td>
</tr>
<tr>
<td>Location Code</td>
<td>Changes the location codes. Click Browse to display a list of existing location values found in the active drawing, entire project or an external list (default.inst). Pick from the list to automatically update the component with the location code.</td>
</tr>
<tr>
<td>Terminal Strip</td>
<td>Specifies the Tag ID given to the terminal strip. If there is an existing name, it appears in the edit box. If not, you can enter a specific ID name or click the &lt; and &gt; buttons to increment or decrement the last digit/character in the Tag Strip value.</td>
</tr>
<tr>
<td>Number</td>
<td>Specifies the ID number for the terminal. If the terminal’s catalog values carry PINLIST information, you can step through the available pin numbers using &lt; or &gt;. If there isn’t PINLIST information, these buttons just increment or decrement the ter-</td>
</tr>
</tbody>
</table>
minal number. You can also click Pick to select a text object or an attribute on the active drawing to use for the terminal number. When inserting a new terminal, the highest terminal number in the strip is identified and the default terminal number for the new terminal increments by 1.

**NOTE** This is unavailable when the terminal symbol does not have a TERM01 attribute or when the terminal number is the same as the wire number.

### Reassign terminal

Reassigns the selected terminals to another terminal strip within the active project. Multiple selection is allowed.

**NOTE** Any terminal strips that have terminals added or removed using the Reassign Terminal tool need to be inserted on the drawing or rebuilt. If you did not update the graphical terminal strip layout for the edited strip, you are prompted to select the appropriate action from the alert dialog box.

**Access:**

On the Panel Layout toolbar, click the Terminal Strip Editor tool. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Terminal Strip, Catalog Code Assignment, or Cable Information tab, select the terminal to modify. In the Terminals section, click Reassign Terminal.

Click Panel Layout ➤ Terminal Strip Editor. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Terminal Strip, Catalog Code Assignment, or Cable Information tab, select the terminal to modify. In the Terminals section, click Reassign Terminal.

The default values are representative of the current terminal strip assignment. As you select terminal strips in the grid, the values in the text boxes update to reflect your selection. If you enter your own values and a matching terminal strip does not currently exist, a new one is created.

**Installation Code**

Specifies the Installation code for the selected terminal. If there is an existing name, it appears in the edit box. If not, you can enter a new value. Click Browse to display a list of existing installation values.
found in the active drawing, entire project or an external list (default.inst). Pick from the list to automatically update the component with the installation code.

**Location Code**

Specifies the Location code for the selected terminal. If there is an existing name, it appears in the edit box. If not, you can enter a new value. Click Browse to display a list of existing location values found in the active drawing, entire project or an external list (default.inst). Pick from the list to automatically update the component with the location code.

**Terminal Strip**

Specifies the Tag ID given to the terminal strip. If there is an existing name, it appears in the edit box. If not, you can enter a new value.

### Renumber terminal strip

Renumbers terminals within a terminal strip. You are prompted to insert the graphical terminal strip if you renumber a terminal that has one or more levels still available.

**NOTE** You cannot renumber a terminal that uses a wire number as its terminal number. Additionally, duplicate terminal numbers are not restricted.

**Access:**

On the Panel Layout toolbar, click the Terminal Strip Editor tool. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Terminal Strip, Catalog Code Assignment, or Cable Information tab, select the level to modify. In the Terminals section, click Renumber Terminals.

Click Panel Layout ➤ Terminal Strip Editor. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Terminal Strip, Catalog Code Assignment, or Cable Information tab, select the level to modify. In the Terminals section, click Renumber Terminals.

**Starting number**

Defines the starting value for the terminal numbers. This value can be alpha, numeric or a combination of both. The default value is the lowest value of the selected terminals.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start with bottom level</td>
<td>Indicates to process the terminals starting with the last level and work its way back to 1, in order (5,4,3,2,1). If unselected, the tool starts with level 1 and moves forward (1,2,3,4,5).</td>
</tr>
<tr>
<td>Ignore non-numeric terminal numbers</td>
<td>Indicates to process only the terminals that are a numeric value, all terminals containing an alpha character are ignored and are not renumbered.</td>
</tr>
<tr>
<td>Ignore accessories</td>
<td>Indicates to ignore any accessories in the terminal strip during the renumber command.</td>
</tr>
<tr>
<td>Renumber</td>
<td>Specifies whether to renumber the terminal based on terminal or level. Per Terminal processes the entire terminal at a time while Per Level processes each level at a time.</td>
</tr>
</tbody>
</table>

**Insert spare terminal**

Adds spare terminals to the edited terminal strip.

**Access:**

On the Panel Layout toolbar, click the Terminal Strip Editor tool. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Terminal Strip, Catalog Code Assignment, or Cable Information tab, select a terminal from the list. In the Spare section, click Insert Spare Terminal.

Click Panel Layout ➤ Terminal Strip Editor. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Terminal Strip, Catalog Code Assignment, or Cable Information tab, select a terminal in the list. In the Spare section, click Insert Spare Terminal.

**Number**

Defines the starting terminal number for inserting spares. The default value is “SPARE.” Select Increment if you want to increment the terminal ID when the spare terminal is inserted. If the quantity is set to less than 2, you cannot increment the ID. If you are inserting multi-level terminals as defined by the catalog assignment, each level of a terminal receives the same number assignment if you select...
Increment. For example, if you insert 3 spare terminals and they are defined as 3 level terminals, all three levels on terminal 1 are designated as 1, 2 as 2, and 3 as 3. If you want to modify these, edit the spare terminal or use the Renumber Terminals tool to get the numbering format you want.

**Quantity**

Specifies a numeric value for the number of spare terminals to insert. The default value is 1. Use < or > to increment the value by a single step.

**Manufacturer**

Lists the manufacturer number for the spare terminal. Enter a value or select one from the Catalog lookup.

**Catalog**

Lists the catalog number for the spare terminal. Enter a value or select one from the Catalog lookup.

**Assembly**

Lists the assembly code for the spare terminal. The Assembly code is used to link multiple part numbers together.

**Catalog Lookup**

Opens the spare terminal’s catalog database from which you can manually enter or select the Manufacturer or Catalog values. Search the database for a specific catalog item to assign to the selected spare terminal. Database queries are set up in the 3 lists across the top of the dialog box with the database hits listed in the dialog’s main window.

**Insert Above/Insert Below**

Once you define the starting number and the number of spare terminals to insert, click Insert Above to insert the defined spare terminals above the selected terminal in the grid, or Insert Below to insert the spares below the selected terminal.

**Insert accessory**
Inserts terminal accessories such as end barriers and dividers, into the terminal strip.

Access:

On the Panel Layout toolbar, click the Terminal Strip Editor tool. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Terminal Strip, Catalog Code Assignment, or Cable Information tab, select the a terminal in the list. In the Spare section, click Insert Accessory.

Click Panel Layout ➤ Terminal Strip Editor. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Terminal Strip, Catalog Code Assignment, or Cable Information tab, select a terminal in the list. In the Spare section, click Insert Accessory.

<table>
<thead>
<tr>
<th>Number</th>
<th>Defines the starting terminal number for inserting accessories. Select Increment if you want to increment the terminal ID when the accessory is inserted. If the quantity is set to less than 2, you cannot increment the ID.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity</td>
<td>Specifies a numeric value for the number of accessories to insert. The default value is 1. Use &lt; or &gt; to increment the value by a single step.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Lists the manufacturer number for the accessory. Enter a value or select one from the Catalog lookup.</td>
</tr>
<tr>
<td>Catalog</td>
<td>Lists the catalog number for the accessory. Enter a value or select one from the Catalog lookup.</td>
</tr>
<tr>
<td>Assembly</td>
<td>Lists the assembly code for the accessory. The Assembly code is used to link multiple part numbers together.</td>
</tr>
<tr>
<td>Catalog Lookup</td>
<td>Opens the accessory’s catalog database from which you can manually enter or select the Manufacturer or Catalog values. Search the database for a specific catalog item to assign to the selected accessory. Database queries are set up in the 3 lists across the</td>
</tr>
</tbody>
</table>
top of the dialog box with the database hits listed in the dialog's main window.

Insert Above/Insert Below

Once you define the starting number and the number of accessories to insert, click Insert Above to insert the defined accessories above the selected terminal in the grid, or Insert Below to insert the accessories below the selected terminal.

**Toggle location codes**

Toggles destinations based on their location codes from one side of the terminal to the other.

**Access:**

On the Panel Layout toolbar, click the Terminal Strip Editor tool. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Terminal Strip, Catalog Code Assignment, or Cable Information tab, Destinations section, click Toggle Location.

Click Panel Layout ➤ Terminal Strip Editor. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Terminal Strip, Catalog Code Assignment, or Cable Information tab, Destinations section, click Toggle Location.

**NOTE** If components are present that have a blank value for the location code, question marks (?) display in the dialog box.

<table>
<thead>
<tr>
<th>Internal Destination</th>
<th>Lists connections to the terminal that reside in the same location as the terminal.</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Destination</td>
<td>Lists connections to the terminal that reside in a different location than the terminal.</td>
</tr>
<tr>
<td><strong>Toggle External to Internal/Toggle Internal to External</strong></td>
<td>Toggles/moves locations from one side of the terminal to the other. Select the location value to move in either list and click the appropriate button.</td>
</tr>
</tbody>
</table>

**Toggle installation code**

Use the terminal strip editor | 617
Toggles destinations based on their installation codes from one side of the terminal to the other.

**Access:**

On the Panel Layout toolbar, click the Terminal Strip Editor tool. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Terminal Strip, Catalog Code Assignment, or Cable Information tab, Destinations section, click Toggle Installation.

From the Panel Layout menu, select Terminal Strip Editor. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Terminal Strip, Catalog Code Assignment, or Cable Information tab, Destinations section, click Toggle Installation.

**NOTE** If components are present that have a blank value for the installation code, questions marks (??) displays in the dialog box.

<table>
<thead>
<tr>
<th>Internal Destination</th>
<th>Lists connections to the terminal that reside in the same location as the terminal.</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Destination</td>
<td>Lists connections to the terminal that reside in a different location than the terminal.</td>
</tr>
<tr>
<td>Toggle External to Internal/Toggle Internal to External</td>
<td>Toggles/moves locations from one side of the terminal to the other. Select the installation value to move in either list and click the appropriate button.</td>
</tr>
</tbody>
</table>

**Associate terminals**

Use this tool to combine two or more terminal blocks from any drawing into a single multiple-level terminal block. You are alerted if you select too many levels to associate. You can then decrease the number of selected levels or use the Break Apart Terminal Associations tool to separate out one of the levels in the new association.

**Access:**

On the Panel Layout toolbar, click the Terminal Strip Editor tool. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Terminal Strip or Catalog Code Assignment tab, select the level to modify. In the Multi-Level section, click Associate Terminals.

618 | Chapter 9  Terminal Tools
Access:

Click Panel Layout ➤ Terminal Strip Editor. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Terminal Strip or Catalog Code Assignment tab, select the level to modify. In the Multi-Level section, click Associate Terminals.

The number of levels you selected to add to the association displays at the top of the dialog box.

**Terminals**

Lists only the terminals that have enough available levels that can accommodate the number of levels you chose to associate.

**Terminal grid**

Displays the terminal information for the terminal selected in the tree control.

- **Level numbering**: Displays a level number for each level that is defined in the terminal properties. The panel symbol’s level numbering is a pound symbol (#).

- **Label**: Lists the level description defined in the terminal block properties.

- **Number**: Lists the terminal numbers defined in the association. Only one terminal number is allowed per level and each level displays its respective terminal number or text. Panel terminal symbols do not display terminal numbers. Terminal levels with an assignment and a terminal that has not been assigned a terminal number display question marks (???) in this column.

- **PinL**: Lists the pin numbers defined on the left side of the terminal block. This data is entered into the L0nPINL attribute if present; otherwise, it is placed into xdata.

- **PinR**: Lists the pin numbers defined on the right side of the terminal block. This data is entered into the L0nPINR attribute if present; otherwise, it is placed into xdata.
Pin numbering is related to the terminal level and not the terminal tag number instance.

- Reference: Lists the terminal symbol's reference location in the project. The syntax is “Sheet,Reference” based on the drawing configuration.

**Associate**

Adds the selected terminal symbol to the terminal association selected on the Terminal Strip Editor dialog box. The selections are processed from top to bottom in the Terminal Strip Editor grid and populate the available levels in the new association from the first available once you click OK.

*NOTE* The grid row must be selected before you can perform the association.

**Move Up/Move Down**

Moves the selected terminal up or down one level within the terminal definition.

**Select row cell styles**

Defines row styles to be used in the table style. The selections are stored in the table when it is inserted and the next time the terminal strip is edited, the settings are read back in.

**Access:**


**Table Style**

Selects a table style from the active drawing to use. This overrides what is defined in the Terminal Strip Editor dialog box.
Terminal

Lists available row cell styles from the selected table style. Select a specific row style to be used for terminals, spare terminals and extra terminals that are inserted due to wiring constraints.

Accessory

Lists available row cell styles from the selected table style. Select a specific row style to be used for accessories.

Terminal strip table data fields to include

Defines the columns for your tabular terminal report. The selections are stored in the table when it is inserted and the next time the terminal strip is edited, all of the settings are read back in.

Access:

On the Panel Layout toolbar, click the Terminal Strip Editor tool. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Layout Preview tab, select Tabular Terminal Strip (Table Object). Click Define Columns. From the Panel Layout menu, select Terminal Strip Editor. Make your selection on the Terminal Strip Selection dialog box and click Edit. On the Layout Preview tab, select Tabular Terminal Strip (Table Object). Click Define Columns.

Available Fields

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report

Lists the fields to display in the report.

Remove/Remove All

Removes the selected field or all fields from the Fields to Report list.

Move Up

Moves the selected field up one spot in the Fields to Report list.

Move Down

Moves the selected field down one spot in the Fields to Report list.
Specifies the cell style for the table. Within the table styles, you can define different cell styles to use. These give the added flexibility to customize how the terminal strip appears. As you select one of the fields to report you can assign a cell style to the selection.

Name
Displays the name for the field that is selected in the Fields to Report section of the dialog box. Use the default name or enter a new name in the edit box.

Width
Specifies the column width to set for the selected Field to Report. Enter a positive numeric value in the edit box.

Available Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation1</td>
<td>Left Installation column in the Terminal Strip Editor grids.</td>
</tr>
<tr>
<td>Location1</td>
<td>Left Location column in the Terminal Strip Editor grids.</td>
</tr>
<tr>
<td>Device1</td>
<td>Left Device column in the Terminal Strip Editor grids.</td>
</tr>
<tr>
<td>Pin1</td>
<td>Left Pin column in the Terminal Strip Editor grids.</td>
</tr>
<tr>
<td>Wire1</td>
<td>Left Wire column in the Terminal Strip Editor grids.</td>
</tr>
<tr>
<td>Type1</td>
<td>Left Type column in the Terminal Strip Editor grids.</td>
</tr>
<tr>
<td>Cable1</td>
<td>Left Cable column in the Terminal Strip Editor Cable Information grid.</td>
</tr>
<tr>
<td>Conductor1</td>
<td>Left Conductor column in the Terminal Strip Editor Cable Information grid.</td>
</tr>
<tr>
<td>T1</td>
<td>Left T column in the Terminal Strip Editor grids.</td>
</tr>
<tr>
<td>Number</td>
<td>Number column in the Terminal Strip Editor grids.</td>
</tr>
</tbody>
</table>
T2

Right T column in the Terminal Strip Editor grids.

Manufacturer

Manufacturer column in the Terminal Strip Editor Catalog Code Assignment grid.

Catalog

Catalog column in the Terminal Strip Editor Catalog Code Assignment grid.

Conductor2

Right Conductor column in the Terminal Strip Editor Cable Information grid.

Cable2

Right Cable column in the Terminal Strip Editor Cable Information grid.

Type2

Right Type column in the Terminal Strip Editor grids.

Wire2

Right Wire column in the Terminal Strip Editor grids.

Pin2

Right Pin column in the Terminal Strip Editor grids.

Device2

Right Device column in the Terminal Strip Editor grids.

Location2

Right Location column in the Terminal Strip Editor grids.

Installation2

Right Installation column in the Terminal Strip Editor grids.

Jumper

Column for displaying defined jumpers.
Generate terminal strip tables

Insert terminal strip tables onto drawings

Use the Terminal Strip Table Generator tool to insert terminal tables onto drawings. A new drawing file is created with each section break and automatically added to the active project.

1. Click the arrow on the Terminal Strip Editor to access the Terminal Strip Table Generator tool.

2. Click the Terminal Strip Table Generator tool.

3. Select the terminal strips to create tables from.

4. Specify the file name for the first drawing. It is recommended to add a numeric suffix to the file name since the last character of the file name is incremented for each new drawing.

5. (Optional) Specify a template file to use.

6. Select whether to create the table as blocks or an AutoCAD table object.

7. Specify the table layout settings:

   - If you selected Table Blocks, specify the header block, row block, annotation format, scale, angle and rows per section.

   - If you selected Table Object, specify the table style, row style, table title and layer. Select whether to insert the tables in a new drawing, rebuild an existing terminal strip in an existing drawing or refresh an existing terminal strip in an existing drawing.

8. Specify the X and Y section placement values for the tables.

9. Click OK.

Terminal strip table generator

This tool controls the Tabular Terminal layout format automatically for any number of terminal strips. A new drawing file is created with each section break and automatically added to the active project. The terminal strip's
installation code, location code, and tag are written to the Drawing Description Field inside of the project file (*.wdp).

Access:

Click the arrow on the Terminal Strip Editor tool to access the Terminal Strip Table Generator tool.

Click Panel Layout ➤ Terminal Strip Table Generator.

**NOTE** You can create only one section per drawing file. Each new terminal strip selected creates a new section and a new drawing.

**Terminal Strip Selection**

Lists all terminal strips in the active project. Select the terminal strips to use for automatically creating the drawing files. You can select a single terminal strip or multiple strips. Multiple strips can be selected using either the Shift or Control keys while highlighting rows, or by clicking and dragging the mouse.

**Drawing Information for Table Output**

**First Drawing Name**

Specifies a starting drawing file location and file name to use for the automatic creation of the drawing files. The drawings are automatically added to the active project and display at the end of the drawing list in the Project Manager.

**NOTE** Since the last character of the drawing file name is incremented for each drawing that is created, it is recommended to start the first drawing file name with a numeric suffix.

**Template**

Specifies the template file to use for the table. Enter a template file name or click Browse to search for and select a template file.

**NOTE** You cannot select an existing file name for the first drawing.
Table Blocks/Table Object

Specifies the type of table to generate. The dialog box options change depending on whether you are creating a table as blocks or as an AutoCAD table object.

Table Layout (for Table Blocks)

<table>
<thead>
<tr>
<th>Block Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal Table Header Block</td>
<td>Defines columns in the table and display the terminal strip identification. The default name for the Terminal Table Header Block is TERMLAY_HEADER.DWG. Click Browse to search for a header block to be used in this tabular terminal strip layout. You can leave this field blank if you do not want a header added to the drawing.</td>
</tr>
<tr>
<td>Terminal Table Row Block</td>
<td>Defines the individual terminal block rows in the table and displays the terminal, wiring, cabling, and terminal destination information. The default name for the Terminal Table Row Block is TERMLAY_ROW.DWG. Click Browse to search for a row block to be used in this tabular terminal strip layout.</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>You can leave this field blank if you do not want the table rows added to the drawing. However, we do not recommend it because the table will be empty.</td>
</tr>
</tbody>
</table>

Tabular layout AutoCAD block files insertion points are required to be in line with one another in the Y-axis. AutoCAD Electrical places each symbol in the drawing at a relative distance based upon the height of the geometry contained in the block file.

| Section Placement                | Specifies the exact location of the terminal strip header block for each drawing being created. The row blocks come in relative to the header location. You can also specify the angle and scale for the terminal strip header block. Select from the list of pre-defined angles and scale values. |
| Annotation Format                | Specifies the device tag destination format displayed on either side of the terminal block. One field is for |
the left-hand side, while the other is for the right-hand side of the terminal footprint.

**Default Format**

Updates the Annotation Format fields to reflect the default allowed replaceable parameters (page 126). You are not limited to the selections provided by the default pick list. The replaceable parameter variables can be displayed in any combination including hard-coded characters such as dashes, brackets, and parenthesis.

**Rows Per Section**

Specifies the number of rows per section. The number of rows per section controls the section sizes and subsequently the number of drawing files created. For example, if there are 115 rows and the Rows Per Section is set to 40, then 3 sections/drawing files are created.

**Table Layout (for Table Objects)**

- **Table Style**
  Specifies the table style to use for the table. Select from the list or click Browse to browse to and select another drawing file whose table styles you want to use.
  
  **NOTE** If the selected table style is not in the TableStyle.dwg file, it is added.

- **Define Columns**
  Defines the columns for the table. The selections are stored in the table when it is inserted and the next time the terminal strip is edited, the settings are read back in.

- **Row Styles**
  Defines specific row styles to use for the selected table style. On the Select Row Cell Styles dialog box, select the table style and row cell styles to use and click OK. The selections are stored in the table when it is inserted and the next time the terminal is edited, the settings are read back in.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Layer</strong></td>
<td>Defines the specific layer for the table to be placed on when inserted. On the Select Table Layer dialog box, select the layer name from the list of layers on the active drawing and click OK. The selections are stored in the table when it is inserted and the next time the terminal is edited, the settings are read back in.</td>
</tr>
<tr>
<td><strong>Table Title</strong></td>
<td>Defines a title for the table. Enter a title, select from a list of variables or use a combination of both. When selecting from the list, the selection is added to the end of the string if one exists in the edit box.</td>
</tr>
<tr>
<td><strong>Browse</strong></td>
<td>Browses for any saved settings (in a *.tsl file) that you previously created.</td>
</tr>
<tr>
<td><strong>Save As</strong></td>
<td>Saves the settings to an external file (with extension *.tsl) that you can later reuse. The default folder location is the User folder in the Documents and Settings location.</td>
</tr>
<tr>
<td><strong>Default</strong></td>
<td>Uses the default settings for creating the table.</td>
</tr>
<tr>
<td><strong>Section Placement</strong></td>
<td>Specifies the exact location of the table for each drawing being created.</td>
</tr>
<tr>
<td><strong>Insert in New Drawing</strong></td>
<td>Creates a new drawing for each table and adds the drawings to the active project.</td>
</tr>
<tr>
<td><strong>Rebuild in Existing Drawing</strong></td>
<td>Updates an existing table that was already placed on a drawing in place. If the terminal strip exists in the project, it is located, deleted, and rebuilt in place without prompting you to select a new insertion point.</td>
</tr>
</tbody>
</table>

628 | Chapter 9  Terminal Tools
NOTE If the selected terminal strip is not found in the project, an alert displays asking if you want to insert the missing strip in a new drawing. If you click Yes, the terminal strip is inserted. If you click No, the terminal strip is not inserted. The terminal strips that were found are updated.

Refresh in Existing Drawing

Refreshes the data within an existing tabular terminal strip; a new table is not inserted.

NOTE If the selected terminal strip is not found in the project, an alert displays asking if you want to insert the missing strip in a new drawing. If you click Yes, the terminal strip is inserted. If you click No, the terminal strip is not inserted. The terminal strips that were found are updated.

Overview of terminal properties database

The terminal properties database file (_TERMPROPS table in the default_cat.mdb) can be viewed, edited, and expanded using the Terminal Properties Database Editor tool. The terminal properties table holds the terminal properties based on the manufacturer, catalog, and assembly code entries. When a catalog assignment is made to a terminal, it looks to the terminal properties table for a matching entry and pulls out and assigns the properties when a match is found. The following wild cards are supported in the catalog field:

- * = matches any characters
- ? = matches a single character
- # = matches a single numeric digit
- @ = matches a single alphabetic character
Structure of the terminal properties database table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RECNUM</td>
<td>(Microsoft Access internal use)</td>
</tr>
<tr>
<td>MANUFACTURER</td>
<td>Manufacturer code (value must be consistent with the catalog lookup files; 24 characters maximum)</td>
</tr>
<tr>
<td>CATALOG</td>
<td>Catalog number (use wild cards as much as possible; 60 characters maximum)</td>
</tr>
<tr>
<td>ASSEMBLYCODE</td>
<td>AutoCAD Electrical internal assembly code (must be consistent with the catalog lookup files; 60 characters maximum)</td>
</tr>
<tr>
<td>LEVELS</td>
<td>Number of levels for the terminal</td>
</tr>
<tr>
<td>LEVELDESCRIPTION</td>
<td>Levels description/level definition (255 characters maximum)</td>
</tr>
<tr>
<td>TPINL</td>
<td>Pin label definition for the left side of the terminal (255 characters maximum)</td>
</tr>
<tr>
<td>TPINR</td>
<td>Pin label definition for the right side of the terminal (255 characters maximum)</td>
</tr>
<tr>
<td>WIRESPERCONNECTON</td>
<td>Definition of the wiring constraints (255 characters maximum)</td>
</tr>
</tbody>
</table>

**NOTE** When dealing with a multi-tier terminal, a comma (,) is used as a delimiter for the LevelDescription, WiresPerConnection, TPINR and TPINL fields. For example, the LevelDescription may be “UPPER,LOWER” and the WiresPerConnection may be “2,2.”

### Edit terminal properties database

Use the Terminal Properties Database Editor tool to edit the terminal properties database, located in the catalog database.

1. Click Component ➤ Terminals ➤ Terminal Properties Database Editor.
2 In the Select Terminal Properties Table dialog box, select the table to edit and click Edit.

**NOTE** You can also create a new table by entering the manufacturer name in the edit box and clicking Create.

3 In the Edit dialog box:
- To edit an existing record, click Sort, Filter, or Find to search for the record to edit. Select the record from the list and click Edit.
- To create a new record, click Add New, or select an existing record and click Add Copy to create a new record based on an existing one.
- To delete an existing record, select the record in the list and click Delete.

4 To edit or create a new record, in the Edit Record dialog box, specify the values to assign to the record and click OK.

5 In the Edit dialog box, click Save/Exit.

**Select terminal properties table**

Use this tool to select the relevant _TERMPROPS table to edit or create a new one.

**Access:**

Click Components ➤ Terminals ➤ Terminal Properties Database Editor.

**Select or Type Manufacturer**

Lists all of the TERMPROPS tables that are in the catalog database. The “(Default)” manufacturer is used to edit the generic _TERMPROPS table. Select the table to edit or enter a name for a new one.

**Table**

Displays the proper table name in the catalog database. This text changes depending on which manufacturer is selected. For example, if you select SQD, then _TERMPROPS_SQD displays.
Create

(Available only when you enter the name of a manufacturer.) Creates a new table in the catalog database with the specified name and adds the table to the list of manufacturers. Once a table is created, the Edit (Table: _TERMPROPS_manufacturer) dialog box displays so you can edit the new table.

NOTE
The following characters are not allowed in the table name: ~ @ # $ % ^ & * - + = \ { } " ' ; : ? / < > , ! [ ] |. These characters are replaced with an underscore (_) if entered in the edit box.

Edit

(available only after a manufacturer is selected from the list) Opens the Edit (Table: _TERMPROPS_manufacturer) dialog box so you can edit the selected TERMPROPS table.

Edit

AutoCAD Electrical consults a terminal properties database table when a catalog assignment is made to a terminal. Use this to edit the terminal properties database.

Access:

Click Components ➤ Terminals ➤ Terminal Properties Database Editor. Specify the table to create and click Create or select the table to edit and click Edit.

This lookup database table is a table within the catalog lookup Access .mdb file. The default file name is default_cat.mdb, table _TERMPROPS, and comes populated with a sample of vendor data. You can expand this table as needed. Use your own copy of Microsoft Access or use this dialog box to add new entries, add entries based on existing entries, edit, and delete entries from the table.

Sort

Sorts the list of database records using either an alphanumeric sort or number values. You can specify 4 sorts to perform on the list.

Find

Sorts the list of database records using either an alphanumeric sort or number values. You can specify 4 sorts to perform on the list.
Indicates to replace the find value with the new text string that you specify.

Filters the listing based on certain values in the table. Picking the blank entry in the list removes the filter for that field. After you define the values to filter, apply the filter in the database editing window.

Displays the Edit Record dialog box for modifying the existing record in the database.

Displays the Edit New Record dialog box for entering a new record into the database.

Displays the Edit Copied Record dialog box for modifying and copying the record to make a new record. You cannot have two duplicate copies in the database.

Removes the selected record from the database.

**Edit record**

**Access:**

Click Components ➤ Terminals ➤ Terminal Properties Database Editor. Specify the table to create and click Create or select the table to edit and click Edit. In the Edit dialog box, click Add New, Add Copy, or Edit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RECNUM</td>
<td>(Microsoft Access internal use)</td>
</tr>
<tr>
<td>MANUFACTURER</td>
<td>Manufacturer code (value must be consistent with the catalog lookup files; 24 characters maximum)</td>
</tr>
<tr>
<td>CATALOG</td>
<td>Catalog number (use wild cards as much as possible; 60 characters maximum).</td>
</tr>
<tr>
<td>ASSEMBLYCODE</td>
<td>AutoCAD Electrical internal assembly code (must be consistent with the catalog lookup files; 60 characters maximum)</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LEVELS</td>
<td>Number of levels for the terminal</td>
</tr>
<tr>
<td>LEVELDESCRIPTION</td>
<td>Levels description/level definition (255 characters maximum)</td>
</tr>
<tr>
<td>TPINL</td>
<td>Pin label definition for the left side of the terminal (255 characters maximum)</td>
</tr>
<tr>
<td>TPINR</td>
<td>Pin label definition for the right side of the terminal (255 characters maximum)</td>
</tr>
<tr>
<td>WIRESPERCONNECTION</td>
<td>Definition of the wiring constraints (255 characters maximum)</td>
</tr>
</tbody>
</table>

When dealing with a multi-tier terminal, a comma (,) is used as a delimiter for the LevelDescription, TPINL, TPINR and WiresPerConnection fields. For example, the LevelDescription may be “UPPER, LOWER” and the WiresPerConnection may be “2,2.”
Point-to-Point Wiring
Tools

In this chapter

- Working with Connectors
- Bend wires at right angles
- Insert multiple bus wiring
- Import data from Autodesk Inventor Professional Cable & Harness
- Overview of the spreadsheet import file structure
- Insert splices
Use point-to-point wiring tools

The Point-to-Point wiring tools help you more easily create and work with point-to-point style wiring schematics (as opposed to ladder-style schematics). Though you may find some of these tools and enhancements useful for ladder-style schematics, these tools are tuned to work well with drawings that are heavy on inter-wired, multiple-pin connectors.

Instead of creating and maintaining a large library of schematic connector symbols, each is generated parametrically, on the fly, per user input and at user-defined orientation. The Insert Connector toolbar contains connector insertion and editing tools.

In addition to the tools specifically related to connectors found on the Connector toolbar, you can utilize other AutoCAD Electrical tools for editing your point-to-point wiring diagrams.

**Edit Pin Numbers**
Use the Edit Component tool to edit the pin assignments on the parametrically generated connectors.

**Connector Dash Link Lines**
Use the Link Components (Dashed Line) tool to insert dash linked lines between parent and split-off child parametric connector symbols.

**Scoot Connector**
Use the Scoot tool to reposition the parametric connector along the same direction as the connected wiring.
Use the Scoot tool to move wires attached to pins on the connectors. The wire scoots and the connector pin along with it while the overall connector shell stays fixed.

**Insert Wires**
Use the Insert Wires tool to route single-wire connections. Use the Multiple Wire Bus tool, Component mode, to insert and route multiple wires in one tool.

**NOTE** A wire connection point should only have up to 3 wire connections tied to it. Adding more wires to a single point prevents the angled wire connection to tie uniquely to the wire connection point.
**Insert connectors**

Use this tool to insert a parametrically generated connector symbols.

1. Click the Insert Connector tool.

2. In the Insert connector dialog box, specify the pin spacing and pin count.
   (Optional) For pin count, click Pick and draw a fence showing the length of the appropriate connector.

3. Specify whether to build the connector using fixed pin spacing or to have it compress or expand to match the pins up with underlying wire crossings.

4. Specify whether to insert the entire connector all at once or to insert it manually, pin by pin, with an option to insert spacers or to break the connector into 2 or more pieces.

5. Click the Rotate or Flip buttons to change the display of the connector symbol.
   The preview image updates to reflect your changes to the connector display options.

6. (Optional) Click Details for more options to define settings for the size, shape and display of the parametrically built connector symbols.

7. Click Insert.
   A preview outline of the connector displays for placement on the drawing. It shows rounded corners for the plug side of the connector. An 'x' indicates the insertion point of the connector and the arrow indicates the plug side wire connection direction.

8. Specify the insertion point on the drawing or enter Z (zoom), P (pan), X, V, or Tab at the command prompt to change the connector orientation before insertion. Review the sections below to see how Tab, V key, or X key changes your connector orientation.
   If you selected to allow spacers/breaks, in the Custom Pin Spaces/Breaks dialog box, click Break Symbol Now to break the connector and display the Connector Layout dialog box for defining how you want the rest of the pins inserted on the
drawing.

Reverse connector using the Tab key

Prior to committing the connector outline to the drawing, you can press Tab to reverse the connector either about its long axis or end for end. If the connector is vertical, a series of TAB keystrokes cycles the image through these 4 orientations:

![Connector orientations](image)

Start point  TAB 1  TAB 2  TAB 3

Rotate connector using the V key

Press "V" at the command prompt to switch between vertical and horizontal orientations. Based on where the outline is in the flip process, the Tab keystroke reverses the connector either about its long axis or end for end. When in its horizontal orientation, a series of Tabs cycles the image through these four orientations

![Connector orientations](image)

Start point  TAB 1  TAB 2  TAB 3

Switch layout using the X key

Press "X" at the command prompt to toggle between "Fixed Spacing" and "At Wire Crossings." Press the X key, and then move the connector preview over

Use point-to-point wiring tools | 639
the wires so the connector stretches to align each pin with the underlying wire spacing. The connector stretches only to meet the underlying spacing when the first pin lands on a wire. If the size of the connector exceeds the total number of wires underlying the connector, the remaining pins follow the specified fixed spacing value.

**Rotate connectors**

Use this tool to rotate the connector about its insertion point in 90-degree increments. The wire connections do not reroute with each rotation of the connector. You must resolve wiring using the wire editing tools.
NOTE  This command differs from the standard ROTATE command in that it renames the wire connection attributes to maintain full compatibility with the Insert Wire command, and it can hold the terminal pin text and tag-ID attributes in their current orientation.

1  Click the arrow on the Insert Connector tool to access the Rotate Connector tool.

2  Click the Rotate Connector tool.

3  Specify whether to hold the current attribute orientation.
   If you select Yes (default), the attribute text orientation does not rotate as the connector rotates.

4  Select the connector to rotate.
   The connector automatically rotates 90 degrees.

5  Keep clicking on the connector until the appropriate position is reached.

6  Press Enter or Esc to exit the command.

Example: Hold attribute orientation = yes

Original  First Rotate  Second Rotate  Third Rotate

Use point-to-point wiring tools | 641
Example: Hold attribute orientation = no

Original   First Rotate   Second Rotate   Third Rotate

Reverse connectors

Use this tool to reverse the orientation of the connector about its horizontal or vertical axis. Any existing wire connections don't automatically reroute to...
the reverse side of the connector and you will have to resolve wiring using the wire editing tools.

1 Click the arrow on the Insert Connector tool to access the Reverse Connector tool.

2 Click the Reverse Connector tool.

3 Select the connector to reverse.
   The connector automatically reverses depending on its original orientation.
   
   **NOTE** For a single receptacle connector with no rounded corners, the appearance of the graphics appears unchanged, but the wire connection attributes actually move to the other side of the connector.

4 Press Enter or Esc to exit the command.

**Stretch connectors**

Use this tool to increase or decrease the connector's overall shell length. You might do this to make room for new pins or to capture previously added pins.
that fell beyond the connector shell. You identify which end of the connector is to be altered and the measurement of displacement.

1. Click the arrow on the Insert Connector tool to access the Stretch Connector tool.

2. Click the Stretch Connector tool.

3. Specify the end of the connector to stretch.

4. Specify where you want the connector to end (second point of displacement). Either drag your mouse to the appropriate location or enter coordinates.

   **NOTE** You can press TAB during the stretch to change the visibility of the connector attributes. See the Tips and Hints below for more information.

5. Press Enter or Esc to exit the command.

**Tips and Hints**

- Stretch Connector does not support window selection.
- Turn Snap ON.
- The stretch begins at the end of the connector. There is not a first point of displacement.
- If the stretched connector end runs over the top of the connector's tag-ID attribute (attribute name TAG1 or TAG2), then this attribute along with attributes INST, LOC, DESC1, DESC2, and DESC3 relocate with the stretch. Pressing TAB during the stretch changes the visibility of these attributes. If turned ON, the attributes display as temporary graphics that move with the stretch cursor; if turned OFF, the temporary graphics are not visible.
- Avoid stretching one end of a connector all the way to the other end of the connector.
**Split connector**

Use this tool to split the parametric connector into 2 separate block definitions (for example, parent and a child or a child and another child).

1. Click the arrow on the Insert Connector tool to access the Split Connector tool.

2. Click the Split Connector tool.

3. Select the connector block to split.

4. Specify the split point (i.e. pick between two sets of pins).

5. (Optional) Define the origin point for the new block. The default is preset to be in-line with the first set of pins on the split-off piece. If you do not want to accept the default, you can enter the coordinates or click Pick Point, and then select the origin point on the drawing.

6. (Optional) Set the break type: no lines, straight lines, jagged lines, or draw it. The default is set to jagged lines.

7. (Optional) Select to reposition the child block to move it as part of this command.

8. Click OK.

9. To reposition the child block, select a point on the screen to place the block.

10. Press Enter or Esc to exit the command.

**Add pins to a connector**

Use point-to-point wiring tools | 645
Once the connector is inserted onto the drawing you can edit the connector pins found inside of the connector shell. You may need to make room for the insertion of new pins by either stretching the connector shell (Stretch Connector), moving existing pins (Move Connector Pin), or scooting wires with attached pins (Scoot) to make room for your new pins.

1. Click the arrow on the Insert Connector tool to access the Add Connector Pins tool.

2. Click the Add Connector Pins tool.

3. Select the connector.

4. Specify where to insert the next available pin number (displayed on the command line) or press R+space to manually define the new starting pin number. The next available pin numbering is based on the existing pins and an optional pin list associated to the selected connector. The PINLIST values defined on the parent symbol are queried in the project database to determine the next available pin number on the connector component. This checks across the entire project to find the pin numbers used on both parent and any child connector symbols. If a PINLIST value is not defined, then the next available sequential pin number (based on existing pins) is used. Pin assignments can be numbers or letters or combinations of both.

5. Press Enter or Esc to exit the command.

**Tips and Hints**

- Turn Snap ON.
- Pins can be added inside the shell or beyond either end of the connector shell.
- Pins are inserted along the connector’s centerline axis, even if your pick point is far off to one side of the connector.
- Connectors can be stretched later to accommodate new pins added beyond either end of the connector.
- Pins can be added between the original pins; pins can then be moved or scooted to accommodate spacing.

- Pins can be lined up with a pin on another connector. After selecting the Add Connector Pins tool, select the connector to add the pin to, press Shift + right-click to display the Object Snaps options, select Insert and click the pin to align the new pin to. The new pin is inserted onto the selected component and is lined up with the pin on the other connector.

Delete pins from connectors

Once the connector is inserted onto the drawing you can edit the connector pins found inside of the connector. Use this tool to remove a pin from an existing connector and, if the connector has a defined pin list, free this deleted point-to-point wiring tools | 647
pin to be re-inserted later on this connector or on a related child of this connector.

1. Click the arrow on the Insert Connector tool to access the Delete Connector Pins tool.

2. Click the Delete Connector Pins tool.

3. Pick the pins to delete from the connectors.
   The pin number attribute on the connector block disappears. This attribute along with associated wire connection and description attributes are not immediately removed from the connector. They are renamed so that they are effectively ignored. If the connector is subsequently stretched or split, then these deleted pin attributes are purged from the connector block instance.

4. Press Enter or Esc to exit the command.

Tips and Hints

■ Deleting a pin that has a connected wire does not remove the wire. In this case, the wire no longer is connected to the connector. It appears to be a wire that is unconnected at the connector end.

Swap pin numbers

![Diagram showing swap pin numbers]

This tool exchanges one set of connector pin numbers for another on an existing connector or between connectors on the drawing.
NOTE You cannot swap a combination connector with a single plug or receptacle connector. Additionally, you cannot use this tool to swap pins from one side of a connector to the other.

1 Click the arrow on the Insert Connector tool to access the Swap Connector Pins tool.

2 Click the Swap Connector Pins tool.

3 Select the connector pin to swap.
   Temporary graphics are drawn around the selected pin number indicating that it has been included in the "swap" list.

4 Select the pin that you want to swap with the selected pin.
   The connector pins are swapped between the two selections.

5 Select another set of pins to swap or press Enter or Esc to exit the command.

Move pins

Use this tool to reposition pins within an existing connector.

1 Click the arrow on the Insert Connector tool to access the Move Pins tool.

2 Click the Move Pins tool.

3 Select the connector pin to move.

4 Specify the new location for the pin.
   The pin relocates along the connector's centerline axis, even if your pick point is far off to one side of the connector. You can also specify a location beyond either end of the current connector shell, and then use the Stretch Connector tool to extend the shell to enclose these pins.

5 Press Enter or Esc to exit the command.
**Edit connector pin numbers**

Once the connector is inserted onto the drawing file's block definition, you can edit the connector pins found inside of the connector. Use the Connector Pin Numbers in Use dialog box to edit the pins defined on the parametric connector. Connector symbols have attributes to define Installation and Location codes, manufacturing data, component tagging and descriptions, and pin assignments.

1. Click the Edit Component tool.
2. Select the connector.
3. In the Insert/Edit Component dialog box, Pins section, click List.
4. In the Connector Pin Numbers in Use dialog box, select a pair of pins to modify.
5. In the Pin Number section, enter a new pin number value in the edit boxes or click the arrows to either increase or decrease both plug and receptacle values by one.
6. (Optional) Enter a description for the plug or receptacle terminal.
7. Click OK.

**Insert connector**

Use this tool to generate a connector symbol from user-defined parameters. The symbol is created on the fly and inserted as a block insert into your active drawing file. Since these are created on an as-needed based, it eliminates the need for you to create and maintain a library of connector symbols.

**Access:**

Click the Insert Connector tool.

From the Components menu, select Insert Connector ➤ Insert Connector.

Click Details to expand the dialog box to provide more options to define settings for the size, shape, and display of the parametrically built connector symbols.
Layout

Determines the overall appearance of the parametric connector, including pin spacing and pin count.

Pin Spacing

Specifies the distance between the pin wire connections. This value initially defaults to the Rung Spacing defined in Drawing Properties ➤ Drawing Format ➤ Ladder Defaults - Spacing setting for the drawing file.

Pin Count

Specifies the number of pins associated with the connector. This is required to parametrically build the connector.

Pick

This is an alternate Pick method for determining the Pin Count for the new connector. You can do a fence selection of crossed wires or you can define a starting point and ending point in empty space. For the fence selection, a pin exists for every wire intersection with the AutoCAD fence line. For example, if you cross 5 wires with the fence pick points, the pin count value will be 5. On the other hand, if you select endpoints in empty space, the total number of pins is based upon dividing the distance between the two pick points by the Pin Spacing value.

Fixed Spacing

Generates the connector with a fixed spacing from one pin to the next. This is the Pin Spacing value. If the Pin Spacing edit box is left blank, the fixed spacing value defaults to the drawing’s ladder default spacing value.

At Wire Crossings

Modifies the pin placement to have the pins coincide with underlying wires. The connector stretches or compresses to match up with underlying wires as it inserts on to the drawing.

If the connector has more pins than underlying wires, the excess pins are added at the end of the connector using the default fixed spacing value.

Pin List

Specifies either the starting pin number for an incrementing series of pin numbers or the actual comma-delimited list of pin numbers to be used on the connector. For example, a pin list entry of “1” for a connector with the Pin Count
set to 8 generates a connector with pins labeled "1" through "8." On the other hand, a pin list entry of "1,2,3,4,A,B,C,GND" generates an 8-pin connector with pins labeled "1", "2", "3", "4", "A", "B", "C", "GND."

If the Pin List edit box is left blank, the connector numbering starts at 1 and continues up through the Pin Count value. If you define more pin list data than pin count, the pins are used in the order they are defined. The entire list is saved on the connector as PINLIST xdata. This can be later referenced to add missing pins (Add Connector Pin tool) or to assign unused pins to a child instance of the parent connector.

Insert All

Creates the connector without further prompts (i.e. no option for inserting spacers or for breaking the connector into 2 or more pieces).

Allow Spacers/Breaks

Gives you manual control over the insertion of the connector. Displays the Custom Pin Spaces/Breaks dialog box that prompts you for the insertion of each connector pin prior to committing the connector block definition to the drawing file. The running count of pins inserted versus total pins defined for the connector is listed at the top of the dialog box. Select an option for inserting the other pins:

- **Insert Next Connection**: Continues building the connector by inserting the next pin (repeated prompting until all pins are inserted).

- **Add Spacer**: Adds a spacer in place of a pin on the connector in order to leave room for a future pin or to skip over a wire that is not to be broken by the connector. The connector stretches its length to account for this extra blank space.

- **Break Symbol Now**: Breaks connector and begins prompt back at the connector layout dialog box. If you terminate the command without inserting the remainder of the connector, you can go to another drawing and restart the command. You can continue with the previous connector or discard the saved data and start with a new one.
**NOTE** This insert of a continued, broken connector must be done during the current AutoCAD Electrical session.

- **Cancel Custom**: Inserts the remaining pins into the connector without any further prompts.

**Start Connector As Child**

Defines the new connector block definition as a child of a parent connector. This means that after it is created it needs to be linked to a parent connector through a common tag-ID value (select Edit Component and link to parent using any of the normal methods).

**Start with Break**

Creates the child symbol with a jagged or broken top. If unselected, the child symbol has a rounded corner determined by the radius dimension defined in the Size section of the dialog box.

**Orientation**

Use to quickly change the connector's orientation prior to placing it into the drawing file. This orientation change also modifies the preview to reflect the selection.

- **Rotate**

  Switches the orientation of the parametric connector insertion between horizontal and vertical.

- **Flip**

  Flips the connector about its long axis.
**Type**

Determines the type of connector to be built as to whether it includes the plug/receptacle combination or if it will display either the plug side or the receptacle side.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plug/Receptacle Combination</td>
<td>Creates the connector as a single block file showing both the plug and receptacle.</td>
</tr>
<tr>
<td>Wire Number Change</td>
<td>Sets the property of the connector symbol to change the wire number through a plug/receptacle connector or symbol. By default, the wire numbers are maintained through a plug/receptacle connector.</td>
</tr>
<tr>
<td>Add Divider Line</td>
<td>Creates a plug/receptacle combination connector with a line down the middle of the block to indicate the separation of the plug and receptacle. This line becomes part of the block definition for the connector.</td>
</tr>
<tr>
<td>Plug Only</td>
<td>Creates the connector as a single block file showing the plug representation only.</td>
</tr>
<tr>
<td>Receptacle Only</td>
<td>Creates the connector as a single block file showing the receptacle representation only.</td>
</tr>
</tbody>
</table>

**Display**

Use to define the connector's placement on the drawing relative to other connectors and the drawing border. This controls which side of the connector the plug will be displayed, whether the connector goes in vertically or horizontally, and whether the pins are visible.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector</td>
<td>Specifies whether the connector inserts vertically or horizontally.</td>
</tr>
<tr>
<td>Plug</td>
<td>Specifies which direction the plug portion of the connector comes in relative to the overall plug/receptacle parametric build. The plug representation is displayed with rounded corners.</td>
</tr>
</tbody>
</table>
Options include vertical with the plug to the left, vertical with the plug to the right, horizontal with the plug to the bottom, or horizontal with the plug to the top.

**Pins**

Specifies which pin numbers are visible or hidden on the connector. In the case of a plug/receptacle combination, options include showing both sides, showing the plug only, showing the receptacle only, or hiding both.

If you select to make the pins on the plug or receptacle invisible, the attribute and its value are still defined in the block definition on the drawing file.

If you selected Plug Only or Receptacle Only for the Type, the pin display options are show or hide only. These show or hide the pin numbers on a single plug or receptacle symbol. Hidden pins are still present on the symbol, they are just marked invisible. Values assigned to the hidden pins will still show up in various wire connection from/to reports. You can unhide hidden attributes using the Move/Show Attribute tool.

**Size**

The values in the edit boxes define the parameters used to build the graphical outline that represents the shell of the connector.

- **Receptacle**
  Specifies the width of the receptacle side of the connector. This value can be the same as the plug side.

- **Plug**
  Specifies the width of the plug side of the connector.

- **Top**
  Specifies the distance from the first pin of the connector to the top end of the connector.

- **Bottom**
  Specifies the distance from the last pin of the connector to the bottom end of the connector.

- **Radius**
  Specifies the fillet radius for the rounded portion of the plug representation. If left blank or if you enter a 0.0 value, then the corner is drawn without a fillet. If the radius value exceeds the Plug width value, the radius value will be internally set back to be equal to the plug width value.
**Insert**

Inserts the connector symbol on the drawing. If a pin count was not defined, an error message appears indicating that you must define a pin count before proceeding. A preview outline of the connector displays for placement on the drawing. It shows angled corners for the plug side of the connector. An 'x' indicates the insertion point of the connector. An arrow indicates the plug side wire connection direction for plug/receptacle or plug-only connector inserts or shows the wire connection direction for a receptacle-only connector insert.

Prior to committing the connector outline to the drawing, you can press TAB on your keyboard to flip the connector through 4 different orientations or press the "V" key to switch between vertical and horizontal orientations.

**Connector layout**

**Access:**

Click the Insert Connector tool. In the Insert Connector dialog box, select Allow Spacers/Breaks and click Insert. In the Custom Pin Spaces/Breaks dialog box, click Break Symbol Now.

From the Components menu, select Insert Connector ➤ Insert Connector. In the Insert Connector dialog box, select Allow Spacers/Breaks and click Insert. In the Custom Pin Spaces/Breaks dialog box, click Break Symbol Now.

Selecting Break Symbol Now on the Custom Pin Spaces/Breaks dialog box breaks the connector and displays this dialog box for defining how you want the rest of the pins inserted on the drawing.

**Pin Spacing**

Specifies the distance between the pin wire connections. This value initially defaults to the Rung Spacing defined Drawing Properties ➤ Drawing Format ➤ Ladder Defaults - Spacing setting for the for the drawing file.

**Fixed Spacing**

Creates the connector pin spacing as fixed. The spacing is driven by the Pin Spacing value. If the Pin Spacing edit box is left blank, the fixed spacing value is determined from the drawing's ladder defaults spacing value.
Modifies the connector to have the pins coincide with underlying wires. The connector stretches or compresses to match up with underlying wires as it inserts on to the drawing. If the connector has more pins than underlying wires, the excess pins are added at the end of the connector using the default fixed spacing value.

**Pin Insertion**

**Insert All** Creates the connector without further prompts (for example, no option for inserting spacers or for breaking the connector into 2 or more pieces). When you click OK on the Connector Layout dialog box, the block definition is committed to the drawing and the command is complete.

**Allow Spacers/Breaks** Gives you manual control over the insertion of the connector. Displays the Custom Pin Spaces/Breaks dialog box that prompts you for the insertion of each connector pin prior to committing the connector block definition to the drawing file. The running count of pins inserted versus total pins defined for the connector is listed at the top of the dialog box. Select an option for inserting the other pins:

- **Insert Next Connection**: Continues building the connector by inserting the next pin (repeated prompting until all pins are inserted).
- **Add Spacer**: Adds a spacer in place of a pin on the connector in order to leave room for a future pin or to skip over a wire that is not to be broken by the connector. The connector stretches its length to account for this extra blank space.
- **Break Symbol Now**: Breaks connector and begins prompt back at the Connector Layout dialog box. If you terminate the command without inserting the remainder of the connector, you can go to another drawing and restart the command. You can continue with the previous connector or discard the saved data and start with a new one.

**NOTE** This insert of a continued, broken connector must be done during the current AutoCAD Electrical session.
- **Cancel Custom**: Inserts the remaining pins into the connector without any further prompts.

**Connector pin numbers in use**
Lists all of the pins previously used in the project and the available pins that can be assigned to a connector. The connector tag and pin count displays below the title bar in the dialog box.

**Access:**

Click the Edit Component tool. Select the connector to edit. In the Insert/Edit Component dialog box, Pins section, click List.

From the Components menu, select Edit Component. Select the connector to edit. In the Insert/Edit Component dialog box, Pins section, click List.

**NOTE** You can edit pin numbers when a row is selected in the grid.

**Pin List**
Displays all available pins to be assigned to the parametrically-built connector. The number in parenthesis () indicates the single or pair of pins for the connector. The first column is the value assigned to TERM01 or TERM01P while the second column assigns its number to TERM02 or TERM02J. Select the pin from the list to populate the grid. The Pin list table in the catalog database (default_cat.mdb) supports connectors drawn in the ladder diagram or connector diagram schematics.

Displays an 'x' for all pins that are displayed since they are part of the connector and not selected on the block being edited (the pins may be on a different drawing or part of another symbol). Only the pin numbers associated to the block selected are editable; the controls at the bottom of the dialog box are disabled if a pin with an 'x' is selected from the list.

**Sheet, Reference**
Displays the sheet number and potential reference line number where the connector definition is located in the project.

**Plug**
Displays the plug pin number. The value changes automatically if you edit it in the Pin Numbers section of the dialog box.
<table>
<thead>
<tr>
<th>Description</th>
<th>Displays the terminal descriptions that are associated to the wire connection point. The first Description column displays the description for the plug; the second displays the description for the receptacle.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receptacle</td>
<td>Displays the receptacle pin number. The value changes automatically if you edit it in the Pin Numbers section of the dialog box.</td>
</tr>
<tr>
<td>Wire Numbers</td>
<td>Displays the wire numbers on either side of the combination connector or a single wire number based on whether or not the connector is a simple plug or jack.</td>
</tr>
</tbody>
</table>
| Pin Numbers | Displays the plug and receptacle pin numbers for the selected row. Enter a new value in the edit box or click the arrows to increment or decrement both numbers on the plug and receptacle.  

**NOTE** If you replace pin numbers through editing, the replaced pin numbers may go back into the Pin List if they were originally defined in the Pin List range. |
| Pin Descriptions | Edits the plug and receptacle terminal descriptions. The value you enter in the edit box displays in the Description column of the grid. |

**Bend wires at right angles**

Use this tool to bend a wire in a right angle and make 3 right angle turns to avoid or add geometry. When a wire is defined at a right angle, you can modify the wire and create a new right angle bend while maintaining the original wire connections to the components.
NOTE This tool terminates if the bend attempts to connect two different wire networks or if the bend bypasses more than a single right-angle turn.

1. Click the arrow on the Insert Wires tool to access the Bend Wire tool.

2. Click the Bend Wire tool.

3. Select one of the two wires that make up a right-angle turn.

4. Select the opposing wire that makes up the right-angle turn. The additional wire segments are added based on the right-angle direction.

5. Right-click to exit the command.

**Insert multiple bus wiring**

1. Click the arrow on the Insert Wires tool to access the Multiple Wire Bus tool.

2. Click the Multiple Wire Bus tool.

3. Set the horizontal and vertical spacing for the wires.

4. Select the mode for defining the "starting at" position.
   - Starting at component wire connection points: Select the radio button and click OK. Select or window-select the wire connection points on the component.
   - Starting from another bus: Select the number of wires (using the buttons or type in the edit box) and click OK. Specify the connection point on the existing wire bus for the first wire of the new bus. Slowly move the cursor over the other existing wires of the bus to allow the new bus wires to connect.
Starting in empty space: Select the starting direction (Horizontal or Vertical), select the number of wires (using the buttons or type in the edit box), and click OK. Specify the starting point in space for the first wire of the new bus.

During wire insertion, the current wire type displays at the command prompt. If starting at a component or in empty space, you can override this by typing in the hotkey "T" and selecting a new wire type from the Set/Edit Wire Type dialog box. The new wire type becomes the current wire type and the command continues with the wire insertion.

As you pull the wires out, phantom wires display on your cursor indicating the direction and number of wires to be placed on the drawing. You can turn a corner by moving your cursor out of line with the bus. To reverse or flip the turn’s phase sequence, press "F" + Enter. The phantom wire display displays in red when it detects that the routing approaches within a wire connection trap distance of another wire.

5 Click a point on the screen to set the endpoint of the wires or press "C" + Enter to lock down the current routing and continue to draw multiple wires. If the bus approaches a multi-connection device, such as a connector, it attempts to align the spacing of the bus wires to match with the wire connections.

6 Right-click to create the wires. The wires and wire connection dots insert, and loops or gaps (if configured) automatically insert at wire crossing points.
Import data from Autodesk Inventor Professional Cable & Harness

From the XML export from Autodesk Inventor Professional (AIP) into AutoCAD Electrical, you can select from a list of connectors defined in the export, and then place the connectors onto a 2D drawing file. After the connectors are inserted onto the drawing, click Wire on the Connector Selection dialog box to place all wire connections to all components on the drawing file. AutoCAD Electrical parses the file data to determine all wire From and To connections. Once the wiring information is determined, the wires are routed making sure to miss existing geometry on the drawing. The wire insertion tool finds the best possible route with the fewest amount of wire loops in between the connection reducing the requirement on gap pointers. The wires are connected in the appropriate position on the connector representation.

As the wires are inserted, the wire types in the XML file are applied to the Wire Layer in the AutoCAD Electrical drawing. Additionally, wire numbers and cable marker symbols are inserted onto the drawing. The wire numbers are inserted following the drawing's wire number setting (above wire, in-line with wire, or below wire). The first cable marker listed in the XML file is inserted as the parent and the subsequent markers of the same reference designator (Cable Tag) are inserted as children.

Certain Autodesk Inventor Professional wire property names need to be maintained inside of AutoCAD Electrical. You must make sure that your column header names (set in the Rename User Columns dialog box) match the property names coming out of the Autodesk Inventor Professional XML export (set in the Autodesk Inventor Custom Properties dialog box). For example, the property CORE SIZE maps to a user column of the Create/Edit Wire Type dialog box if there is a column header defined as "CORE SIZE." If mapping does not exist then the data is not maintained inside of your AutoCAD Electrical drawing file.
Autodesk Inventor Professional properties mapped to AutoCAD Electrical attributes

There are 4 Autodesk Inventor Professional assembly entity types that get general and custom properties: component occurrences, Wire (From/To) occurrences, cable occurrences, and splice occurrences.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>AIP Property Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Component Properties</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connector REF DES</td>
<td>Occurrence</td>
<td>Component RefDes - TAG1 attribute in AutoCAD Electrical</td>
</tr>
<tr>
<td>PART NUMBER</td>
<td>Definition</td>
<td>Autodesk Inventor part number - Xdata in AutoCAD Electrical</td>
</tr>
<tr>
<td>VENDOR</td>
<td>Definition</td>
<td>Manufacturer - Xdata in AutoCAD Electrical</td>
</tr>
<tr>
<td>STRIP LENGTH</td>
<td>Definition, Custom</td>
<td>Save on component - Xdata in AutoCAD Electrical</td>
</tr>
<tr>
<td>Various user-defined *</td>
<td>Definition, Custom</td>
<td>Defined in the component library definition (part editing) - Xdata in AutoCAD Electrical</td>
</tr>
<tr>
<td>Various user-defined *</td>
<td>Occurrence, Custom</td>
<td>Defined in the harness occurrence level - Xdata in AutoCAD Electrical</td>
</tr>
<tr>
<td><strong>Wire Properties</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wire ID</td>
<td>Occurrence</td>
<td>Unique wire number ID (occurrence name) - AutoCAD Electrical wire number; WIRENO attribute in AutoCAD Electrical</td>
</tr>
<tr>
<td>Wire Definition</td>
<td>Definition</td>
<td>Wire library definition data saved in Cable &amp; Harness library XML - wire layer name in AutoCAD Electrical</td>
</tr>
<tr>
<td>Property</td>
<td>Definition</td>
<td>Notes</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cable Properties</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cable ID</td>
<td>Occurrence</td>
<td>Unique cable ID - TAG 1 attribute in AutoCAD Electrical</td>
</tr>
<tr>
<td>Cable Definition</td>
<td>Definition</td>
<td>Cable library definition data saved in Cable &amp; Harness library XML - Xdata in AutoCAD Electrical</td>
</tr>
<tr>
<td>Cable Wire Name</td>
<td>Definition</td>
<td>Cable conductor ID - RATING1 attribute in AutoCAD Electrical</td>
</tr>
<tr>
<td>Various user-defined *</td>
<td>Definition, Custom</td>
<td>Defined in the cable library definition (part editing) - Xdata in AutoCAD Electrical</td>
</tr>
<tr>
<td>Various user defined *</td>
<td>Occurrence, Custom</td>
<td>Defined in the harness occurrence level - Xdata in AutoCAD Electrical</td>
</tr>
<tr>
<td>Splice Properties</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Splice ID</td>
<td>Occurrence</td>
<td>Unique splice ID - TAG1 attribute in AutoCAD Electrical</td>
</tr>
<tr>
<td>Splice Definition</td>
<td>Definition</td>
<td>Splice library definition data saved in Cable &amp; Harness Library XML - Xdata in AutoCAD Electrical</td>
</tr>
<tr>
<td>Various user defined *</td>
<td>Definition, Custom</td>
<td>Defined in the splice library definition (part editing) - Xdata in AutoCAD Electrical</td>
</tr>
</tbody>
</table>

664 | Chapter 10  Point-to-Point Wiring Tools
Various user-defined * Occurrence, Custom Defined in the harness occurrence level - Xdata in AutoCAD Electrical

* Properties that are not defined in Autodesk Inventor Professional but are still usable in AutoCAD Electrical.

**Import connector wire lists**

Use the Insert Connector from List tool to import a connector wire list from another application, such as Autodesk Inventor Professional Cable & Harness.

**NOTE** If the AutoCAD Electrical drawing is missing one end of the connector or if a connection was not found, wiring information is displayed next to the pin and the information is written into a log file so you know AutoCAD Electrical was unable to resolve the wire connections in the drawing. The log file name is [drawing file name.LOG] and is found in the same folder as the drawing file.

1. In Autodesk Inventor Professional Cable & Harness, define wire names and connections for your assembly file.
2. Define cable tags and conductor IDs and their connections in the assembly file.
3. Select the harness ID in the model browser and select Export Harness Data from the Cable and Harness panel.
   You are prompted to select a file name and location for the export of harness component and wiring data. An XML file is created for import into AutoCAD Electrical.
4. In AutoCAD Electrical, create a new drawing file.
5 Click the arrow on the Insert Connector tool to access the Insert Connector from List tool.

6 Click the Insert Connector from List tool.

7 In the Connector List File Selection dialog box, select a connector list file to import into AutoCAD Electrical and click Open.

8 In the Connector Selection dialog box, define the connectors to be inserted onto the drawing.
   An 'X' in the Placed column indicates if the connector is placed or was previously placed into the project.
   ■ (Optional) Specify whether to build the connector using fixed pin spacing or to have it compress or expand to match the pins up with underlying wire crossings.
   ■ (Optional) Specify whether to insert the entire connector all at once or to insert it manually, pin by pin, with an option to insert spacers or to break the connector into 2 or more pieces.
   ■ (Optional) Click the Rotate or Flip buttons to change the display of the connector symbol.
   ■ (Optional) Click Details for more options to define settings for the size, shape and display of the parametrically built connector symbols.

9 Select the connectors to insert from the list and click Insert.

10 Click the insertion point in the drawing for each connector.

11 In the Connector Selection dialog box, continue selecting the connectors to insert and place them onto the drawing.

12 When all connectors are placed on the drawing, click Wire It.
   Wires are generated in the drawing. Layers and XRECORDS are defined in the drawing and applied to the lines. Wire numbers are also placed in the drawing based on wire placement settings.
NOTE You can place the connectors on the drawing and add wires at a later time. To do so, follow steps 1 - 9. When you want to add wires, open the Connector Selection dialog box, and click Wire It.

**Connector selection**

From the XML export from Autodesk Inventor Professional into AutoCAD Electrical, you can select from a list of connectors defined in the export, and then place the connectors onto a 2D drawing file.

**Access:**

- On the Insert Connector toolbar, click the Insert Connectors from List tool.
- From the Components menu, select Insert Connector ➤ Insert Connector from List.

The first time you run this tool, you must select the connector list file (.xml, .xls, .mdb, and .csv) in the Connector List File Selection dialog box and click Open. The connector list file is retained in memory for subsequent selections of this tool.

**NOTE** If you select to open a spreadsheet or database that contains multiple sheets or tables, the Select Input Source dialog box displays where you can select the sheet or table to open.

**Connector List**

Columns are not editable. You can perform an alphanumeric sort of the connector details by clicking the column headers.

- **Placed**
  Displays an "x" if the connector is placed or was previously placed into the project.

- **Installation**
  Displays the component’s Installation code if defined in the XML import file.

- **Location**
  Displays the component’s Location code if defined in the XML import file.
| Tag | Displays the connector’s reference designation (RefDes) from the Autodesk Inventor Professional (AIP) assembly or tags found in the XML import file. |
| Total Pins | Displays the total pin count for the tag. |
| Wired Pins | Displays the number of pins wired inside of the AIP assembly found in the import file. |
| Description | Displays the occurrence name of the part defined in the AIP browser. The occurrence name is typically the part number of the component, however you can overwrite the name. |
| Show All/Hide Placed | **Show All** displays all connectors in the grid whether they have been placed or not while **Hide Placed** removes previously placed connectors from the grid list. |
| Connectors | Displays all connectors found in the import file in the grid display. The static text shows the total number of connector components listed in the grid control. |
| Splices | Displays all splices found in the import file in the grid display. The static text shows the total number of splices listed in the grid control. |

**NOTE** If there is a selection active when filtering the list and one or more of the selected rows drops out of the display, a warning message displays where you decide whether to proceed or not.

**Layout**

| Pin Spacing | Specifies the spacing for the distance between pin connections on their parametrically built connector symbol. The default spacing is defined from the drawing's Rung Spacing setting. The edited value is persistent for the ACADE session and reverts to the default upon every start up of the application. |
| Fixed Spacing | Creates the connector pin spacing as fixed. The fixed spacing value is driven from the Pin Spacing setting. |
At Wire Crossings

Modifies the connector to have the pins meet the underlying wires. AutoCAD Electrical searches the wires and stretches the connector before adding the block definition to the drawing. If there are more pins associated to the connector than there are wires, AutoCAD Electrical finds the wires first, then continues the connector definition at the fixed spacing.

Wired Pins

Creates the connector using the number of pins wired in the AIP assembly and found in the import file. This reduces the size of the overall connector based upon pins used and not library definition. If this is not selected, the connector is created using the total pins on the connector as defined in the export/import file.

Insert All

Creates the connector without inserting spacers or breaking the connector. When you click Insert the block definition is committed to the drawing and the command is complete.

Allow Spacers/Breaks

Displays the Custom Pin/Spaces dialog box that prompts you for the insertion of each connector pin prior to committing the connector block definition to the drawing file. The number of pins inserted in the block definition out of the total number of pins defined in the connector is indicated at the top of the dialog box. Select an option for inserting the other pins:

- **Insert Next Connection**: Continues adding pins to the connector until all are defined.
- **Add Spacer**: Adds a spacer in place of a pin on the connector; connector stretches its definition.
- **Break Symbol Now**: Breaks connector and begins prompt back at the connector layout dialog box.
- **Cancel Custom**: Places connector in as if you selected Insert all on the portion it is working on. Does not remove preceding break commands.

Splice Symbol Name

Defines a symbol to be used to display a splice in the wire. Type in a symbol name to use when inserting splices or click Browse to select the symbol name to use. If left blank, once you click Insert, an error message displays since you must select a Splice Symbol Name to insert the splice onto the drawing.
**Orientation**

Quickly change the connectors orientation prior to placing it into the drawing file. This orientation change also modifies the preview to reflect the selection.

- **Rotate**
  
  Switches the orientation of the parametric connector insertion between horizontal and vertical.

- **Flip**
  
  Flips the connector insertion about its long axis.

**Type**

Determines the overall style of the connector.

- **Plug/Receptacle Combination**
  
  Creates the connector as one AutoCAD Electrical block file with both the plug and receptacle.

- **Wire Number Change**
  
  Sets the property of the connector symbol to change the wire number through the connector symbol. By default, the wire numbering is the same on both sides of the connector.

- **Add Divider Line**
  
  Creates the connector with a line down the middle of the block to indicate the separation of the plug and receptacle. This line becomes part of the block definition for the connector.

- **Plug Only**
  
  Creates the connector as a single block file with the plug representation only.

- **Receptacle Only**
  
  Creates the connector as a single block file with the receptacle representation only.

**Display**

Defines the connector's placement on the drawing relative to other connectors and the drawing border. This controls which side of the connector the plug
will be displayed, whether the connector goes in vertically or horizontally, and whether the pins are visible.

**Connector**

Specifies whether the connector comes into the drawing vertically or horizontally relative to other connectors and the drawing border.

**Plug**

Specifies which direction the plug portion of the connector comes in relative to the overall plug/receptacle parametric build. The plug representation is displayed with rounded corners.

Options include vertical with the plug to the left, vertical with the plug to the right, horizontal with the plug to the bottom, or horizontal with the plug to the top.

**Pins**

Specifies which pin numbers are visible or hidden on the connector. Options include showing both sides, showing the plug only, showing the receptacle only, or hiding both.

If you select to make the pins on the plug or receptacle invisible, the attribute and its value are still defined in the block definition on the drawing file.

If you selected Plug Only or Receptacle Only for the Type, the pin display options are show or hide only. These show or hide the pin numbers on a single plug or receptacle symbol.

**Size**

Defines the outside shell size for the connector. The values in the edit boxes build the graphical shell that represents the connector on the point to point diagram.

**Receptacle**

Specifies the overall thickness of the receptacle side of the connector. This value can be the same as the plug side.

When the connector is built, the receptacle side wire connection attribute is moved from the insertion point on the divider line to the outside line representing the receptacle. The associated terminal pin attribute (TERM01) travels half the distance as the wire connection attribute placing itself in the middle between the dimension on the divider line.

**Plug**

Specifies the overall thickness of the plug side of the connector. This value can be the same as the receptacle side.
When the connector is built, the plug side wire connection attribute is moved from the insertion point on the divider line to the outside line representing the plug. The associated terminal pin attribute (TERM01_) travels half the distance as the wire connection attribute placing itself in the middle between the dimension on the divider line.

**Top**
Specifies the distance from the top or breaking point of the connector to the first or next wire connection point. This determines where the top line is drawn relative to the first master symbol insertion point. The distance is used for the entire connector or breaking the connector.

**Bottom**
Specifies the distance from the bottom or breaking point of the connector to the last or previous wire connection point. This determines where the bottom line is drawn relative to the last master symbol insertion point. The distance is used for the entire connector or breaking the connector.

**Radius**
Specifies the radial dimension of the rounded portion of the plug representation. If left blank, a radius is not created on the plug connector. If you enter a value that exceeds the overall plug side distance, the radius value is erased and the radius is not created on the plug connector.

**Pick File**
Displays the Connector List File Selection dialog box to select a new file for import.

**Wire It**
Reviews connectors placed on the active drawing and runs the wiring commands to make connections between the connectors.

- When both ends of the wire connections are found on the active drawing, the wires are generated between the two points and wire numbering is added based on current configurations.

- When only one end of the wire connection is found on the active drawing, text is placed next to the connector in the X?WIREnn wire annotation attribute on the connector symbol. This text is overwritten when the second
end of the wire is placed on the drawing and the Wire It command is run again.

- When neither connection for a wire are on the active drawing, the wiring command is ignored until you add the connectors into the drawing file.

**NOTE** If the AutoCAD Electrical drawing is missing one end of the connector or if a connection was not found, wiring information is displayed next to the pin and the information is written into a log file so you know AutoCAD Electrical was unable to resolve the wire connections in the drawing. The log file name is `{drawing filename.LOG}` and is found in the same folder as the drawing file.

**Insert**

Upon selection of one or more rows in the grid display, this button is enabled. Once selected, the parametric connector program launches to create a connector image in the drawing.

- **Single row selection**
  Places one connector at a time and returns to the Connect- or Selection dialog box with the connector row marked as 'x.'

- **Multiple row selection**
  Places the selected connectors in consecutive order. Steps through the list of connectors previously selected in the dialog box, placing them in the drawing one at a time. After the connectors are created the Connector Selection dialog box displays with the connector rows marked as 'x.'

**Overview of the spreadsheet import file structure**

You can select various file types (including XLS, CSV, MDB, and XML) to import into AutoCAD Electrical. For the Insert Connector from List tool to work, the spreadsheet and CSV import file must have the following structure. The spreadsheet for import allows 27 columns per record. The first row in the CSV or XLS file is treated as a header row, and is skipped in the import. All columns must exist and the required fields (bolded) determine the connector to be used in the Connector Selection dialog box.
<table>
<thead>
<tr>
<th>Position</th>
<th>Field</th>
<th>Purpose</th>
<th>Column Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TYPE1</td>
<td>CMP1: C = Connector/ S = Splice</td>
<td>Text</td>
</tr>
<tr>
<td>2</td>
<td>INST1</td>
<td>Installation Code of CMP1</td>
<td>Text</td>
</tr>
<tr>
<td>3</td>
<td>LOC1</td>
<td>Location Code of CMP1</td>
<td>Text</td>
</tr>
<tr>
<td>4</td>
<td>CMP1</td>
<td>Component 1</td>
<td>Text</td>
</tr>
<tr>
<td>5</td>
<td>PIN1</td>
<td>Connected pin on CMP1</td>
<td>Text</td>
</tr>
<tr>
<td>6</td>
<td>DESC1</td>
<td>Description of CMP1</td>
<td>Text</td>
</tr>
<tr>
<td>7</td>
<td>CAT1</td>
<td>Catalog number for CMP1</td>
<td>Text</td>
</tr>
<tr>
<td>8</td>
<td>MFG1</td>
<td>Manufacturer of CAT1</td>
<td>Text</td>
</tr>
<tr>
<td>9</td>
<td>ASM1</td>
<td>Assembly code for CMP1</td>
<td>Text</td>
</tr>
<tr>
<td>10</td>
<td>TYPE2</td>
<td>CMP2: C = Connector/ S = Splice</td>
<td>Text</td>
</tr>
<tr>
<td>11</td>
<td>INST2</td>
<td>Installation Code of CMP2</td>
<td>Text</td>
</tr>
<tr>
<td>12</td>
<td>LOC2</td>
<td>Location Code of CMP2</td>
<td>Text</td>
</tr>
<tr>
<td>13</td>
<td>CMP2</td>
<td>Component 2</td>
<td>Text</td>
</tr>
<tr>
<td>14</td>
<td>PIN2</td>
<td>Connected pin on CMP2</td>
<td>Text</td>
</tr>
<tr>
<td>15</td>
<td>DESC2</td>
<td>Description of CMP2</td>
<td>Text</td>
</tr>
<tr>
<td>16</td>
<td>CAT2</td>
<td>Catalog number of CMP2</td>
<td>Text</td>
</tr>
<tr>
<td>17</td>
<td>MFG2</td>
<td>Manufacturer of CAT2</td>
<td>Text</td>
</tr>
</tbody>
</table>
The MDB file must contain a table with the abovementioned 27 columns. Each column should be defined using the VARCHAR data type of an appropriate size to suit the data. The names of the columns in the table are not important, but the position is.

**Import connector wire lists**

Use the Insert Connector from List tool to import a connector wire list from another application, such as Autodesk Inventor Professional Cable & Harness.

**NOTE** If the AutoCAD Electrical drawing is missing one end of the connector or if a connection was not found, wiring information is displayed next to the pin and the information is written into a log file so you know AutoCAD Electrical was unable to resolve the wire connections in the drawing. The log file name is \{drawing file name\}.LOG and is found in the same folder as the drawing file.

1. In Autodesk Inventor Professional Cable & Harness, define wire names and connections for your assembly file.
2 Define cable tags and conductor IDs and their connections in the assembly file.

3 Select the harness ID in the model browser and select Export Harness Data from the Cable and Harness panel. You are prompted to select a file name and location for the export of harness component and wiring data. An XML file is created for import into AutoCAD Electrical.

4 In AutoCAD Electrical, create a new drawing file.
5 Click the arrow on the Insert Connector tool to access the Insert Connector from List tool.

6 Click the Insert Connector from List tool.

7 In the Connector List File Selection dialog box, select a connector list file to import into AutoCAD Electrical and click Open.

8 In the Connector Selection dialog box, define the connectors to be inserted onto the drawing. An 'x' in the Placed column indicates if the connector is placed or was previously placed into the project.
   ■ (Optional) Specify whether to build the connector using fixed pin spacing or to have it compress or expand to match the pins up with underlying wire crossings.
   ■ (Optional) Specify whether to insert the entire connector all at once or to insert it manually, pin by pin, with an option to insert spacers or to break the connector into 2 or more pieces.
   ■ (Optional) Click the Rotate or Flip buttons to change the display of the connector symbol.
   ■ (Optional) Click Details for more options to define settings for the size, shape and display of the parametrically built connector symbols.

9 Select the connectors to insert from the list and click Insert.

10 Click the insertion point in the drawing for each connector.

11 In the Connector Selection dialog box, continue selecting the connectors to insert and place them onto the drawing.

12 When all connectors are placed on the drawing, click Wire It. Wires are generated in the drawing. Layers and XRECORDS are defined in the drawing and applied to the lines. Wire numbers are also placed in the drawing based on wire placement settings.
NOTE You can place the connectors on the drawing and add wires at a later time. To do so, follow steps 1 - 9. When you want to add wires, open the Connector Selection dialog box, and click Wire It.

Connector selection

From the XML export from Autodesk Inventor Professional into AutoCAD Electrical, you can select from a list of connectors defined in the export, and then place the connectors onto a 2D drawing file.

Access:

On the Insert Connector toolbar, click the Insert Connectors from List tool.
From the Components menu, select Insert Connector ➤ Insert Connector from List.

The first time you run this tool, you must select the connector list file (.xml, .xls, .mdb, and .csv) in the Connector List File Selection dialog box and click Open. The connector list file is retained in memory for subsequent selections of this tool.

NOTE If you select to open a spreadsheet or database that contains multiple sheets or tables, the Select Input Source dialog box displays where you can select the sheet or table to open.

Connector List

Columns are not editable. You can perform an alphanumeric sort of the connector details by clicking the column headers.

<table>
<thead>
<tr>
<th>Placed</th>
<th>Displays an &quot;x&quot; if the connector is placed or was previously placed into the project.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation</td>
<td>Displays the component’s Installation code if defined in the XML import file.</td>
</tr>
<tr>
<td>Location</td>
<td>Displays the component’s Location code if defined in the XML import file.</td>
</tr>
</tbody>
</table>
Tag
Displays the connector's reference designation (RefDes) from the Autodesk Inventor Professional (AIP) assembly or tags found in the XML import file.

Total Pins
Displays the total pin count for the tag.

Wired Pins
Displays the number of pins wired inside of the AIP assembly found in the import file.

Description
Displays the occurrence name of the part defined in the AIP browser. The occurrence name is typically the part number of the component, however you can overwrite the name.

Show All/Hide Placed
Show All displays all connectors in the grid whether they have been placed or not while Hide Placed removes previously placed connectors from the grid list.

Connectors
Displays all connectors found in the import file in the grid display. The static text shows the total number of connector components listed in the grid control.

Splices
Displays all splices found in the import file in the grid display. The static text shows the total number of splices listed in the grid control.

NOTE If there is a selection active when filtering the list and one or more of the selected rows drops out of the display, a warning message displays where you decide whether to proceed or not.

Layout

Pin Spacing
Specifies the spacing for the distance between pin connections on their parametrically built connector symbol. The default spacing is defined from the drawing's Rung Spacing setting. The edited value is persistent for the ACADE session and reverts to the default upon every start up of the application.

Fixed Spacing
Creates the connector pin spacing as fixed. The fixed spacing value is driven from the Pin Spacing setting.
At Wire Crossings

Modifies the connector to have the pins meet the underlying wires. AutoCAD Electrical searches the wires and stretches the connector before adding the block definition to the drawing. If there are more pins associated to the connector than there are wires, AutoCAD Electrical finds the wires first, then continues the connector definition at the fixed spacing.

Wired Pins

Creates the connector using the number of pins wired in the AIP assembly and found in the import file. This reduces the size of the overall connector based upon pins used and not library definition. If this is not selected, the connector is created using the total pins on the connector as defined in the export/import file.

Insert All

Creates the connector without inserting spacers or breaking the connector. When you click Insert the block definition is committed to the drawing and the command is complete.

Allow Spacers/Breaks

Displays the Custom Pin/Spaces dialog box that prompts you for the insertion of each connector pin prior to committing the connector block definition to the drawing file. The number of pins inserted in the block definition out of the total number of pins defined in the connector is indicated at the top of the dialog box. Select an option for inserting the other pins:

- **Insert Next Connection**: Continues adding pins to the connector until all are defined.
- **Add Spacer**: Adds a spacer in place of a pin on the connector; connector stretches its definition.
- **Break Symbol Now**: Breaks connector and begins prompt back at the connector layout dialog box.
- **Cancel Custom**: Places connector in as if you selected Insert all on the portion it is working on. Does not remove preceding break commands.

Splice Symbol Name

Defines a symbol to be used to display a splice in the wire. Type in a symbol name to use when inserting splices or click Browse to select the symbol name to use. If left blank, once you click Insert, an error message displays since you must select a Splice Symbol Name to insert the splice onto the drawing.
**Orientation**

Quickly change the connectors orientation prior to placing it into the drawing file. This orientation change also modifies the preview to reflect the selection.

- **Rotate**
  Switches the orientation of the parametric connector insertion between horizontal and vertical.

- **Flip**
  Flips the connector insertion about its long axis.

**Type**

Determines the overall style of the connector.

- **Plug/Receptacle Combination**
  Creates the connector as one AutoCAD Electrical block file with both the plug and receptacle.

- **Wire Number Change**
  Sets the property of the connector symbol to change the wire number through the connector symbol. By default, the wire numbering is the same on both sides of the connector.

- **Add Divider Line**
  Creates the connector with a line down the middle of the block to indicate the separation of the plug and receptacle. This line becomes part of the block definition for the connector.

- **Plug Only**
  Creates the connector as a single block file with the plug representation only.

- **Receptacle Only**
  Creates the connector as a single block file with the receptacle representation only.

**Display**

Defines the connector's placement on the drawing relative to other connectors and the drawing border. This controls which side of the connector the plug
will be displayed, whether the connector goes in vertically or horizontally, and whether the pins are visible.

**Connector**
Specifies whether the connector comes into the drawing vertically or horizontally relative to other connectors and the drawing border.

**Plug**
Specifies which direction the plug portion of the connector comes in relative to the overall plug/receptacle parametric build. The plug representation is displayed with rounded corners.
Options include vertical with the plug to the left, vertical with the plug to the right, horizontal with the plug to the bottom, or horizontal with the plug to the top.

**Pins**
Specifies which pin numbers are visible or hidden on the connector.
Options include showing both sides, showing the plug only, showing the receptacle only, or hiding both.
If you select to make the pins on the plug or receptacle invisible, the attribute and its value are still defined in the block definition on the drawing file.
If you selected Plug Only or Receptacle Only for the Type, the pin display options are show or hide only. These show or hide the pin numbers on a single plug or receptacle symbol.

**Size**
Defines the outside shell size for the connector. The values in the edit boxes build the graphical shell that represents the connector on the point to point diagram.

**Receptacle**
Specifies the overall thickness of the receptacle side of the connector. This value can be the same as the plug side.
When the connector is built, the receptacle side wire connection attribute is moved from the insertion point on the divider line to the outside line representing the receptacle. The associated terminal pin attribute (TERM01_) travels half the distance as the wire connection attribute placing itself in the middle between the dimension on the divider line.

**Plug**
Specifies the overall thickness of the plug side of the connector. This value can be the same as the receptacle side.
When the connector is built, the plug side wire connection attribute is moved from the insertion point on the divider line to the outside line representing the plug. The associated terminal pin attribute (TERM01_) travels half the distance as the wire connection attribute placing itself in the middle between the dimension on the divider line.

**Top**

Specifies the distance from the top or breaking point of the connector to the first or next wire connection point. This determines where the top line is drawn relative to the first master symbol insertion point. The distance is used for the entire connector or breaking the connector.

**Bottom**

Specifies the distance from the bottom or breaking point of the connector to the last or previous wire connection point. This determines where the bottom line is drawn relative to the last master symbol insertion point. The distance is used for the entire connector or breaking the connector.

**Radius**

Specifies the radial dimension of the rounded portion of the plug representation. If left blank, a radius is not created on the plug connector. If you enter a value that exceeds the overall plug side distance, the radius value is erased and the radius is not created on the plug connector.

**Pick File**

Displays the Connector List File Selection dialog box to select a new file for import.

**Wire It**

Reviews connectors placed on the active drawing and runs the wiring commands to make connections between the connectors.

- When both ends of the wire connections are found on the active drawing, the wires are generated between the two points and wire numbering is added based on current configurations.

- When only one end of the wire connection is found on the active drawing, text is placed next to the connector in the X?WIREnn wire annotation attribute on the connector symbol. This text is overwritten when the second
end of the wire is placed on the drawing and the Wire It command is run again.

■ When neither connection for a wire are on the active drawing, the wiring command is ignored until you add the connectors into the drawing file.

**NOTE** If the AutoCAD Electrical drawing is missing one end of the connector or if a connection was not found, wiring information is displayed next to the pin and the information is written into a log file so you know AutoCAD Electrical was unable to resolve the wire connections in the drawing. The log file name is `{drawing filename.LOG}` and is found in the same folder as the drawing file.

**Insert**

Upon selection of one or more rows in the grid display, this button is enabled. Once selected, the parametric connector program launches to create a connector image in the drawing.

<table>
<thead>
<tr>
<th>Single row selection</th>
<th>Places one connector at a time and returns to the Connector Selection dialog box with the connector row marked as ‘x.’</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple row selection</td>
<td>Places the selected connectors in consecutive order. Steps through the list of connectors previously selected in the dialog box, placing them in the drawing one at a time. After the connectors are created the Connector Selection dialog box displays with the connector rows marked as ‘x.’</td>
</tr>
</tbody>
</table>
Insert splices

The splice symbol is an in-line connection symbol allowing one or more wires to connect at each end. The default splice symbol is set up to trigger a wire number change through the symbol.

1. Click the arrow on the Insert Connector tool to access the Insert Splice tool.

2. Click the Insert Splice tool.
   The Splice Symbols dialog box displays.

3. Select the splice to insert from the icon menu, enter the splice name in the Type it box, or click Browse to browse to and select the symbol from another location.

4. Click OK.

5. Pick the insertion point on the drawing. Place the symbol on an existing wire, causing the symbol to break the wire or place it in empty space (where you can later draw a wire through the symbol or connect one or more wires to each end of it). The Insert/Edit Component dialog box displays.

6. Assign the catalog information, description, and other information as required.

7. Click OK.
In this chapter

- Move from reference to reference
- Move between drawings
- Plot one or more drawings
- Create a project-wide script file
- Project-wide update or retag
- Track drawing changes
- Translate description text
- Publish to the web
- Title Block Utility
Move from reference to reference

Use the Surfer tool to move from reference to reference across the project drawing set. A new window opens and the original window closes when Surf is selected unless you hold the Shift key while running the command.
Start the Surfer

1. Click the Surfer tool.

2. Select a component tag, catalog number, or wire number on the current drawing, or press Enter to use the Type it to Surf it dialog box to enter the component tag, catalog number, or wire number.

   **NOTE** You can also select a report table cell containing any of these to surf on. If the selected cell does not contain any of the surf-able fields, AutoCAD Electrical looks in the selected row for a surf-able field. If the report is the Wire From/To or Component Wire List report, it looks for the Wire Number field first, then a Tag field, and finally a Catalog Number field. If the report is a Bill of Materials report, it looks for a Catalog Number field first, then the Tag field. For all other reports, AutoCAD Electrical looks for the Tag field first, then the Catalog Number field. If a non-surfable cell is selected, it looks for the component tag, then a wire number, and finally a catalog number.

   All references relating to the component, including panel layout and panel nameplate references, display in the Surf dialog box.

3. Double-click any reference listed in the Surf dialog box to zoom in on the selected reference. If the reference is on one or more drawings, each drawing opens automatically.

   **TIP** Use the Type column to easily select the object to surf to. The codes are as follows:

   - C - Component Symbol
   - P - Parent or Standalone Schematic Symbol
   - T - Terminal
   - W - Wire Number
   - # - Panel Layout Symbol
   - # np - Panel Layout nameplate reference

4. Using the Surf dialog box, edit the component, display a BOM listing for each reference or select a different component reference.
5 Click Close.

**Continue a previous surf session**

At any time, a previous surf session can be continued from the point where it left off.

1 Click the Continue Surfer tool.
   From the Projects menu, select Project > Continue Surfer.
   All references relating to the component, including panel layout and panel nameplate references, are displayed in the Surf dialog box.

2 Double-click any reference listed in the Surf dialog box to zoom in on the selected reference.
   If the reference is on one or more drawings, each drawing is opened automatically.

3 Using the Surf dialog box, edit the component, display a BOM listing for each reference or select a different component reference.

4 Click Close.

**Surf**

Move from reference to reference across the project drawing set.

In addition to surfing on a component tag, catalog number, or wire number on the current drawing, you can surf on a report table cell containing any of these. When surfing on a table inserted by the Terminal Strip Editor, you can select the title cell to surf on the Tagstrip value even if the Tagstrip is not included in the title. If you select a cell that is not surf-able (such as the Tag,
Access:

- Click the Surfer tool on the Main toolbar.
- From the Projects menu, select Project ➤ Surfer.

**NOTE** Your dialog box may differ depending on whether you're moving from reference to reference across the project drawing set or looking for problems related to wire signal source or destination codes.

When surfing for source or destination signals, the Surf dialog box displays the type (Src or Dst), sheet/reference value and description.

- **Show more**
  - Displays the extra non-Installation/Location matching references when in IEC tagging mode. If unselected, only the exact surf matches display in the list.
  
  **NOTE** This is unavailable if there aren’t any non-Installation/Location matching references or if you are not in IEC tagging mode.

- **Freshen**
  - Makes changes on the active drawing visible to the surfing tool.

- **Edit**
  - Edits a reference using the Insert/Edit Component dialog box.

- **Catalog Check**
  - Displays a BOM listing of the highlighted reference.
  
  **NOTE** The reference must have catalog and manufacturer values.

- **Pan**
  - Moves the view in the active viewport.

- **Zoom Save**
  - Saves the current zoom factor on the WD_M block.
Increases the apparent magnification of the drawing area. The zoom factor is related to the smaller of the active drawing’s default dimension text size (DIMTXT) and text size (TEXTSIZE). The smaller this value is, the closer the zoom is on the reference.

Delete

Delete the instance that is currently displayed.

NOTE Child and other related devices will not be deleted.

Pick New List

Changes the component terminal or signal reference you want to surf.

Zoom Out

Reduces the apparent magnification of the drawing area.

Go to

Goes directly to the reference of the highlighted entry.

**Special codes in the surf list box**

- c: Component symbol
- p: Parent or standalone schematic symbol
- t: Terminal
- w: Wire number
- #: Panel layout symbol
- # np: Panel layout nameplate reference
Move between drawings

Use Next and Previous to move among the drawings inside of the active project. A new window is opened and the original window is closed when
Next or Previous are selected unless you hold the Shift key while running the commands.

1 Open a drawing file from the active project.
2 Click Next or Previous on the Main Electrical toolbar to move to another drawing file within the project.
3 Continue moving among the drawings until the file you are looking for is opened.
4 Select Window ➤ {drawing file name} to close the drawing after you make any modifications.
   You can also close a drawing file by right-clicking the file name in the Project Manager and selecting Close from the context menu.

Plot one or more drawings
Batch plot the full drawing set or a subsection of the drawing set.

1 On the Project Manager, click the arrow on the Publish/Plot tool, and select Plot Project.
2 Select one or more drawings to plot.
3 Click OK.
4 In the Batch Plotting Options and Order dialog box, select the layout tab to plot.
5 Select the output device.
   - Use plot config (.pc3): Click to use an existing plotter configuration file (.pc3), enter the file name or click Browse to select the file.
     A plotter configuration file contains information such as the device driver and model, the output port to which the
device is connected, and various device specific settings.

- **Use layout tab’s default**: Click to use the default plotter configuration.

6. Click Detailed Plot Configuration mode to turn on or turn off the options set within the Detailed Plot Configuration Option dialog box.

7. Click ON or OFF.

8. Select the order in which the plot will be out:
   - **OK**: Output plots in the selected order.
   - **OK-Reverse**: Output plots in the reverse order.

9. Click OK to save any open drawings.

10. Click OK Project.

**Batch plotting options and order**
Batch plot the full drawing set or a subsection of the drawing set.

**Access:**

On the Project Manager, click the arrow on the Publish/Plot tool, and select Plot Project. Select the drawings to process and click OK.

**Layout tab to plot**
Selects the layout tab to plot. Change the tab by selecting from the pick list.

**(Optional) For each drawing**

- **Run a pre-plot command script file**
  Run an optional script file containing a list of commands to execute BEFORE the plot command is issued.
  The default script file name is preplot.scr, located in AutoCAD Electrical user subdirectory.
Run a post-plot command script file

Run an optional script file containing a list of commands to execute AFTER the plot command is issued. The default script file name is postplot.scr, located in AutoCAD Electrical user subdirectory.

**NOTE** Changes to drawings are not saved during the plotting process. Additionally, the plot time and date stamp text is discarded after the plot is complete. To preserve changes made during the plotting process, add the QSAVE command into the pre- or post-plot script file.

**Output device name**

A plotter configuration file contains information such as the device driver and model, the output port to which the device is connected, and various device specific settings.

- **Use plot config (.pc3)** Use an existing plotter configuration file (.pc3).
- **Use layout tab’s default** Use the default plotter configuration.

**Detailed plot configuration mode**

Turns detailed plot configuration options on or off.

- **Optional page setup name** Enter an optional page setup name when plot configuration options are turned off.
- **Pick list (from current drawing)** Select an option for the pick list when plot configuration options are turned off.

**Plot to file**

Enter a subdirectory to plot to or leave blank to plot to the subdirectory where the drawings are located.
**Order**

**OK**
Outputs plots in the selected order

**OK-Reverse**
Outputs plots in the reverse order.

---

**Create a project-wide script file**

An AutoCAD script file can be run against one or more drawings in the current project.

For example, to ensure all drawings are set to model space and zoomed extents:

1. Create an ASCII text script file called model_ext.scr.
2. Add the following AutoCAD commands and AutoLISP functions:
   - `(setq "TILEMODE" 0)`
   - `ZOOM EXT`
   - `(load "c:\myprograms\chktitle.lsp")`

**NOTE**
Double backslashes must be used.

- `CHKTITLE`
- `QSAVE`

3. Test the script for proper operation.
   - On the current drawing, issue the SCRIPT command, followed by the script file name.
   - If the script runs properly, it is ready for project-wide use.

---

**Project-wide update or retag**

Create a project-wide script file | 697
Access:

Click the arrow on the Project Manager tool to access the Project-Wide Update/Retag tool. From the Projects menu, select Project-Wide Update/Retag.

**Component Retag**

Retag all nonfixed components.

**NOTE** If Ladder References Resequence selected, the component retag process is performed after the ladder resequencing is complete.

**Component Cross-Reference Update**

Updates the cross-referencing for components on selected drawings.

**NOTE** Cross-references are updated after other options such as component retag or ladder resequencing is performed.

**Wire Number and Signal Tag/Retag**

Sets options for wire number retagging.

Click Setup to display the Wire Tagging (project-wide) dialog box. Here you can insert or update wire numbers associated with wire line networks across a project.

**Ladder References**

Renumber each ladder sequentially.

**Resequence Setup**

Defines options for starting reference numbers and how to sequence ladders from drawing to drawing.

**Renumber Ladders dialog box**

Renumbers the ladder for the selected drawings from the active project.

1. Enter the ladder reference number for the first drawing.
For all subsequent drawings:
- Select to use the next sequential reference.
- Select Skip, drawing to drawing count to enter an amount to skip for the next drawing's first ladder reference.

Bump Up or Down

Moves ladder references up if drawings have been added to the middle of a project or moves ladder references down if drawings have been removed from the project.

NOTE Enter a negative number to move ladder references down.

Sheet (%S value)

Automates resequencing the sheet value on consecutive drawings.

Resequence - Start with

Enter a number to start the resequencing.

Bump-Up/Down by

Select to move the current sheet value up or down by a given count.

Drawing (%D value)

Performs a project-wide update of the drawing's %D “DWG NAME” parameter.

Other Configuration Settings

Updates the drawing parameters related to component, cross-reference and wire tagging modes and format project-wide.

Title Block Update

Automates updating title block information for the active drawing or the entire project drawing set.
Track drawing changes

The Mark/Verify tool can help you track changes made to a project drawing set during any phase in the engineering process. Before you send your drawings out for review, use the Mark option. Each AutoCAD Electrical component, wire number, and beginning ladder reference is invisibly marked and referenced in a table in the current project's scratch database file. When the drawings are returned, you can use the Verify option to generate a report of changes. The report includes a list of all added, changed, copied, and deleted components and wire numbers. Changes made using AutoCAD, AutoCAD LT or AutoCAD Electrical are all detected.

For AutoCAD Electrical to detect if a component or wire number is deleted, it must reference the MARKVERIFY table that is saved in the project's database file. If the project database file is erased after the Mark option is run, then a subsequent Verify command cannot report deleted items since it is limited to reporting only changes involving new inserts, copies, and edited components and wire numbers.

The Verify command detects and reports changes to the following:

- Component TAG name (such as CR101 changed to CR101A)
- Description text
- Switch position text, rating values
- Beginning PLC module address value
- Terminal pin numbers (both stand-alone terminals and component pin numbers)
- Catalog number, manufacturer, assembly code value
- Location/Installation code values
- Wire numbers
- Beginning ladder reference number
- Wire Source/Destination codes
- Deleted items - Project database maintained
Track changes made to a drawing set

Use this tool to insert comments in your drawings before sending them for review. Once the drawings are returned to you, run this tool again to see any changes that were made to the drawing set.

1  Click the arrow on the Project Manager tool to access the Mark/Verify Drawings tool.

2  Click the Mark/Verify Drawings tool.

3  Specify to mark either the project or the current drawing.

4  Specify to mark AutoCAD Electrical components. You can also select:
   - Include non-AutoCAD Electrical blocks to mark all blocks even if they do not carry AutoCAD Electrical intelligence.
   - Select Include wires/lines to detect changes to any lines or wires in the drawings.

5  Click OK.

6  Enter your initials and any comments about the drawing set, and then click OK. This information (along with the current time and date) is included in later reporting.

   Invisible flags are placed on the wire numbers and component tags. These flags do not change the appearance or functioning of the drawings. However, they may increase the drawing size by a small amount.

7  After you make edits to the drawings or receive the drawings back from your client, reopen the drawings in AutoCAD Electrical so you can verify the changes.

8  Use the Mark/Verify Drawings command to report the accumulated changes made to the drawing set.

9  Specify to verify the drawings and click OK.

   A list of the detected changes is displayed in a report dialog box.
Specify to display the data in the AutoCAD Electrical report format, save the report, or print the changes. You can also select to surf through the list to examine each detected change in context.

**Mark and verify**

This tool places an invisible mark on each component before sending the drawings to a client. When the drawings are returned, a list is generated that includes any components or wire numbers that have been modified, edited, or copied.

**NOTE** This command writes information to the project database file that is used to check for deleted components. Your drawings must be named and part of the active project to use this command.

**Access:**

Click the arrow on the Project Manager tool to access the Mark/Verify Drawings tool.

From the Projects menu, select Mark/Verify Drawings.

- **Mark/verify drawing or project**
  Specifies to mark or verify the active drawing or process all drawings in the current project.

- **Mark**
  Places invisible information on all AutoCAD Electrical components including blocks not created in AutoCAD Electrical, lines, and wires.

- **Verify**
  Generates a list of changes since the drawings have been marked.

- **Remove**
  Removes all invisible mark data.

- **Previous**
  Redisplays the last check mark exception report.

- **Surf**
  Continues surfing on exceptions generated the last time the mark/verify command was used.
Translate description text

Use this to convert description or switch position component text from one language to another. When AutoCAD Electrical finishes it displays a report listing what was successfully translated and what was not. You can use this report to surf to the problem areas (where a phrase could not be translated) and make manual edits one by one.

1 Click the arrow on the Project Manager tool to access the Language Conversion tool.

2 Click the Language Conversion tool.

3 Select to run the command on the entire project, the active drawing, selected drawings, or on selected objects in the drawing.

4 Select the "From" and "To" languages to use.

5 Specify if multiple lines of the component description text are translated based on exact or partial matches.
   By default, the conversion will look for exact matches on the description labels you select with partial match as an option.

6 Click OK and the components or drawings you want to process.

**TIP** You can add more phrases to the translation table using the Edit Language Database File tool (Projects ➤ Language Conversion ➤ Edit Language Database File) and re-run the language swap to obtain more satisfactory results.

Language conversion
Translates component description text from one language to another. Description text and switch position text is processed on schematic and panel components.

Access:

Click the arrow on the Project Manager tool to access the Language Conversion tool.

From the Projects menu, select Language Conversion ➤ Language Conversion.

Run language swap on

Performs language translation on the entire project, the active drawing, selected drawings, or on selected objects in the drawing.

From To

Translates from the current language to another language.

What to do

Translates the selected item.

Translation on

Determines if multiple lines of the component description text is translated based on exact or partial matches.

NOTE By default, translation is performed on exact matches only.

Edit: language lookup file

Opens the current language table for review and modification. The default table is wd_lang1.mdb

Access:

Click the arrow on the Project Manager tool to access the Edit Language Database File tool.

From the Projects menu, select Language Conversion ➤ Edit Language Database File.

Select language

Selects a predefined language.

NOTE Language matches are NOT case sensitive, but phrase substitutions are made exactly as entered in the language table.
Add a Language  Adds a new column to the database with a blank entry for each existing phrase associated with the new language name.

Delete Language  Deletes a language from the predefined language table.

Phrase list in selected language  Displays a phrase list for the selected language.

New phrase  Adds a blank entry to the end of each language list and the translations for phrase list at the bottom of the dialog box.

Copy phrase  Adds a copy of each translation of the selected phrase to the end of each language list.

Delete phrase  Deletes all translations of the selected phrase from the database.

Translations for phrase above - Select to edit  Displays phrases from the selected language. Double-click a phrase to edit.

Publish to the web

Create a web page of selected drawings in the current project.

1  Select Projects ➤ Publish to Web.

2  In the Publish to Web dialog box, select a location to store the drawing files.

3  Select an image format.
   ■ DWF: Design web format files are vector-based representations of drawing (.DWG) files.

   **NOTE** DWF is the recommended image format as it supports intra-drawing surfing from a component tag or component description list.
- **JPEG**: Joint Photographics Experts Group files are raster-based. This format is not recommended for large files that contain text.

- **PNG**: Portable Network Graphics files are raster-based like JPEG images, but PNG provides a higher quality output.

4 Click OK.

5 Select one or more drawing to publish to the web.

- **Do All**: Selects all drawings from the project drawing list to be copied to the new project.

- **Process**: Selects one or more drawings from the project drawing list to be copied to the new project.

- **Reset**: Moves all selected drawings back to the project drawing list.

- **Un-select**: Moves one or more drawings back to the project drawing list.

- **by Section/sub-section**: Selects drawings by sections and subsections.

6 Click OK.

7 Enter a name for the project banner for the web page.

8 Enter one or more project titles for the web page.

9 Select the method to output drawing images to the web page.

10 Click OK.

11 Enter an output device name.

12 Press ENTER to select no as the default when prompted to select to write the plot to a file [Yes/No]

13 Press ENTER to select no as the default when prompted to save change to page setup [Yes/No]

14 Press ENTER to select yes as the default when prompted proceed with plot [Yes/No]

The progress of the plot job is displayed. When complete, you will be notified that the plot and publish job is complete.

**Publish to web - temporary folder for build**
Creates a Web page of selected drawings in the current project. The Web pages and associated support files are saved in the specified folder, enabling preview and testing prior to posting to the Web. If the folder does not exist, one is created.

**Access:**

On the Project Manager, click the arrow on the Publish/Plot tool, and select Publish to Web.
From the Projects menu, select Publish to Web.

**DWF**
Design Web format files are vector-based representations of drawing (.DWG) files.

**NOTE** DWF is the recommended image format as it supports intra-drawing surfing from a component tag or component description list.

**JPEG**
Joint Photographic Experts Group files are raster-based. This format is not recommended for large files that contain text.

**PNG**
Portable Network Graphics files are raster-based like JPEG images, but PNG provides a higher quality output.

**AutoCAD Electrical publish to web - banner, title text, options**

**Access:**

On the Project Manager, click the arrow on the Publish/Plot tool and select Publish to Web. Specify or create a folder location for the files to be saved and click OK. Select the drawings to process and click OK.
From the Projects menu, select Publish to Web. Specify or create a folder location for the files to be saved and click OK. Select the drawings to process and click OK.

**Banner**
Creates the text string that forms the banner for the web page. The default is the .WDP file name and its path for the current project.
Title Text
Creates the text that appears below the banner. The default is the current project’s first four project description LINEX values.

Layout to output
Creates the drawing images using the AutoCAD Plot to DWF function. The plot mode can be Model, Layout1, or As Saved.

Configuration name
Uses the plot configuration file for generating the .DWF drawing images.

NOTE To override, set WD_DWF_PC3 in the wd.env environment settings file.

Build intra-drawing surf pick lists
Automates the surf and zoom capabilities on components on the drawing image displayed on the Web. Intra-drawing surfing is available once the page creation process is complete.

NOTE This option slows the .DWF plotting process.

Allow drag and drop
Copies the .DWG files or creates .DXF file copies of the drawings and posts them on the Web page. You can drag these files from the Web page into an AutoCAD session.

Use drawing title blocks
If your existing drawing title block consists of an AutoCAD block with attributes, AutoCAD Electrical can be linked into it for automated, project-wide title block updates. The AutoCAD Electrical project-wide information lines and the AutoCAD Electrical per-drawing values can be mapped to attributes on your existing title block. You can create project-specific mapping files. AutoCAD Electrical always looks for a mapping file that matches the current project’s .wdp file name before it defaults to DEFAULT.WDT. For example, if the active project is ACME99.WDP and you instruct AutoCAD Electrical to do a title block update, AutoCAD Electrical looks for mapping file ACME99.WDT.
If not found, AutoCAD Electrical then looks for DEFAULT.WDT (if not found, AutoCAD Electrical aborts the command).

**Title block attributes**

When you instruct AutoCAD Electrical to do a project-wide title block update, AutoCAD Electrical reads this attribute mapping file. Attributes on title block are mapped to AutoCAD Electrical project data lines and several AutoCAD Electrical settings values. Each one of the drawing values has a code that is entered into your title block setup which assigns that value to a specific attribute. The form of each mapping line below is either `<attribute name> = LINEx`, where "x" is a project data line number (for example, LINE1) or `<attribute name> = xx` where "xx" can be any of these:

- **SHEET**: sheet number value (the %S value)
- **SHEETMAX**: number of drawings in the active project (the "N" value in title block “SHEET x of "N")
- **DWGNAM**: drawing name value (the %D value)
- **DD1 (or DWGDESC), DD2, DD3**: the drawing descriptions assigned in the Project Description dialog box
- **DWGSEC**: optional section code assigned in the Project Description dialog box
- **DWGSUB**: optional Subsection code assigned in the Project Description dialog box
- **FILENAME**: filename without path or extension
- **FULLFILENAME**: filename with path and extension
- **FILENAMEEXT**: file name with .dwg extension only
- **IEC_P**: drawing’s IEC Project value
- **IEC_I**: drawing’s installation value
Example: your title block has attributes SH for the sheet number and DSTAMP for a plot date stamp and TSTAMP for a plot time stamp value. It also has attributes T1 and T2 for title lines and attribute CUSTOMER for the customer text, all of which come from the project’s first 3 defined description lines. Include these mapping entries:

T1 = LINE1
T2 = LINE2
CUSTOMER = LINE3
SH = SHEET
DSTAMP = PLOTDATE
TSTAMP = PLOTTIME

This "xx" value can also be any fixed text within quotes, such as DRAWNBY = "Joe Engineer"

**NOTE** If the title block’s target attribute tag name contains one or more wild card characters (# @ . * ? ~ [ ] - ) the name must be preceded by a backwards apostrophe char (Example: '[REV] = LINE5, where title block attribute name is [REV])

**Use multiple title blocks**

If your title block/revision block consists of multiple blocks, you can encode 2 or more block names into the ".wdt" file. You can even encode wildcards.
into the block name that AutoCAD Electrical searches for. For example, the following line encoded in the ".wdt" file triggers AutoCAD Electrical to look for and update not only a block called "TB" but also two other blocks.

\[ \text{BLOCK} = \text{TB, TB-REV, TB-ISSUE} \]

You can also use wild-cards to define title blocks. Your drawing could have any of 3 different title block sizes, perhaps named TITLE-SIZEB, TITLE-SIZEC, or TITLE-SIZED. The following line encoded in the ".wdt" file triggers AutoCAD Electrical to find and update the title block no matter what size is used on the drawing.

\[ \text{BLOCK} = \text{TITLE-SIZE*} \]

**Set up multiple descriptions**

Prior to AutoCAD Electrical 2007 only one description line was allowed per drawing in the project file. One method to map this information to multiple attributes is to set up the "attrname=DWGDESC" entry in the ".wdt" file to be in this form: \( \text{attrname1|attrname2|attrname3=DWGDESC} \) using the "|" character between the target attribute names. Then, in the DWGDESC value in the Project Description dialog box, delimit the DWGDESC value with "|" at the break points.

For example, if your title block has 3 description attributes, TITLE-1, TITLE-2, and TITLE-3 and you want the text entered into the AutoCAD Electrical project DWGDESC entry split across these three attributes. Set up your ".wdt" title block mapping file with this entry: \( \text{TITLE-1|TITLE-2|TITLE-3=DWGDESC} \). Now, in the AutoCAD Electrical Project Descriptions dialog box, split the drawing's DWGDESC description text into 3 pieces using "|" delimiters (for example, "Main cabinet|120VAC|PLC I/O"). The AutoCAD Electrical Update Title Block command then splits this string of text across the three title block attributes.

**NOTE** The Title Block Setup command does not support this method. You will need to use a text editor, such as Notepad, to manually edit your ".wdt" file.

As of AutoCAD Electrical 2007, 3 description lines are supported per drawing in the project file. An easier way to map multiple descriptions (up to 3) to multiple attributes is to use the Title Block Setup command (Projects > Title Block Setup). In the Setup Title Block Update dialog box, specify the title block link method, enter a block name, and click OK. In the Title Block Setup dialog box, click Drawing Values. Select an attribute to use for Drawing Description 1 through 3 and click OK.
Update the title block project-wide

1. Click the Project Manager tool.

2. In the Project Manager, right-click the project name, and select Descriptions.
   A list of the current values for the project-wide LINEx values displays.

3. Change values for the title, job number, date, scale, or other description attributes.

4. Click OK.

5. In the Project Manager, right-click the project name, and select Title Block Update.
   The Update Title Block dialog box displays. You can identify the data lines you want to write out to each title block in your project.

6. Select the values that need to be updated on the title block, along with SHEET and SHEETMAX if new drawings have been added to your project.

   NOTE If you want to save these selections, click Save. The settings are stored in the default.wdu file.

7. (Optional) Select Resequence sheet %S value.
   This renumbers the sheet values and changes the sheet max value. This is commonly used when drawings are added to the project drawing set.

8. Click OK Project-Wide.

9. Select to process all of the drawings in the project and click OK.
   AutoCAD Electrical calls up each drawing, finds the drawing’s title block, and makes the changes to the attribute names mapped to the values you selected, SHEET, and SHEETMAX. It also resequences the SHEET values as it goes.

Update title block
Automates updating title block information for the current drawing or the entire project drawing set. Project and drawing specific settings are linked to one or more attributes contained in the title block.

This tool assumes that you have a border with mapped attributes using the .wdt file or a mapping attribute file (WD_TB) inside of the border. This specifies which attribute on the border should be updated with text from the Update Title Block dialog box. The text in this dialog box comes from right-clicking on the project name in the Project Manager and selecting Descriptions.

The prompt text for each line is controlled by the default_wdtitle.wdl file or _wdtitle.wdl file if you placed one in the project folder. If AutoCAD Electrical can’t find a _wdtitle.wdl file in the project folder, it looks for the default_wdtitle.wdl file in the User folder.

Access:

Click the Project Manager tool. Right-click the project name and select Title Block Update.

From the Projects menu, select Project ➤ Project Manager. Right-click the project name and select Title Block Update.

**Select Lines to Update (Project Description Lines)**

Lists project-wide LINE1 through LINExx values.

LINE1-LINE9 values are as follows:

- **LINE1**: Title 1
- **LINE2**: Title 2
- **LINE3**: Title 3
- **LINE4**: Job Number
- **LINE5**: Date
- **LINE6**: Engineer
- **LINE7**: Drawn By
Select Lines to Update (these are per-drawing values)

Lists drawing-specific values.

**Drawing Description**
The drawing descriptions in the project. Up to 3 drawing descriptions can be added to a drawing. The drawing description codes DD1 (or DWGDESC), DD2 and DD3 are used for the 3 description lines.

**Drawing Section**
The drawing sections in the project.

**Drawing Sub-section**
The drawing subsections in the project.

**Filename**
The file name without an extension.

**File/extension**
The file name with the appropriate extension.

**Full Filename**
The full file name and the pathname where the file is located.

**P**
The project value for the drawing.

**I**
The installation value for the drawing.

**L**
The location value for the drawing.

**Drawing (%D value)**
The %D value of the drawing settings.

**Sheet (%S value)**
The %S value of the drawing settings.

**Sheet maximum**
The maximum count of drawings in the project.
Resequence sheet %S values

Renumber the sheet number for each drawing in the project set or for a selected portion of the project drawing set.

Activate each drawing to process

Specifies to activate every drawing so you can update the title block lines on selected drawings in the project.

OK Active Drawing Only

Updates the text for the selected lines on the active drawing only.

OK Project-wide

Updates the text for the selected lines on the selected drawings in the project.

Setup title block update

Automates updating title block information for the active drawing or the entire project drawing set. Project and drawing-specific property settings are linked to one or more attributes contained in the title block.

The link between AutoCAD Electrical and the title block is defined by either an external text file (.wdt) or by an invisible WD_TB attribute added to your existing title block. If the WDT method is used, you can use a project-specific file or the Default.wdt file. In either case, the title block attribute names are mapped to the project-wide LINEx values and to several drawing-specific setting values.

Access:

From the Projects menu, select Title Block Setup.

Method 1

Project.wdt

Create a project-specific mapping file that only references for drawings in the current project. The file name is the same as the project name with a .wdt extension.
Create a default mapping file in the project's subdirectory that is referenced if a project-specific file is not found and if a WD_TB attribute is not present in the title block.

Method 2

The title block contains an invisible attribute with a value that defines the mapping between the title block and AutoCAD Electrical. No external WDT file is required because the mapping information is self-contained on the title block.

The attribute name = WD_CODE mapping information is encoded on the WD_TB attribute on the title block of the drawing. The attribute's value gives the mapping information in the format of a semi-colon delimited text string. For example:

TITLE-1=LINE1;TITLE-2=LINE2;SH=SHEET;SH_TOTAL=SHEET_MAX

where project wide values for LINE1 and LINE2 codes update attributes TITLE-1 and TITLE-2. The %S sheet value is copied to the title block attribute SH, and the number of drawing files in the project is written out to attribute SH_TOTAL.

Title block setup

Defines attribute mappings. The lines that follow the title block name list the attribute names on that block and what pieces of AutoCAD Electrical project data or drawing specific data that AutoCAD Electrical should copy to that attribute.

Access:

From the Project menu, select Title Block Setup. Specify the title block link method, enter a block name, and click OK.

Title block name

Lists the available title block names.
**Add New**

Adds new title blocks to the project. Enter a block name. For multiple blocks, separate with a comma. For example, DEMOTBLK, DEMOTBLK2, DEMOTBLK3

**Edit**

Edits the selected title block.

**Remove**

Removes the selected title block.

**Pick on**

Selects an attribute directly on the drawing if you do not know the name of attribute.

**Attribute**

Specifies the attribute to use for the drawing, project, or plotting value. Select an attribute from the list.

**Project Values / Drawing Values / Plotting Values**

Displays the project, drawing-specific and plotting values.

**User Defined**

Maps attributes to text constants or AutoLISP values.

---

**Title block setup (user-defined)**

Assigns text constants and AutoLISP expressions to a title block attribute.

**Access:**

From the Project menu, select Title Block Setup. Specify the title block link method, enter a block name, and click OK. Click User Defined on the Title Block Setup dialog box.

**Current User-Defined Assignments**

Lists the attributes and assigned text constant or AutoLISP expression.

**Attributes**

Modify an existing link by selecting it from the attribute list. To clear an existing link, select -none- from the attribute list.

**Text constant or AutoLISP expression**

Enter a text constant or an AutoLISP expression to assign to the attribute. For example, you can assign...
(getvar LOGINNAME) to attribute DWGBY, or you can assign YourName to DWGBY.

**Update list**

Adds the text constant or AutoLISP expression to the user-defined list.

## Link information to the title block

You can link some AutoCAD Electrical project description data entries and some of the AutoCAD Electrical drawing values to the attributes that appear in the drawing title blocks. There are 2 methods to do this: using an attribute mapping file and mapping information embedded on the title block.

### Link values using an attribute mapping file

A text file, DEFAULT.WDT, defines what AutoCAD Electrical values are mapped to the drawing title block attributes. Use any text editor to create or edit file default.wdt:

- **BLOCK = TITLE**
- **PROJ_TITLE = LINE1**
- **DRAW_TITLE1 = LINE2**
- **DRAW_TITLE2 = DWGDESC**
- **PROJ_NUM = LINE4**
- **STATUS = LINE5**
- **STATUS_DATE = LINE6**
- **REV = LINE7**
- **SX = SHEETMAX**
- **SH = SHEET**
- **PLOTTIME = PLOTTIME**
- **PLOTDATE = PLOTDATE**

When you instruct AutoCAD Electrical to do a project-wide title block update, AutoCAD Electrical reads this mapping file. The "BLOCK = " entry tells AutoCAD Electrical the AutoCAD block name of the title block. The lines that follow list the attribute names on that block and what pieces of AutoCAD...
Electrical project data or drawing specific data that AutoCAD Electrical should copy to that attribute. The PLOTTIME and PLOTDATE entries also appear in this file but they are used only by the AutoCAD Electrical batch plotting routine.

You can include other non-AutoCAD Electrical-mapped attributes as well in this mapping file. For example, the line

DRAWN_BY = "Joe Doe"

This triggers AutoCAD Electrical to look for an attribute named "DRAWN_BY" and, if found, insert a value of "Joe Doe." If your target attribute name contains an AutoLISP wild-card character such as #, ?, [, ], @, ~, ., or * then you'll need to precede that character with the ` character. For example, if your target attribute name is SHT# and you want to map the AutoCAD Electrical SHEET parameter to it, you would set up the mapping with

SHT# = SHEET

You can create project-specific mapping files. AutoCAD Electrical always looks for a mapping file that matches the current project's .wdp file name before it defaults to DEFAULT.WDT. For example, if the current, active project is ACME99.WDP and you instruct AutoCAD Electrical to do a title block update, AutoCAD Electrical looks for mapping file ACME99.WDT. If not found, AutoCAD Electrical then looks for DEFAULT.WDT (and if not found, AutoCAD Electrical aborts the command).

Map information embedded on the title block

An invisible attribute on your drawing's title block, named "WD_TB," can be encoded with the mapping information. This method eliminates the need for an external mapping text file. When you instruct AutoCAD Electrical to do a project-wide title block update, AutoCAD Electrical first searches each drawing for any block that carries an attribute named WD_TB. If found, AutoCAD Electrical assumes that it has found the drawing's title block and skips any search for a .wtd file. AutoCAD Electrical extracts the WD_TB attribute value where the mapping information is stored. The format is <attribute name>=<LINEx>;<attribute name>=<LINEx>. Here is an example of what the WD_TB attribute value would be:

PROJ_TITLE=LINE1;DRAWN_TITLE1=LINE2;DRAWN_TITLE2=DWGDESC;PROJ_NUM=LINE4
Customize LINEx labels

The generic LINEx labels that display in the various title block and project description dialog boxes can be customized to match the field names in your title block.

1. Create a file called either projname_wdtitle.wdl or default_wdttitle.wdl in the project subdirectory. Use any generic text editor like Notepad or Wordpad.

2. The file should contain one line per label in the format LINEx=label. The entries do not have to be in order and line numbers may be skipped.
   - LINE1 = Project Title 1
   - LINE2 = Title 2
   - LINE3 = Title 3
   - LINE4 = Project Number
   - LINE5 = Date
   - LINE6 = Engineer
   - LINE7 = Drawn By
   - LINE8 = Checked By
   - LINE9 = Scale

3. Save and exit the ASCII text file.

4. Open AutoCAD and test.

Search sequence for .wdl files

You may create different .wdl files for different projects. The search sequence is as follows:

1. Look in the same directory as the project's .WDP file for a file called PROJNAM_WDTITLE.WDL

2. Look in the same directory as the project's .WDP file for a file called DEFAULT_WDTITLE.WDL

3. If WD_ACADPATHFIRST flag is present in wd.env file, look for DEFAULT_WDTITLE.WDL in ACAD paths

4. Look for DEFAULT_WDTITLE.WDL in the AutoCAD Electrical USER directory
If WD_SUP_ALT is defined in the wd.env file, look for DEFAULT_WDTITLE.WDL in the specified path.

Look for DEFAULT_WDTITLE.WDL in base AutoCAD Electrical directory.

Look for DEFAULT_WDTITLE.WDL in ACAD paths (if WD_ACADPATHFIRST flag isn’t set in wd.env)

Map a title block

Create a mapping for the title block.

1. From the Projects menu, select Title Block Setup.
2. Select the title block link method:
   - **Method 1**: Text mapping file with .WDT extension.
   - **Method 2**: Mapping is defined by an invisible attribute contained in the title block.
3. Click OK.
   - If the .WDT file exists:
     - Click View to view and edit the file.
     - Click Overwrite to create a new file.
     - Click Edit to modify the existing file.

   **NOTE** If no existing file is found, you must identify the title block’s AutoCAD block name.

4. In the Title Block Setup dialog box, select the attribute from each list to map to its corresponding AutoCAD Electrical value.
5. Click Drawing Values to assign drawing specific and plotting values.
6. Click User Defined to map attributes to text constants or AutoLISP values.
7. Click OK.

Setup title block update

Automates updating title block information for the active drawing or the entire project drawing set. Project and drawing-specific property settings are linked to one or more attributes contained in the title block.
The link between AutoCAD Electrical and the title block is defined by either an external text file (.wdt) or by an invisible WD_TB attribute added to your existing title block. If the WDT method is used, you can use a project-specific file or the Default.wdt file. In either case, the title block attribute names are mapped to the project-wide LINEx values and to several drawing-specific setting values.

Access:

From the Projects menu, select Title Block Setup.

**Method 1**

**Project.wdt**
Create a project-specific mapping file that only references for drawings in the current project. The file name is the same as the project name with a .wdt extension.

**DEFAULT.WDT**
Create a default mapping file in the project's subdirectory that is referenced if a project-specific file is not found and if a WD_TB attribute is not present in the title block.

Method 2

The title block contains an invisible attribute with a value that defines the mapping between the title block and AutoCAD Electrical. No external WDT file is required because the mapping information is self-contained on the title block.

The attribute name = WD_CODE mapping information is encoded on the WD_TB attribute on the title block of the drawing. The attribute's value gives the mapping information in the format of a semi-colon delimited text string. For example:

```
TITLE-1=LINE1;TITLE-2=LINE2;SH=SHEET;SH_TOTAL=SHEET_MAX
```

where project wide values for LINE1 and LINE2 codes update attributes TITLE-1 and TITLE-2. The %S sheet value is copied to the title block attribute SH, and the number of drawing files in the project is written out to attribute SH_TOTAL.
**Title block setup**

Defines attribute mappings. The lines that follow the title block name list the attribute names on that block and what pieces of AutoCAD Electrical project data or drawing specific data that AutoCAD Electrical should copy to that attribute.

**Access:**

From the Project menu, select Title Block Setup. Specify the title block link method, enter a block name, and click OK.

<table>
<thead>
<tr>
<th>Title block name</th>
<th>Lists the available title block names.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add New</td>
<td>Adds new title blocks to the project. Enter a block name. For multiple blocks, separate with a comma. For example, DEMOTBLK, DEMOTBLK2, DEMOTBLK3</td>
</tr>
<tr>
<td>Edit</td>
<td>Edits the selected title block.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the selected title block.</td>
</tr>
<tr>
<td>Pick on</td>
<td>Selects an attribute directly on the drawing if you do not know the name of attribute.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Specifies the attribute to use for the drawing, project, or plotting value. Select an attribute from the list.</td>
</tr>
<tr>
<td>Project Values / Drawing Values / Plotting Values</td>
<td>Displays the project, drawing-specific and plotting values.</td>
</tr>
<tr>
<td>User Defined</td>
<td>Maps attributes to text constants or AutoLISP values.</td>
</tr>
</tbody>
</table>

**Title block setup (user-defined)**
Assigns text constants and AutoLISP expressions to a title block attribute.

Access:

From the Project menu, select Title Block Setup. Specify the title block link method, enter a block name, and click OK. Click User Defined on the Title Block Setup dialog box.

Current User-Defined Assignments

Lists the attributes and assigned text constant or AutoLISP expression.

Attributes

Modify an existing link by selecting it from the attribute list. To clear an existing link, select -none- from the attribute list.

Text constant or AutoLISP expression

Enter a text constant or an AutoLISP expression to assign to the attribute. For example, you can assign (getvar LOGINNAME) to attribute DWGBY, or you can assign YourName to DWGBY.

Update list

Adds the text constant or AutoLISP expression to the user-defined list.

Map AutoLISP values to the title block

You can vector to the title block system variable values or values extracted by AutoLISP programs. For example, let's say that your system's environment variable "USERNAME" contains a value that must show up on the drawing title block. You set up your default.wdt file to map the AutoCAD Electrical "LINE12" value to attribute "DWGBY" on your standard title block. Now you want to automatically have LINE12 point at the USERNAME environment variable so that, during title block update, the USERNAME value goes to LINE12 which, in turn, sends it on to the "DWGBY" attribute on the title block. Encode the AutoLISP (getenv "") function into the LINE12 value for your current project description data.

Now when you run the Title Block update, make sure that LINE12 is selected. During the update AutoCAD Electrical evaluates the expression (getenv "USERNAME"), retrieves the environment value, and writes that value out to
the attribute that is mapped to LINE12 (mapped in the .wdt file or on the WD_TB attribute value carried by the title block).

NOTE If the expression is a full AutoLISP function, it must return a string value (not an integer, real, list, or nil value). The program must be encoded into the project description data as "(load 'filename.lsp)." It must be self-starting upon load.

Setup title block update

Automates updating title block information for the active drawing or the entire project drawing set. Project and drawing-specific property settings are linked to one or more attributes contained in the title block.

The link between AutoCAD Electrical and the title block is defined by either an external text file (.wdt) or by an invisible WD_TB attribute added to your existing title block. If the WDT method is used, you can use a project-specific file or the Default.wdt file. In either case, the title block attribute names are mapped to the project-wide LINEx values and to several drawing-specific setting values.

Access:

From the Projects menu, select Title Block Setup.

Method 1

**Project.wdt**

Create a project-specific mapping file that only references for drawings in the current project. The file name is the same as the project name with a .wdt extension.

**DEFAULT.WDT**

Create a default mapping file in the project's subdirectory that is referenced if a project-specific file is not found and if a WD_TB attribute is not present in the title block.

**DEFAULT.WDT**

Create a default mapping file in the default AutoCAD Electrical subdirectory that is referenced if a project-specific file is not found and if a WD_TB attribute is not present in the title block.
**Method 2**

The title block contains an invisible attribute with a value that defines the mapping between the title block and AutoCAD Electrical. No external WDT file is required because the mapping information is self-contained on the title block.

The attribute name = WD_CODE mapping information is encoded on the WD_TB attribute on the title block of the drawing. The attribute's value gives the mapping information in the format of a semi-colon delimited text string. For example:

```
TITLE-1=LINE1;TITLE-2=LINE2;SH=SHEET;SH_TOTAL=SHEET_MAX
```

where project wide values for LINE1 and LINE2 codes update attributes TITLE-1 and TITLE-2. The %S sheet value is copied to the title block attribute SH, and the number of drawing files in the project is written out to attribute SH_TOTAL.

### Title block setup

Defines attribute mappings. The lines that follow the title block name list the attribute names on that block and what pieces of AutoCAD Electrical project data or drawing specific data that AutoCAD Electrical should copy to that attribute.

**Access:**

From the Project menu, select Title Block Setup. Specify the title block link method, enter a block name, and click OK.

<table>
<thead>
<tr>
<th>Title block name</th>
<th>Lists the available title block names.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add New</td>
<td>Adds new title blocks to the project. Enter a block name. For multiple blocks, separate with a comma. For example, DEMOTBLK,DEMOTBLK2,DEMOTBLK3</td>
</tr>
<tr>
<td>Edit</td>
<td>Edits the selected title block.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the selected title block.</td>
</tr>
<tr>
<td>Pick on</td>
<td>Selects an attribute directly on the drawing if you do not know the name of attribute.</td>
</tr>
</tbody>
</table>

726 | Chapter 11  Project-Wide Tools
**Attribute**
Specifies the attribute to use for the drawing, project, or plotting value. Select an attribute from the list.

**Project Values / Drawing Values / Plotting Values**
Displays the project, drawing-specific and plotting values.

**User Defined**
Maps attributes to text constants or AutoLISP values.

---

**Title block setup (user-defined)**
Assigns text constants and AutoLISP expressions to a title block attribute.

**Access:**
From the Project menu, select Title Block Setup. Specify the title block link method, enter a block name, and click OK. Click User Defined on the Title Block Setup dialog box.

**Current User-Defined Assignments**
Lists the attributes and assigned text constant or AutoLISP expression.

**Attributes**
Modify an existing link by selecting it from the attribute list. To clear an existing link, select -none- from the attribute list.

**Text constant or AutoLISP expression**
Enter a text constant or an AutoLISP expression to assign to the attribute. For example, you can assign (getvar LOGINNAME) to attribute DWGBY, or you can assign YourName to DWGBY.

**Update list**
Adds the text constant or AutoLISP expression to the user-defined list.
Icon Menus

In this chapter

- Overview of the Icon Menu Wizard
- Use alternate icon menus
- Modify Icon Menu File Directly
Overview of the Icon Menu Wizard

Use the Icon Menu Wizard to easily customize the icon menus. You can copy, cut, and paste icons from one submenu into another, drag icons within the Symbol Preview window to place those that are commonly used at the top and those that are used less frequently at the bottom of the window, and create new icons to use when inserting components.

Once you click OK in any of the Add Icon dialog boxes, the following happens:

- The new icon is created and saved depending on the status of the WD_SLB code in the environment file (.env).
  If WD_SLB is disabled in the environment file, the Images folder of the corresponding icon menu .dat file is created (if it does not already exist) and new images are saved here. (C:\Documents and Settings\{username}\Application Data\Autodesk\AutoCAD Electrical\{release number}\{country code}\Support\Images). If you browsed to an existing image, the image is copied to the Images folder.
  If WD_SLB is enabled, the Images folder corresponding to the folder defined by the WD_SLB is created (if it does not already exist) and new images are saved here. If the WD_SLB value is “N:\Electrical\Menu” then the folder N:\Electrical\Menu\Images is created and used. If you browsed to an existing image, the image is copied to the Images folder.

  **NOTE** You can enclose the image path within quotation marks if you do not want the images copied to the Images folder. The .dat file saves the absolute path instead. For example, if the image file edit box contains “C:\Desktop\push_button.png,” then the push_button.png is not copied to the Image folder.

- The new icon is added to the end of the existing icon images in the Symbol Preview window of the Icon Menu Wizard dialog box.

- The relative path of the new icon information is written to the .dat file once you click OK in the Icon Menu Wizard dialog box. However, the complete path of the block or circuit is saved in the .dat file if the Block Name edit box or the File name edit box contains the complete path of the drawing file.

**Add or modify icons using the icon menu wizard**

The Icon Menu Wizard can be used to add or modify icons for both the schematic and panel symbol libraries. You can add new menu pages to the
AutoCAD Electrical icon menu, and then populate them with your own custom symbols. Each new page can have icon selections that cascade down to other new menu pages.

Use this dialog box to add an icon that is then used for inserting components or circuits onto the drawing, running an AutoCAD Electrical command, or opening a submenu page to the icon menu. You can also change the properties of existing icons.
Add a new icon to the menu

1. Create your new AutoCAD Electrical compatible library symbol. For schematic symbols, follow the guidelines regarding the symbol "dwg" file naming convention and required attributes.

2. Click the arrow on the Miscellaneous tool to access the Icon Menu Wizard tool.

3. Click the Icon Menu Wizard tool.

4. On the Select Menu File dialog box, select the menu file (.dat) to modify and click OK.

5. On the Icon Menu Wizard dialog box, select Add ➤ Component to add a new icon to the menu. You can alternately select Command, New Circuit, Add Circuit or New Submenu depending on which type of icon you want to add.
   - Component: Adds an icon that inserts a component into the drawing.
   - Command: Adds an icon that runs an AutoCAD Electrical command when selected.
   - New Circuit: Creates a new circuit and adds the icon (that is created from a new circuit) that inserts the circuit into the drawing.
   - Add Circuit: Adds an icon (created from an existing circuit) that inserts the circuit into the drawing.
   - New Submenu: Adds an icon that opens a submenu page when selected. You can then select an icon from the submenu to insert the specified component into the drawing or run an AutoCAD Electrical command.

6. On the Add Icon - Component dialog box, define the required information (such as symbol file name, image file, and block name) for the icon menu button. To select the icon's image file, enter text, click Browse to select an existing image file, click Pick to select a block from the active drawing (the block name then appears in the Image File edit box), or click Active to select the active drawing to use as the icon image file name.
The icon options to define differ depending on which type of icon you are adding to the menu file (.dat).

7 Click OK.
The new icon displays at the bottom of the Symbol Preview window.

8 On the Icon Menu Wizard dialog box, click OK.

9 Click Components ➤ Insert Component. On the Insert Component dialog box, select the new icon.

**Edit the properties of an existing icon in the menu**

1 Create your new AutoCAD Electrical compatible library symbol. For schematic symbols, follow the guidelines regarding the symbol ".dwg" file naming convention and required attributes.

2 Click the arrow on the Miscellaneous tool to access the Icon Menu Wizard tool.

3 Click the Icon Menu Wizard tool.

4 On the Select Menu File dialog box, select the menu file to modify and click OK.

5 On the Icon Menu Wizard dialog box, right-click the icon to edit and select Properties.

6 On the Properties - Component (Command, Circuit or Sub-menu) dialog box, edit the required information (such as symbol file name, image file, and block name) for the icon menu button. To select the icon’s image file, enter text, click Browse to select an existing image file, click Pick to select a block from the active drawing (the block name then appears in the Image File edit box), or click Active to select the active drawing to use as the icon image file.

The icon options to define differ depending on which type of icon you are editing.
Click OK.

**Icon menu wizard**

Use this to modify the icon menu. You can rearrange icons using drag and drop in the Symbol Preview window, add icons, create new submenus, delete icons, cut/copy/paste icons, and modify icon properties.

**Access:**

Click the arrow on the Miscellaneous tool to access the Icon Menu Wizard tool. Click Components ➤ Symbol Library ➤ Icon Menu Wizard.

**NOTE** You can lock the icon menu (.dat) file using the Windows File Properties dialog box so unauthorized users cannot make modifications to the .dat file. In the Windows File Properties dialog box, set the file attributes to Read-only.

**Menu**

The tree structure is created by reading the icon menu file (.dat). The displayed nodes are based on the order of arrangement of submenus defined in the .dat file.

**Tabs**

- **Menu:** Changes the visibility of the Menu tree view.
- **Up one level:** Displays the menu that is one level before the current menu in the Menu tree view.
- **Views:** Changes the view display for the Symbol Preview window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.
- **Add:** Modifies the icon menu by adding icons for commands, components or circuits or add a new sub-menu.

**Symbol Preview window**

Displays the symbol images corresponding to the menu or the submenu selected in the Menu section. You can drag icons within the Symbol Preview window for re-arrangement (multiple selection is allowed) such as placing commonly used icons at the top and rarely used icons at the bottom of the window.
NOTE When you move the cursor over an icon, the icon name and block/circuit/command name display as tooltip information.

Right-click menus

Options for the Menu tree structure view

Right-click a menu or submenu in the Menu tree structure view to display the following options:

■ Expand/Collapse: Toggles the visibility of the menus.

■ New submenu: Creates a new submenu in the tree structure and the Symbol Preview window.

■ Cut: (available for submenus only) Removes the selected submenu and its contents from the list. You can then paste the submenu into another submenu or a main menu.

   NOTE The menu number does not change during a Cut and Paste. For example, if you cut menu number 100 and paste it into another submenu page, the pasted menu page is still menu number 100.

■ Copy: (available for submenus only) Makes a copy of the highlighted submenu and stores it in the Paste clipboard. You can then paste the submenu and its contents into another submenu or a main menu.

   NOTE A new menu number is created for the pasted submenu. The next available menu number (greater than 99) is assigned.

■ Paste: Adds the copied or cut submenu to the highlighted menu or submenu.

■ Delete: (available for submenus only) Deletes the submenu and all related content.

■ Properties: Opens a Properties dialog box to modify the existing menu or submenu properties like the menu name, image or submenu title. The existing data in the *.dat file is overwritten with your changes once you click OK.

Options for the Symbol Preview window
Right-click an icon or in empty space in the Symbol Preview window to display the following options:

- **View**: Changes the view display for the Symbol Preview window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.

- **Add icon**: Adds new icons (component, command, or circuit) or adds an existing circuit into the Symbol Preview window.

- **New submenu**: Creates a new submenu in the Symbol Preview window and the tree structure.

- **Cut**: Removes the selected icon from the Symbol Preview window. You can then paste the icon into the desired submenu.

- **Copy**: Makes a copy of the highlighted icon and stores it in the Paste clipboard. You can then paste the icon into the appropriate submenu.

- **Paste**: Adds the copied or cut icon to the highlighted submenu.

- **Delete**: Deletes the icon.

- **Properties**: Opens a Properties dialog box to modify the existing symbol icon properties like the icon name, image or block names. The existing data in the *.dat file is overwritten with your changes once you click OK.

### Add icon - component

The icon name and symbol block name are saved in the active *.dat file (such as ACE_JIC_MENU.DAT) once you click OK on the Icon Menu Wizard dialog box. The icon then displays at the end of the existing icon images in the Symbol Preview window of the Insert Component dialog box. The icon displays at the end of the existing icon images in the Symbol Preview window of the Insert Component dialog box.

#### Access:

Click the arrow on the Miscellaneous tool to access the Icon Menu Wizard tool. Select the menu file to modify and click OK. In the Icon Menu Wizard dialog box click Add and then select Component.

Click Components ➤ Symbol Library ➤ Icon Menu Wizard. Select the menu file to modify and click OK. On the Icon Menu Wizard dialog box click Add and then select Component.

You can also access this dialog box by right-clicking in the Symbol Preview window of the Icon Menu Wizard dialog box and selecting Add Icon ➤ Component.
TIP To determine which *.dat file is active, in the Project Properties dialog box, Project Settings tab, Library and Icon Menu Paths section, expand the Schematic Icon Menu File option. This is the schematic icon menu file listed in the *.wdp file.

Icon Details

Defines the icon name and image.

**Preview**

Displays an image preview of the specified image file.

**Name**

Specifies the name to appear in the icon, the description text and the tool tip for the icon.

**Image file**

Specifies the image file to use for the new icon. You can enter the image file name (or complete path) or select it using one of the following methods:

- **Browse**: Finds an existing image to use for the icon. You can browse for .sld or .png images.
- **Pick**: Selects an existing block name on the current drawing to use as the image file name. For example, if you select block HPB11, the image file name edit box displays “HPB11.”
- **Active**: (This is unavailable if the drawing is a new drawing and has not been saved) Selects the active drawing name to use as the Image file. For example, if the active drawing name is “demo005,” then the image file edit box has “demo005” listed as the file name.

The browsed image is copied to the Images folder and saved as a relative path in the .dat file. However, you can enclose the image path in quotation marks if you do not want the image copied to the Images folder and to save the complete path instead of the relative path in the .dat file. The entered image file name can be names like “PB1” or “CONTROL RELAY,” file names with an extension such as “pb1.png,” or it can follow the syntax (slide_library or dll file (slide or .png)). For example, “S2(pb)” or “S7(control_relay).”
NOTE The image file name cannot contain invalid characters such as \\;*:<>| and only .png and .sld image files are supported.

Create PNG from current screen image

Creates the .png image file from the current screen image. If the specified image file does not exist, this option is selected by default. If you do not want to create the icon from the current drawing's displayed image, deselect the check box.

NOTE This option is unavailable if you enter an image file name with the syntax {slide_library or dll file (slide or .png)} For example, “S2(pb)” or “S7(control relay)”. It is also unavailable if the Image File edit box contains the image file path instead of the image file name.

Zoom

(Available only when Create PNG from current screen image is selected.) Zooms in on the current screen image using the AutoCAD Pan command. Once you exit Pan mode and press Enter, the dialog box redisplayed so you can finish defining the new icon.

Location

(This appears once the Image file is specified.) Indicates the full path of the image file location where the new images are created or the browsed images are copied to. If you entered a file name with the syntax {slide_library or dll file (slide or .png)} for the image file, the path of the .dat file or the WD_SLB folder displays here.

738 | Chapter 12  Icon Menus
**Block Name to Insert**

Defines the symbol block that is inserted when you click the icon in the Insert Component dialog box.

<table>
<thead>
<tr>
<th>Block Name</th>
<th>Specifies the symbol block name. The symbol's file name can be typed into the edit box or you can enter it using one of the following methods:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>■ Browse: Finds an existing WBlocked drawing (*.dwg) file to assign to the icon. In this case the complete path of the drawing file is inserted in the edit box.</td>
</tr>
<tr>
<td></td>
<td>■ Pick: Selects an existing block on the current drawing (for example, block recently created with Symbol Builder). WBlocked version (.dwg) needs to exist.</td>
</tr>
<tr>
<td></td>
<td>■ Active: Inserts the active drawing as a block.</td>
</tr>
</tbody>
</table>

**Add icon - command**

An icon can be configured to trigger an AutoCAD command, trigger an AutoCAD Electrical command, or run a script file. The icons that trigger insertion of multi-pole schematic symbol assemblies and panel footprints are examples that require encoding of special AutoCAD Electrical commands.

The icon name and symbol block name are saved in the active * .dat file (such as ACE_JIC_MENU.DAT) once you click OK on the Icon Menu Wizard dialog box. The icon then displays at the end of the existing icon images in the Symbol Preview window of the Insert Component dialog box.

**NOTE** If you are modifying the panel menu file, use this option for inserting panel symbols. Also, use this for inserting 3-pole schematic symbols.

**Access:**

Click the arrow on the Miscellaneous tool to access the Icon Menu Wizard tool. Select the menu file to modify and click OK. On the Icon Menu Wizard dialog box click Add, and then select Command.

Click Components ➤ Symbol Library ➤ Icon Menu Wizard. Select the menu file to modify and click OK. On the Icon Menu Wizard dialog box click Add, and then select Command.
You can also access this dialog box by right-clicking in the Symbol Preview window of the Icon Menu Wizard dialog box and selecting Add Icon ➤ Command.

**TIP** To determine which *.dat file is active, in the Project Properties dialog box, Project Settings tab, Library and Icon Menu Paths section, expand the Schematic Icon Menu File option. This is the schematic icon menu file listed in the *.wdp file.

**Icon Details**

Defines the icon name and image.

<table>
<thead>
<tr>
<th>Preview</th>
<th>Displays an image preview of the specified image file.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specifies the name to appear in the icon, the description text and the tool tip for the icon.</td>
</tr>
</tbody>
</table>
| Image file      | Specifies the image file to use for the new icon. You can enter the image file name (or complete path) or select it using one of the following methods:  
  ▪ Browse: Finds an existing image to use for the icon. You can browse for .sld or .png images.  
  ▪ Pick: Selects an existing block name on the current drawing to use as the image file name. For example, if you select block HPB11, the image file name edit box displays “HPB11.”  
  ▪ Active: (This is unavailable if the drawing is a new drawing and has not been saved) Selects the active drawing name to use as the Image file. For example, if the active drawing name is “demo005,” then the image file edit box has “demo005” listed as the file name.  

The browsed image is copied to the Images folder and saved as a relative path in the .dat file. However, you can enclose the image path in quotation marks if you do not want the image copied to the Images folder and to save the complete path instead of the relative path in the .dat file. The entered image file name can be names like "PB1" or "CONTROL RELAY," file names with an extension such as “pb1.png,” or it can follow the syntax (slide_library or dll file (slide or .png)). For example, "S2(pb)" or "S7(control_relay)."

**NOTE** The image file name cannot contain invalid characters such as \\/:*?<>| and only .png and .sld image files are supported.
Create PNG from current screen image

Creates the .png image file from the current screen image. If the specified image file does not exist, this option is selected by default. If you do not want to create the icon from the current drawing’s displayed image, deselect the check box.

**NOTE** This option is unavailable if you enter an image file name with the syntax `{slide_library or dll file (slide or .png)}`. For example, “S2(pb)” or “S7(control_relay)”. It is also unavailable if the Image File edit box contains the image file path instead of the image file name.

Zoom

(Available only when Create PNG from current screen image is selected.) Zooms in on the current screen image using AutoCAD Pan command. Once you exit Pan mode and press Enter, the dialog box redisplays so you can finish defining the new icon.

Location

(This appears once the Image file is specified) Indicates the full path of the image file location where the new images are created or the browsed images are copied to. If you entered a file name with the syntax `{slide_library or dll file (slide or .png)}` for the image file, the path of the .dat file or the WD_SLB folder displays here.

**Command to Execute**

**NOTE** If you select an AutoCAD Electrical command, you must manually enter the additional parameters as indicated.

Command

Specifies to start an AutoCAD command or AutoCAD Electrical routine. You can enter the command name to execute with arguments. Click List to select from a list of AutoCAD Electrical commands for panel and schematic multi-pole symbol inserts. This makes it easier for you to build the appropriate command to insert a symbol.

Parameters

Displays the command parameters for a specific AutoCAD Electrical command. If the command does not have any parameters, the value “none” displays.

**Create new circuit**

The icon name and symbol block name are saved in the active *.dat file (such as ACE_JIC_MENU.DAT) once you click OK on the Icon Menu Wizard dialog box.
box. The icon then displays at the end of the existing icon images in the Symbol Preview window of the Insert Component dialog box.

**Access:**

Click the arrow on the Miscellaneous tool to access the Icon Menu Wizard tool. Select the menu file to modify and click OK. In the Icon Menu Wizard dialog box click Add, and then select New Circuit.

Click Components ➤ Symbol Library ➤ Icon Menu Wizard. Select the menu file to modify and click OK. On the Icon Menu Wizard dialog box click Add, and then select New Circuit.

You can also access this dialog box by right-clicking in the Symbol Preview window of the Icon Menu Wizard dialog box and selecting Add Icon ➤ New Circuit.

**TIP** To determine which *.dat file is active, in the Project Properties dialog box, Project Settings tab, Library and Icon Menu Paths section, expand the Schematic Icon Menu File option. This is the schematic icon menu file listed in the *.wdp file.

**Icon Details**

Defines the icon name and image.

- **Preview**
  Displays an image preview of the specified image file.

- **Name**
  Specifies the name to appear in the icon, the description text and the tool tip for the icon.

- **Image file**
  Specifies the image file to use for the new icon. You can enter the image file name (or complete path) or select it using one of the following methods:
  - **Browse:** Finds an existing image to use for the icon. You can browse for .sld or .png images.
  - **Pick:** Selects an existing block name on the current drawing to use as the image file name. For example, if you select block HPB11, the image file name edit box displays “HPB11.”
  - **Active:** (This is unavailable if the drawing is a new drawing and has not been saved) Selects the active drawing name to use as the Image file. For example,
if the active drawing name is “demo005,” then the image file edit box has “demo005” listed as the file name.

The browsed image is copied to the User folder if wd_userckt_dir is disabled in the .env file.

**NOTE** The User folder can be overridden by the wd_userckt_dir defined folder if the environment code is enabled in the .env file.

However, you can enclose the image path in quotation marks if you do not want the image copied to the User folder and to save the complete path instead of the relative path in the .dat file. The entered image file name can be names like "PB1" or "CONTROL RELAY," file names with an extension such as “pb1.png,” or it can follow the syntax {slide_library or dll file (slide or .png)}. For example, "S2(pb)" or "S7(control_relay)."

**NOTE** The image file name cannot contain invalid characters such as \ / : * ? < > | and only .png and .sld image files are supported.

---

**Create PNG from current screen image**

Creates the .png image file from the current screen image. If the specified image file does not exist, this option is selected by default. If you do not want to create the icon from the current drawing's displayed image, deselect the check box.

**NOTE** This option is unavailable if you enter an image file name with the syntax {slide_library or dll file (slide or .png)}" For example, “S2(pb)” or “S7(control_relay)”. It is also unavailable if the Image File edit box contains the image file path instead of the image file name.

---

**Zoom**

(Available only when Create PNG from current screen image is selected) Zooms in on the current screen image using AutoCAD Pan command. Once you exit Pan mode and press Enter, the dialog box redisplay so you can finish defining the new icon.
**Location**

(This appears once the Image file is specified) Indicates the full path of the image file location where the new images are created or the browsed images are copied to. If you entered a file name with the syntax (slide_library or dll file (slide or .png)) for the image file, the path of the .dat file or the WD_SLB folder displays here.

**Circuit Drawing File**

Defines the circuit file name that is created.

**File Name**

Specifies the file name for the circuit. Enter a drawing file name to use.

**Location**

Displays the complete path of the new drawing file that is created. The default user circuit folder is the User folder if the wd_usercktdir code is disabled in the environment file. If wd_usercktdir is enabled, the folder defined by this code is used as the user circuit folder.

**Add existing circuit**

The icon name and circuit drawing name are saved in the active *.dat file (such as ACE_JIC_MENU.DAT) once you click OK on the Icon Menu Wizard dialog box. The icon then displays at the end of the existing icon images in the Symbol Preview window of the Insert Component dialog box.

**Access:**

Click the arrow on the Miscellaneous tool to access the Icon Menu Wizard tool. Select the menu file to modify and click OK. In the Icon Menu Wizard dialog box click Add, and then select Add Circuit.

From the Components menu, select Symbol Library ➤ Icon Menu Wizard. Select the menu file to modify and click OK. In the Icon Menu Wizard dialog box click Add, and then select Add Circuit.

You can also access this dialog box by right-clicking in the Symbol Preview window of the Icon Menu Wizard dialog box and selecting Add Icon ➤ Add Circuit.
TIP To determine which *.dat file is active, in the Project Properties dialog box, Project Settings tab, Library and Icon Menu Paths section, expand the Schematic Icon Menu File option. This is the schematic icon menu file listed in the *.wdp file.

Icon Details

Defines the icon name and image.

**Preview**
Displays an image preview of the specified image file.

**Name**
Specifies the name to appear in the icon, the description text and the tool tip for the icon.

**Image file**
Specifies the image file to use for the new icon. You can enter the image file name (or complete path) or select it using one of the following methods:
- **Browse**: Finds an existing image to use for the icon. You can browse for .sld or .png images.
- **Pick**: Selects an existing block name on the current drawing to use as the image file name. For example, if you select block HPB11, the image file name edit box displays “HPB11.”
- **Active**: (This is unavailable if the drawing is a new drawing and has not been saved) Selects the active drawing name to use as the image file. For example, if the active drawing name is “demo005,” then the image file edit box has “demo005” listed as the file name.

If the circuit drawing file name contains the path of the drawing file referring to the User folder or the wd_userckt_dir defined folder, the browsed image is copied to the User folder if wd_userckt_dir is disabled in the .env file or the wd_userckt_dir defined folder if wd_userckt_dir is enabled in the .env file. If the circuit drawing file name contains the path of the drawing file that doesn’t refer to the User or wd_userckt_dir defined folder, the browsed image is copied to the Images folder and saved as a relative path in the .dat file. However, you can enclose the image path in quotation marks if you do not want the image copied to the Images folder and to save the complete path instead of the relative path in the .dat file. The entered image file name can be names like "PB1" or "CONTROL RELAY," file names with an extension such as “pb1.png,”
or it can follow the syntax (slide_library or dll file (slide or .png)). For example, "S2(pb)" or "S7(control relay)."

**NOTE** The image file name cannot contain invalid characters such as `\ / : * ? < > | and only .png and .sld image files are supported.

---

Create PNG from current screen image

Creates the .png image file from the current screen image. If the specified image file does not exist, this option is selected by default. If you do not want to create the icon from the current drawing’s displayed image, deselect the check box.

**NOTE** This option is unavailable if you enter an image file name with the syntax (slide_library or dll file (slide or .png))”. For example, “S2(pb)” or “S7(control_relay)”. It is also unavailable if the Image File edit box contains the image file path instead of the image file name.

---

Zoom

(Available only when Create PNG from current screen image is selected) Zooms in on the current screen image using AutoCAD Pan command. Once you exit Pan mode and press Enter, the dialog box redisplays so you can finish defining the new icon.

---

Location

(This appears once the Image file is specified) Indicates the full path of the image file location where the new images are created or the browsed images are copied to. If you entered a file name with the syntax (slide_library or dll file (slide or .png)) for the image file, the path of the .dat file or the WD_SLB folder displays here.

---

**Circuit Name to Insert**

Defines the circuit to insert when you click the icon.

---

**File Name**

Specifies the file name for the circuit. Enter a drawing file name to use, click Browse to select a drawing, or click Active to use the active drawing name as the circuit name.

---

**Create new submenu**

The icon name and symbol block name are saved in the active *.dat file (such as ACE_JIC_MENU.DAT) once you click OK on the Icon Menu Wizard dialog.
box. The icon then displays at the end of the existing icon images in the Symbol Preview window of the Insert Component dialog box.

Access:

Click the arrow on the Miscellaneous tool to access the Icon Menu Wizard tool. Select the menu file to modify and click OK. In the Icon Menu Wizard dialog box click Add, and then select New Submenu.

From the Components menu, select Symbol Library ➤ Icon Menu Wizard. Select the menu file to modify and click OK. In the Icon Menu Wizard dialog box click Add, and then select New Submenu.

You can also access this dialog box by right-clicking in the Symbol Preview window of the Icon Menu Wizard dialog box and selecting New Sub Menu.

**TIP** To determine which *.dat file is active, in the Project Properties dialog box, Project Settings tab, Library and Icon Menu Paths section, expand the Schematic Icon Menu File option. This is the schematic icon menu file listed in the *.wdp file.

**Icon Details**

Defines the icon name and image.

- **Preview**
  Displays an image preview of the specified image file.

- **Name**
  Specifies the name to appear in the icon, the description text and the tool tip for the icon.

- **Image file**
  Specifies the image file to use for the new icon. You can enter the image file name (or complete path) or select it using one of the following methods:
  - **Browse**: Finds an existing image to use for the icon. You can browse for .sld or .png images.
  - **Pick**: Selects an existing block name on the current drawing to use as the image file name. For example, if you select block HPB11, the image file name edit box displays “HPB11.”
  - **Active**: (This is unavailable if the drawing is a new drawing and has not been saved) Selects the active drawing name to use as the Image file. For example, if the active drawing name is “demo005,” then the image file edit box has “demo005” listed as the file name.
The browsed image is copied to the Images folder and saved as a relative path in the .dat file. However, you can enclose the image path in quotation marks if you do not want the image copied to the Images folder and to save the complete path instead of the relative path in the .dat file. The entered image file name can be names like "PB1" or "CONTROL RELAY," file names with an extension such as "pb1.png," or it can follow the syntax (slide_library or dll file (slide or .png)). For example, "S2(pb)" or "S7(control_relay)."

NOTE The image file name cannot contain invalid characters such as `\ / : " ? < > | and only .png and .sld image files are supported.

<table>
<thead>
<tr>
<th>Create PNG from current screen image</th>
<th>Creates the .png image file from the current screen image. If the specified image file does not exist, this option is selected by default. If you do not want to create the icon from the current drawing's displayed image, deselect the check box.</th>
</tr>
</thead>
</table>

**NOTE** This option is unavailable if you enter an image file name with the syntax (slide_library or dll file (slide or .png)). For example, “S2(pb)” or “S7(control_relay)”. It is also unavailable if the Image File edit box contains the image file path instead of the image file name.

<table>
<thead>
<tr>
<th>Zoom</th>
<th>(Available only when Create PNG from current screen image is selected) Zooms in on the current screen image using AutoCAD Pan command. Once you exit Pan mode and press Enter, the dialog box redispays so you can finish defining the new icon.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Location</th>
<th>(This appears once the Image file is specified) Indicates the full path of the image file location where the new images are created or the browsed images are copied to. If you entered a file name with the syntax (slide_library or dll file (slide or .png)) for the image file, the path of the .dat file or the WD_SLB folder displays here.</th>
</tr>
</thead>
</table>

**Submenu**

This section displays the menu number of the submenu page and allows you to define the submenu title.

<table>
<thead>
<tr>
<th>Menu Number</th>
<th>Displays the menu number of the submenu page for reference.</th>
</tr>
</thead>
</table>

748 | Chapter 12  Icon Menus
Menu Title

Specifies the submenu title that is used in the Insert Component dialog box. This is automatically specified but you can edit the title if desired.

**NOTE** The submenu icon name and the menu title can be different. For example, the icon name is Cable Markers but the submenu title is Special Cable Markers.

**Properties - main menu**

Use this tool to modify the existing menu properties such as changing the menu name. Your changes overwrite the information in the .dat file.

**Access:**

Click the arrow on the Miscellaneous tool to access the Icon Menu Wizard tool. Select the menu file to modify and click OK. In the Icon Menu Wizard dialog box right-click the menu file to modify (for example, JIC Symbols) and select Properties.

From the Components menu, select Symbol Library ➤ Icon Menu Wizard. Select the menu file to modify and click OK. In the Icon Menu Wizard dialog box right-click the menu file to modify (for example, JIC Symbols) and select Properties.

**Name**

Specifies the name of the main menu. The default changes depending on which menu you are working with (for example, JIC Symbols).

**Menu File**

Displays the file name and full path of the menu file. (for example, ace_jic_menu.dat).

**Properties - component**
Use this tool to modify the existing symbol icon properties such as changing the icon name, image or block name. Your changes overwrite the information in the .dat file.

**Access:**

Click the arrow on the Miscellaneous tool to access the Icon Menu Wizard tool. Select the menu file to modify and click OK. In the Icon Menu Wizard dialog box right-click on the component icon to modify and select Properties.

From the Components menu, select Symbol Library ➤ Icon Menu Wizard. Select the menu file to modify and click OK. In the Icon Menu Wizard dialog box right-click on the component icon to modify and select Properties.

**TIP** To determine which *.dat file is active, in the Project Properties dialog box, Project Settings tab, Library and Icon Menu Paths section, expand the Schematic Icon Menu File option. This is the schematic icon menu file listed in the *.wdp file.

**Icon Details**

Defines the icon name and image.

- **Preview**
  
  Displays an image preview of the specified image file.

- **Name**

  Specifies the name to appear in the icon, the description text and the tool tip for the icon.

- **Image file**

  Specifies the image file to use for the new icon. You can enter the image file name (or complete path) or select it using one of the following methods:
  - **Browse**: Finds an existing image to use for the icon. You can browse for .sld or .png images.
  - **Pick**: Selects an existing block name on the current drawing to use as the image file name. For example, if you select block HPB11, the image file name edit box displays “HPB11.”
  - **Active** (This is unavailable if the drawing is a new drawing and has not been saved) Selects the active drawing name to use as the Image file. For example, if the active drawing name is
"demo005," then the image file edit box has "demo005" listed as the file name.

The browsed image is copied to the Images folder and saved as a relative path in the .dat file. However, you can enclose the image path in quotation marks if you do not want the image copied to the Images folder and to save the complete path instead of the relative path in the .dat file. The entered image file name can be names like "PB1" or "CONTROL RELAY," file names with an extension such as “pb1.png,” or it can follow the syntax (slide_library or dll file (slide or .png)). For example, "S2(pb)" or "S7(control_relay)."

**NOTE** The image file name cannot contain invalid characters such as \\ / : " ? < > | and only .png and .sld image files are supported.

### Create PNG from current screen image

(Available only when you edit the image file) Creates the .png image file from the current screen image. If the specified image file does not exist, this option is selected by default. If you do not want to create the icon from the current drawing’s displayed image, deselect the check box.

**NOTE** This option is unavailable if you enter an image file name with the syntax (slide_library or dll file (slide or .png))" For example, “S2(pb)” or “S7(control_relay)”. It is also unavailable if the Image File edit box contains the image file path instead of the image file name.

### Zoom

(Available only when Create PNG from current screen image is selected) Zooms in on the current screen image using AutoCAD Pan command. Once you exit Pan mode and press Enter, the dialog box redisplay so you can finish defining the new icon.

### Location

(This appears once the Image file is specified) Indicates the full path of the image file location where the new images are created or the browsed images are
copied to. If you entered a file name with the syntax 
{slide_library or dll file (slide or .png)) for the image 
file, the path of the .dat file or the WD_SLB folder 
displays here.

Block Name to Insert

Defines the symbol block that is inserted when you click the icon in the Insert 
Component dialog box.

Block Name

Specifies the symbol block name. The symbol's file name 
can be typed into the edit box or you can enter it using 
one of the following methods:

- Browse: Finds an existing WBlocked drawing (*.dwg) 
  file to assign to the icon. In this case the complete path 
of the drawing file is inserted in the edit box.

- Pick: Selects an existing block on the current drawing 
  (for example, block recently created with Symbol 
  Builder). WBlocked version (.dwg) needs to exist.

- Active: Inserts the active drawing as a block.

Properties - command

Use this tool to modify the existing symbol icon properties such as changing 
the icon name, image or block name. Your changes overwrite the information 
in the .dat file.

Access:

Click the arrow on the Miscellaneous tool to access the Icon Menu Wizard tool. 
Select the menu file to modify and click OK. In the Icon Menu Wizard dialog 
box right-click on the command icon to modify and select Properties. 
From the Components menu, select Symbol Library ➤ Icon Menu Wizard. 
Select the menu file to modify and click OK. In the Icon Menu Wizard dialog 
box right-click on the command icon to modify and select Properties

TIP To determine which *.dat file is active, in the Project Properties dialog box, 
Project Settings tab, Library and Icon Menu Paths section, expand the Schematic 
Icon Menu File option. This is the schematic icon menu file listed in the *.wdp file.
Icon Details

Defines the icon name and image.

**Preview**
Displays an image preview of the specified image file.

**Name**
Specifies the name to appear in the icon, the description text and the tool tip for the icon.

**Image file**
Specifies the image file to use for the new icon. You can enter the image file name (or complete path) or select it using one of the following methods:

- **Browse**: Finds an existing image to use for the icon. You can browse for .sld or .png images.
- **Pick**: Selects an existing block name on the current drawing to use as the image file name. For example, if you select block HPB11, the image file name edit box displays “HPB11.”
- **Active**: (This is unavailable if the drawing is a new drawing and has not been saved) Selects the active drawing name to use as the Image file. For example, if the active drawing name is “demo005,” then the image file edit box has “demo005” listed as the file name.

The browsed image is copied to the Images folder and saved as a relative path in the .dat file. However, you can enclose the image path in quotation marks if you do not want the image copied to the Images folder and to save the complete path instead of the relative path in the .dat file. The entered image file name can be names like "PB1" or "CONTROL RELAY," file names with an extension such as “pb1.png,” or it can follow the syntax (slide_library or dll file (slide or .png)). For example, “S2(pb)” or “S7(control_relay).”

**NOTE** The image file name cannot contain invalid characters such as \ / : " ? < > | and only .png and .sld image files are supported.

**Create PNG from current screen image**
(Available only when you edit the image file) Creates the .png image file from the current screen image. If the specified image file does not exist, this option is selected by default. If you do not want to create the icon from the current drawing’s displayed image, deselect the check box.
NOTE This option is unavailable if you enter an image file name with the syntax (slide_library or dll file (slide or .png))”. For example, “S2(pb)” or “S7(control_relay)”. It is also unavailable if the Image File edit box contains the image file path instead of the image file name.

**Zoom**

(Available only when Create PNG from current screen image is selected) Zooms in on the current screen image using AutoCAD Pan command. Once you exit Pan mode and press Enter, the dialog box redisplays so you can finish defining the new icon.

**Location**

(This appears once the Image file is specified) Indicates the full path of the image file location where the new images are created or the browsed images are copied to. If you entered a file name with the syntax (slide_library or dll file (slide or .png)) for the image file, the path of the .dat file or the WD_SLB folder displays here.

**Command to Execute**

Defines the command to execute when you click the icon.

**NOTE** If you select an AutoCAD Electrical command you must manually enter the additional parameters as indicated.

**Command**

Specifies to execute an AutoCAD command or AutoCAD Electrical routine. You can enter the command name to execute with arguments.

Click List to select from a list of AutoCAD Electrical commands for panel and schematic multi-pole symbol inserts. This makes it easier for you to build the appropriate command to insert a symbol.

**Parameters**

Displays the command parameters for a specific AutoCAD Electrical command. If the command does not have any parameters, the value “none” displays.

**Properties - circuit**
Use this tool to modify the existing symbol icon properties such as changing the icon name, image or block name. Your changes overwrite the information in the .dat file.

Access:

Click the arrow on the Miscellaneous tool to access the Icon Menu Wizard tool. Select the menu file to modify and click OK. In the Icon Menu Wizard dialog box right-click on the circuit icon to modify and select Properties. From the Components menu, select Symbol Library ➤ Icon Menu Wizard. Select the menu file to modify and click OK. In the Icon Menu Wizard dialog box right-click on the circuit icon to modify and select Properties.

**TIP** To determine which *.dat file is active, in the Project Properties dialog box, Project Settings tab, Library and Icon Menu Paths section, expand the Schematic Icon Menu File option. This is the schematic icon menu file listed in the *.wdp file.

**Icon Details**

Defines the icon name and image.

**Preview**

Displays an image preview of the specified image file.

**Name**

Specifies the name to appear in the icon, the description text and the tool tip for the icon.

**Image file**

Specifies the image file to use for the new icon. You can enter the image file name (or complete path) or select it using one of the following methods:

- **Browse**: Finds an existing image to use for the icon. You can browse for .sld or .png images.

- **Pick**: Selects an existing block name on the current drawing to use as the image file name. For example, if you select block HPB11, the image file name edit box displays “HPB11.”

- **Active**: (This is unavailable if the drawing is a new drawing and has not been saved) Selects the active drawing name to use as the image file. For example, if the active drawing name is “demo005,” then the image file edit box has “demo005” listed as the file name.
If the circuit drawing file name contains the path of the drawing file referring to the User folder or the wd_userckt_dir defined folder, the browsed image is copied to the User folder if wd_userckt_dir is disabled in the .env file or the wd_userckt_dir defined folder if wd_userckt_dir is enabled in the .env file. If the file does not exist, the Create Circuit alert dialog box displays asking you if you want to create the circuit.

If the circuit drawing file name contains the path of the drawing file that doesn’t refer to the User or wd_userckt_dir defined folder, the browsed image is copied to the Images folder and saved as a relative path in the .dat file. However, you can enclose the image path in quotation marks if you do not want the image copied to the Images folder and to save the complete path instead of the relative path in the .dat file. The entered image file name can be names like "PB1" or "CONTROL RELAY,” file names with an extension such as “pb1.png,” or it can follow the syntax (slide_library or dll file (slide or .png)). For example, "S2(pb)" or “S7(control_relay).”

**NOTE** The image file name cannot contain invalid characters such as \/:*?<>| and only .png and .sld image files are supported.

---

**Create PNG from current screen image**

(Available only when you edit the image file) Creates the .png image file from the current screen image. If the specified image file does not exist, this option is selected by default. If you do not want to create the icon from the current drawing’s displayed image, deselect the check box.

**NOTE** This option is unavailable if you enter an image file name with the syntax (slide_library or dll file (slide or .png))” For example, “S2(pb)” or “S7(control_relay)”. It is also unavailable if the Image File edit box contains the image file path instead of the image file name.

---

**Zoom**

(Available only when Create PNG from current screen image is selected) Zooms in on the current screen image using AutoCAD Pan command. Once you exit Pan mode and press Enter, the dialog box redisplays so you can finish defining the new icon.
Location  
(This appears once the Image file is specified) Indicates the full path of the image file location where the new images are created or the browsed images are copied to. If you entered a file name with the syntax {slide_library or dll file (slide or .png)} for the image file, the path of the .dat file or the WD_SLB folder displays here.

**Circuit Drawing File**

Defines the circuit file name that is created.

**File Name**  
Specifies the file name for the circuit. Enter a drawing file name to use.

**Location**  
Displays the complete path of the new drawing file that is created. The default user circuit folder is the User folder if the wd_usercktmdir code is disabled in the environment file. If wd_usercktmdir is enabled, the folder defined by this code is used as the user circuit folder.

**Properties - submenu**

Use this tool to modify the existing symbol icon properties such as changing the icon name, image or block name. Your changes overwrite the information in the .dat file.

**Access:**

Click the arrow on the Miscellaneous tool to access the Icon Menu Wizard tool. Select the menu file to modify and click OK. In the Icon Menu Wizard dialog box right-click on the submenu to modify and select Properties. From the Components menu, select Symbol Library ➤ Icon Menu Wizard. Select the menu file to modify and click OK. In the Icon Menu Wizard dialog box right-click on the submenu to modify and select Properties.

**TIP** To determine which *.dat file is active, in the Project Properties dialog box, Project Settings tab, Library and Icon Menu Paths section, expand the Schematic Icon Menu File option. This is the schematic icon menu file listed in the *.wdp file.
**Icon Details**

Defines the icon name and image.

**Preview**
Displays an image preview of the specified image file.

**Name**
Specifies the name to appear in the icon, the description text and the tool tip for the icon.

**Image file**
Specifies the image file to use for the new icon. You can enter the image file name (or complete path) or select it using one of the following methods:

- **Browse**: Finds an existing image to use for the icon. You can browse for .sld or .png images.
- **Pick**: Selects an existing block name on the current drawing to use as the image file name. For example, if you select block HPB11, the image file name edit box displays “HPB11.”
- **Active**: (This is unavailable if the drawing is a new drawing and has not been saved) Selects the active drawing name to use as the Image file. For example, if the active drawing name is “demo005,” then the image file edit box has “demo005” listed as the file name.

The browsed image is copied to the Images folder and saved as a relative path in the .dat file. However, you can enclose the image path in quotation marks if you do not want the image copied to the Images folder and to save the complete path instead of the relative path in the .dat file. The entered image file name can be names like "PB1" or "CONTROL RELAY," file names with an extension such as “pb1.png,” or it can follow the syntax (slide_library or dll file (slide or .png)). For example, “S2(pb)” or "S7(control_relay).”

**NOTE** The image file name cannot contain invalid characters such as \ / : " ? < > l and only .png and .sld image files are supported.

**Create PNG from current screen image**
(Available only when you edit the image file) Creates the .png image file from the current screen image. If the specified image file does not exist, this option is selected by default. If you do not want to create the icon from the current drawing's displayed image, deselect the check box.
NOTE: This option is unavailable if you enter an image file name with the syntax \{slide_library or dll file (slide or .png)\}". For example, “S2(pb)” or “S7(control_relay)”. It is also unavailable if the Image File edit box contains the image file path instead of the image file name.

Zoom

(Available only when Create PNG from current screen image is selected) Zooms in on the current screen image using AutoCAD Pan command. Once you exit Pan mode and press Enter, the dialog box redisplays so you can finish defining the new icon.

Location

(This appears once the Image file is specified) Indicates the full path of the image file location where the new images are created or the browsed images are copied to. If you entered a file name with the syntax \{slide_library or dll file (slide or .png)\} for the image file, the path of the .dat file or the WD_SLB folder displays here.

Submenu

This section displays the menu number of the submenu page and allows you to define the submenu title.

Menu Number

Displays the menu number of the submenu page for reference.

Menu Title

Specifies the submenu title that is used in the Insert Component dialog box. This is automatically specified but you can edit the title if desired.

NOTE: The submenu icon name and the menu title can be different. For example, the icon name is Cable Markers but the submenu title is Special Cable Markers.

Use alternate icon menus

AutoCAD Electrical defaults to icon menu ACE_<standard>_MENU.DAT (where <standard>= JIC, IEC, AS, GB, HYD, JIS, PID, or PNEU) for schematic symbols and ACE_PANEL_MENU.DAT for panel symbols. These menu files are found in the C:\Documents and Settings\{username}\Application Data\Autodesk\AutoCADElectrical\{release #}\{country code\}\Support
An icon menu can be tied to a project so that when the project is active, AutoCAD Electrical references that special icon menu instead of the AutoCAD Electrical normal menu. The alternate menu's full path and file name is saved in the project's .wdp file. You can save an alternate menu for schematic symbols and one for panel symbols.

**Assign specific icon menu files to a project**

1. Select Projects ➤ Project ➤ Project Manager.
2. Make sure the desired project is the active project, right-click on the project name, and select Properties.
3. In the Project Properties ➤ Project Settings dialog box, click the plus sign (+) next to Schematic Icon Menu File or Panel Icon Menu File. Click inside the edit box to change the icon menu's path, click Browse to search for and select an icon menu, or click Default to use the default icon menu.
4. Click OK.

**NOTE** If you make custom images or libraries for the menu, copy them to the same subdirectory as the menu file since AutoCAD Electrical looks for menu images in the active icon menu file's directory.

---

**Overview of the icon menu file**

AutoCAD Electrical supplies several default icon (.dat) menus for schematic symbols and one for panel symbols. For example, the JIC schematic icon menu is defined by the contents of file ACE_JIC_MENU.DAT file and the panel menu is ACE_PANEL_MENU.DAT. These menu files are found in the \Documents and Settings\{username}\Application Data\Autodesk\AutoCAD Electrical 200x\{release number}\{country code}\Support subdirectory. The other icon menu files include: ACE_AS_MENU, ACE_GB_MENU, ACE_JIS_MENU, ACE_IEC_MENU, ACE_HYD_MENU, ACE_PID_MENU, ACE_PNEU_MENU and WD_ABECAD.

There may be times when you want to bypass the Icon Menu Wizard and edit the .dat text file directly using any text editor (such as Microsoft Notepad). It
is important to maintain the menu file structure, otherwise your menu may
not activate properly.

Here are the first few lines of the first page and a submenu (JIC: Push Buttons)
of the ACE_JIC_MENU.DAT file. Refer to this in the following sections.

**M0
D0
JIC: Schematic Symbols
Push Buttons ls2(s_pb)|$S=M3
Selector Switches ls2(s_ss)|$S=M6
Limit Switches ls2(s_zs)|$S=M8

**M3
D5W
JIC: Push Buttons
Push Button NO ls2(shpB11)|HPB11
Push Button NC ls2(shpB12)|HPB12

NOTE You can have an unlimited number of icons on each menu page. Prior to
AutoCAD Electrical 2008, you were limited to 24 icons per page.

Icon menu’s page structure

Each menu page starts with a menu number line preceded by two asterisks
(**). The next line is an AutoCAD Electrical code, which defines the menu
page format (such as how many rows, how many icon buttons per row). This
is used for .dat files that are used prior to AutoCAD Electrical 2008. The next
line is the title, with optional column labels, for the menu page. The rest of
the lines define the information for each icon button on the menu page. These
icons can either launch a command, insert a component or open a submenu.

**M0

<table>
<thead>
<tr>
<th>**M0</th>
<th>Menu number</th>
</tr>
</thead>
</table>

| JIC Symbols | Main menu title. In the Insert Component dialog box, this is the main menu title in the Menu tree selection view and is also displayed above the Symbol Preview window of the dialog box. |

Overview of the icon menu file | 761
Push Buttons

Description text of the icon. This is also the tooltip for the submenu page, command, or component to insert. In this example, clicking Push Buttons in the Insert Component dialog box opens a submenu.

s2(s_pb)

Image information with the syntax: slide_library_name(slide or .png). In this example the slide library (or resource dll library) is “s2” and the slide file (or .png image) is “s_pb.”

**NOTE** If both s_pb.png and s_pb.sld exist, AutoCAD Electrical searches for the .png file first. If not found, looks for the s_pb.sld file.

**S=M3**

Submenu trigger. The syntax is: **S=menu number.** In this example, menu 3 is used for push buttons. This is used to develop the Menu tree structure in the Insert Component dialog box.

**Icon function - submenu trigger**

**M3**

Submenu number

DSW

(Used for .dat files prior to AutoCAD Electrical 2008)
Indicates the number of rows in the menu. In AutoCAD Electrical 2008, you can have any number of rows or columns in your menu. This value is only used to structure .dat files in older versions of AutoCAD Electrical.

JIC: Push Buttons

Submenu page title. This displays below the main menu (JIC Symbols) in the Menu tree structure view of the Insert Component dialog box.

**Add submenu pages**

Enter the definition for any new submenu pages at the bottom of the .dat file. A new Special Symbols submenu page added using the Icon Menu Wizard will add the following lines of text:

**M101**
**SPECIAL SYMBOLS**

Explanation:

**M101**  
Menu page number. User-created menu pages should begin at 100 since AutoCAD Electrical uses 1-99 for its own use.

**SPECIAL SYMBOLS**  
Menu page title

**Icon function - insert component**

Push Button N.O.  
Description text of the icon. This is also the tool tip for the component to insert. In this example, clicking Push Button N.O. in the Insert Component dialog box inserts the component in the drawing.

s2(shpB11)  
Image information with the syntax: slide_library_name(slide or .png). In this example the slide library (or resource dll library) is "s2" and the slide file (or .png image) is "shpB11."

HPB11  
Specifies the block name. The block name is searched in the symbol library search path as defined by the Project Properties dialog box and is inserted into the drawing.

Each entry consists of three parts separated by "|" characters. The first part will be the text that is displayed in the Menu tree structure view or as a tool tip in the Symbol Preview window. The second part is the slide (or .png) name. You should include the path to the .SLD. If the slide is contained within a slide library (or resource dll library) the format here is library_name(slide_name). The third part is the actual icon function. The function can be a symbol name to insert, a sub-menu trigger, or a command. A line that looks like this can be added by the menu wizard to insert a special switch:

Special Switch | hzs11.sld | HZS11

**Icon function - execute command**

Clicking on an icon in the icon menu can also execute an AutoCAD Electrical command. The following example shows the syntax for commands:

Overview of the icon menu file | 763
3 Pole Disconnect |s1(shds13)|$c=wd_3unit HDS11

| 3 Pole Disconnect | Description text of the icon. This is also the tool tip for the command. In this example, clicking 3 Pole Disconnect in the Insert Component dialog box runs a command. |
| s1(shds13) | Image information with the syntax: slide_library_name(slide or .png). In this example the slide library (or resource dll library) is “s1” and the slide file (or .png image) is “shds13.” |
| $C=wd_3unit | Code that executes a command. The syntax is: $C=command name (command parameters). In this example, the command wd_3unit is run when the icon is clicked. |
| HDS11 | Specifies the command parameters. |
BOM and Catalogs

In this chapter

- Use catalog tables
- Overview of the catalog database table structure
- Use the merge utility
- Catalog Assignment
- Contact Quantity/Pin List Lookup
Use catalog tables

Sample catalog information is furnished with the default AutoCAD Electrical installation. The information is held in tables in an Microsoft Access Database file (.mdb) which are populated with sample vendor data. You must expand and modify these tables to meet your specific BOM reporting needs. Use tools provided with AutoCAD Electrical or through the use of a database program that can read/write the Access file format.

The .mdb file is a single file that is named <project>_cat.mdb or default_cat.mdb. If the project-specific.mdb file is used, it must be in the same subdirectory as the <project>.wdp file is located. Here is the AutoCAD Electrical search sequence:

■ 1st choice -- <project>_cat.mdb (in project’s subdirectory)
■ 2nd choice -- default_cat.mdb (in project’s subdirectory)
■ 3rd choice -- default_cat.mdb (in user subdirectory)
■ 4th choice -- default_cat.mdb (in catalog’s subdirectory)

Catalog information can be carried on parent or stand-alone components that have MANUFACTURER, CATALOG, and optional ASSEMBLYCODE attributes. Assigning catalog information to a component’s attributes can be done at component insertion time or any time later during an edit of the component.

Catalog table naming conventions

Each primary or stand-alone component type can have an associated table in your Access mdb file. This approach is taken for both performance reasons and to exclude invalid choices (for example, you can’t assign a blue press-test pilot part number to a standard red pilot light symbol). This means that there can be multiple catalog tables for the same component family. Alternately, all master test and all neon pilot lights (of all colors) might be combined into a single catalog table named LT. AutoCAD Electrical determines what the default catalog lookup table name should be based on the WDBLKNAM attribute.

The following example references a custom master control relay with block name “HCRI_MC_PWR.”
If your symbol does not carry the WDBLKNAM attribute:

1. The symbol is checked for the WDBLKNAM attribute (or Xdata). It is not found.

2. The block name is read (“HCR1_MC_PWR”) minus its first character (the orientation character “H” or “V”). The default_cat.mdb file is searched for a table named “CR1_MC_PWR.”

3. If this table exists, it is used. If this table does not exist and the block name is 8 characters or more, AutoCAD Electrical starts removing characters from the block name until there are only 7 characters left, looking for a table name match with each character removed. Table names that it would look for in sequence would be “CR1_MC_PW”, “CR1_MC_P”, “CR1_MC_.”

4. If there isn’t a match on the last table name, AutoCAD Electrical checks for the family-specific table (CR). This is the second and third character of the block name.

5. If this table exists, it is used. If it does not exist, a MISC_CAT table is looked for if the active project’s properties are set up to use this catch-all table.

6. If all of these items fail, AutoCAD Electrical stops looking (if running a report) or prompts you to add a table to the default_cat.mdb file (if you are inserting or editing a component).

If your symbol includes the invisible WDBLKNAM attribute with a value of “HCRM”:

1. The symbol is checked for the WDBLKNAM attribute (or Xdata). It is found. The attribute’s value of “HCRM” is used instead of the block name and proceeds to step 2.

2. The leading “H” or “V” character is removed. The default_cat.mdb file searches for a table named “CRM.”

3. If this table exists, it is used. If the table does not exist and the attribute value is 8 characters or more, AutoCAD Electrical starts removing characters from the attribute value until there are only 7 characters left, looking for a table name match with each character removed. (In this case, characters are not removed.)

4. If there isn’t a match on the last table name, AutoCAD Electrical checks for a family-specific table (CR). This is the second and third character of the original WDBLKNAM value (HCRM).
If this table exists, it is used. If it does not exist, a MISC_CAT table is looked for if the active project’s properties are set up to use this catch-all table.

If all of these items fail, AutoCAD Electrical stops looking (if running a report) or prompts you to add a table to the default_cat.mdb file (if you are inserting or editing a component).

If you want your custom symbol to go to table “CRM” in the catalog database file instead of the existing table “CR” you must:

1. Add the WDBLKNAM attribute to your master control relay coil library symbols with a value of “HCRM” or “VCRM” (the orientation does not matter).
2. Manually add the CRM table in your catalog lookup database file using Projects ➤ Extras ➤ Add Table to Catalog Database or Microsoft Access.

**NOTE** AutoCAD Electrical always goes to the fixed table names for PLC I/O modules (PLCIO), terminals (TRMS) and cable markers (W0). Panel layout symbols must always use the WDBLKNAM attribute or Xdata without the leading H or V character.

**Family tables in the default_cat.mdb**

The list of tables available in the default_cat.mdb is shown in the following table. All tables are family-specific and 1 table is created for each family.

<table>
<thead>
<tr>
<th>Family Code/Table Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_LISTBOX_DEF</td>
<td>Allows starting MFG/TYPERATING combinations to be predefined for each catalog lookup table when AutoCAD Electrical would normally default to the values given in the first record of the selected catalog lookup table. See <a href="#">Overview of the LISTBOX_DEF catalog database table</a> (page 788).</td>
</tr>
<tr>
<td>_PINLIST</td>
<td>Default pin list data table. AutoCAD Electrical also contains manufacturer-specific pin list tables that have the same format as the _PINLIST table. The naming convention for manufacturer-specific tables is: _PINLIST_AB or _PINLIST_AROMAT. AutoCAD Electrical first searches manufacturer-specific tables; if not found, it then searches the default _PINLIST table. See <a href="#">Use pin lists</a> (page 793).</td>
</tr>
</tbody>
</table>

---

768 | Chapter 13  BOM and Catalogs
<table>
<thead>
<tr>
<th>Family Code/Table Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_TERMPROPS</td>
<td>Default terminal properties data table. AutoCAD Electrical also contains manufacturer-specific terminal properties tables that have the same format as the _TERMPROPS table. The naming convention for manufacturer-specific tables is: _TERMPROPS_AB or _TERMPROPS_AROMAT. AutoCAD Electrical first searches manufacturer-specific tables; if not found, it then searches the default _TERMPROPS table. See Edit terminal properties database. (page 630)</td>
</tr>
<tr>
<td>_W0_CBLWIRES</td>
<td>Cable conductors. See Edit the cable conductor database (page 542).</td>
</tr>
<tr>
<td>AM</td>
<td>Ammeters</td>
</tr>
<tr>
<td>AN</td>
<td>Buzzers, horns, bells</td>
</tr>
<tr>
<td>CB</td>
<td>Circuit breakers</td>
</tr>
<tr>
<td>C0</td>
<td>Connectors/pins</td>
</tr>
<tr>
<td>CR</td>
<td>Control relays</td>
</tr>
<tr>
<td>DN</td>
<td>Device networks</td>
</tr>
<tr>
<td>DR</td>
<td>Drives</td>
</tr>
<tr>
<td>DS</td>
<td>Disconnect switches</td>
</tr>
<tr>
<td>EN</td>
<td>Enclosures/hardware</td>
</tr>
<tr>
<td>FM</td>
<td>Frequency meters</td>
</tr>
<tr>
<td>FU</td>
<td>Fuses</td>
</tr>
<tr>
<td>LR</td>
<td>Latching relays</td>
</tr>
<tr>
<td>LS</td>
<td>Limit switches</td>
</tr>
<tr>
<td>Family Code/Table Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>LT</td>
<td>Lights, pilot lights</td>
</tr>
<tr>
<td>MISC</td>
<td>Miscellaneous</td>
</tr>
<tr>
<td>MO</td>
<td>Motors</td>
</tr>
<tr>
<td>MS</td>
<td>Motor starters/contactors</td>
</tr>
<tr>
<td>NP</td>
<td>Nameplates</td>
</tr>
<tr>
<td>OL</td>
<td>Overloads</td>
</tr>
<tr>
<td>PB</td>
<td>Push buttons</td>
</tr>
<tr>
<td>PE</td>
<td>Photo switches</td>
</tr>
<tr>
<td>PLCIO</td>
<td>Programmable logic controllers</td>
</tr>
<tr>
<td>PM</td>
<td>Power meters</td>
</tr>
<tr>
<td>PS</td>
<td>Pressure switches</td>
</tr>
<tr>
<td>PW</td>
<td>Power supplies</td>
</tr>
<tr>
<td>PX</td>
<td>Proximity switches</td>
</tr>
<tr>
<td>RE</td>
<td>Resistors</td>
</tr>
<tr>
<td>SS</td>
<td>Selector switches</td>
</tr>
<tr>
<td>SU</td>
<td>Surge suppressors</td>
</tr>
<tr>
<td>SW</td>
<td>Toggle switches</td>
</tr>
</tbody>
</table>
Modify or expand catalog tables

You can edit entries in a catalog table or even add new catalog items on-the-fly using AutoCAD Electrical.

1. Force AutoCAD Electrical to reference the desired catalog table. Do this by either inserting a new component related to the catalog table you want to edit or by picking an existing component of that type to edit (using the Edit Component tool).

   For example, if you want to add some new components to the catalog table for standard red pilot lights (LT1R) then either use AutoCAD Electrical to insert a new red pilot light symbol or Edit an existing red pilot light symbol.

2. From the Insert/Edit dialog box, select Catalog lookup. Now you have triggered AutoCAD Electrical to open the desired catalog table.

3. Select Add New to add a new item or select Edit to edit the selected item’s database record. AutoCAD Electrical displays the new or existing catalog record in a dialog.

4. Make the necessary changes and click OK to exit the Edit dialog box.

To add a new table to the catalog file, you can either insert a new component that will trigger AutoCAD Electrical to ask permission to create the table or
you can do it from the Electrical pulldown menu. Select Projects ➤ Reports ➤ Insert Spreadsheet Data to Table.

**Move the catalog database file**

Click Projects ➤ Project ➤ Project Manager. Right-click the project name and select Settings to find the location of the default_cat.mdb file. If you want to move this file to some other directory, such as a shared network drive, then you must edit a small text file to tell AutoCAD Electrical where to look.

1. Move the file to your new drive:directory.
2. Exit AutoCAD. Edit the ".env" file (use the Settings option on the Project Manager to find the full path) with a text editor like WordPad or Notepad.
3. Find the WD_CAT entry. Change the line to point to the new location for the catalog file. Let's say that you've moved them to n:/electric/catalogs/ on your network drive. Change this line to: WD_CAT,n:/electric/catalogs/,AutoCAD Electrical catalog file.
4. Save and exit the file.

**NOTE** AutoCAD Electrical looks for a project specific MDB file first, called <project>_cat.mdb, in the project's subdirectory.

**Parts catalog**

Opens the component's catalog database from which you can manually enter or select the Manufacturer or Catalog values. Search the database for a specific catalog item to assign to the selected component. Database queries are set up in the 3 lists across the top of the dialog with the database hits listed in the dialog's main window.

**Access:**

Click the Insert Component tool. Select the component type to insert and specify the insertion point on the drawing. Click Catalog Data: Lookup.

From the Components menu, select Insert Component. Select the component type to insert and specify the insertion point on the drawing. Click Catalog Data: Lookup.

Click the Edit Component tool and select the component to edit. Click Catalog Data: Lookup.

From the Components menu, select Edit Component and select the component to edit. Click Catalog Data: Lookup.
You can sort the catalog database information by clicking on the column headings.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Manufacturer/Type/Style</strong></td>
<td>Sorts the catalog database by manufacturer type, component type, and style.</td>
</tr>
<tr>
<td><strong>Show list ordered by catalog part number</strong></td>
<td>Sorts the catalog entries by catalog number. By default, the entries are shown in the order they appear in the catalog database.</td>
</tr>
<tr>
<td><strong>Subassembly values in pulldowns</strong></td>
<td>Displays subassemblies in the catalog display. If there are any unique items in the list, they are added to the pull-down choices at the top of the dialog box.</td>
</tr>
<tr>
<td><strong>Symbol name filtering ON</strong></td>
<td>Filters the symbol names using the WDBLKNAM (page 780)value. If this is selected, records containing a WDBLKNAM value that does not match the symbol block name do not appear in the catalog list. If this option is not selected, the query ignores the check on the WDBLKNAM field and returns all catalog information.</td>
</tr>
<tr>
<td><strong>Web/View</strong></td>
<td>Displays more information about your component than can be held in the catalog database such as pictures or specifications. Use the 15th field in the catalog database to set up the WEBLINK. If the WEBLINK field for the selected part is a Web URL, your Internet browser launches and displays it. If it is an image file, pdf, spreadsheet, or some other document type, the application associated with that file's extension (for example, &quot;Open With...&quot;) launches and displays the file's contents.</td>
</tr>
<tr>
<td><strong>Catalog Check</strong></td>
<td>Performs a Bill of Material check and displays the result. This is enabled if the selected component contains catalog data.</td>
</tr>
<tr>
<td><strong>Cable Conductor List View/Edit</strong></td>
<td>(Available for cable markers only) Opens the Edit Catalog Conductor List dialog box. Edit the cable conductor database table (_W0_CBLWIRES) for the selected Manufacturer and Catalog combination.</td>
</tr>
</tbody>
</table>
You can delete or change existing cables or add new ones to the list.

**Add**  
Provides a template, prefilled with default values, for a new catalog item that is added to the catalog database file.

**Edit**  
Edits an existing catalog record. Select the catalog record to edit from the Parts Catalog dialog box and make any changes in the Edit Catalog Record dialog box.

**Component**  
Creates a component-specific catalog table. The name of this catalog table matches the component's block name (minus the "H" or "V" first letter). For example, both horizontal and vertical versions of a standard, N.O. push-button ("HPB11" and "VPB11") reference the same component-specific catalog look up table "PB11".

**NOTE**  
If you select to create a component-specific catalog table, and then cancel out of the dialog box before adding any data to the table, the blank table is deleted.

**Miscellaneous**  
References a table called "MISC_CAT." This general catalog table is set up in the .mdb file with all component types in it. If found, this catalog information displays in the dialog for component catalog number selection.

**Other**  
Assigns a different lookup table to use. Pick from the list of existing tables or manually enter the table name. You can also enter a catalog number (wildcards are accepted) and find the table that references the catalog number.

**Add or edit catalog record**
Provides a template, prefilled with default values, for a new catalog item that is added to the catalog database file. You can also edit an existing catalog record.

Access:

Click the Insert Component tool. Select the component type to insert and specify the insertion point on the drawing. Click Catalog Data: Lookup. In the Parts Catalog dialog box, click Add or Edit.

From the Components menu, select Insert Component. Select the component type to insert and specify the insertion point on the drawing. Click Catalog Data: Lookup. In the Parts Catalog dialog box, click Add or Edit.

Click the Edit Component tool and select the component to edit. Click Catalog Data: Lookup. In the Parts Catalog dialog box, click Add or Edit.

From the Components menu, select Edit Component and select the component to edit. Click Catalog Data: Lookup. In the Parts Catalog dialog box, click Add or Edit.

AutoCAD Electrical uses the first 10 fields for its own use plus reserves an additional 3 user fields for your use. You can insert additional fields, but AutoCAD Electrical ignores them when it constructs various reports. Below are the character fields accessed by AutoCAD Electrical (they must appear in this order in the database records).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog</td>
<td>Specifies the catalog number. You can also specify the number of parts to add to the database file. A blank Count field indicates a quantity of 1.</td>
</tr>
<tr>
<td>Description</td>
<td>Specifies the optional description text for the catalog part.</td>
</tr>
<tr>
<td>Query Fields</td>
<td>Specifies the manufacturer, type, and color for the part.</td>
</tr>
<tr>
<td>Contacts</td>
<td>Specifies the contacts assigned to the part.</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>Specifies miscellaneous text to assign to the part.</td>
</tr>
<tr>
<td>User 1,2,3</td>
<td>Specifies user information. AutoCAD Electrical provides 3 blank user fields for your use. Each can be a maximum of 24 characters wide and are extracted into BOM reports along with all of the other fields.</td>
</tr>
</tbody>
</table>
Assembly Code

Specifies the code to flag that this item has subassembly items. "As main- ➤ subassembly" activates the Assembly Code edit box. Use a unique name code to link this main catalog item with other subassembly items. This code can be up to 60 characters. Spaces are allowed.

Assembly List

Specifies the code to flag this is a subassembly item of a main item. To enter the ASSEMBLYLIST value, select "As subassembly" and enter the exact name of the ASSEMBLYCODE value carried by its main component. You can select the ASSEMBLYCODE list switch to speed up the process.

Text Value

Specifies optional user-defined RATING/misc attribute values. This field is used to vector text values to specific attributes on the edited component.

Weblink

Specifies the .pdf file or Web URL to associate to the component. If the Weblink entry is a Web URL, your Internet browser displays it. If it is an image file, .pdf, spreadsheet, or some other document type, then the application associated with that file's extension (for example, "Open With...") displays the file.

**NOTE**
For ".pdf" display, you can include the page number to display upon document open. Add a space and the page number after the .pdf file name in the WEBLINK field value (for example, c:\\rockwell\\700series.pdf 13).

WDBLKNAM

Specifies the schematic block name (used for catalog lookup - i.e. PB11, CR) of the catalog record. This serves as a filtration of the catalog records based on the schematic block name. This field is used as the first filter when opening up the catalog lookup window for the selection of catalog numbers. This filter provides the mechanism to remove invalid selections from the catalog lookup window, much like the component-specific tables. Use a comma to separate the symbol block names.

List

Lists existing values for each option. AutoCAD Electrical catalog lookups work most efficiently when field values that are meant to be the same are exactly the same, both in
spelling and capitalization. The list box beside each field helps maintain consistency as you add new catalog items. AutoCAD Electrical does a quick scan of the existing catalog file, collects and then displays a listing of all of the different field values it finds in the catalog. If one of the displayed values works for your new catalog item, then select it from this list (instead of typing in a brand new value).

**All upper case**

Displays all of the specified values in all upper case.

## Overview of the catalog database table structure

AutoCAD Electrical uses the first 10 fields for its own plus reserves an additional 3 user fields for your use. You can insert additional fields beyond the fourteenth one if you want, but they are ignored when generating reports. Here are the 15 fields accessed by AutoCAD Electrical. (They must appear in this order in the database records.)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CATALOG</td>
<td>60</td>
<td>Catalog number</td>
</tr>
<tr>
<td>MANUFACTURER</td>
<td>24</td>
<td>First query field - manufacturer code; abbreviations are allowed.</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>150</td>
<td>Generic description.</td>
</tr>
<tr>
<td>TYPE</td>
<td>100</td>
<td>Second query field (field name varies based on table name).</td>
</tr>
<tr>
<td>RATING</td>
<td>100</td>
<td>Third query field (field name varies based on table name).</td>
</tr>
<tr>
<td>MISCELLANEOUS1</td>
<td>100</td>
<td>First miscellaneous text field (header cell is based on the component family).</td>
</tr>
<tr>
<td>Field Name</td>
<td>Width</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MISCELLANEOUS2</td>
<td>100</td>
<td>Second miscellaneous text field (header cell is based on the component family).</td>
</tr>
<tr>
<td>ASSEMBLYCODE</td>
<td>60</td>
<td>Code to flag that this item has subassembly items. Use a unique name code to link this main catalog item with other subassembly items. Spaces are allowed.</td>
</tr>
<tr>
<td>ASSEMBLYLIST</td>
<td>24</td>
<td>Code to flag this is a subassembly item of a main item.</td>
</tr>
<tr>
<td>ASSEMBLYQUANTITY</td>
<td>8</td>
<td>Subassembly quantity (blank = quantity of 1).</td>
</tr>
<tr>
<td>USER1</td>
<td>100</td>
<td>Field #1 for user’s use.</td>
</tr>
<tr>
<td>USER2</td>
<td>100</td>
<td>Field #2 for user’s use.</td>
</tr>
<tr>
<td>USER3</td>
<td>100</td>
<td>Field #3 for user’s use.</td>
</tr>
<tr>
<td>TEXTVALUES</td>
<td>255</td>
<td>Optional user-defined RATING/miscellaneous attribute values.</td>
</tr>
<tr>
<td>WEBLINK</td>
<td>255</td>
<td>Associate .pdf files or Web URL to component.</td>
</tr>
<tr>
<td>WDBLKNAM</td>
<td>60</td>
<td>AutoCAD Electrical block name minus the first character of the block name since the first character is the orientation of block (H= Horizontal, V= Vertical).</td>
</tr>
</tbody>
</table>

**TEXTVALUES rating and miscellaneous attribute value assignment**

An optional fourteenth field named TEXTVALUES can be added to any catalog lookup table. This field can be used to vector text values to specific attributes on the edited component. The format for the text data encoded into this field is:

```plaintext
<attribute tag name1>=<text value>;<attribute tag name2>=<text value>
```
For example, a current catalog entry needs to annotate the component block attributes RATING1 and RATING2 with "ON DELAY" and "5-30 sec" respectively. Insert the following text string into the TEXTVALUES edit box:

RATING1=ON DELAY;RATING2=5-30 sec

**TIP** The Rating attributes should be common among all component types to make the population of the catalog database easier.

During component insertion or edit, if you make a catalog selection that comes with a non-blank TEXTVALUES, AutoCAD Electrical breaks apart the field value and searches for the target attributes on the edited symbol. If found, the component's target attributes are updated with the encoded data pulled from the user-selected catalog lookup record. To use this value:

1. Add this field to any catalog database table if it doesn't already exist.
2. Trigger AutoCAD Electrical to display the target catalog lookup table. (Insert a component and then select Catalog Lookup on the Insert/Edit Component dialog box.)
3. On the Parts Catalog dialog box, pick the appropriate part number and click Edit.
4. On the Edit Record dialog box, type a value into the TEXTVALUES edit box and click OK.

If the TEXTVALUES field did not exist in the selected catalog table, it is added to each record in the database. If it did exist, your new value is saved in the TEXTVALUES field for the selected catalog number's record.

**WEBLINK assignment**

Sometimes you may want to see more information about your component than can be held in the catalog database. For example, you may want to see a picture of the item or get its specifications. Use the fifteenth field in the catalog database to set up the WEBLINK to do this. If the WEBLINK field for the selected part is a web URL, your Internet browser launches and displays it. If it is an image file, pdf, spreadsheet, or some other document type, the application associated with that file's extension (for example, "Open With...") starts and displays the file's contents.

**NOTE** For PDF display, you can include the page number to display upon document open. Add a space and the page number after the pdf filename in the WEBLINK field value (for example, C:\rockwell\700series.pdf 13). This does not work for PDF files loaded across the web.
A dimmed WEBLINK edit box in the Edit Record dialog box means that the catalog lookup table does not have a WEBLINK field defined as the fifteenth field. If dimmed, you can add this field by manually adding it to your own copy of Microsoft Access.

A Weblink assignment can show up in the Surf dialog box. If you select a parent component to surf on and it carries a catalog assignment that references a Weblink value, it displays in the surf selection dialog box along with the other related component references. Double-clicking the Weblink reference launches your browser or appropriate application.

**NOTE** Picking on a child component to initialize in the Surf dialog box will not display a Weblink referenced by a related parent. You must pick on the parent carrying the catalog assignment.

**WDBLKNAM assignment**

The WDBLKNAM value filters the symbol names that display in the Parts catalog dialog box. The Symbol Name Filtering option on the Parts Catalog dialog box suppresses what data displays when a catalog lookup is run for a particular component. If you perform a catalog lookup on a symbol with block name “HTD1_xxx” and the Symbol Name Filtering option is selected, the only records that display are those listed in the TD table of the catalog database file that have a blank WDBLKNAM value or a value in the WDBLKNAM field that matches your symbol’s block name. For example, performing a catalog lookup on an on-delay coil (HTD1N.dwg or VTD1N.dwg) displays all blank WDBLKNAM entries and all entries that include “TD1N” somewhere in the WDBLKNAM field. If this option is not selected, the query ignores the check on the WDBLKNAM field and returns all catalog information.

You can do one of the following to determine how your catalog content is filtered:

1. Add your block name to all of the WDBLKNAM fields in the catalog table. Using the example above, you would add the block name to the TD table.

2. Add an invisible WDBLKNAM attribute to your symbol. Using the example above, name your symbol “HTD1F” for an off-delay coil or “HTD1N” for an on-delay coil.

3. Rename your block with the appropriate prefix (for example, “VTD1F”) followed by a substring “$$” and any other suffix to make the block name unique. AutoCAD Electrical’s catalog lookup sees the “$$” and assumes that this and anything after it is ignored. It treats your symbol as if the block name were just the basic name of “VTD1F.”

780 | Chapter 13  BOM and Catalogs
TIP Option 2 or 3 is preferred.

Use the merge utility

Use the Merge Utility to migrate database and panel symbol data from previous versions of AutoCAD Electrical to a newer version. You can merge PLC, catalog, and footprint databases, or panel drawing files. A backup of the destination database is created before merging, however backup files are not created during panel content (folder) merges. The backup database file is created in the same directory as the original file and its name is the same as the original, but with the extension ".bak." Each run of this utility with the same destination database creates a new backup file, which does not overwrite any existing backup files.

After the comparison of the two databases/folders is complete, the data is copied to the destination database/folder. Records remain in their respective tables in the destination database, unless otherwise specified in the catalog mapping file. After the merge is complete, a Merge Report dialog box displays, showing the full path of the report files. The report files contain detailed information about the merge. These report files are saved in the same directory as the destination database/panel folder and are overwritten for each subsequent merge.

If the selected databases/folders are not compatible for merging, the following is displayed:

<table>
<thead>
<tr>
<th>The file does not exist</th>
<th>This displays if the specified source or destination database file does not exist.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid file format</td>
<td>The selected file must be a database file (.mdb).</td>
</tr>
<tr>
<td>Invalid tables found in the source/destination database</td>
<td>This displays if the source or destination database is not a compatible database.</td>
</tr>
<tr>
<td>Destination database/folder is the same as source database/folder</td>
<td>The specified source and destination databases/folders cannot be the same. You must select another database/folder if you get this alert.</td>
</tr>
<tr>
<td>No drawing files found in source folder</td>
<td>The specified source panel folder must exist and contain drawing files before the merge can take place.</td>
</tr>
</tbody>
</table>
Table mapping file for catalog merges

You can choose to impose an input mapping file to direct where the data will be placed inside of the catalog destination database. The mapping file (named ACEDBMergeUtil.map) is located in the same directory as the main executable program.

NOTE There are additional mappings for vendors, catalog numbers, and fields. See the mapping file for information on these mappings.

To consolidate all the timer relay (TD) tables into one table, use the mapping file. It controls which tables to take from the source database and place into the destination database under a single table.

[Table map]
; <SRC_TABLE>=<DEST_TABLE>
TD1N=TD
TD1NT=TD
TD1NF=TD
TD1FT=TD

Wildcard mapping for catalog database tables is allowed on the source (left) database side of the mapping file. For example, TD*=TD. When the table or wildcard mapping is used and the source database table is component-specific, the merge utility places the table name into the WDBLKNAM field of the destination database. This provides the symbol name for the initial filter used in the catalog lookup window.
**Merge files**

Upon installation, you should run this utility to merge old database and/or symbol content into your newer version.

1. Click the arrow on the Miscellaneous tool to access the Merge Utility tool.

2. Click the Merge Utility tool.

3. Select the content to merge (multiple selections are allowed).

4. Click Next.

5. Select the database from which to copy files. Click Browse to browse for a previous version of an AutoCAD Electrical database.

6. Select the database that the information will be copied to.

7. Select to merge only new records/drawings (which will keep duplicate records in the destination database) or to merge all of the database/folder information.
   
   If you select to merge all of the database/folder information for Catalog databases, you can also specify to maintain user fields, the text value field, or the Web link field.

8. Click Next (if you selected to merge multiple databases) or click Finish.

   A status window opens listing the tables or folders that are being merged, how many records are being added or copied, and the number of records to still be processed.

9. Review the Merge Report and click OK.

**Merge utility**

Copies database/folder data listed in the Source into the Destination. A backup of the destination database is created before merging, however backup files are not created during panel content (folder) merges. The backup database file is created in the same directory as the original file and is named the same as the original, except that it has the extension ".bak." Each run of this utility
with the same destination database creates a new backup file, which will not overwrite any existing backup files.

**NOTE** The specified source and destination databases/folders cannot be the same.

**Access:**

Click the arrow on the Miscellaneous tool to access the Merge Utility tool.
From the Projects menu, select Extras ➤ Merge Utility.

**Select items to merge**

Specifies the content to merge (multiple selections are allowed).

- **PLC Content** merges the PLC database (ace_plc.mdb)
- **Catalog Content** merges the catalog database (default_cat.mdb)
- **Footprint Content** merges the footprint database (footprint_look-up.mdb)
- **Panel Content** merges the panel symbol content (inside the panel folder)

Next is disabled until you select content to merge. The subsequent dialogs appear in the order of this list, depending on what content was selected for the merge.

**Source**

Specifies the database/folder from which to copy the data. This is generally database or symbol content from previous versions of AutoCAD Electrical. You can browse for the database/folder or type the location and filename in the box.

**Destination**

Specifies the current working database/folder, to which the source content is merged. The default working path to the database/folder (in the folders
specified for the database or panel symbol content) is automatically filled in. You can browse for alternative databases/folders to copy the records into.

**Keep Duplicate Records in Destination Database/Folder (Merge New Only)**

Copies only new records from the source database/folder into the destination database/folder when duplicate items are found in the destination database/folder.

**Allow Duplicate Records to Overwrite Destination Database/Folder**

Copies all records from the source database/folder into the destination database/folder, overwriting all records. You can indicate to maintain the user fields, text value field, and web hyperlink field in overwritten records when merging catalog databases.

**Assign catalog information to components**

Catalog information is carried on a parent or stand-alone component. Each component can carry up to 10 different catalog assignments allowing for subassemblies. You can define exactly where AutoCAD Electrical should look to get this catalog information, allowing great flexibility in how you keep your catalog information. There are a number of ways to assign your catalog information to a component:

**Use the Component Insert/Edit dialog box**

The AutoCAD Electrical Insert/Edit dialog is the common dialog you see whether you insert a new component or edit an existing one. Click Catalog lookup to view the component's catalog database file. This is where you can search the database for a specific catalog item to assign to the selected component.

**Use a project-specific catalog file**

You can set up a project catalog file with all of the project's component types in it. The file must reside in the project's subdirectory. The file may be called
either default_cat.mdb or <project>_cat.mdb. AutoCAD Electrical references this file first before looking in the user subdirectory or the catalogs subdirectory (as defined in wd.env).

**Use a miscellaneous catalog file**

You can set up a general catalog table within the .mdb file with all component types in it. AutoCAD Electrical will reference this table, if it exists. The table name is MISC_CAT. If found, this catalog information will display in the dialog for component catalog number selection. In the Insert/Edit dialog box, Catalog Data section, click Lookup. In the Parts Catalog dialog box, click Miscellaneous.

**Use the last used assignment**

During your editing session, AutoCAD Electrical remembers the last MFG / CAT / ASSYCODE assignment you make for each component inserted into your wiring diagram. When you insert another component of that type, AutoCAD Electrical presents the previous component's catalog assignment as the default (assuming a previous one was made during the current editing session).

**Perform a drawing or project-wide search**

In the Insert/Edit dialog box, Catalog Data section, click Project to instruct AutoCAD Electrical to do a drawing-wide or project-wide listing of similar components with their catalog assignments.

**Pull information from another project**

AutoCAD Electrical quickly scans a previous project, finds the instance of that component, and returns the catalog information to you. This is accomplished without leaving your active drawing. In the Insert/Edit dialog box, click Project. In the Find: Catalog Assignments dialog box, select Other project and click OK. AutoCAD Electrical processes the project you select. It quickly scans each listed drawing for the target component type and returns a dialog list of what it found. You can then make your catalog assignment by picking from this dialog list.

**Pull from an external file**

You can pull catalog assignments from a generic ASCII file created by a word processor or output from a spreadsheet or database program. In the Insert/Edit
dialog box, Catalog Data section, click Project. In the Find: Catalog Assignments dialog box, select External file, and click OK.

**Pull from your own external database application**

AutoCAD Electrical provides a means to bypass its internal catalog part number look-up and temporarily pass control to your custom catalog part number selection application. In the Insert/Edit dialog box, Catalog Data section, click Lookup. But instead of immediately accessing the appropriate catalog look-up table, AutoCAD Electrical passes control to your application. You make the MFG/CAT/ASSYCODE selection in your own database program. Your application formats your selection and passes it back to AutoCAD Electrical.

**Add multiple BOM catalog numbers to a component**

You can add up to 10 additional part numbers to any schematic or panel component on the fly. These multiple BOM part numbers appear as sub-assembly part numbers to the main catalog part number in the various BOM and component reports. In the Insert/Edit dialog box, click Multiple Catalog to display a dialog for adding the extra catalog part numbers.

**Insert components and modify catalog information**

Vendor catalog parts lookup and assignment is crucial to enabling AutoCAD Electrical to automatically create various detailed BOM reports. It is also a key step in the workflow between control schematic wiring diagrams and derived physical panel layouts. Catalog parts lookup is through a multitable Microsoft Access database file (default_cat.mdb) shipped with AutoCAD Electrical. It is populated with a number of commonly used component part numbers and descriptions from some of the major electrical controls vendors. The database content is found at: \Documents and Settings\{username}\My Documents\Acade {release #}\AeData\Catalogs.

1. Insert a schematic component symbol onto your drawing. The Insert/Edit Component dialog box displays so you can assign component-specific information to the new component.

2. In the Insert/Edit Component dialog box, Catalog Data section, click Lookup to choose a vendor part number to be assigned to this instance of the component.

AutoCAD Electrical reads the inserted component's AutoCAD block name and determines the correct table to access in the catalog lookup database file (default_cat.mdb). The WDBLKNAM field in the family table is used as the first filter when opening the catalog lookup window for the
selection of catalog numbers. This filter removes invalid selections from
the catalog lookup window.

3 In the Parts catalog dialog box, select the vendor and catalog part number
to use.
The block's invisible MANUFACTURER, CATALOG, and ASSEMBLYCODE
attributes are populated with the key values pulled from the selected
record in the target table. Various description and miscellaneous field
values from the picked record are not saved on the block's attributes; only
the MANUFACTURER, CATALOG, and ASSEMBLYCODE values are saved.

When you are finished modifying component information, you can run the
Schematic Bill of Material report. The report queries the inserted component's
MANUFACTURER, CATALOG, and ASSEMBLYCODE attribute values; AutoCAD
Electrical then formats and outputs a detailed BOM report.

**Catalog values**
This lists the catalog part number information for any/all component (or
footprints) that have the same family block name (WDBLKNAM value) as that
of the component being edited.

| Catalog Check | Displays its bill of materials description. |
| OK | Copies the highlighted catalog info to the component being ed-

**Overview of the LISTBOX_DEF catalog database table**

This optional table can be included in the catalog database file. It allows
starting MFG/TYPE/RATING combinations to be predefined for each catalog
lookup table when AutoCAD Electrical would normally default to the values
given in the first record of the selected catalog lookup table. The records in
this table are structured as follows:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TABLENAME</td>
<td>50</td>
<td>Catalog lookup table name</td>
</tr>
<tr>
<td>Field name</td>
<td>Width</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MANUFACTURER</td>
<td>24</td>
<td>Manufacturer code to default to (Catalog lookup dialog's 1st pulldown)</td>
</tr>
<tr>
<td>LIST2</td>
<td>60</td>
<td>Type value to default to (Catalog lookup dialog's 2nd pulldown)</td>
</tr>
<tr>
<td>LIST3</td>
<td>60</td>
<td>Rating value to default to (Catalog lookup dialog's 3rd pulldown)</td>
</tr>
<tr>
<td>RECNUM</td>
<td>n/a</td>
<td>AutoNumber field (used internally)</td>
</tr>
</tbody>
</table>

Leaving a MFG, LIST2, or LIST3 field blank causes the respective pull-down to default to ALL. Example: when you first insert a relay coil symbol and open the Catalog Lookup dialog, you want the "CR" catalog table display to default to Siemens part numbers for "600V MAX AC" relays. Using a copy of Microsoft Access, open the default_cat.mdb catalog lookup file, and select table _LISTBOX_DEF. Insert a record with these field values: TABLENAME "CR", MANUFACTURER "SIEMENS", and LIST2 "600V MAX AC." The text you enter must exactly match existing field values in the target table. Save and exit. Now, when you insert a relay coil and select Catalog Lookup, the dialog box opens with these defaults displayed.

In order to browse catalog codes for accessory terminals, you have to add a line in the _LISTBOX_DEF table like: TRMS(H) MFG HARDWARE, where MFG is the manufacturer you are interested in (for example, “TRMS(H) AB HARDWARE”). Similarly, to browse catalog codes for jumpers, you have to add a line in the _LISTBOX_DEF table like: TRMS(J) MFG HARDWARE (for example, “TRMS(J) AB HARDWARE JUMPER”, where “JUMPER” is the value for LIST3).
Copy catalog assignments from component to component

This utility allows you to insert or edit catalog part numbers onto the currently selected component or footprint.

1. Click the arrow on the Edit Component tool to access the Copy Catalog Assignment tool.

2. Click the Copy Catalog Assignment tool.

3. Select the master component from which the catalog data will be copied.

4. Select the part number information by clicking Catalog Lookup, Find: Drawing Only, Multiple Catalog, or Catalog Check.
   - **Catalog Lookup:** Select the catalog table information in the Parts Catalog dialog box for the selected component type and click OK.
   - **Find: Drawing Only:** Select from the catalog part number information for any/all component footprints that have the same family block name as that of the component being edited. Click OK.
   - **Multiple Catalog:** Insert extra catalog part numbers onto the currently selected component or footprint. You can add up to 99 additional part numbers to any schematic or panel component on-the-fly. Click OK.
   - **Catalog Check:** Quickly performs a bill of material check and displays the result.

5. Click OK.

6. Select the devices to copy the catalog data to.

---

**NOTE** Child or related devices are not automatically updated; they must be included in the selection.

---

Multiple bill of material information
This tool allows you to insert or edit extra catalog part numbers on to the currently selected component or footprint. You can add up to 99 additional part numbers to any schematic or panel component on-the-fly. These multiple BOM part numbers appear as sub-assembly part numbers to the main catalog part number in the various BOM and component reports.

**Access:**

On the Insert/Edit Component or Panel Layout - Component Insert/Edit dialog box, Catalog Data section, click Multiple Catalog.

**NOTE** You can also access this dialog by clicking Multiple Catalog on the Copy Catalog Assignment dialog box (Components ➤ Component Miscellaneous ➤ Copy Catalog Assignment).

The additional catalog part numbers are saved on the symbol as MFGn/CATn/ASSYCODEn attribute values where "n" is the sequential code value "01" through "10" selected in the top list box. If these attributes are not present on the symbols, AutoCAD Electrical saves the information as Extended Entity Data (Xdata) on the symbol's block insert.

**Sequential code**

Adds up to 99 extra part numbers (in addition to the main catalog part number). Pick which one you want to add or inspect/edit. Click the list button to show all extra part numbers carried on the component.

**Catalog Data**

Specifies the catalog part number information such as the manufacturer and catalog number.

**Count**

Specifies the quantity number for the extra part number (blank=1). This value gets inserted into a BOM report’s "SUBQTY" column.

**Unit**

Specifies the unit of measure, which can be displayed in the component list report.
**Parts Catalog Lookup**

Lists the catalog database table that is to be referenced for the description information for the given Manufacturer/Catalog/Assembly combination. For each catalog entry you must provide a name for the catalog look-up table. For the main catalog entry this information is provided on the symbol itself but may not be there for these catalog entries. Select List to pick from a list of tables that are contained in your catalog database file or Misc to use the MISC_CAT table.

**Catalog Lookup**

Checks for and displays catalog table information in the Parts Catalog dialog box for the selected component type.

**Catalog Check**

Quickly performs a Bill of Material check and displays the result.

**Multiple catalog part number assignments**

This displays the order in which the extra part numbers will appear in the various AutoCAD Electrical reports. You can add up to 99 additional part number assignments to a component.

**Access:**

On the Insert/Edit Component or Panel Layout - Component Insert/Edit dialog box, Catalog Data section, click Multiple Catalog. Click List Sequential Code on the Multiple Bill of Material Information dialog box.

**NOTE** You can also access this dialog by clicking Multiple Catalog on the Copy Catalog Assignment dialog box (Components ➤ Component Miscellaneous ➤ Copy Catalog Assignment) and then clicking List Sequential Code.

To change the order, highlight the part number and click Move Up or Move Down to move it in the list.
Show missing catalog assignments

Use the Components ➤ Component Miscellaneous ➤ Show Missing Catalog Assignments tool to graphically indicate or list the parent or stand-alone components that do not carry catalog information on the active drawing.

Show
Displays the components that do not carry catalog information. They are marked on the screen with a red diamond shape drawn around the symbol's insertion point in temporary graphics. A REDRAW restores the screen to its original state.

Report
Extracts the information from the active drawing or project and displays a list of parent or stand-alone components without catalog information.

TIP
Extracted BOM data can be output to a spreadsheet file, mdb database file, text report file, or comma-delimited for export to a spreadsheet or database program. It can also be inserted, in tabular form, on the current AutoCAD drawing.

Use pin lists

AutoCAD Electrical can automatically track how many contacts have been assigned to a device like a relay or timer coil. When a newly inserted contact exceeds a predefined limit, AutoCAD Electrical can alert you. AutoCAD Electrical can also track available terminal pin number pairs as you insert each new contact and automatically give you the next available pair as a default.

To enable this feature, maximum contact count and pin number pair information is assigned to the parent symbol (ex: relay or timer coil symbol). It is carried as Xdata under the name "WD_PINLIST" or, if a PINLIST attribute is present on the parent device, the pin list is carried on this invisible attribute. A copy of this pin list data is carried in the project's Access database file (<project>_cat.mdb or default_cat.mdb) in a table called _PINLIST. This information can be assigned manually or it can be automatically retrieved from a pin list database table when a catalog part number is assigned to the parent device. Then, as each contact is inserted and referenced back to the
parent, AutoCAD Electrical checks the pin information carried on the parent and verifies that a contact of the proper type is available. If so, it retrieves the next pair of contact pin numbers from the parent and displays as defaults for the new contact.

The AutoCAD Electrical automatic pin list lookup and assignment at component insertion time is not limited to devices that have contacts. You can encode two wire devices like pilot lights or proximity switch into the database file. Insert the MFG and CAT numbers and fill in the COILPINS field with the terminal pin numbers. Leave the PINLIST field blank. Now, when you insert one of these devices and do a Catalog lookup and part number selection, AutoCAD Electrical quickly looks for a MFG/CAT match in the pin list database. On a match AutoCAD Electrical pulls out the device’s coil pin numbers and automatically inserts them on to the newly inserted device.

**Pin list data carried on the parent**

When AutoCAD Electrical annotates a parent coil or other device with the pin list information, AutoCAD Electrical inserts it on the following attributes (if present):

- **PINLIST**: The pin list format string of 3-element groups, one for each available contact
- **MAXNO**: Maximum N.O. contact count, blank means undefined, 0 means none allowed
- **MAXNC**: Maximum N.C. contact count
- **MAXNONC**: Maximum convertible contact count

If these attributes are not present, AutoCAD Electrical encodes the data on to the symbol as extended entity data. If AutoCAD Electrical finds a MFG/CAT match in the pin list database and retrieves the encoded pin list information, it pre-fills the MAXNO, MAXNC, and MAXNONC values with the quantities derived from the decoded pin list data.

To view or manually edit these values, select Edit Component and click the NO/NC Setup button on the Insert/Edit dialog box. AutoCAD Electrical maintains a copy of the parent's PINLIST information in the project's scratch database file (in Microsoft Access format). You can view this by opening the PINLIST table of the wd\user\<projname>.mdb database file.
Modify the pin list database

The pin list database file can be viewed, edited, and expanded using the Pin List Database Editor tool.

**NOTE** This tool is not limited to relays and timers, but can be extended to other switch types that can have extra contacts, plug/jacks, and stand-alone PLC I/O points.

1. Click Component ➤ Cross-Reference ➤ Pin List Database Editor.
2. In the Select Pin List Table dialog box, select the table to edit and click Edit.
   
   **NOTE** You can also create a new table by entering the manufacturer name in the edit box and clicking Create.

3. In the Edit dialog box:
   - To edit an existing record, click Sort, Filter, or Find to search for the record to edit. Select the record from the list and click Edit.
   - To create a new record, click Add New, or select an existing record and click Add Copy to create a new record based on an existing one.
   - To delete an existing record, select the record in the list and click Delete.

4. To edit or create a new record, in the Edit Record dialog box, specify the values to assign to the record and click OK.

5. In the Edit dialog box, click Save/Exit.

Select pin list table

This tool allows you to select the relevant PINLIST table to edit or create a new one.

**Access:**

Click Components ➤ Cross-Reference ➤ Pin List Database Editor.

Select or Type Manufacturer

Lists all of the PINLIST tables that are in the catalog database. The "(Default)" manufacturer is used to edit the generic .PINLIST table.
Select the table to edit or enter a name for a new one.

**Table**

Displays the proper table name in the catalog database. This text changes depending on which manufacturer is selected. For example, if you select SQD, then _PINLIST_SQD displays.

**Create**

(available only when you enter the name of a manufacturer) Creates a new table in the catalog database with the specified name and adds the table to the list of manufacturers. Once a table is created, the Edit (Table: _PINLIST_manufacturer) dialog box displays so you can edit the new table.

**NOTE** The following characters are not allowed in the table name: ~ @ # $ % ^ & * - + = \ { } " ' ; : ? / < > , ![ ] . These characters are replaced with an underscore (_) if entered in the edit box.

**Edit**

(available only after a manufacturer is selected from the list) Opens the Edit (Table: _PINLIST_manufacturer) dialog box so you can edit the selected PINLIST table.

**Edit**

AutoCAD Electrical consults a pin list database table when a part number is added or an existing part number is changed on a parent schematic symbol. If AutoCAD Electrical finds a match on the part number's MFG, CAT, and optional ASSYCODE values in this database table, then the associated contact count and pin number information is retrieved and placed on the parent schematic component.

**Access:**

Click Components ➤ Cross-Reference ➤ Pin List Database Editor. Specify the table to create and click Create or select the table to edit and click Edit.

This lookup database table is a table within the catalog lookup Access .mdb file. The default file name is default_cat.mdb, table _PINLIST, and comes populated with a sample of vendor data. You can expand this table as needed.
Use your own copy of Microsoft Access or use this dialog box to add new entries, add entries based on existing entries, edit, and delete entries from the table.

Sort  
Sorts the list of database records using either an alphanumeric sort or number values. You can specify 4 sorts to perform on the list.

Find  
Sorts the list of database records using either an alphanumeric sort or number values. You can specify 4 sorts to perform on the list.

Replace  
Indicates to replace the find value with the new text string that you specify.

Filter  
Filters the listing based on certain values in the table. Picking the blank entry in the list removes the filter for that field. After you define the values to filter, apply the filter in the database editing window.

Edit  
Displays the Edit Record dialog box for modifying the existing record in the database.

Add New  
Displays the Edit New Record dialog box for entering a new record into the database.

Add Copy  
Displays the Edit Copied Record dialog box for modifying and copying the record to make a new record. You cannot have two duplicate copies in the database.

Delete  
Removes the selected record from the database.

Structure of the pin list database table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RECNUM</td>
<td>(Microsoft Access internal use)</td>
</tr>
<tr>
<td>MANUFACTURER</td>
<td>Manufacturer code (value must be consistent with the catalog lookup files)</td>
</tr>
<tr>
<td>CATALOG</td>
<td>Catalog number (use wildcards as much as possible)</td>
</tr>
</tbody>
</table>
ASSEMBLYCODE  AutoCAD Electrical internal assembly code (must be consistent with the catalog lookup files)

COILPINS  Terminal pin numbers for coils (separate multiple pins with commas)

PINLIST  Contact type and pin numbers

PEER_COILPINS  Terminal pin numbers for peer coil

PEER_PINLIST  Contact type and pin numbers

Edit record

Access:

Click Components ➤ Cross-Reference ➤ Pin List Database Editor. Specify the table to create and click Create or select the table to edit and click Edit. In the Edit dialog box, click Add New, Add Copy, or Edit.

MANUFACTURER

Specifies the Manufacturer code (value must be consistent with the catalog lookup files).

CATALOG

Specifies the Catalog number (use wildcards as much as possible).

ASSEMBLYCODE

Specifies the AutoCAD Electrical internal assembly code (must be consistent with the catalog lookup files).

COILPINS

Specifies the terminal pin numbers for coil. This is generally two pin numbers separated by a comma (for example, K1,K2), but is not limited to just two pin numbers. At insertion/annotation time, AutoCAD Electrical will take this list and apply it to the TERMxx attributes it finds on the parent symbol. If the
parent itself can be either a N.O. or N.C. contact, encode the COILPINS field in a manner similar to the PINLIST field. For example, "1,A1,A2;2,B1,B2" for the COILPINS field for a target mfg/cat record in the _PINLIST table will apply pins "A1/A2" to the parent device pins if the device is a generic N.O. and "B1/B2" if it is a generic N.C. device. Repeat these values in the PINLIST field so that AutoCAD Electrical can correctly track all contacts.

**PINLIST**

Specifies the Contact type and pin numbers. This is a sequence of two or more element groups with each group defining one available child contact element for the device. For a two terminal contact there are three elements in the group. It follows this format:

Contact type, terminal pin, terminal pin

where Contact type = 1 for N.O., 2 for N.C., 0 for convertible contact, , 3 for Form-C (NO/NC pair), 4 for multi-pole terminal strips or undefined type, and 5 for multiple-pin or stacked terminals. AutoCAD Electrical also allows a description label associated with a pin pair. To add description labels, encode the _PINLIST database table entry using a format like this:

1,A1X,A1Y;1,A2X,A2Y,*aux contact=*;2,B1X,B2Y,*NC=;

where the optional comment is always the last element of the sublist and is preceded by an asterisk character (if no asterisk, then the comment is interpreted as another pin number). The previous example would display in the pin list pick list dialog as:

A1X,A1Y
aux contact=A2X,A2Y
NC=B1X,B2Y

Convertible contacts encoded as type 0, followed by two pin numbers, assume that the pin numbers do not change when a contact is flipped from N.O. to N.C. or vice versa. If the contact's pin number actually does change based upon whether in a N.O. versus N.C. configuration, encode each type 0 entry as "0,pinNO,pinNO,pinNC,pinNC;". The first two entries after the "0" flag give the pin number for the N.O. configuration and the second two for the N.C. configuration. AutoCAD Electrical picks the correct pair based upon the contact type being inserted or edited.

For contact type 3 (Form-C), the pins must be entered in this order: common pin, NO pin, NC pin. A Form-C contact set with NO on pin 5, NC on pin 6, and pin 8 common to both contacts would be encoded as 3,8,5,6 where "3"
flags "Form-C", "8" is the common pin, "5" is the NO pin, and "6" is the NC pin.

**PEER_COILPINS, PEER_PINLIST**

There can be two additional "PEER_" fields in the _PINLIST table for defining special cases where a single part number calls out two parent devices. For example, a reversing motor starter part number might include two parent contactor coils, one for forward and one for reverse. Each parent coil symbol needs to have its own pin list assignment. You set up the second coil’s coil pins and pin list data in the PEER_COILPINS and PEER_PINLIST fields for the common part number.

- **PEER_COILPINS**: Terminal pin numbers for peer coils.
- **PEER_PINLIST**: Contact type and pin numbers.

**Set pin list assignments for special uses**

You can set up subcategories of type 4 pin combinations so that some will apply to specific contact types and other pin combinations to other contact types. You can also use a type 4 PINLIST assignment to track and control how many schematic terminal symbols can be tied to a given terminal tag-ID.

**For filtering of special contact use**

You can set up subcategories of type 4 pin combinations so that some will apply to specific contact types and other pin combinations to other contact types. Encode the Pin List entries with a "4" plus a character to provide further filtering of what contacts are available for a given child contact. At the contact end, make sure that an attribute PINLIST_TYPE (or Xdata of the same name) carries a value of "4" plus a character to match up with the coding in the pin list string.

For example, a given device has 5 N.O. contacts but they are not all the same. Three of them are motor contacts and 2 are auxiliary control contacts. Two different schematic symbols are created - one to be used to show the heavy-duty motor starter contacts and another symbol to be used for auxiliary contacts. Set up the motor starter contact symbol with attribute PINLIST_TYPE with a value of "4C" and the auxiliary contact symbol with PINLIST_TYPE value "4A."

Now, in the _PINLIST database table, encode the part number’s pin list information with type "4" entries but use "4A" and "4C" to differentiate which
contact pin combinations are for the auxiliary contacts and which ones are for the starter contacts.

4A, 1L, 2L; 4A, 1R, 2R; 4C, L1, T1; 4C, L2, T2; 4C, L3, T3

When either symbol is inserted and associated with the parent, AutoCAD Electrical sees the symbol's PINLIST_TYPE value. The contact combinations that do not apply to the inserted component type are filtered out. Inserting a N.O. auxiliary motor starter contact (preset with PINLIST_TYPE attribute value of 4A) triggers AutoCAD Electrical to pick the next available 4A pin list combination of 1L/2L or 1R/2R. Inserting a N.O. main motor contact symbol (present with PINLIST_TYPE attribute value of 4C) triggers AutoCAD Electrical to pick the next available 4C pin list combination (L1/T1, L2/T2, or L3/T3).

For multipole terminal block units

You can also use a type 4 PINLIST assignment to track and control how many schematic terminal symbols can be tied to a given terminal tag-ID (ex. a given terminal strip has a fixed number of terminals). For example, let's say you have a fixed, 6-pole terminal strip unit with a manufacturer code of AB and a catalog part number 1492-HJ86 with pin markings on the terminal strip that are identified as 1 through 6. Set up the _PINLIST database with the AB and 1492-HJ86 combo defining a PINLIST of 4,1; 4,2; 4,3; 4,4; 4,5; 4,6. In the schematic, insert the first terminal of a 6-pole terminal strip, with a TAG-ID of "TB-1" and do a catalog lookup. Assign the "AB" part number "1492-HJ86." AutoCAD Electrical finds the pin list information and applies it to the first peer terminal symbol as an attribute value. Now, as you insert additional terminals for this TB-1 terminal strip, AutoCAD Electrical tracks what the next available terminal number is (based on the 1st terminal's PINLIST data). When you try to insert the 7th terminal for TB-1, you're alerted that there are no more terminals available for this multi-pole terminal strip.

NOTE This information was previously found in a separate Access file called wd_pins.mdb. When you use the conversion tools to convert your old .dbf catalog files to the Access file, this file is converted to the _PINLIST table within the catalog file.
Reports

In this chapter

- Generate reports
- Schematic Reports
- Panel Reports
- Overview of format files
- Run automatic reports
- Modify spreadsheet data
- Create user-defined attributes
- Export to Autodesk Inventor Professional
Generate reports

There is a lot of flexibility with AutoCAD Electrical reports, which can be run manually or automatically. AutoCAD Electrical extracts multiple fields into each report type. Different reports contain different fields of information. When running a report, you can select which fields to include and which fields to ignore. You can also add your own fields by creating a user-defined attribute support file (.wda) using the User Defined Attributes List tool. Any attributes listed in your User Defined Attributes file are added as available fields to each report. You can strip out some of the field columns of data and create other useful types of reports. For example, run a component report, strip out everything except the TAGNAME, DESC1, DESC2, and DESC3 field columns and you have a legend plate report. If you don't see the specific report that you need, take advantage of the AutoCAD Electrical flexibility and create your own.

There are some features that are common to most of the AutoCAD Electrical reports. You can extract by location or installation values, edit the report, change the report format, post-process the report with your own programs, save the report out to a file, print the report, and put the report on your drawing as a table.

AutoCAD Electrical provides a number of Schematic (page 897) and Panel (page 923) reports. Reports can be formatted from the Report Generator dialog box or preformatted using Format Files (.set files).

Modify report templates

You can modify Microsoft Excel report templates "wd_template.xls" and "wd_template_w_macro.xls" so that the report displays the way you need it to without having to manually modify the report output each time a report is run. You can change the orientation of a template file to open in Landscape mode rather than Portrait mode by modifying the template and saving it. Run a report and save to an Excel file. When the Excel file is opened, it displays in Landscape mode.

NOTE If you are using the Export Drawing to Spreadsheet tool, modify the "wd_xls_all_template.txt" template.

TIP Changing some of the setup on template files (such as changing the text in the first row or the sheet names) can cause the export to fail. Before modifying any template files, save copies so that you can revert back to the original version if necessary.
**Place reports on drawings**

Once you generate a report you can place it on a drawing or drawings by clicking "Put on Drawing" in the Report Generator dialog box. This displays the Table Generation Setup dialog box where you can select options to format the look of the table.

Report tables can be updated once they have been inserted, saving you the trouble of the setup each time. When a report table is inserted, some intelligence is added to the table object so AutoCAD Electrical can determine which report this table was for. There are 3 items that make a report table unique:

- The report that generated the table (i.e. Bill of Materials, Wire From/To, Component, and so on.)
- The scope of the report (for example, project, active drawing, and so on.)
- The format file (.set file) used to generate the report

If a report is run and a table exists that matches these 3 items, then instead of inserting a new report table, the existing table objects update with the current information.

If you want to insert a report table that will not be updated, select "Insert New (not updatable)." This inserts a report table without the intelligence so that when you run the same report again, the table is not updated.

**Break report tables**

You may want to break a report into multiple tables. You can do this from the Table Generation dialog box without having to run the report multiple times or clicking "Put on Drawing" multiple times. You can break the report table by specifying the number of rows per section. If an entry in the report contains multiple lines of text, such as a Bill of Materials description, each line of text is considered a row. A table will not be broken in the middle of a multi-line entry but the entire entry is moved to the next section.

You can also break a report into sections based on some report fields. This must be selected in the Report Generator dialog box. Different reports may have different Special Breaks available. After you select Special Breaks, and click Put on Drawing, the Apply Special Breaks option is available in the Table Generation Setup dialog box. This option inserts a table object for each section based on the Special Breaks. These multiple table objects (if inserted as updatable) are considered one report table by AutoCAD Electrical and can be
updated and edited as one report using the AutoCAD Electrical Edit Component command.

**Breaking a Report Table across Multiple Drawings**

You can break a report table across multiple drawings if the scope of the report is set to Project and not Active Drawing. In the Table Generation Setup dialog box, once you have defined a break as described above, you can define how many table sections should be placed on each drawing. A blank Sections On Drawing value indicates unlimited sections on the same drawing and you are not prompted for another drawing. Once you enter a Sections On Drawing value, when you reach that value you are prompted for another drawing. If you select a new drawing, you can enter the folder and name for the drawing. Once generated, the drawing is added to the AutoCAD Electrical project. These multiple table objects (if inserted as updatable) are considered one report table by AutoCAD Electrical and can be updated and edited as one report using the AutoCAD Electrical Edit Component command.

**Table generation setup**

This displays your report as a table on your drawing. Once you select OK from the Table Generation Setup dialog box, your cursor will look like a box with a small ‘x’ in the corner. The box is the size the table will be when generated. This allows easy placement of the table on your active drawing file. To use object snap mode, enter an "S" at the command line and AutoCAD Electrical will flip to a normal AutoCAD pick mode so you can use an object snap.

**Access:**

Click the Put on Drawing button on any of the report generation dialog boxes.

**Table**

The available options depend on whether a matching table exists when you click the Put on Drawing button. If there isn't a matching table on the drawing, the Insert New and Insert New (non-updatable) options are available. If a matching table exists on the drawing, the Insert New (non-updatable) and Update Existing options are available.

- **Insert New**
  Inserts a new updatable table. If there is an existing table, new (non-updatable) tables are inserted.

- **Insert New (non-updatable)**
  Inserts tables with no intelligence.
Update Existing  Updates existing tables. If existing tables do not exist, new updatable tables are inserted.

Text

Defines the height, color, and line spacing for the text used in the table. To define the text color, click the Text Color box. The standard AutoCAD color selection dialog box opens, displaying the color selections.

The minimum Spacing value is based on the specified text height and the vertical cell margin of the table style. If you change the text height the spacing value automatically recalculates. If it is too small it is changed to the minimum value. If you change the spacing value it is compared to the minimum value. If it is too small an alert displays and the value adjusts to the minimum value.

Column Labels

Defines whether to include the column heading, the color of title text labels, and the visibility of the column labels.

Include Column Labels  Uses the column headings as the first row of the table.

Label Color  To define the title text color, click the Label Color box. The standard AutoCAD color selection dialog box opens, displaying the color selections.

Show Labels on First Section Only  Indicates to only show the title on the first section of the table, if multiple sections are used. If not selected, the labels will be shown on all table sections.

Title

Defines the table title attributes.

Include time/date  Shows the report's time and date above the table.

Include project info  Shows the project description lines above the table. You select which lines will display in the project description dialog box.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include title line</td>
<td>Shows the report's title above the table. When the checkbox is active, you may modify the default report title.</td>
</tr>
<tr>
<td>Include special break values</td>
<td>Specifies to include special break values for the title line of each section. Special break values will appear on each respective section regardless if the Show Title on First Section Only checkbox is selected.</td>
</tr>
<tr>
<td>Title color</td>
<td>Specifies what color to use for the table title. To define the text color, click the Title Color box. The standard AutoCAD color selection dialog box opens, displaying the color selections.</td>
</tr>
<tr>
<td>Show Title on First Section Only</td>
<td>Indicates to only show the title on the first section of the table, if multiple sections are used. If not selected, the labels will be shown on all table sections.</td>
</tr>
</tbody>
</table>

**Layer**

Specifies which layer to place the table on.

**Column Width**

Specifies the method to use for calculating the width of the columns. You can either have AutoCAD Electrical automatically calculate the column width based on text values for each field or you can define a width for each column. The text will word wrap if the column width is less than the overall length of the text string.

**Borders**

Specifies whether to display borders around the table. You can display all table borders, a border around just the outside of the table, or not have any borders at all.

**First New Section Placement**

Specifies where to place the table in the drawing. You can enter x and y values or pick a point on the screen. The table appears at the specified coordinates once you click the OK button.
**Row Definition**

Specifies the number of table rows, the start and end lines, the number of rows for each section, and whether to build the table from the bottom up.

**Start Line/End**

The starting and ending lines reflect the total number of rows displayed in the Report Generator dialog box. These values default to previously used values on subsequent runs of the report.

**Build Up**

Creates the table from the bottom to the top; meaning that the last line is created first and the first line is created last. The table title appears at the bottom of the report table when this option is selected.

**Apply Special Breaks**

Breaks the table sections based upon the selected break criteria. For example, if you select Manufacturer as the Special Break and there are 15 different manufacturers in the report, your report will be broken into 15 sections.

**Rows for Each Section/Rows**

Specifies the maximum number of rows for the table or section, determining when to split the table.

**Force to Maximum Rows**

Directs AutoCAD Electrical to add blank lines at the end of a table section if necessary until the number of rows equals the Rows setting. Individual records cannot be split into two separate sections.

**Section Definition**

Defines the number of sections on the drawing and the distance between sections on the same drawing. If the Sections value is set to 1, the X-Distance and Y-Distance options are disabled.

**Sections**

Specifies the maximum number of table sections for this report. A blank value indicates an unlimited number of sections on one drawing.

**X-Distance**

Specifies the X-distance from the end of one table section to the beginning of the next. The sections are on the same drawing.
Y-Distance

Specifies the Y-distance from the end of one table section to the beginning of the next. The sections are on the same drawing.

Optional script file reference

This provides the option to save the report file to a script file. You can set up this script file to automatically know the file name of the report you just created. For AutoCAD 2000 and later, the report’s file name can be retrieved using the AutoLISP expression (v1-bb-ref ‘FNAM).

Access:

Click the Save to File button on a report dialog box (such as Schematic Bill of Materials). Select the report type and click OK; then select the file to save and click Save.

The file location and name for your report is displayed at the top of the dialog box.

Run Script

Passes the report file to a script file. This provides a link to post-processing the data or automatically passing it on to another application.

Close - no script

Closes the dialog box without creating a script file.

Script file options reference

Displays if the report file was created and saved. The report filename and location are displayed in the title bar of the dialog box. You can execute a script file and passes the report filename to it. The filename is carried in an AutoLISP variable called FNAM.

Access:

Click the Save to File button on a report dialog box (such as Drawing Extract for all locations). Select the report type and click OK; then select the file to save and click Save. In the Optional Script File dialog box, select Run Script.

Print

Prints the default script file.
Other

Opens a sub-dialog box for selecting a user script file.

**Edit report**

Use this utility to modify a report before you insert it on to your drawing as a ruled text table.

**Access:**

Click the Edit Mode button on any of the report dialog boxes (such as the XLS, CSV, or MDB File or Bill of Material dialog boxes).

**NOTE** Different options are available depending on which type of report you are editing.

**New Lines**

Indicates to add new lines above or below the selected line, or as a sub-assembly of the selected line.

- **Add from Catalog:** Opens a sub-dialog box for selecting which catalog lookup table to open. From this catalog table, you can select a part to add to the report.

- **Add New:** Creates a new report line entry. Enter the values in the input boxes and click OK.

- **Add Copy:** Creates a copy of the selected line entry. Modify the values in the input boxes and click OK.

**Edit or Delete lines**

- **Edit:** Opens a sub-dialog box for editing the values for the selected line.

- **Delete:** Removes the selected line from the report.

  If you do not select all of the lines that make up a single entry, AutoCAD Electrical automatically deletes all the report lines that make up that entire entry. However, if the report contains sub-assembly items, they are not deleted when the main entry is deleted.
Re-order lines

Re-orders the lines with the Sort, Move Up, Move Down, Move to Top, and Move to Bottom buttons.

- **Move Up**: Moves the currently selected line(s) up one place in the report.
- **Move Down**: Moves the currently selected line(s) down one place in the report.
- **Move to Top**: Moves the currently selected line(s) to the top of the report.
- **Move to Bottom**: Moves the currently selected line(s) to the bottom of the report.
- **Smart Swap**: Swaps "**1**" with "**2**" values in all selected lines. For example, in the Wire From/To report there may be field names LOC1 and LOC2. LOC1 is the location code for the component at one end of the wire and LOC2 is the location code for the component at the other end. This feature swaps the values of these fields.

Report generator

Displays the results of the report generation. The dialog box options that are available depend on which report you are creating.

Access:

Select to create any schematic or panel report. Specify whether to process the project, the active drawing, or selected components, and click OK.

Header

Displays the selected items at the top of each section in the report.

Add

Displays the header information inside the report. Select to add the time/date, a title line, project lines, or column labels.
First Section Only
Displays the selected header item at the top of the first section only. The header information is no longer displayed at the top of each section.

Breaks
Controls how the report breaks across multiple pages. Only one check box can be selected at a time. Specify whether to add page breaks or special breaks to the report.

Add page breaks
Breaks the report at the 58th line.

Special breaks
Specifies the value that controls the section break. You can break the report into sections based on the special break selected from the list. The list displays the report-specific content to apply to the special break. For example, selecting Wire Layer displays the wire label records in different sections based on the wire layer data.

Add special break values to header
Adds the special break value to the header. For example, if you select a special break of Installation/Location, the values provided for these devices in the schematic are displayed in the report section header.

Suppress subcatalog entries
(for Component Report only) The component report displays all components and their related catalog numbers. A component can have one or many catalog numbers associated to it based upon whether or it is set up with subcatalog numbers or if you choose to assign multiple BOM items to the component. This removes the extra catalog numbers from the report and displays only the primary catalog number from the Insert/Edit Component dialog box.

Pin chart
(for Connector Plug Report only)
The Connector Plug report displays the wiring information associated to a pin symbol in the form of a chart based upon a similar Component tag. Selecting "On" displays another dialog to set up the chart and yields just the
specified information into the report generator for printing, saving to a file, or placing in a table on the drawing.

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Displays all component tag names in the report.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove duplicated pin numbers</td>
<td>Eliminates any duplicate pin numbers for the selected plug from the report.</td>
</tr>
<tr>
<td>Left Side / Right Side</td>
<td>Displays the wiring information from the left or right side of the pin symbols. This displays what is connected to the pin and the wiring information.</td>
</tr>
<tr>
<td>Fill In Missing Pin Numbers</td>
<td>Identifies additional pin numbering not defined in the schematic for spare pin connections. For example, the connector may have used 4 out of 9 pins in the schematic and those are the connections that are being reported. You can then display the 5 spare pin connections by selecting this check box and identifying the first pin number as 1 and the last as 9. Label for spares displays a text string under the wire number column in the report.</td>
</tr>
</tbody>
</table>

**Internal/external codes left/right**

(for Terminal Plan Report only) Allows the Terminal Plan report to take advantage of terminals that have the optional "I" (Internal) and "E" (external) codes on the wire connection. With this check box selected, you can select from the radio buttons below it to sort within an entry. You can show all of the Internal or External connections on the left or on the right of the wire connection.

**Squeeze**

Specifies whether to reduce the width of the report. Select 1 for maximum squeezing and 3 for minimum squeezing.

**Add blanks between entries**

Adds a blank line between report entries.
Insert as Terminal Strip

(for Panel Terminal Strip Report only) Opens the Panel Terminal Strip Graphical Report - Parameters dialog box for defining a graphical representation of the terminal strip to place on the active drawing file.

Plug/Male side - Jack/Female side - Show All

(for Connector Details Report only) These 3 radio buttons work with the Type attribute value of either P or J for Plug (male) or Jack (female). When the pin symbol is created you can define a Type attribute that defines these characteristics. Then when reporting you can select Plug or Jack to filter the overall report (or you can choose to show all).

Sort

Sorts the report. You can specify four sorts to perform on the list.

User Post

Sets up options for running a post-process report before saving the report to a file or inserting as a table onto your drawing. When you click User Post, the /viawd/wd/comp.lsp LISP routine runs a function against the data and returns to the Report Generator Window.

The LISP routine can be modified to meet your needs. It has a dialog that you can customize and call your own programs.

Display Setup

(for Wire Label report only) Sets up options for label quantity, horizontal or vertical arrangement of data, display selection of wire labels and cable labels, and total number of columns for displaying the report.

<table>
<thead>
<tr>
<th>Display Wire Label</th>
<th>Displays the wire label for all wires in the specified format.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Cable Label</td>
<td>Displays the cable labels in the specified format.</td>
</tr>
<tr>
<td>Label Arrangement</td>
<td>Arranges the wire label horizontally or vertically across the columns.</td>
</tr>
</tbody>
</table>
Specifies the quantity of wire labels or cable labels. Wire labels are generated for every wire connection while cable labels are generated once for every cable.

Number of Columns to Display
Arranges the wire labels in the specified number of columns.

**Change Report Format**
Changes what data fields are reported and the order in which they appear.
(for Wire Label report only) There are two categories that you can change the report format for: wire label or cable label. Once you modify the report format, you can save it for future use. The wire and cable label formats are stored in the same file.

**Surf**
Surfs to the offending symbols. This is generally used for the Missing Level/Sequence Assignments and Wire Annotation Exception reports.

**Edit Mode/Edit Wire Label/Edit Cable Label**
Modifies the report before you insert it to your drawing. You can move data up or down in the report, add lines from a catalog, and delete lines.

**Put on Drawing**
(Not applicable for Wire Label reports) Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

**NOTE** Tables should be placed on drawings that are part of the active project only.

Once wire label reports are placed on the drawing in table format they are not editable using the Edit Component tool. You must use the AutoCAD table edit command to edit the table.

**Save to File**
NOTE Depending on the file type, you may have the ability to include the project’s LINEX values. These are the values in the 24 description lines entered for the project.

**Print**

Prints the report. Select the printer, print range, and number of copies.

**Conduit marker data fields to display**

Changes what data fields are reported and the order in which they appear.

**Access:**

On the Conduit Marker toolbar, click the arrow on the Conduit Reports tool to access the Conduit Marker Report tool. Run the report and click Change Report Format on the Report Generator dialog box.


**Available Fields**

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

**Fields to Report**

Lists the fields to display in the report.

**Remove/Remove All**

Removes the selected field or all fields from the Fields to Report list.

**Move Up**

Moves the selected field up one spot in the Fields to Report list.

**Move Down**

Moves the selected field down one spot in the Fields to Report list.

**Change field name/justification**

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display,
printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

**Available Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAG</td>
<td>Component tag name</td>
</tr>
<tr>
<td>SIZE</td>
<td>Conduit size (diameter)</td>
</tr>
<tr>
<td>MFG</td>
<td>Manufacturer or vendor name (i.e. Siemens)</td>
</tr>
<tr>
<td>CAT</td>
<td>Catalog part number assignment</td>
</tr>
<tr>
<td>ASSYCODE</td>
<td>Optional assembly code value used in catalog lookup query to get part number groups</td>
</tr>
<tr>
<td>WIRENO</td>
<td>Wire number</td>
</tr>
<tr>
<td>WIRELAY</td>
<td>Wire layer</td>
</tr>
<tr>
<td>WIREDESC</td>
<td>Wire type description</td>
</tr>
<tr>
<td>WIREDIA</td>
<td>Wire gauge or diameter</td>
</tr>
<tr>
<td>SPARES</td>
<td>Type of spare or unused wires</td>
</tr>
<tr>
<td>SP/CNT</td>
<td>Count of spare or unused wires</td>
</tr>
<tr>
<td>DESC1-2</td>
<td>Description attribute values 1-2</td>
</tr>
<tr>
<td>HDL</td>
<td>Entity handle number</td>
</tr>
<tr>
<td>SH</td>
<td>Sheet - the %S value</td>
</tr>
<tr>
<td>LEN</td>
<td>Length (calculated wire length)</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>INST1</td>
<td>&quot;From&quot; device's installation code (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>LOC1</td>
<td>&quot;From&quot; device's location code (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>CMP1</td>
<td>&quot;From&quot; device's component tag ID (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PIN1</td>
<td>&quot;From&quot; device's wire connection terminal number (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>INST2</td>
<td>&quot;To&quot; device's installation code (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>LOC2</td>
<td>&quot;To&quot; device's location code (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>CMP2</td>
<td>&quot;To&quot; device's component tag ID (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PIN2</td>
<td>&quot;To&quot; device's wire connection terminal number (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>CBL</td>
<td>Cable tag</td>
</tr>
<tr>
<td>CBLWC</td>
<td>Cable wire or cable core color</td>
</tr>
</tbody>
</table>

**Drawing list data fields to display**

Changes what data fields are reported and the order in which they appear.

**Access:**

In the Project Manager, right-click the project name and select Drawing List Report. Run the report and click Change Report Format on the Report Generator dialog box.

In the Project Manager, right-click the project name and select Drawing List Report. Run the report and click Change Report Format on the Report Generator dialog box.

**Available Fields**

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.
**Fields to Report**

Lists the fields to display in the report.

**Remove/Remove All**

Removes the selected field or all fields from the Fields to Report list.

**Move Up**

Moves the selected field up one spot in the Fields to Report list.

**Move Down**

Moves the selected field down one spot in the Fields to Report list.

**Change field name/justification**

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

**Available Fields**

**NOTE** Additional fields may display if the drawing or project is set up with a title block association. The title block association can be made either through the Acade_title block with the WD_TB attribute or if there is a .WDT file (can be project-specific or just a default one).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FILENAME</td>
<td>AutoCAD drawing file name (.dwg)</td>
</tr>
<tr>
<td>SH</td>
<td>Sheet - the %S value</td>
</tr>
<tr>
<td>SHDWGNAM</td>
<td>Drawing name - the %D value</td>
</tr>
<tr>
<td>SEC</td>
<td>Drawing SEC assignment</td>
</tr>
<tr>
<td>SUBSEC</td>
<td>Drawing SUBSEC assignment</td>
</tr>
</tbody>
</table>

820 | Chapter 14 Reports
Cable insert/edit data fields to display

Changes what data fields are reported and the order in which they appear.

Access:

Click the arrow on the Cable Markers tool to access the Multiple Cable Markers tool. Run the report. Select the location codes for the report and click Change Format on the Cable Insert/Edit dialog box.

From the Wires menu, select Cables ➤ Multiple Cable Markers. Run the report. Select the location codes for the report and click Change Format on the Cable Insert/Edit dialog box.

Available Fields

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report

Lists the fields to display in the report.

Remove/Remove All

Removes the selected field or all fields from the Fields to Report list.

Move Up

Moves the selected field up one spot in the Fields to Report list.

Move Down

Moves the selected field down one spot in the Fields to Report list.

Change field name/justification

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ig-
nored). If you put the report on the drawing, the report justification is top right.

**Available Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIRENO</td>
<td>Wire number</td>
</tr>
<tr>
<td>LOC1</td>
<td>&quot;From&quot; device's location code (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>CMP1</td>
<td>&quot;From&quot; device's component tag ID (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PIN1</td>
<td>&quot;From&quot; device's wire connection terminal pin number (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>LOC2</td>
<td>&quot;To&quot; device's location code (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>CMP2</td>
<td>&quot;To&quot; device's component tag ID (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PIN2</td>
<td>&quot;To&quot; device's wire connection terminal pin number (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>WLAY1</td>
<td>Wire layer &quot;From&quot; device (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>WLAY2</td>
<td>Wire layer &quot;To&quot; device (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>REF1</td>
<td>Line or grid reference location for &quot;From&quot; device (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>REF2</td>
<td>Line or grid reference location for &quot;To&quot; device (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>SH1</td>
<td>Sheet assignment for &quot;From&quot; device (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>SH2</td>
<td>Sheet assignment for &quot;To&quot; device (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>CBL</td>
<td>Cable tag</td>
</tr>
<tr>
<td>CBLWC</td>
<td>Cable wire or cable core color</td>
</tr>
</tbody>
</table>

822 | Chapter 14  Reports
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CBLLOC</td>
<td>Cable location attribute value</td>
</tr>
<tr>
<td>CBLMFG</td>
<td>Cable manufacturer attribute value</td>
</tr>
<tr>
<td>CBLCAT</td>
<td>Cable catalog part number</td>
</tr>
<tr>
<td>CBLASMB</td>
<td>Cable ASSYCODE assignment</td>
</tr>
<tr>
<td>DESC1CBL - DESC3CBL</td>
<td>Cable description attribute values 1 - 3</td>
</tr>
<tr>
<td>CBLP1C2</td>
<td>Cable parent or child (parent = 1, child = 2)</td>
</tr>
<tr>
<td>CMP:PIN1</td>
<td>&quot;From&quot; device's component tag and component terminal pin number</td>
</tr>
<tr>
<td>CMP:PIN2</td>
<td>&quot;To&quot; device's component tag and component terminal pin number</td>
</tr>
<tr>
<td>SEC1</td>
<td>&quot;From&quot; device's drawing section assignment (must end with '1')</td>
</tr>
<tr>
<td>SUB1</td>
<td>&quot;From&quot; device's drawing sub-section assignment (must end with '1')</td>
</tr>
<tr>
<td>SEC2</td>
<td>&quot;To&quot; device's drawing section assignment (must end with '2')</td>
</tr>
<tr>
<td>SUB2</td>
<td>&quot;To&quot; device's drawing sub-section assignment (must end with '2')</td>
</tr>
<tr>
<td>INST1</td>
<td>&quot;From&quot; device's installation code (must end with '1')</td>
</tr>
<tr>
<td>INST2</td>
<td>&quot;To&quot; device's installation code (must end with '2')</td>
</tr>
<tr>
<td>IECCMP1</td>
<td>&quot;From&quot; device's IEC tag name (must end with '1')</td>
</tr>
<tr>
<td>IECCMP2</td>
<td>&quot;To&quot; device's IEC tag name (must end with '2')</td>
</tr>
<tr>
<td>PD1</td>
<td>&quot;From&quot; device's wire connection TERMDESC value (must end with '1')</td>
</tr>
<tr>
<td>PD2</td>
<td>&quot;To&quot; device's wire connection TERMDESC value (must end with '2')</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SEQ1</td>
<td>&quot;From&quot; device's wire connection sequence value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>SEQ2</td>
<td>&quot;To&quot; device's wire connection sequence value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PNLWDLEV1</td>
<td>&quot;From&quot; device's panel equivalent level (WDLEV) value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PNLWDLEV2</td>
<td>&quot;To&quot; device's panel equivalent level (WDLEV) value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>CMPHDL1</td>
<td>&quot;From&quot; device's entity handle value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>CMPHDL2</td>
<td>&quot;To&quot; device's entity handle value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>DWGIX1</td>
<td>&quot;From&quot; device's drawing DWGIX value as listed in FILETIME table of project scratch database (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>DWGIX2</td>
<td>&quot;To&quot; device's drawing DWGIX value as listed in FILETIME table of project scratch database (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>DWGNAM1</td>
<td>&quot;From&quot; device's drawing %D value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>DWGNAM2</td>
<td>&quot;To&quot; device's drawing %D value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>CBLHDL</td>
<td>Cable entity's handle value</td>
</tr>
<tr>
<td>CBLINST</td>
<td>Cable installation assignment</td>
</tr>
<tr>
<td>CBLDWGIX</td>
<td>Cable's drawing DWGIX value as listed in FILETIME table of project scratch database</td>
</tr>
<tr>
<td>WIREHDL1</td>
<td>&quot;From&quot; device's connected wire line entity handle value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>WIREHDL2</td>
<td>&quot;To&quot; device's connected wire line entity handle value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>XDIR1</td>
<td>&quot;From&quot; device's wire connection point direction - i.e. 4 = connects from left (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>XDIR2</td>
<td>&quot;To&quot; device's wire connection point direction - i.e. 2 = connects from above (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PNLX1</td>
<td>&quot;From&quot; wire connection's physical X-coordinate value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PNLY1</td>
<td>&quot;From&quot; wire connection's physical Y-coordinate value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PNLZ1</td>
<td>&quot;From&quot; wire connection's physical Z-coordinate value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PNLXDIR1</td>
<td>Panel wire &quot;From&quot; connection point's direction - i.e. 4 = connects from left, 1 = right, 2 = above, 8 = below (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PNLX2</td>
<td>&quot;To&quot; wire connection's physical X-coordinate value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PNLY2</td>
<td>&quot;To&quot; wire connection's physical Y-coordinate value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PNLZ2</td>
<td>&quot;To&quot; wire connection's physical Z-coordinate value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PNLXDIR2</td>
<td>Panel wire &quot;To&quot; connection point's direction - i.e. 4 = connects from left, 1 = right, 2 = above, 8 = below (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>CLEN</td>
<td>Panel layout calculated wire length</td>
</tr>
</tbody>
</table>

**Panel bill of material data fields to report**
Changes what data fields are reported and the order in which they appear.

**Access:**

Click the Panel Reports tool. Select Bill of Material from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Panel Reports. Select Bill of Material from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

**Available Fields**  
Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

**Fields to Report**  
Lists the fields to display in the report.

**Remove/Remove All**  
Removes the selected field or all fields from the Fields to Report list.

**Move Up**  
Moves the selected field up one spot in the Fields to Report list.

**Move Down**  
Moves the selected field down one spot in the Fields to Report list.

**Change field name/justification**  
Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.
**Available Fields**

The fields that are available depend on the report options you selected when running the report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITEM</td>
<td>Item number assignment</td>
</tr>
<tr>
<td>N/A</td>
<td>Not applicable or not used</td>
</tr>
<tr>
<td>QTY</td>
<td>Quantity</td>
</tr>
<tr>
<td>SUB</td>
<td>Subassembly quantity</td>
</tr>
<tr>
<td>CATALOG</td>
<td>Catalog part number assignment</td>
</tr>
<tr>
<td>MFG</td>
<td>Manufacturer or vendor name (i.e. Siemens)</td>
</tr>
<tr>
<td>ASSYCODE</td>
<td>Optional assembly code value used in catalog lookup query to get part number groups</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>Multi-line description column</td>
</tr>
<tr>
<td>DESC</td>
<td>General description line of text</td>
</tr>
<tr>
<td>QUERY2</td>
<td>2nd query field (middle pulldown on Catalog Lookup dialog box)</td>
</tr>
<tr>
<td>QUERY3</td>
<td>3rd query field (right-hand pulldown on Catalog Lookup dialog box)</td>
</tr>
<tr>
<td>MISC1-2</td>
<td>Catalog lookup data field</td>
</tr>
<tr>
<td>USER1-3</td>
<td>User field in catalog lookup database</td>
</tr>
<tr>
<td>TABNAM</td>
<td>Catalog Database (vendor database) table name</td>
</tr>
<tr>
<td>TAGS</td>
<td>Component tag names</td>
</tr>
<tr>
<td>HDL</td>
<td>Entity handle number</td>
</tr>
</tbody>
</table>
"From” device's drawing DWGIX value as listed in FILETIME table of project scratch database

Panel component exception data fields to report

Changes what data fields are reported and the order in which they appear.

Access:

Click the Panel Reports tool. Select Component Exception from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Panel Reports. Select Component Exception from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Available Fields

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report

Lists the fields to display in the report.

Remove/Remove All

Removes the selected field or all fields from the Fields to Report list.

Move Up

Moves the selected field up one spot in the Fields to Report list.

Move Down

Moves the selected field down one spot in the Fields to Report list.

Change field name/justification

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.
### Available Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAGNAME</td>
<td>Tag ID value (attributes &quot;TAG&quot;, &quot;TAG1&quot;, &quot;TAGSTRIP&quot;, &quot;P_TAG1&quot;)</td>
</tr>
<tr>
<td>INST</td>
<td>Installation attribute value</td>
</tr>
<tr>
<td>LOC</td>
<td>Location attribute value</td>
</tr>
<tr>
<td>COMMENT</td>
<td>Comment or explanation of issue</td>
</tr>
<tr>
<td>PNL</td>
<td>Value of the problem area on the footprint component; shows the value on the panel layout (i.e. If the Comment is &quot;Mismatch LOC&quot;, the LOC attribute is different between the Panel Layout and Schematic components).</td>
</tr>
<tr>
<td>SCHEM</td>
<td>Value of the problem area on the component; shows the value on the schematic drawing (i.e. If the Comment is &quot;Mismatch LOC&quot;, the LOC attribute is different between the Panel Layout and Schematic components).</td>
</tr>
<tr>
<td>HDL</td>
<td>Entity handle number</td>
</tr>
<tr>
<td>SH</td>
<td>Sheet - the %S value</td>
</tr>
<tr>
<td>SHDWGNAM</td>
<td>Drawing name - the %D value</td>
</tr>
<tr>
<td>FULLFILENAME</td>
<td>AutoCAD drawing file name (.dwg) with complete path</td>
</tr>
<tr>
<td>FILENAME</td>
<td>AutoCAD drawing file name (.dwg)</td>
</tr>
</tbody>
</table>

### Panel component data fields to report
Changes what data fields are reported and the order in which they appear.

**Access:**

Click the Panel Reports tool. Select Component from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Panel Reports. Select Component from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

**Available Fields**

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

**Fields to Report**

Lists the fields to display in the report.

**Remove/Remove All**

Removes the selected field or all fields from the Fields to Report list.

**Move Up**

Moves the selected field up one spot in the Fields to Report list.

**Move Down**

Moves the selected field down one spot in the Fields to Report list.

**Change field name/justification**

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

**Available Fields**

| ITEM | Item number assignment |

830 | Chapter 14  Reports
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAGNAME</td>
<td>Tag ID value (attributes &quot;TAG&quot;, &quot;TAG1&quot;, &quot;TAGSTRIP&quot;, &quot;P_TAG1&quot;)</td>
</tr>
<tr>
<td>CNT</td>
<td>Count</td>
</tr>
<tr>
<td>UNITS</td>
<td>Units of measurement (i.e. AMPS, VOLTS, mA)</td>
</tr>
<tr>
<td>SUBQTY</td>
<td>Sub-quantity</td>
</tr>
<tr>
<td>MFG</td>
<td>Manufacturer or vendor name (i.e. Siemens)</td>
</tr>
<tr>
<td>CAT</td>
<td>Catalog part number assignment</td>
</tr>
<tr>
<td>DESC1-3</td>
<td>Description attribute values 1-3</td>
</tr>
<tr>
<td>REF</td>
<td>Line reference or X-Y grid reference or X-Zone reference</td>
</tr>
<tr>
<td>INST</td>
<td>Installation attribute value</td>
</tr>
<tr>
<td>LOC</td>
<td>Location attribute value</td>
</tr>
<tr>
<td>MOUNT</td>
<td>Mount attribute value; panel layout optional attribute for user-defined &quot;panel mounting&quot; assignment</td>
</tr>
<tr>
<td>GROUP</td>
<td>GROUPWITH attribute value; panel layout optional attribute for user-defined &quot;group with&quot; assignment</td>
</tr>
<tr>
<td>RATING1-12</td>
<td>Rating 1 - 12 attribute values</td>
</tr>
<tr>
<td>CATDESC</td>
<td>Catalog one-line description text</td>
</tr>
<tr>
<td>QUERY1</td>
<td>QUERY1 field pulled from catalog lookup and formatted into output report</td>
</tr>
<tr>
<td>QUERY2</td>
<td>2nd query field (middle pulldown on Catalog Lookup dialog box)</td>
</tr>
<tr>
<td>MISC1-2</td>
<td>Catalog lookup data field</td>
</tr>
</tbody>
</table>
USER1-3  User field in catalog lookup database

P1C2  parent = 1, child = 2

WDBLNAM  Related to the name of the component's catalog lookup table

BLOCK  Block name

HDL  Entity handle number

CATEGORY  Type of component (J = plug-jack connector, P = PLC I/O, C = cable marker)

ASSYCODE  Optional assembly code value used in catalog lookup query to get part number groups

SH  Sheet - the %S value

SHDWGNAM  Drawing name - the %D value

SEC  Drawing section assignment

SUBSEC  Drawing sub-section assignment

FAMILY  Component family

WDTAGALT  Related tag ID of device on alternate drawing type

WDTYPE  Alternate type of symbol (i.e. "PN" for pneumatic, "HYD" for hydraulic)

FILENAME  AutoCAD drawing file name (.dwg)

Panel missing level/sequence assignments data fields to report

832  Chapter 14  Reports
Changes what data fields are reported and the order in which they appear.

Access:

Click the Panel Reports tool. Select Missing Level/Sequence Assignments from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Panel Reports. Select Missing Level/Sequence Assignments from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Available Fields

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report

Lists the fields to display in the report.

Remove/Remove All

Removes the selected field or all fields from the Fields to Report list.

Move Up

Moves the selected field up one spot in the Fields to Report list.

Move Down

Moves the selected field down one spot in the Fields to Report list.

Change field name/justification

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

Available Fields

TAGNAME Tag ID value (attributes "TAG", "TAG1", "TAGSTRIP", "P_TAG1")
**Panel wire annotation exception data fields to report**

Changes what data fields are reported and the order in which they appear.

**Access:**

Click the Panel Reports tool. Select Wire Annotation Exception from the report list. Run the report and click Change Report Format on the Report Generator dialog box.
Access:

Click Projects ➤ Reports ➤ Panel Reports. Select Wire Annotation Exception from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Available Fields

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report

Lists the fields to display in the report.

Remove/Remove All

Removes the selected field or all fields from the Fields to Report list.

Move Up

Moves the selected field up one spot in the Fields to Report list.

Move Down

Moves the selected field down one spot in the Fields to Report list.

Change field name/justification

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

Available Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAGNAME</td>
<td>Tag ID value (attributes &quot;TAG&quot;, &quot;TAG1&quot;, &quot;TAGSTRIP&quot;, &quot;P_TAG1&quot;)</td>
</tr>
<tr>
<td>PIN</td>
<td>Wire connection terminal pin number</td>
</tr>
<tr>
<td>WIRENO</td>
<td>Wire number</td>
</tr>
</tbody>
</table>

Generate reports | 835
<table>
<thead>
<tr>
<th>WTYPE</th>
<th>Alternate type of symbol (i.e. &quot;PN&quot; for pneumatic, &quot;HYD&quot; for hydraulic)</th>
</tr>
</thead>
<tbody>
<tr>
<td>INST</td>
<td>Installation attribute value</td>
</tr>
<tr>
<td>LOC</td>
<td>Location attribute value</td>
</tr>
<tr>
<td>MOUNT</td>
<td>Mount attribute value; panel layout optional attribute for user-defined &quot;panel mounting&quot; assignment</td>
</tr>
<tr>
<td>GROUP</td>
<td>GROUPWITH attribute value; panel layout optional attribute for user-defined &quot;group with&quot; assignment</td>
</tr>
<tr>
<td>END1</td>
<td>Component and connection information on one end of wire (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>END2</td>
<td>Component and connection information on one end of wire (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>BLKNAME</td>
<td>WDBLKNAM attribute value used for the linking of symbols to tables in the Default CAT database</td>
</tr>
<tr>
<td>DWGIX</td>
<td>&quot;From&quot; device's drawing DWGIX value as listed in FILETIME table of project scratch database</td>
</tr>
<tr>
<td>HDL</td>
<td>Entity handle number</td>
</tr>
<tr>
<td>CATEGORY</td>
<td>Type of component (J = plug-jack connector, P = PLC I/O, C = cable marker, FP = Panel Footprint, FPT = terminal footprint)</td>
</tr>
<tr>
<td>PDESC</td>
<td>Wire connection point description attribute value</td>
</tr>
<tr>
<td>SFX</td>
<td>Values of R or L; used for terminal block symbols where we identify the wire annotation attributes with an R or L for Right or Left of the symbol</td>
</tr>
<tr>
<td>SH</td>
<td>Sheet - the %S value</td>
</tr>
<tr>
<td>SHDWGNAM</td>
<td>Drawing name - the %D value</td>
</tr>
</tbody>
</table>
CBL  
Cable tag

TEXT  
Wire annotation text

**Panel nameplate data fields to report**
Changes what data fields are reported and the order in which they appear.

**Access:**

Click the Panel Reports tool. Select Nameplate from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Panel Reports. Select Nameplate from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

- **Available Fields**
  Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

- **Fields to Report**
  Lists the fields to display in the report.

- **Remove/Remove All**
  Removes the selected field or all fields from the Fields to Report list.

- **Move Up**
  Moves the selected field up one spot in the Fields to Report list.

- **Move Down**
  Moves the selected field down one spot in the Fields to Report list.

- **Change field name/justification**
  Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ig-
Available Fields

- **TAGNAME**: Tag ID value (attributes "TAG", "TAG1", "TAGSTRIP", "P_TAG1")
- **DESC1-3**: Description attribute values 1-3
- **MFG**: Manufacturer or vendor name (i.e. Siemens)
- **CATALOG**: Catalog part number assignment
- **BLKNAME**: Block name
- **WITH**: Nameplate tied in with this footprint device tag
- **LOC**: Location attribute value
- **MOUNT**: Mount attribute value; panel layout optional attribute for user-defined "panel mounting" assignment
- **GROUP**: GROUPWITH attribute value; panel layout optional attribute for user-defined "group with" assignment
- **INST**: Installation attribute value
- **SH**: Sheet - the %S value
- **SHDWGNAM**: Drawing name - the %D value
- **ITEM**: Item number assignment
- **RATING1-12**: Rating 1 - 12 attribute values
- **POS1-12**: Switch position description text (1 - 12)
HDL

Entity handle number

DWGIX

"From" device's drawing DWGIX value as listed in FILETIME table of project scratch database

Panel terminal exception data fields to report

Changes what data fields are reported and the order in which they appear.

Access:

Click the Panel Reports tool. Select Terminal Exception from the report list. Run the report and click Change Report Format on the Report Generator dialog box. Click Projects ➤ Reports ➤ Panel Reports. Select Terminal Exception from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Available Fields

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report

Lists the fields to display in the report.

Remove/Remove All

Removes the selected field or all fields from the Fields to Report list.

Move Up

Moves the selected field up one spot in the Fields to Report list.

Move Down

Moves the selected field down one spot in the Fields to Report list.

Change field name/justification

 Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ig-
If you put the report on the drawing, the report justification is top right.

**Available Fields**

- **TAGNAME**: Tag ID value (attributes "TAG", "TAG1", "TAGSTRIP", "P_TAG1")
- **INST**: Installation attribute value
- **LOC**: Location attribute value
- **COMMENT**: Comment or explanation of issue
- **PNL**: Value of the problem area on the footprint component; shows the value on the panel layout (i.e. If the Comment is "Mismatch LOC", the LOC attribute is different between the Panel Layout and Schematic components).
- **SCHEM**: Value of the problem area on the component; shows the value on the schematic drawing (i.e. If the Comment is "Mismatch LOC", the LOC attribute is different between the Panel Layout and Schematic components).
- **HDL**: Entity handle number
- **SH**: Sheet - the %S value
- **SHDWGNAM**: Drawing name - the %D value
- **FULLFILENAME**: AutoCAD drawing file name (.dwg) with complete path
- **FILENAME**: AutoCAD drawing file name (.dwg)

**Panel wire connection data fields to report**
Changes what data fields are reported and the order in which they appear.

Access:

Click the Panel Reports tool. Select Wire Connection from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Panel Reports. Select Wire Connection from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Available Fields

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report

Lists the fields to display in the report.

Remove/Remove All

Removes the selected field or all fields from the Fields to Report list.

Move Up

Moves the selected field up one spot in the Fields to Report list.

Move Down

Moves the selected field down one spot in the Fields to Report list.

Change field name/justification

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

Available Fields

| TAGNAME   | Tag ID value (attributes "TAG", "TAG1", "TAGSTRIP", "P_TAG1") |

Generate reports | 841
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PIN</td>
<td>Wire connection terminal pin number</td>
</tr>
<tr>
<td>WIRENO</td>
<td>Wire number</td>
</tr>
<tr>
<td>WTYPE</td>
<td>Alternate type of symbol (i.e. &quot;PN&quot; for pneumatic, &quot;HYD&quot; for hydraulic)</td>
</tr>
<tr>
<td>INST</td>
<td>Installation attribute value</td>
</tr>
<tr>
<td>LOC</td>
<td>Location attribute value</td>
</tr>
<tr>
<td>MOUNT</td>
<td>Mount attribute value; panel layout optional attribute for user-defined &quot;panel mounting&quot; assignment</td>
</tr>
<tr>
<td>GROUP</td>
<td>GROUPWITH attribute value; panel layout optional attribute for user-defined &quot;group with&quot; assignment</td>
</tr>
<tr>
<td>END1</td>
<td>Component and connection information on one end of wire (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>END2</td>
<td>Component and connection information on one end of wire (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>MFG</td>
<td>Manufacturer or vendor name (i.e. Siemens)</td>
</tr>
<tr>
<td>CAT</td>
<td>Catalog part number assignment</td>
</tr>
<tr>
<td>ASSYCODE</td>
<td>Optional assembly code value used in catalog lookup query to get part number groups</td>
</tr>
<tr>
<td>BLKNAME</td>
<td>WDBLKNAM attribute value used for the linking of symbols to tables in the Default CAT database</td>
</tr>
<tr>
<td>ITEM</td>
<td>Item number assignment on Panel drawings; there is no correlation between schematic and panel item number attributes</td>
</tr>
<tr>
<td>DWGIX</td>
<td>&quot;From&quot; device's drawing DWGIX value as listed in FILETIME table of project scratch database</td>
</tr>
<tr>
<td>HDL</td>
<td>Entity handle number</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>CATEGORY</td>
<td>Type of component (J = plug-jack connector, P = PLC I/O, C = cable marker, FP = Panel Footprint, FPT = terminal footprint)</td>
</tr>
<tr>
<td>PDESC</td>
<td>Wire connection point description attribute value</td>
</tr>
<tr>
<td>SFX</td>
<td>Values of R or L; used for terminal block symbols where we identify the wire annotation attributes with an R or L for Right or Left of the symbol</td>
</tr>
<tr>
<td>SH</td>
<td>Sheet - the %S value</td>
</tr>
<tr>
<td>SHDWGNAM</td>
<td>Drawing name - the %D value</td>
</tr>
<tr>
<td>X</td>
<td>X-coordinate</td>
</tr>
<tr>
<td>Y</td>
<td>Y-coordinate</td>
</tr>
<tr>
<td>Z</td>
<td>Z-coordinate</td>
</tr>
<tr>
<td>CBL</td>
<td>Cable tag</td>
</tr>
<tr>
<td>TEXT</td>
<td>Wire annotation text</td>
</tr>
</tbody>
</table>

**Autodesk Inventor Professional wire list data fields to report**
Changes what data fields are reported and the order in which they appear.

**Access:**

Click the Schematic Reports tool. Select Autodesk Inventor Professional Wire List from the report list. Run the report. Select the location codes for the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Schematic Reports. Select Autodesk Inventor Professional Wire List from the report list. Run the report. Select the location
Access:


Available Fields
- Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report
- Lists the fields to display in the report.

Remove/Remove All
- Removes the selected field or all fields from the Fields to Report list.

Move Up
- Moves the selected field up one spot in the Fields to Report list.

Move Down
- Moves the selected field down one spot in the Fields to Report list.

Change field name/justification
- Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

Available Fields

**WIRE ID**
- Wire number

**LOC1**
- "From" device's location code (must end with "1")

**REFDES1**
- "From" device component tag-ID, reference designator #1 (must end with "1")
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PIN1</td>
<td>&quot;From&quot; device's wire connection terminal number (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>LOC2</td>
<td>&quot;To&quot; device's location code (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>REFDES2</td>
<td>&quot;To&quot; device component tag-ID, reference designator #2 (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PIN2</td>
<td>&quot;To&quot; device's wire connection terminal number (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>WLAY1</td>
<td>Wire layer &quot;From&quot; device (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>NAME</td>
<td>Wire layer name</td>
</tr>
<tr>
<td>REF1</td>
<td>Line or grid reference location for &quot;From&quot; device (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>REF2</td>
<td>Line or grid reference location for &quot;To&quot; device (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>SH1</td>
<td>Sheet assignment for &quot;From&quot; device (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>SH2</td>
<td>Sheet assignment for &quot;To&quot; device (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>CABLE ID</td>
<td>Cable tag</td>
</tr>
<tr>
<td>CONDUCTOR ID</td>
<td>Cable wire or cable core color</td>
</tr>
<tr>
<td>CBLLOC</td>
<td>Cable location attribute value</td>
</tr>
<tr>
<td>CBLMFG</td>
<td>Cable manufacturer attribute value</td>
</tr>
<tr>
<td>CBLCAT</td>
<td>Cable catalog part number</td>
</tr>
<tr>
<td>CBLASMB</td>
<td>Cable ASSYCODE assignment</td>
</tr>
<tr>
<td>DESC1CBL-DESC3CBL</td>
<td>Cable description attribute values 1 - 3</td>
</tr>
<tr>
<td>CBLP1C2</td>
<td>Cable parent or child (parent = 1, child = 2)</td>
</tr>
</tbody>
</table>

Generate reports | 845
<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMP:PIN1</td>
<td>&quot;From&quot; device's component tag and component terminal pin number</td>
</tr>
<tr>
<td>CMP:PIN2</td>
<td>&quot;To&quot; device's component tag and component terminal pin number</td>
</tr>
<tr>
<td>SEC1</td>
<td>&quot;From&quot; device's drawing section assignment (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>SUB1</td>
<td>&quot;From&quot; device's drawing sub-section assignment (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>SEC2</td>
<td>&quot;To&quot; device's drawing section assignment (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>SUB2</td>
<td>&quot;To&quot; device's drawing sub-section assignment (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>INST1</td>
<td>&quot;From&quot; device's installation code (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>INST2</td>
<td>&quot;To&quot; device's installation code (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>IECCMP1</td>
<td>&quot;From&quot; device's IEC tag name (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>IECCMP2</td>
<td>&quot;To&quot; device's IEC tag name (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PD1</td>
<td>&quot;From&quot; device's wire connection TERMDESC value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PD2</td>
<td>&quot;To&quot; device's wire connection TERMDESC value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>SEQ1</td>
<td>&quot;From&quot; device's wire connection sequence value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>SEQ2</td>
<td>&quot;To&quot; device's wire connection sequence value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PNLWDLEV1</td>
<td>&quot;From&quot; device's panel equivalent level (WDLEV) value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PNLWDLEV2</td>
<td>&quot;To&quot; device's panel equivalent level (WDLEV) value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>CMPHDL1</td>
<td>&quot;From&quot; device's entity handle value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CMPHDL2</td>
<td>&quot;To&quot; device's entity handle value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>DWGIX1</td>
<td>&quot;From&quot; device's drawing DWGIX value as listed in FILETIME table of project</td>
</tr>
<tr>
<td></td>
<td>scratch database (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>DWGIX2</td>
<td>&quot;To&quot; device's drawing DWGIX value as listed in FILETIME table of project</td>
</tr>
<tr>
<td></td>
<td>scratch database (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>DWGNAM1</td>
<td>&quot;From&quot; device's drawing %D value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>DWGNAM2</td>
<td>&quot;To&quot; device's drawing %D value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>CBLHDL</td>
<td>Cable entity's handle value</td>
</tr>
<tr>
<td>CBLINST</td>
<td>Cable installation assignment</td>
</tr>
<tr>
<td>CBLDWGIX</td>
<td>Cable's drawing DWGIX value as listed in FILETIME table of project scratch</td>
</tr>
<tr>
<td></td>
<td>database</td>
</tr>
<tr>
<td>WIREHDL1</td>
<td>&quot;From&quot; device's connected wire line entity handle value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>WIREHDL2</td>
<td>&quot;To&quot; device's connected wire line entity handle value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>XDIR1</td>
<td>&quot;From&quot; device's wire connection point direction - i.e. 4 = connects from</td>
</tr>
<tr>
<td></td>
<td>left (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>XDIR2</td>
<td>&quot;To&quot; device's wire connection point direction - i.e. 2 = connects from</td>
</tr>
<tr>
<td></td>
<td>above (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PNLX1</td>
<td>&quot;From&quot; wire connection's physical X-coordinate value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PNLY1</td>
<td>&quot;From&quot; wire connection's physical Y-coordinate value (must end with &quot;1&quot;)</td>
</tr>
</tbody>
</table>
"From" wire connection's physical Z-coordinate value (must end with "1")

Panel wire "From" connection point's direction - i.e. 4 = connects from left, 1 = right, 2 = above, 8 = below (must end with "1")

"To" wire connection's physical X-coordinate value (must end with "2")

"To" wire connection's physical Y-coordinate value (must end with "2")

"To" wire connection's physical Z-coordinate value (must end with "2")

Panel wire "To" connection point's direction - i.e. 4 = connects from left, 1 = right, 2 = above, 8 = below (must end with "2")

Panel layout calculated wire length

Bill of material data fields to report
Changes what data fields are reported and the order in which they appear.

Access:

Click the Schematic Reports tool. Select Bill of Material from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Schematic Reports. Select Bill of Material from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Available Fields
Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report
Lists the fields to display in the report.
Removes the selected field or all fields from the Fields to Report list.

Move Up
Moves the selected field up one spot in the Fields to Report list.

Move Down
Moves the selected field down one spot in the Fields to Report list.

Change field name/justification
Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select “Top Right” the report is right-justified during the display, printing and when saved to a file (the “top” portion is ignored). If you put the report on the drawing, the report justification is top right.

Lines for description
The Description field can be multilined. If you include the Description field in your report, choose which lines make up this field. Switch on and off the specific fields to define the Description.

Available Fields

The fields that are available depend on the display options you selected when running the report. Some fields are not applicable in certain display options.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITEM</td>
<td>Item number assignment; purchase list items for Purchase Tallied Format reports.</td>
</tr>
<tr>
<td>N/A</td>
<td>Not applicable or not used; if a report does not use a particular field, N/A is used to line up the raw data and make them consistent between all formats for the BOM</td>
</tr>
<tr>
<td>QTY</td>
<td>Quantity</td>
</tr>
<tr>
<td>SUB</td>
<td>Subassembly quantity</td>
</tr>
<tr>
<td><strong>CATALOG</strong></td>
<td>Catalog part number assignment</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td><strong>MFG</strong></td>
<td>Manufacturer or vendor name (i.e. Siemens)</td>
</tr>
<tr>
<td><strong>ASSYCODE</strong></td>
<td>Optional assembly code value used in catalog lookup query to get part number groups</td>
</tr>
<tr>
<td><strong>DESCRIPTION</strong></td>
<td>Multiline description column</td>
</tr>
<tr>
<td><strong>DESC</strong></td>
<td>General component description line of text</td>
</tr>
<tr>
<td><strong>QUERY2</strong></td>
<td>2nd query field (middle pulldown on Catalog Lookup dialog box)</td>
</tr>
<tr>
<td><strong>QUERY3</strong></td>
<td>3rd query field (right-hand pull-down on Catalog Lookup dialog box)</td>
</tr>
<tr>
<td><strong>MISC1-2</strong></td>
<td>Catalog lookup data fields</td>
</tr>
<tr>
<td><strong>USER1-3</strong></td>
<td>User fields in catalog lookup database</td>
</tr>
<tr>
<td><strong>TABNAM</strong></td>
<td>Catalog database table name</td>
</tr>
<tr>
<td><strong>TAGS or TAG</strong></td>
<td>Component tag names</td>
</tr>
<tr>
<td><strong>INST</strong></td>
<td>Installation attribute value</td>
</tr>
<tr>
<td><strong>LOC</strong></td>
<td>Location attribute value</td>
</tr>
<tr>
<td><strong>HDL</strong></td>
<td>Entity handle number</td>
</tr>
<tr>
<td><strong>DWGIX</strong></td>
<td>DWGIX value as listed in FILETIME table of project scratch database</td>
</tr>
</tbody>
</table>

**Cable summary data fields to report**
Changes what data fields are reported and the order in which they appear.

Access:

Click the Schematic Reports tool. Select Cable Summary from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Schematic Reports. Select Cable Summary from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Available Fields

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report

Lists the fields to display in the report.

Remove/Remove All

Removes the selected field or all fields from the Fields to Report list.

Move Up

Moves the selected field up one spot in the Fields to Report list.

Move Down

Moves the selected field down one spot in the Fields to Report list.

Change field name/justification

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

Available Fields

CBL

Cable tag
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DESC1-3</td>
<td>Description attribute values 1-3</td>
</tr>
<tr>
<td>MFG</td>
<td>Manufacturer or vendor name (i.e. Siemens)</td>
</tr>
<tr>
<td>CAT</td>
<td>Catalog part number assignment</td>
</tr>
<tr>
<td>ASSYCODE</td>
<td>Optional assembly code value used in catalog lookup query to get part number groups</td>
</tr>
<tr>
<td>CBLDESCCAT</td>
<td>Cable BOM single line description field (pulled from the catalog lookup file for the cable's catalog part number query)</td>
</tr>
<tr>
<td>CBLQ1CAT</td>
<td>Cable BOM query1 value (pulled from the catalog lookup file for the cable's catalog part number query)</td>
</tr>
<tr>
<td>CBLQ2CAT</td>
<td>Cable BOM query2 value (pulled from the catalog lookup file for the cable's catalog part number query)</td>
</tr>
<tr>
<td>CBLMISC1CAT-</td>
<td>Cable BOM miscellaneous fields (pulled from the catalog lookup file for the cable's catalog part number query)</td>
</tr>
<tr>
<td>CBLMISC2CAT</td>
<td></td>
</tr>
<tr>
<td>CBLUSER1CAT-</td>
<td>Cable BOM user fields (pulled from the catalog lookup file for the cable's catalog part number query)</td>
</tr>
<tr>
<td>CBLUSER3CAT</td>
<td></td>
</tr>
<tr>
<td>REF</td>
<td>Line reference or X-Y grid reference or X-Zone reference</td>
</tr>
<tr>
<td>LOC</td>
<td>Location attribute value</td>
</tr>
<tr>
<td>SH</td>
<td>Sheet - the %S value</td>
</tr>
<tr>
<td>SHDWGNAM</td>
<td>Drawing name - the %D value</td>
</tr>
<tr>
<td>HDL</td>
<td>Entity handle number</td>
</tr>
<tr>
<td>INST</td>
<td>Installation attribute value</td>
</tr>
</tbody>
</table>
"From" device's drawing DWGIX value as listed in FILETIME table of project scratch database

Cable from/to data fields to report
Changes what data fields are reported and the order in which they appear.

Access:

Click the Schematic Reports tool. Select Cable From/To from the report list. Run the report. Select the location codes for the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Schematic Reports. Select Cable From/To from the report list. Run the report. Select the location codes for the report and click Change Report Format on the Report Generator dialog box.

Available Fields
Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report
Lists the fields to display in the report.

Remove/Remove All
Removes the selected field or all fields from the Fields to Report list.

Move Up
Moves the selected field up one spot in the Fields to Report list.

Move Down
Moves the selected field down one spot in the Fields to Report list.

Change field name/justification
Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.
### Available Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIRENO</td>
<td>Wire number</td>
</tr>
<tr>
<td>LOC1</td>
<td>&quot;From&quot; device's location code (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>CMP1</td>
<td>&quot;From&quot; device's component tag ID (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PIN1</td>
<td>&quot;From&quot; device's wire connection terminal number (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>LOC2</td>
<td>&quot;To&quot; device's location code (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>CMP2</td>
<td>&quot;To&quot; device's component tag ID (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PIN2</td>
<td>&quot;To&quot; device's wire connection terminal number (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>WLAY1</td>
<td>Wire layer &quot;From&quot; device (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>WLAY2</td>
<td>Wire layer &quot;To&quot; device (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>REF1</td>
<td>Line or grid reference location for &quot;From&quot; device (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>REF2</td>
<td>Line or grid reference location for &quot;To&quot; device (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>SH1</td>
<td>Sheet assignment for &quot;From&quot; device (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>SH2</td>
<td>Sheet assignment for &quot;To&quot; device (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>CBL</td>
<td>Cable tag</td>
</tr>
<tr>
<td>CBLWC</td>
<td>Cable wire or cable core color</td>
</tr>
<tr>
<td>CBLLLOC</td>
<td>Cable location attribute value</td>
</tr>
<tr>
<td>CBLMFG</td>
<td>Cable Manufacturer attribute value</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CBLCAT</td>
<td>Cable catalog part number</td>
</tr>
<tr>
<td>CBLASMB</td>
<td>Cable ASSYCODE assignment</td>
</tr>
<tr>
<td>CBLDESCCAT</td>
<td>Cable BOM single line description field (pulled from the catalog lookup file for the cable's catalog part number query)</td>
</tr>
<tr>
<td>CBLQ1CAT</td>
<td>Cable BOM query1 value (pulled from the catalog lookup file for the cable's catalog part number query)</td>
</tr>
<tr>
<td>CBLQ2CAT</td>
<td>Cable BOM query2 value (pulled from the catalog lookup file for the cable's catalog part number query)</td>
</tr>
<tr>
<td>CBLMISC1CAT - CBLMISC2CAT</td>
<td>Cable BOM miscellaneous fields (pulled from the catalog lookup file for the cable's catalog part number query)</td>
</tr>
<tr>
<td>CBLUSER1CAT - CBLUSER3CAT</td>
<td>Cable BOM user fields (pulled from the catalog lookup file for the cable's catalog part number query)</td>
</tr>
<tr>
<td>DESC1CBL-DESC3CBL</td>
<td>Cable description attribute values 1 - 3</td>
</tr>
<tr>
<td>CBLP1C2</td>
<td>Cable parent or child (parent = 1, child = 2)</td>
</tr>
<tr>
<td>CMP:PIN1</td>
<td>&quot;From&quot; device's component tag and component terminal pin number</td>
</tr>
<tr>
<td>CMP:PIN2</td>
<td>&quot;To&quot; device's component tag and component terminal pin number</td>
</tr>
<tr>
<td>SEC1</td>
<td>&quot;From&quot; device's drawing section assignment</td>
</tr>
<tr>
<td>SUB1</td>
<td>&quot;From&quot; device's drawing sub-section assignment</td>
</tr>
<tr>
<td>SEC2</td>
<td>&quot;TO&quot; device's drawing section assignment</td>
</tr>
<tr>
<td>SUB2</td>
<td>&quot;TO&quot; device's drawing sub-section assignment</td>
</tr>
<tr>
<td>INST1</td>
<td>&quot;From&quot; device's installation code</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>INST2</td>
<td>&quot;To&quot; device's installation code</td>
</tr>
<tr>
<td>IECCMP1</td>
<td>&quot;From&quot; device's IEC tag name (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>IECCMP2</td>
<td>&quot;To&quot; device's IEC tag name (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PD1</td>
<td>&quot;From&quot; device's wire connection TERMDESC value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PD2</td>
<td>&quot;To&quot; device's wire connection TERMDESC value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>SEQ1</td>
<td>&quot;From&quot; device's wire connection sequence value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>SEQ2</td>
<td>&quot;To&quot; device's wire connection sequence value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PNLWDLEV1</td>
<td>&quot;From&quot; device's panel equivalent level (WDLEV) value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PNLWDLEV2</td>
<td>&quot;To&quot; device's panel equivalent level (WDLEV) value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>CMPHDL1</td>
<td>&quot;From&quot; device's entity handle value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>CMPHDL2</td>
<td>&quot;To&quot; device's entity handle value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>DWGIX1</td>
<td>&quot;From&quot; device's drawing DWGIX value as listed in FILETIME table of project scratch database (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>DWGIX2</td>
<td>&quot;To&quot; device's drawing DWGIX value as listed in FILETIME table of project scratch database (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>DWGNAM1</td>
<td>&quot;From&quot; device's drawing properties %D value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>DWGNAM2</td>
<td>&quot;To&quot; device's drawing properties %D value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>CBLHDL</td>
<td>Cable entity's handle value</td>
</tr>
</tbody>
</table>

856 | Chapter 14  Reports
<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CBLINST</td>
<td>Cable entity's handle value</td>
</tr>
<tr>
<td>CBLDWGIX</td>
<td>Cable's drawing DWGIX value as listed in FILETIME table of project scratch database</td>
</tr>
<tr>
<td>WIREHDL1</td>
<td>&quot;From&quot; device's connected wire line entity handle value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>WIREHDL2</td>
<td>&quot;To&quot; device's connected wire line entity handle value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>XDIR1</td>
<td>&quot;From&quot; device's wire connection point direction - i.e. 4 = connects from left (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>XDIR2</td>
<td>&quot;To&quot; device's wire connection point direction - i.e. 2 = connects from above (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PNLX1</td>
<td>&quot;From&quot; wire connection's physical X-coordinate value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PNLY1</td>
<td>&quot;From&quot; wire connection's physical Y-coordinate value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PNLZ1</td>
<td>&quot;From&quot; wire connection's physical Z-coordinate value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PNLXDIR1</td>
<td>Panel wire &quot;From&quot; connection point's direction - i.e. 4 = connects from left, 1 = right, 2 = above, 8 = below (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PNLX2</td>
<td>&quot;To&quot; wire connection's physical X-coordinate value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PNLY2</td>
<td>&quot;To&quot; wire connection's physical Y-coordinate value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PNLZ2</td>
<td>&quot;To&quot; wire connection's physical Z-coordinate value (must end with &quot;2&quot;)</td>
</tr>
</tbody>
</table>
Panel wire "To" connection point's direction - i.e. 4 = connects from left, 1 = right, 2 = above, 8 = below (must end with "2")

CLEN
Panel layout calculated wire length

USER1_1 to USER20_1  "From" device's optional user field

USER1_2 to USER20_2  "To" device's optional user field

**Cable label data fields to report**

Changes what data fields are reported and the order in which they appear.

**Access:**

Click the Schematic Reports tool. Select Wire Label from the report list. Run the report and click Cable Label on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Schematic Reports. Select Wire Label from the report list. Run the report and click Cable Label on the Report Generator dialog box.

**Available Fields**
Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

**Fields to Report**
Lists the fields to display in the report.

**Remove/Remove All**
Removes the selected field or all fields from the Fields to Report list.

**Move Up**
Moves the selected field up one spot in the Fields to Report list.

**Move Down**
Moves the selected field down one spot in the Fields to Report list.

**Separator**
Specifies the special character to separate the selected fields. Enter a special character to separate the selected fields inside the list box. Do this by selecting a field from the Fields
to Report list, define the separator, select another field, define a separator, and so on. You can also select the separator from a list. The "\n" symbol stands for the new line. When you use this as separator, the field displays in the new (next) line.

Available Fields

CBL
Cable name

LOC1
Location of "From" components

FROM_CMPS
Components that are in the "From" end of cable

LOC2
Location of "To" components

TO_CMPS
Components that are in the "To" end of cable

DESC1CBL-DESC3CBL
Cable's description lines 1-3

**PLC component connection data fields to report**

Changes what data fields are reported and the order in which they appear.

Access:

Click the Schematic Reports tool. Select PLC I/O Component Connection from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Schematic Reports. Select PLC I/O Component Connection from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Available Fields

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report

Lists the fields to display in the report.
Removes the selected field or all fields from the Fields to Report list.

Move Up
Moves the selected field up one spot in the Fields to Report list.

Move Down
Moves the selected field down one spot in the Fields to Report list.

Change field name/justification
Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

Available Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLCWNUM</td>
<td>Wire number associated with PLC I/O point</td>
</tr>
<tr>
<td>PLCTAG</td>
<td>PLC tag ID value (attribute &quot;TAG&quot; or &quot;TAG1&quot;)</td>
</tr>
<tr>
<td>PLCADDR</td>
<td>PLC I/O point address (attribute &quot;TAGAxx&quot; where xx is &quot;01&quot; - &quot;xx&quot;)</td>
</tr>
<tr>
<td>PLCDESCA-PLCDESCE</td>
<td>PLC I/O description text lines 1 - 5</td>
</tr>
<tr>
<td>PLCTERM</td>
<td>PLC I/O terminal text value, attribute TERMxx</td>
</tr>
<tr>
<td>PLCTERMDESC</td>
<td>PLC I/O terminal description text value, attribute TERM-DESCxx</td>
</tr>
<tr>
<td>PLCINST</td>
<td>PLC I/O module's Installation attribute value</td>
</tr>
<tr>
<td>PLCLOC</td>
<td>PLC I/O module's Location attribute value</td>
</tr>
</tbody>
</table>

860 | Chapter 14 | Reports |
<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WLAY</td>
<td>Wire layer name</td>
</tr>
<tr>
<td>PLCMFG</td>
<td>PLC I/O module's Manufacturer attribute value</td>
</tr>
<tr>
<td>PLCCAT</td>
<td>PLC I/O module's Catalog part number</td>
</tr>
<tr>
<td>PLCASSYCODE</td>
<td>PLC I/O module's ASSYCODE attribute value</td>
</tr>
<tr>
<td>PLCTERMCODE</td>
<td>PLC I/O terminal attribute suffix value (the &quot;xx&quot; part of TERMxx)</td>
</tr>
<tr>
<td>PLCDWGIX</td>
<td>PLC Drawing DWGIX value as listed in FILETIME table of project</td>
</tr>
<tr>
<td>PLCHDL</td>
<td>PLC I/O module's AutoCAD handle value</td>
</tr>
<tr>
<td>PLCLINE1</td>
<td>PLC I/O module's LINE1 attribute value (miscellaneous text such as &quot;Rack&quot; or &quot;Slot&quot;)</td>
</tr>
<tr>
<td>PLCLINE2</td>
<td>PLC I/O module's LINE2 attribute value (miscellaneous text such as &quot;Rack&quot; or &quot;Slot&quot;)</td>
</tr>
<tr>
<td>CMPTAG</td>
<td>Connected component tag ID (attributes &quot;TAG1&quot;, &quot;TAG2&quot;, &quot;TAGSTRIP&quot;)</td>
</tr>
<tr>
<td>CMPDESC1-3</td>
<td>Connected component description attribute values 1 - 3</td>
</tr>
<tr>
<td>CMPINST</td>
<td>Connected component Installation attribute value</td>
</tr>
<tr>
<td>CMPLOC</td>
<td>Connected component Location attribute value</td>
</tr>
<tr>
<td>CMPTERM</td>
<td>Connected component TERMxx attribute value (the side that connects to the PLC I/O point)</td>
</tr>
<tr>
<td>CMPTERMDESC</td>
<td>Connected component TERMDESCxx attribute value (the side that connects to the PLC I/O point)</td>
</tr>
</tbody>
</table>
CMPMFG  Connected component Manufacturer attribute value
CMPCAT  Connected component catalog part number
CMPASSYCODE  Connected component ASSYCODE attribute value
CMPDFGIX  Connected component’s Drawing DWGIX value as listed in FILETIME table of project scratch database
CMPHDL  Connected component’s AutoCAD handle value
CMPLKNAM  Connected component’s AutoCAD block name
TERMTAG  Connected terminal’s TAGSTRIP attribute value
TERMINST  Connected terminal’s Installation attribute value
TERMLOC  Connected terminal’s Location attribute value
TERMTERM  Connected terminal’s TERM or TERM01 attribute value
TERMTERMDESC  Connected terminal’s TERMDESC01 attribute value
TERMMFG  Connected terminal’s Manufacturer attribute value
TERMCAT  Connected terminal’s catalog part number
TERMASSYCODE  Connected terminal’s ASSYCODE attribute value
TERMDWGIX  Connected terminal’s Drawing DWGIX value as listed in FILETIME table of project scratch database
TERMHDL  Connected terminal’s AutoCAD handle value
TERMBLKNAM  Connected terminal’s AutoCAD block name
CBL  Cable tag
CBLWC  Cable wire or cable core color
CBLHDL  Cable entity's handle value

**Component wire list data fields to report**

Changes what data fields are reported and the order in which they appear.

**Access:**

Click the Schematic Reports tool. Select Component Wire List from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Schematic Reports. Select Component Wire List from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

**Available Fields**
Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

**Fields to Report**
Lists the fields to display in the report.

**Remove/Remove All**
Removes the selected field or all fields from the Fields to Report list.

**Move Up**
Moves the selected field up one spot in the Fields to Report list.

**Move Down**
Moves the selected field down one spot in the Fields to Report list.

**Change field name/justification**
Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ig-
nored). If you put the report on the drawing, the report justification is top right.

### Available Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIRENO</td>
<td>Wire number</td>
</tr>
<tr>
<td>PIN</td>
<td>Wire connection terminal pin number</td>
</tr>
<tr>
<td>TAGNAME</td>
<td>Tag ID value (attributes &quot;TAG&quot;, &quot;TAG1&quot;, &quot;TAGSTRIP&quot;, &quot;P_TAG1&quot;)</td>
</tr>
<tr>
<td>LOC</td>
<td>Location attribute value</td>
</tr>
<tr>
<td>WLAY</td>
<td>Wire layer name</td>
</tr>
<tr>
<td>P1C2</td>
<td>parent = 1, child = 2</td>
</tr>
<tr>
<td>REF</td>
<td>Line reference or X-Y grid reference or X-Zone reference</td>
</tr>
<tr>
<td>SH</td>
<td>Sheet - the %S value</td>
</tr>
<tr>
<td>SHDWGNAM</td>
<td>Drawing name - the %D value</td>
</tr>
<tr>
<td>BLKNAME</td>
<td>Block name</td>
</tr>
<tr>
<td>HDL</td>
<td>Entity handle number</td>
</tr>
<tr>
<td>XTERM</td>
<td>Wire connection XTERMMxx suffix. (for example, for attribute X4TERM05 the value would be &quot;05&quot;)</td>
</tr>
<tr>
<td>CBL</td>
<td>Cable</td>
</tr>
<tr>
<td>CBLWC</td>
<td>Cable wire or cable core color</td>
</tr>
<tr>
<td>NONC</td>
<td>Contact attribute value; Normally Open (NO) or Normally Closed (NC) contact state</td>
</tr>
</tbody>
</table>
SEC | Drawing section assignment

SUBSEC | Drawing sub-section assignment

TERMDESC | Component wire connection TERMDescxx value

INST | Installation attribute value

DESC1-3 | Description attribute values 1-3

MFG | Manufacturer or vendor name (i.e. Siemens)

CATALOG | Catalog part number assignment

ASSYCODE | Optional assembly code value used in catalog lookup query to get part number groups

RATING1-12 | Rating 1 - 12 attribute values

XTERMHDL | Wire connection X?TERMxx attribute's entity handle name

XDIR | Wire connection X?TERMxx attribute's direction code and suffix

DWGIX | "From" device's drawing DWGIX value as listed in FILETIME table of project scratch database

**Connector details data fields to report**

Changes what data fields are reported and the order in which they appear.

**Access:**

Click the Schematic Reports tool. Select Connector Details from the report list. Run the report and click Change Report Format on the Report Generator dialog box.
Access:

Click Projects ➤ Reports ➤ Schematic Reports. Select Connector Details from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Available Fields

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report

Lists the fields to display in the report.

Remove/Remove All

Removes the selected field or all fields from the Fields to Report list.

Move Up

Moves the selected field up one spot in the Fields to Report list.

Move Down

Moves the selected field down one spot in the Fields to Report list.

Change field name/justification

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

Available Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONNECTOR</td>
<td>Tag ID of plug/jack connector</td>
</tr>
<tr>
<td>PIN</td>
<td>Wire connection terminal pin number</td>
</tr>
<tr>
<td>TYPE</td>
<td>Child contact type; P = Plug and J = Jack</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>WIRENO</td>
<td>Wire number</td>
</tr>
<tr>
<td>DESC1-3</td>
<td>Description attribute values 1-3</td>
</tr>
<tr>
<td>MFG</td>
<td>Manufacturer or vendor name (i.e. Siemens)</td>
</tr>
<tr>
<td>CATALOG</td>
<td>Catalog part number assignment</td>
</tr>
<tr>
<td>ASSYCODE</td>
<td>Optional assembly code value used in catalog lookup query to get part number groups</td>
</tr>
<tr>
<td>REF</td>
<td>Line reference or X-Y grid reference or X-Zone reference</td>
</tr>
<tr>
<td>INST</td>
<td>Installation attribute value</td>
</tr>
<tr>
<td>LOC</td>
<td>Location attribute value</td>
</tr>
<tr>
<td>SH</td>
<td>Sheet - the %S value</td>
</tr>
<tr>
<td>SHDWGNAM</td>
<td>Drawing name - the %D value</td>
</tr>
<tr>
<td>HDL</td>
<td>Entity handle number; used internally for programming or customization</td>
</tr>
<tr>
<td>RATING1-12</td>
<td>Rating 1 - 12 attribute values</td>
</tr>
<tr>
<td>DWGIX</td>
<td>&quot;From&quot; device's drawing DWGIX value as listed in FILETIME table of project scratch database; used internally for programming or customization</td>
</tr>
</tbody>
</table>

**Connector plug data fields to report**
Changes what data fields are reported and the order in which they appear.

**Access:**

Click the Schematic Reports tool. Select Connector Plug from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Schematic Reports. Select Connector Plug from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

- **Available Fields**
  - Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

- **Fields to Report**
  - Lists the fields to display in the report.

- **Remove/Remove All**
  - Removes the selected field or all fields from the Fields to Report list.

- **Move Up**
  - Moves the selected field up one spot in the Fields to Report list.

- **Move Down**
  - Moves the selected field down one spot in the Fields to Report list.

- **Change field name/justification**
  - Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

**Available Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIRENO</td>
<td>Wire number</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>PIN</td>
<td>Wire connection terminal pin number</td>
</tr>
<tr>
<td>TAGNAME</td>
<td>Tag ID value (attributes &quot;TAG&quot;, &quot;TAG1&quot;, &quot;TAGSTRIP&quot;, &quot;P_TAG1&quot;)</td>
</tr>
<tr>
<td>LOC</td>
<td>Location attribute value</td>
</tr>
<tr>
<td>WLAY</td>
<td>Wire layer name</td>
</tr>
<tr>
<td>P1C2</td>
<td>parent = 1, child = 2</td>
</tr>
<tr>
<td>REF</td>
<td>Line reference or X-Y grid reference or X-Zone reference</td>
</tr>
<tr>
<td>SH</td>
<td>Sheet - the %S value</td>
</tr>
<tr>
<td>SHDWGNAM</td>
<td>Drawing name - the %D value</td>
</tr>
<tr>
<td>BLKNAME</td>
<td>Block name</td>
</tr>
<tr>
<td>HDL</td>
<td>Entity handle number</td>
</tr>
<tr>
<td>XDIR</td>
<td>Wire connection X?TERMxx attribute's direction code and suffix</td>
</tr>
<tr>
<td>CBL</td>
<td>Cable</td>
</tr>
<tr>
<td>CBLWC</td>
<td>Cable wire or cable core color</td>
</tr>
<tr>
<td>SEC</td>
<td>Drawing section assignment</td>
</tr>
<tr>
<td>SUBSEC</td>
<td>Drawing sub-section assignment</td>
</tr>
<tr>
<td>TERMDESC</td>
<td>Component wire connection TERMDESCxx value</td>
</tr>
<tr>
<td>INST</td>
<td>Installation attribute value</td>
</tr>
<tr>
<td>DESC1-3</td>
<td>Description attribute values 1-3</td>
</tr>
<tr>
<td>MFG</td>
<td>Manufacturer or vendor name (for example, Siemens)</td>
</tr>
</tbody>
</table>
CATALOG  Catalog part number assignment

ASSYCODE  Optional assembly code value used in catalog lookup query to get part number groups

RATING1-12  Rating 1 - 12 attribute values

XTERMHDL  Wire connection X?TERMxx attribute's entity handle name

DWGIX  "From" device's drawing DWGIX value as listed in FILETIME table of project scratch database

**Connector summary data fields to report**

Changes what data fields are reported and the order in which they appear.

**Access:**

Click the Schematic Reports tool. Select Connector Summary from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Schematic Reports. Select Connector Summary from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

**Available Fields**

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

**Fields to Report**

Lists the fields to display in the report.

**Remove/Remove All**

Removes the selected field or all fields from the Fields to Report list.

**Move Up**

Moves the selected field up one spot in the Fields to Report list.

**Move Down**

Moves the selected field down one spot in the Fields to Report list.
Change field name/justification  Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

Available Fields

- **CONNECTOR**: Tag ID of plug/jack connector
- **MAX**: Maximum number of pins
- **USED**: Count of used or in-use pins
- **PINSUSED**: List of wire connection pin number in use
- **REPEATS**: Pin numbers repeated
- **INST**: Installation attribute value
- **LOC**: Location attribute value
- **MFG**: Manufacturer or vendor name (i.e. Siemens)
- **CATALOG**: Catalog part number assignment
- **ASSYCODE**: Optional assembly code value used in catalog lookup query to get part number groups
- **HDL**: Entity handle number
- **DWGIX**: "From" device's drawing DWGIX value as listed in FILETIME table of project scratch database
Component data fields to report

Changes what data fields are reported and the order in which they appear.

Access:

Click the Schematic Reports tool. Select Component from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Schematic Reports. Select Component from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Available Fields

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report

Lists the fields to display in the report.

Remove/Remove All

Removes the selected field or all fields from the Fields to Report list.

Move Up

Moves the selected field up one spot in the Fields to Report list.

Move Down

Moves the selected field down one spot in the Fields to Report list.

Change field name/justification

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.
### Available Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITEM</td>
<td>Item number assignment</td>
</tr>
<tr>
<td>TAGNAME</td>
<td>Tag ID value (attributes &quot;TAG&quot;, &quot;TAG1&quot;, &quot;TAGSTRIP&quot;, &quot;P_TAG1&quot;)</td>
</tr>
<tr>
<td>CNT</td>
<td>Count on panel component</td>
</tr>
<tr>
<td>UNITS</td>
<td>Units of measurement (i.e. AMPS, VOLTS, mA) on panel component</td>
</tr>
<tr>
<td>SUBQTY</td>
<td>Subassembly quantity</td>
</tr>
<tr>
<td>MFG</td>
<td>Manufacturer or vendor name (for example, Siemens)</td>
</tr>
<tr>
<td>CAT</td>
<td>Catalog part number assignment</td>
</tr>
<tr>
<td>DESC1-3</td>
<td>Description attribute values 1-3</td>
</tr>
<tr>
<td>REF</td>
<td>Line reference or X-Y grid reference or X-Zone reference</td>
</tr>
<tr>
<td>INST</td>
<td>Installation attribute value</td>
</tr>
<tr>
<td>LOC</td>
<td>Location attribute value</td>
</tr>
<tr>
<td>RATING1-12</td>
<td>Rating 1 - 12 attribute values</td>
</tr>
<tr>
<td>CATDESC</td>
<td>Catalog one-line description text</td>
</tr>
<tr>
<td>QUERY1</td>
<td>QUERY1 field pulled from catalog lookup</td>
</tr>
<tr>
<td>QUERY2</td>
<td>2nd query field (middle pulldown on Catalog Lookup dialog box)</td>
</tr>
<tr>
<td>MISC1-2</td>
<td>Catalog lookup data fields</td>
</tr>
<tr>
<td>USER1-3</td>
<td>User fields in catalog lookup database</td>
</tr>
<tr>
<td>P1C2</td>
<td>parent = 1, child = 2</td>
</tr>
</tbody>
</table>
WDBLKNAM     Name of the component's catalog lookup table

BLOCK        Block name

HDL          Entity handle number

CATEGORY     Type of component (J = plug-jack connector, P = PLC I/O, C = cable marker)

ASSYCODE     Optional assembly code value used in catalog lookup query to get part number groups

SH           Sheet - the %S value

SHDWGNAM     Drawing name - the %D value

SEC          Drawing SEC assignment

SUBSEC       Drawing SUBSEC assignment

FAMILY       Component family

WDTAGALT     Tag-ID of device on alternate drawing type

WDTYPE       Alternate type of symbol (for example, "PN" for pneumatic, "HYD" for hydraulic)

FILENAME     AutoCAD drawing .dwg file name (with full path)

**Missing bill of material data fields to report**
Changes what data fields are reported and the order in which they appear.

**Access:**
Click the Schematic Reports tool. Select Missing Bill of Material from the report list. Run the report and click Change Report Format on the Report Generator dialog box.
Access:

Click Projects ➤ Reports ➤ Schematic Reports. Select Missing Bill of Material from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Available Fields

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report

Lists the fields to display in the report.

Remove/Remove All

Removes the selected field or all fields from the Fields to Report list.

Move Up

Moves the selected field up one spot in the Fields to Report list.

Move Down

Moves the selected field down one spot in the Fields to Report list.

Change field name/justification

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select “Top Right” the report is right-justified during the display, printing and when saved to a file (the “top” portion is ignored). If you put the report on the drawing, the report justification is top-right.

Available Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAGNAME</td>
<td>Tag ID value (attributes &quot;TAG&quot;, &quot;TAG1&quot;, &quot;TAGSTRIP&quot;, &quot;P_TAG1&quot;)</td>
</tr>
<tr>
<td>INST</td>
<td>Installation attribute value</td>
</tr>
<tr>
<td>LOC</td>
<td>Location attribute value</td>
</tr>
</tbody>
</table>

Generate reports | 875
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DESC1-3</td>
<td>Description attribute values 1-3</td>
</tr>
<tr>
<td>REF</td>
<td>Line reference or X-Y grid reference or X-Zone reference</td>
</tr>
<tr>
<td>TABNAM</td>
<td>Catalog database table name</td>
</tr>
<tr>
<td>HDL</td>
<td>Entity handle number</td>
</tr>
<tr>
<td>CATEGORY</td>
<td>Type of component (J = plug-jack connector, P = PLC I/O, C = cable marker)</td>
</tr>
<tr>
<td>SH</td>
<td>Sheet - the %S value</td>
</tr>
<tr>
<td>SHDWGNAM</td>
<td>Drawing name - the %D value</td>
</tr>
<tr>
<td>FILENAME</td>
<td>AutoCAD drawing .dwg file name (with full path)</td>
</tr>
</tbody>
</table>

### Wire from/to data fields to report

Changes what data fields are reported and the order in which they appear.

**Access:**

- Click the Schematic Reports tool. Select Wire From/To from the report list. Run the report. Select the location codes for the report and click Change Report Format on the Report Generator dialog box.
- Click Projects ➤ Reports ➤ Schematic Reports. Select Wire From/To from the report list. Run the report. Select the location codes for the report and click Change Report Format on the Report Generator dialog box.

**Available Fields**

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

**Fields to Report**

Lists the fields to display in the report.

**Remove/Remove All**

Removes the selected field or all fields from the Fields to Report list.
Move Up
Moves the selected field up one spot in the Fields to Report list.

Move Down
Moves the selected field down one spot in the Fields to Report list.

Change field name/justification
Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

Available Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIRENO</td>
<td>Wire number</td>
</tr>
<tr>
<td>LOC1</td>
<td>&quot;From&quot; device's location code (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>CMP1</td>
<td>&quot;From&quot; device's component tag ID (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PIN1</td>
<td>&quot;From&quot; device's wire connection terminal number (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>LOC2</td>
<td>&quot;To&quot; device's location code (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>CMP2</td>
<td>&quot;To&quot; device's component tag ID (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PIN2</td>
<td>&quot;To&quot; device's wire connection terminal number (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>WLAY1</td>
<td>Wire layer &quot;From&quot; device (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>WLAY2</td>
<td>Wire layer &quot;To&quot; device (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>REF1</td>
<td>Line or grid reference location for &quot;From&quot; device (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>REF2</td>
<td>Line or grid reference location for &quot;To&quot; device (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>SH1</td>
<td>Sheet assignment for &quot;From&quot; device (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>SH2</td>
<td>Sheet assignment for &quot;To&quot; device (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>CBL</td>
<td>Cable tag</td>
</tr>
<tr>
<td>CBLWC</td>
<td>Cable wire or cable core color</td>
</tr>
<tr>
<td>CBLLOC</td>
<td>Cable location attribute value</td>
</tr>
<tr>
<td>CBLMFG</td>
<td>Cable manufacturer attribute value</td>
</tr>
<tr>
<td>CBLCAT</td>
<td>Cable catalog part number</td>
</tr>
<tr>
<td>CBLASMB</td>
<td>Cable ASSYCODE assignment</td>
</tr>
<tr>
<td>DESC1CBL-DESC3CBL</td>
<td>Cable description attribute values 1 - 3</td>
</tr>
<tr>
<td>CBLP1C2</td>
<td>Cable parent or child (parent = 1, child = 2)</td>
</tr>
<tr>
<td>CMP:PIN1</td>
<td>&quot;From&quot; device's component tag and component terminal pin number</td>
</tr>
<tr>
<td>CMP:PIN2</td>
<td>&quot;To&quot; device's component tag and component terminal pin number</td>
</tr>
<tr>
<td>SEC1</td>
<td>&quot;From&quot; device's drawing section assignment (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>SUB1</td>
<td>&quot;From&quot; device's drawing sub-section assignment (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>SEC2</td>
<td>&quot;To&quot; device's drawing section assignment (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>SUB2</td>
<td>&quot;To&quot; device's drawing sub-section assignment (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>INST1</td>
<td>&quot;From&quot; device's installation code (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>INST2</td>
<td>&quot;To&quot; device's installation code (must end with &quot;2&quot;)</td>
</tr>
</tbody>
</table>

878 | Chapter 14  Reports
<table>
<thead>
<tr>
<th>Device</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IECCMP1</strong></td>
<td>&quot;From&quot; device's IEC tag name (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td><strong>IECCMP2</strong></td>
<td>&quot;To&quot; device's IEC tag name (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td><strong>PD1</strong></td>
<td>&quot;From&quot; device's wire connection TERMDESC value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td><strong>PD2</strong></td>
<td>&quot;To&quot; device's wire connection TERMDESC value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td><strong>SEQ1</strong></td>
<td>&quot;From&quot; device's wire connection sequence value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td><strong>SEQ2</strong></td>
<td>&quot;To&quot; device's wire connection sequence value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td><strong>PNLWDLEV1</strong></td>
<td>&quot;From&quot; device's panel equivalent panel (WDLEV) value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td><strong>PNLWDLEV2</strong></td>
<td>&quot;To&quot; device's panel equivalent panel (WDLEV) value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td><strong>CMPHDL1</strong></td>
<td>&quot;From&quot; device's entity handle value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td><strong>CMPHDL2</strong></td>
<td>&quot;To&quot; device's entity handle value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td><strong>DWGIX1</strong></td>
<td>&quot;From&quot; device's drawing DWGIX value as listed in FILETIME table of project scratch database (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td><strong>DWGIX2</strong></td>
<td>&quot;To&quot; device's drawing DWGIX value as listed in FILETIME table of project scratch database (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td><strong>DWGNAM1</strong></td>
<td>&quot;From&quot; device's drawing %D value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td><strong>DWGNAM2</strong></td>
<td>&quot;To&quot; device's drawing %D value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td><strong>CBLHDL</strong></td>
<td>Cable entity's handle value</td>
</tr>
<tr>
<td><strong>CBLINST</strong></td>
<td>Cable entity's installation attribute value</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CBLD WGIX</td>
<td>Cable's drawing DWGIX value as listed in FILETIME table of project scratch database</td>
</tr>
<tr>
<td>WIREHD 1</td>
<td>&quot;From&quot; device's connected wire line entity handle value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>WIREHD 2</td>
<td>&quot;To&quot; device's connected wire line entity handle value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>XDIR 1</td>
<td>&quot;From&quot; device's wire connection point direction - i.e. 4 = connects from left (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>XDIR 2</td>
<td>&quot;To&quot; device's wire connection point direction - i.e. 2 = connects from above (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PNLX 1</td>
<td>&quot;From&quot; wire connection's physical X-coordinate value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PNLX 2</td>
<td>&quot;To&quot; wire connection's physical X-coordinate value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PNLZ 1</td>
<td>&quot;From&quot; wire connection's physical Z-coordinate value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PNLZ 2</td>
<td>&quot;To&quot; wire connection's physical Z-coordinate value (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>PNLXDIR 1</td>
<td>Panel wire &quot;From&quot; connection point's direction - i.e. 4 = connects from left, 1 = right, 2 = above, 8 = below (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PNLXDIR 2</td>
<td>Panel wire &quot;To&quot; connection point's direction - i.e. 4 = connects from left, 1 = right, 2 = above, 8 = below (must end with &quot;2&quot;)</td>
</tr>
</tbody>
</table>
CLEN Panel layout calculated wire length

USER1_1 to USER20_1 "From" device’s optional user field

USER1_2 to USER20_2 "To" device’s optional user field

**PLC I/O address and descriptions data fields to report**

Changes what data fields are reported and the order in which they appear.

Access:

- Click the Schematic Reports tool. Select PLC I/O Address and Descriptions from the report list. Run the report and click Change Report Format on the Report Generator dialog box.
- Click Projects ➤ Reports ➤ Schematic Reports. Select PLC I/O Address and Descriptions from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

**Available Fields**

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

**Fields to Report**

Lists the fields to display in the report.

**Remove/Remove All**

Removes the selected field or all fields from the Fields to Report list.

**Move Up**

Moves the selected field up one spot in the Fields to Report list.

**Move Down**

Moves the selected field down one spot in the Fields to Report list.

**Change field name/justification**

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the
Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

**Available Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAGNAME</td>
<td>Tag ID value (attributes &quot;TAG&quot;, &quot;TAG1&quot;, &quot;TAGSTRIP&quot;, &quot;P_TAG1&quot;)</td>
</tr>
<tr>
<td>ADDR</td>
<td>PLC I/O point's address assignment</td>
</tr>
<tr>
<td>TERM</td>
<td>Terminal or terminal number assignment (not the STRIP-ID value)</td>
</tr>
<tr>
<td>TERMDESC</td>
<td>Component wire connection TERMDESCxx value</td>
</tr>
<tr>
<td>DESCA-DESCE</td>
<td>PLC I/O point description attribute values (lines 1-5)</td>
</tr>
<tr>
<td>LREF</td>
<td>Line reference</td>
</tr>
<tr>
<td>WIRENO</td>
<td>Wire number</td>
</tr>
<tr>
<td>INST</td>
<td>Installation attribute value</td>
</tr>
<tr>
<td>LOC</td>
<td>Location attribute value</td>
</tr>
<tr>
<td>MFG</td>
<td>Manufacturer or vendor name (for example, Siemens)</td>
</tr>
<tr>
<td>CAT</td>
<td>Catalog part number assignment</td>
</tr>
<tr>
<td>ASSYCODE</td>
<td>Optional assembly code value used in catalog lookup query to get part number groups</td>
</tr>
<tr>
<td>LINE1</td>
<td>PLC I/O LINE1 attribute description text</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>LINE2</td>
<td>PLC I/O LINE2 attribute description text</td>
</tr>
<tr>
<td>HDL</td>
<td>Entity handle number</td>
</tr>
<tr>
<td>XTERMHDL</td>
<td>Wire connection X?TERMxx attribute's entity handle name</td>
</tr>
<tr>
<td>TERMCODE</td>
<td>Wire connection X?TERMxx attribute suffix (the &quot;xx&quot;)</td>
</tr>
<tr>
<td>SH</td>
<td>Sheet - the %S value</td>
</tr>
<tr>
<td>SHDWGNAM</td>
<td>Drawing name - the %D value</td>
</tr>
<tr>
<td>IEC_P</td>
<td>Drawing's IEC project default - the %P value</td>
</tr>
<tr>
<td>IEC_I</td>
<td>Drawing's IEC Installation default - the %I value</td>
</tr>
<tr>
<td>IEC_L</td>
<td>Drawing's IEC Location default - the %L value</td>
</tr>
<tr>
<td>SEC</td>
<td>Drawing section assignment</td>
</tr>
<tr>
<td>SUBSEC</td>
<td>Drawing sub-section assignment</td>
</tr>
<tr>
<td>DWGIX</td>
<td>&quot;From&quot; device's drawing DWGIX value as listed in FILETIME table of project scratch database</td>
</tr>
</tbody>
</table>

**Terminal numbers data fields to report**

Changes what data fields are reported and the order in which they appear.

**Access:**

Click the Schematic Reports tool. Select Terminal Numbers from the report list. Run the report and click Change Report Format on the Report Generator dialog box.
Access:

Click Projects ➤ Reports ➤ Schematic Reports. Select Terminal Numbers from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Available Fields

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report

Lists the fields to display in the report.

Remove/Remove All

Removes the selected field or all fields from the Fields to Report list.

Move Up

Moves the selected field up one spot in the Fields to Report list.

Move Down

Moves the selected field down one spot in the Fields to Report list.

Change field name/justification

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

Available Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STRIP-ID</td>
<td>Terminal strip TAGSTRIP ID name</td>
</tr>
<tr>
<td>TERM</td>
<td>Terminal or terminal number assignment (not the STRIP-ID value)</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>WIRENO</td>
<td>Wire number</td>
</tr>
<tr>
<td>INST</td>
<td>Installation attribute value</td>
</tr>
<tr>
<td>LOC</td>
<td>Location attribute value</td>
</tr>
<tr>
<td>REF</td>
<td>Line reference or X-Y grid reference or X-Zone reference</td>
</tr>
<tr>
<td>SH</td>
<td>Sheet - the %S value</td>
</tr>
<tr>
<td>SHDWGNAM</td>
<td>Drawing name - the %D value</td>
</tr>
<tr>
<td>BLKNAME</td>
<td>Block name</td>
</tr>
<tr>
<td>MFG</td>
<td>Manufacturer or vendor name (i.e. Siemens)</td>
</tr>
<tr>
<td>CAT</td>
<td>Catalog part number assignment</td>
</tr>
<tr>
<td>ASSYCODE</td>
<td>Optional assembly code value used in catalog lookup query to get part number groups</td>
</tr>
<tr>
<td>DESC1-3</td>
<td>Description attribute values 1-3</td>
</tr>
<tr>
<td>RATNG1-12</td>
<td>Rating 1 - 12 attribute values</td>
</tr>
<tr>
<td>HDL</td>
<td>Entity handle number</td>
</tr>
<tr>
<td>DWGIX</td>
<td>&quot;From&quot; device's drawing DWGIX value as listed in FILETIME table of project scratch database</td>
</tr>
</tbody>
</table>

**PLC modules used so far data fields to report**
Changes what data fields are reported and the order in which they appear.

Access:

Click the Schematic Reports tool. Select PLC Modules Used So Far from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Schematic Reports. Select PLC Modules Used So Far from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Available Fields

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report

Lists the fields to display in the report.

Remove/Remove All

Removes the selected field or all fields from the Fields to Report list.

Move Up

Moves the selected field up one spot in the Fields to Report list.

Move Down

Moves the selected field down one spot in the Fields to Report list.

Change field name/justification

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

Available Fields

| ADDR_BEG | PLC beginning address |

886 | Chapter 14  Reports
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDR_END</td>
<td>PLC ending address</td>
</tr>
<tr>
<td>TAG</td>
<td>PLC tag value</td>
</tr>
<tr>
<td>MFG</td>
<td>Manufacturer or vendor name (i.e. Siemens)</td>
</tr>
<tr>
<td>CAT</td>
<td>Catalog part number assignment</td>
</tr>
<tr>
<td>ASSYCODE</td>
<td>Optional assembly code value used in catalog lookup query to get part number groups</td>
</tr>
<tr>
<td>LINE1</td>
<td>PLC I/O LINE1 attribute description text</td>
</tr>
<tr>
<td>LINE2</td>
<td>PLC I/O LINE2 attribute description text</td>
</tr>
<tr>
<td>INST</td>
<td>Installation attribute value</td>
</tr>
<tr>
<td>LOC</td>
<td>Location attribute value</td>
</tr>
<tr>
<td>REF</td>
<td>Line reference or X-Y grid reference or X-Zone reference</td>
</tr>
<tr>
<td>SH</td>
<td>Sheet - the %S value</td>
</tr>
<tr>
<td>SHDWGNAM</td>
<td>Drawing name - the %D value</td>
</tr>
<tr>
<td>SEC</td>
<td>Drawing section assignment</td>
</tr>
<tr>
<td>SUBSEC</td>
<td>Drawing sub-section assignment</td>
</tr>
<tr>
<td>DESC</td>
<td>General description line of text</td>
</tr>
<tr>
<td>HDL</td>
<td>Entity handle number</td>
</tr>
<tr>
<td>DWGIX</td>
<td>&quot;From&quot; device's drawing DWGIX value as listed in FILETIME table of project scratch database</td>
</tr>
</tbody>
</table>

**Terminal plan data fields to report**
Changes what data fields are reported and the order in which they appear.

Access:

Click the Schematic Reports tool. Select Terminal Plan from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Schematic Reports. Select Terminal Plan from the report list. Run the report and click Change Report Format on the Report Generator dialog box.

Available Fields

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report

Lists the fields to display in the report.

Remove/Remove All

Removes the selected field or all fields from the Fields to Report list.

Move Up

Moves the selected field up one spot in the Fields to Report list.

Move Down

Moves the selected field down one spot in the Fields to Report list.

Change field name/justification

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

Available Fields

INST1

"From" device's installation code
<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC1</td>
<td>&quot;From&quot; device's location code (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>CMP1</td>
<td>&quot;From&quot; device's component tag ID (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PIN1</td>
<td>&quot;From&quot; device's wire connection terminal number (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>PD1</td>
<td>&quot;From&quot; device's wire connection TERMDesc value (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>LAYCMP1</td>
<td>Layer of wire connecting to device component 1 (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>CBL1</td>
<td>Cable ID tied to device component 1 (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>CBLWC1</td>
<td>Cable wire color tied to device component 1 (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>WNUM1</td>
<td>Wire number tied to device component 1 (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>LAYTRM1</td>
<td>Layer of wire connecting to terminal side 1 (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>STRIP-ID</td>
<td>Terminal strip TAGSTRIP ID name</td>
</tr>
<tr>
<td>TD1</td>
<td>Terminal pin TERMDesc value for the first wire connection (must end with &quot;1&quot;)</td>
</tr>
<tr>
<td>TERM</td>
<td>Terminal or terminal number assignment (not the STRIP-ID value)</td>
</tr>
<tr>
<td>TD2</td>
<td>Terminal pin TERMDesc value for the second wire connection (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>TINST</td>
<td>Terminal symbol's installation value</td>
</tr>
<tr>
<td>TLOC</td>
<td>Terminal symbol's location value</td>
</tr>
<tr>
<td>LAYTRM2</td>
<td>Layer of wire connecting to terminal side 2 (must end with &quot;2&quot;)</td>
</tr>
<tr>
<td>WNUM2</td>
<td>Wire number tied to device component 2 (must end with &quot;2&quot;)</td>
</tr>
</tbody>
</table>
CBL2: Cable ID tied to device component 2 (must end with "2")
CBLWC2: Cable wire color tied to device component 2 (must end with "2")
LAYCMP2: Layer of wire connecting to device component 2 (must end with "2")
PD2: "To" device's wire connection TERMDESC value (must end with "2")
PIN2: "To" device's wire connection terminal number (must end with "2")
CMP2: "To" device's component tag ID (must end with "2")
INST2: "To" device's installation code
LOC2: "To" device's location code (must end with "2")
SH: Sheet - the %S value
REF: Line reference or X-Y grid reference or X-Zone reference
HDL: Entity handle number
XDIR1: "From" device's wire connection point direction - i.e. 4 = connects from left (must end with "1")
XDIR2: "To" device's wire connection point direction - i.e. 2 = connects from above (must end with "2")
DWGIX: "From" device's drawing DWGIX value as listed in FILETIME table of project scratch database

Wire label data fields to report
Changes what data fields are reported and the order in which they appear.

Access:

Click the Schematic Reports tool. Select Wire Label from the report list. Run the report and click Wire Label on the Report Generator dialog box.

Click Projects ➤ Reports ➤ Schematic Reports. Select Wire Label from the report list. Run the report and click Wire Label on the Report Generator dialog box.

Available Fields

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

Fields to Report

Lists the fields to display in the report.

Remove/Remove All

Removes the selected field or all fields from the Fields to Report list.

Move Up

Moves the selected field up one spot in the Fields to Report list.

Move Down

Moves the selected field down one spot in the Fields to Report list.

Separator

Specifies the special character to separate the selected fields. Enter a special character to separate the selected fields inside the list box. Do this by selecting a field from the Fields to Report list, define the separator, select another field, define a separator, and so on. You can also select the separator from a list.

The "\n" symbol stands for the new line. When you use this as separator, the field displays in the new (next) line.

Available Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIRENO</td>
<td>Wire number</td>
</tr>
</tbody>
</table>
### CMP
Component that connects to a wire (at any end) and is written to the wire label

### PIN
Wire connection terminal pin number of the component that the wire connects with

### Wire conduit routing data fields to display
Changes what data fields are reported and the order in which they appear.

**Access:**

On the Conduit Marker toolbar, click the arrow on the Conduit Reports tool to access the Wire/Conduit Routing Report tool. Run the report and click Change Report Format on the Report Generator dialog box.


<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Available Fields</strong></td>
<td>Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.</td>
</tr>
<tr>
<td><strong>Fields to Report</strong></td>
<td>Lists the fields to display in the report.</td>
</tr>
<tr>
<td><strong>Remove/Remove All</strong></td>
<td>Removes the selected field or all fields from the Fields to Report list.</td>
</tr>
<tr>
<td><strong>Move Up</strong></td>
<td>Moves the selected field up one spot in the Fields to Report list.</td>
</tr>
<tr>
<td><strong>Move Down</strong></td>
<td>Moves the selected field down one spot in the Fields to Report list.</td>
</tr>
<tr>
<td><strong>Change field name/justification</strong></td>
<td>Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select</td>
</tr>
</tbody>
</table>
"Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

Available Fields

CBL  Cable tag
CBLWC  Cable wire or cable core color
WIRENO  Wire number
INST1  "From" device’s installation code (must end with "1")
LOC1  "From" device’s location code (must end with "1")
CMP1  "From" device’s component tag ID (must end with "1")
PIN1  "From" device’s wire connection terminal number (must end with "1")
INST2  "To" device’s installation code (must end with "2")
LOC2  "To" device’s location code (must end with "2")
CMP2  "To" device’s component tag ID (must end with "2")
PIN2  "To" device’s wire connection terminal number (must end with "2")
WLAY  Wire layer name
ROUTING  Conduit routing path description

Cross-reference table data fields to display
Changes what data fields are reported and the order in which they appear.

Access:

Click the Project Manager tool. In the Project Manager, right-click the project or drawing name and select Properties. Click the Cross-References tab. In the component Cross-Reference Display section, select Table Format and click Setup. In the Table Cross-Reference Format Setup dialog box, Table Style section, click Define Columns.

From the Projects menu, select Project ➤ Project Manager. In the Project Manager, right-click the project or drawing name and select Properties. Click the Cross-References tab. In the component Cross-Reference Display section, select Table Format and click Setup. In the Table Cross-Reference Format Setup dialog box, Table Style section, click Define Columns.

**NOTE** This can also be accessed from the Insert/Edit Component, Cross-Reference section. Select Component override and click Setup. In the Cross-reference component override dialog box, select Table Format and click Setup.

<table>
<thead>
<tr>
<th>Available Fields</th>
<th>Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fields to Report</td>
<td>Lists the fields to display in the report.</td>
</tr>
<tr>
<td>Remove/Remove All</td>
<td>Removes the selected field or all fields from the Fields to Report list.</td>
</tr>
<tr>
<td>Move Up</td>
<td>Moves the selected field up one spot in the Fields to Report list.</td>
</tr>
<tr>
<td>Move Down</td>
<td>Moves the selected field down one spot in the Fields to Report list.</td>
</tr>
<tr>
<td>Change field name/justification</td>
<td>Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select &quot;Top Right&quot; the report is right-justified during the display,</td>
</tr>
</tbody>
</table>

894 | Chapter 14  Reports
printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

### Available Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>W1</td>
<td>Wire number - first wire connection on symbol (TERM01)</td>
</tr>
<tr>
<td>T1</td>
<td>Terminal pin number - first wire connection (TERM01)</td>
</tr>
<tr>
<td>TYPE</td>
<td>Contact type - can be user defined and come from the Contact attribute on the child symbol - this gets overwritten from the contact mapping in the dialog box</td>
</tr>
<tr>
<td>T2</td>
<td>Terminal pin number - second wire connection (TERM02)</td>
</tr>
<tr>
<td>W2</td>
<td>Wire number - second wire connection (TERM02)</td>
</tr>
<tr>
<td>REF</td>
<td>Line reference or X-Y grid reference or X-Zone reference</td>
</tr>
<tr>
<td>SH</td>
<td>Sheet - the %S value</td>
</tr>
<tr>
<td>SHDWGNAM</td>
<td>Drawing name - the %D value</td>
</tr>
<tr>
<td>FILENAME</td>
<td>AutoCAD drawing file name (.dwg)</td>
</tr>
<tr>
<td>FULLFILENAME</td>
<td>AutoCAD drawing file name (.dwg) with complete path</td>
</tr>
</tbody>
</table>

### Data fields to display
Changes what data fields are reported and the order in which they appear.

**Access:**

From the Components menu, select Cross-Reference ➤ Cross-Reference Table. Select the component to evaluate. Click Change Report Format on the Report Generator dialog box.

**Available Fields**

Lists the available fields for formatting the report (including user-defined attributes). Select a field from the list to transfer it into the Fields to Report list.

**Fields to Report**

Lists the fields to display in the report.

**Remove/Remove All**

Removes the selected field or all fields from the Fields to Report list.

**Move Up**

Moves the selected field up one spot in the Fields to Report list.

**Move Down**

Moves the selected field down one spot in the Fields to Report list.

**Change field name/justification**

Specifies the vertical and horizontal justification (Top Left, Middle Center, Bottom Right) of any column and the column label (default is Top Left). The vertical portion of the justification (Top, Middle, Bottom) is only used for the Put on Drawing report feature. For example, if you select "Top Right" the report is right-justified during the display, printing and when saved to a file (the "top" portion is ignored). If you put the report on the drawing, the report justification is top right.

**Available Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>W1</td>
<td>Wire number - first wire connection on symbol (TERM01)</td>
</tr>
<tr>
<td>T1</td>
<td>Terminal pin number - first wire connection (TERM01)</td>
</tr>
</tbody>
</table>
**TYPE**  
Contact type - can be user defined and come from the Contact attribute on the child symbol - this gets overwritten from the contact mapping in the dialog box

**T2**  
Terminal pin number - second wire connection (TERM02)

**W2**  
Wire number - second wire connection (TERM02)

**REF**  
Line reference or X-Y grid reference or X-Zone reference

**SH**  
Sheet - the %S value

**SHDWGNAM**  
Drawing name - the %D value

**FILENAME**  
AutoCAD drawing file name (.dwg)

**FULLFILENAME**  
AutoCAD drawing file name (.dwg) with complete path

---

**Generate schematic reports**

AutoCAD Electrical has multiple schematic reports that you can run. To access the schematic reports, click the Schematic Reports tool on the main Electrical toolbar or select Projects ➤ Reports ➤ Schematic Reports from the menu.

**Bill of Materials reports**

The Bill of Material reports report only components with assigned BOM information. These reports provide the following BOM-related features:

- Extract BOM reports on demand, active drawing or project-wide
- Extract BOM reports on a per-location basis
- Change BOM report format
- Output BOM reports to ASCII report file
Export BOM data to a spreadsheet or database program

Insert BOM as a table right on an AutoCAD drawing

List parent or stand-alone components without catalog information

**Component report**

This report performs a project-wide extract of all components found on your wiring diagram set. This data includes component tags, location codes, location reference, description text, ratings, catalog information, and block names.

**Wire From/To report**

If you marked components and/or terminals with location codes, you can make good use of this report. This report first extracts component, terminal, location code, and wire connection information from every drawing in the project set. Then it displays a location list dialog box where you can make your report’s “from” and “to” location selections. All the location codes AutoCAD Electrical found on the drawing set are listed on each side of this dialog. Location "(??)" is also included in the list if AutoCAD Electrical found any component or stand-alone terminal that didn't have an assigned location code.

**Component Wire List report**

This report extracts the component wire connection data and displays it in a dialog. Each entry shows a connection to a component, the wire number, component tag name, terminal pin number, component location code (if present), and the layer that the connected wire is on.

**Connector Plug report**

This report extracts plug/jack connection reports and optionally generates pin charts. Since each wire tied to each connector pin displays in the report, each pin has 2 entries - one for the 'in' wire and one for the 'out' wire. To create a more useful report, select the PIN chart 'on' radio button at the bottom of the Report Generator dialog box. Make sure the Remove duplicated pin numbers toggle is checked and click OK. This reformats the report so each pin is listed only once.
PLC I/O Address and Description report

This report lists each PLC module and its beginning and ending I/O address numbers. It scans your drawing set and returns all individual I/O connection points it finds. This includes up to five lines of description text and the connected wire number for each I/O point.

PLC I/O Component Connection report

This report scans the selected drawing(s) and returns information about any components connected to PLC I/O points. Data for the report starts at each wire connection point and follows the connected wire. The first terminal symbol, fuse symbol, or connector symbol that is hit reports in the column marked with default "TERMTAG" label. The first schematic component reports in the column with the "CMPTAG" label. If there are multiple instances, the one closest to the PLC I/O point is the one that shows up in the report column.

PLC Modules Used So Far report

For this report, AutoCAD Electrical quickly scans the wiring diagram set. It returns in a few moments and displays the I/O modules it finds. Each entry shows the module's beginning and ending address.

Terminal Numbers report

This project-wide, stand-alone report lists all instances of terminals. Each entry includes information tied directly to the terminal such as terminal number, terminal strip number, and location code.

Terminal Plan report

This project-wide, stand-alone report does a wire network extraction. This means it takes longer to generate, but the report includes wire number and wire layer name information.

Connector Summary report

This report lists a single line for each connector tag along with pins used, maximum pins allowed (if the parent carries the PINLIST information), and a list of any repeated pin numbers used. You can run this report across the project or for a single component.

Generate schematic reports | 899
**Connector Details report**

This report extracts the component wire connection data and displays it in a dialog box. Each entry shows a connection to a component, the wire number, component tag name, terminal pin number, component location code (if present), and the layer that the connected wire is on.

**Cable Summary report**

This project-wide cable conductor report gives a report listing all of the cable marker tags (parent tags) found.

**Cable From/To report**

This project-wide cable conductor report lists the "from / to" for each cable conductor along with the conductor's parent cable number, conductor color code, and wire number (if present).

**Wire Label report**

This report lists wire markers/labels and can be used to create physical wire or cable labels.
Generate a schematic report

1. Click the Schematic Reports tool.
2. Select which schematic report to generate from the report list.
3. Select to process the project, current drawing, or selected components.
4. Specify any report options (if applicable).
5. Select installation or location codes to extract (if applicable).
6. Indicate whether to update the project database or the wire connection table with out-of-date drawings.
7. Click OK.
8. In the Report Generator Window, sort, format, or edit the data before sending the information to the printer, file, or the active drawing file.
   - **Edit Mode:** Modifies the report before you insert it to your drawing. You can move data up or down in the report, add lines from a catalog, and delete lines.
   - **Put on Drawing:** Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.
   - **Save to File:** Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs. Choose from: ASCII report, Comma Delimited, Excel spreadsheet, Access database, and XML format.
   - **User Post:** Switch specific functions against the data in the report. When you select a switch, the LISP routine runs a function against the data and returns to the Report Generator Window.
   - **Change Report Format:** Changes what data fields are reported and the order in which they appear. You can change the justification of any column and the column label. The Description field can be multi-lined. If you include the Description field in your report, you choose which lines make up this field. Switch on and off the specific fields to define the Description.
9. Once all modifications have been made to the report, save the report, place the report on the drawing as a table, or print the report.
**Schematic bill of material**

The Bill of Material reports report only components with assigned BOM information.

**Access:**

Click the Schematic Reports tool. Select Bill of Material from the report list.

From the Projects menu, select Reports ➤ Schematic Reports. Select Bill of Material from the report list.

Specify whether to process the project or the active drawing.

**Include options**

- **Include Cables**
  Specifies to include cable information in the report.
- **Include Connectors**
  Specifies to include connector information in the report.
- **Include Jumpers**
  Specifies to include jumper information in the report.
- **All the above**
  Specifies to cable, connector and jumper information in the report.
- **List terminal numbers**
  Lists each individual Tag-ID and terminal number combination if selected. If unselected (default), the terminals are combined on the same Tag-ID strip into a single entry with a quantity.

**Display option**

- **Normal Tallied Format**
  Identical component or component/assemblies are tallied and reported as single line items (Ex: Red pushbutton operator 800EP-F4 with 800E-A3L latch and two 800E-3X10 N.O. contact blocks).
<table>
<thead>
<tr>
<th><strong>Normal Tallied Format (Group by Installation/Location)</strong></th>
<th>Identical component or component/assemblies with the same installation/location codes are tallied and reported as single line items.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display in Tallied Purchase List Format</strong></td>
<td>Each part becomes its own line item (i.e. no longer any sub-assembly items) and each is tallied across all component types. For example, all 800E-3X10 N.O. contact blocks for all components are reported as a single line item.</td>
</tr>
<tr>
<td><strong>Display in By TAG Format</strong></td>
<td>All instances of a given component-ID or terminal tag are processed together and then reported as a single entry.</td>
</tr>
</tbody>
</table>

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick Named Installation, type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2". Wild-cards are supported.

Once you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.
**Freshen Project Database**

Specifies for AutoCAD Electrical to update the project database to include any out-of-date drawing files.

**Format**

Changes the format of the extracted data. The sub-dialog box lists the format files to select from.

**Schematic cable summary**

This project-wide cable conductor report gives a report listing all of the cable marker tags (parent tags) found.

**Access:**

- Click the Schematic Reports tool. Select Cable Summary from the report list.
- From the Projects menu, select Reports ➤ Schematic Reports. Select Cable Summary from the report list.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick Named Installation, type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2". Wild-cards are supported.

Once you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You
can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**Freshen Project Database**

Specifies for AutoCAD Electrical to update the project database to include any out-of-date drawing files.

**Format**

Changes the format of the extracted data. The sub-dialog box lists the format files to select from.

**Schematic cable from/to**

This project-wide cable conductor report lists the "from / to" for each cable conductor along with the conductor’s parent cable number, conductor color code, and wire number (if present).

**Access:**

Click the Schematic Reports tool. Select Cable From/To from the report list. From the Projects menu, select Reports ➤ Schematic Reports. Select Cable From/To from the report list.

Specify whether to process the project, the active drawing, or selected cables.

**Freshen Project Database**

Specifies for AutoCAD Electrical to update the project database to include any out-of-date drawing files.

**Format**

Changes the format of the extracted data. The dialog box lists the format files to select from.

**Schematic PLC I/O component connection**

This report scans the selected drawing(s) and returns information about any components connected to PLC I/O points. Data for the report starts at each wire connection point and follows the connected wire. The first terminal symbol, fuse symbol, or connector symbol that is hit reports in the column marked with default "TERMTAG" label. The first schematic component reports
in the column with the "CMPTAG" label. If there are multiple instances, the one closest to the PLC I/O point is the one that shows up in the report column.

Access:

Click the Schematic Reports tool. Select PLC I/O Component Connection from the report list.

From the Projects menu, select Reports ➤ Schematic Reports. Select PLC I/O Component Connection from the report list.

Specify whether to process the project or the active drawing.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick Named Installation, type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2". Wild-cards are supported.

Once you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

List

Lists drawings that appear to be out-of-date with the project’s wire connection table.
Freshen Wire Connection Table

Specifies for AutoCAD Electrical to update the wire connection table to include any out-of-date drawing files.

Format

Changes the format of the extracted data. The sub-dialog box lists the format files to select from.

Schematic component wire list

This report extracts the component wire connection data and displays it in a dialog. Each entry shows a connection to a component, the wire number, component tag name, terminal pin number, component location code (if present), and the layer that the connected wire is on.

Access:

- Click the Schematic Reports tool. Select Component Wire List from the report list.
- From the Projects menu, select Reports ➤ Schematic Reports. Select Component Wire List from the report list.

Specify whether to process the project, active drawing, or select components.

Options

Specifies to include stand-alone terminals or plug-jack connectors in the report.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick Named Installation, type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.
**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2". Wild-cards are supported.

Once you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**List**

Lists drawings that appear to be out-of-date with the project's wire connection table.

**Freshen Wire Connection Table**

Specifies for AutoCAD Electrical to update the wire connection table to include any out-of-date drawing files.

**Format**

Changes the format of the extracted data. The sub-dialog box lists the format files to select from.

**Schematic connector details**

AutoCAD Electrical extracts the component wire connection data and displays it in a dialog box. Each entry shows a connection to a component, the wire number, component tag name, terminal pin number, component location code (if present), and the layer that the connected wire is on.

**Access:**

Click the Schematic Reports tool. Select Connector Details from the report list. From the Projects menu, select Reports ➤ Schematic Reports. Select Connector Details from the report list.

Specify whether to process the project or a single pick.
Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild cards are supported.

After you click Named Installation, type the installation code in the box, or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked “OP STA 2”. Wild cards are supported.

After you click Named Location, type the location code in the box, or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

Freshen Project Database

Specifies for AutoCAD Electrical to update the project database to include any out-of-date drawing files.

Format

Changes the format of the extracted data. The dialog box lists the format files to select from.

Schematic connector plug

This report extracts plug/jack connection reports and optionally generates pin charts. Since each wire tied to each connector pin displays in the report, each pin has 2 entries - one for the 'in' wire and one for the 'out' wire. To create a more useful report, select the PIN chart 'on' radio button at the bottom of the Report Generator dialog box. Make sure the Remove duplicated pin numbers...
toggle is checked and click OK. This reformats the report so each pin is listed only once.

**Access:**

Click the Schematic Reports tool. Select Connector Plug from the report list. From the Projects menu, select Reports ➤ Schematic Reports. Select Connector Plug from the report list.

Specify whether to process the project, the active drawing, or selected wires.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild cards are supported.

After you click Named Installation, type the installation code in the box, or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2." Wild cards are supported.

After you click Named Location, type the location code in the box, or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**List**

Lists drawings that appear to be out-of-date with the project's wire connection table.
**Freshen Wire Connection Table**

Specifies for AutoCAD Electrical to update the wire connection table to include any out-of-date drawing files.

**Format**

Changes the format of the extracted data. The dialog box lists the format files to select from.

**Schematic connector summary**

This report lists a single line for each connector tag along with pins used, maximum pins allowed (if the parent carries the PINLIST information), and a list of any repeated pin numbers used. You can run this report across the project or for a single component.

**Access:**

Click the Schematic Reports tool. Select Connector Summary from the report list.

From the Projects menu, select Reports ➤ Schematic Reports. Select Connector Summary from the report list.

Specify whether to process the project or a single pick.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild cards are supported.

After you click Named Installation, type the installation code in the box, or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code.
that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2." Wild cards are supported.

After you click Named Location, type the location code in the box, or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**Freshen Project Database**

Specifies for AutoCAD Electrical to update the project database to include any out-of-date drawing files.

**Format**

Changes the format of the extracted data. The dialog box lists the format files to select from.

**Schematic component**

This report extracts the component wire connection data and displays it in a dialog. Each entry shows a connection to a component, the wire number, component tag name, terminal pin number, component location code (if present), and the layer that the connected wire is on.

**Access:**

Click the Schematic Reports tool. Select Component from the report list.

From the Projects menu, select Reports ➤ Schematic Reports. Select Component from the report list.

Specify whether to process the project or the active drawing.

**Options**

Specifies to include components, cable markers, or connectors in the report. You can also indicate to include the children for the selected options.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild cards are supported.
After you click Named Installation, type the installation code in the box, or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2." Wild cards are supported.

After you click Named Location, type the location code in the box, or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**Freshen Project Database**

Specifies for AutoCAD Electrical to update the project database to include any out-of-date drawing files.

**Format**

Changes the format of the extracted data. The dialog box lists the format files to select from.

**Schematic missing bill of material**

Extracts the information from the active drawing or project and displays a list of parent or stand-alone components without catalog information.

**Access:**

- Click the Schematic Reports tool. Select Missing Bill of Material from the report list.
- From the Projects menu, select Reports ➤ Schematic Reports. Select Missing Bill of Material from the report list.

Specify whether to process the project or the active drawing.
Options

Specifies to include components, cable markers, connectors, or terminals in the report.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild cards are supported.

After you click Named Installation, type the installation code in the box, or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2." Wild cards are supported.

After you click Named Location, type the location code in the box, or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

Freshen Project Database

Specifies for AutoCAD Electrical to update the project database to include any out-of-date drawing files.

Format

Changes the format of the extracted data. The dialog box lists the format files to select from.

Schematic wire from/to

If you marked components and/or terminals with location codes, you can make good use of this report. AutoCAD Electrical first extracts component, terminal, location code, and wire connection information from every drawing
in the project set. Then it displays a location list dialog box where you can make your report's "from" and "to" location selections. All the location codes AutoCAD Electrical found on the drawing set are listed on each side of this dialog. Location "(??)" is also included in the list if AutoCAD Electrical found any component or stand-alone terminal that didn't have an assigned location code.

**Access:**

Click the Schematic Reports tool. Select Wire From/To from the report list. From the Projects menu, select Reports ➤ Schematic Reports. Select Wire From/To from the report list.

Specify whether to process the project, the active drawing, or selected wires.

**List**

Lists drawings that appear to be out-of-date with the project's wire connection table.

**Freshen Wire Connection Table**

Specifies for AutoCAD Electrical to update the wire connection table to include any out-of-date drawing files.

**Format**

Changes the format of the extracted data. The dialog box lists the format files to select from.

**Schematic PLC I/O address and descriptions**

This report lists each PLC module and its beginning and ending I/O address numbers. It scans your drawing set and returns all individual I/O connection points it finds. This includes up to five lines of description text and the connected wire number for each I/O point.

Click the Schematic Reports tool. Select PLC I/O Address and Descriptions from the report list.
From the Projects menu, select Reports ➤ Schematic Reports. Select PLC I/O Address and Descriptions from the report list.

Specify whether to process the project or the active drawing.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild cards are supported.

After you click Named Installation, type the installation code in the box, or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2." Wild cards are supported.

After you click Named Location, type the location code in the box, or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**Freshen Project Database**

Specifies for AutoCAD Electrical to update the project database to include any out-of-date drawing files.

**Format**

Changes the format of the extracted data. The dialog box lists the format files to select from.

**Schematic terminal numbers**
This project-wide, stand-alone report lists all instances of terminals. Each entry includes information tied directly to the terminal such as terminal number, terminal strip number, and location code.

**Access:**

Click the Schematic Reports tool. Select Terminal Numbers from the report list. From the Projects menu, select Reports ➤ Schematic Reports. Select Terminal Numbers from the report list.

Specify whether to process the project or the active drawing.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild cards are supported.

After you click Named Installation, type the installation code in the box, or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked “OP STA 2.” Wild cards are supported.

After you click Named Location, type the location code in the box, or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**Freshen Project Database**

Specifies for AutoCAD Electrical to update the project database to include any out-of-date drawing files.
Format
Changes the format of the extracted data. The dialog box lists the format files to select from.

Schematic terminal plan
This project-wide, stand-alone report does a wire network extraction. This means it takes longer to generate, but the report includes wire number and wire layer name information.

Access:
Click the Schematic Reports tool. Select Terminal Plan from the report list.
From the Projects menu, select Reports ➤ Schematic Reports. Select Terminal Plan from the report list.

Specify whether to process the project, active drawing, or select components.

Installation Codes to Extract
Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild cards are supported.

After you click Named Installation, type the installation code in the box, or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

Location Codes to Extract
Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2." Wild cards are supported.

After you click Named Location, type the location code in the box, or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.
List

Lists drawings that appear to be out-of-date with the project's wire connection table.

**Freshen Wire Connection Table**

Specifies for AutoCAD Electrical to update the wire connection table to include any out-of-date drawing files.

**Format**

Changes the format of the extracted data. The dialog box lists the format files to select from.

**Schematic PLC modules used so far**

For the PLC Modules Used So Far report, AutoCAD Electrical quickly scans the wiring diagram set. It returns in a few moments and displays the I/O modules it finds. Each entry shows the module's beginning and ending address.

**Access:**

Click the Schematic Reports tool. Select PLC Modules Used So Far from the report list.

From the Projects menu, select Reports ➤ Schematic Reports. Select PLC Modules Used So Far from the report list.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

After you click Named Installation, type the installation code in the box, or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.
Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2." Wild cards are supported.

After you click Named Location, type the location code in the box, or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

Freshen Project Database

Specifies for AutoCAD Electrical to update the project database to include any out-of-date drawing files.

Format

Changes the format of the extracted data. The dialog box lists the format files to select from.

Schematic wire label

This report lists wire markers/labels and can be used to create physical wire or cable labels.

Access:

Click the Schematic Reports tool. Select Wire Label from the report list. From the Projects menu, select Reports ➤ Schematic Reports. Select Wire Label from the report list.

Specify whether to process the project, the active drawing, or selected wires.

NOTE If you select Active drawing (pick), you must click, the wire rather than the wire number.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components
without an installation code, or only components marked with a location code that matches that entered in the edit box. Wildcards are supported.

Once you pick Named Installation, type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2". Wild-cards are supported.

Once you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**List**

Lists drawings that appear to be out-of-date with the project's wire connection table.

**Freshen Wire Connection Table**

Specifies for AutoCAD Electrical to update the wire connection table to include any out-of-date drawing files.

**Format**

Changes the format of the extracted data. The dialog box lists the format files to select from.

**Location code selection for from/to reporting**

When you select to run a Wire From/To report, AutoCAD Electrical extracts component, terminal, location code, and wire connection information from the selected drawings. This dialog box allows you to make your report's “from” and “to” location selections. All of the location codes AutoCAD Electrical found on the drawing set are listed on each side of this dialog box. Location
“(??)” is also included in the list if AutoCAD Electrical found any component or stand-alone terminals that didn’t have an assigned location code.

Access:

Click the Schematic Reports tool. Select Wire From/To from the report list. Specify whether to process the project, active drawing, or selected wires.

From the Projects menu, select Reports ➤ Schematic Reports. Select Wire From/To from the report list. Specify whether to process the project, active drawing, or selected wires.

Select location codes from the left and right-hand lists to build the the report’s from/to combinations shown in the middle of the dialog box. Click OK to display the report. AutoCAD Electrical quickly filters and formats the extracted data and presents it in the Report Generator dialog box. You can then save it to a text report file, a comma-delimited file to import into a spreadsheet or database program, or insert it on to a drawing in table format.

Location codes

Displays the “from” (left-hand list) and “to” location codes (right-hand list) found on the drawing(s). Clicking a location code moves the selected code from these lists to the Report From/To list in the center of the dialog box.

Report From/To

Displays the combination of location codes you selected from the Location Code lists. This is used to generate the Wire From/To report.

Buttons

- All >> or All <<: Adds or removes all of the location codes from the Report From/To list depending on which side of the dialog box the button is located.
- << or >>: Removes the selected location code from the Report From/To list.

Multiple Combinations

Displays the Select Multiple From/To Location Combinations for Report dialog box. Each location code in the “From” side is linked to each location code in the “To” side of the report. For example, if you select MACHINE (from) and FLOOR (to) in
addition to MCAB5 (from) and JBOX1 (to) the following combinations are created:
MACHINE -> FLOOR
MACHINE -> JBOX1
MCAB5 -> FLOOR
MCAB5 -> JBOX1
Each of the combinations is processed and combined into a single report. Adjust the list as desired (for example, you can select to remove highlighted combinations or keep only those combinations you highlight in the list) and click OK.

Include reverse sequences
Includes reversed wire connections in the report. If unselected, some Wire From/To combinations may be excluded due to wire sequencing.

Generate panel reports

AutoCAD Electrical has multiple panel reports that you can run. To access the panel reports, click the Panel Reports tool on the Panel Layout toolbar or select Projects ➤ Reports ➤ Panel Reports from the menu.

Bill of Material report
This report parallels the Schematic BOM report, but deals with panel component and terminal footprint symbols and nameplates. Optionally, it can include schematic items that are not referenced on the panel layouts (for example, field devices). You can customize the scope of the report by filtering on certain location values (for example, report for CAB1 items only), process only a subset of drawings, or include/exclude certain categories of items. The report displays and tallies like items (for example, same part number) together. Those with extra subassembly items are shown with a SUB multiplier value.

Component report
This report lists every occurrence of a smart panel component footprint found on the current drawing or in the project drawing set. You can customize the
scope of the report by filtering on certain location values (for example, report for CAB1 items only), process only a subset of drawings, or include/exclude certain categories of items. Each extracted panel component is listed as its own line item. If it has a part number that results in subassembly part numbers, or has been individually annotated with multi-BOM part numbers, each additional part number is a line item right below the main line item.

**NOTE** This report will not include panel terminals unless you check that option.

**Nameplate report**

This report is similar to the panel component report, but filters out all but nameplate symbols.

**Wire Connection report**

Wire connection reports, extracted from the schematic wiring diagrams, can be formatted and inserted next to panel footprint symbols as simple wiring tables. AutoCAD Electrical extracts and formats a small report of wire connection information for the selected components, referencing the wire extract file. If your footprint symbols carry the AutoCAD Electrical X?TERMxx attributes, AutoCAD Electrical reports their XYZ wire connection location. The location is offset by the value defined in Panel Configuration dialog box.

**Component Exception report**

This report provides error checking between the schematics and panel layout drawings. AutoCAD Electrical looks at the selected components, both schematic and panel, looking for a match in the project. For each schematic component selected, it tries to find a matching panel component based on tag, location, and installation information. If a match is found, it compares catalog and description information, looking for any discrepancies. AutoCAD Electrical then looks at each selected panel component looking for a matching schematic component in the same way.

**Terminal Exception report**

This report provides error checking between the schematic terminals and panel layout terminals. AutoCAD Electrical looks at the selected terminals, both schematic and panel, looking for a match in the project. For each schematic terminal selected, it tries to find a matching panel terminal based on tag, location, and installation information. If a match is found, it compares catalog information, looking for any discrepancies. AutoCAD Electrical then
looks at each selected panel terminal looking for a matching schematic terminal in the same way.

**Wire Annotation Exception report**

This report lists which physical component symbol doesn’t have a From and a To for wire annotation information. For wire annotation, the panel component symbols contain wiring information as either attributed or Mtext data. This is used as a troubleshooting mechanism to aid in the assignment of wiring annotation. End1 is the end of the wire that contains the annotation and End2 is the end of the wire that was annotated on End1, but is not found in the range of drawings selected.

**Missing Level/Sequencing Assignments report**

This report lists which component symbols do not have leveling and sequencing information already assigned to them. This is used as a troubleshooting mechanism to aid in the assignment of leveling and sequencing information to provide better wire routing capabilities.
Generate a panel report

1. Click the Panel Reports tool.

2. Select which panel report to generate from the report list.

3. Select to process the project, active drawing, or selected components.

4. Select installation or location codes to extract (if applicable).

5. Specify to extract any installation or location codes (if applicable).

6. Indicate whether to update the project database with out-of-date drawings.

7. Click OK.

8. In the Report Generator Window, sort, format, or edit the data before sending the information to the printer, file, or the active drawing file.
   - **Edit Mode**: Modifies the report before you insert it in your drawing. You can move data up or down in the report, add lines from a catalog, and delete lines.
   - **Put on Drawing**: Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.
   - **Save to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs. Choose from: ASCII report, Comma Delimited, Excel spreadsheet, Access database, and XML format.
   - **User Post**: Switches specific functions against the data in the report. When you select a switch, the LISP routine runs a function against the data and returns to the Report Generator Window.
   - **Change Report Format**: Changes which data fields are reported and the order in which they appear. You can change the justification of any column and the column label. The Description field can be multi-lined. If you include the Description field in your report, you choose which lines make up this field. Switch on and off the specific fields to define the Description.

9. Once all modifications have been made to the report, save the report, place the report on the drawing as a table, or print the report.
Panel bill of materials

This report parallels the Schematic BOM report, but deals with panel component and terminal footprint symbols and nameplates. Optionally, it can include schematic items that are not referenced on the panel layouts (for example, field devices). You can customize the scope of the report by filtering on certain location values (for example, report for CAB1 items only), process only a subset of drawings, or include/exclude certain categories of items. The report displays and tallies like items (for example, same part number) together. Those with extra subassembly items are shown with a "SUB" multiplier value.

Access:

Click the Panel Reports tool. Select Bill of Material from the report list.

Click Projects ➤ Reports ➤ Panel Reports. Select Bill of Material from the report list.

Specify whether to process the project or the active drawing.

Include options

Include Nameplates
Specifications to include nameplate information in the report.

Include Cable/Connectors
Specifications to include connector information in the report.

All the above
Specifications to include cable, connector and nameplate information in the report.

List terminal numbers
Lists each individual Tag-ID and terminal number combination if selected. If unselected (default), the terminals are combined on the same Tag-ID strip into a single entry with a quantity.

Include Jumpers
Specifications to include jumper information in the report.

Full: include schematic components not referenced on panel layout
Specifications to include all schematic component information not found on the panel layout in the report.
Display option

Normal Tallied Format
Identical component or component/assemblies are tallied and reported as single line items (Ex: Red pushbutton operator 800EP-F4 with 800E-A3L latch and two 800E-3X10 N.O. contact blocks).

Normal Tallied Format (Group by Installation/Location)
Identical component or component/assemblies with the same installation/location codes are tallied and reported as single line items.

Display in Tallied Purchase List Format
Each part becomes its own line item (i.e. no longer any sub-assembly items) and each is tallied across all component types. For example, all 800E-3X10 N.O. contact blocks for all components are reported as a single line item.

Display in By TAG Format
All instances of a given component-ID or terminal tag are processed together and then reported as a single entry.

Installation Codes to Extract
Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick Named Installation, type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

Location Codes to Extract
Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2." Wild cards are supported.
After you click Named Location, type the location code in the box, or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**Freshen Project Database**

Specifies for AutoCAD Electrical to update the project database to include any out-of-date drawing files.

**Format**

Changes the format of the extracted data. The dialog box lists the format files to select from.

**Panel component exception**

This report provides error checking between the schematics and panel layout drawings. AutoCAD Electrical looks at the selected components, both schematic and panel, looking for a match in the project. For each schematic component selected, it tries to find a matching panel component based on tag, location, and installation information. If a match is found, it compares catalog and description information, looking for any discrepancies. AutoCAD Electrical then looks at each selected panel component looking for a matching schematic component in the same way.

**Access:**

Click the Panel Reports tool. Select Component Exception from the report list. From the Projects menu, select Reports ➤ Panel Reports. Select Component Exception from the report list.

Specify whether to process the project, active drawing, or a selected component.

**Conditions for Report**

Specifies which conditions the report checks for: whether the panel item is on the schematic, whether the schematic item is on a panel, if there are multiple instances of the terminal, and if there is a mismatch between schematic and panel terminals.
Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild cards are supported.

Once you pick Named Installation, type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2." Wild cards are supported.

After you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

Redisplay Last Run

Displays the previously extracted report.

Format

Changes the format of the extracted data. The sub-dialog box lists the format files to select from.

Panel component

This report lists every occurrence of a smart panel component footprint found on the current drawing or in the project drawing set. You can customize the scope of the report by filtering on certain location values (for example, report for CAB1 items only), process only a subset of drawings, or include/exclude certain categories of items. Note: this report will not include panel terminals unless you check that option. Each extracted panel component is listed as its own line item. If it has a part number that results in subassembly part numbers,
or has been individually annotated with multi-BOM part numbers, each additional part number is a line item right below the main line item.

Access:

Click the Panel Reports tool. Select Component from the report list.

Click Projects ➤ Reports ➤ Panel Reports. Select Component from the report list.

Specify whether to process the project or the active drawing.

Options

Specifies to include nameplates or terminals in the report. You can also indicate to skip components with blank device TAG values or blank manufacturer or catalog values.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick Named Installation, type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2". Wild-cards are supported.

After you select Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.
**Freshen Project Database**

Specifies for AutoCAD Electrical to update the project database to include any out-of-date drawing files.

**Format**

Changes the format of the extracted data. The dialog box lists the format files to select from.

**Missing level/sequence assignments**

This report lists which component symbols do not have leveling and sequencing information already assigned to them. This is used as a troubleshooting mechanism to aid in the assignment of leveling and sequencing information to provide better wire routing capabilities.

**Access:**

- Click the Panel Reports tool. Select Missing Level/Sequencing Assignments from the report list.
- From the Projects menu, select Reports ➤ Panel Reports. Select Missing Level/Sequencing Assignments from the report list.

In the Missing Level/Sequence Assignments dialog box, click Show to display temporary graphics around the insertion point of the panel layout symbols or click Report to run the report.

Specify whether to process the project or the active drawing.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick Named Installation, type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.
Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2". Wild-cards are supported.

Once you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

Format

Changes the format of the extracted data. The sub-dialog box lists the format files to select from.

Wire annotation exception

This report lists which physical component symbol doesn't have a From and a To for wire annotation information. For wire annotation, the panel component symbols contain wiring information as either attributed or Mtext data. This is used as a troubleshooting mechanism to aid in the assignment of wiring annotation. End1 is the end of the wire that contains the annotation and End2 is the end of the wire that was annotated on End1, but is not found in the range of drawings selected.

Access:

Click the Panel Reports tool. Select Wire Annotation Exception from the report list.

From the Projects menu, select Reports ➤ Panel Reports. Select Wire Annotation Exception from the report list.

Specify whether to process the project or the active drawing.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.
Once you pick Named Installation, type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2". Wild-cards are supported.

Once you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**Format**

Changes the format of the extracted data. The sub-dialog box lists the format files to select from.

**Panel nameplate**

This report is similar to the panel component report, but filters out all but nameplate symbols.

**Access:**

Click the Panel Reports tool. Select Nameplate from the report list. From the Projects menu, select Reports ➤ Panel Reports. Select Nameplate from the report list.

Specify whether to process the project, active drawing, or a selected component.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.
Once you pick Named Installation, type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2." Wild cards are supported.

Once you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**Redisplay Last Run**

Displays the previously extracted report.

**Format**

Changes the format of the extracted data. The dialog box lists the format files to select from.

**Panel terminal exception**

This report provides error checking between the schematic terminals and panel layout terminals. AutoCAD Electrical looks at the selected terminals, both schematic and panel, looking for a match in the project. For each schematic terminal selected, it tries to find a matching panel terminal based on tag, location, and installation information. If a match is found, it compares catalog information, looking for any discrepancies. AutoCAD Electrical then looks at each selected panel terminal looking for a matching schematic terminal in the same way.

**Access:**

Click the Panel Reports tool. Select Terminal Exception from the report list.

From the Projects menu, select Reports ➤ Panel Reports. Select Terminal Exception from the report list.
Specify whether to process the project, active drawing, or a selected component.

**Conditions for Report**

Specifies which conditions the report checks for: whether the panel item is on the schematic, whether the schematic item is on a panel, if there are multiple instances of the terminal, and if there is a mismatch between schematic and panel terminals.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick Named Installation, type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked "OP STA 2." Wild cards are supported.

Once you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**Redisplay Last Run**

Displays the previously extracted report.

**Format**

Changes the format of the extracted data. The dialog box lists the format files to select from.

**Panel wire connection**
Wire connection reports, extracted from the schematic wiring diagrams, can be formatted and inserted next to panel footprint symbols as simple wiring tables. AutoCAD Electoral extracts and formats a small report of wire connection information for the selected components, referencing the wire extract file. If your footprint symbols carry the AutoCAD Electrical X?TERMxx attributes, AutoCAD Electrical reports their XYZ wire connection location. The location is offset by the value defined in Panel Configuration dialog box.

**Access:**

Click the Panel Reports tool. Select Wire Connection from the report list. From the Projects menu, select Reports ➤ Panel Reports. Select Wire Connection from the report list.

Specify whether to process the project, active drawing, or a selected component.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components that carry part number values, components without an installation code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

After you pick Named Installation, type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes. You can also create a report from multiple installation codes. AutoCAD Electrical automatically creates a comma-delimited list for the named installation search.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components that carry part number values, components without a location code, or only components marked with a location code that matches that entered in the edit box. For example, BOM report for components marked “OP STA 2.” Wild cards are supported.

After you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.
**Redisplay Last Run**

Displays the previously extracted report.

**Format**

Changes the format of the extracted data. The dialog box lists the format files to select from.

---

**Overview of format files**

A Format File (.set file) can be used to pre-format a report for both manually-run reports and automatic reports. When running automatic reports more options within the .set file are used since user input is not required for each report. (Automatic reports are covered in next section). You can create as many format files as you want. If you are using updatable, intelligent tables, a format file is the third item that makes a report table unique. If you want to be able to insert multiple updatable tables for the same report with the same scope you need to use different format files for each report. If you are not inserting updatable tables, or the report or scope is different, then you do not need to use different format files.

A format file defines which fields to include from the available fields, the field order, justification, and column label. This information from the format file is used for both manual and automatic reports. When running automatic reports, the format file can also contain information for saving the report to file(s) and/or putting the report on the drawing(s) as a report table. The Report Format File Setup dialog box allows you to create or modify your format files.

You can enter in X-Y coordinates for the first section or click Pick to select a location. If you are breaking your report table into sections and are allowing multiple table sections per drawing, you can define the distance from one table section to the next. The value entered here is the distance between the end of one table section and the start of the next. For example, if you want 2 inches between table sections horizontally, enter a 2 as the X-Distance value. A blank value is interpreted as zero.

**NOTE** Your format file can be saved using any file name but is given a ".set" file extension. The format files can be edited using any text file editor but it is not recommended since the syntax for the files is somewhat complicated. It is recommended that you use the Report Format File Setup dialog box to create or modify your format files. If you are going to use Automatic Reports to create output files click "Save Report to File".
You can select each file type available for the selected report and enter one file name per type. If multiple file types are selected, when the report is run using the Automatic Reports, each file is created from that report data.
Define format files

1. Click the arrow on the Schematic Reports tool to access the Report Format File Setup tool.

2. Click the Report Format File Setup tool.

   **NOTE** You can also open this dialog box by clicking Format File Setup on the Automatic Report Selection (page 993) dialog box.

3. Select which report to generate a format file for or open an existing format file.

4. Specify any report options (if applicable).

5. Select installation or location codes to extract (if applicable).

6. (Optional) Select to add special break values to the page header. Selecting a special break of Installation/Location, displays the values for these devices in the report section header.

7. Sort or format the data before saving the format file.

   **TIP** If you are going to use the format file in automatic reports you should define either the Save Report to File options and/or Put on Drawing options since the reports are not displayed in the Report Generator dialog box.

   - **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs. Choose from: ASCII report, Comma Delimited, Excel spreadsheet, Access database, and XML format.

   - **Change Report Fields**: Changes which data fields are reported and the order in which they appear. You can change the justification of any column and the column label. The Description field can be multi-lined. If you include the Description field in your report, you choose which lines make up this field. Switch on and off the specific fields to define the Description.

   - **Put on Drawing**: Opens the Table Generation Setup (page 806) dialog box for specifying how to display your report as a table on your drawing.
Sort Fields: Controls the sorting order of fields in the report.

8 Save the format file for later retrieval and usage when generating reports.
9 Click Done.

Report format file setup - panel bill of material

Access:

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Bill of Material from the Panel report list.
From the Projects menu, select Reports ➤ Report Format File Setup. Select Bill of Material from the Panel report list.

Include options

Specifies whether to include nameplates, cable/connectors, or both in the report. You can also indicate whether to include schematic components not referenced on the panel layout.

Display option

- **Normal Tallied Format**: identical component or component/assemblies are tallied and reported as single line items (Ex: Red pushbutton operator 800EP-F4 with 800E-A3L latch and two 800E-3X10 N.O. contact blocks).
- **Normal Tallied Format (Group by Installation/Location)**: identical component or component/assemblies with the same installation/location codes are tallied and reported as single line items.
- **Display in Tallied Purchase List Format**: each part becomes its own line item (i.e. no longer any sub-assembly items) and each is tallied across all component types. For example, all 800E-3X10 N.O. contact blocks for all components are reported as a single line item.
- **Display in By TAG Format**: all instances of a given component-ID or terminal tag are processed together and then reported as a single entry.
Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

Report options

- **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.
  
  The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields**: Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. The Description field is handled a little differently than the other fields. This field can be a multi-line field which is actually made up of multiple fields. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing**: Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.
■ **Sort Fields**: Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

**Breaks**

■ **Special breaks**: Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.

■ **Add Special break values to header**: Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the panel are displayed in the report section header.

**Format File**

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name\}' sub-directory.

■ **Open Format File**: Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

■ **Save Format File**: Saves a format file on the hard disk for later retrieval and usage when generating reports.

■ **Save As Format File**: Saves a format file that you opened and modified with a different name.

**Report format file setup - panel component exception**

**Access:**

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Component Exception from the Panel report list.
From the Projects menu, select Reports ➤ Report Format File Setup. Select Component Exception from the Panel report list.
**Conditions for Report**

Specifies which conditions the report checks for: the panel item is not on the schematic, the schematic item is not on a panel, multiple instances of the component, and if there is a mismatch between schematic components and panel components.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

**Report options**

- **Save Report to File:** Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.
  
  The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields:** Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. If you include the Description field in your
report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing:** Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields:** Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

### Breaks

- **Special breaks:** Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.

- **Add Special break values to header:** Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the panel are displayed in the report section header.

### Format File

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name\}' sub-directory.

- **Open Format File:** Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

- **Save Format File:** Saves a format file on the hard disk for later retrieval and usage when generating reports.

- **Save As Format File:** Saves a format file that you opened and modified with a different name.

### Report format file setup - panel component
Access:

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Component from the Panel report list. From the Projects menu, select Reports ➤ Report Format File Setup. Select Component from the Panel report list.

Options

Specifies to include nameplates, cables, connectors, terminals, or all of them in the report. You can also indicate to skip components with blank device TAG values or blank manufacturer or catalog values.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

Report options

- **Save Report to File:** Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.
The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields**: Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing**: Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields**: Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

### Breaks

- **Special breaks**: Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.

- **Add Special break values to header**: Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the panel are displayed in the report section header.

### Format File

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name\}' sub-directory.

- **Open Format File**: Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

- **Save Format File**: Saves a format file on the hard disk for later retrieval and usage when generating reports.
Save As Format File: Saves a format file that you opened and modified with a different name.

**Report format file setup - missing level/sequence assignments**

**Access:**

Click the arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Missing Level/Sequence Assignments from the Panel report list.

Click Projects ➤ Reports ➤ Report Format File Setup. Select Missing Level/Sequence Assignments from the Panel report list.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

After you pick the Named Installation button, you can type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

After you pick the Named Location button, you can type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

**Report options**

Save Report to File: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.
The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options are shown on all report sections.

- **Change Report Fields**: Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. The Description field is handled a little differently than the other fields. This field can be a multi-line field which is actually made up of multiple fields. If you include the Description field in your report, choose which lines make up this field. Switch on and off the specific fields to define the Description.

- **Put on Drawing**: Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields**: Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK in the dialog boxes. If you are working in an unnamed format file, you must save the data after you select Done to keep the changes.

### Format File

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name\}' sub-directory.

- **Open Format File**: Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

- **Save Format File**: Saves a format file on the hard disk for later retrieval and usage when generating reports.

- **Save As Format File**: Saves a format file that you opened and modified with a different name.

### Report format file setup - wire annotation exception

Overview of format files | 949
Access:

Click the arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Wire Annotation Exception from the Panel report list. Click Projects ➤ Reports ➤ Report Format File Setup. Select Wire Annotation Exception from the Panel report list.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild cards are supported.

After you click the Named Installation button, you can type the installation code in the box, or click the List: Drawing or List: Project button to select from a list of used installation codes.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild cards are supported.

After you click the Named Location button, you can type the location code in the box, or click the List: Drawing or List: Project button to select from a list of used location codes.

Report options

- **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.

  The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options are shown on all report sections.

- **Change Report Fields**: Changes what data fields are reported and the order in which they appear. You can also change the justification of any column
and even the column label. The Description field is handled a little differently than the other fields. This field can be a multi-line field which is actually made up of multiple fields. If you include the Description field in your report, you choose which lines make up this field. Switch on and off the specific fields to define the Description.

- **Put on Drawing:** Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields:** Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK in the dialog boxes. If you are working in an unnamed format file, you must save the data after you select Done to keep the changes.

**Format File**

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the "Documents and Settings\{user name}\" subdirectory.

- **Open Format File:** Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user subdirectory. Select a file to edit from the list and click OK.

- **Save Format File:** Saves a format file on the hard disk for later retrieval and usage when generating reports.

- **Save As Format File:** Saves a format file that you opened and modified with a different name.

**Report format file setup - panel nameplate**

**Access:**

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Nameplate from the Panel report list.

From the Projects menu, select Reports ➤ Report Format File Setup. Select Nameplate from the Panel report list.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code,
or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

**Report options**

- **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format. The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields**: Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing**: Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields**: Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.
Breaks

- **Special breaks**: Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.

- **Add Special break values to header**: Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the panel are displayed in the report section header.

Format File

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name\}' sub-directory.

- **Open Format File**: Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

- **Save Format File**: Saves a format file on the hard disk for later retrieval and usage when generating reports.

- **Save As Format File**: Saves a format file that you opened and modified with a different name.

Report format file setup - panel terminal exception

Access:

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Terminal Exception from the Panel report list.

From the Projects menu, select Reports ➤ Report Format File Setup. Select Terminal Exception from the Panel report list.

Conditions for Report

Specifies which conditions the report checks for: the panel item is not on the schematic, the schematic item is not on a panel, multiple instances of the terminal, and if there is a mismatch between schematic terminals and panel terminals.
Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

Report options

- **Save Report to File:** Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.
  
  The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields:** Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing:** Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields:** Controls the sorting order of the fields in the report.
NOTE The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

Breaks

- **Special breaks**: Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.

- **Add Special break values to header**: Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the panel are displayed in the report section header.

Format File

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name\}' sub-directory.

- **Open Format File**: Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

- **Save Format File**: Saves a format file on the hard disk for later retrieval and usage when generating reports.

- **Save As Format File**: Saves a format file that you opened and modified with a different name.

**Report format file setup - panel wire connection**

Access:

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Wire Connection from the Panel report list. From the Projects menu, select Reports ➤ Report Format File Setup. Select Wire Connection from the Panel report list.
Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

Report options

- **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format. The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields**: Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing**: Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields**: Controls the sorting order of the fields in the report.
NOTE The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

Breaks

- **Special breaks**: Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.

- **Add Special break values to header**: Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the panel are displayed in the report section header.

Format File

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name\}' sub-directory.

- **Open Format File**: Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

- **Save Format File**: Saves a format file on the hard disk for later retrieval and usage when generating reports.

- **Save As Format File**: Saves a format file that you opened and modified with a different name.

Report format file setup - schematic AIP wire list

**Access:**

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Autodesk Inventor Professional Wire List from the Schematic report list.

From the Projects menu, select Reports ➤ Report Format File Setup. Select Autodesk Inventor Professional Wire List from the Schematic report list.
Report options

- **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.

The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields**: Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing**: Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields**: Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

Format File

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name\}' sub-directory.

- **Open Format File**: Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

- **Save Format File**: Saves a format file on the hard disk for later retrieval and usage when generating reports.

- **Save As Format File**: Saves a format file that you opened and modified with a different name.

Report format file setup - schematic bill of material
Access:

Click the arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Bill of Material from the Schematic report list.

From the Projects menu, select Reports ➤ Report Format File Setup. Select Bill of Material from the Schematic report list.

Include options

Specifies to include cables, connectors, or both in the report.

Display option

- **Normal Tallied Format**: identical component or component/assemblies are tallied and reported as single line items (for example, Red pushbutton operator 800EP-F4 with 800E-A3L latch and two 800E-3X10 N.O. contact blocks).

- **Normal Tallied Format (Group by Installation/Location)**: identical component or component/assemblies with the same installation/location codes are tallied and reported as single line items.

- **Display in Tallied Purchase List Format**: each part becomes its own line item (for example, no longer any subassembly items) and each is tallied across all component types. For example, all 800E-3X10 N.O. contact blocks for all components are reported as a single line item.

- **Display in By TAG Format**: all instances of a given component-ID or terminal tag are processed together and reported as a single entry.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you click Named Installation, you can type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes.
Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you click Named Location, you can type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes.

Report options

■ **Save Report to File:** Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format. First Section Only shows only the selected option (such as title line or time and date) on the first section of the report if multiple sections are used. If not checked, the selected options are shown on all report sections.

■ **Change Report Fields:** Changes what data fields are reported and the order in which they appear. You can change the justification of any column and the column label. The Description field can be multi-lined. If you include the Description field in your report, you choose which lines make up this field. Toggle on and off the specific fields to define the Description.

■ **Put on Drawing:** Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

■ **Sort Fields:** Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK on the dialog boxes. If you are working in an unnamed format file, you must save the data after you click Done to keep the changes you made.

Breaks

■ **Special breaks:** Specifies the value that controls the section break. The list displays the report-specific content to apply to the special break.

■ **Add Special break values to header:** Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the schematic are displayed in the report section header.
Format File

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name}\' sub-directory.

■ **Open Format File**: Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

■ **Save Format File**: Saves a format file on the hard drive for later retrieval and usage when generating reports.

■ **Save As Format File**: Saves a format file that you opened and modified with a different name.

Report format file setup - schematic cable from/to

Access:

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Cable From/To from the Schematic report list.

From the Projects menu, select Reports ➤ Report Format File Setup. Select Cable From/To from the Schematic report list.

Report options

■ **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.

The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

■ **Change Report Fields**: Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.
- **Put on Drawing**: Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields**: Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

**Breaks**

- **Special breaks**: Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.

- **Add Special break values to header**: Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the schematic are displayed in the report section header.

**Format File**

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name}' sub-directory.

- **Open Format File**: Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

- **Save Format File**: Saves a format file on the hard disk for later retrieval and usage when generating reports.

- **Save As Format File**: Saves a format file that you opened and modified with a different name.

**Report format file setup - schematic cable summary**
Access:

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Cable Summary from the Schematic report list. From the Projects menu, select Reports ➤ Report Format File Setup. Select Cable Summary from the Schematic report list.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

Report options

- **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.
  
  The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields**: Changes what data fields are reported and the order in which they appear. You can also change the justification of any column
and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing:** Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.
- **Sort Fields:** Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

**Breaks**

- **Special breaks:** Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.
- **Add Special break values to header:** Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the schematic are displayed in the report section header.

**Format File**

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name\}' sub-directory.

- **Open Format File:** Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

  **NOTE** You cannot open format files created prior to AutoCAD Electrical 2005 for this report.

- **Save Format File:** Saves a format file on the hard disk for later retrieval and usage when generating reports.
- **Save As Format File:** Saves a format file that you opened and modified with a different name.
Report format file setup - schematic PLC I/O component connection

Access:

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select PLC I/O Component Connection from the Schematic report list.

From the Projects menu, select Reports ➤ Report Format File Setup. Select PLC I/O Component Connection from the Schematic report list.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

Report options

- **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.

  The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if
multiple sections are used. If not selected, the selected options will be shown on all report sections.

■ **Change Report Fields:** Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

■ **Put on Drawing:** Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

■ **Sort Fields:** Controls the sorting order of the fields in the report.

---

**NOTE** The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

---

**Breaks**

■ **Special breaks:** Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.

■ **Add Special break values to header:** Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the schematic are displayed in the report section header.

---

**Format File**

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\user name' sub-directory.

■ **Open Format File:** Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

**NOTE** You cannot open format files created prior to AutoCAD Electrical 2005 for this report.

■ **Save Format File:** Saves a format file on the hard disk for later retrieval and usage when generating reports.
Report format file setup - schematic component wire list

Access:

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Component Wire List from the Schematic report list.
From the Projects menu, select Reports ➤ Report Format File Setup. Select Component Wire List from the Schematic report list.

Options

Specifies to include stand-alone terminals or plug-jack connectors in the report.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.
Report options

- **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.
  The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields**: Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing**: Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields**: Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

Breaks

- **Special breaks**: Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.

- **Add Special break values to header**: Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the schematic are displayed in the report section header.
Format File

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name\}' sub-directory.

- **Open Format File:** Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

  **NOTE** You cannot open format files created prior to AutoCAD Electrical 2005 for this report.

- **Save Format File:** Saves a format file on the hard disk for later retrieval and usage when generating reports.

- **Save As Format File:** Saves a format file that you opened and modified with a different name.

Report format file setup - schematic connector details

**Access:**

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Connector Details from the Schematic report list.

From the Projects menu, select Reports ➤ Report Format File Setup. Select Connector Details from the Schematic report list.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or...
only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

**Report options**

- **Save Report to File:** Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.

  The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields:** Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing:** Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields:** Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

**Breaks**

- **Special breaks:** Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.

- **Add Special break values to header:** Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the schematic are displayed in the report section header.
Format File

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name\}' sub-directory.

- **Open Format File:** Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

- **Save Format File:** Saves a format file on the hard disk for later retrieval and usage when generating reports.

- **Save As Format File:** Saves a format file that you opened and modified with a different name.

Report format file setup - schematic connector plug

**Access:**

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Connector Plug from the Schematic report list.

From the Projects menu, select Reports ➤ Report Format File Setup. Select Connector Plug from the Schematic report list.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.
Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

Report options

- **Save Report to File:** Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.
  The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields:** Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing:** Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields:** Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

Breaks

- **Special breaks:** Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.

- **Add Special break values to header:** Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the schematic are displayed in the report section header.
Format File

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name\}' sub-directory.

- **Open Format File**: Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

- **Save Format File**: Saves a format file on the hard disk for later retrieval and usage when generating reports.

- **Save As Format File**: Saves a format file that you opened and modified with a different name.

**Report format file setup - schematic connector summary**

Access:

- Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Connector Summary from the Schematic report list.

- From the Projects menu, select Reports ➤ Report Format File Setup. Select Connector Summary from the Schematic report list.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.
Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

Report options

- **Save Report to File:** Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format. The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields:** Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing:** Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields:** Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

Breaks

- **Special breaks:** Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.

- **Add Special break values to header:** Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the schematic are displayed in the report section header.
Format File

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the ‘Documents and Settings\{user name\}’ sub-directory.

- **Open Format File**: Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

- **Save Format File**: Saves a format file on the hard disk for later retrieval and usage when generating reports.

- **Save As Format File**: Saves a format file that you opened and modified with a different name.

**Report format file setup - schematic component**

**Access:**

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Component from the Schematic report list.

From the Projects menu, select Reports ➤ Report Format File Setup. Select Component from the Schematic report list.

**Options**

Specifies whether to include components, cable markers, or connectors in the report. You can also indicate to include the children for any of the selected options.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.
Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

Report options

- **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.

  The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields**: Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing**: Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields**: Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

Breaks

- **Special breaks**: Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.
Add Special break values to header: Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the schematic are displayed in the report section header.

Format File

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the ‘Documents and Settings\{user name}’ sub-directory.

Open Format File: Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

Save Format File: Saves a format file on the hard disk for later retrieval and usage when generating reports.

Save As Format File: Saves a format file that you opened and modified with a different name.

Report format file setup - schematic missing bill of material

Access:

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Missing Bill of Material from the Schematic report list.

From the Projects menu, select Reports ➤ Report Format File Setup. Select Missing Bill of Material from the Schematic report list.

Options

Specifies whether to include components, cable markers, connectors, or terminals in the report. You can select one or multiple options to include.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.
Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

**Report options**

- **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.
  The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields**: Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. The Description field is handled a little differently than the other fields. This field can be a multi-line field which is actually made up of multiple fields. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing**: Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields**: Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.
Breaks

- **Special breaks**: Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.

- **Add Special break values to header**: Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the schematic are displayed in the report section header.

Format File

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name\}' sub-directory.

- **Open Format File**: Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

- **Save Format File**: Saves a format file on the hard disk for later retrieval and usage when generating reports.

- **Save As Format File**: Saves a format file that you opened and modified with a different name.

**Report format file setup - schematic wire from/to**

**Access:**

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Wire From/To from the Schematic report list.

From the Projects menu, select Reports ➤ Report Format File Setup. Select Wire From/To from the Schematic report list.

**Report options**

- **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.
The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields:** Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing:** Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields:** Controls the sorting order of the fields in the report.

**NOTE**  The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

**Format File**

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name\}' sub-directory.

- **Open Format File:** Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

- **Save Format File:** Saves a format file on the hard disk for later retrieval and usage when generating reports.

- **Save As Format File:** Saves a format file that you opened and modified with a different name.

**Report format file setup - schematic PLC/IO address and descriptions**

**Access:**

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select PLC I/O Address and Descriptions from the Schematic report list.
Access:

From the Projects menu, select Reports ➤ Report Format File Setup. Select PLC I/O Address and Descriptions from the Schematic report list.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

Report options

- **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.
  
The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields**: Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.
Put on Drawing: Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

Sort Fields: Controls the sorting order of the fields in the report.

NOTE The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

Breaks

Special breaks: Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.

Add Special break values to header: Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the schematic are displayed in the report section header.

Format File

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name}' sub-directory.

Open Format File: Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

Save Format File: Saves a format file on the hard disk for later retrieval and usage when generating reports.

Save As Format File: Saves a format file that you opened and modified with a different name.

Report format file setup - schematic terminal numbers
Access:

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Terminal Numbers from the Schematic report list. From the Projects menu, select Reports ➤ Report Format File Setup. Select Terminal Numbers from the Schematic report list.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

Report options

- **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.

  The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields**: Changes what data fields are reported and the order in which they appear. You can also change the justification of any column.
and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing:** Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields:** Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

**Breaks**

- **Special breaks:** Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.

- **Add Special break values to header:** Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the schematic are displayed in the report section header.

**Format File**

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name\}' sub-directory.

- **Open Format File:** Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

- **Save Format File:** Saves a format file on the hard disk for later retrieval and usage when generating reports.

- **Save As Format File:** Saves a format file that you opened and modified with a different name.

**Report format file setup - schematic terminal plan**
Access:

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Terminal Plan from the Schematic report list. From the Projects menu, select Reports ➤ Report Format File Setup. Select Terminal Plan from the Schematic report list.

**Installation Codes to Extract**

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

**Location Codes to Extract**

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

**Report options**

- **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.
  
The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields**: Changes what data fields are reported and the order in which they appear. You can also change the justification of any column
and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing**: Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.
- **Sort Fields**: Controls the sorting order of the fields in the report.

**NOTE** The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

**Breaks**

- **Special breaks**: Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.
- **Add Special break values to header**: Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the schematic are displayed in the report section header.

**Format File**

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name\}' sub-directory.

- **Open Format File**: Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

**NOTE** You cannot open format files created prior to AutoCAD Electrical 2005 for this report.

- **Save Format File**: Saves a format file on the hard disk for later retrieval and usage when generating reports.
- **Save As Format File**: Saves a format file that you opened and modified with a different name.
Report format file setup - schematic PLC modules used so far

Access:

Click the drop-down arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select PLC Modules Used So Far from the Schematic report list.

From the Projects menu, select Reports ➤ Report Format File Setup. Select PLC Modules Used So Far from the Schematic report list.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Installation button, you can simply type the installation code in the box or click the List: Drawing or List: Project button to select from a list of used installation codes.

Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you pick the Named Location button, you can simply type the location code in the box or click the List: Drawing or List: Project button to select from a list of used location codes.

Report options

- **Save Report to File**: Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs using this dialog box. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.
  
  The First Section Only button indicates to only show the selected option (such as title line or time and date) on the first section of the report, if
multiple sections are used. If not selected, the selected options will be shown on all report sections.

- **Change Report Fields**: Changes what data fields are reported and the order in which they appear. You can also change the justification of any column and even the column label. If you include the Description field in your report, you choose which lines make up this field. Just toggle on and off the specific fields to define the Description.

- **Put on Drawing**: Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

- **Sort Fields**: Controls the sorting order of the fields in the report.

---

**NOTE**  The options are saved in the format file after you click OK on the sub-dialog boxes. If you are working in an unnamed format file, you have to save the data after you select Done in order to keep the changes you have made.

---

**Breaks**

- **Special breaks**: Specifies the value that controls the section break. The drop-down list displays the report-specific content to apply to the special break.

- **Add Special break values to header**: Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the schematic are displayed in the report section header.

---

**Format File**

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name}\' sub-directory.

- **Open Format File**: Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user sub-directory. Select a file to edit from the list and click OK.

- **Save Format File**: Saves a format file on the hard disk for later retrieval and usage when generating reports.

- **Save As Format File**: Saves a format file that you opened and modified with a different name.
Report format file setup - schematic wire label

The options are saved in the format file after you click OK on the dialog boxes. If you are working in an unnamed format file, you must save the data after you click Done to keep the changes you made.

Access:

Click the arrow on the Schematic Reports tool to access the Report Format File Setup tool. Select Wire Label from the Schematic report list.

From the Projects menu, select Reports ➤ Report Format File Setup. Select Wire Label from the Schematic report list.

Report Filter

- **Display Wire Label**
  Displays the wire label for all wires, except those that are part of a cable.

- **Display Cable Label**
  Displays the cable labels in the specified format.

Change Report Fields

Changes which data fields are reported and the order in which they appear. You can change the justification of any column and the column label.

There are two categories that you can change the report format for: wire label or cable label. Once you modify the report format, you can save it for future use. The wire and cable label formats are stored in the same file.

Label Quantity per Connection

Specifies the quantity of wire labels or cable labels. Wire labels are generated for every wire connection while cable labels are generated once for every cable.

Number of Columns to Display

Arranges the wire labels in the specified number of columns.

Horizontal/Vertical Arrangement

Arranges the wire label horizontally or vertically across the columns.
Save Report to File

Saves the report to a file. Select the type of output file from the Save Report to File dialog box. You can define multiple file outputs. Choose from: ASCII report (.rep), Comma Delimited (.csv), Excel spreadsheet (.xls), Access database (.mdb), and XML (.xml) format.

First Section Only shows only the selected option (such as title line or time and date) on the first section of the report if multiple sections are used. If not checked, the selected options are shown on all report sections.

Put on Drawing

Opens the Table Generation Setup dialog box for specifying how to display your report as a table on your drawing.

NOTE Once wire label reports are placed on the drawing in table format they are not editable using the Edit Component tool. You must use the AutoCAD table edit command to edit the table.

Breaks

Special Breaks

Specifies the value that controls the section break. The list displays the report-specific content to apply to the special break.

Add Special Break Values to Header

Adds the special break value to the page header. For example, if you select a special break of Installation/Location, the values provided for these devices in the schematic are displayed in the report section header.

Installation Codes to Extract

Extracts only the information for components with specific installation values. Indicate to process all components, components without an installation code, or only components marked with an installation code that matches that entered in the edit box. Wild-cards are supported.

Once you click Named Installation, you can type the installation code in the box or click List: Drawing or List: Project to select from a list of used installation codes.
Location Codes to Extract

Extracts only the information for components with specific location values. Indicate to process all components, components without a location code, or only components marked with a location code that matches that entered in the edit box. Wild-cards are supported.

Once you click Named Location, you can type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes.

Format File

Format files define specific criteria applied to the report prior to generating the report to screen, printer, file, or automatic generation. The format files are saved to the 'Documents and Settings\{user name}' sub-directory.

Open Format File

Selects format files to edit. The Report Format Settings File Selection dialog box opens and displays a list of format files (.set) in the user subdirectory. Select a file to edit from the list and click OK.

Save Format File

Saves a format file on the hard drive for later retrieval and usage when generating reports.

Save As Format File

Saves a format file that you opened and modified with a different name.

Run automatic reports

The Automatic Report Selection tool allows you to run multiple reports at one time. The Report Generator dialog box is not displayed for each report and no user input is required once launched. This feature can be used to generate any number of output files or to automatically place report tables on drawings.

The first step to using the Automatic Reports feature is to create the format files using the Report Format File Setup dialog box defining the report options and output as described above. You can create any number of format files for the same report if you use the same report with different options. Once your format files are created you are ready to run the reports automatically.

If any of your selected format files contain Table Output, if there are no existing, updatable matching report tables, the report tables insert on new
drawings. If you are running multiple reports with multiple table output, each report gets its own. You can specify the first drawing name for any necessary new drawings and the template name. Subsequent drawing names generate automatically by incrementing the previous drawing's name.

If you frequently run the same group of reports you can save the set of format files as a Report Grouping. To set up a Report Grouping, add all your format files as if you are going to run the reports then click Save Report Grouping. The information about the format files is saved in a Report Grouping file with an ".rgf" extension. The next time you want to run that report set, open the Automatic Reports Selection dialog box, click Open Report Grouping, and select the ".rgf" file you previously saved; you are ready to run the reports.

When you click OK, the reports run in the selected order. If the format file contains output options, the files are created. If the format file contains table output options that report's tables are inserted. If existing, matching report tables are found, they are updated, otherwise new table objects insert on new drawings.
Generate a report using format files

1. Click the arrow on the Schematic Reports tool to access the Automatic Report Selection tool.

2. Click the Automatic Report Selection tool.

3. Select which report to generate from the schematic or panel report list.

4. Specify the format file to use for the selected report. If there aren’t any format files to select from, you must click the Format File Setup button to create and save a format file.

5. Click the Add button to add the report name and format file to the Selected Reports list. This button is not active until both a report name and format file are selected.

6. Continue adding more reports to the Selected Reports list. For the File and Table Output options, an ‘X’ indicates that the automatic generation will run that portion, while an ‘O’ indicates that it will not run that portion.

7. Modify the output of a report type by selecting the report in the Selected Reports list and then clicking the Modify Output button. Make changes in the sub-dialog box and click OK.

8. Save the list of report names and format files for later retrieval and usage.

9. Specify a starting drawing file location and filename, and the drawing template file to use for the automatic creation of the drawing files.

10. Click OK to generate a report for the selected type(s).

Automatic report selection
This tool allows you to run multiple reports at one time. This can be used to generate any number of output files or to automatically place report tables on drawings.

**Access:**

Click the arrow on the Schematic Reports tool to access the Automatic Report Selection tool.

From the Projects menu, select Reports ➤ Automatic Report Selection.

**NOTE** All drawings are automatically added to the bottom of the Project Listing.

**Report Name**

Displays a list of all schematic and panel reports available for automatic report generation. Not every AutoCAD Electrical report is available for this command.

**Format File Name**

Displays a list of format files. These format files are associated with a particular report name. If there aren't any format files to select from, you must click the Format File Setup button to create and save a format file.

The Browse button allows you to search for a specific format file that is not displayed in the list.

**Control buttons**

- **Modify Output**: Changes the output types for individually selected reports. Each format file definition can determine whether the report is set to a file or table on the drawing, or both. Select a file in the Selected Reports list, click the Modify Output button, and click either of the toggle buttons to turn on or off the output type.

- **Add**: Adds the report name and format file to the Selected Reports list. This button is not active until both a report name and format file are selected.

- **Remove**: Removes individual reports from the Selected Reports list. Select the file from the list so that it is highlighted and press the Remove button.

- **Remove All**: Removes all of the reports from the Selected Reports list. There is no need to select the files in the list; simply press the Remove All button.
Selected Reports

Displays the current active listing of all reports for the report generation. The list displays the report name and format file name, as well as indicators that show if the report output is a file or table.

For the File and Table Output options, an 'X' indicates that the automatic generation will run that portion, while an 'O' indicates that it will not run that portion.

Open or Save Report Grouping

Allows you to define an alias (grouping) file with a pre-defined list of reports for later retrieval and usage. You can make many grouping files for different customer types and configurations. The Report Grouping files are maintained in the Documents and Settings\USER sub-directory. The file names have an .rgf file extension.

- **Open Report Grouping**: Opens a previously saved grouping of report names and format files.
- **Save Report Grouping**: Saves a file that contains the list of report names and format files for later retrieval and usage. You may define a list of reports based upon which customer is using the report data and the format that customer would like to see the reports in.

Drawing Information for Table Output

Specifies a starting drawing file location and filename, and the drawing template file to use for the automatic creation of the drawing files. You can select a template drawing file to use for the automatic creation of drawing files. Type in a template filename or use the Browse button to search for and select a template file. It is advised to start the first drawing filename with a numeric suffix.

**NOTE** If you enter just a filename, the drawing files will be created and saved in the active project path.
Modify spreadsheet data

Use this to edit component tags, descriptions, catalog assignments, wire numbers, or PLC I/O descriptions from a spreadsheet and then have your edits update your drawings. Your spreadsheet/database edits can update existing
or blank values on existing components, terminals, PLC I/O modules, and wire numbers but it cannot insert new items into the drawings.

1. Click the arrow on the Schematic Reports tool to access the Export to Spreadsheet tool.

2. Click the Export to Spreadsheet tool.

3. Select the data category to export.
   If you select General, information for the categories marked with an asterisk (*) is extracted. Each category is saved to a separate sheet (spreadsheet format) or table (database format). The tab-delimited or comma-delimited formats are not available when writing out to multiple categories.

4. Click OK.

5. In the Data Export dialog box, specify to export the spreadsheet data for the current drawing or the entire project.

6. Specify the output format (Microsoft Excel, Access file, Tab-delimited ASCII, or Comma-delimited ASCII) and the location codes to extract, and click OK.
   AutoCAD Electrical creates a file of the data pulled from your wiring diagram drawings.

7. Open this file in any spreadsheet or database program for view and edit.
   **Caution:** If you selected a Tab or Comma-delimited ASCII format, import all fields as text. Some spreadsheet programs may try to convert some fields into numeric or scientific notation values. You may need to save the AutoCAD Electrical extracted data to a file with a .txt extension and then use the spreadsheet’s import wizard to force all fields to be classified as text.

8. After editing, save the spreadsheet data back out to its original format.

9. (Optional) Before importing the spreadsheet data back into the drawing or project, add additional columns to the spreadsheet data. Label each column with a target ATTRIBUTE name.
During the import function, AutoCAD Electrical checks for these new attributes and updates them with data you entered into the spreadsheet.

10 Click the arrow on the Schematic Reports tool to access the Update from Spreadsheet tool.

11 Click the Update from Spreadsheet tool.

12 Select the spreadsheet and click Open.

13 In the Update Drawings per Spreadsheet Data dialog box, specify to import the spreadsheet data for the current drawing or the entire project.

14 Select any other import options and click OK. The project or drawing's data automatically updates to match the edits on the spreadsheet.
   All spreadsheet update changes are automatically logged, complete with time and date, in a text file saved to the AutoCAD Electrical user subdirectory.
   If you edit the BLOCK field in the spreadsheet and assign a different block name, AutoCAD Electrical tries to find the new block during the update. If found, the old block is switched to the new one.

**NOTE** Do not edit the HDL and DWGNAME fields. These are used by the Drawing Update from Spreadsheet utility to link your edits back to the correct drawing and correct block insert on that drawing.

---

**Export to spreadsheet**
This utility copies the selected data category to a comma-delimited, Excel XLS, or Access MDB file format for editing.

**Access:**

- Click the drop-down arrow on the Schematic Reports tool to access the Export to Spreadsheet tool.
- From the Projects menu, select Export to Spreadsheet ➤ Export to Spreadsheet.

**Limitation:** Your spreadsheet edits can update existing or blank values on existing components, terminals, PLC I/O modules, and wire numbers but it cannot insert new items into the drawings. It only changes existing values.

**Component data export**

This utility copies components to a comma-delimited, Excel XLS, or Access MDB file format for editing.

**Access:**

- Click the arrow on the Schematic Reports tool to access the Export to Spreadsheet tool. Select Component from the list.
- From the Projects menu, select Export to Spreadsheet ➤ Export to Spreadsheet. Select Component from the list.

**Data export for**

Specifies to export the data for the active drawing or the entire project.

**Output format**

Specifies the format for outputting the spreadsheet.

**Location Codes to extract**

Extracts only the information for components with specific location values. After you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**General data export**
This utility copies all the data categories to a comma-delimited, Excel XLS, or Access MDB file format for editing.

**Access:**

Click the arrow on the Schematic Reports tool to access the Export to Spreadsheet tool. Select General from the list.

From the Projects menu, select Export to Spreadsheet ➤ Export to Spreadsheet. Select General from the list.

**Data export for**

Specifies to export the data for the active drawing or the entire project.

**Output format**

Specifies the format for outputting the spreadsheet.

**Location Codes to extract**

Extracts only the information for components with specific location values. After you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**PLC I/O header information export**

This utility copies PLC I/O header information to a comma-delimited, Excel XLS, or Access MDB file format for editing.

**Access:**

Click the arrow on the Schematic Reports tool to access the Export to Spreadsheet tool. Select PLC I/O header information from the list.

From the Projects menu, select Export to Spreadsheet ➤ Export to Spreadsheet. Select PLC I/O header information from the list.

**Data export for**

Specifies to export the data for the active drawing or the entire project.
Output format

Specifies the format for outputting the spreadsheet.

Location Codes to extract

Extracts only the information for components with specific location values. After you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

PLC I/O connection export

This utility copies PLC I/O wire connections to a comma-delimited, Excel XLS, or Access MDB file format for editing.

Access:

Click the arrow on the Schematic Reports tool to access the Export to Spreadsheet tool. Select PLC I/O wire connections from the list.

From the Projects menu, select Export to Spreadsheet ➤ Export to Spreadsheet. Select PLC I/O wire connections from the list.

Data export for

Specifies to export the data for the active drawing or the entire project.

Output format

Specifies the format for outputting the spreadsheet.

Location Codes to extract

Extracts only the information for components with specific location values. After you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

PLC I/O address/description export
This utility copies PLC I/O address/descriptions to a comma-delimited, Excel XLS, or Access MDB file format for editing.

Access:

Click the arrow on the Schematic Reports tool to access the Export to Spreadsheet tool. Select PLC I/O address/descriptions from the list. From the Projects menu, select Export to Spreadsheet ➤ Export to Spreadsheet. Select PLC I/O address/descriptions from the list.

Data export for

Specifies to export the data for the active drawing or the entire project.

Output format

Specifies the format for outputting the spreadsheet.

Location Codes to extract

Extracts only the information for components with specific location values. After you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

Panel layout data export

This utility copies panel components to a comma-delimited, Excel XLS, or Access MDB file format for editing.

Access:

Click the arrow on the Schematic Reports tool to access the Export to Spreadsheet tool. Select Panel components from the list. From the Projects menu, select Export to Spreadsheet ➤ Export to Spreadsheet. Select Panel components from the list.

Data export for

Specifies to export the data for the active drawing or the entire project.
Output format

Specifies the format for outputting the spreadsheet.

Location Codes to extract

Extracts only the information for components with specific location values. After you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

Panel terminals data export

This utility copies panel terminals to a comma-delimited, Excel XLS, or Access MDB file format for editing.

Access:

Click the arrow on the Schematic Reports tool to access the Export to Spreadsheet tool. Select Panel terminals from the list. From the Projects menu, select Export to Spreadsheet ➤ Export to Spreadsheet. Select Panel terminals from the list.

Data export for

Specifies to export the data for the active drawing or the entire project.

Output format

Specifies the format for outputting the spreadsheet.

Location Codes to extract

Extracts only the information for components with specific location values. After you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

Terminal data export
This utility copies terminals to a comma-delimited, Excel XLS, or Access MDB file format for editing.

**Access:**

Click the arrow on the Schematic Reports tool to access the Export to Spreadsheet tool. Select Terminals from the list. From the Projects menu, select Export to Spreadsheet ➤ Export to Spreadsheet. Select Terminals from the list.

**Data export for**

Specifies to export the data for the active drawing or the entire project.

**Output format**

Specifies the format for outputting the spreadsheet.

**Location Codes to extract**

Extracts only the information for components with specific location values. After you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**Update drawings per spreadsheet data**

**Access:**

Click the drop-down arrow on the Schematic Reports tool to access the Update from Spreadsheet tool. Select the spreadsheet and click Open. From the Projects menu, select Export to Spreadsheet ➤ Update from Spreadsheet. Select the spreadsheet and click Open.

**Process**

Specifies to import the spreadsheet data for the current drawing or the entire project.

**Force spreadsheet new values to uppercase**

Forces all new spreadsheet values to be displayed in uppercase.
Flip any updated tag/wire number values to fixed

Fixes all updated tag or wire number values. A fixed component tag does not update when the Re-tag Update command is run. The tag name keeps its fixed value.

Create user-defined attributes

You can define your own attributes onto AutoCAD Electrical block files and modify user-defined attributes using the AutoCAD Attribute Edit command or the Show/Edit Miscellaneous option on the AutoCAD Electrical Insert/Edit Component dialog box. The maximum allowable entries for reading or exporting any *.wda file is 150.

Use the User Defined Attribute List tool to selectively determine which non-AutoCAD Electrical attributes are allowed in the AutoCAD Electrical report generators. Otherwise only those attributes defined inside of AutoCAD Electrical for each component category are processed in the project database and subsequent reports.

NOTE You can edit the attribute text file (*.wda) in Notepad; however, you must set the Encoding to Unicode in the Open and Save dialog boxes.

The Project Database Service (PDS) saves all non-AutoCAD Electrical-aware attributes from block files into the project for processing. The PDS maintains these database entries when the drawing file is saved and monitors them in real-time as if they are normal components in the project. Once the PDS successfully places the attribute values of all blocks from the drawing files into the AutoCAD Electrical project database, the report generator program is able to place the listed attribute values into the report generators if a *.wda file is found with the appropriate name in any of the search paths and has the correct format.

NOTE The report format files (*.set) support the user-defined attributes for automatic report generation. If a set file declares an attribute tag that is not found in the User Defined Attribute List, the column in the report is empty. The user defined attributes display in the Change Report Format dialog boxes (on the Report Generator dialog box, click Change Report Format).

Edit user defined attribute list

Once you add an attribute to an AutoCAD Electrical block, you can edit the attribute using the Show/Edit Miscellaneous option in the Insert/Edit...
Component dialog box or using the Enhanced Attribute Editor tool accessed by double-clicking on an AutoCAD block in the drawing. Attributes can then be added to the user defined attribute list for report generation.

1. Click the arrow on the Schematic Reports tool to access the User Defined Attribute List tool.

2. Click the User Defined Attribute List tool.

3. In the User Defined Attribute List dialog box, click inside the Attribute Tag column for Row 1. Click Pick.

4. Select the attribute from the drawing.
   The attribute displays in the Attribute Tag column in Row 1.

5. (Optional) Specify the column width, justification, and column title for the attribute for report generation purposes.
   Click in a cell to edit the cell or right-click in a cell to copy, cut, or paste contents from one cell into another. If left blank, default values are used.

6. Repeat for any additional attributes.

7. Click OK.
   If this is the first time the grid content is being saved, the Save As dialog box displays. Enter the file name and click Save. This is generally <project_name>.wda or default.wda.

**NOTE** Click Save As if an existing file needs to be saved in a different location or with a different name.

---

**User-defined attribute list**

This tool creates an attribute text file (*.wda) of user-defined attributes defined on AutoCAD Electrical block files. The User Defined Attribute List is used by report tools to determine which additional attributes are listed in a report. The list file name can be the same as the active project or named Default to be used by the entire system. The Default.wda file is saved in the base project folder, while the <project_name>.wda file is saved in the same folder as the project definition file (*.wdp).
NOTE Attributes can be added to existing block files using the Add Attribute tool or the AutoCAD ATTDEF command. Edit attributes using the Show/Edit Miscellaneous option in the Insert/Edit Component dialog box or using the Enhanced Attribute Editor tool accessed by double-clicking an AutoCAD Electrical block in the drawing.

Access:

Click the Schematic Reports tool to access the User Defined Attribute List tool. From the Projects menu, select Reports ➤ User Defined Attribute List.

Sort the list by clicking any of the column headers or move rows up or down in the list by highlighting multiple rows and dragging the selection on the sequence number list to the appropriate position.

| Attribute Tag | Edits and displays the list of attribute tags to be made available in the Report Generator. The attribute tags can be in any order in the list. Enter text, click in the cell to edit, or right-click in the cell to pick, copy, cut, or paste a value.  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>NOTE</strong> An attribute tag is required and must be specified before you can edit any of the other fields in its row.</td>
</tr>
</tbody>
</table>
| Column Width    | Edits and displays the column width for the attribute tag. Enter a number, click in the cell to edit, or right-click in the cell to copy or cut a value.  
|                 | **NOTE** If left blank, the column width is restricted to 24 characters. |
| Justification   | Edits and displays the justification of the attribute tag text. Click in the cell and select from Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center or Bottom Right justification. The justification definition can be modified inside the Change Report Format dialog box.  
|                 | **NOTE** If left blank, Top Left justification is used. |
| Column Title    | Edits and displays the column header title in the Report Generator dialog box. Enter text, click in the cell to edit, or right-click in the |
To copy, cut, or paste a value. The column title can be modified inside the Change Report Format dialog box.

**NOTE** If left blank, the attribute tag is used as the column header.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pick</td>
<td>Selects an attribute from the drawing to use as the Attribute Tag.</td>
</tr>
<tr>
<td>Open</td>
<td>Browses for an existing User Defined Attribute List file for editing.</td>
</tr>
<tr>
<td>Save As</td>
<td>Creates a new User Defined Attribute List file with extension .wda.</td>
</tr>
</tbody>
</table>

**Right-click options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pick</td>
<td>Allows selection of an attribute from the drawing. This is available only for the Attribute Tag.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the cell contents to paste in another.</td>
</tr>
<tr>
<td>Cut</td>
<td>Removes the cell contents to paste in another.</td>
</tr>
<tr>
<td>Paste</td>
<td>Places the copied or cut cell contents in a new cell.</td>
</tr>
</tbody>
</table>

**NOTE** You can also copy, cut, and paste entire row contents from one row to another (one at a time), however you cannot paste the row contents into a single cell.

**Set up for export to Autodesk Inventor Professional Cable & Harness**

You can export wire list information from AutoCAD Electrical and directly import it into Autodesk Inventor Professional Cable & Harness. In order to merge electrical and mechanical data, you must first create a one-to-one
mapping from the electrical data to the mechanical assembly. Make sure the following are correctly set up before running the report.

**Pin numbers on component symbols**

The pin numbers on the component symbols in AutoCAD Electrical must correspond to the Pin Name property on the equivalent pin in Autodesk Inventor Professional Cable & Harness. Use the Pin Properties dialog box in Autodesk Inventor Professional Cable & Harness to change the pin name property.

**Component tags**

Each component is defined with a unique Tag ID classified as the Component Tag. The component tags on each component in AutoCAD Electrical must correspond to the unique identifier or reference designator (RefDes property value) for the corresponding electrical part instance in the designated harness assembly in the Cable & Harness application. Use the Part Properties dialog box in Autodesk Inventor Professional Cable & Harness to change the RefDes property.

You can define attributes on components in AutoCAD Electrical that can map to properties when exported to Autodesk Inventor Professional. These attributes can be component definition (catalog database) or component occurrence specific. Use the Edit Component tool to edit the occurrence of a component. Upon selection of a catalog number from the AutoCAD Electrical catalog database, component definition properties can be applied to the component occurrence and the information exported into the XML file.

**NOTE** When you apply additional parts to the component occurrence, their respective component definition properties can also be applied in the overall component occurrence. Up to 10 additional part numbers can be applied to the occurrence of a component. Each of these catalog numbers can have their own set of component definition properties.

**Wires**

In order to map wires from the schematic to the 3D design, each wire needs a persistent tag or number used to uniquely identify it within the design. The wire number in AutoCAD Electrical is used as the Wire ID property value in Cable & Harness. The cabling application needs a From/To list with a unique identifier to track inputs from multiple wire lists and to know when wires have moved or been updated on subsequent imports. The wires in the
schematic must be fixed, mapped to a wire in the Cable & Harness Wire Library, and have distinct wires into the same pin.

NOTE The wire number must be unique for individual From and To connections and a wire network ladder style cannot be used.

You can define attributes and properties on a wire that can map to properties when exported to Autodesk Inventor Professional. These attributes can be wire definition (wire type) or wire occurrence specific. Use the Edit Wire Number tool to edit the wire number. Upon selection of a wire type from the Set/Edit Wire Type dialog box, wire definition properties can be applied to the wire layer occurrence and the information exported into the XML file.

Wire layers

Not all nets in a schematic are physical wires; some are representative of other types of connections, such as those made by attaching a component to a bus bar. When attempts are made to map these nets in a harness assembly, the corresponding pins/parts are often not present. Only the nets that are to be mapped into wires in 3D should be drawn with a layer identified as a wire for inclusion in the output report file for Autodesk Inventor Professional Cable & Harness. If a wire that is included in the custom report output file is not recognized as a library wire in the Cable & Harness Library during the Import Wire List process, the wire occurrence will not be imported.

The layers defined in AutoCAD Electrical must first be defined as valid wire layers. Each AutoCAD Electrical wire layer must then correspond to a valid library wire in the Cable & Harness Library. While the wire layer in AutoCAD Electrical is just a label or name, the Cable & Harness wire definition defines how the wire is displayed - including size (outer diameter and gauge) and color.

Cables

When cables are used in the schematic, the name of the cable conductor (wire) layer defined in the drawing of AutoCAD Electrical must correspond to a valid cable definition in the Cable & Harness Library. The Wire Color/ID of each conductor in AutoCAD Electrical must correspond to a Conductor ID used in that cable definition in the Cable & Harness Library. This Wire Color/ID can be overwritten on each cable conductor occurrence by selecting Edit Component on a cable marker and making the change in the Insert / Edit Cable Marker dialog box. The Conductor list in the AutoCAD Electrical catalog can also be changed to reflect the same Conductor ID used in Cable & Harness.
The cable occurrence definition is made up of one parent symbol and multiple children symbols depending on the number of wire included. Upon selection of a catalog number from the AutoCAD Electrical catalog database, component definition properties can be applied to the component occurrence and the information exported into the XML file.

**NOTE** When you apply additional parts to the component occurrence, their respective component definition properties can also be applied in the overall component occurrence. Up to 10 additional part numbers can be applied to the occurrence of a component. Each of these catalog numbers can have their own set of component definition properties.

### Splices

Each splice is defined with a Splice ID (component tag). The Splice ID in AutoCAD Electrical is used as the RefDes property value in Cable & Harness. Use the Edit Component tool to edit the splice component. Upon selection of a catalog number from the AutoCAD Electrical catalog database, splice definition properties can be applied to the component occurrence and the information exported into the XML file.

**NOTE** When you apply additional parts to the component occurrence, their respective splice definition properties can also be applied in the overall component occurrence. Up to 10 additional part numbers can be applied to the occurrence of a component. Each of these catalog numbers can have their own set of component definition properties.

### Branches and Ts in nets

Branches and Ts in nets are not valid on nets imported into Cable & Harness. These types of representations map to multiple possible physical configurations. The exact physical intent of each wire must be depicted in the wiring diagram. Both non-physical and physical splices must be used so that each net that represents a wire has only two nodes, a From and a To. In AutoCAD Electrical, direct connections into a component must be created (no Ts) so that each physical wire has a definitive From component/pin and a To component/pin.
**AutoCAD Electrical attributes mapped to Autodesk Inventor Professional properties**

There are 4 Autodesk Inventor Professional assembly entity types that get AutoCAD Electrical attributes: components, wires, cable, and splices.

<table>
<thead>
<tr>
<th>Attribute TAG</th>
<th>Attribute Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Component Properties</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INST &amp; LOC</td>
<td>Occurrence</td>
<td>Installation and Location code; associated to the component tag (RefDes)</td>
</tr>
<tr>
<td>TAG1 &amp; TAG2</td>
<td>Occurrence</td>
<td>Component TAG - RefDes property name</td>
</tr>
<tr>
<td>DESC1-DESC3</td>
<td>Occurrence</td>
<td>Descriptions used to describe the component</td>
</tr>
<tr>
<td>CAT</td>
<td>Occurrence</td>
<td>Main AutoCAD Electrical catalog number - Part Number property name in Autodesk Inventor Professional</td>
</tr>
<tr>
<td>MFG</td>
<td>Occurrence</td>
<td>Manufacturer - Vendor of Part Number property name in Autodesk Inventor Professional</td>
</tr>
<tr>
<td>ASSYCODE</td>
<td>Occurrence</td>
<td>Assembly code for part - if part is a subset of an assembly</td>
</tr>
<tr>
<td>CAT01-10</td>
<td>Occurrence</td>
<td>Multiple BOM part numbers</td>
</tr>
<tr>
<td>MFG01-10</td>
<td>Occurrence</td>
<td>Multiple BOM Manufacturer associated to the Multiple BOM part numbers</td>
</tr>
<tr>
<td>ASSYCODE01-10</td>
<td>Occurrence</td>
<td>Multiple BOM Assembly codes associated to the Multiple BOM part numbers</td>
</tr>
</tbody>
</table>
### Rating Information

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RATING1-12</td>
<td>Occurrence</td>
<td>Rating information associated to the component definition</td>
</tr>
<tr>
<td>FAMILY</td>
<td>Definition</td>
<td>Family code definition - FAMILY attribute on AutoCAD Electrical block file</td>
</tr>
<tr>
<td>WDBLKNNAM</td>
<td>Definition</td>
<td>Block name definition used for catalog lookup</td>
</tr>
</tbody>
</table>

#### Wire Properties

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIRENO</td>
<td>Occurrence</td>
<td>Unique wire number ID - AutoCAD Electrical wire number</td>
</tr>
<tr>
<td>LAYER NAME</td>
<td>Occurrence</td>
<td>Wire layer name (AutoCAD Layer) - Wire Definition name in Autodesk Inventor Professional</td>
</tr>
<tr>
<td>Layer Name - Wire Properties Xrecords</td>
<td>Definition</td>
<td>Wire layer properties (Xrecords on AutoCAD layer) - Definition custom properties on the wire number in Autodesk Inventor Professional</td>
</tr>
<tr>
<td>WIRENO attributes WIRENO01-10</td>
<td>Occurrence</td>
<td>Wire attributes on wire number block file - Occurrence custom properties on the wire number in Autodesk Inventor Professional</td>
</tr>
</tbody>
</table>

#### Cable ID Properties

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INST &amp; LOC</td>
<td>Occurrence</td>
<td>Installation and Location code; associated to the component tag (RefDes)</td>
</tr>
<tr>
<td>TAG1 &amp; TAG2</td>
<td>Occurrence</td>
<td>Component TAG - RefDes property name</td>
</tr>
<tr>
<td>RATING1</td>
<td>Occurrence</td>
<td>Cable conductor ID; AutoCAD Electrical Rating1 attribute - Cable Wire name in Autodesk Inventor Professional; add</td>
</tr>
</tbody>
</table>

---

Set up for export to Autodesk Inventor Professional Cable & Harness | 1013
a numeric value along with the conductor color

<table>
<thead>
<tr>
<th>DESC1- DESC3</th>
<th>Occurrence</th>
<th>Descriptions used to describe the component</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAT</td>
<td>Occurrence</td>
<td>Main AutoCAD Electrical catalog number - Part Number property name in Autodesk Inventor Professional</td>
</tr>
<tr>
<td>MFG</td>
<td>Occurrence</td>
<td>Manufacturer - Vendor of Part Number property name in Autodesk Inventor Professional</td>
</tr>
<tr>
<td>ASSYCODE</td>
<td>Occurrence</td>
<td>Assembly code for part - if part is a subset of an assembly</td>
</tr>
<tr>
<td>CAT01-10</td>
<td>Occurrence</td>
<td>Multiple BOM part numbers</td>
</tr>
<tr>
<td>MFG01-10</td>
<td>Occurrence</td>
<td>Multiple BOM Manufacturer associated to the Multiple BOM part numbers</td>
</tr>
<tr>
<td>ASSYCODE01-10</td>
<td>Occurrence</td>
<td>Multiple BOM Assembly codes associated to the Multiple BOM part numbers</td>
</tr>
<tr>
<td>FAMILY</td>
<td>Definition</td>
<td>Family code definition - FAMILY attribute on AutoCAD Electrical block file</td>
</tr>
<tr>
<td>WDBLKNAM</td>
<td>Definition</td>
<td>Block name definition used for catalog lookup</td>
</tr>
</tbody>
</table>

**Splice Properties**

<p>| INST &amp; LOC   | Occurrence | Installation and Location code; associated to the component tag (RefDes) |</p>
<table>
<thead>
<tr>
<th>Component</th>
<th>Occurrence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAG1</td>
<td>Occurrence</td>
<td>Component TAG - RefDes property name</td>
</tr>
<tr>
<td>DESC1-DESC3</td>
<td>Occurrence</td>
<td>Descriptions used to describe the component</td>
</tr>
<tr>
<td>CAT</td>
<td>Occurrence</td>
<td>Main AutoCAD Electrical catalog number - Part Number property name in Autodesk Inventor Professional</td>
</tr>
<tr>
<td>MFG</td>
<td>Occurrence</td>
<td>Manufacturer - Vendor of Part Number property name in Autodesk Inventor Professional</td>
</tr>
<tr>
<td>ASSYCODE</td>
<td>Occurrence</td>
<td>Assembly code for part - if part is a subset of an assembly</td>
</tr>
<tr>
<td>CAT01-10</td>
<td>Occurrence</td>
<td>Multiple BOM part numbers</td>
</tr>
<tr>
<td>MFG01-10</td>
<td>Occurrence</td>
<td>Multiple BOM Manufacturer associated to the Multiple BOM part numbers</td>
</tr>
<tr>
<td>ASSYCODE01-10</td>
<td>Occurrence</td>
<td>Multiple BOM Assembly codes associated to the Multiple BOM part numbers</td>
</tr>
<tr>
<td>RATING1-12</td>
<td>Occurrence</td>
<td>Rating information associated to the component definition</td>
</tr>
<tr>
<td>FAMILY</td>
<td>Definition</td>
<td>Family code definition - FAMILY attribute on AutoCAD Electrical block file</td>
</tr>
<tr>
<td>WDBLKNAM</td>
<td>Definition</td>
<td>Block name definition used for catalog lookup</td>
</tr>
</tbody>
</table>
Output reports to Autodesk Inventor Professional Cable and Harness

Use this tool to export component, connector, wiring/cable, and splice data from your 2D connector drawing into an XML file that can then be imported into Autodesk Inventor Professional to aid in the generation of a cable and harness assembly.

**NOTE** You must first configure wire numbering to be "On per Wire Basis" for export and set up the appropriate variables before running the report.

1. Click the arrow on the Schematic Reports tool to access the Autodesk Inventor Professional Export tool.

2. Click the Autodesk Inventor Professional Export tool.

3. In the Autodesk Inventor Professional Export dialog box, specify whether to process the project or current drawing and click OK.

4. In the Autodesk Inventor Professional XML File Export dialog box, define the location and filename for the export file. By default file is saved with a .xml extension to the C:\Documents and Settings\{username}\My Documents folder.

Configure wire numbering for export

There are several steps to set up the wire numbering convention in AutoCAD Electrical for the import of data into Autodesk Inventor Professional Cable and Harness.

Define wire layers

Layers defined in AutoCAD Electrical must be defined as valid wire layers. While the following steps do not create the layers on the drawings that need to be mapped into the Cable and Harness Library, they tell AutoCAD Electrical which layers are treated as valid wire types.

1. Select Wires ➤ Create/Edit Wire Type.
2 In the Create/Edit Wire Type dialog box, click Add Existing Layer to add the wire line layers in use in the schematic to the list to be recognized as layers by AutoCAD Electrical.

3 In the Layers for Line Wires dialog box, enter the layer name or pick a wire from the existing layer list.
   A wildcard used in the name selects a group of layers. For example, RED_* selects all layers that begin with "RED_".

4 Click OK.

5 In the Create/Edit Wire Type dialog box, click OK.

NOTE You can also change layer properties using the Project Manager tool. In the Project Manager, right-click on the project name and select Properties. In the Drawing Format tab, Layers section, click Define.

Set unique wire IDs
You need to assign each wire a unique wire ID or number before they can be imported into another application.

1 Click the Project Manager tool.

2 In the project listing, right-click the project name, and select Properties.

3 In the Project Properties dialog box, click the Wire Numbers tab.

4 In the Wire Number Options section, select On per Wire Basis.

5 Click OK.

Fix wire numbering
You must fix the wire numbers so they stay the same for subsequent imports into Autodesk Inventor Professional Cable and Harness. Do this after the wire numbers have been assigned. Use any of the following procedures to fix wire numbers.
Automatic wire numbering:

1. Click the Insert Wire Numbers tool.
2. In the Wire Tagging dialog box, select Insert as Fixed if it is not already selected.
3. Click Project-wide, Drawing-wide, or Pick Individual Wires depending on which method you want to use to update your wire numbers.

Manually inserting wire numbers:

1. Click the Edit Wire Number tool.
2. Click a wire that does not currently have a wire number assigned to it.
3. In the Insert wire number dialog box, select Make it Fixed to force the wire number to a fixed state.
4. Click OK.

Inserting wire numbers using project-wide utilities:

1. Click the arrow on the Projects New/Existing tool to access the Project-Wide Utilities tool.
2. Click the Project-Wide Utilities tool.
3. In the Project-Wide Utilities dialog box, select Set all wire numbers to fixed.
4. Click OK. All wire numbers in the project are now flagged as fixed.

**Autodesk Inventor Professional export**

Extracts wire list information into an XML export file to be used exclusively with Autodesk Inventor Professional Cable and Harness.
NOTE You must first configure wire numbering to be "On per Wire Basis" for export and set up the appropriate variables before running the report.

Access:

Click the arrow on the Schematic Reports tool to access the Autodesk Inventor Professional Export tool.

From the Projects menu, select Reports ➤ Autodesk Inventor Professional Export.

Select to export the active drawing or the entire project.

The Autodesk Inventor Professional XML File Export dialog box then displays allowing you to define a location and filename for the export file. By default the file is saved with an .xml extension to the C:\Documents and Settings\username\My Documents folder. You can change the location and the last saved folder is persistent.
Panel Layout

In this chapter

- Overview of panel layouts
- Panel drawing configuration and defaults
- Relationship between schematic drawings and panel layouts
- Overview of footprint attributes/Xdata
- Footprint/Terminal Insertion
- Layout Wire Connection Annotation
- Lookup Files
- Item Numbers/Balloons
- Nameplates
- Panel Leveling/Sequencing Tools
Overview of panel layouts

Panel Layout tools create intelligent mechanical / panel layout drawings. Here are the key features:

- Layouts can be driven from information carried on the AutoCAD Electrical schematic wiring diagram drawings or they can be constructed independently of schematics.

- AutoCAD Electrical places no requirements on special naming or attribute requirements on mechanical footprint symbols. This means that vendor supplied footprint symbols, in AutoCAD format, can be used as is with AutoCAD Electrical.

- Bi-directional update capabilities allow certain schematic wiring diagram edits to automatically update the panel drawings and vice versa.

- Wire number, wire color/gauge information, and connection sequencing data can be extracted directly from the schematics and annotated on to the panel footprint representations.

- AutoCAD Electrical extracts various reports from these smart panel layout drawings including panel BOM, panel component/item lists, nameplate reports, and schematic versus panel exception reports.

Automatic schematic/panel update

AutoCAD Electrical allows limited bi-directional updating between schematic components and the associated footprint blocks. The link is through the common tag identifier - for example, relay coil CR104 schematic symbol links to the panel layout footprint that carries a CR104 attribute value or extended entity data value. Forcing the coil's name to CR104A triggers AutoCAD Electrical to update not only the coil's child contacts but also update the panel footprint's data. If a nameplate is tied to the footprint, its text updates as well.

Access panel layout tools

You access the AutoCAD Electrical panel layout command set from either the main Panel Layout option on the Electrical pull-down menu or from a panel-specific toolbar.
**Using the pull-down menu**

Select the various panel layout commands from AutoCAD Electrical's Panel Layout menu.

**Using the toolbar**

If the Panel Layout toolbar is not visible, you can turn it on by right-clicking on a toolbar and selecting ACE:Panel Layout. Main-level options on the Panel Layout toolbar include:

- Insert Component Footprint
- Terminal Strip Editor
- Copy Footprint
- Edit Footprint
- Insert Balloon
- Wire Annotation of Panel Footprint
Using the mouse

Put your cursor over any panel component and click your right mouse button for a quick shortcut to AutoCAD Electrical commands. A component-specific menu displays at your cursor position.

Double-click on the component itself to edit that component. The AutoCAD Electrical double-click feature is disabled if AutoCAD's "selection" mode is set to "Noun/Verb selection" (i.e. system variable PICKFIRST is set to 1).

Panel drawing configuration and defaults

Configuration settings are saved as attribute values on a non-visible block named WD_PNLM. If your current drawing does not have this block present when any AutoCAD Electrical panel layout command is invoked, AutoCAD Electrical pauses and asks you for permission to insert this block. It inserts at 0,0 but this location is not critical. The key point is that the non-visible block needs to be present somewhere on the drawing.
NOTE You can make this block visible by typing ATTMODE at the AutoCAD command line prompt, changing the value from 1 to 2, and then typing REGEN.

Access:

Click the Panel Configuration tool.
From the Panel Layout menu, select Panel Configuration.

There are a few settings related to panel layout drawings that can be modified through the Panel Configuration dialog box. These settings are retrieved and saved back to attributes on the non-visible block named WD_PNLM.

**Item Numbering**

Specifies the number/letter to use as the first item number. AutoCAD Electrical will manage item number, drawing-wide or project-wide (over many drawings), so that the same number is always applied to identical components.

**Balloon**

Opens a sub-dialog box for setting the type of balloon marker (circle, ellipse, polygon, text), marker size, margin, and text gap.

**Footprint layers**

Opens the Panel Component Layers sub-dialog box for setting the panel component layers, non-text graphic layers, and nameplate layers. Panel footprint layering works in the same way AutoCAD Electrical schematic layering. When AutoCAD Electrical inserts a footprint, it is modified on the fly to match the layering scheme set up in this dialog.

**Wiring level defaults**

Sets the optional 3-digit wiring level codes. These are applied as defaults when codes are not defined on panel layout components or terminal strip representations. Preferred wire connection sequence follows this level and numeric-code-within-level hierarchy.

**Default spacing for multiple inserts**

Specifies the x and y distance spacing for multiple footprint inserts.
Footprint insert

Specifies the default insert scale for panel footprint symbols. Also, defines how to determine the scale of the attribute template added on the fly when the footprint is inserted. Select a scale factor, 1.0 to insert as is, or select to scale to a specific text height.

Panel wire connection report XYZ offset reference

Specifies the x, y, or z-offset value for the mtext added next to a panel component when adding the wire connection information. Use the Setup button to define the default wire connection text format.

Relationship between schematic drawings and panel layouts

Generally the schematic ladder diagram is created first and then the physical panel layout is created from the schematic drawing.

Using pilot lights as an example, each symbol shown on the schematic ladder diagrams needs to map to a scaled, physical pilot light representation on the panel layout drawings. The physical layout drawing might be a control panel enclosure door layout. The door layout shows where each push button component is to be mounted and can indicate the size of the hole in the sheet metal door for mounting.

Pilot light components come in many styles, sizes and ratings from dozens of vendors. On the schematic ladder diagrams, all pilot lights of a given type are identified by the same schematic symbol whether they are miniature pilot lights or a very large, explosion projected pilot light. It is on the physical panel layouts where the pilot lights are shown as they actually look and in actual size (i.e. the physical footprint representation).

For example, look at the three pilot light symbols shown in this schematic drawing.
The top and bottom ones are assigned an Allen-Bradley part number for a 30mm pilot light (catalog part number 800H-PR16R) and the middle one is given a part number for a smaller, 22.5mm pilot light (catalog part number 800MR-P16RS). The manufacturer and catalog part number assignments are carried on invisible attributes MFG and CAT on each instance of the repeated red pilot light symbol. All three symbols look the same on the schematic since they are the same AutoCAD block symbol. The difference is the assigned part number attribute values that each carries: LT411 and LT413 have the 30mm pilot light catalog part number and LT412 has the smaller pilot light part number.

The three red pilot lights are represented as footprints in the panel layout as shown.

On the physical panel layout drawing, these pilot light symbols are inserted as footprint blocks using the Insert Footprint (Schematic List) tool. Notice that LT412 (the 22.5mm pilot light) appears smaller than the others.

AutoCAD Electrical knows which physical representation block symbol to use for each instance of the pilot light schematic symbol based on the manufacturer and part number assignments applied to the MFG/CAT attributes. The vendor name and part number are mapped to the correct footprint drawing (.dwg) file. This drawing is then inserted as a block on the panel layout drawing.
There are two key elements that make this work:

- Vendor footprint library (.dwg) files - two symbols from this library are shown here. These are for Allen-Bradley red pilot lights 30mm and 22.5mm styles respectively.

- Footprint mapping file (footprint_lookup.mdb) - a table is assigned to each manufacturer.

**Overview of footprint attributes/Xdata**

AutoCAD Electrical doesn't have attribute or naming requirements for the mechanical footprint block symbols. As AutoCAD Electrical inserts a footprint symbol into the drawing, it copies various data to the footprint block such as component/device tag name, description, manufacturer code, and catalog number. It first looks for target attributes to copy the data to, but if not found, AutoCAD Electrical simply inserts the schematic values as standard AutoCAD, non-visible extended entity data (Xdata).

Some manufacturers provide free, to-scale mechanical libraries of their control components, all in AutoCAD format. Or you may have your own in-house footprints set up. In either case, since AutoCAD Electrical doesn't have naming or attribute requirements, these libraries can be used as is. When AutoCAD Electrical inserts such a block footprint symbol, it immediately becomes AutoCAD Electrical smart.

**Footprint block attribute/Xdata names**

Below is a list of footprint block data names that can be inserted or read by AutoCAD Electrical. If the footprint block has an attribute with any name listed here, AutoCAD Electrical will use that attribute to carry the specific piece of data. Otherwise, AutoCAD Electrical uses extended entity data with names based on the data names listed here but with a WD_prefix (ex: "WD_DESC1").
FPT identifies block as a terminal footprint
NP identifies block as a nameplate
P_TAG1 pnl component tag (used on component footprints and nameplates)
DESC1-3 description line 1 - 3 (60 char max)
P_ITEM item/detail number
MFG manufacturer name (24 char max)
CAT catalog number (60 char max)
ASSYCODE optional assembly code (internal use by AutoCAD Electrical)
INST installation code (24 char max)
LOC location code (16 char max)
MOUNT mount location code (24 char max)
GROUPWITH group location code (24 char max)
WDBLKNAM schematic symbol block name (used for catalog lookup)
RATING1-12 rating values (60 char max each)
P_TAGSTRIP terminal strip ID (terminal footprints only)
TERM terminal number (terminal footprints only)
WIRENO wire number (terminal footprints only)
**Minimum attribute/Xdata requirements**

Below are the minimum requirements for AutoCAD Electrical to recognize a block as a panel footprint or nameplate.

**Component footprint** - block must carry a minimum of one of the following:

- **Xdata name**: VIA_WD_FP
- **Attribute**: FP (blank value)
- **Attribute**: P_TAG1 (and no attribute NP present)

**Terminal footprint** - block must carry a minimum of one of the following:

- **Xdata name**: VIA_WD_FPT
- **Attribute**: FPT (blank value)

**Panel nameplate** - block must carry a minimum of one of the following:

- **Xdata name**: VIA_WD_NP
- **Attribute**: NP (blank value)

**Select Xdata to change to a block attribute**

This tool converts any piece of non-visible extended entity data (Xdata) into a visible attribute tied directly to the footprint block.

**Access:**

1. Click the arrow on the Edit Footprint tool to access the Make Xdata Visible tool.
2. Select a footprint.
3. From the Panel Layout menu, select Make Xdata Visible. Select a footprint.

After you click Insert, the dialog box disappears. Click on the location for the attribute. The attribute inserts, is linked to the footprint block, and the dialog
box redisplay. Repeat the process to quickly convert other pieces of Xdata into visible attributes.

**Xdata**
Displays all AutoCAD Electrical-related pieces of extended entity data (Xdata).

**Height**
Specifies the height for the attribute value.

**Justification**
Specifies the justification for the attribute value.

**Visibility**
Indicates whether the attribute will be visible on the screen.

**Ratings**
Opens a sub-dialog for setting the values for rating attributes.

**Style**
Sets the width factor and text style for the attributes.

**NOTE** To add or modify the Xdata, use the AutoCAD Electrical Xdata Editor.

---

**Select and insert footprints**

Use AutoCAD Electrical to insert smart footprint outlines of electrical components and devices onto layout drawings. The most common ways to insert these are: semi-automatic mode or manually. In the semi-automatic mode, AutoCAD Electrical uses the component’s manufacturer and catalog number information, goes to a manufacturer look-up database table, finds a match for the catalog number, and selects the associated footprint block symbol to insert. You pick the insertion point and orientation for the footprint. In a manual insert mode, you create smart footprint outlines on the fly or convert existing layout representations to be compatible with AutoCAD Electrical.

**Semi-automatic insertion from schematic data**

Panel Layout ➤ Insert Footprint (Schematic List)
Panel Layout ➤ Insert Terminal (Schematic List)
Let your project set of schematic wiring diagrams help drive the panel layout. Component catalog number information comes directly from manufacturer and catalog data carried on each electrical component. AutoCAD Electrical finds a match for the manufacturer and catalog number combination to determine the correct footprint block to insert.

If a copy of the schematic data is not in memory, then AutoCAD Electrical prompts you to select which schematic data you want to extract. Make your selection in the dialog box and click OK. A list of all parent components is extracted from the project's schematic wiring diagrams. Select from the schematic list and place the equivalent footprint on the layout. AutoCAD Electrical determines the equivalent footprint block from the footprint look-up file.

**Insert footprints from an icon menu**

Panel Layout ➤ Insert Footprint (Manufacturer Menu) or Panel Layout ➤ Insert Footprint (Icon Menu)

For items that might not be included on the schematics, you have 2 options for insertion:

- Pick the item from a vendor icon menu that is preset with specific catalog number data and footprint block names. Choosing from this menu supplies AutoCAD Electrical with the manufacturer and catalog information and the footprint block name, bypassing any look-up.

- Pick a general component category from a generic icon menu (such as pilot lights).

**Insert footprints manually**

Panel Layout ➤ Insert Footprint (Manual)

Select to use a generic marker only, draw shapes, select a similar footprint, choose from a file dialog, or pick on an existing block on the current drawing to convert it to AutoCAD Electrical on the fly.

**Insert footprints from a catalog list**

Panel Layout ➤ Insert Footprint (Lists) ➤ Insert Footprint (Catalog List)

Inserts panel symbols by choosing a catalog number or a component description from a user-defined pick list. The data displayed in this pick list is stored in a database in generic Access format. The file name is
wd_picklist.mdb and can be edited with Access or from Add/Edit/Delete along the bottom of the pick list's dialog box.

**Insert footprints from equipment lists**

Panel Layout ➤ Insert Footprint (Lists) ➤ Insert Footprint (Equipment List)

This tool lists data extracted from your equipment list, finds the appropriate panel symbol by querying the footprint_lookup.mdb, and inserts the panel footprints at your pick point. Each line or record in the equipment list represents a single entry into the Equipment in dialog box for schematic component selection. The quantity for a selected catalog number is not supported.

**Insert panel footprints from a schematic list**

When you insert a panel footprint from a list of the schematic components, if the MFG and CAT values match, it displays the WD_AB icon menu. When the icon menu displays, make your specific footprint block selection. Your menu pick provides AutoCAD Electrical with the footprint block name to use for the target MFG/CAT combination. You can set up multiple orientations/configurations of a single footprint, all tied to the same MFG/CAT part number match in the footprint lookup table. Pick the orientation/configuration of the footprint you want to use, and insert it into the layout drawing.

1. Create a schematic symbol with a TAG1 attribute.
2. Place the symbol in a drawing. In the Insert/Edit Component dialog box, give the TAG attribute a value, and click OK.
3. Save the drawing and navigate to the drawing you want to add a panel footprint to.
4 Click the arrow on the Insert Component Footprint tool to access the Insert Footprint (Schematic List) tool.

5 Click the Insert Footprint (Schematic List) tool.

6 In the Schematic Components List ➤ Panel Layout Insert dialog box, select Project and click OK.

7 In the Select Drawings to Process dialog box, select the drawing that has the schematic symbol you inserted. Click Process, and then click OK.
   This extracts a list of all schematic devices found in the drawing and displays them in a dialog box for selection.

8 In the Schematic Components dialog box, select the schematic component you inserted in step 2 and click Manual.
   Another option is to select the schematic component from the list and click Insert. AutoCAD Electrical looks at the entry's manufacturer and catalog part number. It then takes the manufacturer attribute value (MFG) and finds a table in the footprint_lookup.mdb file with this name. If found, AutoCAD Electrical queries this specific vendor table using the selected entry's catalog (CAT) part number attribute value. If a record match is found, AutoCAD Electrical returns the block name from the matched record. It starts the Insert Footprint command and prompts for the insertion point for the footprint block. As the block inserts, attributes are added in to make the footprint AutoCAD Electrical "smart" and the schematic symbol's values are copied to the footprint representation.

9 In the Footprint dialog box, Choice B section, click Browse.

10 In the Pick dialog box, browse to and select the block you want to insert for the footprint. Click Open.

11 Place the symbol in the drawing. In the Panel Layout - Component Insert/Edit dialog box, notice that this symbol has the same TAG value as the schematic symbol. Click OK.
   As each footprint is inserted, it gets checked off the list in the Schematic Components dialog box (an "x" appears in the left-hand column). This helps track what has already been inserted onto the drawing.
In the Schematic Components dialog box, click Close.

**Syntax for encoding an icon menu page display for footprint selection**

```
(wdmenu "n:/myfolder/my_lookup_menu.dat" 5)
```

where

"n:/myfolder/my_lookup_menu.dat" = your AutoCAD Electrical icon menu file

5 = the "**Mx**" page number in that menu (x = 5)

This is entered into the third edit box, the one labeled "Footprint block name," where the AutoCAD block name normally goes. It signals AutoCAD Electrical to open the icon menu file and jump to the menu page number ("5" in this example). Then AutoCAD Electrical waits for you to pick from the icon menu selection. The specific footprint block path/name to use is encoded into the icon menu file page "5" (excerpt from example "my_lookup_menu.dat" AutoCAD Electrical icon menu file shown below).

**M5**

300 AMP FRAME MCP

2-D plan view\mcp_300_2dpv.sld"MCP300-2Dp.dwg"

3-D plan insertion\mcp_300_3dpv.sld"MCP300-3Dp.dwg"

2-D side view\mcp_300_2dsv.sld$C=wd_infpx "MCP300-2Ds.dwg"

3-D side insertion\mcp_300_3dsv.sld$C=wd_infpx "MCP300-3Ds.dwg"

When you select an icon from the icon menu, it returns the footprint block ".dwg" file to use. This technique of footprint selection is useful for situations where there may be multiple possible orientations of a given footprint part number.
Insert panel footprints using vendor menus

1 Click the Insert Footprint (Manufacturer Menu) tool.

**NOTE** This dialog box is also available by clicking Vendor Menu Select on the Vendor Panel Footprint dialog box after a vendor is first selected.

In the Vendor Menu Selection dialog box, select the vendor menu to use and click OK. You can select one from the list or click Browse to search for a vendor (.pnl) menu file.

2 In the Vendor Panel Footprint dialog box, select the component to insert from the Symbol Preview window and click OK. Clicking an icon inserts the footprint into the active drawing as defined by the command in the .pnl file.

3 Select the insertion point on the screen.

**Insert footprint**

This icon menu can be modified, expanded, or replaced with your own custom menu. You can change the default icon menu using the Library and Icon Menu Paths section of the Project Properties ➤ Project Settings dialog box. (Select Projects ➤ Project ➤ Project Manager. Right-click the project name and select Properties.) Use the Icon Menu Wizard to easily modify the menu. The default icon menu can also be redefined in "wd.env". Add entry "WD_MENU" for schematic icon menu and "WD_PMENU" for panel layout icon menu.

**Access:**

Click the arrow on the Insert Footprint tool to access the Insert Footprint (Icon Menu) tool.

Click Panel Layout ➤ Insert Footprint (Icon Menu).
Select an icon picture or the component type from the Menu tree structure. The main menu in the tree structure is displayed as the menu heading just above the menu tree structure.

**Tabs**
- **Menu**: Changes the visibility of the Menu tree view.
- **Up one level**: Displays the menu that is one level before the current menu in the Menu tree view. This is unavailable if the main menu is selected in the Menu tree view.
- **Views**: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.

**Menu**
The tree structure is created by reading the icon menu file (*.dat). The tree structure is based on the arrangement order of submenus defined in the .dat file.

**NOTE**
If the program cannot find any of the icon menu files listed in the *.wdp, an alert dialog displays.

**Symbol Preview window**
Displays the symbol images corresponding to the menu or the sub-menu selected in the Menu section. Clicking on the icon performs one of the following functions based on the icon properties as defined by the *.dat file:
- **Executes a command**
- **Displays a submenu**

**NOTE**
When you move the cursor over an icon, the icon name and block/circuit/command name display as tooltip information.

**Recently Used**
Displays the last components inserted during the current editing session; the most recently used icon displays in the top. This list box follows the view options setting in the symbol preview window (icon, icon with text or list view) and the total number of icons displayed depends on the value specified in the Display edit box.

**Display**
Specifies the number of icons to display in the Recently Used list box. Enter integer numbers only; the default value is 10.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No edit dialog</td>
<td>Turns off the Insert/Edit Component dialog box when inserting symbols onto the drawing. To add component detail later, click the Edit Component tool, and select the component to edit.</td>
</tr>
<tr>
<td>No tag</td>
<td>Inserts the component, un-tagged (i.e. without assigning a unique Component Tag). The untagged value that displays is the component's TAG1/TAG2 default value. To add component detail later, click the Edit Component tool, and select the component to edit.</td>
</tr>
<tr>
<td>Always display previously used menu</td>
<td>Indicates to display the previously used menu each time you open the Insert Component dialog box. For example, if you insert a push button from the Push Buttons menu, the next time you open the Insert Component dialog box the Push Button menu displays by default.</td>
</tr>
<tr>
<td>Scale schematic</td>
<td>Specifies the component block insertion scale. This defaults to the value set in the Panel Drawing Configuration dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.</td>
</tr>
<tr>
<td>Scale panel</td>
<td>Specifies the footprint insertion scale. This defaults to the value set in the Panel Drawing Configuration dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.</td>
</tr>
<tr>
<td>Type it</td>
<td>Manually type in the component block to insert.</td>
</tr>
<tr>
<td>Browse</td>
<td>Browses to and selects the component to insert.</td>
</tr>
</tbody>
</table>

**Right-click menus**

**Options for the Menu tree structure view**

Right-click the main menu or submenu in the Menu tree structure view to display the following options:

- Expand/Collapse: Toggles the visibility of the menus.
Properties: Opens a Properties dialog box to view the existing menu or submenu properties like the menu name, image or submenu title. Use the Icon Menu Wizard to change any menu properties.

Options for the Symbol Preview window
Right-click an icon or in empty space in the Symbol Preview window to display the following options:

- View: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.
- Properties: (available for icons only) Opens a Properties dialog box to view the existing symbol icon properties like the icon name/image/block names and so on. Use the Icon Menu Wizard to change any icon properties.

Panel layout - terminal insert/edit

Access:

On the Panel Layout toolbar, click the arrow on the Terminal Strip Editor tool to access the Insert Terminal (Manual) tool. Select the method for inserting a terminal strip and place the terminal strip on the drawing.

Click Panel Layout ➤ Insert Terminal (Manual). Select the method for inserting a terminal strip and place the terminal strip on the drawing.

On the Panel Layout toolbar, click the Edit Footprint tool. Select the terminal strip to edit.

Click Panel Layout ➤ Edit Footprint. Select the terminal strip to edit.

NOTE You can also use the Insert Terminal (Schematic List) tool to insert a terminal onto the drawing.

Tag Strip

These controls determine the overall tagging of the terminal strip in the project. The Installation, Location and Tag Strip values define which strip the terminal belongs to.
NOTE Assigning short installation or location codes to components like "PNL" and "FIELD" allow you to later take full advantage of the AutoCAD Electrical ability to create installation or location-specific BOM and component lists.

| Installation | Changes the installation code(s). Click Browse to search the active drawing, entire project and an external list (default.inst) for installation codes. Pick from the list to automatically update the component with the installation code. |
| Location | Changes the location code(s). Click Browse to search the active drawing, entire project and an external list (default.loc) for location codes. Pick from the list to automatically update the component with the location code. |
| Tag Strip | Specifies the Tag ID given to the terminal strip. If there is an existing name, it appears in the edit box. If not, you can enter a specific ID name or click the < and > buttons to increment or decrement the last digit/character in the Tag Strip value. |
| Number | Specifies the terminal number. If there isn’t PINLIST information, the < and > buttons increment or decrement the terminal number. You can also click Pick to select a text object or an attribute on the active drawing to use for the terminal number. If the panel footprint is already associated to a schematic symbol, this edit box is already populated with its value. |

**Modify Properties/Associations**

These controls support associations between schematic terminal symbols and their panel terminal footprint and between multiple schematic terminal symbols.
**NOTE** You cannot associate terminals using the Add/Modify or Break Out Panel options when you insert a terminal using the Insert Terminal (Schematic List) tool. However, once the terminal is inserted onto the drawing, you can modify the associations using these tools.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Add/Modify**     | Displays the Add/Modify Associations dialog box where you can select terminal strips and their respective blocks to make an association to the terminal symbol being inserted or edited.  

**NOTE** This is disabled if the active drawing is not part of the active project. |
| **Break Out Panel**| Removes the selected terminal symbol out of the defined association. The properties from the original association and the terminal’s levels are maintained. |
| **Block Properties**| Displays the Block Properties dialog box where you can define and maintain terminal block properties.  

**NOTE** This is disabled if the active drawing is not part of the active project. |

**Properties/Associations**

The list box displays the current status of the edited terminals association. It lists all associated terminal symbols from the schematic and terminal panel footprints. If the terminal symbol is being inserted for the first time, the list box only displays the reference for itself. The number of levels defined in the block properties displays at the top of the Properties/Associations group. The terminal number being edited is highlighted in the list box.

You can double-click in the list to modify the terminal association in the Add/Modify Associations dialog box.

**NOTE** Pin numbering is related to the terminal level and not the terminal tag number instance.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Label</strong></td>
<td>Lists the level description defined in the terminal block properties.</td>
</tr>
<tr>
<td><strong>Number</strong></td>
<td>Lists the terminal numbers defined in the association. Only one terminal number is allowed per level and each level displays its respective terminal number or text. Panel terminal symbols do not display terminal numbers.</td>
</tr>
<tr>
<td><strong>PinL</strong></td>
<td>Lists the pin numbers defined left side of the terminal block. This data is entered into the L0nPINL attribute if present; otherwise, it is placed in the xdata.</td>
</tr>
<tr>
<td><strong>PinR</strong></td>
<td>Lists the pin numbers defined on the right side of the terminal block. This data is entered into the L0nPINR attribute if present; otherwise, it is placed in the xdata.</td>
</tr>
<tr>
<td><strong>Reference</strong></td>
<td>Lists the terminal symbol’s reference location in the project. The syntax is ‘Sheet,Reference’ based on the drawing configuration.</td>
</tr>
</tbody>
</table>

**Catalog Data**

You can do a drawing-wide or project-wide listing of similar terminals with their catalog assignments. During your editing session, the last MFG / CAT / ASSYCODE assignment for each terminal you insert into your wiring diagram is remembered. When you insert another terminal of that type, the previous terminal’s catalog assignment is set as the default (assuming a previous one was made during the current editing session).

| **Manufacturer** | Lists the manufacturer name for the terminal. Enter a value or select one from the Catalog lookup. |
| **Catalog** | Lists the catalog number for the terminal. Enter a value or select one from the Catalog lookup. |
| **Assembly** | Lists the assembly code for the terminal. The Assembly code is used to link multiple part numbers together. |
| **Item** | Specifies a unique identifier assigned to each terminal. The tag value can be manually typed in the edit box. |
| **Catalog Lookup** | Opens the terminal’s catalog database from which you can select the Manufacturer and Catalog values. Search the database for a specific catalog item to assign to the selected terminal. Database queries are set up in the 3 lists across the top of the dialog with the database hits listed in the dialog box’s main window. |
| **Drawing** | Lists the part numbers used for similar terminals in the current drawing. |
| **Project** | Lists the part numbers used for similar terminals in the project. You can search in the active project, another project, or in an external file. |
| ■ **Active project:** All the drawings in the active project are scanned and the results are listed in a dialog box. Select from the list to assign your new terminal with a catalog number that is consistent with other similar terminals in the project. |
| ■ **Other project:** Scans each listed drawing in a previous project for the target terminal type and returns the catalog information in a sub-dialog box. Make your catalog assignment by picking from the dialog list. |
| ■ **External file:** You can pull catalog assignments from a generic ASCII file created by a word processor or output from a spreadsheet or database program. A dialog box displays the contents of the selected text file. Find and highlight the desired entry. AutoCAD Electrical reads the line of text from the file and breaks it into its component parts. These are displayed in the left-hand dialog list. For each relevant item, highlight it and then pick the appropriate category button in the center column. The highlighted item is transferred to the corresponding category (and then to the Insert/Edit dialog box once OK is clicked). |
| **Multiple Catalog** | Inserts or edits extra catalog part numbers on to the selected terminal. You can add up to 10 part numbers. These multiple BOM part numbers appear as subassembly part numbers to the main catalog part number in the various BOM and terminal reports. |
| **Catalog Check** | Extracts the details from the catalog database to display what the selected item will look like in a Bill of Material template. |
Descriptions

Specifies the optional description attribute text to assign to the terminal block (up to 3 lines of text can be specified). Click Browse to search for all terminal descriptions in the project or active drawing. Select the description you want to copy to the edited terminal block by selecting it in the list and clicking OK.

Ratings

Specifies values for each ratings attribute. You can enter up to 12 ratings attributes on a terminal. Select Show All Ratings to display a list of default values.

NOTE If this button is unavailable, the terminal you are editing does not carry any rating attributes.

Mount or Group

Changes the mount and group codes. You can search the current drawing or entire project for the codes. A quick read of all the current or selected drawing files is done and a list of codes used so far is returned. Select from the list to automatically update the component with the codes.

Show/Edit Miscellaneous

View or edit any attributes that are not predefined AutoCAD Electrical attributes.

External List

Assigns information from an external list to specified data in the Panel Layout - Terminal Insert/Edit dialog box. Any existing information from the dialog box appear in the edit box. To define the information from the selected file, highlight the desired information in the Choices list and select the appropriate button next to the desired edit box.

Schematic components list panel layout insert

This report provides error checking between the schematics and the panel layout drawings. The program looks at the selected components, both schematic and panel, to find a match in the project. For each schematic component selected, the routine tries to find a matching panel component based on tag, location, and installation information. If a match is found, then it further compares catalog information looking for any discrepancies. The
program looks at each selected panel component looking for a matching schematic component in the same way.

**Access:**

Click the arrow on the Insert Component Footprint tool to access the Insert Footprint (Schematic List) tool.

From the Panel Layout menu, select Insert Footprint (Schematic List).

If you start with panel layouts before you create schematics, schematic pick list data is not available to automate footprint selection and annotation. If you list your panel components in a spreadsheet and in a format that AutoCAD Electrical expects, this spreadsheet data can become your schematic pick list data for panel layout.

**Extract component list for**

Specifies to export the data for the active drawing or the entire project.

**Save list to external file**

Uses a previous project's schematics to create a component or terminal spreadsheet listing. This can help drive the new project's panel layout. AutoCAD Electrical creates a comma-delimited file of the schematic data. You can display this data in spreadsheet format (open it in comma-delimited "CSV" format), edit, and then save back out.

**Location Codes to extract**

Extracts only the information for components with specific location values. Once you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**Footprint**

Some schematic components may not carry manufacturer/catalog information or have a part number assigned that is not listed in the footprint lookup file. In such a case, AutoCAD Electrical cannot determine what footprint block
needs to be used so you have to select to make catalog assignments, select or create a footprint, or create a lookup entry on the fly.

**Access:**

- Click the arrow on the Insert Component Footprint tool to access the Insert Footprint (Icon Menu) tool. Select the footprint to insert.
- Click the arrow on the Insert Component Footprint tool to access the Insert Footprint (Manual) tool.
- From the Panel Layout menu, select Insert Footprint (Icon Menu). Select the footprint to insert.
- From the Panel Layout menu, select Insert Footprint (Manual).

**NOTE** Review Choice B below for the Insert Footprint (Manual) tool.

**Choice A**

Enter catalog information, or if there isn’t a catalog assignment use the catalog lookup to find and select catalog information. An attempt will be made to find a match in the manufacturer’s footprint lookup or the _PNLMISC miscellaneous lookup file.

**Choice B**

Skips the catalog assignment. Select to draw a simple footprint representation of the selected device, browse for a footprint block file, pick on an existing block on the current drawing to convert it to AutoCAD Electrical-smart on the fly, or invoke an external program to find and insert a footprint representation of a given catalog number.

- **Use generic marker only**
  - Inserts a block with just the component’s tag, description text, and so on.

- **Draw shapes**
  - Draws a rectangle, circle, or octagon to represent the component. Text and hidden information inserted when drawn.

- **Pick “just like” footprint**
  - Select a block from the drawing.

- **Browse**
  - Pick a block from a list of .DWG files on disk.
Pick a non-AutoCAD Electrical block on the drawing to be instantly changed into a smart AutoCAD Electrical block.

ABECAD
Pick your own ABECAD install to link to.

Choice C
A footprint lookup database table matches MFG/CAT part number combinations with their appropriate footprint blocks. In cases where a MFG/CAT number is given but isn't in a lookup file, AutoCAD Electrical enables this option.

There are two categories of panel footprint lookup files: manufacturer and miscellaneous.

Add Entry to Manufacturer
Adds a new entry to the manufacturer-specific footprint lookup table and matches it with an existing footprint block or drawing file. It will have the same name as the component's manufacturer name.

Add Entry to Miscellaneous
Adds a new entry to a miscellaneous (catch all) footprint lookup table called "_PNLMISC". This will add the MFG/CAT combination to the footprint lookup table and match it with an existing footprint block or library symbol. If the lookup table does not exist it will be created.

Panel layout - component insert or edit
You can go back to any component at any time and make changes. In some cases, a footprint update may be required due to manufacturer, catalog or assembly value changes. When asked whether to manually force a footprint change, click No to leave the existing footprint block as is or click Yes to set...
up a footprint lookup database file or manually draw a simple footprint representation.

**Access:**

Click the arrow on the Insert Footprint tool to access the Insert Footprint (Icon Menu) tool. Select the footprint to insert and specify the insertion point on the drawing.

Click the Edit Footprint tool. Select the footprint or nameplate to edit.

Click Panel Layout ➤ Insert Footprint (Icon Menu). Select the footprint to insert and specify the insertion point on the drawing.

Click Panel Layout ➤ Edit Footprint. Select the footprint to edit.

---

**NOTE** The dialog box options differ depending on whether you are inserting or editing a footprint or nameplate.

**Item Number**

This is automatically assigned when the catalog part number values match an existing component that is already assigned an Item number. If no existing match is found, you can manually enter an item number. These item numbers, which can be linked to “smart” balloons, display in panel BOM and component lists.

- **Find**
  Scans each listed drawing for the target component type and returns a list of what was found. You can make your catalog assignment by picking from the list.

- **List**
  Displays a list of numbers found in the current drawing or project so you can select similar descriptions to edit.

- **Next**
  Finds the next available item number.

**Catalog Data**

Does a drawing or project-wide listing of similar components with their catalog assignments. During your editing session, the last MFG / CAT / ASSYCODE assignment for each component type you insert into your wiring diagram is remembered. When you insert another component of that type, the previous
component's catalog assignment is set as the default (assuming a previous one was made during the current editing session).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufacturer</td>
<td>Lists the manufacturer number for the footprint. Enter a value or select one from the Catalog lookup.</td>
</tr>
<tr>
<td>Catalog</td>
<td>Lists the catalog number for the footprint. Enter a value or select one from the Catalog lookup.</td>
</tr>
<tr>
<td>Assembly</td>
<td>Lists the assembly code for the footprint. The Assembly code is used to link multiple part numbers together.</td>
</tr>
<tr>
<td>Count</td>
<td>Specifies the quantity number for the part number (blank=1). This value gets inserted into a BOM report's &quot;SUBQTY&quot; column.</td>
</tr>
<tr>
<td>Unit</td>
<td>Specifies the unit of measure, which can be displayed in the component list report.</td>
</tr>
<tr>
<td>Catalog Lookup</td>
<td>Opens the component's catalog database from which you can manually enter or pick the Manufacturer or Catalog values. Search the database for a specific catalog item to assign to the currently selected component. Database queries are set up in the lists across the top of the dialog with the database hits listed in the dialog's main window.</td>
</tr>
<tr>
<td>Drawing</td>
<td>Lists the part numbers used for similar components in the current drawing.</td>
</tr>
<tr>
<td>Project</td>
<td>Lists the part numbers used for similar components in the project.</td>
</tr>
<tr>
<td>Multiple Catalog</td>
<td>Inserts or edits extra catalog part numbers on to the currently selected component. You can add up to 99 part numbers. These multiple BOM part numbers appear as subassembly part numbers to the main catalog part number in the various BOM and component reports.</td>
</tr>
<tr>
<td>Catalog Check</td>
<td>Show how the selected item displays like in a Bill of Material template.</td>
</tr>
</tbody>
</table>
**Rating**

Specifies values for each ratings attribute. You can enter up to 12 ratings attributes on a terminal. Select Show All Ratings to display a list of default values.

**NOTE** If this button is unavailable, the component you are editing does not carry any rating attributes.

**Component Tag**

Any existing tags appear in the edit box. To define the component tag, edit the existing tag or type a specific tag in the edit box. Select Fixed if you don’t want this tag to be updated on a retag.

- **Schematic List**: Applies an ID tag number to link the panel component back to its equivalent device on the schematics.
- **External list file**: Assigns a tag from an external list file.

**Description**

Up to 3 lines of description attribute text can be entered.

- **Drawing**: Displays a list of descriptions found in the current drawing so you can select similar descriptions to edit.
- **Project**: Displays a list of descriptions found in the project so you can pick similar descriptions to edit.
- **Defaults**: Opens an ASCII text file from which you can select standard descriptions.

**Installation/Location Codes**

Changes the installation, location, mount, and group codes. You can search the current drawing or entire project for the codes. A quick read of all the current or selected drawing files is done and a list of installation codes used so far is returned. Select from the list to automatically update the component with the codes.
Assign short installation codes to components like "PNL" and "FIELD" so you can take full advantage of the AutoCAD Electrical ability to create location-specific BOM and component lists later.

**Switch Positions**

Labels the positions of a selector switch.

**Show/Edit Miscellaneous**

View or edit any attributes that are not predefined AutoCAD Electrical attributes.

**Multiple bill of material information**

This tool allows you to insert or edit extra catalog part numbers on to the currently selected component or footprint. You can add up to 99 additional part numbers to any schematic or panel component on-the-fly. These multiple BOM part numbers appear as sub-assembly part numbers to the main catalog part number in the various BOM and component reports.

**Access:**

On the Insert/Edit Component or Panel Layout - Component Insert/Edit dialog box, Catalog Data section, click Multiple Catalog.

---

**NOTE** You can also access this dialog by clicking Multiple Catalog on the Copy Catalog Assignment dialog box (Components ➤ Component Miscellaneous ➤ Copy Catalog Assignment).

The additional catalog part numbers are saved on the symbol as MFGn/CATn/ASSYCODEn attribute values where "n" is the sequential code value "01" through "10" selected in the top list box. If these attributes are not present on the symbols, AutoCAD Electrical saves the information as Extended Entity Data (Xdata) on the symbol's block insert.

**Sequential code**

Adds up to 99 extra part numbers (in addition to the main catalog part number). Pick which one you want to add or inspect/edit. Click the list button to show all extra part numbers carried on the component.
Catalog Data

Specifies the catalog part number information such as the manufacturer and catalog number.

Count

Specifies the quantity number for the extra part number (blank=1). This value gets inserted into a BOM report's "SUBQTY" column.

Unit

Specifies the unit of measure, which can be displayed in the component list report.

Parts Catalog Lookup

Lists the catalog database table that is to be referenced for the description information for the given Manufacturer/Catalog/Assembly combination. For each catalog entry you must provide a name for the catalog look-up table. For the main catalog entry this information is provided on the symbol itself but may not be there for these catalog entries. Select List to pick from a list of tables that are contained in your catalog database file or Misc to use the MISC_CAT table.

Catalog Lookup

Checks for and displays catalog table information in the Parts Catalog dialog box for the selected component type.

Catalog Check

Quickly performs a Bill of Material check and displays the result.

Multiple catalog part number assignments
This displays the order in which the extra part numbers will appear in the various AutoCAD Electrical reports. You can add up to 99 additional part number assignments to a component.

Access:

On the Insert/Edit Component or Panel Layout - Component Insert/Edit dialog box, Catalog Data section, click Multiple Catalog. Click List Sequential Code on the Multiple Bill of Material Information dialog box.

NOTE You can also access this dialog by clicking Multiple Catalog on the Copy Catalog Assignment dialog box (Components ➤ Component Miscellaneous ➤ Copy Catalog Assignment) and then clicking List Sequential Code.

To change the order, highlight the part number and click Move Up or Move Down to move it in the list.

Panel equipment in

This tool lists data extracted from your equipment list, finds the appropriate panel symbol by querying the footprint_lookup.mdb, and inserts the panel footprints at your pick point. Each line or record in the equipment list represents a single entry into the Equipment in dialog box for schematic component selection. The quantity for a selected catalog number is not supported.

You can select to insert a single panel footprint or multiple footprints from the equipment list.

Access:

On the Panel Layout toolbar, click the arrow on the Insert Component Footprint tool, then click the arrow on the Insert Footprint (Catalog List) to access the Insert Footprint (Equipment List) tool. Select the spreadsheet file to use and click Open. Specify to use default or previously saved settings and click OK.

From the Panel Layout menu, select Insert Footprint (Lists) ➤ Insert Footprint (Equipment List). Select the spreadsheet file to use and click Open. Specify to use default or previously saved settings and click OK.

Sort List

Sorts the list of components. You can specify four sorts to perform on the list.
**Catalog Check**

Performs a Bill of Material check and displays the result. This is enabled if the selected panel component contains catalog data.

**Footprint scale**

Specifies the block insert scale. (1.0 = full)

**Rotate**

Specifies the block rotation angle. (blank = "ask")

**External Program**

Executes an external user routine to retrieve the footprint block name and catalog data. Requires the WD_XCAT reference in the wd.env and a user AutoLISP file to manage the data send/receive with the external routine.

**Manual**

Specifies to manually pick the panel footprint. The Panel Component dialog box displays, so you can define the footprint to use.

**Insert**

Finds and inserts footprint for the highlighted component. This is based upon a match between the footprint symbol’s catalog part number and an entry in a schematic lookup file. If 0 matches are found you will be prompted to manually draw the footprint, add an entry in the lookup file, or select an existing footprint drawing file. If multiple components are selected in the list, the Spacing for Footprint Insertion dialog box displays, allowing you to define how you want the first component of each device inserted.

**Use Footprint tables**

Accesses the standard footprint lookup table that matches the device’s MFG code. This table is set up to insert a full mechanical representation of the device.

**Use Wiring diagram tables**

Accesses an alternate table in the footprint lookup table. This table matches the MFG code but attaches an "_WD" suffix. The tables with the "_WD" suffix are set up to insert a symbol that carries the wire connection attributes.
Convert Existing

Inserts selected entry's data on an existing "dumb" block insert. This instantly converts the block to a smart AutoCAD Electrical footprint.

Pick File

Allows you to pick a file for the insert. Select an existing AutoCAD Electrical extracted panel component list file or extract a fresh copy of panel component data from the current project's database.

Schematic component or panel footprint

Inserts schematic or panel symbols by choosing a catalog number or a component description from a user-defined pick list. The data displayed in this pick list is stored in a database in generic Access format. The file name is wd_picklist.mdb and can be edited with Access or from Add/Edit/Delete along the bottom of the pick list's dialog box. The AutoCAD Electrical normal search path sequence is used to locate this file.

Access:

Click the arrow on the Insert Component tool to access the Insert Component (Catalog List) tool.
From the Component menu, select Insert Component (Lists) ➤ Insert Component (Catalog List).

Click the arrow on the Insert Footprint tool to access the Insert Footprint (Catalog List) tool.
From the Panel Layout menu, select Insert Footprint (Lists) ➤ Insert Footprint (Catalog List).

Both schematic and panel layout symbols can be included in the pick list database but only schematic or panel entries are displayed at a time depending on whether the routine is called from the AutoCAD Electrical or Panel Layout toolbar.

Sort by

Specifies how to sort the record list. You can sort by description, catalog number, or manufacturer code.

Add

Opens a dialog box for creating a new record. If the footprint block is not in an AutoCAD or an AutoCAD Electrical search path, include the part of the path that needs to be appended to one of these search paths.
paths (or you can enter the full path). If the new record is similar to an existing record, highlight the existing record before you click Add.

**Edit**
Open a dialog box for editing an existing record. Highlight the record and click Edit. Modify the record in the displayed dialog box.

**Delete**
Removes an existing record.

### Schematic terminals list panel layout insert

This report provides error checking between the schematic terminals and panel layout terminals. The program looks at the selected terminals, both schematic and panel, looking for a match in the project. For each schematic terminal selected, it tries to find a matching panel terminal based on tag, location, and installation information. If a match is found, then it compares catalog information, and description information, looking for any discrepancies. The program then looks at each selected panel terminal looking for a matching schematic terminal in the same way.

**Access:**

- Click the arrow on the Insert Footprint tool to access the Insert Terminal (Schematic List) tool.
- From the Panel Layout menu, select Insert Terminal (Schematic List).

If you start with panel layouts before you create schematics, schematic pick list data is not available to automate footprint selection and annotation. If you list your panel components in a spreadsheet and in a format that AutoCAD Electrical expects, this spreadsheet data can become your schematic pick list data for panel layout.

**Extract component list for**

Specifies to export the data for the active drawing or the entire project.

**Save list to external file**

Uses a previous project’s schematics to create a component or terminal spreadsheet listing. This can help drive the new project’s panel layout. AutoCAD Electrical creates a comma-delimited file of the schematic data. You can display this data in spreadsheet format (open it in comma-delimited “CSV” format), edit, and then save back out.
**Location Codes to extract**

Extracts only the information for components with specific location values. Once you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**Settings**

This spreadsheet organizes the selected user-created equipment list and presents the list in a pick list. As you pick an item from the pick list, the appropriate schematic symbol is found and inserted in the drawing at your pick point. Your equipment list can be an AutoCAD Electrical-generated Component report, or it can be a list of motors giving horsepower and starter type along with motor ID and descriptions.

**NOTE** You can open a comma-delimited file, Excel spreadsheet, or Access database file for input.

**Access:**

- Click the arrow on the Insert Component tool to access the Insert Component (Equipment List) or click the arrow on the Insert Footprint tool to access the Insert Footprint (Equipment List) tool. Select the spreadsheet file to use and click Open. Click the table to edit and click OK.
- From the Components menu, select Insert Component (Lists) ➤ Insert Component (Equipment List) or select Panel Layout ➤ Insert Footprint (Lists) ➤ Insert Footprint (Equipment List). Select the spreadsheet file to use and click Open. Click the table to edit and click OK.

**Default settings**

Uses the default settings for managing equipment lists.

**Read settings**

Reads and uses the settings for a previously saved file.

**Spreadsheet/Table columns**

Defines the order of the data in the selected equipment list file. Assign column numbers to data categories (such as Manufacturer, Catalog, and Installation) in the Equipment List Spreadsheet Settings dialog box.

**Save settings**

Saves the column information in a text file to be reused. The filename is user-defined with the extension WDE.
Vendor menu selection
This can save a lot of time if you frequently use the same vendor and panel components. You can even apply this method to create client-specific menus making it easier to use the vendor or components that each client prefers.

Access:

On the Panel Layout toolbar, click the arrow on the Insert Component Footprint tool to access the Insert Footprint (Manufacturer Menu) tool.

Click Panel Layout ➤ Insert Footprint (Manufacturer Menu).

NOTE This dialog box is also available by clicking Vendor Menu Select on the Vendor Panel Footprint dialog box after a vendor is first selected.

The vendor icon menu files that are found in AutoCAD Electrical are listed in the dialog box.

Vendor panel footprint
This can save a lot of time if you frequently use the same vendor and panel components. You can even apply this method to create client-specific menus making it easier to use the vendor or components that each client prefers.

Access:

On the Panel Layout toolbar, click the arrow on the Insert Component Footprint tool to access the Insert Footprint (Manufacturer Menu) tool. Select the vendor menu to use and click OK.

Click Panel Layout ➤ Insert Footprint (Manufacturer Menu). Select the vendor menu to use and click OK.
Clicking an icon inserts the footprint into the active drawing as defined by the command in the .pnl file.

### Tabs
- **Menu:** Changes the visibility of the Menu tree view.
- **Up one level:** Displays the menu that is one level before the current menu in the Menu tree view. This is unavailable if the main menu is selected in the Menu tree view.
- **Views:** Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.

### Menu
The tree structure is created by reading the icon menu file (*.dat). The tree structure is based on the arrangement order of submenus defined in the .dat file.

### Symbol Preview window
Displays the symbol images corresponding to the menu or the sub-menu selected in the Menu section. Clicking on the icon inserts the footprint into the active drawing as defined by the command in the .pnl file.

### Recently Used
Displays the last components inserted during the current editing session; the most recently used icon displays in the top. This list box follows the view options setting in the symbol preview window (icon, icon with text or list view) and the total number of icons displayed depends on the value specified in the Display edit box.

### Display
Specifies the number of icons to display in the Recently Used list box. Enter integer numbers only; the default value is 10.

### No edit dialog
Turns off the Insert/Edit Component dialog box when inserting symbols onto the drawing. To add component detail later, click the Edit Component tool, and select the component to edit.

### No tag
Inserts the component, un-tagged (i.e. without assigning a unique Component Tag). The untagged value that displays is the component’s TAG1/TAG2 default value. To add component detail...
later, click the Edit Component tool, and select the component to edit.

| **Always display previously used menu** | Indicates to display the previously used menu each time you open the Insert Component dialog box. For example, if you insert a push button from the Push Buttons menu, the next time you open the Insert Component dialog box the Push Button menu displays by default. |
| **Scale** | Specifies the component block insertion scale. This defaults to the value set in the Panel Drawing Configuration dialog box. Once set, this value is remembered until reset or until the drawing editing session ends. There are separate scale factors for schematic and panel components. |
| **Vendor Menu Select** | Displays the Vendor Menu Selection dialog box. |
| **Type it** | Manually type in the component block to insert. |
| **Browse** | Browses to and selects the component to insert. |

**Right-click menus**

**Options for the Menu tree structure view**

Right-click the main menu or submenu in the Menu tree structure view to display the following options:

- **Expand/Collapse**: Toggles the visibility of the folders.
- **Properties**: Opens a Properties dialog box to modify the existing menu or submenu properties like the menu name, image or submenu title. Use the Icon Menu Wizard to change any menu properties.

**Options for the Symbol Preview window**

Right-click an icon or in empty space in the Symbol Preview window to display the following options:

- **View**: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.
Properties: (available for icons only) Opens a Properties dialog box to modify the existing symbol icon properties like the icon name/image/block names and so on. Use the Icon Menu Wizard to change any icon properties.

Insert a copy of a panel footprint

Use the Copy Footprint tool instead of AutoCAD Copy when a panel component footprint has a balloon or a nameplate associated with it. Since AutoCAD Electrical establishes invisible Xdata pointers when these are tied to a footprint, they are properly updated when copied using this utility.

1 On the Panel Layout toolbar, click the Copy Footprint tool.

2 Select the panel component to copy.

3 Click the drawing to specify the insertion point or enter a value.
   The Panel Layout - Component Insert/Edit dialog box displays.

4 Specify any necessary values such as the component tag, catalog information, or description.

5 Click OK.

Copy code values to components

Use this tool to quickly insert or copy installation, location, group or mount code values to selected components. These values extract into various reports and may be useful for sorting or grouping purposes. Copied values show up on the target footprints as an attribute value if an attribute is present or as invisible Xdata.
1 On the Panel Layout toolbar, click the arrow on the Miscellaneous tool to access the Panel Location Copy tool.

2 Click the Panel Location Copy tool.

3 Click the Copy Location Code tool.

4 In the Copy Installation\Location\Mount\Group to components dialog box, select the code names you want to copy.

5 Enter a value for the code:
   - Pick Master: Select a panel component from the drawing carrying the desired values for all of the codes you want to copy.
   - Enter a value in the edit box.
   - Drawing: Select a value from a list of values used on the active drawing.
   - Project: Select a value from a list of values used in the project.
   - Pick: Select a panel component from the drawing carrying the desired value for the specific code.

6 Click OK.

NOTE Schematic components only update installation or location values when the component carries an installation or location attribute respectively. Panel components update with either of the two data categories whether target attributes are present or not.
This tool lets you do mass copies of location, installation, group, or mount
codes to all of the components you select. You either type in the desired code,
pick from an on-line list, or pick a similar master component.

Access:

On the Panel Layout toolbar, click the Miscellaneous Panel Tools tool to access
the Panel Location Copy tool. Select the Copy Installation Code, Copy Location Code, Copy Mount Code, or Copy Group Code tool.

From the Panel Layout menu, select Miscellaneous Panel Tools ➤ Copy Installation Code, Copy Location Code, Copy Mount Code, or Copy Group Code.

Pick master
Retrieves existing values by selecting a panel component from the
drawing carrying the desired Installation or Location value you wish
to copy.

Installation
Specifies to copy the installation code that you enter in the edit box.

Location
Specifies to copy the location code that you enter in the edit box.

Mount
Specifies to copy the mount code that you enter in the edit box.

Group
Specifies to copy the group code that you enter in the edit box.

Drawing
Selects a value for the code from a list of values used on the current
drawing.

Project
Selects a value for the code from a list of values used in the project.
Use panel templates

You can use templates to create a panel layout drawing or to automatically insert attributes to footprints during insertion time.

Panel layout template drawings

You can set up an AutoCAD template drawing for panel layout drawings with the WD_PNLM block pre-inserted and set up with your own default settings. You can also set up client-specific template drawings and reference the appropriate one when starting a new AutoCAD Electrical panel drawing.

Attribute template drawings

You can set up to have visible attributes added to any footprint automatically at footprint insertion time. This means that using non-intelligent footprint representations can insert with smart AutoCAD Electrical attributes added automatically, on the fly.

There are 5 attribute template drawings:

- **wd_ptag_addattr_comp.dwg**
  - Component footprints

- **wd_ptag_addattr_trm.dwg**
  - Terminal footprints

- **wd_ptag_addattr_wtrm.dwg**
  - Terminal with wire no. as terminal number

- **wd_ptag_addattr_itemballoon.dwg**
  - Balloons

- **Wd_ptag_addattr_pntermstrip.dwg**
  - Terminal footprints (when inserted by Level/Sequencing tools)

If AutoCAD Electrical finds that the template exists, a copy gets exploded and merged (for example, blocked with the panel footprint as AutoCAD Electrical inserts the footprint into the drawing). Then the schematic data is placed on
the footprint either as visible attribute data (if the target attribute exists) or as nonvisible Xdata if the target attribute does not exist on the footprint block.

As AutoCAD Electrical inserts a footprint and prepares to merge this attribute definition template into the block, it attempts to find the center of the inserted block by collecting and averaging the parts and pieces that make up the block. It adds the attribute definition template at this calculated location. Next, for each attribute definition in the merged template, AutoCAD Electrical checks to see if the original block is already coming in with that particular attribute tag name. If there is no attribute with that name, the merged attribute definition stays, otherwise AutoCAD Electrical erases the merging one and keeps the existing one. AutoCAD Electrical re-blocks the added attribute definitions with the existing footprint. Finally, if there is schematic data to put on the footprint, AutoCAD Electrical annotates the attributes, if present, or writes the data out as nonvisible Xdata.

**Insert panel footprint assemblies**

You can Wblock assemblies of panel components out to disk for insertion later. Use the Insert Panel Assembly utility instead of the AutoCAD Insert/Explode command when you want to insert a WBlocked group of panel component footprints with balloons or nameplates. Since AutoCAD Electrical
establishes invisible Xdata pointers when these are tied to a footprint, they are properly updated when copied using this utility.

1. Click the arrow on the Miscellaneous Panel Tools tool to access the Insert Panel Assembly tool.

2. Click the Insert Panel Assembly tool.

3. Specify whether to add the intelligence needed for each block to be treated as an AutoCAD Electrical footprint.

4. Click OK.

5. In the Wblocked Assembly to Insert dialog box, select the assembly and click Open.

6. Specify the insertion point for the block.

7. Enter a rotation angle or press Enter to use the default.

Your block is inserted onto the drawing at your picked point.

You can also insert copies of panel assemblies that are already on your active drawing.

1. Click the arrow on the Miscellaneous Panel Tools tool to access the Copy Assembly tool.

2. Click the Copy Assembly tool.

3. Select the panel component to copy and right-click.

4. Enter a base point or displacement value.

5. Specify the second point and right-click.

Your block is inserted onto the drawing at your picked point.

Select component data from a spreadsheet
If you start with panel layouts before you create schematics, schematic pick list data is not available to automate footprint selection and annotation. An alternative is available. If you list your panel components in a spreadsheet and in a format that AutoCAD Electrical expects, this spreadsheet data can become your schematic pick list data for panel layout.

**Component spreadsheet data format**

The spreadsheet data must be in this order and have 28 columns of data and be saved in a "CSV comma delimited" text format. Most of the fields can be left blank:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TAG Component tag id (ex: &quot;PB101&quot;)</td>
</tr>
<tr>
<td>2</td>
<td>INST Optional installation code</td>
</tr>
<tr>
<td>3</td>
<td>LOC Optional location code</td>
</tr>
<tr>
<td>4</td>
<td>MOUNT Optional mount code</td>
</tr>
<tr>
<td>5</td>
<td>GROUPWIDTH Optional group code</td>
</tr>
<tr>
<td>6</td>
<td>MFG Manufacturer code</td>
</tr>
<tr>
<td>7</td>
<td>CAT Catalog number</td>
</tr>
<tr>
<td>8</td>
<td>ASM Optional catalog assembly code</td>
</tr>
<tr>
<td>9</td>
<td>CNT Optional count value</td>
</tr>
<tr>
<td>10</td>
<td>UM Optional unit of measure</td>
</tr>
<tr>
<td>11-13</td>
<td>DESC1-DESC3 Three lines of description text</td>
</tr>
<tr>
<td>14</td>
<td>BLKNAM Schematic block name (used to determine catalog lookup table name)</td>
</tr>
<tr>
<td>15-26</td>
<td>RATING1-12 Optional rating values</td>
</tr>
</tbody>
</table>

Select component data from a spreadsheet | 1067
### Panel terminals spreadsheet data format

The spreadsheet data for panel terminals must be in this order and have 30 columns of data and be saved in a "CSV comma delimited" text format. Most of the fields can be left blank:

<table>
<thead>
<tr>
<th>Column</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TAGSTRIP</td>
<td>Terminal strip tag id (ex: &quot;TB1&quot;)</td>
</tr>
<tr>
<td>2</td>
<td>INST</td>
<td>Optional installation code</td>
</tr>
<tr>
<td>3</td>
<td>LOC</td>
<td>Optional location code</td>
</tr>
<tr>
<td>4</td>
<td>MOUNT</td>
<td>Optional mount code</td>
</tr>
<tr>
<td>5</td>
<td>GROUPWIDTH</td>
<td>Optional group code</td>
</tr>
<tr>
<td>6</td>
<td>MFG</td>
<td>Manufacturer code</td>
</tr>
<tr>
<td>7</td>
<td>CAT</td>
<td>Catalog number</td>
</tr>
<tr>
<td>8</td>
<td>ASM</td>
<td>Optional catalog assembly code</td>
</tr>
<tr>
<td>9</td>
<td>CNT</td>
<td>Optional count value</td>
</tr>
<tr>
<td>10</td>
<td>UM</td>
<td>Optional unit of measure</td>
</tr>
<tr>
<td>11-13</td>
<td>DESC1-DESC3</td>
<td>Optional description text</td>
</tr>
<tr>
<td>14</td>
<td>BLOCK</td>
<td>Optional schematic block name (blank)</td>
</tr>
<tr>
<td>15-26</td>
<td>RATING1-12</td>
<td>Optional rating values</td>
</tr>
<tr>
<td>27</td>
<td>ITEM</td>
<td>Optional item number assignment</td>
</tr>
</tbody>
</table>
Previous project's schematic spreadsheet data

If your new project is similar to a previous project, you can use the previous project's schematics to create a component or terminal spreadsheet listing. This can then help drive the new project's panel layout.

Open the previous project in AutoCAD Electrical. From the Panel Layout menu, select Insert Footprint (Schematic List) or Insert Terminal (Schematic List). On the selection dialog, check the Save List to External File option and then extract from the project. AutoCAD Electrical creates a comma-delimited file of the schematic data. You can then display this data in spreadsheet format (open it in comma-delimited "CSV" format), edit, and then save back out. Now follow the procedure described for picking and inserting the panel component or terminal footprints from the spreadsheet driven pick list.

Schematic terminals list panel layout insert

This report provides error checking between the schematic terminals and panel layout terminals. The program looks at the selected terminals, both schematic and panel, looking for a match in the project. For each schematic terminal selected, it tries to find a matching panel terminal based on tag, location, and installation information. If a match is found, then it compares catalog information, and description information, looking for any discrepancies. The program then looks at each selected panel terminal looking for a matching schematic terminal in the same way.

Access:

Click the arrow on the Insert Footprint tool to access the Insert Terminal (Schematic List) tool.
From the Panel Layout menu, select Insert Terminal (Schematic List).

If you start with panel layouts before you create schematics, schematic pick list data is not available to automate footprint selection and annotation. If you list your panel components in a spreadsheet and in a format that AutoCAD
Electrical expects, this spreadsheet data can become your schematic pick list data for panel layout.

**Extract component list for**

Specifies to export the data for the active drawing or the entire project.

**Save list to external file**

Uses a previous project's schematics to create a component or terminal spreadsheet listing. This can help drive the new project's panel layout. AutoCAD Electrical creates a comma-delimited file of the schematic data. You can display this data in spreadsheet format (open it in comma-delimited "CSV" format), edit, and then save back out.

**Location Codes to extract**

Extracts only the information for components with specific location values. Once you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. You can also create a report from multiple location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**Schematic components or terminals**

AutoCAD Electrical processes the project drawing set. It presents a list of all parent components or terminals (plus any child components/terminals that carry non-blank MFG/CAT values) extracted from the project's schematic wiring diagrams. First, you pick from this schematic list, and then place the equivalent footprint on the layout. AutoCAD Electrical determines the equivalent footprint block automatically through a manufacturer/catalog match pulled from the footprint look-up file.

**Access:**

Click the arrow on the Insert Component Footprint tool to access the Insert Footprint (Schematic List) tool. Select Project and click OK. Select the files to process and click OK.

Click the arrow on the Terminal Strip Editor tool to access the Insert Terminal (Schematic List) tool. Select Project and click OK. Select the files to process and click OK.

From the Panel Layout menu, select Insert Footprint (Schematic List) or Insert Terminal (Schematic List). Select Project and click OK. Select the files to process and click OK.
Sort List

Sorts the list of schematic footprints. You can specify four sorts to perform on the list.

Reload

Reinitializes the display. This causes the dialog box to return to the Schematic components (or terminals) list panel layout insert dialog box.

Mark Existing

Puts an "x" in the left-hand column position for any listed schematic component (or terminal) tag that already has its footprint inserted on the panel layout and there is an exact on Catalog and Manufacturer values between the two. Displays a "o" if the tags match but there is mismatch on Catalog and Manufacturer values between the two.

Display

Show All/Hide Existing

Specifies to show all or hide the existing components or terminals.

Multiple Catalog [+]

Shows a full listing of the main catalog numbers plus the multiple catalog entries. Each multiple catalog entry displays in the list as a line entry, allowing you to insert each entry as a separate footprint.

Catalog Check

Quickly performs a Bill of Material check and displays the result.

Footprint Scale

Specifies the block insert scale. (1.0 = full)

Rotate

Specifies the block rotation angle. (blank = "ask")
**External Program**

Executes external user routine to retrieve footprint block name and/or catalog data. Requires WD\_XCAT reference in wd.env and a user AutoLISP file to manage the data send/receive with the external routine.

**Manual**

Specifies to manually pick the insertion point.

**Insert**

Finds and inserts footprint for highlighted component (or terminal). This is based upon a match between the schematic symbol's catalog part number and an entry in a footprint lookup file. If no match is found you will be prompted to manually draw the footprint, add an entry in the lookup file, or select an existing footprint drawing file.

**Use Footprint tables**

Accesses the standard footprint look-up table that matches the device's MFG code. This table is set up to insert a full mechanical representation of the device.

**Use Wiring diagram tables**

Accesses an alternate table in the footprint look-up table. This table matches the MFG code but attaches an "\_WD" suffix. The tables with the "\_WD" suffix are set up to insert a symbol that carries the wire connection attributes.

**Convert Existing**

Inserts selected entry's data on an existing dumb block insert. This instantly converts the block to a smart AutoCAD Electrical footprint.

**Pick File**

Specifies to pick a file for the insert. Select an existing AutoCAD Electrical Schematic extracted component (or terminal) list file or extract a fresh copy of schematic component (or terminal) data from the current project's database.

**Spacing for component or footprint insertion**
If a device selected from the schematic extract list has any associated secondary contacts, these contacts are inserted along with the primary component. Use the options within the Device Spacing area to define how you want the first component of each device inserted. Use the options within the Components for Selected Device area to define how you want to insert all the components that are associated with a selected Device Tag.

Access:

Run any of the component or footprint insertion from list commands (such as Components ➤ Insert Component (Panel List)). Select the drawings to process and click OK. Select multiple components or terminals to insert and click Insert.

The components display in the list box in the order they are inserted. To modify the order, select an item from the list, then select Move Up or Move Down in the list.

Prompt for each location

Specifies the location for each component or terminal using the Insert dialog box.

Fence Insertion

(for component insertion only) Specifies the location for all of the components. Specify the insertion points on the drawing and right-click. The Insert/Edit dialog box displays. Once you click OK on the Insert/Edit dialog box, the component inserts on the drawing.

Use uniform spacing

Specifies the location for the first component (or terminal). The values in the X-distance and Y-distance boxes are used to calculate the insertion coordinates for the remaining components (or terminals).

NOTE You can set the default values for the X-distance and Y-distance in the Panel Configuration dialog box.

Suppress edit dialog and prompts

(for footprint insertion only) Suppresses the edit dialog box that normally appears each time a component (or terminal) is inserted. The Panel Insert/Edit dialog box displays after each insert if this option is not selected.
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Up</td>
<td>Moves the selected component or terminal up one spot in the list.</td>
</tr>
<tr>
<td>Move Down</td>
<td>Moves the selected component or terminal down one spot in the list.</td>
</tr>
<tr>
<td>Reverse</td>
<td>Rearranges the list of terminals in descending order.</td>
</tr>
<tr>
<td>Re-sort</td>
<td>Sorts the list of terminals in ascending order.</td>
</tr>
</tbody>
</table>

**Merge schematic wire numbers onto footprints**

AutoCAD Electrical supports a transfer of schematic wire numbers to panel footprint representations. There are two ways that this information can be assigned to the panel footprint, MTEXT or attributes. If the footprint does not carry certain target attributes then AutoCAD Electrical will generate MTEXT to display the wire connection information.

Before trying this feature make sure you have added wire numbers to your schematics. Once this is completed then you will need to run an AutoCAD Electrical command to extract the wire connection information from the
schematics. Then you may add the wire connection information to the footprint blocks.

1. Click the Panel Configuration tool.
2. Click Panel wire connection report XYZ offset ref Setup.
3. Define the formats for the "From" TERM annotation text and symbol.
4. Specify any additional options to include on the "To" component TagID.
5. View/test the report.
6. Click OK-Project-wide to format the wire connection annotation project-wide.

**Format: schematic layout wire connection annotation**

Defines the default wire connection text format. After you add wire numbers to your schematics and extract this information, you are ready to annotate your panel footprint symbols with this information. The information can be added to the drawing in two different ways. You can build your panel footprint symbols with some target attributes that are used for the wire connection information.

**Access:**

Click the Panel Configuration tool. Click Panel wire connection report XYZ offset reference Setup.

From the Panel Layout menu, select Panel Configuration. Click Panel wire connection report XYZ offset reference Setup.

**NOTE** You can build two sets of panel footprint symbols, one set that does not carry the target attributes for wire information and a set that does. When you insert your panel symbols from the schematic extract, select Use Footprint tables to access the first set of symbols or Use Wiring diag tables to access the second set.
Format

There are two format edit boxes on the dialog. The "Full" format will be used if AutoCAD Electrical does not find the target attributes and inserts MTEXT. The "Partial" format is used if AutoCAD Electrical finds the target attributes (described later). Each format uses parameters that are then replaced with the specific wire information. AutoCAD Electrical provides some pre-defined formats for you to select from the list box at the right. Or you can enter your own format using replaceable parameters (page 126).

Parameters must be separated by non-blank delimiters for AutoCAD Electrical to be able to re-extract wiring diagram information into reports. For example, "%T=%W %1 %G" is not acceptable because there is only a space between the %W and %1 and %G parameters. Acceptable formats include "%T=%W (%I1) %G" or "%T=%W / %I1 (%G)" or "%T=%W (%I1) %G".

NOTE Commas cannot be used in the format. They signal multiple wire connection annotations onto a single wire connection attribute.

Additional options for the "To" component tag

There are additional options that can be included in the text.

Add terminal pin as a suffix to tag

Add the terminal text as a suffix.

Add terminal description to tag

Adds any terminal description value as a suffix.

Include installation prefix to IEC tag format

Adds any installation value as a prefix.

View/Test

Allows a preview or test of the report.

Suppress any duplicated annotation on each terminal

Indicates to hide duplicated annotations so that they do not show on the report.
Add wire information to footprints

After you add wire numbers to your schematics and extract this information, you are ready to annotate your panel footprint symbols with this information. The information can be added to the drawing in two different ways. You can build your panel footprint symbols with some target attributes that are used for the wire connection information. If these target attributes are not present on the panel footprint, AutoCAD Electrical adds a smart MTEXT entity to carry the wire information. If the panel footprint blocks are modified to carry certain target attributes, then these are updated with the wire information.

1. Click the Wire Annotation of Panel Footprint tool.
2. Specify to export the data for the active drawing or the entire project and click OK.
3. Select the wire numbering format to use.
4. Select the layout devices to update with the schematic wire connection information.
5. Click OK.
6. If you are exporting the data for the entire project, select the drawings to process, and click OK.

Schematic wire numbers panel wiring diagram

Annotates panel footprint symbols with wire connection information extracted from selected schematics.

Access:

Click the Wire Annotation of Panel Footprint tool.
From the Panel Layout menu, select Wire Annotation of Panel Footprint.

Panel connection annotation for

Specifies to create an annotation for the active drawing, object in the drawing, or the entire project.
**Freshen**  Updates the wire connection table with the out-of-date files

**List**  Lists the drawings that appear to be out-of-date with the project's wire connection table.

**Report only (no drawing update)**  Specifies to update only the report - not the drawing.

**Location Codes to extract**  Extracts only the information for components with specific location value(s). Once you pick Named Location, type the location code in the box or click List: Drawing or List: Project to select from a list of used location codes. AutoCAD Electrical automatically creates a comma-delimited list for the named location search.

**Replaceable parameters for defining wire annotation**

- **%P**  Terminal pin text
- **%Q**  Terminal pin TERMDESC text
- **%I**  IEC-style installation code
- **%L**  IEC-style location code
- **%M**  Mount assignment (on panel footprint equivalent)
- **%U**  Group assignment (on panel footprint equivalent)
- **%W**  Wire number
- **%C**  Cable tag + conductor/core color combination (format is “tag-color”)
- **%E**  Cable tag
- **%J**  Cable conductor/core color
%V  Cable tag substituted for wire number if cable tag is non-blank.
The wire number is displayed when a cable ID doesn't exist.

%G  Wire color/gauge (or wire layer name)

%H  Cable wire color substituted for wire number if cable color is non-blank.
The wire layer is displayed when a wire conductor in conjunction with a cable
ID doesn't exist.

%T  Terminal strip terminal pin assignment

%K  Terminal strip TERMDESC text - useful for multi-stack terminals

%1  Destination component tag ID. You can use only one of the (%number) para-
    meters.

%2  Equivalent of "%1:%P" (component tag:term)

%3  Equivalent of "%1:%P:%D" (component tag:term:termdesc)

%4  Equivalent of "%L%1" (IEC component tag)

%5  Equivalent of "%L%1:%P" (tag:term)

%6  Equivalent of "%L%1:%P:%D" (tag:term:termdesc)

%7  Equivalent of "%I%1" (INST prefix+IEC component tag)

%8  Equivalent of "%I%L%1:%P" (tag:term)

%9  Equivalent of "%I%L%1:%P:%D" (tag:term:termdesc)

The part after the ":" is suppressed if the value is blank in %2 - %9 parameters.
For example, %2=comp tag:term. The ":term" part is suppressed if blank.

**Schematic layout wire connection annotation**

Defines the wire connection text format.
NOTE You can define the default wire connection text format using the Panel Configuration dialog box. Select Panel Layout ➤ Panel Configuration, and click Panel Wire Connection Report XYZ Offset Reference Setup.

Access:

Click the Wire Annotation of Panel Footprint tool. Make your selections and click OK.

From the Panel Layout menu, select Wire Annotation of Panel Footprint. Make your selections and click OK.

NOTE You can build two sets of panel footprint symbols - one set that does not carry the target attributes for wire information and a set that does. Then when you insert your panel symbols from the schematic extract, select to Use Footprint Tables to access the first set of symbols or select Use Wiring Diagram Tables to access the second set.

Format

There are 2 format edit boxes on the dialog. The "Full" format is used if the target attributes are not found and MText is inserted. The "Partial" format is used if the target attributes are found (described later). Each format uses parameters that are then replaced with the specific wire information. AutoCAD Electrical provides some pre-defined formats for you to select from the list box at the right; or you can enter your own format using replaceable parameters (page 126).

Parameters must be separated by non-blank delimiters for AutoCAD Electrical to be able to re-extract wiring diagram information into reports. For example, "%T=%W %1 %G" is not acceptable because there is only a space between the %W and %1 and %G parameters. Acceptable formats include "%T=%W (%1) %G" or "%T=%W / %1 (%G)" or "%T=%W (%1) %G".

NOTE Commas cannot be used in the format. They signal multiple wire connection annotations onto a single wire connection attribute.

Additional options for the "To" component tag

There are additional options that can be included in the text.

Add terminal pin as a suffix to tag Adds the terminal text as a suffix.
Add terminal description to tag  Adds any terminal description value as a suffix.

Include installation prefix to IEC tag format  Adds any installation value as a prefix.

View/Test

Allows a preview or test of the report.

Suppress any duplicated annotation on each terminal

Indicates to hide duplicated annotations so that they do not show on the report.

If wire numbering converts to MText

The default MText insertion point is the same as the footprint block’s insertion point. The default text size either matches that of existing wire number attributes found on the footprint symbol or, if none present, the MText size is forced to match the current value of the AutoCAD system variable "TEXTSIZE".

If you want to predefine the MText insertion point, text size, and text style on footprint blocks, you can do this by inserting an invisible attribute "WXREF" on your footprint block library symbol. Open up each footprint symbol in AutoCAD and insert a blank attribute definition "WXREF". Put its origin at the point where you want AutoCAD Electrical to insert the block’s MText wire connection information. Mark this attribute definition invisible and set its text size and style to the desired MText size and style.

Use the footprint lookup file

A key part of the AutoCAD Electrical design workflow is to first create the schematic ladder controls diagrams and then use this information to help automate the creation of the related physical panel layouts. The former shows interconnected generic schematic symbols of the components and the latter shows the related footprint representation of each component. These footprint
representations are supplied as a library of .dwg files and are inserted onto the layouts in the form of AutoCAD block inserts.

AutoCAD Electrical makes use of the footprint lookup database (footprint_lookup.mdb) to identify the footprints corresponding to the MANUFACTURER, CATALOG, and ASSEMBLYCODE attribute values of the schematic symbols. The footprint lookup file maps catalog information from a schematic component to a specific panel footprint library symbol. The database content is found at: C:\Documents and Settings\{username}\My Documents\Acade {release #}\AeData\Catalogs.

Within the database file are tables based on manufacturer codes. When you select a component from an AutoCAD Electrical extract file or select a component from a catalog lookup file, it carries a manufacturer code, MFG. AutoCAD Electrical takes this MFG code, goes to the matching table name in the footprint lookup database and tries to find a match on the catalog number (plus ASSEMBLYCODE if not blank). If a match is found, AutoCAD Electrical retrieves the footprint block path/name (or optional geometry definition) from the matching record and inserts the footprint representation into the drawing.

The footprint lookup file supplied with AutoCAD Electrical points to symbols that are full-size physical representations of the device. There may be times you want to insert a footprint that is not necessarily a physical representation but one that carries wire connection attributes. With this type of symbol AutoCAD Electrical can annotate the symbol with schematic wire connection data to create a panel wiring diagram drawing. From the Insert Footprint from Schematic dialog box, if you select Use Wiring diagram tables, AutoCAD Electrical accesses an alternate table in the footprint lookup table. This table matches the MFG code but attaches a "_WD" suffix. The tables with the "_WD" suffix are set up to insert a symbol that carries the wire connection attributes.

You must expand and modify these tables to meet your specific Panel footprint needs. You can do this using tools provided with AutoCAD Electrical or through the use of a database program that can read/write the Access file format. You may use the footprint_lookup.mdb or a project-specific footprint lookup file, called <project>_footprint_lookup.mdb. If the project-specific .mdb file is used, it must in the same subdirectory as the <project>.wdp file.

**AutoCAD Electrical search sequence**

1st choice -- <project>_footprint_lookup.mdb in project's subdirectory
2nd choice -- footprint_lookup.mdb in project's subdirectory
3rd choice -- footprint_lookup.mdb in user subdirectory
4th choice -- footprint_lookup.mdb in panel subdirectory
5th choice -- AutoCAD search paths

**Lookup file naming convention**

AutoCAD Electrical takes the target footprint's MFG code and looks for a table, in your Access schematic_lookup.mdb file format file with that name. For example, if the footprint's MFG value is SQD, then AutoCAD Electrical searches for a schematic lookup table called SQD; manufacturer code of AB yields the table name AB. The alternate table should carry the MFG name with a ".WD" suffix. For example, for AB the alternate table would be named AB_WD.

**Lookup file format**

Footprint lookup tables are in a Microsoft Access database file. Each record consists of these fields (in this order):

- **CAT**
  Catalog number, wild cards allowed

- **ASSYCODE**
  Optional assembly code value - internal AutoCAD Electrical use only

- **BLKNAM**
  Footprint block name with partial path or geometry definition

- **DESC**
  Optional short description used for display purposes only

**Block name vs. geometry definition**

You can encode a simple geometry definition in place of a footprint path/block name in the lookup file. For example, if a footprint shape for a given part number is a 3x4 rectangle, instead of creating and saving a 3x4 rectangle as a Wblocked.dwg file you can encode the instructions for drawing the rectangle in the lookup file like this:

```
("LINE" "0,0" "@4.00,0" "@0,3.00" "@-4.00,0" "C")
```

The example above follows the command sequence you’d type in to create the footprint outline. When AutoCAD Electrical comes across this instead of a path/block name in the lookup file, it executes the command sequence and blocks it on the fly.
Edit footprint lookup files

You can make edits and additions to footprint lookup files using the Footprint Database File Editor tool or you can edit them directly using Microsoft Access.

1 Click the arrow on the Miscellaneous Panel Tools tool to access the Footprint Database File Editor tool.

2 Click the Footprint Database File Editor tool.

3 Select the Edit Existing Table button.

4 Select the table to edit and click OK.

5 In the Footprint lookup dialog box, decide if you want to edit an existing record or add a new one.
   ■ If you decide to edit an existing record, select the record to edit and click Edit Record.
   ■ If you decide to add a new record, click Add New.

6 Add or edit the record values and click OK.
   The Catalog Number and Footprint block name, at a minimum, must be filled in to provide a key field for the search and a block or geometry definition for the matching footprint.
   Your new record is added to the list. You can also immediately see any changes you made to an existing record.

7 Click Save to save your changes and keep the dialog box open for more editing, or click OK / Save/ Exit to save your changes and close the dialog box.

Panel footprint lookup database file editor

The footprint lookup database links a manufacturer’s catalog part numbers to appropriate footprint block .dwg files. This information is in a multi-table
Access database file (footprint_lookup.mdb). There is a table for each manufacturer code.

Access:

Click the arrow on the Miscellaneous Panel Tools tool to access the Footprint Database File Editor tool.
From the Panel Layout menu, select Database File Editor ➤ Footprint Database File Editor.

Each entry in the table maps a given part number to its footprint block name. The table name must match the manufacturer code.

- **Edit existing table**: Opens a sub-dialog box for editing existing manufacturer footprint lookup tables.
- **Create new table**: Opens a sub-dialog box for creating new manufacturer footprint lookup tables.
- **Create empty file**: Opens a sub-dialog box for creating a blank footprint lookup file. This option is available if a Footprint_lookup.mdb file does not exist in the designated location.

**Footprint lookup**

This tool allows you to examine the records and, modify, delete or add records.

Access:

Click the arrow on the Miscellaneous Panel Tools tool to access the Footprint Database File Editor tool. Select the Edit Existing Table button, select the table to edit, and click OK.
From the Panel Layout menu, select Footprint Database File Editor. Select the Edit Existing Table button, select the table to edit, and click OK.

- **Edit record**: Opens a sub-dialog box for editing an existing record. Highlight the record and click on the Edit button. Modify the record in the displayed sub-dialog.
- **Delete**: Removes an existing record.

Use the footprint lookup file | 1085
Add new

Opens a sub-dialog box for creating a new record. Fill in the fields as desired. If the footprint block is not in an AutoCAD search path or an AutoCAD Electrical search path, include the part of the path that needs to be appended to one of these search paths (or you can enter the full path). If the new record is similar to an existing record, highlight the existing record before you click on the Add button.

Add or edit footprint record

This tool makes edits and additions to footprint look-up files. You may also edit them directly using Microsoft Access.

Access:

Click the arrow on the Miscellaneous Panel Tools tool to access the Footprint Database File Editor tool. Select the Edit Existing Table button, select the table to edit, and click OK. Click Add New or Edit Record on the Footprint Lookup dialog box.

From the Panel Layout menu, select Footprint Database File Editor. Select the Edit Existing Table button, select the table to edit, and click OK. Click Add New or Edit Record on the Footprint Lookup dialog box.

NOTE The Catalog Number and Footprint block name, at a minimum, must be filled in to provide a key field for the search and a block or geometry definition for the matching footprint.

Catalog Number

 Specifies the catalog part number for the record. Click View to display a list of catalog fields on a per table basis. The catalog value may contain wildcards. Wild card characters include:

* = match any characters
? = match any single character
# = match any single numeric digit
@ = match any single alphabetic character

Assembly code

Specifies the assembly code for the record.
Footprint block name

The Block value can be a symbol name or AutoLISP expression. If the footprint block is not in an AutoCAD search path or an AutoCAD Electrical search path, include the part of the path that needs to be appended to one of these search paths (or enter the full path to the footprint block).

Browse

Locates the block name.

Pick

Captures the block name if it already exists on the current drawing.

Geometry

Substitutes a simple on-the-fly generated outline for the matching footprint. Several shapes are selectable or you can manually enter the definition.

Icon Menu

Opens an AutoCAD Electrical icon menu page for the block you specify in the Catalog Number section of the dialog box.

Enter the menu name or browse for it. Once selected, click List to see a list of the sub-menu pages defined within that icon menu to select from or enter the number of the menu page to display and click OK.

The menu number corresponding to the catalog number is then saved in the footprint lookup table.

Comment

Specifies the optional comment for the footprint record. This is for reference in this file only. It does not get extracted into any AutoCAD Electrical report.

Assign an item or detail number to a footprint

An item or detail number can be assigned to a component’s footprint through the Insert/Edit dialog box. This is stored as a data value on the footprint block itself. To bring this item number out to a visible label, a balloon for example,
select the Balloon icon from the toolbar and pick somewhere on the footprint block. The footprint's item number is retrieved and then you are prompted to select start/end for a leader.

A single item number attribute, B_ITEM, is inserted on the balloon symbol. You can set up a template to have additional visible attributes added to the balloon automatically at insertion time. Create this drawing with the attribute definitions you want to include with the balloon symbol:

\wd\panel\wd_ptag_addattr_itemballoon.dwg.

If an existing template is found, a copy of it gets exploded and merged (i.e. blocked with the balloon as AutoCAD Electrical inserts it into the drawing).

The AutoCAD Electrical item balloon labels are smart in that they update automatically if the footprint's item number is manually changed through the EDIT dialog.

TIP To build up a multiple balloon, let's say of a switch and a nameplate combination, insert a balloon with leader on the switch. Then insert a balloon without leader on the nameplate. Use AutoCAD MOVE command to move the second balloon so that it touches the first. Both balloons still remain "smart".

Assign an item number to a component's footprint

1 Click the Insert Balloon tool on the Panel Layout toolbar.
2 Select the component for the balloon or press S at the command line prompt to open the Balloon Setup dialog box.
3 Specify the leader start or balloon insertion point.
4 Specify the leader end and press Enter when you are done specifying the leader.
   You can also press Enter without specifying the leader end to create the balloon at the first picked point (the balloon won't have a leader).
5 Enter the item number and press Enter.

NOTE You can also preset the balloon shape, size, text size, and arrow type from the balloon setup section on the Panel Configuration dialog box.
Resequence item numbers

All Panel components and nameplates are extracted and their item numbers resequenced starting at the value you provide.

1 Click the arrow on the Miscellaneous Panel Tools tool to access the Re-sequence Item Numbers tool.

2 Click the Re-sequence Item Numbers tool.

3 Specify the beginning number to use.

4 Specify to process the data for the current drawing or the entire project. If you select Project, you will be able to select which drawings from within the project. If you select Current Drawing only, AutoCAD Electrical will not check other drawings for existing item number assignments.

5 Click OK.

Panel balloon setup

Sets the type of balloon marker for the footprint, marker size, margin, and text gap.

Access:

Click the Panel Configuration tool. Click Balloon Setup.
From the Panel Layout menu, select Panel Configuration. Click Balloon Setup.

Balloon

Specifies the type and size of balloon marker to insert. Choose from Circle, Ellipse, Polygon, and None.
Circle - select either Diameter or Fit. Enter the diameter value or the Fit Margin, which sizes the circle automatically to fit the text plus the margin value.
Ellipse - select either Axis or Fit. Enter the horizontal and vertical axis sizes or the Fit Margin as above.
Polygon - select a polygon shape by picking on the current shape icon. Choose either Diameter or Fit as above.
None (text only) - enter the gap value (the amount of space between the end of the leader line and the text).

**Text**
Specifies the text size for the marker.

**Arrow**
Specifies the arrowhead and size. Choose the type of arrowhead for the leader from the list and enter the arrowhead size in the box. These values correspond to AutoCAD leader/dimension system variables.

### Resequence panel item numbers

This tool assigns or resequences item number assignments on a drawing or project. This extracts all panel components and nameplates and resequences their item numbers starting at the value you provide. Resequencing is based on the main MFG/CAT/ASSYCODE value combination. Additional multi-catalog numbers on a specific component are ignored. Only the main part number combination is used to group similar components together under a common item number.

**Access:**

Click the arrow on the Miscellaneous Panel Tools tool to access the Resequence Item Numbers tool.

From the Panel Layout menu, select Miscellaneous Panel Tools ➤ Resequence Item Numbers.

Select the beginning item number to use. This processes the drawing or project drawing set and assigns incrementing item numbers for each new part number. Any old item number assignments are overwritten with new ones, existing balloons are updated, and repeated part numbers are assigned the same item number, even when running project-wide.

**Start**
Specifies the beginning number to use. Add leading zeros if desired (ex: "001" instead of "1") to enable better report sorting on item number.

**Drawings to Process**
Specifies to process the data for the active drawing or the entire project. If you select Project, you can select which drawings to process from within the project. If you select Active Drawing, other drawings are not checked for existing item number assignments.
Insert nameplates

A nameplate is inserted on to the drawing as a block. It can either be referenced
to an existing component footprint block or inserted as a stand-alone
nameplate.

When tied to a component footprint, the component footprint is the parent
and the nameplate is a child of that parent. AutoCAD Electrical establishes
the link automatically by using invisible Xdata pointers on each block. This
is different from the schematic parent/child link where a common
"TAG1/TAG2" tag ID defines the relationship. AutoCAD Electrical automatically
annotates the nameplate with the parent's description data lines and tag value
(if the nameplate block carries these target attribute names).

Create your own nameplates

Use this example to create your own stretchable nameplate symbols. The
nameplate attribute definitions (P_TAG1 and DESC1 through DESC3) are
created and saved as drawing npxxt3.dwg. Another drawing, _npxxt3.dwg,
is created and the first drawing is inserted as a block at 0,0. A polyline rectangle
is positioned around the block and then the drawing is saved. Now the panel
icon menu file, wd_pmenu.dat, is edited with any text editor (ex: WordPad)
and the "_npxxt3" entry is referenced as shown below. Enter the full path if
the symbol is not in the default \Program Files (x86)\Adobe\Acad
{version}\libs\panel folder.

**M28
D3W
NAMEPLATES
Generic, TAG and 3 DESC | s1(npxxt3) | $C=wd_inrnp_xg "" "" "" _NPXXTD3"
Generic, TAG number only | s1(npxxt) | $C=wd_inrnp_xg "" "" "" _NPXXT"
Generic, 3 DESC lines only | s1(npxxd3) | $C=wd_inrnp_xg "" "" "" _NPXXD3"
Nameplate, cat lookup|pnl2(_np)|$C=wd_inrnpx

NOTE You only need to define the D*W row if you plan on using this .dat file in
a version of AutoCAD Electrical prior to AutoCAD Electrical 2008.
**Insert a nameplate**

Several generic, rectangular nameplates with stretchable boundaries are provided. Three generic nameplates are shown on the top row of the sub-dialog box. Each of these consists of a nested block, which AutoCAD Electrical explodes and groups upon insertion. The rectangular outline of the resulting nameplate can be stretched using AutoCAD Grips or the Stretch Window command.

1. Click the Insert Footprint tool.
2. Select Nameplates from the list.
3. Select the desired nameplate from the sub-dialog box.
4. Pick the target footprint and press Enter.
   - To insert a stand-alone nameplate, simply press Enter without first selecting a component.
5. Pick the insertion point and move your cursor to rotate the nameplate to the desired alignment. Click the left mouse button to end the dynamic insertion.
6. Specify the nameplate tag, description, installation and location codes, and catalog data in the Panel Layout - Nameplate Insert/Edit dialog box.
   - AutoCAD Electrical immediately annotates the nameplate with a copy of the description data that it finds carried on the footprint (which is the same description that is found on the schematic representation of the component).
7. Click OK to insert the nameplate.

**TIP** Use AutoCAD MOVE command to position the nameplate in relation to the parent footprint.
Remove sequencing assignments
Routing assignments found on components, boundary boxes, or terminals can be removed when no longer needed.

1. On the Panel Level/Sequencing toolbar, click the arrow on the Level/Sequencing Assignments tool to access the Remove Level/Sequencing Assignment tool.

2. Click the Remove Level/Routing Sequencing tool.

3. Select the terminal strip, component, or boundary box to remove the assignments from.
   The leveling assignments are automatically removed.

4. Press ESC to exit the command.

Show sequencing assignments
You can select a supplementary terminal strip to display its defined leveling assignments to the command line. You can also select two panel footprint symbols to display wire connection information in a visual path on the screen.
Show terminal strip sequencing assignments

1. On the Panel Level/Sequencing toolbar, click the Show Terminal Strip Sequencing Assignments tool.

2. Select a supplementary terminal strip. The leveling assignments for the selected terminal strip display in the command line. You will see something similar to: LEV4-LEV1=001-001-001-001.

3. Press ESC to exit the command.

Show footprint sequencing assignments

1. On the Panel Level/Sequencing toolbar, click the Show Footprint Sequencing Assignments tool.

2. Select footprint to show the routing path from.

3. Select the device to show the path to. The wire connection information for the selected footprints display on the screen.

4. Press ESC to exit the command.
Swap terminal strip wire text

Use this to swap wire annotation text from one side of the terminal strip to the other. The Internal and External default definition applies when the terminal strip is initially placed.

1. On the Panel Level/Sequencing toolbar, click the Panel Terminal Strip Swap Wire Text tool.

2. Select the wire annotation text to swap.
   The wire annotation is flipped to the other side of the selected terminal strip.

3. Press ESC to exit the command.

View/edit panel component connection sequence

This tool allows you to view and rearrange the sequencing of all panel footprint components that share a common set of Level 1-4 level code assignments. This coding, when present, influences the way that AutoCAD Electrical calculates the wire connection from/to sequence. As it processes the schematic component representations and wiring, it checks for any coding found on the panel footprint and panel terminal strip representations. When present, it adjusts the from/to sequencing accordingly.

**NOTE** Leveling is required prior to assigning sequencing on the panel footprints.

Access:

On the Panel Level/Sequencing toolbar, click the View/Edit Component Sequence tool. Select a footprint with a set of level codes assigned to it.

Click Panel Layout ➤ Panel Level/Sequencing ➤ View/Edit Component Sequence. Select a footprint with a set of level codes assigned to it.
The components that have level codes matching the picked footprint are displayed in the list box in the order they will be inserted. This includes panel footprint components that might appear on drawings other than the active drawing (marked with ** in the list). To modify the order, select an entry in the list, then select Move Up or Move Down in the list. Multiple selection is supported.

**Move Up**
Moves the selected component(s) up one spot in the list.

**Move Down**
Moves the selected component(s) down one spot in the list.

**Pick Mode**
Defines the sequence by actual picks at each component. Pick near each component in the order of how you want the sequence to proceed from component to component. Picking is limited to components on the active drawing.

**Remove All**
Removes the component sequence information from all listed components.

**OK-new**
Saves the sequence assignments and writes them out to the panel footprint representations. The data is stored on attribute WDLEV or as extended entity data (xdata) on the symbol if the target attribute is not available.

**Copy level assignments**

Use this tool to define or capture a common set of level assignments for panel footprint components and then copy these 3-digit level codes to one or multiple footprints. This coding, when present, influences the way that AutoCAD Electrical calculates the wire connection from/to sequence. As it processes the schematic component representations and wiring, it checks for
any coding found on the panel footprint and panel terminal strip representations. When present, it adjusts the from/to sequencing accordingly.

Access:

On the Panel Level/Sequencing toolbar, click the Copy Level Assignments tool. Click Panel Layout ➤ Panel Level/Sequencing ➤ Copy Level Assignments.

Level 4/Level 3/Level 2/Level 1

You can type in the level assignments or select from the drawing using Pick. Categories: Level 4 (shipping split - highest level), Level 3 (unit), Level 2 (cubical), and Level 1 (pan or plate - lowest level). You can copy all level information or unselect one or more level categories prior to copying. An enabled, blank edit box indicates to erase any existing values and forces the use of the drawing-wide default value. If an edit box is grayed out, the existing value is not overwritten. Use the switches to enable or disable the edit box for each level category.

Terminal strips only

Applicable only the level assignments are to be copied to panel terminal strip representations, and the terminal strips are referenced on the schematics as well as the panel layout drawing. (In other words, they are not supplementary terminal strips that are only represented on the panel layout drawings). Select this option, and then select one of the following:

- **Disable** (Default) AutoCAD Electrical treats the terminal connections through the terminal strip normally. It uses the terminal's level category code assignments to influence how the from/to wire sequencing is calculated.

- **Enable** Processes the terminal's connection calculations last. It checks each of the strip's terminal potentials against those on any supplementary terminal strip found that is at the same level combination. For each potential match, it attempts to make the from/to calculation for that terminal to be a simple jumper assignment from
the terminal strip's terminal up to the supplementary terminal strip. When a match is not found, the from/to calculation through the terminal strip operates in a normal fashion.

**Pick**

Selects the footprint representation on the drawing to copy the leveling code from.

---

**Insert panel wiring diagram terminal strip representation**

Use this to define a rectangle as a supplementary terminal strip to be used in the wiring routing information over large control system equipment.

**Access:**

On the Panel Level/Sequencing toolbar, click the Insert Terminal Strip Representation tool.

Click Panel Layout ➤ Panel Level/Sequencing ➤ Insert Terminal Strip Representation.

**Use generic marker only**

Inserts a terminal strip with just the component's tag, description text, and so on.

**Draw shapes**

Draws a rectangle, circle, or octagon to represent the terminal strip. Text and hidden information are inserted when drawn.

**Pick "just like" footprint**

Select a terminal strip from the drawing.

**Browse**

Pick a terminal strip from a list of .DWG files on disk.
Pick a non-AutoCAD Electrical block on the drawing to be instantly changed into a smart AutoCAD Electrical block.

**Insert/edit panel level assignment: terminal strip**

Use this tool to view, assign, or edit 3-digit level codes on panel terminal strip representations. This coding, when present, influences the way that AutoCAD Electrical calculates the wire connection from/to sequence. As it processes the schematic component representations and wiring, it checks for any coding found on the panel footprint and panel terminal strip representations. If present, it adjusts the from/to sequencing accordingly.

This panel terminal strip coding can trigger supplementary or "shipping split" terminal strip references, not necessarily shown on the schematics, to be inserted into the schematic from/to wiring calculation. Specific wire connection sequencing defined directly on the schematics using the Define Wire Sequence command override this Panel level/sequencing assignment mechanism.

**Access:**

On the Panel Level/Sequencing toolbar, click the Insert/Edit Panel Level Assignment tool. Select an existing panel terminal strip representation.

Click Panel Layout ➤ Panel Level/Sequencing ➤ Insert/Edit Panel Level Assignment. Select an existing panel terminal strip representation.

**Default**

Displays a dialog box to set the drawing-wide default assignments for each of the four level categories. Values entered here become the default level assignments for all unassigned panel layout footprint component and terminal strip representations on the active drawing.

**NOTE** This dialog box can also be accessed from the Panel Configuration dialog box.

Enter the optional 3-digit level codes (for example, 001, 002, and so on) for one or more of the four level categories. For example, if everything on the active drawing is in the fourth cubical of the second unit, and all of this is
part of the first shipping split section, enter 004 for level category 2 (for example, cubical), 002 for level category 3 (for example, unit), and 001 for level category 4 (for example, highest category shipping section). With these defaults in place only the lowest level category 1 needs to be assigned on an individual panel terminal strip basis.

**Pick**

Selects a panel layout footprint symbol or terminal strip representation on the active drawing and copies its level category settings over to the currently edited component. Multiple picks are allowed with each additional pick prompting you for an overwrite or append.

**Level 4/Level 3/Level 2/Level 1 edit boxes**

Shows the valid level code or codes assigned to each of the four level categories, Level 4 = shipping split (highest level), Level 3 = unit, Level 2 = cubical, and Level 1 = pan/plate (lowest level). The level code assignments should be 3-digit values and match up with level codes of panel layout footprints whose wiring is to pass through the terminal strip. Multiple code entries are comma separated.

If codes are not defined in the edit boxes, the drawing-wide default values displayed in the left-hand column of uneditable edit boxes are used (if defined).

**Level code/location**

Controls whether the Level 1 edit box displays the 3-digit level code assignments or the device’s LOC attribute value. This location display mode is for display purpose only; the underlying 3-digit Level 1 code is always used for the sorting installation.

**Level 4/Level 3/Level 2/Level 1 radio buttons**

Selects the level category at which the terminal strip representation operates. The categories are Level 4 = shipping split (highest level), Level 3 = unit, Level 2 = cubical, and Level 1 = pan/plate (lowest level). The level code assignment codes should be 3-digit values and match up with level codes of panel layout footprints whose wiring is to pass through the terminal strip. Multiple code entries are comma separated.
**Jumper Directly to Supplementary Terminal Strip: Enable/Disable**

This option is applicable to the terminal strip only if it is referenced on the schematics as well as the panel layout drawing (that is, it is not a supplementary terminal strip that only is represented on the panel layout drawings).

**Disable**

AutoCAD Electrical treats the terminal connections through this terminal strip normally. It uses the terminal's level category code assignments to influence how the from/to wire sequencing is calculated.

**Enable**

AutoCAD Electrical saves this terminal's connection calculations until last. It then checks each of the strip's terminal "potentials" against those on any supplementary terminal strip found that is at the "same" level combination. For each potential match, it attempts to make the from/to calculation for that terminal to be a simple jumper assignment from the terminal strip's terminal up to the supplementary terminal strip. When no match is found, the from/to calculation through the terminal strip is done in a normal fashion.

**Connection left/right**

Two-character code that controls whether the Level 1 assignments show "Panel Terminal Strip Report" connection information on the internal or external side of the terminal block. The first character represents the left side of the terminal strip and the second character represents the right side.

- **Internal (I)**
  
  Refers to the side of the terminal that "receives" wire connections from panel footprint components marked with the target Level 1 code.

- **External (E)**
  
  Refers to the side of the terminal strip with wiring going off to other Level 1 through 4 codes.

- **Both (B)**
  
  Means that both internal and external wiring is on the same side of the terminal strip with the other side empty, code of 'x'. (for example, for customer connections).

For example, a single Level 1 terminal strip marked with Level 1 code "001,002,004" runs between three back plates with mounted components, two on the left (footprint Level 1 codes of '001' and '002') and one on the
right (footprint Level 1 codes "004"). If the terminal strip is marks as follows: "IE 001," "IE 002," and "EI 004," then wiring leaving the left-hand back plates attach to the terminal strip on the left-hand side ("L" in the first character position) and wiring leaving the right-hand plate attaches to the right side of the terminal strip ("R" in the second character position).

**Maximum wires per terminal connection**

Defines the number of wires (either 1 or 2 per side) allowed per terminal connection in the Panel Terminal Strip report.

**Maximum terminals**

Defines the total number of terminal blocks on the entire supplementary terminal strip for the Panel Terminal Strip report. A blank value indicates that the terminal strip length is undefined.

**Maximum/minimum wire size**

Determines a range of wire sizes allowable to be connected to the supplementary terminal strip. Wires that are outside the terminal strip's allowed range bypass it. A blank value in both maximum and minimum edit boxes indicates that this check is not performed.

A connected wire's size is extracted from the wire line's layer name. AutoCAD Electrical simply parses the wire's layer name for the first numeric value found within the name. For example, a wire layer name based on metric wire sizes of "WHITE-2.5MM^2" yields a size value of "2.5". A wire layer that might be set up for AWG wire sizes, "RED_14_XHW", indicates a size value of "14".

For example, the project used AWG-style wire sizes with layer names to match (for example, BLK_12_THHN and RED_16_MTW). The terminal block accepts wire sizes from thin AWG 24 through heavy AWG 12. Set up the maximum edit box to read "12" and the minimum edit box to read "24."

**Allowed level to level connection direction**

Select from:

| All | Wiring from 3-digit code assignments both higher and lower than the terminal's assigned operating level code (the "Level 1-4 radio buttons" described above) can pass freely through this terminal strip. |
Higher only
Wiring from 3-digit code assignments higher than this terminal's assigned operating level code can pass through this terminal strip.

Lower only
Wiring from 3-digit code assignments lower than this terminal's assigned operating level code can pass through this terminal strip.

Example: the middle "002" shipping section has a Level 4 terminal strip at the left-hand end and another at the right-hand end. Wiring from anywhere in the first "001" shipping section needs to come in through the left hand terminal strip. It is marked "Lower only". Wiring going on to the next shipping section "003" needs to pass through the right-hand terminal strip, marked "Higher only."

Multiple terminal strip usage priority
Provides priority for wiring information to be applied to the supplementary terminal strip. If there can be multiple, valid terminal strip paths that match up with the level code combination of a given from/to inter-connection, the path chosen is influenced by this priority setting.

Level code edit: boundary box
Use this tool to view or edit 3-digit level codes for boundary boxes. Devices placed within the boundary box take on the boundary's level codes. The dialog box lists the number of device footprints found within the boundary and the number of devices that currently do not match the boundary default.

Access:
On the Panel Level/Sequencing toolbar, click the arrow on the Insert/Edit Panel Level Assignment tool to access the Insert/Edit Boundary Box Assignment tool. Select a boundary box.
Click Panel Layout ➤ Panel Level/Sequencing ➤ Insert/Edit Boundary Box Assignment. Select a boundary box.

Default
Sets the drawing-wide defaults to use for the wire level codes. This references the panel drawing files default leveling assignment values defined in the Panel Configuration dialog box. Enter op-
tional 3-digit level codes. These are applied as defaults when codes are not defined on footprint devices.

**Level 4/Level 3/Level 2/Level 1**

Specifies which level codes to use in the sequencing. Level 4 = ship split, Level 3 = unit, Level 2 = cubical, and Level 1 = pan/plate. The leveling assignment codes should be 3-digit values since they are used in for sorting component data in the project database. If codes are not defined in the edit boxes, the drawing-wide default values are used.

**Level code/location**

Indicates whether the level codes are displayed in the Level 1 input field or in the location code of the device defined on the schematic.

**Pick**

Selects another physical footprint symbol on the drawing to copy the level codes from.

---

**Insert/edit panel level assignment: component**

Use this tool to view, assign, or edit 3-digit level codes and 4-digit sequence codes on panel footprint components. This coding, when present, can influence the way that AutoCAD Electrical calculates the wire connection from/to sequence. As it processes the schematic component representations and wiring, it checks for any coding found on the panel footprint and panel terminal strip representations. If present, it adjusts the from/to sequencing accordingly.

This panel level assignment coding also can trigger supplementary or "shipping split" terminal strip references, not necessarily shown on the schematics, to be inserted into the schematic from/to wiring calculation. Specific wire connection sequencing defined directly on the schematics using the Define
Wire Sequence command overrides this Panel level/sequencing assignment mechanism.

Access:

On the Panel Level/Sequencing toolbar, click the Insert/Edit Panel Level Assignment tool. Select an existing footprint component.

Click Panel Layout ➤ Panel Level/Sequencing ➤ Insert/Edit Panel Level Assignment. Select an existing footprint component.

Default

Displays a dialog box to set the drawing-wide default assignments for each of the four level categories. Values entered here become the default level assignments for all unassigned panel layout footprint component and terminal strip representations on the active drawing.

NOTE This dialog box can also be accessed from the Panel Configuration dialog box.

Enter the optional 3-digit level codes (for example, 001, 002, and so on) for one or more of the four level categories. For example, if everything on the active drawing is in the fourth cubical of the second unit, and all of this is part of the first shipping split section, enter 004 for level category 2 (for example, cubical), 002 for level category 3 (for example, unit), and 001 for level category 4 (for example, highest category shipping section). With these defaults in place only the lowest level category 1 needs to be assigned on an individual panel terminal strip basis.

Level 4/Level 3/Level 2/Level 1

Shows the level code assigned to each of the four level categories, Level 4 = shipping split (highest level), Level 3 = unit, Level 2 = cubical, and Level 1 = pan/plate (lowest level). The level code assignments should be 3-digit values and chosen with the idea that their sort order on a per-level category basis influences the actual inter-level wire sequence calculation.

The List button for each level category displays a dialog box showing the level combinations that have been assigned so far. Picking from this dialog box assigns those same level category assignments to the currently edited panel layout footprint. If codes are not defined in the edit boxes, the drawing-wide default values displayed in the left-hand column of non-editable edit boxes are used (if defined).
Level code/location

Controls whether the Level 1 edit box displays the 3-digit level code assignment or the device's LOC attribute value. This location display mode is for display purpose only. The underlying 3-digit Level 1 code is always used for the sorting installation.

Pick

Selects another panel layout footprint symbol or terminal strip representation on the active drawing and copies its settings over to the currently edited component.

Bypass terminal strips

Controls this component's wiring bypass of one or more level categories of supplementary terminal strips. For example, special signal wiring passes from the currently edited component to some other components in a different cubical/unit/ship split section. To disable any supplementary terminal strip connections that might automatically be included in the from/to calculations between this edited component and other connected components identified in other level assignment combinations, switch all four bypass options on.

Sequence on Level 1

Influences the wire connection sequencing of the schematic components whose physical footprints share the same combination of four level category assignments. The sequence assignment is a 4-digit number (for example, 0001, 0002, and so on) and is sorted to give a default wire connection sequence.

For example, all of the pushbutton and pilot light footprint representations on a door layout carry the same Level 1 through Level 4 category code assignments, but carry sequence value assignments that increase from left to right and top to bottom on the layout. This means that AutoCAD Electrical calculates the from/to connections for a common wire starting at the top left and leaving the door at the component located in the bottom right-hand corner.
Pick list for panel terminal strip report/graphical report

Use this to select a supplementary terminal strip representation to display wiring information inside of a report generator dialog, and subsequently insert a terminal strip layout drawing.

Access:

On the Panel Level/Sequencing toolbar, click the Panel Terminal Strip Report tool.

Click Panel Layout ➤ Panel Level/Sequencing ➤ Panel Terminal Strip Report.

All supplementary terminal strips found in the active drawing display in the dialog box. Select from the list or click Pick to select the terminal strip from the drawing. Once the terminal strip is selected (either from the list or the active drawing), the report displays in the Report Generator dialog box.

In the Report Generator dialog box, click Insert as Terminal Strip to define a graphical representation of the terminal strip for placement on the active drawing file.

Panel terminal strip graphical report parameters

Access:

On the Panel Level/Sequencing toolbar, click the Panel Terminal Strip Report tool. Select a terminal strip and click OK. In the Report Generator dialog box, click Insert as Terminal Strip.

Click Panel Layout ➤ Panel Level/Sequencing ➤ Panel Terminal Strip Report.
Select a terminal strip and click OK. In the Report Generator dialog box, click Insert as Terminal Strip.

Text height

Defines the height of the terminal strip text.
**Terminal box width**  Defines the width of the boxes that make up the terminal strip.

**Terminal box height**  Defines the height of the boxes that make up the terminal strip.

**Group the terminals/text**  Inserts the graphical report as a set of grouped objects. You can select any member of the group or select the group as a whole. You can toggle group selection on and off by pressing CTRL+H or SHIFT+CTRL+A.

**Orientation**  Specifies the orientation for the terminal strip: vertical, left to right, or right to left.

**Wire connection format**  Each format uses parameters that are then replaced with the specific wire connection information. AutoCAD Electrical provides a predefined default format for you to select from the button. You can also enter your own format using the replaceable parameters (page 126).

**Add spare terminals**  Displays extra terminals at the bottom of the graphical representation.
Conduit Tools

In this chapter

- Overview of conduit tools
- Overview of conduit marker support files
- Generate a conduit marker report
- Generate a conduit routing report
Overview of conduit tools

AutoCAD Electrical provides a set of utilities to help you label, size, and report on conduits. A conduit can be represented by a line or a poly line and by itself does not carry any intelligence. However, you may insert a conduit marker symbol and associate it to a conduit. The conduit marker symbol then carries wire information intelligence pulled from the AutoCAD Electrical drawings.

The first time (per AutoCAD session) that you insert a conduit marker you will have to instruct AutoCAD Electrical to read the wire information. You may read the wire information from multiple drawings within the project, the current drawing, or read the existing WFRM2ALL table in the scratch database.

**NOTE** To use any of the conduit related utilities you will need to turn on the Conduit toolbar by selecting View ➤ Toolbars. Select Electrical as the menu group and click the ACE: Conduit Marker checkbox.

The conduit marker is a block inserted to add intelligence to a line or pline representing a conduit on a layout drawing. There are 4 blocks, called WWAYT, WWAYB, WWAYL, and WWAYR. The blocks are identical except for the insert point, T=top, B=bottom, L=left, R=right. The program will pick which block based on the leader drawn.

**Conduit Marker Intelligence**

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C_TAG</td>
<td>Each marker will receive a unique tag number.Use Setup to define the next tag.</td>
</tr>
<tr>
<td>C_SIZE</td>
<td>Conduit size, i.e. 3/4”</td>
</tr>
<tr>
<td>DESC1</td>
<td>Optional description line 1</td>
</tr>
<tr>
<td>DESC2</td>
<td>Optional description line 2</td>
</tr>
<tr>
<td>WIREINFO#</td>
<td>Wire information for each wire included in the conduit. Wire# ; Wire Layer ; Wire Description ; Wire Size</td>
</tr>
<tr>
<td>W_SPARES#</td>
<td>Spare wires defined. Wire Description ; Count</td>
</tr>
</tbody>
</table>

1110 | Chapter 16  Conduit Tools
**Insert conduit markers**

**Use the Conduit Marker (Pick) tool**

1. Click the Conduit Marker (Pick) tool on the Conduit Marker toolbar.
2. Type S and press Enter to setup the conduit marker.
3. Specify the text for the marker tag and the scale for the marker block. Click OK.
4. Select the line that represents the conduit for the marker on the drawing.
5. Click points to define the leader and press Enter.
6. Select the conduit tag and press Enter.
7. Specify the conduit tag, catalog information, conduit size, description, or included wires in the Insert or Edit Conduit/WirewayLabel dialog box.
   The conduit marker symbol will carry wire information intelligence pulled from the AutoCAD Electrical drawings.
8. Click OK.

**Use the Conduit Marker (From/To List) tool**

1. Click the Conduit Marker (From/To List) tool on the Conduit Marker toolbar.
2. Select the line that represents the conduit for the marker on the drawing.
3. Click points to define the leader and click Enter or the right mouse button.
4. Select the location codes for the conduit marker and click OK. These build the From/To combination for the Wire Run From/To Report.
5. Specify the conduit tag, catalog information, conduit size, description, or included wires in the Insert or Edit Con-
duit/WirewayLabel dialog box.
The conduit marker symbol will carry wire information intelligence pulled from the AutoCAD Electrical drawings.

6 Click OK.

**Edit all conduit marker information**

Once your conduit marker is inserted, you may need to supply some additional information for the marker. You can add the information at the time you insert the marker or select the Edit Conduit Marker on the conduit toolbar after it is inserted.

1 Click the Edit Conduit Marker tool on the Conduit Marker toolbar.
2 Pick the conduit to edit.
3 Make any changes to the conduit tag, catalog information, conduit size, description, or included wires in the Insert or Edit Conduit/Wireway Label dialog box.
4 Click OK.

**Insert or edit conduit/wire way label**

There are two ways to insert a conduit marker depending on where you want to pick the wire information from. You can get the wire information from an actual device on your drawing represented by either a schematic symbol or a panel layout footprint symbol. You may also pull the wire information out of a wire from/to report based on your schematics. Finally, you can extract the information from multiple conduit markers to combine together into a separate conduit marker.

**Access:**

Click the Conduit Marker (Pick) tool or the Edit Conduit Marker tool on the Conduit Marker toolbar. Either select the line that represents the conduit, click to define the leader, and then select layout devices or branching conduit markers and press Enter; or click on an existing conduit marker.
Access:

From the Panel Layout menu, select Conduit Marker Tools ➤ Conduit Marker (Pick) or Edit Conduit Marker. Either select the line that represents the conduit, click to define the leader, and then select layout devices or branching conduit markers and press Enter; or click on an existing conduit marker.

Conduit Tag

AutoCAD Electrical selects a default conduit tag which can be overridden at any time. Click Drawing to use a tag used for similar conduits in the active drawing or click Project to use a tag used for similar conduits in the project. See Conduit Marker Setup (page 1115) to define the default format for the conduit tags.

Size

The conduit size can be selected from the list of available sizes or entered in the box. To make this a little easier, AutoCAD Electrical can calculate the percentage full for each conduit size available. To do this, AutoCAD Electrical needs 2 support files (page 1116) containing wire size information and conduit size information. If there isn’t a .WW1 file or if the wire sizes aren’t in the file, the calculations are not made.

Catalog Area

Assign catalog information to the conduit that will be extracted into a bill of materials report. You can do a drawing-wide or project-wide listing of similar conduits with their catalog assignments.

Find

Scans each drawing for the target conduit type and returns a list of what was found. You can make your catalog assignment by selecting from the list.

Lookup

Opens the conduit's catalog database from which you can manually enter or select the Manufacturer or Catalog values. Search the database for a specific catalog item to assign to the selected conduit. Database queries are set up in the 3 lists across the top of the dialog with the database hits listed in the dialog's main window.
| **Previous** | Scans the previous project to find an instance of the selected conduit and returns the conduit values. You can then make your catalog assignment by picking from the dialog list. |
| **Drawing** | Lists the part numbers used for similar conduits in the current drawing. |
| **Project** | Lists the part numbers used for similar conduits in the project. You can search in the active project, another project, or in an external file.  
- **Active project**: All of the drawings in the current project are scanned and the results are listed in a sub-dialog box. Select from the list to assign your new conduit with a catalog number that is consistent with other similar conduits in the project.  
- **Other project**: Scans each listed drawing in a previous project for the target component type and returns the catalog information in a sub-dialog box. Make your catalog assignment by picking from the dialog list.  
- **External file**: You can pull catalog assignments from a generic ASCII file created by a word processor or output from a spreadsheet or database program. A dialog box displays the contents of the selected text file. Find and highlight the desired entry. AutoCAD Electrical reads the line of text from the file and breaks it into its component parts. These are displayed in the left-hand dialog list. For each relevant item, highlight it and then pick the appropriate category button in the center column. The highlighted item is transferred to the corresponding category (and then to the Insert/Edit dialog box once OK is clicked). |
| **Multiple Catalog** | Inserts or edits extra catalog part numbers onto the selected conduit. You can add up to 10 part numbers to any conduit. These multiple BOM part numbers appear as sub-assembly part numbers to the main catalog part number in the various BOM and conduit reports. |
| **Catalog Check** | Displays what the selected item will look like in a Bill of Material template. |

**Description**

Optional description lines.
**Wires to include in conduit/wireway**

Define which wires are to be included in this conduit. Select from the available list in the upper box and add to the included list in the lower box. At any time you can pick from a from/to list by clicking Add Wires from List, or you can add wires from additional devices by clicking Pick Devices.

- **Add Wires from List**: Adds wires by picking from a from/to list
- **Pick Devices**: Adds wires from additional devices
- **Spares**: Defines the spares to include in the conduit
- **Sort**: Sorts the list of conduit wires using an alphanumeric sort.

**Report/Print**

Opens the Report Generator dialog box for running a Conduit marker report.

**Conduit marker setup**

The conduit marker is a block inserted to add intelligence to a line or pline representing a conduit on a layout drawing. There are 4 blocks, called WWAYT, WWAYB, WWAYL, and WWAYR. The blocks are identical except for the insert point, T=top, B=bottom, L=left, R=right. The program will pick which block based on the leader drawn.

**Access:**

- Click the Conduit Marker (Pick) tool on the Conduit Marker toolbar. Type S and press Enter.
- From the Panel Layout menu, select Conduit Marker Tools ➤ Conduit Marker (Pick). Type S and press Enter.

- **Conduit tag**: Specifies the marker tag. Each conduit marker will receive a unique tag. Enter the text for the next tag. Each successive tag will be incremented from the previous tag.

- **Scale**: Defines the scale to insert the conduit marker block.

**Add spare wires**

Overview of conduit tools | 1115
This defines the spare wires to include in your conduit.

Access:

Click the Conduit Marker (Pick) tool on the Conduit Marker toolbar. From the Panel Layout menu, select Conduit Marker Tools ➤ Conduit Marker (Pick). Click the Spares button on the Insert/Edit Conduit/Wireway Label dialog box.

- Select wires from
  Lists the spare wires that can be added to the conduit. The list is built from the .WDW support file.

- Type it
  If the wire type is not listed, type your spare wire description in the edit box.

- Wires to Add
  Lists the wires that will be added to the conduit.

- Count
  Specifies the number of wires to add to the conduit. Adjust your quantity by typing the number or by selecting the <or > buttons.

- Update Quantity
  If you type the quantity, you may need to select this button to see the new quantity in the list.

Overview of conduit marker support files

AutoCAD Electrical has a couple of support files containing wire size information and conduit size information: the .wdw file and the .ww1 file. These files are simple text files that can be edited with any text editor such as WordPad.

.WDW file

The .WDW file contains the wire information. You may have a different file for each project. Simply create a projname.wdw file and put in the same directory as your project file (.WDP). If you want to use the same file for all projects, then create or modify the DEFAULT.WDW file in the USER folder (in the Project Manager, right-click the project name and select Settings to find the full path).
There should be a separate line in the file for each AutoCAD Electrical wire layer. The line has three fields, each field separated by a semi-colon. The first field is the actual wire layer name used on the drawing. The second field is the wire layer description. This description is used in the AutoCAD Electrical Wire Color/Gauge Label tool. The third field is the wire size.

For example, if you have a wire layer called 14_RED_THHN and you want the wire color/gauge label to read #14AWG RED for this layer, and the wire itself has a wire diameter of 0.0087, the line in the .WDW file would read:

```
14_RED_THHN;#14AWGRED;0.0087
```

**.WW1 file**

The .WW1 file contains the conduit information. You may have a different file for each project. Simply create a projname.ww1 file and put in the same directory as your project file (.WDP). If you want to use the same file for all projects, then create or modify the DEFAULT.WW1 file in the USER folder (in the Project Manager, right-click the project name and select Settings to find the full path).

There should be a separate line in the file for each conduit. Each line has two fields. The first field is the conduit size that will be shown in the Conduit Marker dialog box. The second field is the conduit size, i.e. the inner cross-sectional area of the conduit, so AutoCAD Electrical can determine how full the conduit is once you add up all the wire diameter sizes from the wires (pulled from the .WDW file). For example, if you have a 1" conduit with an inner diameter of 0.8 resulting in a cross-sectional area of 0.5024, the line in the .WW1 file would read:

```
1";0.5024
```

**NOTE** If you create a .WW1 file AutoCAD Electrical will show only the conduits listed in this file in the Conduit Marker dialog box.
Generate a conduit marker report

You must have at least one conduit marker with wire connections on your drawing in order to run this report.

1. Click the Conduit Report tool on the Conduit Marker toolbar.

2. Specify whether to run the report across selected drawings from the project, the current drawing, or just selected conduit markers.
   You can specify to display the last report run from this dialog box instead of running a new report by clicking the Redisplay Last Run button.

3. Click OK.

4. Select the drawings or conduit markers to process (depending on whether the report is being run across the projector selected markers).

5. In the Report Generator dialog box, make any changes to the report format. You can specify to add the time and date, title line, project lines, column labels, page numbers, and blank spaces between report entities.

6. (Optional) Click Edit Mode to edit the report.

7. If the report is formatted correctly specify to print the report, put it on the drawing, or save the report to a file.

Conduit marker report

This utility extracts conduit marker information into a report. Extractable conduit marker symbols are named "WAY*". A conduit can be represented by a line or a polyline and by itself does not carry any intelligence. However, you can insert a conduit marker symbol and associate it to a conduit.
conduit marker symbol then carries wire information intelligence pulled from
the AutoCAD Electrical drawings.

Access:

On the Conduit Marker toolbar, click the arrow on the Conduit Reports tool to
access the Conduit Marker Report tool.

From the Panel Layout menu, click Conduit Marker Tools ➤ Conduit Marker
Report.

Decide if you want to run the report across selected drawings from the project,
the active drawing, or just selected conduit markers.
**Generate a conduit routing report**

You must have at least one conduit marker with wire connections on your drawing in order to run this report.

1. Click the arrow on the Conduit Reports tool on the Conduit Marker toolbar to access the Wire/Conduit Routing Report tool.

2. Click the Wire/Conduit Routing Report tool.

3. Specify whether to run the report across selected drawings from the project, the current drawing, or just selected conduit markers.
   You can specify to display the last report run from this dialog box instead of running a new report by clicking the Redisplay Last Run button.

4. Click OK.

5. Select the drawings or conduit markers to process (depending on whether the report is being run across the project or selected markers).

6. In the Report Generator dialog box, make any changes to the report format. You can specify to add the time and date, title line, project lines, column labels, page numbers, and blank spaces between report entities.

7. (Optional) Click Edit Mode to edit the report.

8. If the report is formatted correctly specify to print the report, put it on the drawing, or save the report to a file.

**Wire/conduit routing report**

AutoCAD Electrical provides a set of utilities to help you label, size, and report on conduits. A conduit can be represented by a line or a poly line and by itself does not carry any intelligence. However, you can insert a conduit marker.
symbol and associate it to a conduit. The conduit marker symbol then carries wire information intelligence pulled from the AutoCAD Electrical drawings.

Access:

On the Conduit Marker toolbar, click the arrow on the Conduit Reports tool to access the Wire/Conduit Routing Report tool.

From the Panel Layout menu, select Conduit Marker Tools ➤ Wire/Conduit Routing Report.

Decide if you want to run the report across selected drawings from the project, the active drawing, or just selected conduit markers.
In this chapter

- Convert promis.e drawing files to AutoCAD Electrical
- Convert non-AutoCAD Electrical blocks
- Convert text to an attribute
- Convert Arrows
- Overview of ECDS legacy conversion
- Tagging and Linking Tools
Convert promis.e drawing files to AutoCAD Electrical

The promis.e Conversion tool converts drawing files from promis.e to AutoCAD Electrical, while maintaining graphical elements. The drawing file data is converted into a format that can be edited and maintained in AutoCAD Electrical. You can convert a single drawing file or an entire project.

A log file is created in the same location as the drawing file or project to display all modifications. The log file name is either [drawing file name]_cnv.log or [project name]_cnv.log.

The conversion does the following:

- Inserts the WD_M block if it does not exist in the drawing.
- Searches for Installation/Location drawing-wide defaults.
- Searches for blocks, cross-reference tables and field boxes.
- Extracts a list of cross-reference symbols.
- Processes cable marker symbols, PLC modules, line entities, wire connection point, cross-reference tables, and block inserts.
- Copies footprint P_TAG1 values to the associated nameplate.
- Renames terminal block names.
- Cleans up cross-reference inserts.
- Flips ladder line references to AutoCAD Electrical “smart.”
- Processes wire numbers.
- Inserts a copy of the WD_PNLM block at 0,0.

NOTE You cannot see the command window messages during conversion unless you turn on the command trace mode. (Select Projects ➤ Extras ➤ Command Trace Mode ➤ Command Trace On.)

1124 | Chapter 17  Conversion Tools
Convert promis.e drawings to AutoCAD Electrical drawings

Use this to convert promis.e drawings to AutoCAD Electrical "smart" drawings.

1. On the Conversion toolbar, click the promis.e Conversion tool.

2. Select to convert the active drawing, multiple drawings in the active project, or an entire promis.e project.

3. Click OK.

4. If you selected Convert Multiple Drawings, Active Project select the drawings to process and click OK.

5. If you selected Convert promis.e Project select the promis.e project mapping file and click Open. Select the drawings to process and click OK. In the Convert promis.e Project dialog box:
   - Select the project to convert and click Open.
   - Select the installation codes to convert.
   - (Optional) Make any changes to project, installation, and drawing naming.
   - (Optional) Make any changes to the conversion setup, or symbol libraries.
     Make sure the specified symbol library path contains the wd_m.dwg block necessary for the conversion.
   - Enter the AutoCAD Electrical project path into the text box.
   - Click OK.

**NOTE** If the project file already exists and is marked active, the conversion cannot finish. You must have another project open so AutoCAD Electrical can temporarily activate the other project, delete the active project (the one being overwritten), write the new .wdp file and reactivate the project.

promis.e conversion

This tool converts drawing files from promis.e to AutoCAD Electrical. It examines the current symbol attributes on the drawing and maps them to the
equivalent AutoCAD Electrical attribute to make them AutoCAD Electrical "smart."

Access:

Click the Convert promis.e Drawings tool on the Conversion toolbar.

Click Projects ➤ Conversion Tools ➤ promis.e Conversion.

**Convert Active Drawing Only**

Converts only the open and active drawing file from promis.e format to AutoCAD Electrical. Drawing files are not renamed or added to the project. This option is unavailable if the active drawing is unnamed.

**Convert Multiple Drawings, Active Project**

Converts drawing files that are already associated with the active project.

**Convert promis.e Project**

Selects an existing promis.e project and uses your AutoCAD Electrical project definitions to rename the folders and files to adhere to the names defined inside of promis.e. The drawing files are found in the promis.e structure.

**Convert promis.e project**

This defines the conversion process from promis.e to AutoCAD Electrical. Once you click OK, this creates AutoCAD Electrical project definition file and folders, and then copies the drawing files into the new folders.

**NOTE** You cannot see the command window messages during conversion unless you turn on the command trace mode (select Projects ➤ Extras ➤ Command Trace Mode ➤ Command Trace On.)

Access:

Click the Convert promis.e Drawings tool on the Conversion toolbar. Select Convert promis.e Project and click OK. Select the promis.e mapping file and click Open.

Click Projects ➤ Conversion Tools ➤ promis.e Conversion. Select Convert promis.e Project and click OK. Select the promis.e mapping file and click Open.
promis.e Projects

Project Names
Lists the promis.e projects defined in the project mapping file.

Installation Codes
Lists the installation codes defined in the project installation mapping file and the number of selected drawings.

The drawing count shows the number of drawings in the selected promis.e Project.

AutoCAD Electrical Project

Naming (Project, Installation, Drawing)
Uses replaceable parameters to name projects (%P), installations (%I), drawing file names (%S), and folders. Replaceable parameters take on the values from the promis.e mapping files, however you can add additional characters.

Conversion Setup
Specifies pre- and post-processing script files to run against the entire project, and the AutoCAD Electrical support files to use (Default_wdtitle.wdl and Default.wdt). After you select the desired support file, it is renamed and placed in the same folder as the new project definition file (*.WDP). You also have the option to save the command line error message to a log file.

Symbol Libraries
Opens the Project Properties ➤ Project Settings dialog box for selecting library search paths and icon menu files for the new project.

Conversion destination (base folder)
Specifies the AutoCAD Electrical project path. This is where the new project folder and drawing files are located. A path must be specified before the conversion can take place.
Convert non-AutoCAD Electrical blocks

This utility takes non-AutoCAD Electrical blocks or graphics representing a symbol and replaces it with an AutoCAD Electrical block and transfers the attribute or text values to this new AutoCAD Electrical block.

1 Click the Convert to Schematic Component tool on the Conversion toolbar.
2 Pick your non-AutoCAD Electrical block containing attributes and/or text entities.
3 Pick an AutoCAD Electrical block from the Insert Component dialog box to use in its place.
4 Specify the insertion point.
5 From the Component Parent/Stand-Alone Annotation dialog box, assign text/attribute values to AutoCAD Electrical attribute names and click Done.
If your non-AutoCAD Electrical block has attributes, or you picked some text entities, the dialog box includes buttons to make it easier to assign your values to AutoCAD Electrical attributes.

Finish mapping values from non-AutoCAD Electrical blocks

This allows you to continue what you started with the Convert to Schematic Component tool. Use this if you did not finish mapping values from your non-AutoCAD Electrical block.

1 Click the Map Attributes From Old To New tool on the Conversion toolbar.
2 Select the block for additional attributes.
3 Optionally, select any non-AutoCAD Electrical block or text objects to map values to the AutoCAD Electrical attributes and click Done.
**Component annotation**

These utilities may take non-AutoCAD Electrical blocks or graphics representing a symbol, replace it with an AutoCAD Electrical block and transfer the attribute or text values to this new AutoCAD Electrical block.

**Access:**

- On the Conversion toolbar, click the Convert to Schematic Component tool.
- From the Projects menu, select Conversion Tools ➤ Convert Drawing ➤ Convert to Schematic Component.
- On the Conversion toolbar, click the Map Attributes from Old to New tool.
- From the Projects menu, select Conversion Tools ➤ Convert Drawing ➤ Map Attributes from Old to New.

The left-side of the dialog box lists the text or attributes to map to an AutoCAD Electrical block while the right-side of the dialog box lists valid attribute fields to fill in.

**NOTE** Your options may differ depending on how you accessed the dialog box.

<table>
<thead>
<tr>
<th>Text value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(available only if you select non-AutoCAD Electrical elements) Lists the available text values to assign to the attributes. All AutoCAD Electrical attributes for the block inserted are displayed in the Text Value list (if there is a block to map with existing attribute values).</td>
<td></td>
</tr>
<tr>
<td>=</td>
<td>(available only if you select non-AutoCAD Electrical elements) Transfers the text value to the selected attribute. Select a value from the list at the left and then pick the “=” button next to the desired AutoCAD Electrical attribute.</td>
</tr>
<tr>
<td>+</td>
<td>(available only if you select non-AutoCAD Electrical elements) Appends the text value to the end of the current value for the selected attribute. Select a value from the list at the left and then pick the “+” button next to the target AutoCAD Electrical attribute.</td>
</tr>
</tbody>
</table>
Pick  Picks text or attribute objects from the drawing to assign to the AutoCAD Electrical attribute.

Hide  Makes the AutoCAD Electrical attribute visible or invisible.

Drawing/Project  Lists the installation, location, mount, and group annotations already used on the current drawing or project.

Miscellaneous, Ratings, Positions, Pins  Opens sub-dialog boxes for changing the attribute list to reflect ratings, pins, and so on.

Delete original non-AutoCAD Electrical block  Deletes a non-AutoCAD Electrical block once you've mapped all of the attributes.

Delete picked text objects  Replaces the picked text with the new AutoCAD Electrical attribute. To leave the selected text as is, then make sure you turn this option off.

Zoom window  Defines an area of the drawing to fill the graphics window. Click to define the graphics window; the image is then zoomed to the area that you defined in the window.

Zoom extents  Zooms the selected block to the size of the graphics window.

Zoom in  Increases the magnification of the view so the blocks appear larger.

Zoom out  Decreases the magnification of the view so the blocks appear smaller.

Pan  Shifts the location of the view without changing the magnification. Use the Pan button to move the view in the graphics window in any direction planar to the screen.
Convert text to an attribute

This tool converts a text object into an attribute definition. The original text string becomes the default value of the attribute. For example, if you convert the text “120 VOLTS AC” to an attribute definition with a tag name of “RATING1”, the original text becomes the attribute’s default value.

1 On the Conversion toolbar, click the Convert Text to Attribute Definition tool.
2 Select the text entity to convert.
3 Define the attribute tag name. Enter a value or click the arrows to increment or decrement the displayed attribute tag name (for example, click the > button to increment the tag name “RATING5” to “RATING6”).
4 Click OK.

Convert text to attribute definition

Converts a text object (that is not associated to a block) into an attribute definition. You can convert an attribute definition on a library symbol that becomes an attribute when the symbol drawing is inserted as a block into another drawing. For example, if you convert the text “120 VOLTS AC” to an attribute definition with a tag name of “RATING1”, the original text becomes the attribute’s default value.

Access:

On the Conversion toolbar, click the Convert Text to Attribute Definition tool.
From the Components menu, select Attributes ➤ Convert Text to Attribute Definition.

Attribute tag name

Specifies the attribute tag to assign to the selected text. Enter a value or click the arrows to increment or decrement the displayed attribute tag name (for example, click the > button to increment the tag name “RATING5” to “RATING6”).
Convert non-AutoCAD Electrical arrows

Use the Convert Block to Source Arrow tool to replace a non-AutoCAD Electrical source arrow with a smart AutoCAD Electrical source arrow and map the information to the new AutoCAD Electrical source.

Use the Convert Block to Destination Arrow tool to replace a non-AutoCAD Electrical destination arrow with a smart AutoCAD Electrical destination arrow.
**Convert a block to a source arrow**

1. Click the Convert Block To Source Arrow tool on the Conversion toolbar.
2. Select your non-AutoCAD Electrical source block and/or any text related to it that you might want to map to the new AutoCAD Electrical source.
3. Select the wire end for the source arrow.
4. Define the Source Signal Code and click OK.
5. Define attribute values.

**Convert a block to a destination arrow**

1. Click the Convert Block To Destination Arrow tool on the Conversion toolbar.
2. Select your non-AutoCAD Electrical destination block and/or any text related to it that you might want to map to the new AutoCAD Electrical destination.
3. Select the wire end for the destination arrow.
4. Define the Destination Signal Code and click OK.
5. Define attribute values.

**Overview of ECDS legacy conversion**

For this conversion to be effective, AutoCAD Electrical must have information to intelligently swap AutoCAD Electrical type blocks with the blocks used on your ECDS drawings. It also must know how to map the values carried on each attribute on the blocks. This information is all supplied in an Access database file called WDVIACMP.MDB.

**COMPSWSAP table**

The COMPSWAP table tells AutoCAD Electrical how to swap blocks. It is simply a list of the blocks used on your ECDS drawings with a corresponding list of
AutoCAD Electrical blocks. When the converter is run, AutoCAD Electrical looks for the block in the ECDS list and if it finds it, swaps it out for the block in the AutoCAD Electrical list.

If the origin for the AutoCAD Electrical block is different than the ECDS block, enter an XY Offset. If you need to use multiple AutoCAD Electrical blocks to "build up" the ECDS symbol, use an available AutoCAD Electrical command $C=wd_via_cv_3unit, followed by the individual block names.

**ATTRMAP table**

The ATTRMAP table tells AutoCAD Electrical how to map the information held on the attributes within each block. For each attribute used on the ECDS blocks, enter the AutoCAD Electrical attribute name in the next column to create the attribute map. Then when AutoCAD Electrical swaps out the blocks, the information carried on the individual attributes are not lost.

Notice the line mapping the attribute DESCRIPTION to DESC#. If you have blocks which contain multiple copies of the same attribute, for example, DESCRIPTION, you can map these to separate AutoCAD Electrical attributes such as DESC1, DESC2, DESC3. The "#" in the AutoCAD Electrical Attribute field, indicates that each time a DESCRIPTION attribute is found within a block, the AutoCAD Electrical attribute name should be incremented by 1 (starting with 1).

**IOATTRMAP table**

The IOATTRMAP table is the same as the ATTRMAP table but is used when a PLC block is swapped out. This accounts for some of the same attributes being mapped differently for PLC blocks than other blocks.

**Convert using the ECDS to Electrical Database Builder**

The Access database file used for the ECDS to Electrical converter, WDVIACMP.MDB, can be modified directly with Microsoft Access or with the ECDS to Electrical Database Builder tool.

1. From the Projects menu, select Extras ➤ ECDS Legacy Conversion ➤ ECDS to Electrical Database Builder.
2. Select the line within the list to edit. Individual values appear in the edit boxes.
3. Edit the necessary fields and click Update.
4. Add a new line to the database by filling in the fields and clicking Add.
5. Delete a line by selecting the line and clicking Delete.
6 Click OK.

**Convert VIA ECDS or Jr. Project to AutoCAD Electrical**

If you used ECDS you may have drawings you want to use with AutoCAD Electrical. AutoCAD Electrical provides a conversion tool that converts the intelligence of your ECDS drawings to the intelligence that AutoCAD Electrical expects.

**Access:**

From the Projects menu, select Extras ➤ ECDS Legacy Conversion ➤ ECDS to Electrical Drawing Convert.

**Project Options**

- **Existing VIA ECDS or Jr. Project (.VPJ)** Specifies the ECDS project name. Enter your ECDS project name or browse for it.

- **AutoCAD Electrical Project (.WDP)** Specifies the AutoCAD Electrical project name. Enter an AutoCAD Electrical project name, either existing or new. If you are adding the drawings to an existing AutoCAD Electrical project make sure you select that option, otherwise the .WDP project file are overwritten. The ECDS drawings are copied to another location before they are converted. A default location for the converted drawings are supplied, but you can enter any location. If the directory does not exist, AutoCAD Electrical creates it.

- **Library path** Specifies the path to the schematic symbol library to use for the project. A default search path is supplied pointing to the Symbol library of converted symbols. You can include electrical, pneumatic, or other schematic libraries in the path. You can also include a series of paths for AutoCAD Electrical to search in order.

- **Symbol1, Symbol2, Symbol3** Adds the path for a specific library of converted symbols. AutoCAD Electrical provides three libraries
of converted symbols. These symbols look just like the older ECDS symbols but carry the expected AutoCAD Electrical attributes. The path to those symbols are added to your search path. Also, when you select your project to convert, AutoCAD Electrical reads the old ECDS PROJECT.CFG, and look for the Symbol library name. You can also type in any directory path you wish.

NOTE The libraries of converted symbols are supplied in a zip file called ConvSym.zip. Before running the conversion utility you must unzip the libraries. Unzip pointing to your /Program Files/Autodesk/Acad.../Support directory but make sure you use the folder names within the zip file. The zip file creates three subdirectories called "Converted Symbol1," "Converted Symbol2," and "Converted Symbol3."

Drawing Options

Your drawings are copied to another directory and converted; the original drawings are not changed.

Copy Directory

Specifies the path for the converted drawings. If the directory does not exist it is created.

Drawing Configuration

Sets up the drawing defaults that are used for each drawing. The defaults are read from your ECDS PROJECT.CFG file, if possible.

AutoCAD Electrical presents a list of drawings in your ECDS project. Select the drawings you want to convert. AutoCAD Electrical then calls up each drawing, converts the intelligence and saves it. A log file is created named projnam_cv.log and saved in the same directory as the .WDP file. The log file contains information about any problems encountered in the conversion.
Use tagging and linking tools

Apply these manual tools to enable nonblocked geometry to be made AutoCAD Electrical-aware. The existing geometry stays in place and is unblocked, but key text entities are converted to attributes with user picks and are linked into a generic, nongraphical block insert. Wire connection attributes can also be merged into this generic block insert. The process to convert it from dumb text, circle, and line entities takes only moments to complete and the result appears as a fully functional AutoCAD Electrical-aware block insert.

Tagging results:

- The selected text entities are replaced with a template block file.
- The TAG attribute takes on the value of the converted text.
- The TAG attribute is set to fixed.
- The color of the TAG attribute is by layer. The attribute is the same layer as defined on the WD_M block.
- The TAG attribute takes on the same ACAD properties as the tagged text.

Linking results:

- The selected text entities are replaced with an AutoCAD Electrical attribute.
- Colors change to visually distinguish what has been already converted as defined in the WD_M block.
- Temporary lines display the link.

Wire Connection Results:

- Visual indicators (x) appear where the wire connection attributes have already been applied.
- Wire connection attributes, terminal attributes, and terminal description attributes are added.
- The block definition is automatically modified during the attribute addition process.
- Terminal attribute colors change to visually distinguish what has been already converted as defined in the WD_M block.

Add Geometry Results:

- TAG1, TAG2, PLC TAG, and TAGSTRIP attributes are defined and selected first.
- The block definition is automatically modified.
- The geometry's color changes by layer to visually distinguish what has been already converted as defined in the WD_M block.

Tag and link components
You can do multiple tagging and linkages without exiting the commands.

**NOTE** This procedure uses schematic components, but the same procedure can be done using panel components.
Initial set-up

1. On the Conversion toolbar, click the Special Explode tool.
2. Explode any existing blocks.
   This explodes attributes and blocks to geometry and text entities while maintaining the value previously defined in the attribute.
3. On the Conversion toolbar, click the Change/Convert Wire Type tool.
4. Select the wire layer from the grid to add wire lines to.
   The selected wire layer highlights in blue to indicate which layer is selected; the current wire layer highlights in gray.
5. Click Pick and select wire lines from the drawing to add to a wire layer.
6. Click OK.

Tag components

1. On the Conversion toolbar, click the arrow on the Tag Schematic tool to access any of the schematic tagging commands.
2. Select the text entity to replace with the component TAG1 template block file.
   The selected text string highlights indicating what has been selected for conversion.
3. Right-click to apply the tag.
4. (Optional) Tag any other text entities with the proper block file.
5. Right-click to exit the Tagging command. You may need to right-click a few times before exiting.
**Link components**

1. On the Conversion toolbar, click the arrow on the Link Schematic tool to access any of the schematic linking commands.

2. Select the existing tagged TAG1 block definition.

3. Right-click to apply the selection.

4. Select the text to link to the tagged attribute. The selected text properties are applied to the new attribute. Colors change to visually distinguish what has been converted and temporary lines display the link.

5. Right-click to create the link.

6. (Optional) Link any other text entities to the proper attribute.

7. Right-click to exit the Linking command. You may need to right-click a few times before exiting.

**Add geometry and wire connections**

1. On the Conversion toolbar, click the arrow on the Link Schematic tool to access the Add Wire Connections tool.

2. Select the block to tie the wire connections to.

3. Select the end point of the wire or a position on a symbol. Press Shift, right-click, and select End Point from the menu to easily select the end point.

4. After you define the wire connection attribute, you can select the terminal text if the drawing contains the value. If not, continue with the next wire connection attribute.

5. Right-click to apply the selection. Visual indicators (x) appear where the wire connection attributes have already been applied.

6. Repeat the selection for the other end point.

7. Right-click to exit the command. You may need to right-click a few times before exiting.
a few times before exiting.

8 On the Conversion toolbar, click the arrow on the Link Schematic tool to access the Add Geometry tool.

9 Select the block to add the geometry to.

10 Pick or window select the geometry to associate to the template block file.

11 Right-click to apply the selection.

12 Specify the insertion point.

**Special explode**

Use this tool to explode attributes and blocks to geometry and text entities while maintaining the value previously defined in the attributes. You can take advantage of the tagging tools to modify the text entities to attributes and the linking tools to make various blocks.

**NOTE** Use AutoCAD Explode to convert Mtext to normal text for tagging and linking.

Access:

On the Conversion toolbar, click the Special Explode tool.

Click Projects ➤ Conversion Tools ➤ Special Explode.

Select the block to explode into separate text entities and geometry.

**Tag schematic**

Use these tools to convert text entities into an attributed block. Through the insertion of a template block, you have control over which attributes are inserted and visible. All necessary attribute definitions are automatically placed.
During the tagging process, the text entity is removed and replaced with a template block file that contains multiple attributes used in AutoCAD Electrical.

**Access:**

On the Conversion toolbar, click the arrow on the Tag Schematic tool to access any of the schematic tagging commands.

Click Projects ➤ Conversion Tools ➤ Tag Schematic. Select one of the schematic tagging commands from the list.

Click any of the tagging tools. Select the text entity to replace with the component TAG1 template block file, and right-click to apply the tag.

- **Tag Schematic Component**
  Makes selected text entities an attributed block file with the TAG1 attribute visible. The template block file (HDV1_CONVERT.DWG or VDV1_CONVERT.DWG depending on the drawing properties) contains attributes for a schematic component.

- **Tag PLC**
  Makes selected text entities an attributed PLC address associated to a PLC tag. The template block file (PLCIO_ADDR_CONVERT.DWG, PLCIO_CONVERT.DWG, PLCIO_V_ADDR_CONVERT.DWG, or PLCIO_V_CONVERT.DWG depending on the drawing properties) contains attributes found useful for PLC addressing. After the addressing is defined on the block, select a PLC Tag or place one into the symbol definition for use with AutoCAD Electrical.

- **Tag Child**
  Makes selected text entities an attributed block file with the TAG2 attribute visible. The template block file (HDV2_CONVERT.DWG or VDV2_CONVERT.DWG depending on the drawing properties) contains attributes used for a child component.

- **Tag Child - N.O.**
  Makes selected text entities an attributed block file with the TAG2 attribute visible. The template block file (HDV21_CONVERT.DWG or
VDV21_CONVERT.DWG depending on the drawing properties) contains attributes used for a child normally open contact component.

**Tag Child - N.C.**

Makes the selected text entities an attributed block file with the TAG2 attribute visible. The template block file (HDV22_CONVERT.DWG or VDV22_CONVERT.DWG depending on the drawing properties) contains attributes used for a child normally closed contact component.

**Tag Child - Form C**

Makes the selected text entities an attributed block file with the TAG2 attribute visible. The template block file (HDV23_CONVERT.DWG or VDV23_CONVERT.DWG depending on the drawing properties) contains attributes used for a child Form C contact component.

**Tag Schematic Terminal - Terminal Number**

Makes the selected text entities an attributed block file with the TAGSTRIP and TERM01 attribute visible. The template block file (HT0T_CONVERT.DWG or VT0T_CONVERT.DWG depending on the drawing properties) contains attributes used for a terminal block component containing a terminal number.

**Tag Schematic Terminal - Wire Number**

Makes the selected text entities an attributed block file with the TAGSTRIP and WIRENO attribute visible. The template block file (HT0W_CONVERT.DWG or VT0W_CONVERT.DWG depending on the drawing properties) contains attributes used for a terminal block component containing a wire number as the terminal number.

**Tag Schematic Terminal - Wire Number Change**

Makes the selected text entities an attributed block file with the TAGSTRIP and TERM01 attribute visible. The template block file (HT1T_CONVERT.DWG or VT1T_CONVERT.DWG depending on the drawing properties) contains attributes used for a terminal block component that...
changes the wire number. This creates a terminal number block that has a different wire number for each wire connected to it.

**Link schematic**

Use these tools to associate nonblocked text to previously placed template blocks. Through the modification of a template block, you have control over which attributes are inserted and visible. All necessary attribute definitions are placed using the properties of the existing text entities, such as justification, height, and location. If multiple template block files are selected, the value of the text is added to the previously defined template block attributes as hidden attributes and the text is not removed.

**Access:**

On the Conversion toolbar, click the arrow on the Link Schematic tool to access any of the linking commands.

Click Projects ➤ Conversion Tools ➤ Link Schematic. Select one of the linking commands from the list.

Click any of the linking tools. Select the existing tagged TAG1 block definition, and right-click to apply the selection. Select the text to link to the tagged attribute. The selected text properties are applied to the new attribute. Right-click to create the link.

**Link Description**

Links simple text as Description 1-3 attributes on an AutoCAD Electrical block file. You can link them as description attributes to one or more existing template block definitions. During the conversion process, the text entity is removed and replaced with the next available description attribute, up to 3.

**Link Split Tag**

Links another string of text to a tag attribute, creating a split tag. Create the device Tag using the TAG1, TAG, or P_TAG1 attributes, and then use this tool to select the existing TAG attribute on the drawing and link another string of text, creating a split tag situation. The first TAG becomes the Part1 of the split tag while the linked portion becomes the Part2 of the split tag.
Links simple text to a PLC address attribute as PLC I/O address description attributes. During the conversion process, the text entity is removed and replaced with the next available PLC address description attribute, up to 5.

Link Terminal Number
Links simple text to a TAGSTRIP attribute as a terminal number attribute on an AutoCAD Electrical terminal block symbol. During the conversion process, the text entity is removed and replaced with the TERM01 or WIRENO attribute.

Link Location Code
Links simple text as Location attributes on an AutoCAD Electrical block file. The entity value is used as the Location value for one or more template block definitions. If only one template block is selected for the link, the text entity is removed and replaced with the Location attribute.

Link Installation Code
Links simple text as Installation attributes on an AutoCAD Electrical block file. The entity value is used as the Installation value for one or more template block definitions. If only one template block is selected for the link, the text entity is removed and replaced with the Installation attribute.

Link Manufacturer
Links simple text as manufacturer attributes on an AutoCAD Electrical block file. The entity value is used as the Manufacturer value for one or more template block definitions. If only one template block is selected for the link, the text entity is removed and replaced with the Manufacturer attribute.

Link Catalog Number
Links simple text as Catalog Number attributes on an AutoCAD Electrical block file. The entity value is used as the Catalog Number value for one or more template block definitions. If only one template block is selected for the link, the
text entity is removed and replaced with the Catalog Number attribute.

**Link Rating**

Links simple text as Rating 1-12 attributes on an AutoCAD Electrical block file. The entity value is used as the rating value for one or more template block definitions. If only one template block is selected for the link, the text entity is removed and replaced with the rating attribute, up to 12.

**Link User**

Links simple text (that is not an attribute definition or part of geometry) as User (01-99) attributes on an AutoCAD Electrical block file. The entity value is used as the user value for one or more template block definitions. If only one template block is selected for the link, the text entity is removed and replaced with the user attribute, up to 99. Window selection is allowed.

**Tag panel**

Use these tools to convert text entities into an attributed block file. Through the insertion of a template block, you have control over which attributes are inserted and visible. All necessary attribute definitions are automatically placed. During the tagging process the text entity is removed and replaced with a template block file that contains multiple attributes used in AutoCAD Electrical.

**Access:**

On the Conversion toolbar, click the arrow on the Tag Panel tool to access any of the panel tagging commands.

Click Projects ➤ Conversion Tools ➤ Tag Panel. Select one of the panel tagging commands from the list.

Click any of the tagging tools. Select the text entity to replace with the component TAG1 template block file and right-click to apply the tag.

**Tag Panel Component**

Makes selected text entities an attributed block file with the P_TAG1 attribute visible. The template block file (ACE_P_TAG1_CONVERT.DWG) contains attributes for a panel component.
| Tag Nameplate | Makes selected text entities an attributed block file with the DESC1-3 attributes visible. The template block file (ACE_NP_CONVERT.DWG) contains attributes used in nameplate symbols. If the description text strings were previously defined as attributes on an AutoCAD Electrical panel component block definition, the attribute values on the panel component are hidden and the nameplate attributes DESC1-3 are added and made visible. |
| Tag Panel Terminal - Terminal Number | Makes selected text entities an attributed block file with the TERM01 terminal number attribute visible. The template block file (ACE_TERM_MT.Convert.DWG) contains attributes for terminal numbers. |
| Tag Panel Terminal - Wire Number | Makes selected text entities an attributed block file with the WIRENO wire number attribute visible. The template block file (ACE_TERMW_CONVERT.DWG) contains attributes for panel terminal symbols. |

**Link panel**

Use these tools to associate nonblocked text to previously placed template blocks. Through the modification of a template block, you have control over which attributes are inserted and visible. All necessary attribute definitions are placed using the properties of the existing text entities, such as justification, height, and location. If multiple template block files are selected, the value of the text is added to the previously defined template block attributes as hidden attributes and the text is not removed.

**Access:**

On the Conversion toolbar, click the arrow on the Link Panel tool to access any of the linking commands.

Click Projects ➤ Conversion Tools ➤ Link Panel. Select one of the linking commands from the list.

Click any of the linking tools. Select the existing tagged TAG1 block definition and right-click to apply the selection. Select the text to link to the tagged...
attribute. The selected text properties are applied to the new attribute. Right-click to create the link.

**Link Description**
Links simple text as Description 1-3 attributes on an AutoCAD Electrical Panel block file. You can link them as description attributes to one or more existing template block definitions. During the conversion process, the text entity is removed and replaced with the next available description attribute, up to 3.

**Link Split Tag**
Links another string of text to a tag attribute, creating a split tag. Create the device Tag using the TAG1, TAG, or P_TAG1 attributes, and then use this tool to select the existing TAG attribute on the drawing and link another string of text, creating a split tag situation. The first TAG becomes the Part1 of the split tag while the linked portion becomes the Part2 of the split tag.

**Link Item Number**
Links simple text as an Item Number attribute on an AutoCAD Electrical Panel block file. During the conversion process, the text entity is removed and replaced with the Item Number attribute (P_ITEM).

**Link Location Code**
Links simple text as Location attributes on an AutoCAD Electrical Panel block file. The entity value is used as the Location value for one or more template block definitions. If only one template block is selected for the link, the text entity is removed and replaced with the Location attribute.

**Link Installation Code**
Links simple text as Installation attributes on an AutoCAD Electrical Panel block file. The entity value is used as the Installation value for one or more template block definitions. If only one template block is selected for the link, the text entity is removed and replaced with the Installation attribute.
Link Manufacturer  Links simple text as manufacturer attributes on an AutoCAD Electrical Panel block file. The entity value is used as the Manufacturer value for one or more template block definitions. If only one template block is selected for the link, the text entity is removed and replaced with the Manufacturer attribute.

Link Catalog Number  Links simple text as Catalog Number attributes on an AutoCAD Electrical Panel block file. The entity value is used as the Catalog Number value for one or more template block definitions. If only one template block is selected for the link, the text entity is removed and replaced with the Catalog Number attribute.

Link Rating  Links simple text as Rating 1-12 attributes on an AutoCAD Electrical Panel block file. The entity value is used as the rating value for one or more template block definitions. If only one template block is selected for the link, the text entity is removed and replaced with the rating attribute, up to 12.

Link User  Links simple text (that is not an attribute definition or part of geometry) as User (01-99) attributes on an AutoCAD Electrical block file. The entity value is used as the user value for one or more template block definitions. If only one template block is selected for the link, the text entity is removed and replaced with the user attribute, up to 99. Window selection is allowed.

Add geometry
Use this tool to add AutoCAD geometry to a template block file to be created as part of a unique block instance. It creates a new block definition with the
newly added geometry. You can subsequently create a new block file if the block is exploded.

**Access:**

On the Conversion toolbar, click the arrow on the Link Schematic or Link Panel tool to access the Add Geometry tool. Click Projects ➤ Conversion Tools ➤ Link Schematic (or Link Panel) ➤ Add Geometry.

Select the block to add the geometry to. Pick or window select the geometry to associate to the template block file, and right-click to apply the selection. Specify an insertion point.

**Add wire connections**

Use this tool to add wire connection attributes to the existing tagged block file. Select line endpoints or geometry to add the appropriate wire connection attributes to. A new block definition is created with the newly added wire connections. You can subsequently create a new block file if the block is exploded.

**Access:**

On the Conversion toolbar, click the arrow on the Link Schematic or Link Panel tool to access the Add Wire Connections tool. From the Projects menu, select Conversion Tools ➤ Link Schematic (or Link Panel) ➤ Add Wire Connections.

Select the block TAG or PLC Address to tie the wire connection to. Select the wire end or pick near the selected block to select a location if no wire exists. If you picked a location, the Wire Direction dialog box displays. Select where you want the wire to come from: above, right, below, or left of the selected block. Right-click to apply the wire connection.

**Show links**
Use this tool to select the tagged template block file and display everything (such as description, location, manufacturer, and catalog number codes) that has been linked to it.

Access:

On the Conversion toolbar, click the arrow on the Link Schematic or Link Panel tool to access the Show Links tool.

Click Projects ➤ Conversion Tools ➤ Link Schematic (or Link Panel) ➤ Show Links.

Select a single link by picking or multiple links by windowing. Temporary line graphics show what was previously linked.

**Un link**

Use this tool to select an existing linked attribute and unlink the attribute from the symbol, changing the attribute to AutoCAD text.

Access:

On the Conversion toolbar, click the arrow on the Link Schematic or Link Panel tool to access the Un Link tool.

Click Projects ➤ Conversion Tools ➤ Link Schematic (or Link Panel) ➤ Un Link.

Select the link to remove; the link between the attributes and the block it is associated to is removed.

**Overview of block/attribute mapping**

You can perform drawing-wide or project-wide block replacements using a user-defined Microsoft Excel spreadsheet and an AutoCAD Electrical-aware symbol library that it references. The spreadsheet performs a lookup for each block name and finds the corresponding new block. Each new block drawing is pulled from the AutoCAD Electrical symbol library and inserted (scaled and rotated as required) in the drawing. The spreadsheet is checked to copy the old attribute values to the appropriate new names on the newly-inserted block. This process continues across the drawing, and terminates when no more block names remain or it automatically continues to the next drawing if project-wide mode is selected.
The mapping spreadsheet has two parts: Attribute mapping defaults and Block name mapping. Each section is a sheet within the spreadsheet and must follow a defined column format. The sheets must be in order, where sheet 1 defines the attribute mapping and sheet 2 defines the block mapping.

Attribute mapping sheet format

<table>
<thead>
<tr>
<th>Column A / Old Attribute Name</th>
<th>Attribute tag found on the legacy, non-AutoCAD Electrical block insert. Wildcards and AutoLisp-style punctuation for wildcards are supported.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column B / AcadE Attribute Name</td>
<td>Attribute tag name found on the AutoCAD Electrical block insert. Wildcards and AutoLisp-style punctuation for wildcards are supported.</td>
</tr>
</tbody>
</table>

Block name mapping sheet format

<table>
<thead>
<tr>
<th>Column A / Old Block Name</th>
<th>Legacy, non-AutoCAD Electrical block insert name. Wildcards and AutoLisp-style punctuation for wildcards are supported.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column B / AcadE Block Name</td>
<td>AutoCAD Electrical block name to use as a replacement for all instances of the block query match on columns A and C.</td>
</tr>
<tr>
<td>Column C / Filtering Expression</td>
<td>Optional AutoLisp expression, or attribute definition, that along with column A are what the program uses</td>
</tr>
</tbody>
</table>

1152 | Chapter 17   Conversion Tools
to query the table to find the correct mapping entry for a given block name to swap.

**Column D / Scale Multiplier**

If blank, the new block swaps in at the same scale as the existing block it replaces. If this field is not blank, the swapped block is scaled up or down per the field’s multiplier value.

**Column E / X-Y Offset**

If blank, the new block swaps in at the same XY coordinate as the existing block it replaces. If not blank and in the format of a coordinate pair, the swapped block inserts offset from the original block’s origin by this XY amount.

**Column F / Attribute name overrides**

Defines specific attribute Old=New mapping that is not defined in sheet 1 or is to override what is found in sheet 1. Multiple entries in this field are supported with this syntax: Old1=New1;Old2=New2.

**Column G / Attribute Value Overrides**

Defines specific attribute values to insert into the newly swapped attributes. Multiple entries in this field are supported with this syntax: New1=val1;New2=val2. An entry of “New1=” blanks out that attribute value.

The block replacement process generates a log file of the results. The log file ([projectname]_cnv.log) is created in the same folder as the .wdp project file. The following conditions are reported:

- Problem finding/opening mapping spreadsheet
- Problem inserting WD_M block (if not already present)
- Legacy block name not mapped to an AutoCAD Electrical block
- AutoCAD Electrical block not found in library search path
- Problem inserting AutoCAD Electrical block
- Legacy attribute name not mapped
Map block values using a user-defined spreadsheet

NOTE A user-defined spreadsheet is required for this tool. Refer to the "Learn about block/attribute mapping" file for help on creating the spreadsheet if you do not already have one created.

1. On the Conversion toolbar, click the Block Replacement tool.
2. Select to run the block replacement for the entire project, the active drawing, or a selected component on the active drawing.
3. Click OK.
4. On the Select Mapping Spreadsheet dialog box, select the spreadsheet to be used for mapping the blocks and attributes.
5. Click Open.

If you select an existing spreadsheet the block replacement automatically begins. If the spreadsheet file does not exist you are presented with the option to create the spreadsheet framework for the block/attribute mapping.

If a spreadsheet was not found, on the Spreadsheet Not Found dialog box, click OK to run through the active project's drawing set, and fill in a blank spreadsheet with extracted block names and attributes. Only the first column of each of the sheets are filled in. You can then add the block/attribute mapping information and then rerun the command using the new spreadsheet.

Block replacement

Performs drawing-wide and project-wide block replacements using a user-defined spreadsheet. This automatically maps the unconverted drawing's non-AutoCAD Electrical block inserts and attributes to appropriate AutoCAD Electrical-smart component symbols drawn from a symbol library.

Access:

On the Conversion toolbar, click the Block Replacement tool.
From the Projects menu, select Conversion Tools ➤ Block Replacement.
Select to run the block replacement on the entire project, the active drawing, or a single symbol on the active drawing.
**Overview of power check tools**

You can add information to your schematic components to indicate power source and load values using the supplied Power Check tools. Once these values have been added, you can run the Power Load Check Report to scan the wire interconnections and report if there is too much load on a given power source.

There are 3 tools to use for checking power source/load:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add/Edit Power Source/Load values</td>
<td>Marks a component with a power source and load value. The value is added to an AutoCAD Electrical connection attribute. This dialog box contains a list of available connection points. If you select near the connection point for the power value it will be pre-selected in the dialog box. Enter the power source and load value and an optional units value. These values will be saved on the connection point as invisible xdata.</td>
</tr>
<tr>
<td>Set Pass Power</td>
<td>Marks a component with a PASSPWR flag. The PASSPWR flag instructs the Power Report to pass through the marked component when calculating the load on a given source. If a component carries the PASSPWR flag the Power Report program will pass through the component and continue looking for load values on the network.</td>
</tr>
<tr>
<td>Power Load Check Report</td>
<td>Looks for any components assigned as a power source and then follows any wires connected to that terminal. When a load is hit, it stops reading on that wire segment and doesn't search past the load. For example, if you apply a supply value to the left power bus on a ladder, there are a bunch of pilot lights and relay coils in the ladder. AutoCAD Electrical goes down the left bus and checks each connected rung. It reads through contact and terminals, but when it hits a load on a rung, it accumulates the load value (if present) and stops going any further on that rung. The utility will still check the other rungs tied to the left-hand bus and try to find more loads.</td>
</tr>
</tbody>
</table>
**Tip: Adding Xdata to library symbols prior to insertion**

You can add the Xdata on the library symbol prior to inserting it. If a drawing already contains that block, you must use the Update Block option prior to running the report. Open the library symbol and use the Xdata Editor to add Xdata directly onto the appropriate TERM## attribute. The following xdata could be added at the library level:

- **Source** - VIA_WD_PWR_SRC
- **Load** - VIA_WD_PWR_LOAD
- **Unit** - VIA_WD_PWR_UNIT
- **Potential** - VIA_WD_POTENTIAL

**Set power source/load value**

This utility marks a component with a power source and load value. A related routine, when invoked, then scans the wire interconnections and reports if there is too much load on a given power source.

**Access:**

On the Power Check toolbar, click the Add/Edit Power Source/Load Levels tool.

Click Wires ➤ Wire Number Miscellaneous ➤ Power Check ➤ Add/Edit Power Source/Load Levels.

Select the component for the power source or load value. The value is added to an AutoCAD Electrical connection attribute. This dialog box contains a list of available connection points. If you select near the connection point for the power value it will be pre-selected in the dialog box. Enter the power source and load value and an optional units value. These values will be saved on the connection point as invisible xdata.

**NOTE** As you add these power source or load values, think of AutoCAD Electrical tracing through these components to see what the load is on the power source. Pick which terminal to add the value to accordingly.

**Source/load assignment**

| Source/Load | Indicates to set the source or load value. |

---

Overview of power check tools | 1159
Value
Specifies the source or load value to save on the connection point.

Units
(Optional) Specifies the units for the source or load value. Select from the drop-down list to specify the units.

**Potential assignment**

Optional for voltage level mismatch checks. Select from the drop-down list to specify the potential value.

**Set pass power**

This utility marks a component with a PASSPWR flag. The PASSPWR flag instructs the Power Report to pass through the marked component when calculating the load on a given source. If a component carries the PASSPWR flag the Power Report program will pass through the component and continue looking for load values on the network.

*NOTE* Certain components don’t need a PASSPWR flag (such as terminals and contacts) since they are automatically ‘passed’ through.

**Access:**

On the Power Check toolbar, click the Mark Component To Pass Power tool.
Click Wires ➤ Wire Number Miscellaneous ➤ Power Check ➤ Mark Component To Pass Power.

Each selected component is displayed in the list. If the component already carries the PASSPWR flag, a * appears next to the tag. To set or unset the PASSPWR flag, click on the component’s tag in the list.

**Power source/load report**

Once a component is marked with a power source and load value, this utility scans the wire interconnections and reports if there is too much load on a given power source.

**Access:**

On the Power Check toolbar, click the Power Load Check Report tool.
Click Wires ➤ Wire Number Miscellaneous ➤ Power Check ➤ Power Load Check Report.
Select to run the report on the project, selected components in the active drawing, or all components in the active drawing. You can also select to redisplay the last Power Check report.

Overview of pneumatic tools

Use the Insert Pneumatic Component tool on the Extra Libraries toolbar to insert your Pneumatic symbols (to access the toolbar, select Projects ➤ Toolbars ➤ Extra Libraries or right-click on any toolbar and select ACE: Extra Libraries). Then use all of the AutoCAD Electrical drafting and editing tools to modify the pneumatic layout, including Stretch, Trim and Scoot.

The Icon Menu provides easy access to pneumatic library symbols. The pneumatic symbol library consists of all the pneumatic symbols and is found at \Program Files [x86]\Autodesk\Acad {version}\Libs\pneu_iso125.

Recommended Settings for drawing pneumatic diagrams

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
<th>Where this can be set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ladder Orientation</td>
<td>Horizontal</td>
<td>Drawing Properties ➤ Drawing Format</td>
</tr>
</tbody>
</table>

Insert component

This icon menu can be modified, expanded, or replaced with your own custom menu. You can change the default icon menu using the Library and Icon Menu Paths section of the Project Properties ➤ Project Settings dialog box. Select Projects ➤ Project ➤ Project Manager. Right-click the project name and select Properties. Use the Icon Menu Wizard to easily modify the menu. The default icon menu can also be redefined in "wd.env." Add entry "WD_MENU" for schematic icon menu and "WD_PMENU" for panel layout icon menu.

Access:

Click the Insert Component tool or the Multiple Insert Component tool.

Click Components ➤ Insert Component or Components ➤ Multiple Insert ➤ Multiple Insert (Icon Menu).
Access:

**NOTE** This dialog box is also accessed when inserting Pneumatic, Hydraulic, or P&ID components; in-line wire labels; stand-alone cross-reference symbols; cable markers; and saved circuits.

Select an icon picture or the component type from the Menu tree structure. The main menu in the tree structure is displayed as the menu heading just above the menu tree structure.

**Tabs**
- **Menu**: Changes the visibility of the Menu tree view.
- **Up one level**: Displays the menu that is one level before the current menu in the Menu tree view. This is unavailable if the main menu is selected in the Menu tree view.
- **Views**: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.

**Menu**
The tree structure is created by reading the icon menu file (*.dat). The tree structure is based on the arrangement order of submenus defined in the .dat file.

**Symbol Preview window**
Displays the symbol and submenu icons corresponding to the menu or the submenu selected in the Menu tree structure. Clicking on the icon performs one of the following functions based on the icon properties as defined by the *.dat file:
- **Inserts the symbol or circuit onto the drawing**
- **Executes a command**
- **Displays a submenu**

**NOTE** When you move the cursor over an icon, the icon name and block/circuit/command name display as tooltip information.
Displays the last components inserted during the current editing session; the most recently used icon displays in the top. This list follows the view options setting in the symbol preview window (icon only, icon with text or list view) and the total number of icons displayed depends on the value specified in the Display edit box.

Specifies the number of icons to display in the Recently Used list box. Enter integer numbers only; the default value is 10.

Inserts the icon using a vertical or horizontal orientation. This is opposite the drawing’s default ladder rung orientation.

Turns off the Insert/Edit Component dialog box when inserting symbols onto the drawing. To add component detail later, click the Edit Component tool, and select the component to edit.

Inserts the component, un-tagged (i.e. without assigning a unique Component Tag). The untagged value that displays is the component’s TAG1/TAG2 default value. To add component detail later, click the Edit Component tool, and select the component to edit.

Indicates to display the previously used menu each time you open the Insert Component dialog box. For example, if you insert a push button from the Push Buttons menu, the next time you open the Insert Component dialog box the Push Button menu displays by default.

Specifies the component block insertion scale. This defaults to the value set in the Drawing Properties ➤ Drawing Format dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.

Specifies the footprint insertion scale. This defaults to the value set in the Drawing Properties ➤ Drawing Format dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.

Manually type in the component block to insert.
Right-click menus

Options for the Menu tree structure view
Right-click on the main menu or submenu in the Menu tree structure view to display the following options:

- Expand/Collapse: Toggles the visibility of the menus.
- Properties: Opens a Properties dialog box to view the existing menu or submenu properties like the menu name, image or submenu title. Use the Icon Menu Wizard to change any menu properties.

Options for the Symbol Preview window
Right-click an icon or in empty space in the Symbol Preview window to display the following options:

- View: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.
- Properties: (available for icons only) Opens a Properties dialog box to view the existing symbol icon properties like the icon name, image, block names and so on. Use the Icon Menu Wizard to change any icon properties.

Pneumatic, Hydraulic and P&ID icon menus
The Menu tree structure displays the symbols for the selected component type (pneumatic, hydraulic or P&ID). The Insert Pneumatic Component, Insert Hydraulic Component and Insert P&ID Component tools are accessed on the Extra Library toolbar.

![Insert Pneumatic Component](image)

Insert Pneumatic Component

![Insert Hydraulic Component](image)

Insert Hydraulic Component
Insert P&ID Component
Insert hydraulic components

Use the Insert Hydraulic Component tool to insert a component into the drawing.

1  On the Extra Libraries toolbar, click the Insert Hydraulic Component tool.
2  On the Insert Component dialog box, select the starting orientation for the component: horizontal or vertical.
3  (Optional) If you want to turn off the Insert/Edit Component dialog box when inserting symbols onto the drawing, select No edit dialog.
4  (Optional) If you want to insert the component, untagged (for example, without assigning a unique Component Tag) select No tag. The untagged value that displays is the component’s TAG1/TAG2 default value.
5  Select the component to insert (such as Filters ➤ Centrifugal) from the Symbol Preview window. The Recently Used column displays components inserted during the current editing session. You can also select the component to insert from this list.
6  Specify the insertion point in the drawing. The orientation of the symbol tries to match the underlying wire. The wire breaks automatically if the symbol lands on it.
7  In the Insert/Edit Component dialog box, annotate the component.
8  Click OK.

Recommended Settings for drawing Hydraulic diagrams

<table>
<thead>
<tr>
<th>Setting</th>
<th>Inch Unit</th>
<th>Metric Unit</th>
<th>Where this can be set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid Size</td>
<td>0.125</td>
<td>2.5</td>
<td>Tools ➤ Drafting Settings</td>
</tr>
</tbody>
</table>
**Insert component**

This icon menu can be modified, expanded, or replaced with your own custom menu. You can change the default icon menu using the Library and Icon Menu Paths section of the Project Properties ➤ Project Settings dialog box. Select Projects ➤ Project ➤ Project Manager. Right-click the project name and select Properties. Use the Icon Menu Wizard to easily modify the menu. The default icon menu can also be redefined in "wd.env." Add entry "WD_MENU" for schematic icon menu and "WD_PMENU" for panel layout icon menu.

**Access:**

Click the Insert Component tool or the Multiple Insert Component tool.
Click Components ➤ Insert Component or Components ➤ Multiple Insert ➤ Multiple Insert (Icon Menu).

**NOTE** This dialog box is also accessed when inserting Pneumatic, Hydraulic, or P&ID components; in-line wire labels; stand-alone cross-reference symbols; cable markers; and saved circuits.
Select an icon picture or the component type from the Menu tree structure. The main menu in the tree structure is displayed as the menu heading just above the menu tree structure.

**Tabs**
- **Menu**: Changes the visibility of the Menu tree view.
- **Up one level**: Displays the menu that is one level before the current menu in the Menu tree view. This is unavailable if the main menu is selected in the Menu tree view.
- **Views**: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.

**Menu**
The tree structure is created by reading the icon menu file (*.dat). The tree structure is based on the arrangement order of submenus defined in the .dat file.

**Symbol Preview window**
Displays the symbol and submenu icons corresponding to the menu or the submenu selected in the Menu tree structure. Clicking on the icon performs one of the following functions based on the icon properties as defined by the *.dat file:
- Inserts the symbol or circuit onto the drawing
- Executes a command
- Displays a submenu

**NOTE** When you move the cursor over an icon, the icon name and block/circuit/command name display as tooltip information.

**Recently Used**
Displays the last components inserted during the current editing session; the most recently used icon displays in the top. This list follows the view options setting in the symbol preview window (icon only, icon with text or list view) and the total number of icons displayed depends on the value specified in the Display edit box.

**Display**
Specifies the number of icons to display in the Recently Used list box. Enter integer numbers only; the default value is 10.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical/Horizontal</td>
<td>Inserts the icon using a vertical or horizontal orientation. This is opposite the drawing’s default ladder rung orientation.</td>
</tr>
<tr>
<td>No edit dialog</td>
<td>Turns off the Insert/Edit Component dialog box when inserting symbols onto the drawing. To add component detail later, click the Edit Component tool, and select the component to edit.</td>
</tr>
<tr>
<td>No tag</td>
<td>Inserts the component, un-tagged (i.e. without assigning a unique Component Tag). The untagged value that displays is the component’s TAG1/TAG2 default value. To add component detail later, click the Edit Component tool, and select the component to edit.</td>
</tr>
<tr>
<td>Always display previously used</td>
<td>Indicates to display the previously used menu each time you open the Insert Component dialog box. For example, if you insert a push button from the Push Buttons menu, the next time you open the Insert Component dialog box the Push Button menu displays by default.</td>
</tr>
<tr>
<td>menu</td>
<td></td>
</tr>
<tr>
<td>Scale schematic</td>
<td>Specifies the component block insertion scale. This defaults to the value set in the Drawing Properties ➤ Drawing Format dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.</td>
</tr>
<tr>
<td>Scale panel</td>
<td>Specifies the footprint insertion scale. This defaults to the value set in the Drawing Properties ➤ Drawing Format dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.</td>
</tr>
<tr>
<td>Type it</td>
<td>Manually type in the component block to insert.</td>
</tr>
<tr>
<td>Browse</td>
<td>Browses to and selects the component to insert.</td>
</tr>
</tbody>
</table>

**Right-click menus**

**Options for the Menu tree structure view**
Right-click on the main menu or submenu in the Menu tree structure view to display the following options:

- Expand/Collapse: Toggles the visibility of the menus.
- Properties: Opens a Properties dialog box to view the existing menu or submenu properties like the menu name, image or submenu title. Use the Icon Menu Wizard to change any menu properties.

**Options for the Symbol Preview window**

Right-click an icon or in empty space in the Symbol Preview window to display the following options:

- View: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.
- Properties: (available for icons only) Opens a Properties dialog box to view the existing symbol icon properties like the icon name, image, block names and so on. Use the Icon Menu Wizard to change any icon properties.

**Pneumatic, Hydraulic and P&ID icon menus**

The Menu tree structure displays the symbols for the selected component type (pneumatic, hydraulic or P&ID). The Insert Pneumatic Component, Insert Hydraulic Component and Insert P&ID Component tools are accessed on the Extra Library toolbar.
Insert P&ID components

Use the Insert P&ID Component tool to insert a component into the drawing.

2. In the Insert Component dialog box, select the starting orientation for the component: horizontal or vertical.
3. (Optional) If you want to turn off the Insert/Edit Component dialog box when inserting symbols onto the drawing, select No edit dialog.
4. (Optional) If you want to insert the component, untagged (for example, without assigning a unique Component Tag), select No tag. The untagged value that displays is the component's TAG1/TAG2 default value.
5. Select the component to insert from the Symbol Preview window.
   The Recently Used column displays components inserted during the current editing session. You can also select the component to insert from this list.
6. Specify the insertion point in the drawing.
   The orientation of the symbol tries to match the underlying wire. The wire breaks automatically if the symbol lands on it.
7. In the Insert/Edit Component dialog box, annotate the component.
8. Click OK.

Recommended Settings for drawing P & ID diagrams

<table>
<thead>
<tr>
<th>Setting</th>
<th>Inch Unit</th>
<th>Metric Unit</th>
<th>Where this can be set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid Size</td>
<td>0.125</td>
<td>2.5</td>
<td>Tools ➤ Drafting Settings</td>
</tr>
</tbody>
</table>
Insert component

This icon menu can be modified, expanded, or replaced with your own custom menu. You can change the default icon menu using the Library and Icon Menu Paths section of the Project Properties ➤ Project Settings dialog box. Select Projects ➤ Project ➤ Project Manager. Right-click the project name and select Properties. Use the Icon Menu Wizard to easily modify the menu. The default icon menu can also be redefined in "wd.env." Add entry "WD_MENU" for schematic icon menu and "WD_PMENU" for panel layout icon menu.

Access:

- Click the Insert Component tool or the Multiple Insert Component tool.
- Click Components ➤ Insert Component or Components ➤ Multiple Insert ➤ Multiple Insert (Icon Menu).

**NOTE** This dialog box is also accessed when inserting Pneumatic, Hydraulic, or P&ID components; in-line wire labels; stand-alone cross-reference symbols; cable markers; and saved circuits.
Select an icon picture or the component type from the Menu tree structure. The main menu in the tree structure is displayed as the menu heading just above the menu tree structure.

**Tabs**
- **Menu**: Changes the visibility of the Menu tree view.
- **Up one level**: Displays the menu that is one level before the current menu in the Menu tree view. This is unavailable if the main menu is selected in the Menu tree view.
- **Views**: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.

**Menu**
The tree structure is created by reading the icon menu file (*.dat). The tree structure is based on the arrangement order of submenus defined in the .dat file.

**Symbol Preview window**
Displays the symbol and submenu icons corresponding to the menu or the submenu selected in the Menu tree structure. Clicking on the icon performs one of the following functions based on the icon properties as defined by the *.dat file:
- Inserts the symbol or circuit onto the drawing
- Executes a command
- Displays a submenu

**NOTE** When you move the cursor over an icon, the icon name and block/circuit/command name display as tooltip information.

**Recently Used**
Displays the last components inserted during the current editing session; the most recently used icon displays in the top. This list follows the view options setting in the symbol preview window (icon only, icon with text or list view) and the total number of icons displayed depends on the value specified in the Display edit box.

**Display**
Specifies the number of icons to display in the Recently Used list box. Enter integer numbers only; the default value is 10.
Vertical/Horizontal  
Inserts the icon using a vertical or horizontal orientation. This is opposite the drawing’s default ladder rung orientation.

No edit dialog  
Turns off the Insert/Edit Component dialog box when inserting symbols onto the drawing. To add component detail later, click the Edit Component tool, and select the component to edit.

No tag  
Inserts the component, un-tagged (i.e. without assigning a unique Component Tag). The untagged value that displays is the component’s TAG1/TAG2 default value. To add component detail later, click the Edit Component tool, and select the component to edit.

Always display previously used menu  
Indicates to display the previously used menu each time you open the Insert Component dialog box. For example, if you insert a push button from the Push Buttons menu, the next time you open the Insert Component dialog box the Push Button menu displays by default.

Scale schematic  
Specifies the component block insertion scale. This defaults to the value set in the Drawing Properties ➤ Drawing Format dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.

Scale panel  
Specifies the footprint insertion scale. This defaults to the value set in the Drawing Properties ➤ Drawing Format dialog box. Once set, this value is remembered until reset or until the drawing editing session ends.

Type it  
Manually type in the component block to insert.

Browse  
Browses to and selects the component to insert.

Right-click menus

Options for the Menu tree structure view
Right-click on the main menu or submenu in the Menu tree structure view to display the following options:

- **Expand/Collapse**: Toggles the visibility of the menus.
- **Properties**: Opens a Properties dialog box to view the existing menu or submenu properties like the menu name, image or submenu title. Use the Icon Menu Wizard to change any menu properties.

**Options for the Symbol Preview window**

Right-click an icon or in empty space in the Symbol Preview window to display the following options:

- **View**: Changes the view display for the Symbol Preview window and Recently Used window. The current view option is indicated with a check mark. Options include: Icon with text, Icon only or List view.
- **Properties**: (available for icons only) Opens a Properties dialog box to view the existing symbol icon properties like the icon name, image, block names and so on. Use the Icon Menu Wizard to change any icon properties.

**Pneumatic, Hydraulic and P&ID icon menus**

The Menu tree structure displays the symbols for the selected component type (pneumatic, hydraulic or P&ID). The Insert Pneumatic Component, Insert Hydraulic Component and Insert P&ID Component tools are accessed on the Extra Library toolbar.

![Insert Pneumatic Component](image)

![Insert Hydraulic Component](image)

![Insert P&ID Component](image)
Overview of real-time error checking

Although AutoCAD Electrical checks for duplicated schematic component reference designations and wire numbers during the insert or edit process, you have the option of displaying the warning in real time. Real-time error checking is enabled by default in the Project Properties ➤ Project Settings (page 99) tab.

If you enter an existing component tag/wire number during the insert/edit process, a warning dialog box displays. This alerts you of the duplication and suggests alternative tag names based on the user-defined format. You can select whether to use the duplicated tag or use a new tag that is suggested (or you can type in a new tag).

**NOTE** The combined value of the component tag and installation code is used for error checking in IEC mode.

An error log file is created for every project if you chose to display the real-time warnings. The real time warning is saved in the log file named "<project_name>_error.log" and is saved in the User subdirectory. If a log file already exists, the new content is added to the same file. A blank line separates one error record from another.

**About the .wdn file**

The .wdn file is a text file used specifically for auditing terminals. Terminal numbers listed in the .wdn file are not checked for duplication. You can use wildcards to exclude a range of terminals for duplication checking such as all terminals with a tag name starting with "T" and with terminal number "1." AutoCAD Electrical searches for the <project_name>.wdn file in the same folder as the project definition file (*.wdp). If <project_name>.wdn is not found, AutoCAD Electrical looks for the default.wdn file in the project folder (C:\Documents and Settings\{username}\My Documents\Acade\{version}\AeData\Proj).

The default .wdn file contains the terminal number filters GND, PE, and E. These are ignored when checking for duplication and will not be listed in the Electrical Audit report.
Use the troubleshooting tools

There are many tools to use for troubleshooting your AutoCAD Electrical drawing.

Use the audit tool

Use this tool to identify and clean up some types of problems that might affect an AutoCAD Electrical drawing. The Electrical Audit tool displays a report of detected problems for the active project. You can save this file for reference or surf the file to view and correct the errors.

1. Select Projects ➤ Reports ➤ Electrical Audit.
   When you run the command, the progress bar describes the progress of the audit process. Once the audit is complete, a text box displays the total number of errors found.

2. Click Details to view the detected problems.

3. Click any of the tabs highlighted with an error icon.
   These are the areas where problems were found in your project. If no errors were found, the Details button is not enabled.

4. Click on an audit record in the dialog box and click Go To (or double-click the audit record).
   Once you browse to an error location an 'x' appears in the audit dialog box.

5. Fix the error using any of the AutoCAD Electrical editing tools.
   After correcting the error, you can select another audit record in the dialog box for correction.

6. Click Close after correcting errors, Save As/Save All if you want to save the report, or Print if you want to print the report.

NOTE Run the Drawing Audit tool to perform wire-related clean-up functions automatically. You can look for problems related to missing wires which were connected via gap pointers, clean up wires pointing to non-existent wire numbers, erase wire numbers that are not linked to a wire network, and draw a red outline around each wire entity.

Clean the drawings

1. Select Projects ➤ Extras ➤ Clean Drawing Utility.
2 On the Clean Drawing Utility dialog box, select the drawings to clean: drawings in the active project, a single drawing, or all drawings in a selected folder.

3 (Optional) Click Purge All to run the AutoCAD Purge command and purges all unused items (such as block definitions, dimension styles, layers, linetypes, and text styles).

4 Click OK.

5 If you selected to clean all drawings in the active project, select the drawings to process and click OK.

New, clean copies of the selected drawings are created and inserted into the drawing.

**Use the debug tool**

If you receive a message that AutoCAD Electrical is having trouble updating your project's scratch database file, you may want to turn on the Debug Trace. This can help track down the problem. Select one of the following commands:

- Select Projects ➤ Extras ➤ Command Trace Mode ➤ MDB Command Trace On.
  
  To turn the tracing off, select Projects ➤ Extras ➤ Command Trace Mode ➤ MDB Command Trace Off.

- Select Projects ➤ Extras ➤ Command Trace Mode ➤ Command Trace On.
  
  To turn the tracing off, select Projects ➤ Extras ➤ Command Trace Mode ➤ Command Trace Off.

**Check, repair, or trace wire and gap pointers**

The Check/Repair Gap Pointers utility verifies that the invisible Xdata pointers on both sides of a wire gap/loop are valid. If not, appropriate pointers are established. The Check/Trace a Wire utility single steps through and highlights each connected wire of the selected wire network.
Check/repair wire gaps

Use this utility to create wire number jumps (on the current drawing) without resorting to individual signal source/destination arrow symbols.

1. Click the arrow on the Insert Wire tool to access the Check/Repair Gap Pointers tool.

2. Click the Check/Repair Gap Pointers tool.

3. Select each wire segment as directed.
   Gap data is added as needed. The result of the check/repair is shown in the command prompt area.

Check/trace a wire

Overview of real-time error checking | 1179
This utility can help you troubleshoot problems with unconnected or shorted wires and invalid wire crossing gap pointers.

1. Click the arrow on the Insert Wire tool to access the Check/Trace a Wire tool.

2. Click the Check/Trace a Wire tool.

3. Select a wire on the network. You can select "A" to show All Segments. If you prefer to step through wire by wire, press the spacebar.

4. Determine whether to pan or zoom the selected wire. The connected wire segments endpoints are shown in the command prompt area.

**Check multiple wires**

1. Select Projects ➤ Reports ➤ Drawing Audit from the menu.

2. Select whether to process the active drawing or the entire project, and click OK.

3. Indicate which areas to check for errors. You can look for problems related to missing wires which were connected through gap pointers, clean up wires pointing to nonexistent wire numbers, erase wire numbers that are not linked to a wire network, and draw a red outline around each wire entity.

4. Click OK.

The Drawing Audit utility displays a report of wire-related clean-up functions that were performed.

**Electrical audit**

This utility identifies problems that affect the active project. When you run the command, the progress bar describes the progress of the audit process. Once the audit is complete, a text box displays the total number of errors.
found. Click Details to view the detected problems, and then go to the error location within the project and correct the error.

Access:

Click the arrow on the Schematic Reports tool to access the Electrical Audit tool. From the Projects menu, select Reports ➤ Electrical Audit.

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wire - No Connection</td>
<td>Displays the unconnected wires for the active project. The report lists the unconnected wire number, location point, error message, and the drawing where the error occurs. If there isn't a record of a wire number, the wire number column is blank.</td>
</tr>
<tr>
<td>Wire Exception</td>
<td>Displays missing or duplicated wire numbers for the active project. The report lists the duplicated wire number, error message, and the drawing where the error occurs. If a wire number is missing, the wire number column is blank.</td>
</tr>
<tr>
<td>Cable Exception</td>
<td>Displays the duplicated cable and wire id for the active project. The report lists the duplicated cable tags or cable tags with duplicated wire id, error message, reference of the cable tag, and the drawing where the error occurs.</td>
</tr>
<tr>
<td>Component - No Catalog Number</td>
<td>Displays components with no bill of material part assignments. The report lists the component reference designation tag, reference of the component tag, error message, and the drawing where the error occurs.</td>
</tr>
<tr>
<td>Component Duplication</td>
<td>Displays the duplicated schematic/panel components. The report lists the schematic/panel component reference designation tag, reference of the component tag error message, and the drawing where the error occurs.</td>
</tr>
<tr>
<td>Component - No Connection</td>
<td>Displays component connections with no connected wires. The report lists the component reference designation tag, reference of the component tag, error message, and the drawing where the error occurs.</td>
</tr>
</tbody>
</table>
Displays duplicated schematic terminal numbers. The report lists the terminal tag id and duplicated terminal number, reference of the terminal number, error message, and the drawing where the error occurs.

**NOTE** Terminal numbers listed in WDN files (located in the same folder as the project definition file (*.wdp)) are not checked for duplications. You can use wildcards to exclude a range of terminals for duplication checking making use of this text file.

Displays duplicated component pin assignments. The report lists the schematic component reference designation tag and component wire connection pin, reference of the component tag, error message, and the drawing where the error occurs.

Displays any children without a parent schematic component. The report lists the component reference designation tag for the child without a parent, reference of the child component tag, error message, and the drawing where the error occurs.

Displays the recovery tip so that you can fix the error.

Goes to the error location within the project and correct the error. This is enabled when you select a single audit record in the dialog box. Once you browse to an error location an "x" appears in the left-hand column of the Electrical Audit dialog box.

**NOTE** You can also double-click an audit record to go to the error location.

Saves the audit report. Save As saves only the active report while Save All saves the complete audit report.

Prints the audit report.

**Drawing audit**
The Drawing Audit tool displays a report of wire-related clean-up functions that were performed.

Access:

Click the arrow on the Schematic Reports tool to access the Drawing Audit tool.
From the Projects menu, select Reports ➤ Drawing Audit.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit drawing or project</td>
<td>Specifies to run the audit on the active drawing or selected drawings in the active project.</td>
</tr>
<tr>
<td>Previous</td>
<td>Redisplays the last audit report that was run. You can then surf to the performed function, save the report, or print the report for reference.</td>
</tr>
<tr>
<td>Surf</td>
<td>Goes to the error location within the drawing where the error occurred and was fixed.</td>
</tr>
</tbody>
</table>

After you click OK, you can select the type of drawing audit to run. If you selected to audit the project, select the drawings in the active project to audit, and click OK.

- **Wire gap pointers**
  Looks for problems related to missing wires which were connected via gap pointers. Also see Wires ➤ Wire Numbers Miscellaneous ➤ Check / Repair Gap Pointers.

- **Bogus wire number and color/gauge label pointers**
  Looks for and cleans up wires pointing to nonexistent wire numbers (this is the opposite of wire number floaters). Also looks for bad color/gauge label pointers.

- **Zero length wires**
  Looks for and erases zero length line entities on the wire layer.

- **Wire number floaters**
  Looks for and erases wire numbers that are not linked to a wire network (for example, the wire was manually erased but wire number remains).

- **Show wires (mark in red)**
  Draws a red outline around each wire entity. (Available when running on the active drawing only.)
Modify invisible data

For some functions AutoCAD Electrical adds invisible information to a block insert or even to a specific attribute. This invisible data is called Xdata. To add or modify this invisible data, AutoCAD Electrical provides an Xdata editor.

Edit existing invisible data

1 Select Projects ➤ Extras ➤ Xdata Editor.
2 Select an attribute in the drawing.
3 If Xdata exists for the attribute, select the Xdata to edit from the list in the dialog box.
   The existing name and value will be shown in the edit boxes allowing you to edit them.
4 Edit the name and value as desired. Once you click out of the edit box, the name or value will be updated in the list.
5 Click Save Changes to update the selected block or attribute with the Xdata changes.

Add invisible data to an attribute

1 Select Projects ➤ Extras ➤ Xdata Editor.
2 Select an attribute in the drawing.
   If the selected block or attribute does not carry any Xdata, the list box will indicate this.
3 Click Add New.
4 Enter the name for the Xdata and its value. Click OK.
5 Click Save Changes to update the selected block or attribute with the Xdata changes.

Xdata editor
For some functions AutoCAD Electrical adds invisible information to a block insert or even to a specific attribute. This invisible data is called Xdata. To add or modify this invisible data, AutoCAD Electrical provides an Xdata editor.

**Access:**

From the Projects menu, select Extras ➤ Xdata Editor. Select an attribute in the drawing.

The dialog displays showing any existing Xdata information. If the selected block or attribute does not carry any Xdata, the list box will indicate this. If the selected block or attribute carries any Xdata already, the names and values will be displayed in the list box at the top of the dialog.

**Name**

Specifies the Xdata name. To edit the name, click on it in the list. The existing name is shown in the edit boxes allowing you to edit it. Once you click out of the edit box, the name is updated in the list.

**Value**

Specifies the Xdata value. To edit the value, click on it in the list. The existing value is shown in the edit boxes allowing you to edit it. Once you click out of the edit box, the value is updated in the list.

**Add New**

Adds new Xdata information. Enter in the application name for the Xdata and its value.

**Delete Xdata**

Removes the selected Xdata from the list.
Advanced Productivity

In this chapter

- Set up peer-to-peer component relationships
- Create automated pin assignments
- Set up AutoCAD Electrical for multiple users
- Show source and destination markers on cable wires
- Use the PLC Database File Editor
- Add your own symbols, circuits and commands to the icon menu
- Build your own symbols
- Configure projects for various drawing standards
- Use Autodesk Vault with AutoCAD Electrical
The following example has a valve representation on an instrument drawing, FE100, and its equivalent on the electrical schematic, SOL2500. They are the same physical device, but carry different tags based on the drawing discipline in which they appear. Though each device is represented as a parent symbol, you can set up a peer-to-peer relationship between them so that the electrical schematic’s tag name automatically cross-references to the instrument drawing, and the instrument bubble’s tag cross-references to the schematic’s tag.

The instrument bubble symbol is set up with an optional split tag. Instead of a single TAG1 attribute, it has 2 tags: TAG1 PART1 and TAG1 PART2. The instrument bubble is also set up as a normal AutoCAD Electrical parent schematic symbol without the wire connection points. It includes 2 extra attributes beyond what a normal parent symbol carries:

■ WDTAGALT - carries a copy of the schematic symbol’s TAG1 value.

■ WDTYPE - an invisible attribute with a nonblank value indicating the drawing discipline. Example: “PID” or “IN” or “PNEU” or “HYD.”

The schematic parent solenoid symbol includes just one extra attribute: WDTAGALT carries a copy of the instrument bubble’s value.

Your drawings must be part of the active AutoCAD Electrical project so that the WDTAGALT value on the instrument drawing is automatically updated when you edit the schematic parent tag name and vice versa. Using AutoCAD Electrical SURF on one automatically includes the other in the surf pick window.

1. Open the Project Manager.
2. Open the project containing the instrument and schematic drawings.
3. On the Project Manager, double-click the schematic drawing to open it.
4. Zoom in so that your schematic symbol is visible.
5 On the Project Manager, double-click the instrument drawing to open it.

6 Zoom in so that your valve representation is visible.

7 On the Project Manager, right-click the project name, and select Properties.

8 On the Project Properties, Cross-References dialog box, Cross-Reference Options section, select Peer-to-Peer.

9 Click OK.

10 Right-click the schematic symbol to edit in the drawing (in this case, SOL2500).

11 Select Edit Component from the context menu.

12 On the Insert/Edit Component dialog box, click Tags Used: Schematic.

13 Select Show all components for all families. The tag values from the other symbol are displayed in the list.

14 Select the valve representation (in this case, FE100) with a family code of IN (for instrument).

15 Click Copy Tag.

16 On the Copy Tag dialog box, click WDTAGALT.

17 On the Insert/Edit Component dialog box, click Show/Edit Miscellaneous.

18 Verify that the WDTAGALT value lists the valve's TAG1 value (in this case, FE100) and click OK.

19 On the Insert/Edit Component dialog box, click OK.

20 On the Update Other Drawings dialog box, click Now to update the drawing.
The schematic symbol's WDTAGALT value is automatically updated and the valve's TAG1 value (or TAG1 PART1/TAG1 PART2 combined value) displays next to the symbol in the drawing.

The valve's WDTAGALT value is automatically updated and the schematic symbol's TAG1 value displays next to the valve in the drawing.

Create automated pin assignments

AutoCAD Electrical consults a Pin List database when a part number is added or an existing part number is changed on a parent schematic symbol. If AutoCAD Electrical finds a match on the part number's MFG, CAT, and optional ASSYCODE values (which ties to the catalog number to make unique parts) in this database table, then the associated contact count and pin number information is retrieved and placed on the parent schematic component.

Any device can have pins assigned to it, but common components that carry pin assignments are relays, motor starters, and connectors. Pins are used for:

- Error checking
- Accurate connection information
- Providing correct connections

You can expand the Pin List database table as needed. Many users have difficulty creating their own database entries so the following procedures simplify this procedure for you.

**Basic workflow**

Pin lists are directly associated to catalog numbers and therefore are not applied to a component symbol until the catalog number has been assigned. You can use wildcards inside the Pin List database to find the catalog number to apply
a single pin list to multiple symbols. The basic workflow for pin numbers being assigned to a symbol is as follows:

- Insert a component.
- On the Insert/Edit Component dialog box, assign a catalog number.
- Pin List database is queried.
- Coil pins are applied to the parent symbol’s terminal attributes.
- The Pin List is applied to the parent symbol as xdata or attributes.
  If the pin numbers are assigned as xdata, there isn’t a PINLIST attribute since the pin assignment comes from the pin list table.

**Setting up COILPINS**

The COILPINS column in the Pin List database specifies the terminal pin numbers for a coil or parent symbol of a component. This is generally two pin numbers separated by a comma (such as K1,K2). When a component calls for additional pin assignments on the parent, you can continue the list with each value separated by commas. These values are applied to the TERM01 and TERM02 attributes respectively on the parent symbol.

If you set COILPINS = "K1,K2;" then pins K1/K2 are assigned to the parent symbol of a component.

In the example below, TERM01 = K1 and TERM02 = K2.

![Diagram of CR101 with labels K1 and K2](image)

**Setting up COILPINS for two wired devices**

The automatic pin list look-up and assignment at component insertion time is not limited to relay devices as shown in the example above. You can encode two wire devices like pilot lights or proximity switches into the database file. Insert the Manufacturer and Catalog numbers and fill in the COILPINS field with the terminal pin numbers. Leave the PINLIST field blank. Now, when you insert one of these devices and do a catalog lookup and part number selection, AutoCAD Electrical quickly looks for a MFG/CAT match in the pin list database. On a match, AutoCAD Electrical pulls out the device’s coil pin numbers and inserts them in the newly inserted device.
Setting up a PINLIST

The PINLIST column in the Pin List database specifies the contact types and their respective pin numbers. A two terminal contact has three elements in this format: contact type, terminal pin, terminal pin. Each PINLIST value can have up to 256 characters. Use a value from 0-5 to specify the contact type, where:

- 0 = convertible contact
- 1 = N.O.
- 2 = N.C.
- 3 = Form-C (NO/NC pair)
- 4 = multiple-pole terminal strips or undefined type
- 5 = multiple-pin or stacked terminals

If you set PINLIST = "0,13,14;0,23,24" then 0= contact type, 13 (or 23)= TERM01, and 14 (or 24)= TERM02.

If you set PINLIST = "0,13,14,*prompt," *prompt" adds a description label. This optional label is always the last element of the list and is preceded by an asterisk character (if the asterisk is left out, the comment is interpreted as another pin number).

To view or manually edit the PINLIST values, select Edit Component, and then click NO/NC Setup on the Insert/Edit Component dialog box.

Setting up PEER_COILPINS and PEER_PINLIST

The PEER_ fields in the Pin List database specify pin list assignments for a single part number with two parent devices. You set up the second coil's coil pins and pin list data in the PEER_COILPINS and PEER_PINLIST fields for the common part number. This is commonly used for setting up forward and reversing starters or latching and unlatching relays. You apply the pins to the forward (latching) relay, and then apply the peer pins to the reversing (unlatching) relay.

To split the pin list data between two peer coil symbols:

1. Insert the first coil symbol and make the catalog look-up selection. The COILPINS and PINLIST data is found and applied to the coil symbol. Any defined peer coil and pinlist data is also saved on the symbol as invisible xdata.
2 Insert the second coil symbol but do not make a catalog assignment.
3 In the Insert/Edit Component dialog box, click NO/NC Setup.
4 Click Pick.
5 Select the first coil symbol.
   The saved peer pinlist data is moved from the first symbol over to this peer symbol. Child contacts can now be auto-annotated with the selected coil’s available pin list information and max NO/NC count tracked on a per-coil basis.

**Set up AutoCAD Electrical for multiple users**

You can manually move any shared files to a new central location after installation by using normal Microsoft Windows operations to cut or copy and paste from their local location to a central shared location. These shared files are located by AutoCAD Electrical as long as they are placed in the AutoCAD Electrical defined path (such as in the project’s subdirectory), the path given by the AutoCAD Electrical environment variable, or AutoCAD search paths.

**NOTE** We recommend that you create a backup of your information in another location and remove the shared data from your local drive to ensure the data is being located correctly.

**Shared files**

The following shared files can be pasted from your local machine to a shared location. The table lists the file names, default location, and any WD.ENV file lines that must be modified.

The main executables and static support files are located under C:\Program Files [(x86)]\Autodesk\Acad {version}\, while user-modifiable support files and database content are found under C:\Documents and Settings\{username\}\Application Data\Autodesk\AutoCAD Electrical\{release #}\{country code\}"
NOTE It is not required that you share these files, but sharing makes it easier for multiple users to work with projects in AutoCAD Electrical.

Databases

default_cat.mdb, footprint_lookup.mdb, schematic_lookup.mdb, wd_lang1.mdb, wd_picklist.mdb, wddinrl.xls
C:\Documents and Settings\{username}\My Documents\Acads\version\AeData\Catalogs

WD.ENV file edit:
Original path: WD_CAT,%WD_DIR%/catalogs/, AE catalog file path
Edited path: WD_CAT,N:Electrical/Shared_Files/Catalogs/, AE catalog file path

NOTE These files must be kept in the same location since the program locates them according to the same WD.ENV file entry.

Symbol libraries

jic1, jic125, iec2, iec4, jis2, gb2, panel, pneu_iso125
C:\Program Files [(x86)]\Autodesk\Acads\version\Libs

NOTE The symbol library path is stored with each project in its .wdp file and must be modified.

AutoCAD Electrical icon menu (Insert Component menus)

ACE_AS_MENU.DAT, ACE_GB_MENU.DAT,
ACE_HYD_MENU.DAT, ACE_IEC_MENU.DAT,
ACE_JIC_MENU.DAT, ACE_JIS_MENU.DAT, ACE_PANEL_MENU.DAT, ACE_PID_MENU.DAT,
ACE_PNEU_MENU.DAT, WD_ABECAD.DAT
C:\Documents and Settings\{username}\Application Data\Autodesk\AutoCAD Electrical\{release #}\{country code}\Support

NOTE The menu path is stored with each project in its .wdp file and must be modified.

Slide images for AutoCAD Electrical menus

ACE_GB.slb, ACE_JIS.slb, ace_as.slb, ace_hyd.slb,
ace_pid.slb, bb.slb, iec1.slb, loc2.slb, pn0.slb, pn1.slb,
pn2.slb, pn3.slb, pnl2.slb, pnl.slb, s1.slb, s2.slb, Ww.slb
C:\Documents and Settings\{username}\Application Data\Autodesk\AutoCAD Electrical\{release #}\{country code}\Support
C:\Program Files [(x86)]\Autodesk\Acade {version}\Support

**WD.ENV file edit:**
Original path: "WD_SLB,x:some path/, to override path pointing to ".slb" slide lib support files
Edited path: WD_SLB,N:/Electrical/Shared_Files/Slides/, to override path pointing to ".slb" slide lib support files

**NOTE** For the path in the .env file to be recognized, the asterisk (*) in front of the line must be removed. These slide files may be relocated using this path, or they can just be placed in the same location as the menu files.

**PLC database/images**
Content of PLC folder (ace_plc.mdb and bitmap files)
C:\Documents and Settings\{username}\My Documents\Acade {version}\AeData\PLC

**NOTE** These files must be in a location that is specified as an AutoCAD Support path. They can be placed in a location that is already defined as being a support path, or you can add a new support path pointing to this location.

**Description selections**
wd_desc.wdd
C:\Documents and Settings\{username}\Application Data\Autodesk\AutoCAD Electrical\{release #}\{country code}\Support

**NOTE** These files must be in a location that is specified as an AutoCAD Support path. They can be placed in a location that is already defined as being a support path, or you can add a new support path pointing to this location.

**Installation code selection list**
default.inst
Optional file, does not exist by default. To create this file in Notepad, create a file with the project name and an .inst extension (or use default.inst) and save to an AutoCAD Support path so the program can find it.

Set up AutoCAD Electrical for multiple users | 1195
**Location code selection list**

<table>
<thead>
<tr>
<th>Default</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>default.loc</td>
<td>Optional file, does not exist by default. To create this file in Notepad, create a file with the project name and a .loc extension (or use default.loc) and save to an AutoCAD Support path so the program can find it.</td>
<td></td>
</tr>
</tbody>
</table>

**Using network deployment**

You can alternately install AutoCAD Electrical databases, symbol libraries, part footprint files, and support files to a shared network location, so all users can work from a common standard database and simplifying database management and configuration.

To start network deployment, select Network Deployment in the AutoCAD Electrical installation program. Install the Network Installation Wizard (NIW) and run it from the start menu. From the NIW you can create an image for client installations.

Use the Symbols Libraries, Catalog Database and Support Files dialog box to install these files to a shared network location so that multiple users can work from a common standard symbol library and parts database.

**Referencing icon menus from other menu files**

You can also share custom symbols to be accessed by multiple users. The easiest way to do this is to create and link to your own menu file.
You can set up AutoCAD Electrical’s icon menuing system so that you can switch back and forth from the default menu file (such as ACE_JIC_menu.dat) to your own menu (for example "special_menu.dat").

1 Add a line similar to this to AutoCAD Electrical’s ACE_JIC_menu.dat file:
   Special menu|special_menu.sld|$C=(c:wd_loadmenu "special_menu.dat")c:wd_insym_go2menu 0)

2 In your new "special_menu.dat" file, add this line so you can switch back to AutoCAD Electrical’s default menu:
   Default Electrical menu|back2wd.sld|$C=(c:wd_loadmenu "ACE_JIC_menu.dat")c:wd_insym_go2menu 0)

3 In AutoCAD Electrical’s default icon menu, select the new entry. Your menu immediately appears. When you want to go back to AutoCAD Electrical’s default menu, select Default Electrical menu on your own special menu. AutoCAD Electrical immediately switches back to the AutoCAD Electrical default icon menus.

**Show source and destination markers on cable wires**

There may be times when you want to show the individual wires of a cable at each end where they connect and yet you want to show the wires coming together to form a single line cable in between the ends. Showing individual wires along the entire run of the cable is too messy or not an option.

You can use the Fan-In/Out command set to do this. The Fan-In/Out command relies on special pairs of source/destination markers plus a special layer for the single line part of the cable representation. This layer is defined in the Define Layers dialog box.
Setting up layers

1. In a blank AutoCAD Electrical drawing, click the Drawing Properties tool.
2. On the Alert dialog box, click OK to add the WD_M block.
3. In the Drawing Properties dialog box, click the Style tab. You can select the default Fan-In/Out marker style here along with defining the layers for the wires. Notice that the default layer name for fan in/out single line layers is "_MULTI_WIRE."
4. In the Drawing Properties dialog box, click OK.
5. Click the AutoCAD Layer tool.
6. In the Layer Properties Manager dialog box, change the color of "_MULTI_WIRE" to red and the color of "WIRES" to blue for this example. The color difference illustrates how the feature works.
7. In the Layer Properties Manager dialog box, click OK.

Inserting components

1. Click the Insert Component tool.
2. In the Insert Component: JIC Schematic Symbols dialog box, select Push Buttons.
3. In the JIC: Push Buttons dialog box, select Push Button N.O.
4. Press F9 to turn SNAP on.
5. Insert the push button anywhere on the left-hand side of the drawing.
6. In the Insert/Edit Component dialog box, click OK-Repeat to insert two more push buttons directly below the first one.
7. In the Insert/Edit Component dialog box, click OK after the last push button is inserted on the drawing.
8 Repeat to insert 3 Limit Switches N.O. Insert the limit switches anywhere on the right-hand side of the drawing (slightly below the push buttons you just inserted).
**Adding wires**

1. Click the Insert Wire tool.
2. Add a wire to the top push button. Drag the wire to the right.
3. Repeat for the other two push buttons.
4. Add a wire to each of the limit switches. Drag the wires to the left.
5. Press F9 to turn SNAP off.
6. Select all of the wires and verify that they were created on the WIRES layer.
Adding source and destination markers

1. Click the arrow on the Source Destination Signals tool to access the Fan In/Out Source tool.

2. Click the Fan In/Out Source tool.

3. In the Fan In/Out Source dialog box, select Solid as the Source marker style.

4. Click the left button to set the wire connection orientation.

5. Select in the middle of the wire that is connected to the top push button.

6. In the Signal - Source Code dialog box, enter "cbla" as the code and "RED" as the description.

   If you enter the color of the wire in the Description field, AutoCAD Electrical reports use this information in the Wire Color field.

7. Click OK.

8. In the Source/Destination Signal markers (for Fan In/Out) dialog box, click Yes to insert the matching destination marker now.

   **NOTE** Since the destination wires are nearby it's easier to insert them right away. If the wires were on another drawing you could wait until later to add the destination markers.

9. In the Fan-In/Fan-Out Signal Destination dialog box, select Solid as the destination marker style.

10. Click the right button to set the wire connection orientation.

11. Select in the middle of the wire connected to the top limit switch.

    Notice that the wires for both change from blue to red and

Show source and destination markers on cable wires | 1201
the description, RED, displays on both.
AutoCAD Electrical breaks the wire and changes the appropriate wire piece to the defined layer. When inserting a source marker the wire coming out of the marker changes; when inserting a destination marker, the wire going into the marker changes.

You are prompted to define the next source.

12 Repeat for the middle and bottom wires for each group.
   For the middle wire: In the Signal - Source Code dialog box, click Use to enter "CBLA-01" as the code and enter "BLUE" as the description.
   For the bottom wire: In the Signal - Source Code dialog box, click Use to enter "CBLA-02" as the code and enter "WHT" as the description.
   Notice that the wires change from blue to red and the descriptions, BLUE and WHT, display on both sets of wires.

13 Press Esc to exit the command.

14 Select all of the wires and verify that they are on the _MULTI_WIRE layer.
Creating connecting wires

1. At the command line, type L and press Enter.

2. Click on the end of the uppermost wire and drag down across each of the wires connected to the push buttons. Continue dragging past the push buttons and click.

3. Drag your cursor to the right to create a horizontal line, and click.

4. Drag down across the ends of the wires connected to the limit switches, ending on the bottom wire and click. Press Enter to create the lines.
5 Type MA at the command prompt to run the AutoCAD MATCHPROP command.

6 Click the wire connected to the top limit switch.

7 Click each of the lines you just created. The lines change from black to red since they are taking on the properties of the wire you selected.

8 Press Enter to exit the command.
Adding cable markers

At this point you have established the link between the pushbuttons and the limit switches. You can now include a cable marker identifier that is associated with these wire connections in various wire and cable reports.

1. Click the Cable Marker tool.
2. Select to insert a cable marker.
3. Insert the cable marker on the horizontal line.
4. In the Insert/Edit Cable Marker (Parent wire) dialog box, click Catalog Data Lookup.
5. In the Parts Catalog dialog box, select the 3 conductor (second item in list) and click OK.
6. In the Insert/Edit Cable Marker (Parent wire) dialog box, delete the wire color/id value (BLK), and click OK.
7. In the Insert Some Child Components dialog box, click Close.

Use the PLC Database File Editor

AutoCAD Electrical can generate any of hundreds of different PLC I/O modules on demand, in a variety of different graphical styles, all without a single, complete I/O module library symbol resident on the system. Modules automatically adapt to the underlying ladder rung spacing, whatever that value might be, and can even be stretched or broken into two or more pieces.
at insertion time. This is all possible because AutoCAD Electrical generates PLC I/O modules via a parametric generation technique driven by a PLC database (ACE_PLC.MDB).
Creating new PLC modules

By default, when creating a new PLC module the PLC Database File Editor lists as many blank field Terminal Types as there are terminals defined in the New Module dialog box.

1  Click the arrow on the Insert PLC (parametric build) tool to access the PLC Database File Editor tool.

2  Click the PLC Database File Editor tool.

3  In the PLC Database File Editor dialog box, highlight PLCs in the PLC selection list and click New Module.

4  In the New Module dialog box, specify the following:
   ■  Manufacturer: Allen-Bradley
   ■  Series: 1746
   ■  Series Type: Discrete Input
   ■  Code (Catalog Number): 1746-IA9
   ■  Terminals: 9
   ■  Addressable Points: 8

5  Click OK.

<table>
<thead>
<tr>
<th>Terminal Type</th>
<th>Show</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Blank</td>
<td>Always</td>
</tr>
<tr>
<td>2 Blank</td>
<td>Always</td>
</tr>
<tr>
<td>3 Blank</td>
<td>Always</td>
</tr>
<tr>
<td>4 Blank</td>
<td>Always</td>
</tr>
<tr>
<td>5 Blank</td>
<td>Always</td>
</tr>
<tr>
<td>6 Blank</td>
<td>Always</td>
</tr>
<tr>
<td>7 Blank</td>
<td>Always</td>
</tr>
<tr>
<td>8 Blank</td>
<td>Always</td>
</tr>
<tr>
<td>9 Blank</td>
<td>Always</td>
</tr>
</tbody>
</table>

You now have a new blank input module with 9 terminals and 8 addressable I/O points. You now need to define some information for each terminal in the module, the most important being what symbols AutoCAD Electrical should stack together to build the module. Usually the top-most symbol for the module is a little different than the rest so that it can carry some basic information for the module that only needs to occur once in the final symbol.
Assigning Terminal Types

1. In the PLC Database File Editor dialog box, right-click Terminal Type 1 and select Edit Terminal from the context menu.

   The Select Terminal Information dialog box displays. There are 3 categories for top symbols: Top Input, Top Output, and Top Terminal. Top Input and Top Output are addressable terminals, while the Top Terminal category consists of non-addressable terminals.

2. In the Select Terminal Information dialog box, select Top Input.

   The available terminals for that category are displayed along with any recently used terminals. Each terminal shown is slightly different. It may have an input wire connection terminal or have terminals for both input and output, or it may not have a wire connection.

3. Select to use Module Info Input I/O Point Wire Left by selecting the picture and then click OK.

   The selected terminal is assigned to the Terminal Type in the PLC Database File Editor dialog box. AutoCAD Electrical looks at the block to see what attributes come in when the block is inserted. Some of the attributes come in with predefined values that can be overwritten. You will see these predefined values in the grid below the terminal type list.

4. In the PLC Database File Editor dialog box, multiple-select the next 7 terminals, right-click and select Edit Terminal.

   **NOTE** You can select multiple fields to edit at the same time by dragging your mouse across contiguous fields or by holding down the Control key while selecting non-contiguous fields.
In the Select Terminal Information dialog box, select the Input category and look at the available terminals.

```
<table>
<thead>
<tr>
<th>Terminal Type</th>
<th>Show</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input I/O Point Wire Left</td>
<td>Always</td>
</tr>
<tr>
<td>Input I/O Point Wire Left</td>
<td>Always</td>
</tr>
<tr>
<td>Input I/O Point Wire Left</td>
<td>Always</td>
</tr>
<tr>
<td>Input I/O Point Wire Left</td>
<td>Always</td>
</tr>
<tr>
<td>Input I/O Point Wire Left</td>
<td>Always</td>
</tr>
<tr>
<td>Input I/O Point Wire Left</td>
<td>Always</td>
</tr>
<tr>
<td>Input I/O Point Wire Left</td>
<td>Always</td>
</tr>
</tbody>
</table>
```

Select the Input I/O Point Wire Left terminal and click OK. All 7 terminals are assigned at the same time.

7 In the PLC Database File Editor dialog box, right-click on the last terminal and select Edit Terminal.

8 In the Select Terminal Information dialog box, select the Terminal category.

9 Click the Terminal Point Wire Right terminal and click OK.

As an alternative to the Select Terminal Information dialog box, you can use the drop-down list of predetermined Terminal Types. Click the arrow for the Terminal Type and select from the list of available terminal types.

**Setting additional terminal information**

Some modules may have terminals that are not used. When you build your PLC module on an AutoCAD Electrical drawing there is a choice inside the Module Layout dialog box to include unused/extra connections. When this toggle is not selected, all terminal entries marked as "Show: When Including Unused" in the PLC Database File Editor are skipped. When this toggle is

Use the PLC Database File Editor | 1209
selected, all entries marked with "Show: When Excluding Unused" are skipped. This gives flexibility to how a module is represented.

1. In the PLC Database File Editor dialog box, make sure all of the terminals are set to Show: Always.

2. Make sure all of the terminals are set to Optional Re-prompt: No.
   You can trigger AutoCAD Electrical to prompt for a new beginning address number when the parametric build flips from inputs to outputs or vice versa. On the line where you want AutoCAD Electrical to re-prompt for a new output address, select Output. If you want a re-prompt for a new input address, select Input from the list.

3. If you want a prompt for an automatic break in the PLC module, select the toggle in the Break After column.

4. If you want to override the rung spacing for the I/O and wire connection point spacing, enter a value in the Spacing Factor column.
   When AutoCAD Electrical generates a PLC module, it uses the current rung spacing for I/O and wire connection point spacing. When a Spacing Factor is specified, AutoCAD Electrical sees this spacing factor value on any terminal type I/O point or wire connection entry line, it uses a factor of the rung spacing. For example, a 2 for a given entry inserts this point down 2 times the rung spacing instead of a full rung spacing. A value of 1.5 inserts the point down an extra half rung spacing than normal. A value of 0.0 puts the particular I/O point at the same location as the preceding one.

**Modifying the terminal box dimensions**

The Style Box Dimensions dialog box defines the module box dimensions (such as the offset values and line properties) based upon the style number used when the PLC was created.

1. In the PLC Database File Editor dialog box, click Style Box Dimensions.

2. Select Style 2 as the graphic style for your plc module. Styles 1-5 are predefined, styles 6-9 may be user-defined. Select a style number - a sample portion of a PLC module displays.
   There are about two dozen symbols (with a file name "HP?*.dwg" where "?" is the style number) associated with each style in the \Program Files [(x86)]\Autodesk\Acade\libs\jic1 subdirectory. To create a new style, copy an existing style's symbols to one of the unused style numbers (6-9) and edit each library symbol.
3 Specify the module box dimensions for the selected style. These values set the right, left, top, and bottom offsets for the rectangle that surrounds the module. The optional Split Top and Split Bottom specify the offsets for a split module where Split Top specifies the offset for the top of a split module and Split Bottom specifies the offset for the bottom of the split module. If left blank, the rectangle Top and Bottom values are used.

4 Specify any properties for the lines that make up the box. You can set the color and line type using the properties fields. To predefine the color, enter "COLOR colorname" into the box. For line type, enter "LTYPE linetypename" in the box.

5 Click OK.

Modifying the terminal block settings

The Terminal Block Settings dialog box is used to manage the library symbols in the PLC Database File Editor. You can add a terminal to the list by clicking in any box in the last entry of the list. A blank entry line is added to the bottom of the list. You must define the block name, assign it to a terminal category for selection, give it a description, and assign a bitmap to be used for dialog displays.

The list displays the block name, category, unique description, and sample bitmap file for each terminal type.

<table>
<thead>
<tr>
<th>Block Name</th>
<th>As defined when creating the parametric PLC blocks. Block file names adhere to the naming conventions to identify the PLC style numbering in the third position and the orientation in the first position.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Used in the PLC Database File editor to easily find specific types of terminals.</td>
</tr>
<tr>
<td>Unique Description</td>
<td>These descriptions are used during the terminal type selection process. They need to be maintained as unique</td>
</tr>
<tr>
<td>Sample Bitmap File</td>
<td>This file is also used by the PLC database File editor to display a view of the terminal for selection.</td>
</tr>
</tbody>
</table>
NOTE Symbols and BMP files need to be created outside of the PLC database file editor. Symbols are found in the standard library search path, while PLC Bitmap images are maintained in the same OS folder as the PLC Database itself (Typically C:\Documents and Settings\{username}\My Documents\Acade {version}\AcadData). 

1 In the PLC Database File Editor dialog box, click Settings. The Terminal Block Settings dialog box lists the library symbols for the terminal blocks that appeared in the Select Terminal Information dialog box. Notice that row 1 lists the block file name and sample bitmap file for the terminal we selected for Terminal Type 1.

2 Switch between the various graphic styles. Notice that the block name updates depending on the style and orientation you select. For example, the block name is "HP1WA-DL" for Style 1, Horizontal. If you select Style 4, Vertical the block name changes to "VP4WA-DL".

Graphical styles are used during the operation of the PLC Parametric Selection process. These bitmap images are displayed during normal operation and selection of PLC entries and are found at C:\Program Files\Autodesk\Acade {version}\Acad. Use the same file names that are already there: P_STYEx.bmp where 'x' is the plc style 1-9.

3 Click View DWG or View Bitmap to view the PLC parametric symbols.

4 After you are done viewing the various symbols, click Cancel.

Adding terminal attributes

1 Select the first terminal in the list of terminals.

The attributes associated to the block, along with any predefined values, are displayed below the Tree Structure section of the dialog box.

<table>
<thead>
<tr>
<th>LINE1</th>
<th>LINE2</th>
<th>LOC</th>
<th>MFG</th>
<th>TAG</th>
<th>TERM</th>
</tr>
</thead>
<tbody>
<tr>
<td>RACK %1</td>
<td>SLOT %2</td>
<td>ABB-Bruderer</td>
<td>P15100</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notice that the value for the LINE1 is RACK %%1 and LINE2 is SLOT %%2. The prompting values of %%1 and %%2 are populated with what you type into the text box when prompted. The static text of Rack and Slot appears in the attribute once the PLC module is created. There are multiple prompting variables from %%1 through %%9. Prompting strings can be added to any existing attributes on the terminal block. If you wanted to add additional prompts with out using the existing attributes
you would have to modify the block file to add additional attributes such as Line3.

Top terminals are the only symbols which can accept prompts during the parametric PLC insertion process.

2 Edit each attribute value for the TAG attributes to read "IN-%%N."

Besides the Module Prompt variables, AutoCAD Electrical also supports the use of an address variable. When the module is inserted, the PLC I/O addresses are calculated based on some AutoCAD Electrical settings and the module settings. You can trigger AutoCAD Electrical to include a prefix or suffix to each address value it inserts.

The %%N represents the calculated I/O address and the IN- is the prefix that gets added to the address value. You can also use the prompt values. For example, if you want to permanently encode the rack and group numbers (%%1 and %%%2 prompts) into each I/O address value, encode each I/O address entry in the date file with "TAGA_=%%1%%2%%N."

3 If you want to assign a text constant to any attribute value, combine a text constant with the variables as shown in the module prompts and addressing examples above.

Inserting the PLC module into the drawing

1 Click Save Module to save the module to the PLC database file.

2 Click Done/Insert.

   The PLC Parametric Selection dialog box displays.

3 Click OK to insert the new PLC module onto the drawing.

4 Specify the insertion point on the drawing.

5 In the Module Layout dialog box, click OK.

6 In the I/O Address dialog box, specify a beginning I/O address or use the quick picks to select an address (such as I:/00).

7 Click OK.

   Your module should look similar to the following. The Manufacturer, Catalog Number, and Description attributes also display at the top of the module (not shown).
Add your own symbols, circuits and commands to the icon menu

AutoCAD Electrical supplies two default icon menus: one for schematic symbols and the other for panel symbols. Each menu is driven by a text file. AutoCAD Electrical defaults to icon menu ACE_<standard>_MENU.DAT (where <standard> = JIC, IEC, GB, HYD, JIS, PID, or PNEU) for schematic symbols and ACE_PANEL_MENU.DAT for panel symbols. These menu files are found in the C:\Documents and Settings\{username}\Application Data\Autodesk\AutoCAD Electrical\{release #}\{country code}\Support subdirectory.
You modify or expand the icon menus by editing the underlying icon menu text file. You can use a generic text editor and edit it manually or you can use the AutoCAD Electrical Icon Menu Wizard.

Use the Icon Menu Wizard dialog to select the function to be performed when the icon is selected from the icon menu.

- **Add component**: Inserts a symbol
- **Add circuit**: Inserts a prebuilt circuit. This causes AutoCAD Electrical to insert and explode the .dwg name supplied.
- **Add new submenu**: Starts a new submenu.
- **Add command**: Performs a command. Use Command for inserting three-phase schematic symbols and panel footprints.
**Add components to the icon menu**

The Icon Menu Wizard can be used to add or modify icons for both the schematic and panel symbol libraries.

1. Create your new AutoCAD Electrical compatible library symbol. For schematic symbols, follow the guidelines regarding the symbol ".dwg" file naming convention (page 163) and required attributes. (page 177)

2. Click the arrow on the Miscellaneous tool to access the Icon Menu Wizard tool.

3. Click the Icon Menu Wizard tool.

4. In the Select Menu File dialog box, select to modify the schematic menu file, and click OK.

5. In the Icon Menu Wizard dialog box, select Add Component to add a new icon to the menu.

   **NOTE** You can also right-click in empty space and select Add icon Component.

Three pieces of information are needed for the new icon button.
6 On the Add Icon - Component dialog box, specify the image file name and graphic to appear in the icon button. The image name can be manually typed into the edit box. You can browse to an existing .sld or .png file to assign to the icon, use an image file that matches the active drawing name, use an image file that matches a picked block on the drawing, or use an image with the same name as the block name entered for the block name.

**NOTE** Browse cannot be used if you are using a slide library (instead of individual <slide>.sld files). Manually enter these as "library name(slide name)". For example, "S1(hpb11)."

If you have not created the slide image and want to have it created automatically from the current screen image, select Create PNG from current screen image. The Icon Menu Wizard runs the AutoCAD MSLIDE command on your current screen image to create the .png and .sld file. If the file does not exist, then Create PNG from the current screen image is selected by default. If you do not want to create the image from the current drawing's displayed image, switch it off. If you want to redo an existing image, click this switch on.

7 Specify the block name to insert on the icon. The symbol's file name can be typed into the edit box or you can browse for an existing WBlocked " .dwg" file to assign to the icon, insert the full active drawing as a block, or select an existing block on the current drawing.

8 Click OK.

The new menu button displays in the menu and the text you entered for the icon label appears in the tooltip or in the list if you set the viewing option to either Icon with text or List view.
Select the appropriate Insert Component command and test your new symbol insert.

Add an icon menu page

You can add new menu pages to the AutoCAD Electrical icon menu, and then populate them with your own custom symbols. Each new page can have icon selections that cascade down to other new menu pages. Once you click OK, your trigger icon and new submenu page are added.

1. On the Icon Menu Wizard dialog box, select Add ➤ New submenu to add a new icon to the menu.

   NOTE You can also right-click in empty space and select New Submenu.

   The Create New Submenu dialog box displays. Here you can select the function that will be performed when the icon is selected from the icon menu.

   Three pieces of information are needed to trigger the new menu page.

2. On the Create New Submenu dialog box, specify the image file name and .sld or .png graphic to appear in the icon button. The image name can be manually typed into the edit box. You can browse to an existing .sld or .png file to assign to the icon, use an image file that matches the active drawing name, use an image file that matches a picked block on the drawing, or use an image file with the same name as the block name entered for the block name.

   NOTE Browse cannot be used if you are using a slide library (instead of individual <slide>.sld files). Manually enter these as “library name(slide name)”.

3. Specify the submenu’s title.
4 Click OK.
5 Select the appropriate Insert Component command and test your new symbol insert.

**Add an icon to trigger a command**

An icon can be configured to trigger an AutoCAD command, trigger an AutoCAD Electrical command, or run a program. For example, "Rectangle" can be typed into the edit box so that every time you click the box, it runs the AutoCAD Rectangle command.

1 On the Icon Menu Wizard dialog box, click Add ➤ Command.

   **NOTE** You can also right-click in empty space and select Add icon ➤ Command.

2 On the Add Icon - Command dialog box, specify the name to appear on the icon and the image file to use on the icon button.
3 Specify the command to execute when the icon button is selected.
   Click List to select from a list of AutoCAD Electrical Commands for Panel and Schematic multi-pole symbol inserts. This makes it easier for you to build the appropriate command to insert a multipole symbol or a panel symbol. To see the command line parameters for a specific AutoCAD Electrical command, select the command in the list and the parameters display at the right. If quotation marks are shown, then enclose the parameter value within quotation marks.

   **NOTE** If you select an API command that requires parameters you must manually enter the additional parameters as indicated. Commands that require parameters should be inside of parenthesis. If you use one of the AutoCAD commands from the list, no parenthesis are needed. For example, to add an icon that will insert a black flush pushbutton, Allen-Bradley, catalog number 800T-A2A, with no rotation, select the command WD_INFP from the list. When you return to the Command dialog box, you must enter in the rest of the parameters.

   ■ "family" is used for the catalog file lookup table name
   ■ "mfg" is used for the footprint lookup
   ■ "cat" is the actual catalog number
Add circuits to the icon menu

Add Circuit is the same as Insert Command except that the block file is made up of more than one AutoCAD Electrical block definitions and related wire lines.

1 On the Icon Menu Wizard dialog box, click Add ➤ Add circuit.

NOTE You can also right-click in empty space and select Add icon ➤ Add circuit.

Three pieces of information are needed for the new icon button.

2 On the Add Existing Circuit dialog box, specify the image file name and .sld or .png graphic to appear in the icon button. The image name can be manually typed into the edit box. You can browse to an existing .sld or .png file to assign to the icon, use an image file that matches the active drawing name, use an image file that matches a picked block on the drawing, or use an image file with the same name as the block name entered for the block name.

NOTE Browse cannot be used if you are using a slide library (instead of individual <slide>.sld files). Manually enter these as "library name(slide name)".

3 Specify the circuit name to insert on the icon. The symbol's file name can be typed into the edit box or you can browse for an existing WBlocked *.dwg" file to assign to the icon or insert the full active drawing as a block.

4 Click OK.

The new menu button displays in the menu.

5 Select the appropriate Insert Component command and test your new symbol insert.
Change the icon’s image

There are times when you might want to change the image associated with an icon menu choice. The AutoCAD Electrical Icon Menu Wizard provides a quick, easy way to reassign or reshoot a slide image. Slides can be saved as individual files in the AutoCAD Electrical search path or they can be maintained inside of a library of slide files called the slide library.

**NOTE** If you make custom slides or slide libraries for the menu, copy them to the same subdirectory as the menu file since AutoCAD Electrical looks for menu slides in the active icon menu file's directory.

1. On the Icon Menu Wizard dialog box, right-click an icon button to edit and select Properties.

2. On the Properties dialog box, specify the image file name and .sld or .png graphic to appear in the icon button. The image name can be manually typed into the edit box. You can browse to an existing .sld or .png file to assign to the icon, use an image file that matches the active drawing name, use an image file that matches a picked block on the drawing, or use an image file with the same name as the block name entered for the block name.

If you have not created the .png image and want to have it created automatically from the current screen image, select Create PNG from current screen image. The Icon Menu Wizard runs the AutoCAD MSLIDE command on your current screen image to create the .png and .sld file. If the file does not exist, then Create PNG from current screen image is selected by default. If you do not want to create the image from the current drawing's displayed image, switch it off. If you want to redo an existing image, click this switch on.

**NOTE** Browse cannot be used if you are using a slide library (instead of individual <slide>.sld files). Manually enter these as "library name(slide name)".

3. Click OK.

The new menu button displays in the menu.

4. Select the appropriate Insert Component command and test your new symbol insert.

Add your own symbols, circuits and commands to the icon menu | 1221
Edit the DAT file with a text editor

There may be times when you want to bypass the Icon Menu Wizard and edit the menu DAT file directly. It is important to maintain the menu file structure, otherwise your menu may not activate properly. An AutoCAD Electrical menu ".dat" file is a text file that can be viewed and edited with any text editor (ex: WordPad or Notepad). See Overview of the icon menu file. (page 760)

Best practices for icon menu changes

We recommend that you create your own icon menu and leave the AutoCAD Electrical icon menu intact. This provides you with easier migration when upgrading to the next version of AutoCAD Electrical. You can set up the AutoCAD Electrical icon menu system so that you can flip back and forth between the default ACE_<standard>_MENU.DAT (such as ACE_JIC_MENU.DAT) and your own "my_menu.dat."

1 Copy the standard menu into a new file name instead of creating the file from scratch. Open the new DAT file with a text editor and remove everything except for the top portion of the file (shown below).

**M0

INSERT COMPONENT: JIC SCHEMATIC SYMBOLS

Rename the title line to indicate that this is your very own personal menu file.

2 Add a line similar to the following in the ACE_<standard>_MENU.DAT file.

My schem menu|mymenu.sld|$C=(c:wd_loadmenu "my_menu.dat")(c:wd_insym_go2menu 0)

3 In your new "my_menu.dat" file, add a line similar to the following one so that you can jump back to the default AutoCAD Electrical icon menu.

Default AutoCAD Electrical menu|back2wd.sld|$C=(c:wd_loadmenu "ACE_JIC_MENU.DAT")(c:wd_insym_go2menu 0)

**M0

My Menu: My Companies Symbols

AutoCAD Electrical menu|back2wd.sld|$C=(c:wd_loadmenu "ACE_JIC_MENU.DAT")(c:wd_insym_go2menu 0)

4 In the AutoCAD Electrical default icon menu, click the new "My menu" entry.
Your menu should immediately appear and remains the default for subsequent component inserts. If you want to go back to the AutoCAD Electrical default menu, click the "AutoCAD Electrical menu" button you added to your custom menu. AutoCAD Electrical flips back to the default icon menu and it now remains the default for subsequent inserts.

Build your own symbols

You can use the Symbol Builder to easily create an AutoCAD Electrical symbol or to convert existing non-AutoCAD Electrical symbols. This utility builds a smart schematic symbol by either adding AutoCAD Electrical attributes to the symbol’s geometry or by converting text entities to AutoCAD Electrical attributes. You can also use AutoCAD attribute definition and editing commands to do the same thing. This tool makes the task easier by letting you quickly pick and place attributes. It tracks what attributes are present and checks your work to make sure that any required attributes are not omitted.

For this exercise, we are going to create a symbol and add AutoCAD Electrical attributes to the new geometry.

Create a parent schematic symbol

In this exercise, we are going to create a power supply using the Symbol Builder tool.
NOTE If at any time you exit out of the Symbol Builder, restart it, and select any graphics and attributes you've added so far. You can then start from where you left off.

1 In an AutoCAD Electrical drawing, click the Miscellaneous tool to access the Symbol Builder tool.

2 Click the Symbol Builder tool.

3 At the command prompt press Enter.
   You can create your own symbol rather than modify an existing symbol.

4 In the Symbol Builder: Choose symbol category dialog box, Schematic Symbol section, click Parent.

5 In the Symbol Builder - Schematic Parent or Stand-alone symbol dialog box, click Rectangle.

6 Draw a rectangle on the drawing.

Add attributes to symbol

1 In the Symbol Builder - Schematic Parent or Stand-alone symbol dialog box, click Standard.
   This option assigns attributes to the rectangle as well as sets the height and justification for each attribute. In this exercise we will add 5 attributes: TAG1, DESC1, LOC, INST and FAMILY. However you are not limited to these 5 attributes and you can include your own user-defined attributes on the AutoCAD Electrical block files. The TAG1 attribute is the only one required for a parent schematic symbol and indicates to AutoCAD Electrical that the symbol should be treated as a parent. The Component type: Schematic Parent or Stand-alone dialog box displays listing the AutoCAD Electrical attributes that you
can insert and define as part of the symbol. Once an attribute is inserted on the symbol it is disabled in the Missing attributes list. AutoCAD Electrical allows only one insertion of each attribute.

NOTE You cannot create a symbol with the Symbol Builder until the minimum attribute requirements are met. In most cases this means the TAG1 or TAG2 attribute.

2 Select TAG1, Height = 0.125 and Justify = Center.
3 Click Insert Attribute.
4 Insert the attribute above the rectangle.
   The TAG1 default code dialog box displays. The default code is the %F value of the tag format (such as "CR", "PB", "LT").
5 In the TAG1 default code dialog box, enter PS and click OK.
   Notice that the Component type: Schematic Parent or Stand-alone dialog box redisplay. The TAG1 option is now grayed out since that attribute has been placed for the parent symbol. Continue placing the rest of the attributes.

6 Select DESC1, Height = 0.125 and Justify = Center.
7 Click Insert Attribute.
8 Insert the attribute below TAG1.

![TAG1 DESC1](image)

You do not have to insert the MFG, CAT or ASSYCODE attributes at this time since they are automatically added through the Symbol Builder's WBLOCK option and set to invisible by default.

9 Insert the LOC, INST, and FAMILY attributes (in order) as indicated below.
   - LOC: Height = 0.0625, Justify = Center, Insertion point = above TAG1
Once you place the FAMILY attribute, the FAMILY code dialog box displays. The Family value generally matches the TAG1 %F value. This value is only used when naming the block.

10 Click OK.

Notice that the FAMILY and TAG1%F codes display in the Component type: Schematic Parent or Stand-alone dialog box above the Insert Attribute button. These values should both be PS.

11 Click Back to Main Menu.

Add wire connection points

1 Click Wire Connection.

You can define wire connection points and terminal text for the library symbol. The Terminal style/configuration dialog box displays.

2 Select terminal style 1=Screw.

This terminal style inserts both the graphic to represent the screw and the wire connection points.

You have to determine which direction the wire will attach to the component. In this exercise, wire connection attributes are inserted at the left, bottom, and right side of the symbol.
3 Click the button with the wire coming in from the left.

4 Insert the terminal in the center of the left-hand side of the rectangle as shown.

**TIP** Always use an AutoCAD Snap to insert the wire connection point.

Once you select the wire connection point, you can insert a terminal attribute and assign a default pin number to the attribute. The TERM01 attribute ➤ X?TERM01 wire connection point dialog box displays. The terminal number TERMxx attribute text can be linked to a wire connection point X?TERM attribute. This is done by a match on the last two characters of the TERMxx and the X?TERMxx attribute names.

**NOTE** The "xx" in TERMxx is an incrementing number based upon how many terminal attributes have been added.

Use this dialog box to move the TERM01 text, change the text height or justification, convert existing text entity to TERM-DESC01 or TERM01 attribute, and indicate that there shouldn’t be a TERM text entity for the wire connection.

5 If the TERM01 text is not where you want it, click Move and select the new location for the text.

**TIP** You may have to move the dialog out of the way to see where the terminal insertion was originally placed.

6 Click OK.

7 In the Pin number default value dialog box, enter "L1" and then click OK.
This sets "L1" as the default terminal pin number.
The Terminal style/configuration dialog box redisplays.

**NOTE** If you want to add multiple instances you can use the Multiple Insert option. This prevents you from having to insert the pins one at a time.
8 Click the button with the wire coming in from the bottom.
9 Insert the terminal in the bottom center of the rectangle.
10 In the TERM02 attribute ➤ X?TERM02 wire connection point dialog box, click OK.
11 In the Pin number default value dialog box, enter "GND" and then click OK.

12 Click the button with the wire coming in from the right.
13 Insert the terminal in the center of the right-hand side of the rectangle.
14 In the TERM03 attribute ➤ X?TERM03 wire connection point dialog box, click OK.
15 In the Pin number default value dialog box, enter "L2" and then click OK.

Your drawing should look like the following.

16 In the Terminal style/configuration dialog box, click Back to Main Menu.

The Symbol Builder - Schematic Parent or Stand-alone symbol dialog box redisplays. Notice that the number of connection points that were placed is listed next to the Wire Connection button.

Finishing the parent symbol
The additional options for creating a symbol listed below are not used for this example, but you can use them when creating your own symbol if desired.

- **Terminal**: Place the TERMxx attribute if you didn’t already place it. For example, if you had selected "None" as the terminal style earlier, you could...
now use this option to insert the TERMxx attribute for each wire connection point. You can use this option only if you already defined an AutoCAD Electrical wire connection attribute to which you want to link terminal text.

- **NO/NC:** Add an attribute for the contact state (NO, NC, NO-HC).
- **Dashed:** Inserts Dash Link Line attributes that allow the program to draw dashed link lines between a parent symbol and its related child contact. This requires special attributes at the point where the dashed line connects to the symbol.
- **Convert Text:** Converts existing text entities to AutoCAD Electrical attributes in the same location as the original text. If you windowed existing geometry and text entities at the initial prompt of the Symbol Builder, this converts the existing text entities to AutoCAD Electrical attributes “in place.” Select Convert to AutoCAD Electrical attributes to map your text/attributes to the attribute names for the selected symbol type.

1. **Click Rating.**
   Place optional rating attributes on the symbol. You can add up to 12 rating attributes. Attribute prompts that you define display in the Insert/Edit Component dialog box when you insert or edit the new symbol.

2. **In the Add Rating attributes dialog box, select 0.125 and Center for RATING1 and click Insert.**

3. **Insert RATING1 just below DESC1 on the symbol.**

4. **Select 0.125 and Center for RATING2 and click Insert.**

5. **Insert RATING2 just below RATING1 on the symbol.**
   Your symbol should look like the following.

6. **Click Back to Main Menu.**
The Symbol Builder - Schematic Parent or Stand-alone symbol dialog box redisplays. Notice that the number of rating values that were placed is listed next to the Rating button.

7 Click WBlock.

WBlock creates the symbol file to be inserted while Block creates the symbol for this drawing file only.

AutoCAD Electrical provides a default name for the new symbol. Avoid changing the first 4 letters of the file name and limit the total length to 32 characters.

NOTE If the Wblock tools is disabled you have not satisfied the requirement of the TAG1 attribute on the block. If this is the case, make sure you have inserted the TAG1 attribute.

8 Enter a file name or accept the default and click Save.

9 In the Block insertion base point dialog box, click OK.

10 Specify the insertion point. Pick the point in-line with the top terminals so that it is easy to later place on a wire.

11 When asked to insert an instance of this block now, click OK.

12 Place the symbol on your drawing. If you place the symbol on an existing rung, the wire breaks, the component tag inserts, and the wires connect to the symbol.

New symbols you create can also be inserted with the AutoCAD Electrical Insert Component or Insert Panel Component commands. You can add your new symbol to the icon menu or you can select it from the Type it or Browse dialog file selection options in the icon menu.

13 In the Insert/Edit Component dialog box, click OK.
Create a schematic terminal symbol

1. In an AutoCAD Electrical drawing, click the Miscellaneous tool to access the Symbol Builder tool.

2. Click the Symbol Builder tool.

3. At the command prompt press Enter.
   This allows you to create your own symbol rather than modify an existing symbol.

4. In the Symbol Builder: Choose symbol category dialog box, Schematic Symbol section, click Terminal - Schematic terminal (follows wire number).

5. In the Symbol Builder - Schematic Parent or Stand-alone symbol dialog box, click Rectangle.

6. Draw a square on the drawing.

Add attributes to symbol

1. In the Symbol Builder - Schematic Parent or Stand-alone symbol dialog box, click Standard.
   The Component type: Schematic Terminal dialog box displays listing the AutoCAD Electrical attributes that you can insert for the symbol. Once an attribute is inserted on the symbol it is disabled in the Missing attributes list. AutoCAD Electrical allows only one insertion of each attribute.

   **NOTE** You cannot create a symbol with the Symbol Builder until the minimum attribute requirements (TAGSTRIP) are met.

2. Select TAGSTRIP, Height = 0.125 and Justify = Center.

3. Click Insert Attribute.
4 Insert the attribute above the rectangle. Notice that the Component type: Schematic Terminal dialog box redisplay. The TAGSTRIP option is now grayed out since that attribute has been placed for the symbol.

5 Select WIRENO, Height = 0.125 and Justify = Center.

6 Click Insert Attribute.

7 Insert the attribute above TAGSTRIP.

You do not have to insert the MFG, CAT or ASSYCODE attributes at this time since they are automatically added through the Symbol Builder’s WBLOCK option and set to invisible by default.

8 Click Back to Main Menu.

Add wire connection points

1 Click Wire Connection. This allows you to define wire connection points and terminal text for the library symbol. The Terminal style/configuration dialog box displays.

You have to determine which direction the wire will attach to the component. In this exercise, wire connection attributes will be inserted at the left and right side of the symbol.

NOTE Wire connection attributes should be on all 4 sides of a terminal block so that it can be inserted in either horizontal or vertical wires.
2 Click the button with the wire coming in from the left.

3 Insert the terminal in the center of the left-hand side of the rectangle.

**TIP** Use the Midpoint OSnap to insert the wire connection point in the middle of the line.

4 Click the button with the wire coming in from the right.

5 Insert the terminal in the center of the right-hand side of the rectangle.

Your drawing should look like the following.

6 In the Terminal style/configuration dialog box, click Back to Main Menu.

The Symbol Builder - Schematic Terminal dialog box redisplays. Notice that the number of connection points that were placed is listed next to the Wire Connection button.

**Finishing the terminal symbol**

1 Click WBlock.

2 In the New Terminal block name dialog box, click No Wire Change.

AutoCAD Electrical terminals follow a specific naming convention. The first two characters are "HT". The third character is a "0" if the wire number does not change through its terminal or it is a "1" if the terminal symbol should trigger a wire number change. The 4th character is an underscore (_) if the terminal does not carry attributes for AutoCAD Electrical to process (meaning it is a blank terminal symbol). Otherwise the 4th - nth character positions are user-defined. By clicking No Wire Change the terminal block name is filled in for you.

3 Click OK.
4 Enter a file name or accept the default and click Save.
5 In the Block insertion base point dialog box, click OK.
6 Specify the insertion point. Pick the center of the square so that it is easy to later place on a wire.
7 When asked to insert an instance of this block now, click OK.

8 Place the symbol on your drawing. If you place the symbol on an existing wire, the wire breaks, the component tag inserts, and the wires connect to the symbol.
New symbols you create can also be inserted with the AutoCAD Electrical Insert Component or Insert Panel Component commands. You can add your new symbol to the icon menu or you can select it from the Type it or Browse dialog file selection options in the icon menu.

9 In the Terminals dialog box, click OK.
10 Select Wires ➤ Insert Wire Numbers from the menu.
11 Click Pick Individual Wires.
12 Select the wires on either side of the terminal.
   Wire numbers are assigned and populated on the block.
Convert existing geometry

1. Explode any existing blocks.
2. Click the arrow on the Miscellaneous tool to access the Symbol Builder tool.
3. Click the Symbol Builder tool.
4. Select any geometry and text that are to become part of the converted symbol and press Enter.
5. In the Symbol Builder: Choose symbol category dialog box, Schematic Symbol section, click Parent.
6. In the Symbol Builder - Schematic Parent or Stand-alone symbol dialog box, click Standard.
   The Component type: Schematic Parent or Stand-alone dialog box displays listing the AutoCAD Electrical attributes that you can insert for the symbol. Once an attribute is inserted on the symbol it is disabled in the attribute list. AutoCAD Electrical allows only one insertion of each attribute.
7. Select TAG1, Height = 0.125 and Justify = Center.
8. Click Pick Text.
9. Select the text you want to change to the TAG1 attribute ("ID" in this example).
   The text changes automatically from its original value ("ID") to "TAG1."
10. In the TAG1 default code dialog box, enter PB and click OK.
    Notice that the Component type: Schematic Parent or Stand-alone dialog box redisplayes. The TAG1 option is now grayed out since that attribute has been placed for the parent symbol. Continue placing the rest of the attributes.
11 Select DESC1, Height = 0.125 and Justify = Center.

12 Click Pick Text.

13 Select the text you want to change to the DESC1 attribute ("DESCRIPTION" in this example).

![DESC1 TAG1]

Finishing the parent symbol

1 Click Back to Main Menu.
   The Symbol Builder - Schematic Parent or Stand-alone symbol dialog box redisplays.

2 Click WBlock.
   AutoCAD Electrical provides a default name for the new symbol. Avoid changing the first 4 letters of the file name and limit the total length to 32 characters.

3 Enter a file name or accept the default and click Save.

4 In the Block insertion base point dialog box, click OK.

5 Specify the insertion point. Pick the center of the symbol so that it is easy to later place on a wire.

6 When asked to insert an instance of this block now, click OK.

7 Place the symbol on your drawing. If you place the symbol on an existing rung, the wire breaks, the component tag inserts, and the wires connect to the symbol.

   New symbols you create can also be inserted with the AutoCAD Electrical Insert Component or Insert Panel Component commands. You can add your new symbol to the icon menu or you can select it from the Type it or Browse dialog file selection options in the icon menu.
8 In the Insert/Edit Component dialog box, click OK.

Create a panel footprint

A panel footprint symbol can be in either of two general forms: a to-scale physical representation of the device or a generic wiring diagram representation whose main purpose is to show wire connection annotation information.

The procedure for creating a panel footprint is similar to that of creating a schematic symbol with the following differences:

■ Panel footprint symbols do not have to carry the wire connection attributes that schematic symbols almost always carry.
■ There are no parent/child versions of a symbol for panel footprint symbols.
■ Some of the attribute names are different. A panel symbol must have the P_TAG1 or P_TAGSTRIP attribute rather than the TAG1 or TAGSTRIP attribute.
■ Panel footprint symbol block naming does not follow the special naming convention. The first 4 or 5 characters of the block name for a panel symbol is not as critical as it is for schematic symbols.
In this example, we will take geometry (either geometry you just drew, geometry you have been using, or a vendor representation) and convert it to an AutoCAD Electrical panel footprint using the Symbol Builder.

1. Explode any existing blocks.
2. In an AutoCAD Electrical drawing, click the Miscellaneous tool to access the Symbol Builder tool.
3. Click the Symbol Builder tool.
4. Select any geometry and text that are to become part of the symbol and press Enter.
5. In the Symbol Builder: Choose symbol category dialog box, Panel Layout Symbol section, click Footprint.

Add attributes to symbol

Below are the minimum attribute requirements for AutoCAD Electrical to recognize a block as a panel footprint. The component footprint block must carry a minimum of one of the following:

1. In the Panel Symbol Builder dialog box, click Standard.
   This option allows you to assign attributes to the rectangle as well as set the height and justification for each attribute. There are 7 attributes that should be added to the panel symbol: P_TAG1, DESC1, DESC2, LOC, INST, MFG and CAT.

   The Component type: Panel Footprint dialog box displays listing the AutoCAD Electrical attributes that you can insert for the symbol. Once an attribute is inserted on the symbol it is disabled in the attribute list. AutoCAD Electrical allows only one insertion of each attribute.
2 Select P_TAG1, Height = 0.125, Justify = Center and Visible.
3 Click Insert Attribute.

4 Insert the attribute above the symbol graphics.
   Notice that the Component type: Panel Footprint dialog box redisplays. The P_TAG1 option is now grayed out since that attribute has been placed for the symbol. Continue placing the rest of the attributes.

5 Select DESC1, Height = 0.125, Justify = Center and Visible.
6 Click Insert Attribute.
7 Insert the attribute below P_TAG1.
8 Select DESC2, Height = 0.125, Justify = Center and Visible.
9 Click Insert Attribute.
10 Insert the attribute below DESC1.

11 Insert the LOC, INST, MFG and CAT attributes (in order) as indicated below.
   ■ LOC: Height = 0.01, Justify = Center, Invisible, Insertion point = just below DESC2 and to the left
   ■ INST: Height = 0.01, Justify = Center, Invisible, Insertion point = above LOC
   ■ MFG: Height = 0.01, Justify = Center, Invisible, Insertion point = just below DESC2 and to the right
   ■ CAT: Height = 0.01, Justify = Center, Invisible, Insertion point = above MFG
Click Back to Main Menu.

**Finishing the panel symbol**

Additional options for creating a symbol. These options will not be used for this example, but you can use them when creating your own symbol if desired.

- **Rating:** Inserts optional rating attributes. AutoCAD Electrical allows up to 12 Rating attributes. These attributes can be used for anything from amps to motor horsepower. If you insert one or more of these optional attributes, define an attribute prompt for each such as "Motor FLA" or "Voltage". These prompts display in the Panel Layout - Component Insert/Edit dialog box when you insert your new symbol.

- **Terminal/Wire Numbers:** Inserts attributes to show terminal and wire number connection annotation. For each wire number you need, select the desired wire number direction and then place the point on your new symbol. Select one of the supplied wire number or terminal styles from the menu. You can edit existing terminal styles or create your own. Learn more about creating your own terminal symbols in the AutoCAD Electrical Help.

- **Convert Text:** Converts existing text entities to AutoCAD Electrical attributes in the same location as the original text. If you windowed existing geometry and text entities at the initial prompt of the Symbol Builder, this converts the existing text entities to AutoCAD Electrical attributes "in place." Select Convert to AutoCAD Electrical attributes to map your text/attributes to the attribute names for the selected symbol type.

1. Click WBlock.
   
   WBlock creates the symbol file to be inserted while Block creates the symbol for this drawing file only.

2. Enter a file name or accept the default and click Save.

3. In the Block insertion base point dialog box, click OK.
4 Specify the insertion point. Pick a point in the center of the symbol graphics.

5 When asked to insert an instance of this block now, click OK.

6 Place the symbol on your drawing.

New symbols you create can also be inserted with the AutoCAD Electrical Insert Panel Component commands. You can add your new symbol to the icon menu or you can select it from the Type it or Browse dialog file selection options in the icon menu.

7 In the Panel Layout - Component Insert/Edit dialog box, Component Tag section, click Schematic List.

8 Select the schematic device to tie the panel footprint to from the list and click OK.

The Panel Layout - Component Insert/Edit dialog box is filled in with the schematic device information such as the tag, Installation code, Location code, Manufacturer, and Catalog Number.

9 Click OK.

Adding attributes using templates
If you do not want to use the Symbol Builder to add attributes to the panel footprint, you can use an attribute template to automatically add attributes. You can have certain attributes added to any footprint automatically at footprint insertion time. There is an attribute template drawing, C:\Program Files\Autodesk\Acade [version]\Libs\panel\wd_ptag_addattr_comp.dwg, that gets exploded and re-blocked automatically with the panel footprint as it inserts into the drawing. If this template does not exist or if it doesn't contain certain target attributes needed to carry values pulled across from the
schematics, AutoCAD Electrical annotates the footprint with the data in extended entity data format.

You can set up to have visible attributes added to any footprint automatically at footprint insertion time. There are 3 attribute template drawings:

-wd_ptag_addattr_comp.dwg component footprints
-wd_ptag_addattr_trm.dwg terminal with terminal number
-wd_ptag_addattr_wtrm.dwg terminal with wire number as terminal number

If AutoCAD Electrical finds that the template exists, a copy of it gets exploded and merged (i.e. blocked with the panel footprint as AutoCAD Electrical inserts the footprint into the drawing). Then the schematic data is added on to the footprint either as visible attribute data (if the target attribute exists) or as nonvisible Xdata if the target attribute does not exist on the footprint block.

As AutoCAD Electrical inserts a footprint and prepares to merge this attribute definition template into the block, it attempts to find the center of the inserted block by collecting and averaging the parts and pieces that make up the block. It inserts the attribute definition template at this calculated location. Next, for each attribute definition in the merged template, AutoCAD Electrical checks to see if the original block is already coming in with that particular attribute tag name. If there is no attribute with that name, the merged attribute definition stays, otherwise AutoCAD Electrical erases the merging one and keeps the existing one. AutoCAD Electrical re-blocks the added attribute definitions with the existing footprint. Finally, if there is schematic data to put on the footprint, AutoCAD Electrical annotates the attributes, if present, or writes the data out as nonvisible Xdata.

**Configure projects for various drawing standards**

AutoCAD Electrical has multiple configuration options so that you can configure your drawings in a manner that fits your needs. You can configure drawings for IEC standard or automatically override family tag codes.
Configure for IEC standard

Below is a list of configuration options (both project properties and drawing-specific properties) that are most commonly used when dealing with the IEC drawing standard and a description of each.

Project Properties

Project Properties are configured by right-clicking on the project name in the Project Manager and selecting Properties. The options configured here are project-wide options, such as the paths to symbol libraries, or drawing default options for new drawings that are created in the selected project. The drawing options defined in the Project Properties dialog box can also be applied to any drawing in the project if needed.

Project Settings Tab

Schematic Libraries

AutoCAD Electrical contains two specific IEC-type symbols, IEC2 and IEC4. The main difference between these libraries is the size of the text associated with them.

- IEC2 symbols have a text size of 2.5 for the main text items such as Component Tag, Installation, Location, Component Description, and so on.
- IEC4 symbols have a text size of 3.5 for the Component Tag and a text size of 2.7 for Installation, Location, Component Description and so on.

Schematic Icon Menu File

AutoCAD Electrical contains one IEC-specific icon menu file: ACE_IEC_MENU.DAT.

Components Tab

Component TAG Format

In IEC you may want your components to be tagged with “Sheet Number, Family Code,” followed by a number that is either sequential or reference-based. To do this, in the Tag Format edit box, enter: “%S%F%N” where %S = the sheet number, %F = the family code defined for the component being inserted and %N = the number-
Components Tab

ing scheme for the active drawing (either sequential or reference-based).
For sequential numbering, you can enter a starting number to use as a starting component number.
For reference-based numbering, you can use one of the following numbering formats:

■ X-Y Grid
■ X Zones
■ Reference Number

Component TAG Options

Defines most of the specific tagging options to conform to the IEC tagging mode. Select the option that best fits your needs:

■ Combined Installation/Location Tag Mode:
  Uses the combined installation/location tag for interpreting component tag names. For example, 100CR relay contact marked with location code PNL1 is interpreted as being associated with a different relay coil than relay contact -100CR marked with location code PNL2. If this setting is not selected, both contacts are associated with the same parent relay coil, -100CR.
  By selecting this option, your component tags are automatically prefixed with the =, +, and - where applicable.

■ Suppress dash when first character of tag:
  Suppresses any single dash character prefix in an IEC tag that does not have a leading Installation/Location prefix (i.e. "-K101" dash is suppressed to "K101" but "+LOC1-K101" remains unchanged.
  When switched OFF, it automatically adds a single dash character to an IEC tag that does not already have a single leading dash prefix and does not have a leading Installation/Location prefix.
  For example, tag "K101" becomes ".-"
Components Tab

K101* but "+LOC1-K101" remains unchanged.

**NOTE** This suppression takes place automatically in reports; and takes place graphically only when a component is inserted, edited, or retagged.

- Format Installation/Location into tag: Specifies to exclude the Installation and Location code values as part of the tag when displaying. For example, if this is not on, a tag might show up as K16 in the Surf dialog box. But if selected, the tag might show up +AAA-K16 (where AAA is the location).
- Suppress Installation/Location in tag when match drawing default: Suppresses Location and Installation values on components if they match the drawing default values.
- Suppress Installation/Location in tag on reports: Specifies to exclude Installation and Location values as part of the tag when displayed in reports.
- Upon insert: automatic fill Installation/Location with drawing default or last used: Fills the Installation and Location edit boxes on the Insert/Edit component dialog box and the attributes on the block with drawing default or last used values (if no drawing default). If not selected, these edit boxes and attributes are not filled in and are assumed.

Cross-Reference Tab

Cross-Reference Format

In IEC, you may want to configure your cross-referencing text to display the “Sheet Number - Reference Number.” To do this, in the Same Drawing

1246 | Chapter 19  Advanced Productivity
Cross-Reference Tab

edit box, enter “%S-%N” (or click the %S-%N button). You can also define the format of the cross-referencing text that references other drawings in the Between Drawings edit box.

Suppress Installation/Location codes when matching the drawing defaults

Select this if you want to suppress IEC prefixes.

NOTE You must run the Component Cross-Reference command to update any existing cross-referencing text.

Component Cross-Reference Display

In IEC, it is common to display a representation of the type of child component (Normally Open, Normally Closed or Form-C contact) in either a graphical or table format. If you select the graphical (nontable) format, you can define details of the graphical format by clicking Setup.

Styles Tab

Wire Style

In IEC, it is sometimes preferable to display wire connections as tee markers instead of connection dots. To do this, in the Wire Tee section, select the appropriate angle tee marker from the list.

Drawing Format Tab

Ladder Defaults

In IEC, the most common ladder orientation is Horizontal. In the Ladder Defaults section, configure how to display your horizontal ladders.

Format Referencing

Defines the type of referencing that is used to replace the %N value for component tag and wire number formats. In IEC the most commonly used format is X Zones.
NOTE If you want AutoCAD Electrical to place the labels for the X-Y Grid or X Zones referencing style, use the appropriate command from the Insert Ladder toolbar.

- **X-Y Grid**: All referencing is tied to an X-Y grid system of numbers and letters along the left-hand side and top of the drawing. Set your drawing’s vertical and horizontal index numbers and letters, spacing, and origin in the X-Y grid setup dialog box.

  **TIP** Use negative spacing values for Horizontal or Vertical if you want to change the X-Y grid system’s origin to be other than the upper left-hand corner of the drawing.

- **X Zones**: Similar to X-Y Grid, but there isn’t a Y-axis. Set your drawing’s horizontal labels, spacing, and origin on the X Zones setup dialog box.

  **TIP** Use negative zone spacing value if you want the zone reference origin to be at the right side of the drawing.

**Scale**

Scale for IEC drawings is normally set to mm full size.

**Drawing Properties**

Drawing Properties are configured by either right-clicking on the drawing name in the Project Manager and selecting Properties ➤ Drawing Properties, or by selecting Properties ➤ Drawing Properties. The options configured here are only applied to the drawing that they were configured on.
NOTE Options that are duplicated on the Drawing Properties and Project Properties dialog boxes are not be described in this section.

Drawing Settings Tab

IEC-Style Designators

Defines Installation and Location codes that are used for drawing defaults when placing components on the drawing and no override Installation or Location values are given on the specific component. These values are used when the Combined Installation/Location tag mode option is selected (described previously in Project Properties section).

Automatically override family tag codes

A component’s family name can be overridden at insertion time, during a later edit, or automatically using the wd_fam.dat mapping file. The wd-fam.dat file overrides the family tag code of library symbols by mapping the codes to new values. The tag code of a symbol is used in generating the tag-ID of inserted components, such as the “PB” of tag-ID “PB101.”

AutoCAD Electrical searches for this mapping file in the following order:

1. User subdirectory (C:\Documents and Settings\{username}\Application Data\Autodesk\AutoCAD Electrical\{release #}\{country code}\Support\User\)
2. Active project’s .wdp file subdirectory
3. All paths defined under AutoCAD Options ➤ Files ➤ Support Files Search Path

Depending on how you want to override component family names, you can move the wd_fam.dat file into the various locations mentioned above.

■ To always substitute a new family value for all projects you create, place the file in the User folder. (option 1)

■ To use AutoCAD Electrical defaults most of the time but sometimes override them with project-specific defaults, place the file in the project folders for the project you want to override. You can have different defaults for each project. (option 2)

■ If you want a default override from the AutoCAD Electrical default values, but sometimes want a project override to the global override, you will want
to use option 3 and 2. Place the file somewhere in the AutoCAD support path, like “C:\Program Files\Autodesk\Acad 200\Acad,” and then when you want to override these values, place the file in the project folder.

Use Autodesk Vault with AutoCAD Electrical

Autodesk Vault allows you to keep a history of your design changes. You can review how your designs have progressed and rollback to a previous version if necessary. Vault also acts as a central shared secured repository of drawings and data with the ability to search for required information across multiple drawings and projects.

The AutoCAD Vault add-in works within AutoCAD Electrical, adding data management tools to the interface. Through the AutoCAD Vault add-in, you can add files to a vault, and check files in and out. The add-in works with both DWG and image files. In AutoCAD Electrical, you work on one project at a time. The project file (.wdp) lists all the .dwgs that are part of a project. When you make a change in one drawing, all files related to that drawing automatically update.

Perform vault tasks with the Project Manager

When working with AutoCAD Electrical and Autodesk Vault, you check out projects or individual drawings from a vault location to edit. You can perform all vault tasks within the Project Manager when you are logged into the vault. You can also manage the relationships between a project file and its dependents in the vault, while standard project management operations continue to be available.

NOTE Access to vault folders depends upon the permissions you are granted. You cannot see files or folders that you do not have permissions for viewing.

AutoCAD Vault ARX adds vault features to the Project Manager once logged into the Vault. The vault commands are available by right-clicking on a project or drawing within the AutoCAD Electrical Project Manager. You can use the Project Manager to:

- Log in and out of the vault
  - Upon initial start-up of AutoCAD Electrical you are not logged into the vault. You must log into Autodesk Vault to work with projects in the vault. You can also log into the vault using the File ➤ Vault menu

- Check projects in and out of the vault
The most basic requirement of the vault is that you never work directly on a file in the vault. You must check out the project to the working folder on your local drive to edit it. When you finish working on the project, you must check the project back into the vault.

When a project file and its related drawing files are checked out of a vault, only the files that are not currently checked out are downloaded. If the working copy of a file is older than the version in the vault, you are prompted to replace the working copy. If the working copy is currently checked out, it is not replaced.

**TIP** If you want others to view updates you made to a project and you want to continue modifying the project, select the Keep Checked Out option on the Check In dialog box. This checks in the updates you made to the project and keeps the project checked out to you.

**NOTE** You must have all references of a project file downloaded to your working folder to edit the project file.

- **View the status of files in a design**
  The status icons indicate the status of your local files as compared to the same files in the vault. You can tell when the local copy is in sync with the vault and when it is not. The tooltip for each status icon describes the state of the file and suggests the next logical step. The status of a local file is updated when it is saved to disk.

**NOTE** The vault status icons are only available in the list view and only appear when you are logged into the vault.

### Setup for single user vs. multiple users

You can perform vault operations on the entire project or individual drawing files listed within the project in AutoCAD Electrical. However, in a multiple-user design environment, you can choose to check out and edit individual files as they are needed rather than checking out the entire project at once while still maintaining drawing file dependencies and versions. After you make changes to the files and check them back into the vault, the associated files simultaneously update.

Use the Project Manager to perform all vaulting operations. In AutoCAD Electrical, you can select a file (or multiple files) within a project to:

- Check in (all)
Workflow overview

1. Start AutoCAD Electrical.
2. Log into Vault.
3. In a single user environment, if you did not set a working folder yet, start Autodesk Vault Explorer and set a working folder on your local computer and then switch back to AutoCAD Electrical. In a multiple-user design environment, set the working folder on a shared network resource for the entire project team. This allows simultaneous access for all users on the same dataset and maintains the data consistency.
4. Open a project you want to add to the vault.
5. Add the opened project to the vault using the Check In or Check In Folder command.
6. Use the Open from Vault or Check Out command to open and check out the file from the vault.
7. To work on more files in the project, check out multiple files to the working folder using the Check Out All command in the Project Manager.
8. When you finish modifying the files, check them back into the vault using the Check In All command in the Project Manager. All related files update.

Best practices for vault commands

Below are the suggested workflows for using the most common vault commands with AutoCAD Electrical.

Open from vault

Use Open from the Vault to access files in the vault for viewing or editing. To modify a file from the vault, the file must be checked out to you and worked on from your local drive. You must be logged into the Autodesk Data Management Server to open and check out a file.

1. In the Project Manager, select Open Project from Vault from the project selection menu.
2 In the Select file dialog box, navigate to the project definition file, and then select it. To maintain the relationship between the drawing files that are defined in the project file, you must check out all files specified in a project file when opening a project from Vault.

3 Click Open.

Get latest version

Get Latest Version retrieves a read-only copy of the most recent design data that is checked in. You cannot modify it until you check it out using Autodesk Vault Explorer or the Vault add-in for AutoCAD-based products.

1 In the Project Manager, select a file.

2 Right-click and select:
   ■ Get Latest Version to get the most recent version of the selected project file.
   ■ Get Latest Version for All to get the most recent version of the selected project file and all of the related files.

3 In the Get Latest Version dialog box, click OK.
   The most recent versions of the selected files are downloaded from the vault. If the working copy of a file is newer than the most recent version of the file in the vault, you are prompted to choose either losing changes made to the current working copy or to not get the latest version of that file.

4 Click Settings to get the parents and children of the selected file.

Get previous version

Get Previous Version retrieves a past version of a file or a project and places a read-only copy in your working folder. Historical versions can never be modified. You can only create a new version of a file.

1 In the Project Manager, right-click a file or project, and then click Get Previous Version.

2 In the Get Previous Version dialog box, select a version of the file or project to retrieve.

3 If the file has parents and children to get, click Settings, and then specify which related files are retrieved as well.

4 Click OK.
A read-only copy of the file is placed in the local working folder. You can view the file but you cannot modify it. To modify the file, you must check it out.

**Create a project version**

Project versions are controlled by project file (.wdp) versions. The project file acts as the parent for all drawings in the project and each version of the .wdp is associated to the latest versions of the drawing at that instance. You can edit individual drawings of a project and create versions of the drawings as needed. When you want to take a project snapshot (create a project version), check out the .wdp and check it back in.

Even if the .wdp is not modified, if any drawings have newer versions, a newer version of the .wdp is created, associating all newer drawing versions.

**TIP** Use Vault Explorer to examine the relationship between versions of the project file and corresponding drawings.

**Roll back to a previous project version**

You can roll back to a previous project version using Vault Explorer, restoring the project file (.wdp) and all associated drawing and project configuration files to a previous version.

1. Close the project and drawings in AutoCAD Electrical.
2. Using Vault Explorer, examine the .wdp file and corresponding drawing versions.
3. Select the desired .wdp file.
4. Click Get Previous Version.

**Automatically check in drawings**

Some operations in AutoCAD Electrical (such as project-wide or reporting tools) cause Vault to automatically check out all affected drawings. These drawings can be automatically checked in when modifications are complete. When asked whether to check the file in, click Yes or Yes to All. If you do not want to be prompted to check in your drawings since you want the check in to happen automatically, in the Options dialog box, select Check In dialog on auto check in.

1254 | Chapter 19  Advanced Productivity
When files are checked in, comments are automatically added to help identify and distinguish between the versions of the files that are automatically created. You can modify the comments as desired during check in unless you suppressed the Check In dialog box.

**Shared sandbox guidelines**

A shared workspace is a working folder located on a shared server for all users to access. The shared workspace configuration can be used with:

- Autodesk Vault Explorer
- Autodesk Productstream
- AutoCAD Vault Add-in
- Microsoft Vault Add-in

You can choose to work in a local or shared working folder according to your design requirements. A shared working folder is highly recommended for the AutoCAD Electrical environment, especially in a multi-user situation, because it enables you and your design team to keep all files up-to-date.

To use a shared workspace, the system administrator should preset a consistent working folder for all project members to use. Assign the working folder location to the root level ($) of the vault. A shared working folder cannot be assigned to a subfolder.

**NOTE** If Inventor add-in clients will access the same vault, do not enforce a shared working folder. If Inventor and AutoCAD Electrical are sharing the same vault, the vault administrator cannot enforce the shared working folder. Each AutoCAD Electrical user must set the working folder individually to point to a common network drive.

**Rules For Using Shared Working Folders**

Using a shared workspace means multiple users may be working on the same files. All your vault operations are protected as long as you log into the vault prior to working on the files. The following guidelines will help prevent you from overwriting the changes made by someone else, and vice versa.

1. Remain logged into the vault at all times. You can use the Vault auto login option so you are automatically logged into the vault when AutoCAD Electrical starts.
If a file is currently checked out to another user, you cannot perform the following operations:

- Get Latest Version
- Get Previous Version
- Check Out

You cannot check out a file that is currently opened for read-write by another user.

You can still check out a file that is opened for read-only by another user.

You can open a file in read-only when it is currently checked out to someone else using the same working folder.

Ensure the drawings are checked back into the vault after you finish working on them so they are available to other users who may need to modify them.
AutoCAD Electrical Command

In this chapter

- AutoCAD Electrical Commands
**AutoCAD Electrical Commands**

These topics are usually called from within the command itself. If you do not find all the information you need, look further in the Help.

- **3 Phase Wire Numbers** (page 491)
- **Add Attribute** (page 431)
- **Add Connector Pins** (page 645)
- **Add/Edit Internal Jumper** (page 397)
- **Add/Edit Power Source/Load Levels** (page 1159)
- **Add Geometry** (page 1149)
- **Add Rung** (page 480)
- **Add Table to Catalog Database** (page 86)
- **Add Wire Connections** (page 1150)
- **Adjust In-Line Wire/Label Gaps** (page 511)
- **Align** (page 332)
- **Associate Terminals** (page 570)
- **Autodesk Inventor Professional Export** (page 1018)
- **Automatic Report Selection** (page 993)
- **Bend Wire** (page 659)
- **Block Replacement** (page 1154)
- **Break Apart Terminal Associations** (page 572)
- **Cable Markers** (page 449)
- **Change Attribute Justification** (page 424)
- **Change Attribute Layer** (page 403)
- **Change Attribute Size** (page 428)
- **Change/Convert Wire Type** (page 157)
- **Change Cross-Reference to Multiple Line Text** (page 414)
Check/Repair Gap Pointers (page 1178)
Check/Trace Wire (page 1178)
Child Location/Description Update (page 416)
Clean Drawing Utility (page 1177)
Component Cross-Reference (page 383)
Conduit Marker (From/To List) (page 1112)
Conduit Marker (Pick) (page 1112)
Conduit Marker Report (page 1118)
Continue Surfer (page 690)
Convert Block to Destination Arrow (page 1132)
Convert Block to Source Arrow (page 1132)
Convert Ladder (page 483)
Convert Text to Attribute Definition (page 1131)
Convert to Schematic Component (page 1129)
Copy/Add Component Override (page 365)
Copy Assembly (page 1065)
Copy Catalog Assignment (page 790)
Copy Circuit (page 385)
Copy Component (page 308)
Copy Footprint (page 1061)
Copy Function-Installation Code (page 1062)
Copy Group Code (page 1062)
Copy Level Assignments (page 1096)
Copy Location Code (page 1062)
Copy Mount Code (page 1062)
Copy Project (page 50)
Copy Terminal Block Properties (page 572)
Copy Wire Number (page 511)
Copy Wire Number (In-Line) (page 511)
Create/Edit Wire Type (page 152)
Create New Drawing (page 64)
Create New Project (page 48)
Cross-Reference Check (page 340)
Delete Component (page 332)
Delete Connector Pins (page 647)
Delete Wire Gap (page 473)
Delete Wire Numbers (page 521)
Destination Signal Arrow (page 536)
Drawing Audit (page 1182)
Drawing Properties: Components (page 116)
Drawing Properties: Cross-References (page 121)
Drawing Properties: Drawing Format (page 123)
Drawing Properties: Drawing Settings (page 96)
Drawing Properties: Styles (page 114)
Drawing Properties: Wire Numbers (page 493)
ECDS to Electrical Database Builder (page 1134)
ECDS to Electrical Drawing Convert (page 1135)
Edit Component (page 288)
Edit Conduit Marker (page 1112)
Edit Footprint (page 1047)
Edit Jumper (page 573)
Edit Language Database File (page 704)
Edit Selected Attribute (page 401)
Edit Wire Number (page 508)
Edit Wire Sequence (page 533)
Edit User Table Data (page 352)
Electrical Audit (page 1180)
Export to Spreadsheet (page 998)
Fan In/Out Destination (page 549)
Fan In/Out - Single Line Layer (page 550)
Fan In/Out Source (page 549)
Find/Edit/Replace Component Text (page 407)
Find/Replace Terminal Text (page 408)
Find/Replace Wire Numbers (page 501)
Fix Wire Numbers (page 506)
Fix/UnFix Component Tag (page 413)
Flip Wire Gap (page 473)
Flip Wire Number (page 511)
Footprint Database File Editor (page 1084)
Hide Attribute (Single Picks) (page 410)
Hide Attribute (Window/Multiple) (page 410)
Hide/Unhide Cross-Referencing (page 361)
Hide Wire Numbers (page 521)
Icon Menu Wizard (page 734)
IEC Tag Mode - Update (page 89)
In-Line Wire Labels (page 467)
Insert 22.5 Degree Wire (page 437)
Insert 45 Degree Wire (page 437)
Insert 67.5 Degree Wire (page 437)
Insert Balloon (page 1089)
Insert Component (page 284)
Insert Stand Alone Cross-Reference (page 359)
Insert Terminal (Manual) (page 1045)
Insert Terminal (Panel List) (page 325)
Insert Terminal (Schematic List) (page 1056)
Insert Terminal Strip Representation (page 1098)
Insert WBlocked Circuit (page 395)
Insert Wire (page 437)
Insert Wire Gap (page 473)
Insert Wire Numbers (page 488)
Language Conversion (page 703)
Link Catalog Number (Panel) (page 1147)
Link Catalog Number (Schematic) (page 1144)
Link Components with Dashed Lines (page 361)
Link Description (Panel) (page 1147)
Link Description (Schematic) (page 1144)
Link Item Number (Panel) (page 1147)
Link Installation Code (Panel) (page 1147)
Link Installation Code (Schematic) (page 1144)
Link Location Code (Panel) (page 1147)
Link Location Code (Schematic) (page 1144)
Link Manufacturer (Panel) (page 1147)
Link Manufacturer (Schematic) (page 1144)
Link PLC Address Description (Schematic) (page 1144)
Link Rating (Panel) (page 1147)
Link Rating (Schematic) (page 1144)
Link Split Tag (Panel) (page 1147)
Link Split Tag (Schematic) (page 1144)
Link Terminal Number (Schematic) (page 1144)
Link User (Panel) (page 1147)
Link User (Schematic) (page 1144)
List Signal Code (page 342)
Location Box (page 422)
Location Symbols (page 420)
Make Xdata Visible (page 1030)
Map Attributes from Old to New (page 1129)
Mark/Verify Drawings (page 702)
Mark Component to Pass Power (page 1160)
Merge Utility (page 783)
Missing Level/Sequence Assignments (page 932)
Modify Symbol Library (page 430)
Move Circuit (page 385)
Move Component (page 332)
Move Connector Pins (page 649)
Move/Show Attribute (page 410)
Move Wire Number (page 511)
Multiple Cable Markers (page 461)
Multiple Insert (Icon Menu) (page 284)
Multiple Wire Bus (page 436)
Panel Bill of Materials Report (page 927)
Panel Component Report (page 930)
Panel Component Exception Report (page 929)
Panel Configuration (page 1024)
Panel Nameplate Report (page 934)
Panel Terminal Exception Report (page 935)
Reverse Connector (page 642)
Reverse/Flip Component (page 339)
Revise Ladder (page 483)
Rotate Attribute (page 410)
Rotate Connector (page 640)
RSLogix 500 Export to Spreadsheet (page 268)
Save Circuit to Icon Menu (page 393)
Schematic Bill of Material Report (page 902)
Schematic Cable From/to Report (page 905)
Schematic Cable summary Report (page 904)
Schematic Component Report (page 912)
Schematic Component Wire List Report (page 907)
Schematic Connector Details Report (page 908)
Schematic Connector Plug Report (page 909)
Schematic Connector Summary Report (page 911)
Schematic Database File Editor (page 349)
Schematic Missing Bill of Material Report (page 913)
Schematic PLC I/O Address and Descriptions Report (page 915)
Schematic PLC I/O Component Connection Report (page 905)
Schematic PLC Modules Used So Far Report (page 919)
Schematic Terminal Numbers Report (page 916)
Schematic Terminal Plan Report (page 918)
Schematic Wire From/To Report (page 914)
Schematic Wire Label Report (page 920)
Scoot (page 332)
Set Wire Type (page 158)
Settings Compare (page 130)
Show Footprint Sequencing Assignments (page 1094)
Show Links (page 1150)
Show Missing Catalog Assignments (page 793)
Show Terminal Strip Sequencing Assignments (page 1094)
Show Wire Sequence (page 528)
Show Wires (page 486)
Signal Error/List Report (page 541)
Source Signal Arrow (page 537)
Special Explode (page 1141)
Split PLC Module (page 335)
Split Connector (page 335)
Spreadsheet to PLC I/O Utility (page 259)
Squeeze Attribute/Text (page 425)
Stretch Attribute/Text (page 425)
Stretch Connector (page 643)
Stretch PLC Module (page 332)
Stretch Wire (page 439)
Surfer (page 690)
Swap/Update Block (page 212)
Swap Connector Pins (page 648)
Swap Wire Number (page 511)
Symbol Builder (page 202)
Tag Child (page 1141)
Tag Child - Form C (page 1141)
Tag Child - N.C. (page 1141)
Tag Child - N.O. (page 1141)
Tag Nameplate (page 1146)
Tag Panel Component (page 1146)
Tag Panel Terminal - Terminal Number (page 1146)
Tag Panel Terminal - Wire Number (page 1146)
Tag PLC (page 1141)
Tag Schematic Component (page 1141)
Tag Schematic Terminal - Terminal Number (page 1141)
Tag Schematic Terminal - Wire Number (page 1141)
Tag Schematic Terminal - Wire Number Change (page 1141)
Terminal: Erase Internal/External Connections (page 579)
Terminal: Mark External Connections (page 579)
Terminal: Mark Internal Connections (page 579)
Terminal: Show Internal/External Connections (page 579)
Terminal List (From File) (page 582)
Terminal List (Manual Picks) (page 582)
Terminal Properties Database Editor (page 631)
Terminal Renumber (Pick Mode) (page 578)
Terminal Renumber (Project-Wide) (page 578)
Terminal Strip Editor (page 588)
Terminal Strip Table Generator (page 624)
Title Block Setup (page 715)
Toggle Angled Tee Markers (page 532)
Toggle NO/NC (page 340)
Toggle Wire Number In-Line (page 492)
Trim Wire (page 439)
Unlink (page 1151)
Update from Project Scratch Database (page 86)
Update from Spreadsheet (page 1004)
Update Signal References (page 360)
Update Stand-Alone Cross-Reference (page 360)
Update Symbol Library WD_M Block (page 142)
Update to New WD_M Block, No Changes (page 141)
Update to New WD_M Block, Values, Layers (page 141)
Update to New WD_PNLM Block, No Changes (page 141)
Update to New WD_PNLM Block, Values, Layers (page 141)
Unhide Attribute (Window/Multiple) (page 410)
Unhide Wire Numbers (page 521)
Unity Pro Export (page 281)
Unity Pro Export to Spreadsheet (page 275)
User Defined Attribute List (page 1006)
View/Edit Component Sequence (page 1095)
Wire Annotation Exception Report (page 933)
Wire Annotation of Panel Footprint (page 1077)
Wire Arrows for Reference Only (page 284)
Wire Color/Gauge Labels (page 442)
Wire/Conduit Routing Report (page 1120)
Wire Number Leader (page 511)
Xdata Editor (page 1184)
X-Y Grid Setup (page 523)
X Zones Setup (page 522)
Zip Project (page 83)
### Index

<table>
<thead>
<tr>
<th>Term</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>_PINLIST database table</td>
<td>800</td>
</tr>
<tr>
<td>.rgf files</td>
<td>991</td>
</tr>
<tr>
<td>.set files</td>
<td>938</td>
</tr>
<tr>
<td>.wda files</td>
<td>1005</td>
</tr>
<tr>
<td>.wdn files</td>
<td>1176</td>
</tr>
<tr>
<td>.wdp files</td>
<td>29, 77</td>
</tr>
<tr>
<td>.wdw files</td>
<td>1116</td>
</tr>
<tr>
<td>.ww1 files</td>
<td>1116</td>
</tr>
<tr>
<td>.xhw files</td>
<td>270</td>
</tr>
<tr>
<td>.xsy files</td>
<td>270, 280</td>
</tr>
<tr>
<td>3 Phase Wire Numbering dialog box</td>
<td>491</td>
</tr>
<tr>
<td>3-phase bus</td>
<td>435, 660</td>
</tr>
</tbody>
</table>

### A

<table>
<thead>
<tr>
<th>Term</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>ace_plc.mdb</td>
<td>225</td>
</tr>
<tr>
<td>Add Attribute dialog box</td>
<td>432</td>
</tr>
<tr>
<td>add catalog record</td>
<td>766</td>
</tr>
<tr>
<td>Add Catalog Record dialog box</td>
<td>775</td>
</tr>
<tr>
<td>Add Existing Circuit dialog box</td>
<td>744</td>
</tr>
<tr>
<td>Add Footprint Record dialog box</td>
<td>1086</td>
</tr>
<tr>
<td>Add Icon - Command dialog box</td>
<td>739</td>
</tr>
<tr>
<td>Add Icon - Component dialog box</td>
<td>736</td>
</tr>
<tr>
<td>Add New Table to MDB dialog box</td>
<td>86</td>
</tr>
<tr>
<td>Add Record dialog box</td>
<td>314</td>
</tr>
<tr>
<td>Add Spare Wires dialog box</td>
<td>1116</td>
</tr>
<tr>
<td>Alert dialog box</td>
<td>142</td>
</tr>
<tr>
<td>alternate environment settings</td>
<td>160</td>
</tr>
<tr>
<td>angled tee markers</td>
<td>530</td>
</tr>
<tr>
<td>angled wires</td>
<td>437</td>
</tr>
<tr>
<td>annotate from external file</td>
<td>302</td>
</tr>
<tr>
<td>arrow styles</td>
<td>536</td>
</tr>
<tr>
<td>assemblies</td>
<td>1064</td>
</tr>
<tr>
<td>Assign Wire Numbering Formats by Wire</td>
<td></td>
</tr>
<tr>
<td>Layers dialog box</td>
<td>504</td>
</tr>
<tr>
<td>associate terminals</td>
<td>585</td>
</tr>
<tr>
<td>Associate Terminals dialog box</td>
<td>618</td>
</tr>
<tr>
<td>associations</td>
<td>568, 585</td>
</tr>
<tr>
<td>add</td>
<td>568, 585</td>
</tr>
<tr>
<td>modify</td>
<td>568, 585</td>
</tr>
<tr>
<td>terminals</td>
<td>568</td>
</tr>
<tr>
<td>add annotate from external</td>
<td>302</td>
</tr>
<tr>
<td>blocks</td>
<td>431</td>
</tr>
<tr>
<td>child components</td>
<td>177</td>
</tr>
<tr>
<td>child update</td>
<td>416</td>
</tr>
<tr>
<td>connector parametric build</td>
<td>177</td>
</tr>
<tr>
<td>copy</td>
<td>196</td>
</tr>
<tr>
<td>copy codes</td>
<td>1061</td>
</tr>
<tr>
<td>COPYTAG</td>
<td>196</td>
</tr>
<tr>
<td>edit</td>
<td>400, 403</td>
</tr>
<tr>
<td>explode</td>
<td>1137</td>
</tr>
<tr>
<td>for schematics (all)</td>
<td>177</td>
</tr>
<tr>
<td>force to layers</td>
<td>403</td>
</tr>
<tr>
<td>hide</td>
<td>410</td>
</tr>
<tr>
<td>hydraulic symbols</td>
<td>192</td>
</tr>
<tr>
<td>in-line wire labels</td>
<td>177</td>
</tr>
<tr>
<td>insert missing</td>
<td>201</td>
</tr>
<tr>
<td>justification</td>
<td>424</td>
</tr>
<tr>
<td>layers</td>
<td>403</td>
</tr>
<tr>
<td>link</td>
<td>1137</td>
</tr>
<tr>
<td>location</td>
<td>418</td>
</tr>
<tr>
<td>map</td>
<td>1128</td>
</tr>
<tr>
<td>mapping</td>
<td>1151</td>
</tr>
<tr>
<td>mapping list</td>
<td>1005</td>
</tr>
<tr>
<td>miscellaneous</td>
<td>197</td>
</tr>
<tr>
<td>missing</td>
<td>134</td>
</tr>
<tr>
<td>move</td>
<td>403, 410</td>
</tr>
<tr>
<td>non-AutoCAD Electrical</td>
<td>197</td>
</tr>
<tr>
<td>P&amp;ID symbols</td>
<td>192</td>
</tr>
<tr>
<td>parent</td>
<td>416</td>
</tr>
<tr>
<td>parent components</td>
<td>177</td>
</tr>
<tr>
<td>plc i/o symbols</td>
<td>177</td>
</tr>
<tr>
<td>predefine</td>
<td>199</td>
</tr>
<tr>
<td>push</td>
<td>409</td>
</tr>
<tr>
<td>ratings</td>
<td>337</td>
</tr>
<tr>
<td>rotate</td>
<td>410</td>
</tr>
</tbody>
</table>
show 410
sizes 425
splices 177
split tag names 172
styles 425
tag 1137
TAG1 196
TAG2 196
template drawings 1064
terminal block footprint
symbols 192
terminal symbols 177
text conversion 1131
title block 708
use template drawings 1064
user-defined 1005
WD_M block 134
wire connections 177
wire signal symbols 177
audit 1176
drawings 1176
project 1176
AutoCAD Electrical Publish to Web -
Banner, Title Text, Options dialog box 707
Autodesk Inventor Professional 662, 667, 673, 678, 1008
import 662, 667, 678
report setup 1008
spreadsheet structure 673
wire list output 1008
Autodesk Inventor Professional Export
dialog box 1018
Autodesk Inventor Professional Wire List Data Fields to Report dialog box 843
Autodesk Vault 50
automatic fill 414
automatic report selection 991
Automatic Report Selection dialog box 994

B

balloons 1087
insert 1087

setup 1087
Batch Plotting Options and Order dialog box 695
Bill of Material Data Fields to Report dialog box 848
bill of materials 298, 300, 790–793, 902, 913, 1051, 1053
copy 790
list 300, 792, 1053
missing 793
missing report 913
multiple 298, 791, 1051
schematic report 902
block 431
values 431
block mapping 1151
block properties 568
copy 568
block replacement 1151
Block Replacement dialog box 1154
blocks 209, 330, 431, 568, 1128, 1149
add geometry 1149
attributes 431
convert 1128
properties 568
split 330
update 209
boundary box sequence 1103

C
cable conductor database 542
Cable From/To Data Fields to Report dialog box 853
cable from/to report 905
Cable Insert/Edit Data Fields to Display
dialog box 821
Cable Insert/Edit dialog box 462
Cable Label Data Fields to Report dialog box 858
cable markers 443, 466, 542
child 443
database 542
edit 443
extract 443
insert 443
cable summary report 904
catalog database table 777, 788
catalog lists 312
Catalog Lookup dialog box 101
Catalog Values dialog box 788
catalogs 86, 101, 629, 766, 777, 781, 785, 788, 790, 793
add tables 86
assignments 785
check 785
copy 790
database structure 777
expand catalog tables 766
information 766
LISTBOX_DEF 788
lookup file 101
merge database files 781
merge utility 781
missing assignments 793
modify 785
modify data 766
project-specific 785
records 766
tables 766
terminal properties database 629
values 785
Change Attribute Size dialog box 428
Change Attribute/Text Justification dialog box 424
change spreadsheet data 996
Change/Convert Wire Type dialog box 157
check contacts 1176
child attributes 196
child components 308
Child Contact and Panel Update from Schematic Parent dialog box 416
Circuit Scale dialog box 395
Cable Summary Data Fields to Report dialog box 851
circuit 384, 1214
add custom - advanced 1214
copy 384
insert 384
move 384
save 384
save icons 384
scale 384
clean drawings 1176
client subdirectories 83
client-specific libraries 83
codes 1061
command trace mode 1176
Commands 1258
Compare Drawing and Project Settings dialog box 130
compare settings 129
Component Annotation dialog box 1129
Component Annotation from External File dialog box 302
Component Cross-Reference dialog box 383
Component Data Export dialog box 999
Component Data Fields to Report dialog box 872
component exception report 943
component overrides 362
remove 362
Component Reference Listing dialog box 341
component report 912
component tables 766
component tags 411
fix 411
Component Type 203, 207
Panel Footprint, Terminal, or Nameplate dialog box 207
Schematic Parent, Stand-Alone, or Child dialog box 203
Component Wire List Data Fields to Report dialog box 863
component wire list report 907
component wiring list 1077
components 96, 209, 284, 302, 308, 312–313, 316, 323, 330, 338, 340, 349, 355, 389, 396, 400,
409, 413–414, 418, 446, 468,
698, 967, 975, 1055, 1061, 1067,
1093, 1104, 1128, 1137, 1161,
1166–1167, 1171–1172, 1176
align 330
annotate from external file 302
annotations 1128
attributes 400
block update 209
check 340, 1176
child 308
copy 308
copy codes 1061
copy group 1061
copy installation 1061
copy location 1061
copy mount 1061
descriptions 409
drawing properties 96
duplicate 1176
draw 284
delete child 308
delete lookup file 349
equipment list 316
erase 330
fence 308
flip 338
hydraulic 1166
insert 284, 308, 323
insert by catalog 313, 1055
insert from catalog lists 312
insert from panels 323
insert multiple 1067
insert panel 323
jumpers 396
link 1137
location 418
location code 414
lookup file 316
manipulate 330
move 330
P&ID 1171
pin numbers in use 284
project properties 96
reference listing 340
remove sequencing 1093
report setup 975
retag 413, 698
reverse 338
schematic symbols 284, 355, 389,
446, 468, 1161, 1167, 1172
sequence 1104
split 330
stretch 330
swap 340
tag 1137
tags 284
wire list report 967
Conduit Marker Data Fields to Display
dialog box 817
Conduit Marker Report dialog box 1118
Conduit Marker Setup dialog box 1115
conduit markers 1110, 1116, 1118, 1120
add spares 1110
block 1110
edit 1110
insert 1110
report 1118, 1120
setup 1110
spare wires 1110
support files 1116
conduit routing report 1120
conduit sequence report 1120
configuration 126
connection codes 579
erase 579
connection sequencing 525
Connector Details Data Fields to Report
dialog box 865
connector details report 908
Connector Layout dialog box 656
connector list file 667, 678
Connector Pin Numbers in Use dialog box 658
Connector Plug Data Fields to Report
dialog box 868
connector plug report 909
Connector Selection dialog box 667, 678
Connector Summary Data Fields to Report
dialog box 870
connector summary report 911
settings 362
source symbol 353
table formats 372
table setup 374, 380
table updates 377
text setup 362
unhide 361
visibility 361
cross-referencing 1188
advanced 1188

D

dashed lines 344, 361
with arrows 344
dat files 1214
data export 1008
data fields 812, 921
location from/to 921
Data Fields to Display dialog box 896
data import 662
database files 90, 781
merge 781
rebuild 90
debug 1176
default panel settings 134
default schematic settings 134
default_cat.mdb 766
default_wdt1tle.wdl 70, 83
default.grp 70
default.inst 70
default.loc 70
default.mnt 70
default.wdt 83
define format file setup 940
Define Layers dialog box 145
descriptions 409, 708
move 409
multiple 708
Descriptions dialog box 303
destination arrows 1132
convert 1132
destination codes 536
destination markers 536, 543, 1197
advanced 1197
insert 536
show 543
Din Rail dialog box 348
din rails 344
display configurations 68
dot tee markers 530
Drawing Audit dialog box 1183
drawing files 34, 38, 52, 63, 68, 82, 91–
92, 96, 129, 624, 700, 708, 1124,
1176
archive 82
changes 91, 700
clean 1176
convert 1124
create 38, 52, 63
display configuration 68
drawing properties 96
group 34
open 38, 52
preview 34
process 91
properties 96
remove 34
reorder 34
select 91
title blocks 708
unavailable 92
update 91
update settings 129
Drawing List Data Fields to Display dialog box 819
Drawing List Display Configuration dialog box 69
Drawing Properties 114, 117, 119, 121–
122, 124, 132, 494, 517, 540
Components tab dialog box 117
Cross-References tab dialog box 121
Drawing Format tab dialog box 124
Drawing Settings tab dialog box 114, 132
Styles tab dialog box 122, 540
Wire Numbers tab dialog box 119,
494, 517
drawing setup 96, 131
drawing standards 1243
advanced 1243
drawing template 131
duplicate numbers 1176
duplicate tags 1176

E
ECDS to AutoCAD Electrical 1133
Edit Attribute dialog box 401
Edit Catalog Record dialog box 775
Edit dialog box 350, 632, 796
Edit Entry dialog box 555
Edit Footprint Record dialog box 1086
edit IEC components 294
edit IEC pins 294
Edit Language Lookup File dialog box 704
Edit Miscellaneous and Non-AutoCAD Electrical Attributes dialog box 198
Edit Multi-Connection Sequence Terminal Symbol dialog box 555
Edit PLC I/O Point dialog box 249
Edit PLC Module dialog box 221
Edit Record dialog box 314, 351, 633, 798
Edit Report dialog box 88
edit schematic reports 811
edit spreadsheet reports 811
Edit Terminal dialog box 611
Edit Terminal Jumpers dialog box 576
Edit User Table Data dialog box 352
Edit Wire Connection Sequence dialog box 533
Electrical Audit dialog box 1180
Electrical Database Builder 1133
equipment list 316, 320, 1053, 1057
insert from 316
settings 320, 1057
error checking 1176
exception reports 383
explode blocks 1141
export 999
component data 999
general data 999
panel components data 999
panel terminals data 999
plc i/o descriptions data 999
plc i/o header data 999
plc i/o wire connections data 999
spreadsheet data 999
terminals data 999
export I/O 267
Export to Spreadsheet dialog box 999

F
family overrides 302
fan in/out 543
Fan-In/Fan-Out Signal Destination dialog box 549
Fan-In/Fan-Out Signal Source dialog box 549
Fan-In/Out Single Line Layer dialog box 550
fan-in/out styles 548
file formats 77
Files Unavailable for Processing dialog box 92
Find or Replace Wire Numbers dialog box 501
Find/Edit/Replace (drawing or project) dialog box 406
Find/Edit/Replace Component Text dialog box 407
Find/Replace Terminal Text dialog box 408
fix component tags 411
Fixed/Unfix Component Tag dialog box 413
Footprint dialog box 1045
footprint lists 323
Footprint Lookup dialog box 1085
footprint lookup file 313, 1055
footprint_lookup.mdb 1081
footprints 143, 313, 344, 781, 785, 1026, 1028, 1031, 1036, 1055, 1061, 1064, 1067, 1077, 1081, 1087, 1093, 1128
assign item number 1087
attributes 1028
balloons 1087
component annotations 1128
component values 785
copy 1061
copy assembly 1064
din rails 344
edit 1031
equipment list 1031
insert 1031
insert assembly 1064
insert by catalog 313, 1055
insert component 1031
insert from list 1031
insert multiple 1067
layers 143
lookup database editor 1081
lookup file 313, 1026, 1055, 1081
manual insertion 1031
mapping 1026
merge 781
panel layout symbols 1036
project-wide 1067
select component data from spreadsheets 1067
selection 1031
sequencing 1093
vendor menus 1031
vendor selection 1031
wire information 1077
Force Attribute/Text to a Different Layer dialog box 403
Format 1075
Schematic Layout Wire Connection Annotation dialog box 1075
format description text 305
format file setup 938
AIP wire list 938
bill of materials 938
cable from/to 938
cable summary 938
component 938
component exception 938
component wire list 938
connector details 938
connector plug 938
connector summary 938
missing bill of materials 938
missing level/sequence assignments 938
nameplate 938
PLC I/O address and descriptions 938
PLC I/O component connection 938
PLC modules used so far 938
terminal exception 938
terminal numbers 938
terminal plan 938
wire annotation exception 938
wire connection 938
wire from/to 938
wire labels 938
format reports 812

G
General Data Export dialog box 1000
graphical cross-reference 368
Graphical Cross-Reference Format Setup dialog box 370
graphical terminal strips 585

H
help 24
hydraulic attributes 192

I
I/O points 246
icon menu files 759
icon menu wizard 730, 1214
advanced 1214
Icon Menu Wizard dialog box 734
icon menus 730, 759–760, 1031, 1214
add circuit 730
add command 730
add component icon 730
add new icon 730
advanced 1214
alternate files 759
create circuit 730
customize 730
file format 760
modifying 760
panel layout 1031
properties 730
IEC component tag modes 89
IEC Tag Mode Update dialog box 89
import data 662
import spreadsheet data 1004
in-line markers 467
in-line wires 492
information lines 708
input file format 320, 1057
Insert Accessory dialog box 616
Insert Component dialog box 284, 355, 389, 446, 468, 1161, 1167, 1172
Insert Connector dialog box 650
Insert Destination Code dialog box 536
Insert dialog box 322
Insert Footprint dialog box 1036
Insert Ladder dialog box 478
Insert Panel Wiring Diagram Terminal Strip Representation dialog box 1098
Insert Spare Terminal dialog box 614
Insert Wire Color/Gauge Labels dialog box 442
Insert/Edit Cable Marker (2nd+ wire of cable) dialog box 458, 460
Insert/Edit Cable Marker (Parent Wire) dialog box 450, 454
Insert/Edit Child Component dialog box 309, 311
Insert/Edit Component dialog box 288, 294
Insert/Edit Conduit/Wire Way Label dialog box 1112
Insert/Edit Panel Level Assignment 1099, 1104
Component dialog box 1104
Terminal Strip dialog box 1099
Insert/Edit Terminal Symbol dialog box 560
insert/edit terminals 559
installation codes 618
internal jumpers 396
define 396
invisible data 1184

J
jr. project to AutoCAD Electrical 1133
jumper terminals 573
jumpers 573
edit 573
select 573

L
ladders 253, 475, 480–482
change rung spacing 482
change size 480
configure 253
defaults 475
from spreadsheet 253
insert 475
insert rungs 482
line reference numbers 482
move 481
references 253
renumber 480
reposition 481
Language Conversion dialog box 704
language tables 304, 703
review 304
language translation 304, 703
view 304
lastproj.fil 29
layers 143, 150
add wire 150
create wire 150
manage 143
panel components 143
panel rename 143
rename 143
schematic rename 143
setup 143
leaders 512
Level Code Edit 1103
Boundary Box dialog box 1103
level codes 1096
copy 1096

1279 | Index
level sequencing 1096, 1099, 1103–1104
copy 1096
Library Swap -- All Drawing dialog box 214
library symbols 83, 162–163, 173–174, 197, 199, 201, 429
change 429
client-specific 83
convert existing 201
create 199, 201
default location 173
hydraulic 174
manage 197
modify 197
multiple 173
naming 162–163
P&ID 174
substitute 197
text sizes 429
link information 718
link symbols 1151
linking tools 1137
links 344, 361
dashed 361
LISTBOX_DEF 788
load value 1158
Location Box dialog box 422
location boxes 422
insert 422
location codes 414, 617
insert 414
location marks 418
location symbols 418
add to menu 418
Location Symbols dialog box 420
lookup 316

merge utility 781
Merge Utility dialog box 783
miscellaneous attributes 197
Missing Bill of Material Data Fields to Report dialog box 874
missing bill of materials report 913, 977
setup 977
missing catalog assignments 793
missing level/sequence assignments 948
missing level/sequence assignments report 932
Modify Line Reference Numbers dialog box 483
Modify/Fix/Unfix dialog box 508
Module Box Dimensions dialog box 237
Module Layout dialog box 220
Module Specifications dialog box 244
MTEXT 1077
multi-connection terminals 554
multi-level terminals 568
multi-line text 414
multi-stack terminals 568
multi-tier terminals 568
Multiple Bill of Material Information dialog box 298, 791, 1051
multiple bill of materials 298, 791, 1051
multiple bill of materials lists 300, 792, 1053
Multiple Cable Markers dialog box 461
Multiple Catalog Part Number Assignments dialog box 300, 792, 1053
multiple clients 83
multiple libraries 173
Multiple Wire Bus dialog box 436

nameplates 934, 1091
create 1091
generic 1091
insert 1091
report 934
New Module dialog box 239
next 693
non-AutoCAD Electrical attributes 197
numbers 1087
assign item 1087
assign to footprints 1087
detail 1087
item number 1087
resequence item 1087

O
open drawings 693
Option 302
Tag Format "Family" Override dialog box 302
Optional ENV File Assignment for Current Project dialog box 160
override tags 302

P
P&ID attributes 192
Panel Balloon Setup dialog box 1089
Panel Bill of Material Data Fields to Report dialog box 826
panel bill of materials report 927
Panel Component Data Fields to Report dialog box 830
Panel Component Exception Data Fields to Report dialog box 828
panel component exception report 929
Panel Component Layers dialog box 149
panel component list 322–323
insert from 322
panel component report 930
Panel Components dialog box 326
Panel Drawing Configuration and Defaults dialog box 1024
Panel Equipment In dialog box 1053
panel footprint database editor 1081
Panel Footprint dialog box 313, 1055
Panel Footprint Lookup Database File Editor dialog box 1084
panel footprints 1024
setup 1024
panel footprints (see footprints) 1031
panel layers 143
rename 143
panel layout 1022, 1026
drawings 1022, 1026
toolbar 1022
tools 1022
Panel Layout - Component Insert/Edit dialog box 1047
Panel Layout - Terminal Insert/Edit dialog box 1039
Panel Layout Data Export dialog box 1002
Panel Layout List - Schematic Components Insert dialog box 325
panel layout symbols 1036
panel layers 1064
templates 1064
panel linking 1147
Panel Missing Level/Sequence Assignments Data Fields to Report dialog box 833
Panel Nameplate Data Fields to Report dialog box 837
panel nameplate report 934
panel reports 804, 923, 991
about 804
automatic generation 991
bill of materials 923
component 923
component exception 923
generate 923
missing level/sequence assignments 923
nameplate 923
terminal exception 923
wire annotation exception 923
wire connection 923
Panel Reports dialog box 923
Panel Symbol Builder dialog box 208
Panel Tag List dialog box 302
panel tagging 1146
Panel Terminal Exception Data Fields to Report dialog box 839
panel terminal exception report 935
panel terminal list 322–323
insert from 322
Panel Terminal List - Schematic Terminals Insert dialog box 325
Panel Terminal Strip Graphical Report
Parameters dialog box 1107
panel terminal strip report
parameters 1107
panel terminals 1056, 1069
Panel Terminals Data Export dialog box 1003
Panel Terminals dialog box 329
Panel Wire Annotation Exception Data Fields to Report dialog box 834
Panel Wire Connection Data Fields to Report dialog box 841
panel wire connection report 937
panel wiring diagram 1077
parameters 126
parent attributes 196
parts catalog 772
Parts Catalog dialog box 772
parts lookup 772
pass power 1158
physical representation block symbols 1026
Pick List for Panel Terminal Strip Report/Graphical Report dialog box 1107
pin list database 795–796, 798
edit 795, 798
pin list table 795
create 795
pin lists 793, 795–796, 798, 800, 1190
advanced 1190
assignments 800
create table 795
edit 796
edit record 798
type 4 800
pin numbers 306
pin numbers in use 636
Pin Numbers in Use dialog box 306
PINLIST_TYPE 800
pins 284
edit 284
piping & instrumentation symbols 1171
PLC 218, 221, 225, 246, 251, 253, 267, 525, 781, 905, 965
add modules 225
annotate modules 221
annotate points 246
build symbols 225
change settings 253
copy 225
copy modules 225
database file 225
database file editor 225
database format 253edit database 225edit modules 221
generate I/O drawings 253
generate modules 218
graphics style 225
I/O points 246
insert 218, 221
insert I/O symbol 246
insert spaces 218
insert symbol 246
ladder configuration settings 253
ladder references 253
layout modules 218
merge databases 781
modify modules 225
modify symbols 246
modify terminals 225
module dimensions 225
module layout 218
module prompts 225
parametric build 218
report 905
report format files 965
RSLogix export 267
save settings 253
selecting styles 218
selection 225
spreadsheet format 253
stand-alone I/O points 246
stand-alone points 246
stand-alone symbols 246
styles 251
symbol placement 225
update symbols 225
wire numbers 525
PLC Component Connection Data Fields to Report dialog box 859
PLC database file editor 225, 1205
advanced 1205
PLC Database File Editor dialog box 233
PLC I/O Address and Descriptions Data Fields to Report dialog box 881
PLC I/O address and descriptions report 915
PLC I/O Address/Description Export dialog box 1002
PLC I/O component connection report 905
PLC I/O Connection Export dialog box 1001
PLC I/O Header Information Export dialog box 1000
PLC I/O Wire Numbers dialog box 525
PLC Modules Used So Far Data Fields to Report dialog box 886
PLC modules used so far report 919
PLC Parametric Selection dialog box 219
PLC Selection dialog box 236
plot 694
pneumatic tools 1161
point-to-point tools 636
add pins 636
delete pins 636edit pin numbers 636
insert connectors 636
move pins 636
reverse connector 636
rotate connector 636
split connectors 636
stretch connector 636
swap pins 636
position tags 172
potential assignment 1158
power check 1158
power check report 1160
power flag 1158
power source 1158
overview 1158
report 1158
Power Source/Load Report dialog box 1160
previous 693

Project Database Table Data - Project
Drawing Files Update dialog box 86
project manager 38, 52
Project Manager dialog box 38, 52
Project Properties 99, 102, 106, 110–112, 496, 539
Components tab dialog box 102
Cross-References tab dialog box 110
Drawing Format tab dialog box 112
Project Settings dialog box 99
Styles tab dialog box 111, 539
Wire Numbers tab dialog box 106, 496
project related files 70
.wdn 70
catalog lookup 70
description defaults 70
external component 70
family code map 70
footprint lookup 70
installation codes 70
location codes 70
project labels 70
ratings defaults 70
RSLogix import 70
Spreadsheet to PLC 70
title block 70
wire color and gauge labels 70
Project Zip dialog box 83
Project-wide Schematic Terminal
Renumber dialog box 578
Project-wide Update or Retag dialog box 698
project-wide utilities 509
Project-wide Utilities dialog box 509
add drawings to a project 29
alternate environment settings 160
archive 82
collaborate 50
configure - advanced 1243
copy 29
create 29
database file 90
database table data 86
descriptions 29
file formats 77
files 29
group drawings 29
group manager 29
multiple clients 83
open 29
preview 29
properties 96
recent 29
related files 70
remove drawings 29
reorder drawings 29
save to web 705
script file 697
select 29
setup 96
task list 91
update settings 129
utilities 509
vault 50
vault - advanced 1250
promis.e 1124
convert 1124
promis.e Conversion dialog box 1125
Prompts at Module Insertion Time dialog box 245
properties 96, 131, 492, 523–524, 730
circuits 730
commands 730
component 730
components 96
cross-references 96
drawing 96
drawing cross-references 96
drawing format 96
drawing settings 131
drawing styles 96
drawing wire numbers 96
icon menus 730
project 96
set 96
styles 96
submenus 730
wire numbers 96, 492
x zones 523
x-y grid 524
Properties - Circuit dialog box 755
Properties - Command dialog box 752
Properties - Component dialog box 750
Properties - Main Menu dialog box 749
Properties - Submenu dialog box 757
Publish to Web - Temporary Folder for Build dialog box 707

R
ratings 337
 annotate 337
Ratings Defaults dialog box 337
Reassign Terminal dialog box 612
Rebuild Database File dialog box 90
records 314, 349, 351, 766, 777, 1081
 add 314
 add footprint 1081
catalog record 766
catalog structure 777
edit 314, 351
edit footprint 1081
edit schematic 349
Ref Des 1008
Remove Component Override dialog box 366
Rename Panel Layers dialog box 148
Rename Schematic Layers dialog box 148
Renumber Terminal Strip dialog box 613
replaceable parameters 126
Report Format File Setup - Missing Level/Sequence Assignments dialog box 948
Report Format File Setup - Panel Bill of Material dialog box 941
Report Format File Setup - Panel Component dialog box 946
Report Format File Setup - Panel Component Exception dialog box 943
Report Format File Setup - Panel Nameplate dialog box 951
Report Format File Setup - Panel Terminal
  Exception dialog box 953
Report Format File Setup - Panel Wire
  Connection dialog box 955
Report Format File Setup - Schematic AIP
  Wire List dialog box 957
Report Format File Setup - Schematic Bill of Material dialog box 959
Report Format File Setup - Schematic Cable
  From/To dialog box 961
Report Format File Setup - Schematic Cable Summary dialog box 963
Report Format File Setup - Schematic Component dialog box 975
Report Format File Setup - Schematic Component Wire List dialog box 967
Report Format File Setup - Schematic Connector Details dialog box 969
Report Format File Setup - Schematic Connector Plug dialog box 971
Report Format File Setup - Schematic Connector Summary dialog box 973
Report Format File Setup - Schematic Missing Bill of Material dialog box 977
Report Format File Setup - Schematic PLC
  I/O Address and Descriptions dialog box 980
Report Format File Setup - Schematic PLC
  I/O Component Connection dialog box 965
Report Format File Setup - Schematic PLC Modules Used So Far dialog box 987
Report Format File Setup - Schematic Terminal Numbers dialog box 983
Report Format File Setup - Schematic Terminal Plan dialog box 985
Report Format File Setup - Schematic Wire
  From/To dialog box 979
Report Format File Setup - Schematic Wire Label dialog box 989
Report Format File Setup - Wire
  Annotation Exception dialog box 950
  report format files 940
reports 383, 541, 810, 812, 897, 923, 991, 1005, 1008, 1107
  attribute mapping list 1005
  automatic 991
cross-reference 383
exception/error 383
export for cabling 1008
file options 810
generate 812
grouping 991
output to .csv 1008
panel 923
schematic 897
setup for export 1008
stand-alone signals 541
terminal pick list 1107
wire signal 541
resequence 698
Retag Components dialog box 413
Reverse/Flip Component dialog box 339
routing 1093
remove 1093
row styles 620
RSLogix 267
change module 267
export I/O 267
import 267
RSLogix 500 Import Change Module dialog box 269
RSLogix 500 Import dialog box 269
rung spacing 482
insert 482

S

Save Circuit to Icon Menu dialog box 393
save settings 129
save to file 810
schematic attributes 177
Schematic Component dialog box 313, 1055
Schematic Components List Panel Layout
  Insert dialog box 1044
Schematic Components or Terminals
dialog box 1070
schematic database editor 349
schematic drawing properties 96, 131
Schematic Equipment In dialog box 321
schematic ladder diagrams 1026
schematic layers 143
rename 143
Schematic Layout Wire Connection
  Annotation dialog box 1079
schematic linking 1144
schematic lists 1031, 1056, 1067, 1069
schematic lookup database 349
schematic lookup file 316, 349
  edit 349
schematic project properties 96, 99
schematic reports 525, 804, 897, 991
  about 804
  automatic generation 991
  bill of materials 897
  cable from/to 897
  cable summary 897
  component 897
  component wire list 897
  connector details 897
  connector plug 897
  connector summary 897
  control from/to 525
  generate 897
  missing bill of materials 897
  PLC I/O address and
descriptions 897
  PLC I/O component connection 897
  PLC modules used so far 897
  terminal numbers 897
  terminal plan 897
  wire from/to 897
  wire label 897
Schematic Reports dialog box 897
schematic symbols 284, 355, 389, 446,
  468, 1161, 1167, 1172
schematic tagging 1141
Schematic Terminals List Panel Layout
  Insert dialog box 1056, 1069
Schematic Wire Numbers Panel Wiring
  Diagram dialog box 1077
scratch databases 86
script file creation 697
script files 810
Select Description from AutoCAD Electrical
  Language Table dialog box 304
Select Description Text Format dialog
  box 305
Select Drawings to Process dialog box 91
Select Pin List Table dialog box 795
Select Row Cell Styles dialog box 620
Select Terminal Information dialog
  box 237
Select Terminal Properties Table dialog
  box 631
Select Terminals to Jumper dialog
  box 574
Select Xdata to Change to a Block Attribute
  dialog box 1030
sequence footprint components 1095
sequencing 1093
  remove 1093
  show 1093
Set Pass Power dialog box 1160
Set Power Source/Load Value dialog
  box 1159
Set Wire Type dialog box 159
settings 96, 99, 131, 253
  drawing properties 96, 131
  PLC I/O 253
  project properties 99
Settings dialog box 320, 1057
settings list tool 88
settings list utility 806
  table setup 806
Setup Title Block Update dialog
  box 715, 721, 725
Signal Code dialog box 342
Signal-Source Code dialog box 537
signals 342, 353, 536
destination 342
follow 342
source 342
slide files 251
source arrows 536, 1132
convert 1132
source markers 536, 543, 1197
advanced 1197
show 543
Spacing for Component or Footprint
Insertion dialog box 1073
spare terminal strips 585
Special Explode dialog box 1141
splices 685
Split Block dialog box 335
split tags 172
spreadsheet data 811, 996, 1067
components 996
edit report 811
export 996
general data 996
import 996
modify 996
panel components 996
panel terminals 996
plc i/o descriptions 996
plc i/o header information 996
plc i/o wire connections 996
terminals 996
spreadsheet import structures 673
spreadsheet mapping 1151
Spreadsheet to PLC I/O Utility dialog box 259
Spreadsheet to PLC I/O Utility Setup dialog box 262
Stand-Alone Destination Cross-Reference Symbol dialog box 359
stand-alone I/O points 246
edit 246
Stand-Alone Source Cross-Reference Symbol dialog box 359
standard description lists 303
Style Box Dimensions dialog box 243
styles 96, 536, 548
drawing properties 96, 536
fan-in/out 548
project properties 96, 536
support files 1193
advanced 1193
surf 688
codes 688
continue a previous surf 688
drawings 688
Surf dialog box 690
swap 209
library 209
update block 209
Swap Block/Update Block/Library Swap dialog box 212
swap NO/NC 340
symbol annotation 199
symbol builder 201, 1223
advanced 1223
create symbols 201
panel symbols 201
schematic symbols 201
Symbol Builder 202
Choose Symbol Category dialog box 202
Symbol Builder - Schematic Symbols dialog box 205
Symbol Library Attribute Text/Scale Resize dialog box 430
symbols 134, 162–163, 173, 197, 199, 201, 209, 353, 418, 429, 1161, 1214, 1223
add custom - advanced 1214
advanced 1223
annotate 199
convert panel 201
convert schematic 201
create 199
cross-references 353
default library 173
library 429
library swap 209
location 418
multiple libraries 173
naming 162–163
pneumatic library 1161
stand-alone 353
Table Cross-Reference Format Setup dialog box 374, 380
table cross-reference updates 377
table cross-references 368, 372, 374, 380
table generation 806
tabular terminal strips 585
tag wire numbers 484
project-wide 484
TAG1 196
TAG1_PARTX 172
TAG2 196
TAG2_PARTX 172
tagging tools 1137
Tags in Use dialog box 301
Task List dialog box 91
tasks 91
tee connection symbols 530
template drawings 1064
templates 131
Terminal Block Properties dialog box 566, 609
Terminal Block Settings dialog box 241
terminal blocks 192
footprint symbols 192
Terminal Data Export dialog box 1004
terminal exception report 953
terminal numbers 578
resequence 578
Terminal Numbers Data Fields to Report dialog box 883
terminal numbers report 917
Terminal Plan Data Fields to Report dialog box 888
terminal plan report 918
terminal row styles 620
Terminal Strip Definition dialog box 589
terminal strip editor 585
cable information 585
catalog code assignment 585
define columns 585
insert accessories 585
insert spares 585
installation codes 585
location codes 585
preview 585
row styles 585
terminal strip 585
wire constraints 585
Terminal Strip Editor 590, 595, 600, 604
Cable Information tab dialog box 600
Catalog Code Assignment tab dialog box 595
Terminal Preview tab dialog box 604
Terminal Strip tab dialog box 590
Terminal Strip Representation - Setup dialog box 584
Terminal Strip Representation dialog box 583
Terminal Strip Selection dialog box 588
Terminal Strip Table Data Fields to Include dialog box 621
Terminal Strip Table Generator dialog box 624
terminal strips 582, 585, 624, 1093, 1095, 1098–1099, 1104, 1107
accessories 585
associate 585
draw shapes 1098
drawing files 624
edit 585
graphical format 585
insert 585, 1098
insert accessories 585
insert spares 585
installation codes 585
location codes 585
panel report parameters 1107
pick list 1107
renumber 585
row styles 585
sequence 1099, 1104
sequencing 1093
swap text 1095
table creation 624
tabular format 585, 624
unique records 585
terminals 225, 323, 408, 554, 559, 568, 573, 578–579, 582, 585, 629, 1067, 1093, 1107
add associations 559
associations 568
blocks 225
break apart 568
break associations 568
connections 579
copy properties 568
edit 585
edit associations 559
edit database record 629
edit levels 585
edit properties database 629
edit symbol 559
edit type 225
information 225
insert 323, 559
insert multiple 1067
insert panel 323
jumpers 573
list 582
marking 579
modify sequence 225
multi-connection 554
multi-level 568
multi-stack 568
multi-tier 568
orientation 582
pick list 1107
properties database 629
reassign 585
remove sequencing 1093
renumber 578, 585
select properties database 629
setup 582
show associations 568
text 408, 582
terminal 408
text conversion 1131
Text Cross-Reference Format Setup dialog box 367
text cross-references 362
text justification 424
text sizes 425
text styles 425
TEXTVALS 777
Title Block Setup (User-Defined) dialog box 717, 724, 727
Title Block Setup dialog box 716, 723, 726
title blocks 83, 708, 718, 724
customize 718
embedded information 718
link 718
map 718
map AutoLISP 724
project-wide update 708
setup 708
update 708
Toggle Installation Codes dialog box 618
Toggle Location Codes dialog box 617
track changes 700
translate descriptions 703
troubleshoot tools 1176

U

unavailable files 92
Unity Pro 270, 280
export 270, 280
import from 270
Unity Pro Export dialog box 281
Unity Pro Import dialog box 275
unlink symbols 1151
Update Block - New Block’s Path/filename dialog box 215
update drawings 1004
Update Drawings per Spreadsheet Data dialog box 1004
Update Title Block dialog box 713
update title blocks 708
Update Wire Signal and Stand-Alone Cross-Reference dialog box 360
used panel tags 302
used schematic tags 301
user data 351
   edit 351
User-Defined Attribute List dialog box 1006
user-defined attributes 1005
   edit 1005
utilities 82
   zip 82
V
vault 50
vault drawings 1250
   advanced 1250
vault projects 1250
   advanced 1250
Vendor Menu Selection dialog box 1058
vendor menus 1031
Vendor Panel Footprint dialog box 1058
vendor part numbers 785
vendor selection 1031
verify changes 700
View/Edit Panel Component Connection Sequence dialog box 1095
W
WD_AB icon menu 1031
wd_fam.dat 70
wd_lang1.mdb 703
WD_M block 134
   alert 134
defaults 134
   insert 134
WD_M blocks 63, 362
   new drawings 63
   overrides 362
WD_PNLM block 134
   insert 134
WD_SLB 730
wd.env files 29, 70, 77
wddinrl.xls 344
web 705
   create pages 705
   publishing drawing files 705
WEBLINK assignment 777
What’s New 2, 26
wire annotation exception 950
wire annotation exception report 933
wire colors 502
   encode 502
   information 502
Wire Conduit Routing Data Fields to Report dialog box 892
wire connection 579
terminals 579
wire connections 914, 979, 1074, 1077, 1150
   add 1150
   annotations 1077
default 1074
from/to report 914
   report format files 979
text 1077
Wire From/To Data Fields to Report dialog box 876
wire from/to report 914
Wire Jumpers dialog box 397
Wire Label Data Fields to Report dialog box 891
wire label report 920, 989
   format files 989
wire layers 150, 156, 502
   add existing 150
change 150, 156
   convert 156
create 150
   edit 150
   setup 150
wire list export 1008
wire markers 467
wire networks 525
   edit 525
sequence 525
show 525
wire numbers 96, 484, 492, 501–502,
   506–508, 511–514, 516, 519, 521,
   525, 1074, 1077
3-phase bus 484
   add to footprints 1077
copy 514
drawing properties 96, 492, 516
edit 506
erase 521
extra 513
find 501
fixed 506–507
flip 516
format 502
hide 521
increment 519
insert 484, 492
insert special 484
leader 512
make vertical 519
merge 1074
mirror 514, 516
motor circuits 484
move 511–512
panel wiring diagram 1077
plc tags 525
position 492
project properties 96
project-wide 508
replace text 501
reposition 511
reposition leader text 512
rotate 512
show 484
size 519
swap 513
tag 484
toggle 516
wire sequence 1095
wire shields 466
Wire Signal or Stand-Alone Reference Report dialog box 541
wire tag mode 484
project-wide 484
Wire Tagging (project-wide) dialog box 490
Wire Tagging dialog box 489
wire types 156
edit 156
set 156

Wire/Conduit Routing Report dialog box 1120
wires 156, 434–435, 437, 439–440, 443, 467, 473, 484, 525, 541, 585, 659–660, 1074, 1077, 1176
3-phase bus 435
angled 437
bend 659
cable marker report 443
change type 156
check 1176
color labels 440
colors 440
connection annotations 1077
constraints 585
duplicate 1176
gaps 473
gauge labels 440
in-line markers 467
insert 437
insert 3-phase bus 660
insert labels 440
multiple wire bus 435
repair 1176
report sequencing 525
show 484
signal report 541
stand-alone reference report 541
stretch 440
trace 1176
trim 439
ungap 473
wire connection text 1074
wiring 636
WO_CBLWIRE 542

X

X Zone Setup dialog box 523
X-Y Grid dialog box 524
xdata 1028, 1184
add 1184
editor 1184
make visible 1028
Xdata Editor dialog box 1185